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Importazione e completamento dei movimenti bancari 816 ................................................. 

Formati di importazione dei movimenti bancari 816 ................................................................. 
Altri comandi per importazione dei dati 816 ............................................................................ 
Completamento manuale e annulla importazione 816 ........................................................... 
Link utili 817 .................................................................................................................................. 

Comando Importa in contabilità 818 ................................................................................................. 
Procedura per l'importazione 818 .............................................................................................. 
Formati d'importazione 818 ........................................................................................................ 
Parametri importazione 819 ........................................................................................................ 

Nome file: 819 .................................................................................................................... 
Importa dati da clipboard (Excel) 819 ................................................................................ 
UTF-8 819 ........................................................................................................................... 
Gestione Estensioni... 819 .................................................................................................. 
Impostazioni 820 ................................................................................................................ 
Bottone OK 820 .................................................................................................................. 

Segnalazione di errori 820 .......................................................................................................... 

Importa i tuoi movimenti in Banana Contabilità+ 821 ................................................................... 
 Procedura per l'importazione 821 ............................................................................................. 
Passi successivi 821 ..................................................................................................................... 
Formati di importazione estratti bancari 822 .......................................................................... 
Nome file 822 ................................................................................................................................. 
Struttura del file d'importazione 822 ........................................................................................ 
Domande frequenti 823 ............................................................................................................... 

Dialogo Importa movimenti 824 ........................................................................................................ 
Contenuto del dialogo 824 .......................................................................................................... 
Dialogo Importa Movimenti 824 ................................................................................................. 

Conto destinazione 824 ............................................................................................................ 
Seleziona movimenti 825 .......................................................................................................... 

Data inizio, Data fine 825 ............................................................................................ 



Non importare se esiste già lo stesso Riferimento esterno, Data e Importo 825 ........ 
Ordina registrazioni per data 825 ............................................................................... 

Completa le registrazioni con 825 ............................................................................................. 
Completamento automatico dei valori 825 ................................................................. 
Applica regole (solo piano Advanced) 825 .................................................................. 

 Conto temporaneo di Contropartita 825 ........................................................................... 
Numero documento iniziale 826 ........................................................................................ 

Raggruppa registrazioni per numero Fattura 826 ..................................................................... 
 Modifica delle registrazioni importate 826 .............................................................................. 

Importa i movimenti bancari nel formato ISO 20022 (generico) 828 .......................................... 
Anteprima del file ISO-20022 828 .............................................................................................. 
Importazione dei dati nella contabilità esistente 828 ............................................................ 
Note tecniche relative alla conversione del file ISO 20022 828 ............................................ 
Specifiche nazionali 829 .............................................................................................................. 

Importa movimenti (generico) 830 ................................................................................................... 
Procedura per l'importazione 830 .............................................................................................. 
Importazione da altri file di Banana Contabilità 830 .............................................................. 
Importa file TXT/CSV 831 ............................................................................................................. 
Importazione estratti conto con estensione importazione 831 ............................................. 

Cercare e installare un'estensione: 831 .................................................................................... 

Importare movimenti dal Cash Manager 832 .................................................................................. 
Impostare il conto di giro per i versamenti 832 ....................................................................... 
Versamenti dal conto corrente bancario alla cassa 832 ......................................................... 
Importare i dati del Cash Manager 833 ..................................................................................... 

In contabilità 834 ...................................................................................................................... 
Conto destinazione 834 ..................................................................................................... 
Numero documento iniziale 834 ........................................................................................ 

Seleziona movimenti 834 .......................................................................................................... 
Data Inizio / Data fine (compresa) 834 ............................................................................... 

Raggruppa movimenti 834 ........................................................................................................ 
Una registrazione per conto 835 ........................................................................................ 

Nota 835 ..................................................................................................................... 

Importa movimenti Paypal 836 .......................................................................................................... 
Approfondimenti: 836 ............................................................................................................... 

Importa conti 837 ................................................................................................................................. 
Opzioni 838 ............................................................................................................................... 

Importa anche centri di costo 838 ..................................................................................... 
Aggiungi conti inesistenti 838 ............................................................................................ 
Rimpiazza testo descrizione 838 ........................................................................................ 
Rimpiazza saldo d’apertura 838 ......................................................................................... 

Importa codici IVA 839 ........................................................................................................................ 
Importa da un file di contabilità 839 ......................................................................................... 
Opzioni importazione Codici IVA 839 ......................................................................................... 

Aggiungi nuovi codici e nuovi gruppi 839 .......................................................................... 



Sostituisci tutte le righe 839 .............................................................................................. 
Messaggio Conto IVA non trovato 839 ...................................................................................... 
Importare i Codici IVA Svizzeri predefiniti 839 ........................................................................ 
Documentazione Gestione IVA 840 ............................................................................................ 

Importa file 841 .................................................................................................................................... 
File sorgente 842 ............................................................................................................... 
File destinazione 842 ......................................................................................................... 

Opzioni 842 ............................................................................................................................... 
Importa movimenti 842 ...................................................................................................... 
Importa registrazioni ricorrenti 842 ................................................................................... 
Importa registrazioni preventivo 842 ................................................................................. 
Sostituisci importi della tabella Conti 842 .......................................................................... 
Sostituisci proprietà file (dati base) 842 ............................................................................ 
Converti numeri di conto 842 ............................................................................................. 

Risultato e possibili errori 843 .................................................................................................... 
Opzioni avanzate d'importazione 843 ....................................................................................... 

Importa cambi 844 ............................................................................................................................... 
Nota 844 ..................................................................................................................... 

Seleziona data 845 ............................................................................................................. 
Sostituire cambi 845 .......................................................................................................... 
Aggiorna righe 845 ............................................................................................................ 

Regole per il completamento automatico delle registrazioni importate 846 ............................ 
Completamento automatico registrazioni importate 846 ...................................................... 
Le regole per il completamento 846 .......................................................................................... 
Flusso di lavoro 846 ...................................................................................................................... 
Come iniziare 847 .......................................................................................................................... 
Principali vantaggi 847 ................................................................................................................ 
Aggiunta di regole 847 ................................................................................................................. 
Regole = Base di conoscenza 848 .............................................................................................. 
Processo di completamento veloce e preciso 848 ................................................................... 

Come funzionano le regole di completamento delle registrazioni importate 850 .................... 
Importazione dei movimenti bancari  850 ................................................................................ 
Completamento delle registrazioni con le regole 850 ............................................................ 
Regole 851 ...................................................................................................................................... 
Registrazioni completate (Risultato) 851 ................................................................................. 
Ulteriore completamento manuale 852 ..................................................................................... 
Crea Regole con dialogo Applica regole 852 ............................................................................ 
Crea Regole partendo da una registrazione 853 ..................................................................... 
Registrazioni su più righe 853 .................................................................................................... 
Funzionalità al momento non disponibili 854 .......................................................................... 

Come iniziare con l'uso delle regole per il completamento registrazioni 855 ........................... 
1. Impartisci il comando Importa in contabilità 855 ............................................................... 
 2. Dialogo Applica regole 855 .................................................................................................... 
3. Crea nuove regole 856 ............................................................................................................. 

Ritorna al dialogo Applica regole 857 ....................................................................................... 



4. Conferma Applica Regole 857 ................................................................................................. 
Annulla le modifiche effettuate 858 .......................................................................................... 

Completa le altre registrazioni con Contropartita temporanea 858 .................................... 
Aggiungere informazioni alle registrazioni completate con le regole 858 .......................... 

Regole di completamento dialogo Applica regole 860 ................................................................... 
Dialogo Applica Regole 860 ......................................................................................................... 

Applica regole alle registrazioni con... 861 ............................................................................... 
Tabella di visualizzazione delle registrazioni importate 861 ..................................................... 

Comandi contestuali 861 ............................................................................................................. 
Opzioni di visualizzazione 862 .................................................................................................. 
Bottoni di conferma 862 ............................................................................................................ 

Consigli su come utilizzare la finestra Applica regole 863 ..................................................... 
Tabella registrazioni ricorrenti 863 ........................................................................................... 

Aggiungi/Modifica regole 864 ............................................................................................................ 
Esempio Aggiungi nuova regola 864 .......................................................................................... 
Dialogo Aggiungi nuova regola 864 ........................................................................................... 
Regola 865 ...................................................................................................................................... 
Condizioni di ricerca 865 .............................................................................................................. 

Cerca in Descrizione (Colonna Descrizione) 865 ....................................................................... 
Importo 866 .............................................................................................................................. 
Conto bancario 866 ................................................................................................................... 

Azioni per il completamento 866 ................................................................................................ 
Conto di contropartita 866 ........................................................................................................ 
IVA 866 ..................................................................................................................................... 
CC1, CC2, CC3 867 .................................................................................................................... 
Altri campi da completare 867 .................................................................................................. 

Tabella Registrazioni corrispondenti 867 ................................................................................. 
Bottoni 867 ..................................................................................................................................... 
Modifica regole nella Tabella Registrazioni Ricorrenti 867 ................................................... 

Tabella Registrazioni ricorrenti con Regole 868 ............................................................................. 
Le colonne usate dalle Regole 868 ............................................................................................. 

Colonne di corrispondenza (o di ricerca) 869 ............................................................................ 
La colonna Doc 869 ............................................................................................................ 
La colonna Descrizione 869 ............................................................................................... 
Le colonne Conto Dare e Conto Avere 869 ........................................................................ 
La colonna Importo 870 ..................................................................................................... 

Colonne di sostituzione (o di completamento) 870 ................................................................... 
Completamento colonna DocLink  870 ...................................................................................... 
Completamento manuale delle registrazioni 870 ...................................................................... 

Registrazioni su più righe (split rows) 871 ............................................................................... 
Consigli 872 .............................................................................................................................. 

Copiare in blocco le regole da un file all'altro 872 .................................................................. 

Regole Completamento Contabilità Entrate e Uscite 873 ............................................................. 
La tabella Registrazioni ricorrenti nella contabilità Entrate/Uscite 873 .............................. 

Il conto di giro 874 ............................................................................................................................... 



Uso del conto di giro nell'importazione dati dalla cassa o carta di credito 874 ......................... 

Ripresa dati da altri programmi 875 ................................................................................................. 
Importazione dati one time con Excel 875 ................................................................................ 
Importazione movimenti bancari 875 ........................................................................................ 
Esempio importazione file bancario CSV tramite Excel 875 .................................................. 

Colonne contabilità multi-moneta 876 ...................................................................................... 
Ulteriori consigli 876 ................................................................................................................. 

Importazione ricorrente da altri programmi 877 ..................................................................... 

Tabella Registrazioni ricorrenti 878 .................................................................................................. 
Visualizzare e disporre colonne e viste nella tabella Registrazioni ricorrenti 878 ............ 
Inserire registrazioni ricorrenti tramite la colonna Doc 878 ................................................. 
Riprendere registrazioni ricorrenti nella tabella Registrazioni 879 ..................................... 
Copiare registrazioni dalla tabella Registrazioni alla tabella Registrazioni ricorrenti

879 ............................................................................................................................................ 

Registrazioni automatiche con cadenze regolari 881 .................................................................... 
Prerequisiti 881 ............................................................................................................................. 

Aggiungere le colonne Data fine e Ripeti alla contabilità 881 ................................................... 
Creare una registrazione automatica dalla tabella Registrazioni ricorrenti 882 ............... 
Creare una registrazione automatica dal dialogo Applica registrazioni automatiche

883 ............................................................................................................................................ 

Controlla e ricalcola contabilità 884 ................................................................................................. 
Ricalcolo e controllo contabilità (primario) 884 ....................................................................... 
 Finestra controlla contabilità (controllo esteso) 884 ............................................................ 

Ricalcola contabilità ed esegui controlli estesi 885 ............................................................ 
Proprietà dati base 885 ................................................................................................................ 
Registrazioni 885 .......................................................................................................................... 

Differenze registrazioni 885 ............................................................................................... 
Includi differenze intermedie 885 ...................................................................................... 
 Saldi di verifica (#CheckBalance) 886 .............................................................................. 

Stesso documento con date diverse 887 .................................................................................. 
Conti 887 ........................................................................................................................................ 

Struttura piano dei conti 887 ............................................................................................. 
Presenza di differenze di cambio 887 ................................................................................ 
Saldi di apertura differiscono dai saldi di chiusura anno precedente 887 .......................... 

Controlli personalizzati (Estensioni) 887 .................................................................................. 
Includi controlli estesi con il tasto maiuscolo + F9 887 ......................................................... 

Colonna Movimento 888 ...................................................................................................................... 

Colonna Saldo per rilevare le differenze contabili 889 .................................................................. 
Come la colonna Saldo trova le differenze 889 ........................................................................ 
Controllare la contabilità 890 ..................................................................................................... 

Esportazione da Banana Contabilità+ 891 ....................................................................................... 
Esporta righe 891 .......................................................................................................................... 
Esporta File 891 ............................................................................................................................. 



Esporta Anteprima di stampa 891 .............................................................................................. 
Formati per l'esportazione 891 ................................................................................................... 

Esportazione dei dati in Excel 893 .................................................................................................... 
Nome file 893 ..................................................................................................................... 
Visualizza file immediatamente 893 .................................................................................. 

Opzioni 893 .................................................................................................................................... 
Definisci nome celle 893 .................................................................................................... 
Definisci nomi tabelle 894 .................................................................................................. 
Usa nomi in Xml (Inglese) 894 ........................................................................................... 
Proteggi tabelle 894 ........................................................................................................... 

Altre sezioni 894 ....................................................................................................................... 
Risultato dell'esportazione 894 .................................................................................................. 
Copia/incolla dei dati da Banana a Excel 895 ........................................................................... 

Includi 896 ............................................................................................................................................. 
Ricontrolla contabilità 896 ................................................................................................. 

Includi 896 ................................................................................................................................ 
Vista 896 ............................................................................................................................ 

Periodi 896 ................................................................................................................................ 
Conti / Categorie per periodo 896 ...................................................................................... 
Riassunto IVA 896 .............................................................................................................. 
Crea periodi per tutto l’anno 896 ....................................................................................... 
Numero massimo periodi 897 ............................................................................................ 

Esporta in Html 898 ............................................................................................................................. 
Nome file 898 ..................................................................................................................... 
Visualizza file immediatamente 898 .................................................................................. 

Opzioni creazione file 898 ......................................................................................................... 
Intestazione 1, 2 e 3 898 .................................................................................................... 

Altre sezioni 899 ....................................................................................................................... 

Opzioni Html 900 .................................................................................................................................. 
Usa foglio di stile CSS 900 .................................................................................................. 
Usa foglio stile predefinito 900 .......................................................................................... 

Foglio stile esterno 900 ............................................................................................................. 
Nome file 900 ..................................................................................................................... 
Includi foglio di stile nel file Html 901 ................................................................................ 

Esporta in Xml 902 ............................................................................................................................... 
Nome File 902 .................................................................................................................... 
Visualizza file immediatamente 902 .................................................................................. 
Foglio stile XSLT 902 .......................................................................................................... 

Opzioni 903 ............................................................................................................................... 
Altre sezioni 903 ....................................................................................................................... 

Esporta righe in txt 904 ...................................................................................................................... 
Nome file 904 ..................................................................................................................... 
Formato 904 ....................................................................................................................... 
Visualizza file immediatamente 904 .................................................................................. 



Opzioni 904 ............................................................................................................................... 

Blocco registrazioni con la tecnologia del Blockchain 905 ........................................................... 
Certificazione dati con blockchain 905 ...................................................................................... 
Comando blocca registrazioni 905 ............................................................................................. 

Data nuovo blocco (compresa) 905 .......................................................................................... 
Password (opzionale) 906 ......................................................................................................... 
Ultimo blocco 906 ..................................................................................................................... 
Blocco valido 906 ...................................................................................................................... 
Data blocco 906 ........................................................................................................................ 
Numero di blocco 906 ............................................................................................................... 
Hash progressivo 906 ............................................................................................................... 

Registrazioni: Vista Blocco 906 .................................................................................................. 
Il marchio digitale BloccoProgr 907 ........................................................................................... 

Verifica blocco 907 ........................................................................................................................ 
 Sblocca registrazioni 908 ........................................................................................................... 

Sblocco parziale 908 ................................................................................................................. 
Perché lasciare sbloccare la contabilità? 908 .......................................................................... 
Organizzare la certificazione e la verifica 909 ......................................................................... 
Sicurezza dati 909 ......................................................................................................................... 
Archiviazione a lungo termine 909 ............................................................................................. 

Aggiungi o rimuovi funzionalità 910 ................................................................................................. 
Abilita Maiuscolo/Minuscolo nei numeri di conto descrittivi e nei codici 910 ..................... 
Aggiungi tabella Articoli 910 ....................................................................................................... 
Aggiungi le colonne Articoli nella tabella Registrazioni 910 ................................................. 
Aggiungi tabella e colonne Articoli nella tabella Registrazioni 910 ..................................... 
 Aggiungi le colonne Indirizzi nella tabella Conti 911 ............................................................. 
 Aggiungi e rimuovi tabella Preventivo 911 ............................................................................. 
 Modifica colonna tipo importo IVA nelle registrazioni 911 ................................................... 

Nota 911 ..................................................................................................................... 

Dialogo - sezione Periodo 912 ............................................................................................................ 
Tutto 912 ........................................................................................................................... 
Periodo specificato 912 ...................................................................................................... 

Movimenti senza data 912 ........................................................................................................ 

I grafici di Banana Contabilità+ 913 ................................................................................................. 
Pannello di controllo 913 ............................................................................................................. 

Valori temporali 913 .................................................................................................................. 
Legenda 913 ............................................................................................................................. 
Periodo 914 ............................................................................................................................... 
Intervallo 914 ............................................................................................................................ 
Valore 914 ................................................................................................................................. 
Tipo 914 .................................................................................................................................... 

Stampa, Salva  o Copia il grafico 914 ........................................................................................ 

Estensioni 916 ...................................................................................................................................... 
Rendiconto IVA 2024 per la Svizzera 916 ................................................................................. 
Fatturazione QR per la Svizzera 916 .......................................................................................... 



Patriziati Ticino stampe elenco Patrizi 916 .............................................................................. 
Analisi di bilancio e flussi di cassa 916 ..................................................................................... 
Gestione portafoglio titoli 916 .................................................................................................... 
Gestione costruzioni e ristrutturazioni 917 .............................................................................. 
Rendiconto gestionale e stato patrimoniale Enti Terzo Settore (Italia) 917 ...................... 
Elenco di tutte le estensioni 917 ................................................................................................ 
Estensioni autoprogrammate 917 .............................................................................................. 

Applicativi di Produttività 918 ........................................................................................................... 
Altre funzioni abbinabili agli Applicativi Produttività 918 ..................................................... 

Offerte e Fatture distinte dalla contabilità 919 .............................................................................. 
Come iniziare con Offerte e Fatture 919 ................................................................................... 
Le tabelle  920 ............................................................................................................................... 
Struttura della fattura 920 .......................................................................................................... 
Stampe e report 921 ..................................................................................................................... 
Differenze con l'applicativo Fatturazione integrata 922 ........................................................ 
Esportazione e archiviazione dati 922 ....................................................................................... 
Altre Funzioni 922 ......................................................................................................................... 
Funzioni disponibili solo con il piano Advanced 923 ............................................................... 
Funzionalità al momento non disponibili 923 .......................................................................... 

Caratteristiche Offerte e Fatture 924 ............................................................................................... 
La logica delle offerte e fatture 924 .......................................................................................... 
Funzionalità simili a Excel 924 .................................................................................................... 
Basato su tabelle 925 ................................................................................................................... 
Impostazioni dati base 925 ......................................................................................................... 
File e salvataggio dati 925 .......................................................................................................... 
Inserimento dati Offerte e Fatture 926 ..................................................................................... 
Segnalazioni errori e controllo 926 ............................................................................................ 
Stampe e report 926 ..................................................................................................................... 
Esportazione e archiviazione dati 926 ....................................................................................... 
Documentazione completa 927 ................................................................................................... 
Cronologia modifiche 927 ............................................................................................................ 
 Funzioni disponibili solo con il piano Advanced 927 .............................................................. 
Funzionalità al momento non disponibili 927 .......................................................................... 

Come iniziare una Fattura 929 ........................................................................................................... 
 Creare un file Fattura 929 .......................................................................................................... 
 Inserire i dati base 929 ............................................................................................................... 
Creare nuova fattura 929 ............................................................................................................ 
Stampare una fattura 930 ........................................................................................................... 
Le tabelle 930 ................................................................................................................................ 

Tabella Contatti 931 ............................................................................................................................ 
Le colonne 931 ............................................................................................................................... 

Id 931 ........................................................................................................................................ 
Organizzazione 931 ................................................................................................................... 
Titolo (Prefisso) 931 .................................................................................................................. 
Nome 931 ................................................................................................................................. 



Cognome 931 ............................................................................................................................ 
Via 931 ...................................................................................................................................... 
Extra 932 .................................................................................................................................. 
Casella postale 932 ................................................................................................................... 
CAP 932 .................................................................................................................................... 
Località 932 .............................................................................................................................. 
Codice nazione 932 ................................................................................................................... 
Lingua 932 ................................................................................................................................ 
Numero fiscale 932 ................................................................................................................... 
Numero IVA 932 ........................................................................................................................ 
Note 932 ................................................................................................................................... 

Tabella Articoli | Offerte e fatture 933 ............................................................................................. 
Le colonne 933 ............................................................................................................................... 

Links 933 ................................................................................................................................... 
Id 933 ........................................................................................................................................ 
Descrizione 933 ........................................................................................................................ 
Unità 933 .................................................................................................................................. 
Prezzo unità 933 ....................................................................................................................... 
Conto 933 ................................................................................................................................. 
Note 934 ................................................................................................................................... 

 Importazione catalogo 934 ......................................................................................................... 

Tabella Fatture 935 ............................................................................................................................. 
Le colonne 935 ............................................................................................................................... 

Id 935 ........................................................................................................................................ 
Data 935 ................................................................................................................................... 
Descrizione 935 ........................................................................................................................ 
Contatto Id 935 ......................................................................................................................... 
Indirizzo 936 .............................................................................................................................. 
Importo sconto 936 ................................................................................................................... 
Totale 936 ................................................................................................................................. 
Scadenza 936 ............................................................................................................................ 
Pagamento 936 ......................................................................................................................... 
Note 936 ................................................................................................................................... 

Tabella Offerte 937 .............................................................................................................................. 
Le colonne 937 ............................................................................................................................... 

Id 937 ........................................................................................................................................ 
Data 937 ................................................................................................................................... 
Descrizione 937 ........................................................................................................................ 
Contatto Id 937 ......................................................................................................................... 
Indirizzo 937 .............................................................................................................................. 
Importo sconto 937 ................................................................................................................... 
Totale 937 ................................................................................................................................. 
Note 938 ................................................................................................................................... 

Tabella Codici IVA 939 ......................................................................................................................... 
Le colonne 939 ............................................................................................................................... 

Id 939 ........................................................................................................................................ 



Descrizione 939 ........................................................................................................................ 
%IVA 939 .................................................................................................................................. 
Note 939 ................................................................................................................................... 

IVA sul lordo o sul netto 939 ....................................................................................................... 

Aggiungere, Modificare Fatture 940 ................................................................................................. 
Menu Fatture 940 .......................................................................................................................... 
Creare una nuova fattura 940 ..................................................................................................... 
 Modificare una fattura 940 ......................................................................................................... 
 Duplicare una fattura 941 .......................................................................................................... 
 Cancellare una fattura 941 ......................................................................................................... 
 Stampare una fattura 942 .......................................................................................................... 
 Visualizzare le fatture aperte 942 ............................................................................................. 
 Visualizzare le fatture di un cliente 942 .................................................................................. 
 Archiviare le fatture 942 ............................................................................................................. 

Dialogo Aggiungere e modificare le fatture 944 ............................................................................. 
Accedere alla finestra di dialogo 944 ........................................................................................ 
Dialogo Sezioni 944 ...................................................................................................................... 

Dialogo Modifica fattura 945 .............................................................................................................. 
Viste 945 ......................................................................................................................................... 
Struttura 945 ................................................................................................................................. 

(1) Informazioni e testi liberi 946 .............................................................................................. 
(2) Indirizzo cliente 948 ............................................................................................................ 
(3) Articoli / colonne articoli 948 ............................................................................................... 
(4) Sconti e totali 950 ............................................................................................................... 
(5) Impostazioni 950 ................................................................................................................. 
(6) Comandi 950 ....................................................................................................................... 

Personalizzazione 951 .................................................................................................................. 

Dialogo Impostazioni fattura 952 ...................................................................................................... 
Nuovi documenti 952 .................................................................................................................... 
Campi utente fattura 953 ............................................................................................................ 
Interfaccia 953 ............................................................................................................................... 

Viste 953 ................................................................................................................................... 
Campi fattura 953 ..................................................................................................................... 
Articoli 953 ................................................................................................................................ 
Colonne Articoli 953 .................................................................................................................. 

Strumenti 953 ................................................................................................................................ 
Aiuto 954 ........................................................................................................................................ 

Traduzione testi fattura 955 .............................................................................................................. 

Cronologia modifiche dell'estensione offerte e fatture 956 ......................................................... 
2024-02-01 956 .............................................................................................................................. 

956 ................................................................................................................................................... 
2023-07-18 956 .............................................................................................................................. 
2023-04-03 957 .............................................................................................................................. 
2022-12-14 957 .............................................................................................................................. 



2022-12-06 957 .............................................................................................................................. 
2022-09-21 957 .............................................................................................................................. 
2022-03-31 957 .............................................................................................................................. 
2022-02-10 957 .............................................................................................................................. 
2022-02-08 958 .............................................................................................................................. 
2022-02-07 958 .............................................................................................................................. 
2022-02-01 958 .............................................................................................................................. 

Novità release 2022-02-01 960 .......................................................................................................... 
La sezione di modifica della Fattura 960 .................................................................................. 

(1) Sezione Impostazioni 960 .................................................................................................... 
(2) Viste 960 ............................................................................................................................. 
(3) Cortesia, Indirizzo extra e Casella postale 960 .................................................................... 
(4) Campi utente (piano Advanced) 960 ................................................................................... 
(5) Data articolo (piano Advanced) 960 .................................................................................... 
(6) Sconto articolo (piano Advanced) 961 ................................................................................. 
(7) Testi su più righe e in grassetto 961 ................................................................................... 
(8) Prezzo unitario e Quantità con 4 o più decimali 961 ........................................................... 
(9) Acconto 961 ......................................................................................................................... 

Sezione Impostazioni 961 ............................................................................................................ 
(1) Titolo per nuove offerte e fatture 961 ................................................................................. 
(2) Gestisci viste 961 ................................................................................................................ 
(3) Campi visibili 962 ................................................................................................................ 

Dialogo Offerte e Fatture Release Beta 963 .................................................................................... 
Come installarla 963 ..................................................................................................................... 
Novità della versione Beta 963 ................................................................................................... 
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L'interfaccia di Banana Contabilità Plus

Sei al tuo primo approccio a Banana Contabilità Plus? Nessun problema. In questa pagina ti
mostriamo brevemente cosa trovi nella schermata principale e come funzionano i vari elementi. 

A prima vista Banana Contabilità Plus è simile ad Excel, basato su tabelle, e il ha un modo d'uso molto
pratico e intuitivo . Ma scoprirai che Banana Contabilità Plus fa molto di più.

▶ Video: L'interfaccia di Banana Contabilità Plus
Consigli e comandi per l'inserimento veloce dei dati

1. La barra dei menu
La barra dei menu cambia a seconda dell'applicativo aperto. Ogni menu ha dei comandi specifici. I
menu degli applicativi contabili sono i seguenti: File, Modifica, Dati, Formato, Strumenti, Report,
Azioni, Estensioni, Finestre, Aiuto.

Dal menu Aiuto si gestiscono i dati dell'abbonamento di Banana Contabilità Plus.

Attenzione: nei sistemi operativi Mac, la barra dei menu è posta in alto, a destra del logo di Apple a
forma di mela.

Nuovo: nel Menu Finestra hai diversi comandi, che ti permettono fra l'altro di:

Cambiare la disposizione delle finestre dati (affiancati o a cascata)

https://www.banana.ch/it/node/10754
https://www.banana.ch/it/node/10754
https://www.banana.ch/it/node/11509
https://www.banana.ch/it/node/11509
https://www.banana.ch/it/node/11509
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Scegliere diverse impostazioni dal comando Aspetto:
Scegliere quali elementi dell'interfaccia visualizzare, per adattarli a schermi piccoli.
Scegliere il tema di visualizzazione.
Rendere visibile il menu Sviluppo.

2. La barra degli strumenti
La barra degli strumenti consente di accedere rapidamente alle finestre e ai comandi più usati.

È sufficiente spostarsi con il mouse sull’icona desiderata e attendere un attimo per avere una
descrizione del significato.

Nuovo: se si hanno diversi file aperti è ora possibile vedere facilmente su quale si sta lavorando e
passare da uno all'altro molto semplicemente dalla barra degli strumenti.

3. La zona immissione testo
Normalmente, i testi vengono scritti direttamente nella cella, ma appaiono anche nella zona posta
sotto la barra degli strumenti, dove è possibile anche effettuare delle modifiche. Diverse funzioni ne
velocizzano e automatizzano l'inserimento.

4. Le tabelle
Ogni file è costituito da più tabelle, che mostrano contenuti diversi della contabilità o dell'applicativo.
Passa da una tabella all'altra semplicemente toccando con il mouse il nome della tabella.
Le tabelle variano a seconda dell'applicativo aperto. Lavorare con le tabelle consente di avere i dati
sempre ordinati e raggruppati secondo il contenuto.

Vi sono tabelle principali (fisse) e ausiliarie (che compaiono in seguito a determinati comandi). Le
tabelle ausiliarie (quelle generate dall'utente) sono utili per modifiche o aggiunta di dati e devono
essere aggiornate, semplicemente cliccando sull'icona in alto a destra della tabella 

Oltre ai vari report disponibili, Banana Contabilità Plus permette di stampare tutto ciò che si vede a
video in qualsiasi tabella. Per maggiori informazioni visita la pagina Stampe/anteprima.

5. Le viste
Le viste sono modi diversi di visualizzare i dati della stessa tabella, mostrando solo determinate
colonne. Sono molto utili quando si vogliono visualizzare i dati in modo diverso, senza alterare le
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impostazioni di base. Passa da una vista all'altra semplicemente toccando con il mouse il
nome della vista.

Le viste sono posizionate nella zona sotto le tabelle e possono essere personalizzate con il comando
Disponi tabelle. Vi è anche la possibilità di crearne di nuove.

6. Il Filtro
La funzione Filtra righe, disponibile nel piano Advanced  di Banana Contabilità Plus, permette di
cercare, trovare e modificare all'istante movimenti precedentemente inseriti. Insieme all'Ordina
righe temporaneo rappresenta un'importante innovazione per la velocizzazione del controllo
contabile.
Per maggiori informazioni visita la pagina Filtra e Ordina righe temporaneo.

7. L'aiuto contestuale
In Banana Contabilità Plus, l'aiuto contestuale ti dà un aiuto immediato e relativo esattamente a ciò a
cui stai lavorando. Questo avviene in diversi modi complementari:

A - La finestra del messaggio di errore, che il programma mostra quando rileva un possibile
errore:

Se premi OK visualizzi ogni singolo messaggio.
Se premi Aiuto vieni portato alla pagina di spiegazione del messaggio di errore con le
possibili soluzioni.
Vistando Non segnalare, tutti i messaggi di errore vengono salvati nella finestra
Messaggi di errore.
 

B - Simbolo punto interrogativo in alto a destra della tabella 
Con un click sul simbolo vieni portato alla nostra pagina della Documentazione, dove puoi
trovare approfondimenti sull'uso della tabella e su tutte le altre funzioni del programma.
 

C - Simbolo punto interrogativo in basso nella finestra Info o Messaggi
Cliccando su questo simbolo vieni portato alla pagina spiegazione del messaggio di errore e
delle possibili soluzioni.
 
D - Bottone Aiuto nelle finestre di dialogo
Cliccando questo bottone viene visualizzata la pagina online di spiegazione della finestra di
dialogo aperta o del messaggio di errore.

http://www.banana.ch/it/advanced
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8. Le colonne
Le colonne sono gli elementi verticali della tabella. Ogni colonna ha una sua propria intestazione. Puoi
personalizzare l'intestazione, la larghezza, lo stile, il formato e anche la sequenza attraverso le
funzioni che si trovano nel menu Dati → Disponi colonne .

In alcune colonne i dati vengono inseriti dall'utente, mentre in altre il programma immette
automaticamente i dati e non sono quindi modificabili dall'utente (es. le colonne delle schede conto).

Puoi aggiungere nuove colonne sempre tramite il comando Dati → Disponi colonne , ma se
contengano dei valori non verranno elaborate dal programma.

9. Cerca e sostituisci
La funzione Cerca e sostituisci si attiva dal menu Dati e rimane visibile fino a che non viene chiusa
manualmente. È molto pratica per trovare e cambiare testi in modo facile e veloce nella tabella. Da
non confondere con il comando Rinomina (solo nel piano Advanced), che invece cambia il nome di un
conto, un codice IVA o altro in tutto il file.

10. Le finestre informative
È la zona posizionata nella parte inferiore dello schermo, dove vengono visualizzate le informazioni
utili per operare, relative alla tabella e alla casella in cui ci si trova. Questa zona si suddivide in tre
finestre molto utili che danno informazioni immediate:

la finestra Info segnala i contenuti della riga e cella in cui ci si trova (esempio nome e saldo del
conto, codice IVA e descrizione del codice utilizzato).
la finestra Messaggi, segnala i messaggi di errore.
la finestra Grafici, visualizza il grafico dei contenuti della cella o riga in cui ci si trova (per
esempio se ci si posiziona su un conto, appare il grafico con l'andamento del conto).

Passa da una finestra all'altra semplicemente toccando con il mouse il nome della finestra.

La finestra Info

La finestra Info indica le informazioni riguardanti la cella e la riga in cui ci si trova: i nomi e i codici dei
conti interessati alla registrazione, gli importi e i saldi residui. Quando vi è un errore, qua viene
visualizzata la differenza in rosso.

http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
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Cliccando sul simbolo del punto interrogativo si accede alla pagina dove viene spiegato
l'errore.

La finestra Messaggi

Quando il programma riscontra degli errori, compare una finestra di dialogo che li segnala:

Premi OK per visualizzare ogni singolo messaggio.
Vistando Non segnalare, tutti i messaggi di errore vengono salvati nella finestra Messaggi di
errore.
Se premi Aiuto vai alla pagina di spiegazione dell'errore con possibili soluzioni (Aiuto
contestuale).

La finestra Messaggi contiene un elenco degli errori che sono stati segnalati dal programma.

Dalla finestra Messaggi, con un doppio clic sul messaggio di errore, passi alla riga che ha
generato l’errore.

Con un click sul simbolo  del punto interrogativo accedi alla pagina di spiegazione del
messaggio.
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La finestra Grafici

Selezionando un conto o un gruppo, ottieni il grafico nella finestra Grafici in basso. Il grafico ti
fornisce immediatamente l'andamento della situazione, anche con il confronto tra previsione e
situazione reale. Hai una visione immediata nel tempo senza dover consultare gli importi.
Con il piano Advanced  di Banana Contabilità Plus è ora possibile anche copiare, esportare e
stampare i grafici, nonché copiare nella clipboard i dati che hanno determinato il grafico. Maggiori
informazioni alla pagina dei Grafici.

11. La barra di stato
Si trova alla base della finestra del programma e contiene le seguenti informazioni:

Numero di riga della cella selezionata/Numero di righe della tabella
Se il Filtro è attivo viene anche indicato il numero delle righe visibili
Se si selezionano più celle numeriche o di tipo contatore tempo, si ottiene:

Conteggio: numero di celle selezionate contenenti numeri.
Somma: somma dei valori delle celle selezionate.
Se per esempio si selezionano 3 celle numeriche (1'500 + 1'500 + 1'800) e  nella barra di
stato viene riportato il totale 4'800.

Zoom
Per ingrandire o diminuire la dimensione delle tabelle.
Per cambiare la dimensione del testo dei menu, usa le impostazioni del tuo sistema operativo.
Vedi anche Opzioni programma. 

http://www.banana.ch/it/advanced
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Inserimento veloce dei dati contabili

In Banana Contabilità Plus diverse funzioni pratiche permettono di velocizzare e automatizzare le
seguenti operazioni:

Inserimento e modifica dati
Controllo e rilevamento di eventuali errori.

Ecco le funzioni più usate per l'inserimento veloce dei dati:

Copia, taglia e incolla dati
Usa queste funzioni per copiare, tagliare e incollare dati da una cella all'altra, da una riga all'altra, da
una tabella all'altra, da Excel a Banana, ecc. Guarda le funzioni del menu Modifica .

Tasti di immissione e scelta rapida
Puoi velocizzare l'immissione dei tuoi dati con diversi tasti di scelta rapida o inserendo il punto "." che
assume funzioni diverse in base alla colonna in cui ci si trova.

Ecco i più comuni:

Nella colonna Data, il punto "." inserisce la data odierna.
Nella colonna Ora, il punto "." inserisce l'ora attuale (per esempio nel Foglio ore ).
Tasto F4 (o Cmd+4 sui computer Apple) ricopia i dati dalla cella sovrastante.

Trovi la lista completa dei tasti di scelta rapida dal menu Aiuto → Tasti di scelta rapida.

Auto-completamento nello scrivere testi, conti e importi
L'auto-completamento rende molto più facile e veloce l'inserimento dei dati. Appena digiti i primi
caratteri, il programma visualizza i dati già presenti (conti, codici IVA, date o i testi che hai già
inserito) già inseriti in precedenza; basta selezionare il testo desiderato, premere F6 e il programma
inserisce in automatico la registrazione. 
Nel menu Strumenti > Opzioni programma > Editor > Limite righe completamento
automatico, puoi limitare il numero di valori che vengono proposti o anche disattivare la funzionalità.
Puoi usare uno dei seguenti tasti per accettare il valore che viene proposto:

Tasto Enter, accetta la scelta e passa alla prossima cella modificabile, a destra o sotto, secondo
le impostazioni scelte.
Tasto Ctrl+ Freccia giù si accetta il valore scelto e si passa alla cella sottostante.
Tasto Tabulatore, accetta e passa alla cella a destra.
Tasto Maiusc +Tabulatore, accetta e passa alla cella a sinistra.
Tasto F6 (o Cmd+6 per Mac) accetta il testo ed esegue il comando associato (vedi spiegazione
seguente).

http://www.banana.ch/doc/it/node/2558
https://www.banana.ch/it/node/11220


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 75

Attenzione:

Per disattivare l'auto-completamento dell'anno precedente, occorre disattivare l'opzione Smart fill
con registrazioni dell'anno precedente, dal menu File → Proprietà file → Opzioni.

Le registrazioni ricorrenti
Le Registrazioni ricorrenti (menu Azioni), permette di memorizzare in un'apposita tabella le
registrazioni ripetitive e riprenderle in automatico nella tabella Registrazioni quando occorre
nuovamente registrarle (es. affitti, abbonamenti, ecc..).

Importa movimenti da estratti conto
La funzione permette di importare tutti i movimenti da un estratto conto (conto postale, bancario,
carta di credito, PayPal..) nella tabella Registrazioni, evitando si scrivere tutti i dati delle registrazioni
manualmente. Guarda tutte le opzioni disponibili.
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Regole di completamento
Con la funzione Regole di completamento , a partire dalla tabella Registrazioni, puoi creare delle
regole dei movimenti che importi regolarmente dall'estratto conto e memorizzarle nella tabella
Registrazioni ricorrenti; nelle importazioni successive dall'estratto conto, il programma inserisce in
automatico, direttamente nella tabella Registrazioni, le registrazioni con le regole, completando la
contabilità. Guarda anche il nostro video sulle Regole.  

Le Regole sono possibili solo nel piano Advanced .

Calcolatrice integrata
Puoi velocemente inserire delle formule nelle celle non protette, e premendo il tasto Invio, il
programma esegue il calcolo visualizzando il risultato finale. Questa funzione consente di fare calcoli
immediati, e di inserire il risultato finale direttamente nelle celle dove si sta lavorando. La calcolatrice
integrata è presente in tutte le tabelle e in tutte le colonne del tipo Importo.

https://www.banana.ch/doc/it/rules
https://www.banana.ch/it/node/11531
https://www.banana.ch/it/advanced
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Esegui comando (tasto F6)
Alcune colonne sono associate con delle azioni che si attivano con il menu Modifica → Esegui
comando, oppure con il relativo tasto (F6 o Cmd+6 su computer Apple) indicato nella finestra
informativa. Questa funzione permette di riprendere dei dati o delle righe rapidamente senza dover
digitare nuovamente i contenuti. Esempi di azioni:

Colonna Doc: ripresa delle registrazioni ricorrenti o del numero progressivo.
Colonna Descrizione: ripresa dei dati della riga simile.

Testo a capo
Quando il testo di una riga è molto lungo, il comando Calcola altezza riga dal menu Formato,
permette di visualizzarlo completamente, adattando l’altezza della riga. Per maggiori informazioni
guarda la pagina Menu Formato

Ecco le funzioni più usate per il controllo e il rilevamento di eventuali errori:

La colonna Saldo
In Banana Contabilità Plus è stata introdotta la possibilità di attivare, nella tabella Registrazioni, la
colonna Saldo, che verifica in tempo reale la differenza fra i conti Dare e Avere e mostra subito
eventuali differenze.

Guarda il Video sulla colonna Saldo
La pagina della colonna Saldo

Il comando Controlla Contabilità
Il comando Controlla contabilità dal menu Azioni, ricontrolla tutte le operazioni e segnala subito
eventuali errori o differenze.

La tabella Totali
Dalla tabella Totali hai una panoramica sintetica di come va la tua attività, perché mostra i totali dei
gruppi principali e serve per controllare la quadratura contabile. Guarda le spiegazioni sulla tabella
Totali.

Filtra e ordina righe temporaneo
Le funzioni Filtra e ordina righe temporaneo  consentono di ordinare e filtrare temporaneamente le
righe di una tabella, senza modificare il contenuto o l'ordine permanenti della stessa. Sono funzioni
utilissimi per cercare immediatamente dei dati, sia a livello di testi che di importi.
Una volta rimossi i criteri di ordinamento o di filtro, le righe della tabella tornano al loro ordine
originale. Maggiori informazioni...

https://www.banana.ch/it/node/11369
https://www.banana.ch/doc10/it/node/9827
http://www.banana.ch/doc/it/node/10003
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Filtra e Ordina righe temporaneo

Le funzioni Filtra righe e Ordina righe temporaneo di Banana Contabilità Plus consentono di
filtrare e ordinare temporaneamente le righe di una tabella, senza modificarne la disposizione
permanente. Sono funzioni utilissime per cercare immediatamente (e modificare) dei dati, sia testi
che importi.
Una volta rimossi i criteri di ordinamento o di filtro, le righe della tabella tornano al loro ordine
originale.

Per cambiare l'ordine delle righe di una tabella in modo definitivo occorre usare il menu Dati >
comando Ordina Righe.

Le funzioni Filtra righe e Ordina righe temporaneo sono delle nuove
funzionalità. Vi preghiamo di darci il vostro feedback su come migliorarle.
Sono disponibili solo nel piano Advanced di Banana Contabilità Plus .

La funzione Ordina righe temporaneo
Questo strumento permette di ordinare rapidamente il contenuto secondo la colonna dalla quale è
impartita la funzione Ordina:

Clicca con il tasto destro del mouse sull'intestazione della colonna dove hai bisogno di un
ordinamento.
Posizionati sulla piccola freccia e seleziona il criterio di ordinamento ascendente o discendente.

Vantaggi

Puoi ordinare le righe visualizzate, in senso ascendente o discendente, in base alla colonna
desiderata.
A differenza di Excel, quando rimuovi l'ordinamento di visualizzazione, le righe tornano
all'ordine originale senza dover usare il comando Annulla operazione.

Nell'intestazione della colonna scelta per ordinare i dati apparirà una freccia.

http://www.banana.ch/it/advanced
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Nota importante

La funzione Ordina righe temporaneo è diversa dal comando Ordina righe (dal menu Dati):

Ordina righe temporaneo è un ordinamento delle righe a video temporaneo, concepito per
velocizzare la revisione e la modifica dei dati inseriti in precedenza. È possibile rimuovere
facilmente i criteri di ordinamento per tornare all'ordine originale delle righe. Questa funzione è
disponibile solo con il piano Advanced .
Il comando Ordina righe (dal menu Dati)  modifica in modo permanente l'ordine delle righe
della tabella e può essere annullato solo con il comando Annulla. Questo comando è
disponibile per tutti i piani.

La funzione Filtra righe
La funzione Filtra Righe consente di visualizzare solo le righe della tabella che includono la parola
chiave inserita come criterio di ricerca. Comporta un notevole risparmio di tempo per i seguenti
motivi:

Trovi le registrazioni desiderate in pochi secondi.
Puoi modificare direttamente le registrazioni filtrate.
Il filtro è presente in tutte le tabelle (Conti, Registrazioni, Cambi...) e per utilizzarlo è sufficiente
digitare la parola chiave nella casella del filtro.
Puoi facilmente rimuovere il filtro per tornare all'ordine originale delle righe.

Il testo evidenziato in verde è solo a scopo esplicativo; non appare nel software.

Funzioni e sintassi del Filtro

Il filtro consente di trovare le righe semplicemente inserendo un testo come criterio di ricerca.
Quando si inserisce il testo da cercare, il programma filtra tutte le righe che contengono il testo
specificato, separato da spazi.

Ecco alcuni esempi di Filtro:

fattura mario
Mostra le righe che contengono  le parole "mario" e "fattura" in qualsiasi posizione.
mar fat
A seconda del numero di righe presenti, è possibile ottenere lo stesso risultato anche solo
inserendo un testo abbreviato.
"fattura mario"
Ricerca di testo che include spazi: se si inserisce il testo tra virgolette, il programma
considererà il testo come una singola parola.

http://www.banana.ch/it/advanced
http://www.banana.ch/doc/it/node/2676
http://www.banana.ch/doc/it/node/2676
http://www.banana.ch/doc/it/node/2676
http://www.banana.ch/doc/it/node/2676
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"!~Mario"
Normalmente la ricerca include sia maiuscole che minuscole.
È possibile specificare che la ricerca sia solo per le maiuscole o le minuscole inserendo un
carattere speciale.

Caratteri particolari

È possibile utilizzare quasi tutti i caratteri nella ricerca.

Solo il punto esclamativo "!" e la barra verticale "|" all'inizio di una sequenza di testo hanno un
significato particolare.

"|" per indicare OPPURE
Almeno uno degli elementi preceduti da "|" deve essere presente nella riga.
Nel caso seguente, la ricerca visualizzerà le righe che includono "mario" e "fattura" oppure
"parcella".
mario |invoice |parcella
La barra verticale è il carattere Alt-124, Se non lo trovate sulla tastiera cercate con google

"Layout tastiera windows/mac italia/svizzera/usa"  e guardate nella sezione immagini.
Specificatore di comando "!".
Qualsiasi testo preceduto dal punto esclamativo è considerato un comando e ha un significato
particolare.
Ad esempio, per escludere un testo, utilizzare la sequenza di comandi "!-".
mario !-fattura

Sintassi per ricerca avanzata

I criteri di ricerca avanzata sono disponibili unicamente in inglese.
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Menu File

In Banana Contabilità ogni contabilità è salvata su un file separato.
I file di Banana Contabilità sono compatibili con i diversi sistemi operativi e con sistemi di
sincronizzazione.

Nuovo...
Apri...
Chiudi / Chiudi tutto
Proprietà file (Dati base)
Salva/Salva con nome/Salva tutto
Crea dossier Pdf
Esporta file
Imposta pagina
Imposta Logo
Stampa/Anteprima
Crea Pdf...
Spedisci file per email
Apri percorso file
File recenti / preferiti

 Chiudi/Chiudi tutto

Questi  comandi ti permettono di chiudere il file attivo o tutti i file aperti di Banana Contabilità.

http://www.banana.ch/doc/it/node/3909
http://www.banana.ch/doc/it/node/3904
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Crea nuovo file

Per creare un nuovo file si parte dal menu File → Nuovo.

Questo comando apre la finestra per creare un nuovo file. Dalla stessa finestra puoi accedere a tutti i
modelli disponibili. Ti consigliamo di partire da un modello esistente e di personalizzarlo con i tuoi
dati. La finestra che appare dà la possibilità di creare un nuovo file in tre modalità diverse:

Partendo da uno dei nostri Modelli predefiniti1.
Copiare i dati da un file già esistente2.
Partire da un file nuovo vuoto3.

Attenzione: chi ha sottoscritto un abbonamento al Piano Professional di Banana Contabilità Plus, nel
creare il nuovo file, appare il messaggio che c'è il limite di 70 righe di registrazioni. Questo messaggio
può essere ignorato e non apparirà nel momento in cui vengono superate le 70 righe di registrazioni.

 Inizia da un modello
Con questa procedura si crea un nuovo file partendo dai modelli esistenti. Ci sono tanti modelli adatti
per ogni forma giuridica e attività.

Menu File → Nuovo
Scegliere la Nazione/lingua
Scegliere la categoria
Scegliere il tipo di contabilità
Selezionare il modello che più si avvicina alle proprie esigenze.
Cliccando sul file, questo si apre automaticamente e si può salvare con nome.

Tutti i file che hanno le opzioni IVA hanno la tabella Codici IVA aggiornata alle nuove aliquote.
Il piano dei conti può essere adattato alle proprie esigenze (cambiare la descrizione dei conti, inserire
o eliminare dei gruppi, sottogruppi, ecc.).

Si può cercare un modello, inserendo una parola chiave nella casella Filtra per.
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Salva il file con nome

Una volta aperto il modello, salva con nome il file cliccando su File → Salva con nome:

Scegli la cartella di destinazione
Può rilevarsi utile creare una cartella separata per la contabilità e diversa anche per anno, in
modo da poter tenervi all'interno oltre al file della contabilità anche i documenti relativi a
quell'anno. 
Dai un nome al file che contenga il nome della ditta e l'anno contabile (per esempio
ditta_rossi_2018).
Il programma aggiunge l'estensione ".ac2" che contraddistingue i file creati con Banana
Contabilità.

Adatta il modello

Modifica le Proprietà file :1.
Intestazione e periodo contabile.
Indirizzo

Procedi con l'adattamento del Piano dei conti :2.
Inserisci i tuoi conti bancari.
Inserisci o modifica i conti per adattarli alle tue esigenze. 
L'aggiunta e la modifica di conti nel piano contabile può anche essere fatta
successivamente, in base alle necessità che emergono.

Inizia da un tutorial 
Si parte usando dei modelli esistenti, i quali però contengono già dei dati contabili d'esempio al loro
interno. Non per tutti i modelli è disponibile un tutorial.

I file tutorial sono utili per capire come strutturare la contabilità all'interno di un certo modello, i dati
d'esempio inseriti sono solo a scopo dimostrativo e possono essere modificati, cancellati o rimpiazzati
con i propri dati in qualsiasi momento.

Quando selezioni un modello ed esso dispone di un file di tutorial, vicino alla descrizione di dettaglio
del modello appare automaticamente il tasto Crea da Tutorial.

http://www.banana.ch/doc/it/node/3810
http://www.banana.ch/doc/it/node/3900
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 Inizia da un file esistente
Si parte copiando i dati da un file o modello già esistente.

Ci sono diverse modalità per copiare i dati:

Aprire il file che deve servire da modello, tramite il bottone Sfoglia e indicare il percorso dove si
trova il file.
Creare una copia del file aperto, cliccando su File → Salva con nome.
Creare una copia del file aperto dal menu Strumenti → Crea copia File. Nella finestra di
dialogo che appare, scegliere quali dati tenere. Se nessuna delle tre opzioni vengono attivate,
viene creato un file unicamente con il piano contabile.

Salvare il file nella cartella dove si vogliono tenere i dati (di regola nella cartella documenti).
Indicare nel nome del file la ditta e l'anno contabile (per esempio "ditta Rossi 2018.ac2").
Se riprendi una contabilità esistente inserisci nella colonna Apertura anche i saldi iniziali.
Se lavori con una contabilità multi-moneta aggiorna i cambi di apertura.

 Inizia da un file nuovo vuoto
Si parte da zero, pertanto occorre impostare i dati base della contabilità e tutto il piano contabile
(scelta sconsigliata).
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Menu File → Nuovo.
Scegliere la Nazione/ lingua.
Cliccare sul tipo di contabilità desiderata.
In fondo alla lista dei modelli cliccare su Nuovo vuoto.
Impostare i Parametri creazione nuovo file.

Impostare le Proprietà file (Dati base)
Salvare con nome il file
Creare la struttura del piano contabile.

Documenti correlati

Contabilità Entrate uscite e Libro cassa
Contabilità in partita doppia
Contabilità in partita doppia con multi-moneta
Documentazione Utilità.
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Passaggio al nuovo anno 
Quando si passa a un nuovo anno, vi è una procedura automatizzata che crea un nuovo file e riporta i
saldi d'apertura. 

Parametri creazione
Quando il programma crea un file con caratteristiche nuove, si devono impostare i Parametri
creazione nuovo file.
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Parametri creazione nuovo file

Lingua
La lingua che viene usata per creare le intestazioni delle colonne nelle varie tabelle.

Decimali e arrotondamento
Decimali campi importi

Per evitare differenze contabili, il numero dei decimali dei campi importi viene fissato per ogni file. Di
regola, si usano 2 decimali, ma vi sono monete per le quali non si usano decimali e bisogna impostare
0 (zero). Per altre monete che usano più decimali come il Dinaro tunisino o le cripto valute come il
Bitcoin (9 decimali), Ethereum (18 decimali) bisogna indicare il numero appropriato.
Si possono gestire contabilità con importi fino a 27 decimali.

Decimali importi in moneta estera

Se si tratta di una contabilità multi-moneta si deve definire il numero dei decimali per gli importi in
moneta estera. Se per esempio la contabilità è in EUR e si gestiscono criptovalute come l'Ethereum, si
deve inserire 18.
Generalmente, il numero dei decimali non deve essere inferiore a quello dei decimali in moneta base. 

Tipo arrotondamento

È il tipo di arrotondamento applicato per arrotondare importi con decimali che vanno oltre il numero
di decimali fissato.
Nel caso che si abbiano fissati 2 decimali è il tipo usato per arrotondare le cifre oltre i due decimali.
A seconda dei metodi usati, i seguenti importi: 1.005;  1.015; 1.025; 1.035 risulteranno arrotondati in
maniera diversa.

Commerciale/aritmetico (metà su) arrotondato al maggiore: 1.01; 1.02; 1.03;  1.04.
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Di regola in contabilità si usa questo sistema.
Bancario (metà al pari) arrotondato al valore pari più vicino: 1.00; 1.02; 1.02;  1.04).

Funzionalità da includere
Per maggiori informazioni sulle funzioni da includere vedi:

Aggiungi nuove funzionalità.

Colonne indirizzi nella tabella conti

Se si attiva la casella, viene aggiunta nella tabella Conti la vista Indirizzi, in cui è possibile inserire gli
indirizzi dei clienti, dei fornitori o dei soci.

Tabella preventivo

Se si attiva la casella, viene aggiunta la Tabella Preventivo , dove si possono inserire le
registrazioni riguardo le proprie previsioni.

Si possono avere quindi contabilità in diverse lingue e con decimali diversi. Per cambiare la lingua e i
decimali una volta creata la contabilità, bisogna convertire la contabilità cliccando su Strumenti →
Converti in nuovo file .

https://www.banana.ch/doc/it/node/4766/#budget_table
https://www.banana.ch/doc/it/node/4766/#budget_table
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Contabilità in più lingue

Con Banana Contabilità Plus puoi creare dei file di contabilità in diverse lingue e presentare il bilancio
e il conto economico nella lingua che ti serve.
Le lingue disponibili sono: italiano, tedesco, francese, inglese, spagnolo, portoghese, cinese, olandese.

Vedi Piano conti Svizzero PMI completo multilingua .

Le diverse lingue
La lingua del programma
Quella usata per l'interfaccia, menu dialoghi, ecc.
Si può cambiare dal menu Strumenti → Opzioni programma
Riquadri 1 e 3 dell'immagine sopra.
Documentazione in diverse lingue
Hai una documentazione completa in diverse lingue, accessibile facilmente cliccando sul
bottone d'aiuto.
La lingua del file della contabilità
Quando crei il file della contabilità, le colonne sono impostate nella lingua di creazione.
Riquadro 2 dell'immagine sopra.
La lingua dell'intestazione delle colonne e delle tabelle
Puoi cambiarla a tuo piacimento. Per esempio, invece di usare il termine IVA, usare la sigla più
adatta della tua nazione.
Contenuti in qualsiasi lingua
Nelle celle puoi inserire scritte in qualsiasi lingua.
Colonne supplementari per altre lingue
Puoi aggiungere colonne per avere il Bilancio e il Conto economico in diverse lingue. Nella
tabella Registrazioni e in tutte le altre tabelle puoi creare colonne anche per altre lingue.
Viste per le diverse lingue
Passi da una lingua all'altra velocemente e puoi stampare solo nella lingua desiderata.
Report Bilancio e Conto economico nelle diverse lingue
Puoi personalizzare le stampe per visualizzare le colonne che desideri.

https://www.banana.ch/apps/it/node/8017
http://www.banana.ch/doc/it/node/7233
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Cambiare la lingua di creazione del file
Ogni documento su Banana Contabilità Plus è un file distinto. La lingua del file è separata da quella
del programma e viene definita nel momento della creazione del file stesso (menu File → Nuovo).

I nomi e l'intestazione delle colonne sono attribuiti al momento in cui il file viene creato, usando la
lingua della creazione.

Per cambiare la lingua del file e delle colonne, devi creare un nuovo file:

Dal menu Strumenti → Converti in nuovo file.
Nella finestra di dialogo che si apre scegliere la tipologia di file uguale a quella del file esistente
e premere il bottone OK.
Nella finestra successiva scegliere la nuova lingua del file e il tipo di arrotondamento e premere
OK.

Il programma crea un nuovo file identico a quello precedente, con le nuove impostazioni della lingua.
Questo nuovo file deve essere salvato con nome.

Cambiare la lingua corrente del file
La lingua corrente è quella che il programma usa per visualizzare le diciture, come per esempio
"Saldo d'apertura" nella scheda conto o le date nei report. Normalmente è uguale alla lingua di
creazione, ma può essere cambiata nelle Proprietà file → Varia.

Cambiare le intestazioni delle colonne
Puoi adattare l'intestazione delle colonne dal menu Dati →  Disponi colonne .

Aggiungere colonne per diverse lingue
Nella tabella Conti e anche nelle altre tabelle (Registrazioni, Codici IVA) si possono aggiungere delle
colonne supplementari dove inserire la descrizione in altre lingue.

Dal menu Dati →  Disponi colonne →  Aggiungi colonna .
Come nome della colonna utilizzare il nome della lingua (ad esempio tedesco, cinese, ecc.).
Completare per ogni riga la descrizione nella lingua che è stata aggiunta.

http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
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Creare Viste per ciascuna lingua
Crea una vista per ogni lingua per avere delle stampe solo con la lingua desiderata.

Menu Dati → comando Disponi tabelle .
Creare una Vista per ogni lingua .
In ogni tabella si possono avere viste diverse per le diverse lingue o anche viste che includono
le colonne delle diverse lingue.
Personalizzare le stampe nella lingua che serve. Per stampare in diverse lingue, creare una
Personalizzazione di stampa per ogni lingua in modo da non dover cambiare ogni volta le
impostazioni, ma averle già pronte.

Bilancio Abbellito per ciascuna lingua
Una volta aggiunta che la colonna della lingua è stata aggiunta nella tabella Conti, si può visualizzarla
anche nel report del Bilancio. 

Aprire il dialogo Bilancio abbellito con gruppi .
Scegliere la Personalizzazione che si vuole stampare.
Nella sezione Personalizzazione con il comando Duplica Crea una nuova Personalizzazione per la
tua lingua .
Come nome della personalizzazione dare il nome della lingua.
Sezione Colonne:

Bottone Avanzato per le colonne del Bilancio.
Bottone Aggiungi.
Nella sezione della tabella Conti:

Rendere visibile la colonna della lingua che interessa visualizzare.
Nascondere la colonna Descrizione della lingua predefinita.

Ripetere l'operazione anche per le colonne del Conto Economico .
La prossima volta che si apre il Menu Report Bilancio abbellito per gruppi, si avrà la lingua
indicata.
Inserire la personalizzazione nel menu Preferiti .
Così si accede più velocemente al report.

I testi predefiniti del report (data ecc.) sono visualizzati nella lingua corrente della contabilità.
Può essere necessario cambiare di volta in volta la lingua corrente .

Estensioni
Se si hanno delle necessità specifiche in diverse lingue, possono essere programmati come
Estensioni.

http://www.banana.ch/doc/it/node/2719
http://www.banana.ch/doc/it/node/2740
http://www.banana.ch/doc/it/node/2604
http://www.banana.ch/doc/it/node/3314
http://www.banana.ch/doc/it/node/2604
http://www.banana.ch/doc/it/node/2604
http://www.banana.ch/doc/it/node/3920
http://www.banana.ch/doc/it/node/2604
http://www.banana.ch/doc/it/node/2573
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Apri e salva file

Per aprire un file scegli il comando Apri dal menu File, oppure usa l'icona corrispondente nella Barra
degli Strumenti.

Apri file
I dati presenti sul disco sono caricati in memoria, dove possono essere elaborati.

I file di contabilità possono essere aperti se si trovano sul computer locale o sono accessibili
tramite un disco di rete.
Se sono stati scambiati tramite email, bisogna prima spostarli in una cartella del computer.
Solo una persona alla volta può aprire il file in modifica.
Se si fanno modifiche ad un file protetto o già in uso, per salvarle bisogna scegliere un altro
nome di file.
Se il file è protetto da una password viene visualizzato il dialogo inserire password.
Quando l'anno precedente è protetto da password, e si vuole eseguire il comando del Bilancio
abbellito con gruppi, il programma chiederà di inserire la password per l'anno precedente, in
alternativa è necessario uno degli accorgimenti indicati nelle note alla pagina dialogo
inserire password.
Il programma avvisa che il file è stato aperto in modalità di lettura, nei seguenti casi:

Il file si trova su un supporto non riscrivibile (CD-ROM).
Il file si trova su una cartella temporanea non scrivibile.
Il file è protetto in scrittura o l'utente non ha i diritti per modificare il file.
Il file è stato aperto da un altro utente
Il file è già stato aperto dallo stesso utente o in un'altra sessione. 

 Come cercare i file della contabilità *.ac2
Se non ti ricordi in quale cartella si trovano i file contabili, puoi ricorrere alla ricerca di Windows-
Explorer o al Finder per Mac.

Ricerca file di contabilità su computer Windows

I file di Banana Contabilità hanno l'estensione ".ac2". La funzionalità di ricerca varia molto dalle
diverse versioni di Windows.

Windows 10: clicca sull'icona Cerca e inserisci ac2 o l'iniziale del nome del file e poi clicca sulla
freccia Documenti.
Nel File Manager dell'Explorer inserisci l'estensione "*.ac2", oppure, il nome della tua contabilità
e lascia che Windows cerchi il file.
Quando in Banana Contabilità clicchi sul menu File → Apri, inserisci nella casella di ricerca in
alto a destra della finestra di dialogo, l'estensione "*.ac2" e clicca in basso sull'icona Cerca in
tutto il computer o seleziona la cartella dove cercare il file.

Ricerca file di contabilità su computer Mac

In Banana Contabilità, nel dialogo di apertura, File → Apri, nella casella Cerca (in alto a destra)
inserisci "ac2", oppure una parola del nome del file. Tramite le icone, scegli eventualmente
dove cercare (in tutto il computer o nelle cartelle selezionate).
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Apri il Finder e inserisci nella casella di ricerca "ac2" o l'iniziale o una parola del nome del file
che vuoi cercare.
Clicca con il tasto destro sull'icona del Finder, clicca su Cerca e poi inserisci "ac2" o il nome
del file.

 Salva file
Con il comando Salva o Salva con nome, i dati vengono salvati su disco. I dati esistenti su disco
sono rimpiazzati con quelli nuovi.

Solo un utente alla volta può salvare il file.
Il file può essere salvato dall'utente e unicamente questo non viene utilizzato da altri.
I file possono essere salvati dove si vuole.
La destinazione e il nome del file si indicano quando si salva la prima volta o quando si usa il
comando Salva con nome (menu File).
Al primo salvataggio Banana Contabilità propone di salvare i file .ac2 nella cartella Documenti,
ma è possibile inserire una qualsiasi altra cartella.
Se si gestiscono diverse contabilità, consigliamo di creare una cartella separata per ogni ditta
ed eventualmente anche per ogni anno contabile.
Ogni file può essere protetto da password.

Salvataggio automatico
Banana Contabilità crea e salva automaticamente il lavoro in un file temporaneo.  Quando si salva o si
esce normalmente dal programma, questo file temporaneo viene eliminato. Se il computer dovesse
spegnersi improvvisamente, si potranno recuperare i dati tramite questo file. 

Quando il programma viene riaperto dopo un crash e individua che il file del salvataggio automatico
(temporaneo) non è stato cancellato, visualizza un dialogo Recupero file di salvataggio automatico
che chiede all'utente se desidera recuperare il file.

Nelle Opzioni programma è possibile impostare ogni quanti minuti Banana Contabilità deve eseguire il
salvataggio automatico.

File in formato *.ac2
I file creati con Banana Contabilità hanno estensione "*.ac2", indipendentemente dal sistema
operativo usato.
Il formato file "ac2" è specifico di Banana. Al momento del salvataggio tutti i dati vengono
compattati e salvati in blocco.
I file .ac2 sono compatibili fra i diversi sistemi operativi (Windows, Mac e Linux).
Si può salvare un file in Windows, aprirlo e rielaborarlo in Mac, per poi riaprirlo in Linux o
Windows.
Il file può essere trasmesso come allegato per posta elettronica, modificato su altri sistemi
operativi o rinviato al mittente.
I file sono completamente distinti dal programma Banana Contabilità che invece ha estensione
".exe" per Windows.
I file d'installazione hanno estensione ".dmg" per Mac e ".deb, .rmp, .run o .tgz" per Linux.
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Copia o sposta i file
Banana Contabilità è in grado di salvare i file su qualsiasi unità che sia vista dal sistema operativo,
come un disco riscrivibile.
Da unità non riscrivibili (CD o DVD) Banana Contabilità può solo leggere dei file.

I file *.ac2 si possono spostare:

Da una cartella all'altra
Si utilizza Windows Explorer o Finder per Mac per cercare la cartella dove i file sono stati
salvati.
Si copiano e si spostano nella nuova cartella di destinazione (una volta incollati, se
occorre, possono essere cancellati dalla cartella precedente).

Da un computer all'altro
I file si salvano su una penna di memoria e poi sul nuovo computer:

Apri il file da memorizzare.
Dal menu File → Salva con nome, scegli come destinazione l'unità che indica la
memory stick.
La copia può essere effettuata anche avviando Explorer e trascinando il file della
contabilità nell'unità della memory stick.

Tramite invio email (come allegati) e salvati sul nuovo computer.

Cancella o rinomina i file
Il programma Banana Contabilità non ha una funzione di cancellazione o rinomina del file, per farlo si
deve usare la relativa funzione del sistema operativo (Explorer di Windows o Finder in Mac).

Salva i file su DropBox, Google Drive e altri sistemi Cloud
Banana Contabilità Plus non ha un Cloud proprio, ma ti permette di lavorare sul tuo. Il programma
viene installato sul tuo computer e lavora localmente.

Per quanto riguarda i file contabili, questi appartengono esclusivamente a te e li puoi salvare dove
vuoi, anche su sistemi tipo DropBox e Google Drive che mantengono sincronizzati i file con servizi di
archiviazione Cloud. Maggiori informazioni...
Banana Contabilità sovrascrive i file *.ac2 e cancella il file *.ac2.bak. Nell'elenco dei file cancellati si
trovano le versioni precedenti del file *.ac2.bak.

Visualizzazione delle modifiche

Banana Contabilità, versione Android lavora direttamente con il server Dropbox. Se si fanno modifiche
sul pc, normalmente bisogna aspettare qualche secondo prima di vedere le modifiche sul server e
quindi sul file di Banana Contabilità.

Per accertarsi che il file sia correttamente sincronizzato con il server sul proprio computer, il file deve
essere marcato con il visto verde.
Se non si vedono i simboli di sincronizzazione (verde, rosso, blu), bisogna aggiornare l'applicativo
Dropbox installato sul pc.

Un altro sistema per verificare lo stato della sincronizzazione dal proprio pc, è di cliccare sul simbolo
Dropbox nella barra in basso:
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Inoltre, su Android la sincronizzazione non avviene mentre si sta lavorando con l'applicativo. Bisogna
quindi chiudere e riaprire.

Attenzione:

Banana Contabilità non può accorgersi se si aprono e si modificano dei file contemporaneamente su
più computer. Potrebbe quindi succedere che una persona cancelli dei dati o che un'altra ne aggiunga
di nuovi. Viene tenuta solo l'ultima copia del file che è stato salvato. 
Dovete quindi prestare attenzione ad evitare di lavorare contemporaneamente sullo stesso file.

Risorse correlate:

Aprire percorso file
Copiare e spostare i file della contabilità
Backup dei dati
Recuperare file di salvataggio dei dati
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Inserire password

Quando l'utente apre un file protetto da password, viene visualizzata una finestra di dialogo per
immettere la password.

La password del file viene impostata nelle Proprietà file > Password.
Questo dialogo viene visualizzato anche con la prima esecuzione di alcuni comandi, che
richiedono l'accesso a un file protetto da password, ad esempio la contabilità dell'anno
precedente.

NOTA

Quando l'anno precedente è protetto da password, e si vuole eseguire il comando del Bilancio
abbellito con gruppi, oppure riprendere le registrazioni dall'anno precedente, il programma chiederà
di inserire la password per l'anno precedente.

Per evitare che venga richiesto ripetutamente l'inserimento della password è necessario adottare uno
dei seguenti accorgimenti:

Inserire la medesima password anche nel nuovo anno
Salvare il file dopo aver inserito la password per l'anno precedente (la password rimarrà
memorizzata)
Se però si sposta il nuovo anno o l'anno precedente in una nuova cartella sarà necessario
reinserire la password (questo è il caso se si aprono i documenti da cartelle condivise che
possono avere percorsi differenti da computer a computer). Se il file fa riferimento a più anni,
per esempio 2022, 2021, 2020, ... sarà necessario aprire ogni file (dunque 2022, 2021, 2020,
...) e reinserire in ogni anno la password per l'anno precedente (2021, 2020, ...), quindi salvare
ogni file.
Eliminare il collegamento del file anno precedente nelle Proprietà file, dati base > Opzioni > File
anno precedente (questa soluzione è consigliata unicamente se il collegamento all'anno
precedente non è più necessario)
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Backup dei dati

Copie di sicurezza (backup)
Banana Contabilità permette di scegliere il supporto e la directory dove salvare il file della
contabilità.  Puoi organizzare al meglio i tuoi file sul computer locale, quello di rete o il cloud. Non
include un sistema di gestione dei backup.

Vi consigliamo di creare delle copie di backup esterne, per sopperire ad un'eventuale perdita di dati,
dovuta per esempio ad un crash del proprio computer, ad un difetto del disco rigido o altra causa.

Per Mac usare la funzione "Time machine"
Per Windows usare la funzione "Cronologia file".
Dropbox, OneDrive, iCloud, Google Drive offrono la possibilità di mantenere versioni precedenti.

Esistono in commercio anche altri programmi che consentono di creare automaticamente il backup
dei propri dati.

File .bak
Quando si salva, Banana Contabilità sostituisce il contenuto del file esistente con i dati più recenti
della contabilità, unicamente se la procedura di salvataggio va a buon fine: 

I dati sono salvati in un file temporaneo.
I dati salvati su disco sono sostituiti a quelli preesistenti, solo se l'operazione di salvataggio si è
completa in modo corretto.
L'opzione Crea copia di backup (*.bak), dal menu Strumenti → Opzioni programma →
Gestione file, attiva per default,  rinomina il file preesistente con lo stesso nome, e aggiunge
l'estensione ".bak".
Viene creato un nuovo file con il nome "nome file.ac2.bak" che contiene i dati prima del
salvataggio.

Se un file risulta danneggiato, si può recuperare la versione precedente al salvataggio, aprendo il file
.bak per drag and drop o tramite il comando File → Apri.

Recuperare i dati da un file *.bak
Quando per un motivo qualsiasi non si riesce a trovare il file della contabilità, si può recuperare il file
dalla copia di sicurezza che il programma esegue automaticamente.

Come procedere:

Aprire la cartella dove si trova il file della contabilità.
Aprire il file che ha l'estensione .bak. Se non figura nella cartella, occorre selezionare nella
finestra in basso, "Tipo file" Tutti i files (*.*).
Una volta aperto il file, salvare con nome cancellando l'estensione .bak. In genere si attribuisce
lo stesso nome del file perso.
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Salvataggio automatico
Banana Contabilità crea e salva automaticamente il lavoro in un file temporaneo.  Quando si salva o si
esce normalmente dal programma, questo file temporaneo viene eliminato. Se il computer dovesse
spegnersi improvvisamente, si possono Recuperare i dati tramite questo file. 

File .ac2 danneggiati
I computer sono soggetti a difetti dovuti a problemi tecnici o anche a virus. Delle volte i documenti
trasmessi tramite email arrivano danneggiati. È quindi sempre utile avere delle copie di riserva.
Nel caso in cui, i vostri archivi risultino danneggiati a causa di un errore tecnico, il nostro
Supporto può verificare, a pagamento , se si possono recuperare i dati.

https://www.banana.ch/it/support_it
https://www.banana.ch/it/prices
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Recupero file di salvataggio automatico

Questo dialogo appare quando il programma si chiude inaspettatamente e non è stato possibile
salvare le ultime modifiche apportate al file.

Quando il programma viene riaperto, individua che il file del salvataggio automatico (temporaneo)
non sia stato cancellato, e chiede quindi all'utente se desidera aprire il file.

Si può scegliere:

Apri
Il file di autosave viene aperto.
L'utente può verificare i dati recuperati, e decidere se salvare il file mantenendo i dati
recuperati, oppure, chiuderlo mantenere il file originale senza salvare.
In caso di dubbio l'utente può salvare il file sotto un altro nome tramite File → Salva con
nome.
Il file di autosave viene eliminato.

Elimina
Il programma elimina il file di autosave.
Il programma apre il file originale.

Ignora
Il programma mantiene il file di autosave e non apre nessun file.
La volta successiva che si vuole aprire questo file, il programma informa nuovamente
l'utente.

Interruzioni del funzionamento del programma
Se il programma viene chiuso normalmente, chiede se salvare i dati modificati, e il file di autosave
viene cancellato.

Il programma può non chiudersi normalmente per le seguenti ragioni:

Un'interruzione di corrente o di un altro evento che ha portato all'arresto immediato del sistema
operativo.
Un problema che ha portato alla chiusura inaspettata del programma.

Un problema dovuto ad un altro programma o ad una situazione del sistema operativo o
di un driver che ha provocato l'interruzione del programma.
Prova a far ripartire il computer e usare il programma senza l'avvio di altri programmi.

Un difetto al sistema operativo o un programma difettoso può provocare
l'interruzione di Banana Contabilità.

Problema con alcuni computer Dell.
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Un difetto al computer (errore di memoria).
Un virus.

Problema nel funzionamento di Banana Contabilità.
Di solito ripetendo il medesimo comando, si ha sempre un arresto del programma.
Se il programma si arresta in situazioni completamente diverse, è più probabile che il
problema sia dovuto ad un difetto del computer o del sistema operativo (vedi punto
precedente). 

Verifica prima di tutto di avere la versione più recente del programma.
Procedi all'istallazione della nuova versione (se necessario). Il problema potrebbe
nel frattempo essere stato risolto.

Contattare il supporto tecnico
Verificare le modalità per cui il programma si arresta.

È importante capire in quali situazioni il programma si arresta, in modo che i tecnici possano
replicare il problema.
Quando si Contatta il servizio tecnico  è importante:

Descrivere il problema e come lo si può riprodurre.
Inserire i dati del proprio sistema, che possono essere copiati dal menu Strumenti →
Opzioni Programma → Avanzato → Info sistema.
Se il problema si verifica in relazione ad un file, inviare una copia del file, cancellando i
dati confidenziali.

https://www.banana.ch/it/contact_form
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Copia locale di lavoro

Uno dei punti chiave di ogni applicazione Desktop è il salvataggio dei files. Il lavoro dell'utente e i dati
inseriti non devono essere persi. Anche nel caso di un crash del computer, si deve ridurre al minimo la
mole di lavoro persa.

Con Banana Contabilità+ è stata introdotta una nuova strategia per il salvataggio dei files. Dal punto
di vista dell'utente nulla è cambiato, ma internamente sono stati fatti importanti miglioramenti per
rendere il processo di salvataggio dei dati ancora più sicuro e solido, ed ottimizzarlo per l'uso su dischi
cloud e mobile.

Funzionamento
Con la nuova implementazione del processo di salvataggio e recupero files, Banana crea una copia
locale del file aperto e successivamente lavora sulla copia locale presente nel dispositivo (pc, mobile,
tablet) fintanto che l'utente non salvi il documento. A questo punto Banana ritorna e salva le
modifiche nel file sorgente. Nel frattempo Banana salva regolarmente le modifiche apportate al
documento nella copia locale.

Precisamente Banana procede nel seguente modo:

L'utente seleziona un file da aprire (file sorgente).
Banana crea una copia locale del file sorgente.
Banana blocca l'apertura del file sorgente per prevenire modifiche da più utenti.
Banana legge la copia locale.
Banana salva regolarmente  (di default ogni 2 minuti) nella copia locale le modifiche
apportate al documento.
Come l'utente clicca sul bottone Salva, Banana ritorna e salva le modifiche nel file sorgente.
Come il file viene chiuso, Banana sblocca il file sorgente e cancella la copia locale.
Nel caso l'applicazione non riesca a chiudere e salvare correttamente le modifiche nel file
sorgente (interruzione di corrente o altro) la copia locale rimane sul dispositivo e il contenuto
potrà essere recuperato al successivo avvio di Banana.
Nel caso in cui il file non sia temporaneamente accessibile (p.es.: il file risiede su un disco di
rete o su una penna usb disconnessa), l'utente può continuare a lavorare, e le modifiche al
documento vengono salvate nella copia locale fino al momento in cui il file sorgente è di nuovo
accessibile.

La copia locale funziona in pratica sia da documento di lavoro che documento di recupero.

Vantaggi
La funzione di autosave è sempre attiva, per questo motivo il lavoro che potrebbe essere perso (con
le impostazioni di default per il recupero files) corrisponde al massimo al lavoro degli ultimi due
minuti.

L'accesso al file non deve essere continuo. Anche se temporaneamente un file non è
accessibile (p.es.: il file risiede su un disco di rete o su una penna usb disconnessa), l'utente può
continuare a lavorare, e le modifiche al documento vengono salvate nella copia locale fino al
momento in cui il file sorgente è di nuovo accessibile.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 102

La copia locale non viene sincronizzata nel cloud. Per questo motivo, le prestazioni dell'applicazione
risultano migliori e la quantità di dati inviati nel cloud ridotta al minimo.

Questo processo è implementato alla stessa maniera su tutti i sistemi operativi:  Windows, macOS,
iOS, Linux, Android and WebAssembly, indipendentemente dalla posizione in cui il file è salvato.

Recupero dati
Nel caso di una interruzione dell'applicazione, la copia locale rimane sul dispositivo dell'utente. Al
successivo avvio di Banana, l'applicazione avvisa l'utente che sono state trovate delle modifiche non
salvate nel file sorgente.

L'utente ha tre scelte:

Aprire il file recuperato
L'utente può decide se salvare il file recuperato, o abbandonare le modifiche.
Ignorare l'avviso→
L'utente può decidere successivamente cosa fare.
Abbandonare il file recuperato
Il file recuperato viene subito eliminato.

La copia locale rimane sul dispositivo dell'utente finché il documento rimane in uso o le modifiche non
sono state correttamente ritornare al file d'origine. Una volta che il file è stato chiuso la copia locale
viene eliminata.

Le copie locali sono salvate in una cartella nascosta sotto i dati utente del sistema. L'utente non ha
necessità di accedere a questa cartella, l'accesso a questa cartella è sconsigliato. Nel caso in cui il
nostro supporto richiedesse di aprire questa cartella, si può accedere ad essa tramite il menu
Strumenti → Opzioni programma → Avanzato → Info sistema  → Working Copy path → Apri
percorso ...

Cosa non sostituisce
Questa implementazione:

Non sostituisce una buona politica di backup.1.
Non sostituisce un sistema di controllo versioni.2.

Sebbene questa implementazione sia molto sicura e robusta, non possiamo garantire che funzioni al
100% senza intoppi in tutte le casistiche. Per questo motivo, incoraggiamo i nostri clienti ad adottare
una buona politica di backup e un sistema di controllo versioni.

Diversi sistemi operativi mettono a disposizione funzioni di backup e di versioning. Vi chiediamo di
sfogliare la documentazione del vostro sistema operativo.
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Compatibilità file con versioni precedenti

I file di Banana Contabilità sono compatibili con le versioni precedenti a partire dalla version 5.12.
Questo significa che i file possono essere letti e scritti da qualsiasi versione del programma.

Cerchiamo di preservare il più possibile la compatibilità, in modo da poter scambiare file con versioni
diverse del programma.

Le versioni più recenti implementano delle nuove funzionalità, che non sono disponibili in quelle
precedenti. L'utilizzo di queste funzionalità porta all'incompatibilità. Quando si apre il file con
una versione precedente del programma viene segnalato di non usare il file, perché ci
potrebbero essere degli errori nei calcoli e/o delle  perdite di dati.
Le versioni  più recenti offrono dei nuovi applicativi. Questi non possono essere aperti con le
versioni precedenti.

Qui di seguito presentiamo l'elenco delle modifiche che portano a delle incompatibilità. Se si
utilizzano queste funzionalità è necessario aggiornare il programma alla nuova versione.

Versione 10 (BananaPlus 2020)
Utilizzo della nuova colonna Collegamenti.
La nuova versione introduce la possibile di collegare un documento in ogni riga di qualsiasi
tabella, tramite il menu Dati → Collegamenti.
Nelle versioni precedenti, questa possibilità esisteva solo nella tabella Registrazioni. La
possibilità di aggiungere collegamenti in ogni tabella è una funzionalità molto richiesta dagli
utenti; purtroppo non è stato possibile implementarla, mantenendo la compatibilità dei file
creati con le versioni precedenti. Se si usano dei collegamenti, i file non sono più compatibili
con le versioni precedenti.
Nella nuova versione, quando il file viene aperto, in ogni tabella viene aggiunta una colonna
Collegamento.
I dati contenuti nella colonna DocCollegamento della tabella Registrazioni sono copiati nella
nuova colonna, e la colonna DocCollegamento viene eliminata.
Applicativi Contabilità:

Utilizzo nuova colonna Segmenti.
Utilizzo codice IVA per il Reverse charge.
Utilizzo colonna Pagamenti.
Utilizzo colonna FormulaInizio nella tabella Budget.

Timesheet
Colonne aggiuntive "TimeWork", "TimeAbsence".
Colonne Supplemento.

Applicativo Fatture e Magazzino.
Non sono supportate nelle versioni precedenti.

Versione 9
Applicativi Contabilità:

Tabella Articoli.
Colonne quantità nella tabella Registrazioni.
Conti e codici IVA con descrittivi minuscoli.
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Nuove funzionalità del Bilancio Abbellito con gruppi.
Nuove funzionalità per il comando Archivia PDF.
Nuove funzionalità Stampa.

Applicativo Timesheet
Non è supportato nelle versioni precedenti.

Versione 8
Applicativi Contabilità:

Tabella Budget.
Tabella Documenti.

Applicativo Biblioteca:
Non è supportato nelle versioni precedenti.

Versione 7
Applicativi Contabilità

Modifica IVA Importo base nella tabella Registrazioni.
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Proprietà file (Dati base)

Quando viene creato un nuovo file occorre impostare i dati base che si trovano nel menu File →
Proprietà file.

Le proprietà file (Dati base) variano a dipendenza della tipologia contabile scelta.

Le informazioni relative alle varie sezioni sono disponibili nelle singole lezioni online, elencate nel
menu di sinistra.
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Contabilità

Si accede a questa sezione tramite il menu File → Proprietà file (Dati base) → sezione
Contabilità.

Intestazione sinistra e intestazione destra

Inserire dei testi liberi, utilizzati per intestare le stampe (sinistra e destra).

Data apertura

È la data d’inizio della contabilità (può anche essere lasciata vuota). Quando nelle registrazioni si
immette una data anteriore alla data di apertura, il programma segnala un messaggio di errore.

Data chiusura

È la data di chiusura della contabilità (può anche essere lasciata vuota). Quando nelle registrazioni si
immette una data posteriore alla data di chiusura, il programma segnala un messaggio di errore.

Moneta Base

È la sigla moneta della contabilità.
Selezionare dalla lista la sigla della moneta con cui viene tenuta la contabilità. Si può anche indicare
una moneta che non è nella lista.
Quando si cambia la sigla della moneta base, il programma inserisce la sigla moneta base nelle
intestazioni delle colonne degli importi in moneta base.

Nelle contabilità multimoneta è obbligatorio specificare la moneta base, che diventa la moneta
funzionale , cioè quella che serve per il calcolo del Bilancio e del Conto economico.
 

https://en.wikipedia.org/wiki/Functional_currency
https://en.wikipedia.org/wiki/Functional_currency
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Cambiare la sigla della moneta Base
Se si cambia la sigla moneta il programma non cambia gli importi esistenti. Si consiglia di cambiare la
sigla moneta solo se nella contabilità non ci sono importi di apertura  e registrazioni.

Contabilità SENZA monete estere

Sostituire la sigla della moneta con la nuova sigla.

Contabilità CON monete estere

Per cambiare la sigla moneta nella contabilità con monete estere seguire la procedura indicata
nell'apposita pagina.
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Opzioni

Si accede a questa sezione tramite il menu File → Proprietà file (Dati base) → sezione Opzioni.

Data registrazione obbligatoria

Quando si attiva questa opzione e si inserisce una registrazione senza data vi è una segnalazione di
errore.

Ricalcolare i totali manualmente (F9)

Se si attiva la casella, il ricalcolo dei gruppi principali della contabilità non si effettua
automaticamente, ma con l’uso del tasto F9.

File anno precedente

Con il comando Sfoglia si può selezionare il file dell’anno precedente.

Se il file contabile è collegato al file dell'anno precedente, protetto da password, con la prima
esecuzione di alcuni comandi (ad esempio il Bilancio abbellito con gruppi) viene richiesto di inserire la
password. Verrà visualizzato un dialogo per l'inserimento della password.

Smart fill con registrazioni dell'anno precedente

Attivando questa funzione, il programma tiene in memoria le registrazioni dell’anno precedente, e li
ripropone nello Smart Fill, durante l’immissione delle nuove registrazioni.

Usa il segno meno (-) come separatore dei segmenti

Quando questa funzione è attiva, i segmenti devono essere registrati, nella tabella Registrazioni, con
il segno meno (-) davanti al codice del segmento.
Disattivando questa funzione, i segmenti devono essere registrati con i due punti (:), come nel piano
contabile. I due punti devono sempre precedere il codice del segmento. 
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Registra (+/-) i centri di costo come la categoria

Questa funzione è attiva solo nella Contabilità Entrate e Uscite e nel Cash Manager. Vistando la
casella l’importo è registrato nel centro di costo (in positivo o negativo) come la categoria.
Se invece questa opzione non è attiva, per registrare in negativo occorre far precedere il centro di
costo dal segno meno (-CC).

Documento correlato: Immissione, modifica testi e smart fill
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Indirizzo

Si accede a questa sezione tramite il menu File → Proprietà file (Dati base) → sezione Indirizzo.
In questa sezione è possibile immettere i dati riguardanti la società o della persona di cui viene
gestita la contabilità.
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Moneta estera

Si accede a questa sezione tramite il menu File → Proprietà file (Dati base) → sezione Moneta
estera.

Le spiegazioni di questa sezione sono disponibili alla pagina Iniziare una contabilità multi-moneta.
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IVA

Si accede a questa sezione tramite il menu File → Proprietà file (Dati base) → sezione IVA.

Le spiegazioni di questa sezione sono disponibili alla pagina Proprietà file (IVA).
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Varia

Si accede a questa sezione tramite il menu File → Proprietà file (Dati base) → sezione Varia.

Lingua corrente

Vi sono testi propri del file che il programma genera automaticamente (p.es. le righe della tabella
Totali, i movimenti della scheda conto, la stampa abbellita dei bilanci); in questa sezione è possibile
indicare la lingua di tali testi (di solito è la stessa della lingua di creazione).

Lingua di creazione

È la lingua scelta e selezionata alla creazione del file contabile e viene utilizzata nell’intestazione delle
colonne. Se si desidera cambiare la lingua di creazione è necessario convertire il proprio file in uno
nuovo tramite il menu Strumenti → Converti in nuovo file.

Estensioni

È possibile indicare delle estensioni di Banana Contabilità. Quando il file viene aperto, il programma
istallerà le estensioni in automatico.  Da usare per dei modelli o file che sono abbinati a delle
estensioni. Altre persone che useranno il file si troveranno i comandi per installare il programma.

L'elenco mostra tutte le estensioni che si possono installare.

Parole chiavi estensioni

Inserire una parola chiave contenuta nell'estensione di Banana Contabilità. Solitamente queste parole
chiave, sono specificate nelle istruzioni di installazione delle estensioni; la maggior parte delle
estensioni non utilizza le parole chiave per limitare la visualizzazione a determinati files.

Se uno script ha definito l'attributo @docproperties, il comando risulterà visibile nel menu Extensions
solo per quei files di Banana che hanno impostata la stessa parola chiave nel campo Estensioni. Per
impostare più parole chiave, separarle con il ; (esempio: datev; patriziati).
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Password

Si accede a questa sezione tramite il menu File > Proprietà file (Dati base) > sezione Password.
Si può impostare una password di accesso al file contabile.

I file possono essere protetti con una parola chiave (password).

Inserire una password in un file senza password
Conferma vecchia password

Lasciare vuota la casella.

Nuova password

Inserire la password.

Conferma nuova password

Inserire la stessa password inserita nella casella Nuova password.

Cambiare una password esistente
Inserire la password esistente.
Indicare due volte la nuova password.
Dare l'OK.

Compatibilità password con versioni precedenti
Attivare questa opzione se si vuole che la password sia compatibile con le versione precedenti di
Banana Contabilità.
Opzione sconsigliata perché la password è salvata in una modalità meno sicura.
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Cancellare una password
Inserire la password esistente.
Lasciare vuote le caselle della nuova password.
Dare l'OK.

Password dimenticata
Per le informazioni inerenti alla password dimenticata, consultare le informazioni Domande e riposte,
paragrafo Sblocco password .

Nota

Con la password non si raggiunge un alto livello di protezione. Per rendere i dati veramente
inaccessibili a terzi, bisogna munirsi di un software apposito di criptografazione.

https://www.banana.ch/it/node/9340
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Testi

Si accede a questa sezione tramite il menu File → Proprietà file (Dati base) → sezione Testi.

In questa sezione si possono aggiungere delle chiavi per salvare informazioni extra ( per esempio il
nome del commercialista che ha verificato le registrazioni). Queste chiavi ed i conseguenti testi
possono essere ripresi ed utilizzati negli script.

Chiave

Inserire il testo di riferimento (es. Commercialista responsabile della contabilità).

Valore

Inserire il valore relativo alla chiave (es. Paolo Rossi).

Aggiungi

Il pulsante salva i nuovi dati immessi.

Elimina

Il pulsante elimina la Chiave selezionata.
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Crea PDF

Il comando Crea PDFsi attiva dal menu File > Crea PDF e stampa in PDF tutto quello che vedi a
video.

Esiste anche un altro comando, dal menu File > Crea dossier PDF , che dà invece la possibilità di
scegliere quali contenuti del file di Banana Contabilità Plus  includere nel Pdf.

Opzioni salvataggio

Disponibile in Banana Contabilità Plus solo con il piano Advanced. Guarda tutte le funzioni
del Advanced . Passa ora al piano Advanced !

Includi allegati

Salva all'interno del file pdf gli allegati indicati nella colonna Link.  

Questa opzione è unicamente visibile se si sono indicati nelle colonne di collegamento/Link.
Per motivi di sicurezza, vengono solo inclusi i file che si trovano nella stessa cartella del file di
contabilità o in una sottocartella. 
Nel file PDF creato viene inserito un simbolo in corrispondenza dell'allegato. 
All'interno del lettore PDF cliccando sul simbolo l'allegato viene aperto e visualizzato. 
Però, solo i lettori PDF avanzati (come Adobe Acrobat Reader, Fox-it) offrono però questa
funzionalità.  
Diversi lettori PDF e in particolare quelli contenuti nei browser non offrono la possibilità di di
aprire dei file allegati. 

Note tecniche

In anteprima di stampa e stampa (stampante fisica e stampante virtuale pdf del sistema
operativo) sono possibili tutti i fonts supportati dal sistema operativo.
In Windows, nell'esportazione pdf, sono supportati solo i fonts TrueType che hanno la

http://www.banana.ch/doc/it/node/2124
http://www.banana.ch/doc/it/node/2124
https://www.banana.c/it/advanced
https://www.banana.c/it/advanced
https://www.banana.c/it/advanced
https://www.banana.ch/it/upgrade
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mappatura Unicode cmap e che contengono le seguenti tabelle "OS/2", "cmap", "cvt ", "fpgm",
"glyf", "head", "hhea", "hmtx", "loca", "maxp", "name", "post", "prep".
Se il programma non riesce a caricare il font indicato, lo sostituisce con uno di default
(Helvetica o Arial a dipendenza del sistema operativo) e all'utente vene visualizzato il
messaggio impossibile creare font PDF .

 

https://www.banana.ch/doc/it/appmsg_it_err_fontsostituitoinpdf
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Esporta File

Dal menu File > Esporta file si possono esportare più tabelle contemporaneamente.
Nel dialogo Esporta file sono usate anche le seguenti sezioni:

Quelle specifiche al tipo di file (vedi formati d'esportazione).
Includi - per definire le tabelle e i report che devono essere inclusi nell'esportazione.
Periodo - (Contabilità) per definire il periodo.
IVA - (Contabilità con IVA).
Personalizzazione.

Vedi anche
Esporta righe

Formati esportazione
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Stampe/Anteprima

Stampa tutto ciò che vedi sullo schermo
Oltre ai diversi report disponibili, Banana Contabilità ti permette di stampare tutto ciò che vedi sullo
schermo, semplicemente cliccando sul menu File > Stampa.

Finestra Anteprima

Tutte le stampe dei vari documenti contabili e delle fatture possono essere salvati nel formato PDF,
Html, MS Excel e copiati negli appunti, permettendo di accedere anche a distanza di tempo.

Stampa
Il pulsante richiama la finestra Impostazione Stampante di Windows: le scelte effettuate sono valide
solo per la sessione attuale; le modifiche permanenti devono essere inserite tramite il pannello di
controllo di Windows.

La stampa orizzontale o verticale e altri parametri di stampa della tabella devono essere impostati
tramite il comando Imposta Pagina e sono diversi per ogni Vista.

Stampa solo celle selezionate

Quando nella tabella si ha una selezione di celle, l'opzione Selezione risulta attivata e l'anteprima e
la stampa riguardano solo le celle selezionate. Per stampare tutta la tabella, disattivare l'opzione
Selezione.

 Dimensione pagina

La dimensione pagina viene ripresa dalle preferenze della stampante. Per modificare o correggere la
dimensione pagina andare nelle preferenze della stampa e selezionare il formato desiderato (p.es.
A4). Se hai già selezionato questo formato (A4), lo devi selezionare nuovamente per correggere la
dimensione della pagina.
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Esportazione in altri formati
La stampa può essere esportata in diversi formati:

PDF
Il formato che mantiene le caratteristiche della stampa. 
Html / Excel / Latex
Dei formati per riprendere i dati in altri programmi. 

Bottone Copia negli appunti
Tutto il report è copiato negli appunti, così puoi incollarlo in Excel o in altri programmi, in questi
formati:

Testo
Html (con stili di formattazione).
 

Impostazioni stampa
Cliccando sulla Rotellina Dentata nella barra dei comandi si accede:

Se è una tabella, al dialogo impostazione della stampa.
Se è un report, al  dialogo specifico del report.

Puoi anche modificare la numerazione delle pagine.

Problematiche stampa
Se la visualizzazione dell'anteprima è lenta, è dovuta al fatto che la stampante predefinita non è
disponibile.
È importante usare il driver della stampante aggiornato.

Stampe contabili
Le spiegazioni delle stampe si trovano alle pagine seguenti:

Contabilità in partita doppia
Contabilità multi-moneta
Contabilità entrate / uscite
Cash Manager
Rendiconto IVA
Formulario IVA Svizzera

https://www.banana.ch/area/it/node/10501
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Imposta pagina

Puoi accedere alle proprietà di Stampa e Anteprima tramite il menu File > Impostazioni pagina.
Ogni Vista della tabella ha una propria impostazione di stampa. Il nome della vista è indicato nel titolo
del dialogo.

Intestazione sinistra

Viene visualizzato il titolo della vista attiva. Il titolo è modificabile ed appare in alto a sinistra nella
pagina di stampa.

Intestazione destra

È possibile inserire un testo diverso che viene stampato nella parte in alto a destra della pagina di
stampa. 

Logo

Permette di aggiungere un logo:

Clicca sul bottone Cambia a destra della casella Logo, per acedere al dialogo Formati logo.
Clicca sul bottone Aggiungi; inserisci il tuo logo.
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Dal menu File > Imposta pagina, al posto di nessuno seleziona il logo.
Conferma con il bottone OK.

Maggiori dettagli per inserire un logo sono disponibili alla pagina Imposta logo.
 

Margini

In quest’area si possono impostare i margini della pagina di stampa: Sinistra, Destra, Alto, Basso.
L’unità di misura è il centimetro.

Adatta all'area di stampa

Questa funzione permette di adattare l'area di stampa quando la stampa supera i margini della
pagina già impostati.

Includi in stampa

Se le funzioni vengono attivate permettono di visualizzare i seguenti dati:

Intestazioni file

È il testo immesso nelle Proprietà File, del menu File.

Intestazioni pagina

Nella stampa viene inclusa anche l'intestazione della pagina.

Nome tabella

Nella stampa viene inclusa l'intestazione della tabella (es. Conti, Registrazioni, ecc...).                       

Intestazioni colonne

Permette di visualizzare le varie colonne della tabella.

Carattere grande

La stampa dell'intestazione avviene usando dei caratteri leggermente più grandi.

Cambio pagina

Se attivata, la funzione tiene conto dei salti pagina inseriti, altrimenti vengono ignorati, anche se
presenti.

Numeri pagina

Serve a numerare le pagine.

Stampa ora

Consente di stampare l’ora.
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Stampa data

Consente di stampare la data.

Numeri riga

Si attiva per dotare ogni riga di un numero progressivo.

Griglia

Si può stampare la griglia come nella visualizzazione.

Allegati (piano Advanced)

Nel caso di esportazione in PDF, i documenti digitali collegati alle righe di registrazione, vengono
integrati nel file PDF come allegati. 

Layout

Il programma adatta in automatico la dimensione della pagina.

Zoom %

Consente di aumentare o diminuire, in base alla percentuale, la dimensione dei caratteri da stampare.

Riduci alla larghezza

Se alcune colonne oltrepassano la larghezza del foglio, il programma ridimensiona le colonne o riduce
lo zoom in modo che tutte le colonne vengano stampate correttamente sul foglio.

Come a video

La stampa viene effettuata esattamente come si presenta a video.

Se il contenuto va oltre la dimensione della pagina:

Se è attivata l'opzione "Riduci alla larghezza", verrà ridotta la dimensione del font.
Se non è attivata l'opzione "Riduci alla larghezza", la parte fuori dal foglio non verrà stampata.

Stampa in bianco e nero

La stampa viene effettuata convertendo i colori in scala di grigi.

Stampa pagina orizzontale

Per stampare il foglio in orizzontale.
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Anteprima di stampa Esporta PDF

Questa finestra di dialogo viene visualizzata dall'anteprima di stampa quando occorre esportare in
PDF.

Per esportare delle fatture in PDF :

Dal menu Report > Clienti > Stampa fatture
Indica le fatture da stampare (es. 1-10)
Conferma con OK
Dall'anteprima di stampa clicca sull'icona PDF.

Nome File / Cartella

Inserire il nome al nuovo file da creare o sceglierne uno esistente tramite il tasto Sfoglia. Se l'opzione
File separati è attiva, inserire il nome della cartella in cui salvare i file e controllare che non ci
siano spazi vuoti alla fine del nome della cartella.

Opzioni salvataggio (piano Advanced )

Includi allegati (solo PDF)

Questa opzione salva gli allegati all'interno del file PDF. Gli allegati sono file locali che sono stati
inseriti come collegamenti digitali.

Questa opzione è unicamente visibile se i documenti contengono dei Link.
Nel file PDF creato viene inserito un simbolo in corrispondenza degli allegati; cliccando sul
simbolo l'allegato viene aperto e visualizzato.
Vengono esportati solo gli allegati contenuti nella stessa cartella dove si trova il file della
contabilità o in una sotto-cartella. Per gli allegati che sono in altre cartelle viene segnalato un
messaggio "access denied".

https://www.banana.ch/it/upgrade
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Questo limitazione è fatta per evitare che inserendo un link a un file di sistema o confidenziale,
che si trova in una cartella qualsiasi, venga inavvertitamente esportato nel PDF. 
Si consiglia pertanto di salvare i documenti allegati in una sotto cartella della contabilità.
File con percorsi assoluti non vengono esportati. 

Lettori PDF

Solo alcuni lettori avanzati come Adobe Acrobat Reader e Fox it permettono di visualizzare i file
allegati. 
Altri lettori PDF, come quelli contenuti nel browser, non permettono di visualizzare gli allegati. 

Maggiori informazioni alla pagina Crea file PDF con allegati digitali.

File separati (solo PDF)

L'opzione crea dei file PDF separati per ogni singola fattura, quando vengono stampate più fatture o
gli estratti dei clienti. Per maggiori informazioni guarda il paragrafo dedicato qui di seguito.

Visualizza file immediatamente

Questa opzione, se attivata, apre immediatamente il file dopo la sua creazione, visualizzando il
risultato dell’esportazione.

Stampa fatture o estratti clienti in PDF separati
Questa funzione permette di stampare diverse fatture o estratti cliente con un'unica operazione
ottenendo dei file PDF separati, con un conseguente notevole risparmio di tempo.

Per utilizzare la funzione è necessario scaricare l'ultima versione di Banana
Contabilità Plus .
È disponibile unicamente con il piano Advanced di Banana Contabilità Plus . 

 
Nella stampa di file separati puoi personalizzare alcuni dati:

Puoi indicare il nome del file da usare.

https://www.banana.ch/it/download
https://www.banana.ch/it/download
https://www.banana.ch/it/buy
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Puoi usare delle variabili che riprendono delle informazioni sui singoli documenti, come per
esempio <number> per il numero di documento, o <name> per il nome file di default.

L'elenco completo delle variabili è accessibile cliccando sul simbolo {xy}.
Nella riga sottostante vedi in anteprima il nome del file completo generato dal
programma.

Nel caso in cui un file con lo stesso nome esista già nella cartella indicata, durante il salvataggio
il programma ti chiederà conferma.
Questa opzione è unicamente visibile se nella stampa sono inclusi più documenti. 

Parametri di creazione file PDF

Dimensione pagina

La dimensione della pagina del PDF viene ripresa dalle preferenze della stampante.

Prima di creare i PDF da stampare o inviare per email, verifica che la dimensione della pagina nelle
preferenze di stampa sia impostata sul formato A4.

Formato PDF/A

Il file viene convertito nel formato PDF/A , quindi nello standard di archiviazione, un insieme più
ridotto dello standard PDF. Se si includono determinati elementi, il file PDF non sarà conforme allo
standard PDF/A.  

L'inclusione di allegati di qualsiasi genere è conforme solo nello standard PDF/A-3.
Link a documenti esterni non sono ammessi.

Font

Il programma crea il PDF usando i font specificati dall'utente. Se vi fossero problemi di leggibilità
oppure la ricerca all'interno del PDF non funziona, puoi disabilitare i caratteri True Type dal menu
Strumenti > Opzioni Programma > Avanzato > Caratteri True Type. 

https://en.wikipedia.org/wiki/PDF/A
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Anteprima di stampa Esporta Html/Excel

Nel comando esporta puoi scegliere di esportare nel formato: 

Html
È il formato per le pagine internet e ti permette di visualizzare il documento all'interno del
browser. 
Il formato html ha una logica diverso da quella della stampa e quindi apparirà in modo diverso
rispetto all'anteprima.  
Excel
Crea un file con il contenuto html, però con l'estensione xls. 
Il file verrà aperto da Excel e convertito automaticamente. Excel però avvisa che il file non è un
file Excel effettivo, rispondere semplicemente di continuare.
In questo modo avrai i dati dell'anteprima anche in Excel.
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Numerazione pagine Anteprima di stampa

Si accede alla numerazione pagine dall'icona  che appare nella toolbar dell'anteprima di stampa.

In questo dialogo è possibile definire il numero con cui iniziare la numerazione delle pagine, e il
prefisso da inserire nella numerazione. La stampa del numero di pagina va attivata o disattivata
tramite le impostazioni della pagina o del report visualizzato.

Inizia con

Il numero iniziale con cui iniziare la numerazione delle pagine.

Aggiungi prefisso

Il prefisso da inserire al numero di pagina.
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Crea dossier PDF

L'esportazione in PDF è una delle esportazioni più utilizzate. Banana Contabilità Plus permette di
esportare in PDF tutto il file contabile, inclusi i Report.

Novità! È ora anche possibile esportare in PDF includendo anche tutti gli allegati digitali
(giustificativi). 

L'esportazione in PDF con allegati digitali è disponibile in Banana Contabilità Plus solo con
il piano Advanced . 

Per i report inclusi nell'esportazione del dossier PDF vengono riprese le impostazioni definite tramite i
comandi del menu Report. Se desideri cambiare alcune impostazioni devi quindi accedere al menu
Report.

Per creare un dossier PDF scegli dal menu File > Crea dossier PDF (o clicca l'apposita icona dalla
Barra degli Strumenti).

Nome File

Inserisci il nome del file nuovo da creare o scegline uno esistente tramite il tasto Sfoglia (il
programma riscriverà il file esistente con i nuovi dati).

Visualizza file immediatamente

Viene lanciato il programma per la visualizzazione dell’archivio PDF appena creato. In questo modo si
vede immediatamente il risultato dell’esportazione. È bene ricordarsi che i browser come Mozilla e
MS-Explorer usano un meccanismo di cache dei documenti. Quando si effettua l’esportazione una
seconda volta è possibile che si veda ancora la versione precedente se non si preme sul bottone
Aggiorna del browser.

Opzioni creazione file

https://www.banana.ch/it/buy
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Intestazione 1, Intestazione 2, Intestazione 3

Si possono inserire fino a tre intestazioni diverse che figureranno nel file in PDF.

Logo

Se nel menu File > Imposta logo hai impostato il tuo logo, puoi scegliere se visualizzare il logo nel
dossier Pdf o escluderlo.

Nessuno: si esclude il logo
Logo: si include il logo.

Vedi pagina Impostazioni Logo.
 

Opzioni pagina

Attivando le opzioni pagina, è possibile includere:

I numeri di pagina
La numerazione delle pagine con inizio per ogni sezione
La data.

Formato pagina

Si seleziona il formato della pagina.

Opzioni di salvataggio

Includi allegati

Questa opzione se attivata include nel file Pdf della contabilità gli allegati digitali. Vedi paragrafo
successivo Crea file con allegati digitali.

Crea file PDF con allegati digitali
L'opzione di salvataggio Includi allegati permette di includere nell'esportazione PDF della contabilità
con tutti i giustificativi digitali inseriti nella tabella Registrazioni nella colonna Link. Questa
possibilità permette di fatto di avere in un unico file tutta la propria contabilità, i propri report come
Bilancio, Conto economico, ecc. e tutti i giustificativi digitali.

La funzione Includi allegati all'esportazione in PDF è disponibile unicamente con il piano
Advanced di Banana Contabilità Plus .
Guarda tutti i vantaggi del piano Advanced .

https://www.banana.ch/it/buy
https://www.banana.ch/it/buy
https://www.banana.ch/it/advanced
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Maggiori dettagli sulla funzione Includi allegati

Questa funzione permette di salvare gli allegati digitali all'interno del file PDF,  Gli allegati digitali sono
i files locali che sono stati inseriti nella colonna Link. Nel file PDF creato viene inserito un simbolo in
corrispondenza degli allegati; cliccando sul simbolo l'allegato viene aperto e visualizzato. La
possibilità di aprire i files allegati è unicamente disponibile nei lettori PDF come Adobe Acrobat
Reader, Fox it e altri. Se il file viene invece aperto in un browser, potrebbe non essere possibile aprire
gli allegati.

Questa opzione è unicamente visibile se il o i documenti contengono dei Link.

Note tecniche
Per problemi relativi al formato PDF o font vedi pagina Crea PDF.

Altre sezioni
Per le spiegazioni delle altre sezioni consulta le seguenti pagine web:

Includi
Periodo
IVA
Personalizzazione
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Apri percorso file

Il comando Apri percorso file dal menu File consente di aprire il programma di gestione file del
sistema operativo (Windows Explorer, Finder Mac) e visualizzare la cartella dove si trova il file su cui si
sta lavorando.

Per poter rinominare, spostare o cancellare è necessario che il file sia chiuso.

Procedere come segue:

File → Apri percorso file
Visualizzare la cartella dove il file è stato salvato
Procedere con l'azione desiderata (copia, rinomina, sposta file).

Alle volte il file rimane bloccato anche se risulta chiuso. In questi casi è necessario anche uscire dal
programma per sbloccare completamente il file.
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Spedisci file ac2 per email

Per inviare un file di Banana contabilità (.ac2) si può utilizzare il comando dal menu File → Spedisci
file per email.

Scegliendo questo comando, Banana Contabilità apre il programma di posta elettronica del tuo
computer, crea un nuovo messaggio, inserendo come allegato il tuo file .ac2 di Banana Contabilità.

Se dal tuo programma di posta elettronica viene visualizzato un messaggio che ti informa che devi
creare un profilo Microsoft Outlook, devi seguire le informazioni che si trovano al link seguente:

https://support.microsoft.com/it-it/windows/modificare-i-programmi-predefiniti-in-windows-10-e5
d82cad-17d1-c53b-3505-f10a32e1894d

https://support.microsoft.com/it-it/windows/modificare-i-programmi-predefiniti-in-windows-10-e5d82cad-17d1-c53b-3505-f10a32e1894d
https://support.microsoft.com/it-it/windows/modificare-i-programmi-predefiniti-in-windows-10-e5d82cad-17d1-c53b-3505-f10a32e1894d
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Imposta Logo
Imposta Logo

In Banana Contabilità Plus per inserire un logo vai al menu File → Imposta Logo.

Si accede al dialogo Formati logo:

Sezione Opzioni
Si possono inserire immagini, dimensioni e allineamenti del logo e dei testi nell'intestazione.

Logo

Immagine. Ti consente di aggiungere, modificare e eliminare un logo.
Aggiungere un logo:

Inserire un'immagine del logo tramite il bottone Aggiungi.
Si possono aggiungere più immagini.

Modificare o sostituire un logo:
Selezionare un'immagine dalla lista.
Modificare o sostituire l'immagine selezionata tramite il bottone Modifica.

Eliminare un logo:
Selezionare un'immagine dalla lista.
Eliminare l'immagine selezionata tramite il bottone Elimina.

Larghezza.
Inserire la larghezza in centimetri del logo.

Altezza.
Inserire l'altezza in centimetri del logo.

Allineamento.
Selezionare la posizione del logo: sinistra, centro o destra.
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Testo

Quando attivi il campo Testo:
L'intestazione dei vari documenti contabili viene inserita di fianco all'immagine del logo, a
condizione che nelle impostazioni dei report sia attiva l'opzione per la stampa del logo.

Quando disattivi il campo Testo:
Viene semplicemente inserito il logo senza le informazioni delle intestazioni dei report,
sempre a condizione che nelle impostazioni dei report sia attiva l'opzione per la stampa
del logo.

Posizione relativa al logo:
Puoi scegliere dove posizionare il testo rispetto al logo: sotto, sulla sinistra, sopra,
sulla destra.

Allineamento orizzontale:
Puoi scegliere di allineare il testo a sinistra, centro, destra rispetto al logo.

Allineamento verticale:
Puoi scegliere di allineare il testo in alto, centro, basso rispetto al logo.

Dimensione font intestazioni:
Per la stampa dei report o dei documenti contabili, puoi scegliere di impostare la
dimensione del carattere per ogni riga di intestazione.
Per la fatturazione la dimensione del carattere è possibile farla soltanto tramite script.

Sezione Personalizzazione
Tramite questa sezione puoi personalizzare e memorizzare diverse impostazioni del tuo logo e dei
testi.

Puoi scegliere di creare combinazioni di diverse di immagini, posizioni, allineamenti, e memorizzarle
con nomi diversi.

All'occorrenza puoi richiamarle selezionando il nome della personalizzazione desiderata.

Per stampare un bilancio abbellito o una fattura con un logo differente, è necessario creare una nuova
personalizzazione (per esempio il nome Logo_bilancio, questo nome andrà selezionato nelle
impostazioni del bilancio abbellito o inserito manualmente nel campo Nome logo nelle impostazioni
del layout fattura ).

Nome

Il nome della tua personalizzazione (es. Logo1, Logo2,...).

Descrizione

Inserire una descrizione per avere un riferimento delle impostazioni (es. "Logo sinistra, testo
destra",..).

Imposta come predefinito

Con il bottone imposta come predefinito puoi impostare una personalizzazione come predefinita.

Opzioni

Per maggiori informazioni, guardare la pagina della Personalizzazione.

https://www.banana.ch/apps/it/node/9365#intestazione
https://www.banana.ch/apps/it/node/9365#intestazione
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Inserire il logo nelle stampe
Il logo può essere inserito nelle diverse stampe. Cliccando sui link che seguono si accede alle
informazioni di come inserire il logo.

Bilancio abbellito
Bilancio abbellito con gruppi
Fatture:

Nell'intestazione della fattura del layout CH10  e UNI11  tramite il dialogo Impostazioni
fattura → opzione Logo .

Dall'Anteprima di stampa del Bilancio abbellito e del Bilancio abbellito con gruppi si può accedere alle
impostazioni anche del logo, cliccando sull'icona Impostazioni (rotellina dentata).
 

tiziana Mar, 05/29/2018 - 15:37

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#intestazione
https://www.banana.ch/apps/it/node/9365#intestazione
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File recenti e preferiti

I comandi visualizzano la lista dei file usati recentemente e quelli preferiti.

Appaiono anche nella start page.

File recenti
Gli ultimi file usati.

Rimuovere un file recente dalla lista

Per rimuovere un singolo file dalla lista Files recenti o Preferiti (pagina iniziale), occorre posizionarsi
con il cursore sul nome del file, cliccare con il tasto destro del mouse e selezionare Rimuovi (gli
utenti Mac devono utilizzare la combinazione dei tasti Ctrl + il tasto destro del mouse).

Eliminare la lista dei files recenti

cliccare sul menu File → Files recenti → Vuota lista files recenti.

File preferiti
Elenco dei file che si usano regolarmente.

Rendere un file Preferito

Aprire il file desiderato
Cliccare su File → File Preferiti
Cliccare su Aggiungi alla lista.
La lista può comprendere al massimo 16 files.

Modificare la lista dei Preferiti

File → File Preferiti
Modifica lista...
Dalla finestra che appare con i bottoni Aggiungi, Elimina, Apri cartella, modificare i favoriti.
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Menu Modifica

Il menu Modifica contiene una serie di comandi molto utili per la modifica dei dati.

Annulla/Ripristina operazione
Questi semplici comandi permettono di annullare o ripristinare l'ultima operazione fatta. Per
impostare il numero massimo di operazioni annullabili è necessario l'impostazione nel menu
Strumenti > Opzioni programma > Editor > No massimo annulla operazione.

Taglia/Copia/Incolla
Tutte le righe delle tabelle di Banana Contabilità e i dati in esse contenute (tranne i dati nelle tabelle e
celle protette), possono essere copiate, tagliate e incollate esattamente come in Excel.

Selezionare la riga o l’area con i dati da copiare o da tagliare
Dal menu Modifica > Copia o Taglia
Posizionarsi nella riga o nell’area in cui i dati devono essere copiati
Dal menu Modifica > Incolla.

Si possono anche usare le icone  o premendo i tasti Ctrl+C per copiare, Ctrl+X per
tagliare e Ctrl+V per incollare.
Esistono anche i seguenti comandi:

Copia righe, Elimina righe e Incolla righe: in questo caso si riferiscono a delle righe intere e
non ad una selezione di celle. In questo caso non devono essere usati i comandi Copia, Taglia,
Incolla.
Copia Righe copia le celle negli appunti con l'intestazione della colonna, molto utile per
filtrare in Excel.

Seleziona tutto
Questo comando seleziona tutte le righe e colonne della tabella attiva.
Equivale a cliccare in alto a sinistra della tabella.

Ricopia riga da sopra (F4 o Cmd+4)
Questo comando è molto pratico e permette di copiare il contenuto della cella superiore a quella in
cui ci si trova. Applicabile ad una singola cella, diverse celle o un'intera riga.

Esegui comando (F6 o Cmd+6)
Questo comando svolge diverse funzioni a seconda della cella in cui ci si trova. Maggiori informazioni
sono disponibili alla pagina Interfaccia.
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Inserisci righe vuote... (Ctrl e tasto+)
Questo comando inserisce righe vuote al di sopra della riga selezionata:

Posizionarsi con il cursore al di sotto della riga dove si devono inserire le righe vuote
Cliccare sul menu Modifica > Inserisci righe vuote
Nella finestra che appare, digitare il numero di righe da inserire
Confermare con OK.

 Aggiungi righe vuote...
Questo comando inserisce delle righe vuote al di sotto della riga selezionata:

Posizionarsi con il cursore al di sopra della riga dove si devono inserire le righe vuote
Cliccare sul menu Modifica > Aggiungi righe vuote
Nella finestra che appare, digitare il numero di righe da aggiungere
Confermare con OK.

Esiste un altro procedimento per aggiungere delle righe vuote:

Posizionarsi con il cursore al di sopra della riga dove si devono inserire le righe vuote

Dalla barra degli strumenti cliccare sull'icona seguente  tante volte quante righe occorre
aggiungere.
Questa modalità è consigliata quando il numero delle righe da aggiungere è abbastanza
limitato.
La sequenza dei tasti di scelta rapida è: Ctrl+Enter.

Duplica righe...
Questo comando duplica la riga o le righe selezionate.

Dopo la duplicazione le righe rimangono selezionate e possono essere spostate con il comando
Sposta in su e in giù.

Copia righe... (Ctrl+Shift+C) / Copia con intestazione
colonna
Questo comando, copia tutti i dati della riga, comprese le colonne non visibili, in un spazio
temporaneo, così che possono essere riprese con il comando Inserisci righe copiate. 

Inoltre il comando copia i valori delle celle negli appunti/clipboard con l'intestazione delle colonna, che
è molto utile per filtrare i dati in Excel o con altri programmi . Se si sono selezionate solo alcune celle,
copia il contenuto, sempre però con la relativa intestazione della colonna.

L'intestazione colonna permette di elaborare più facilmente i dati in Excel o con altri programmi.

Anche con il Comando Anteprima puoi fare delle copie con l'intestazione.
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 Elimina righe... (Ctrl e tasto -)
Per eliminare una o più righe, si seleziona la riga o le righe da eliminare e si clicca sul menu Modifica
> Elimina righe.

Le righe eliminate vengono copiate e salvate nella memoria e possono essere reinserite con il
comando Inserisci righe copiate.

Questa funzionalità di copiare le righe prima che vengano eliminate è molto utile per funzionare come
con il comando Taglia di un foglio Excel.

Muovi in su (Alt + freccia su) e giù (Alt + freccia giù)

Sposta le righe selezionate in sù e giù di una posizione.

 Proteggi / Sproteggi righe

Dal menu Modifica, con la funzione Proteggi righe, si attiva la protezione delle righe per evitare
che siano modificate per errore.
Le righe protette hanno il numero di riga in grigio chiaro. Non possono essere modificate fino a
quando, con il comando Sproteggi righe viene tolta la protezione.

Per attuare la protezione:

Selezionare le righe che s’intende proteggere
Dal menu Modifica > Proteggi righe
Confermare con OK il numero di righe da proteggere.

Per Sproteggere le righe:

Tutte le righe delle colonne di sistema sono protette e non possono essere sprotette.
Ad esempio, non è possibile sproteggere le righe delle schede conto o le righe dove il programma
esegue dei calcoli automatici.
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Menu Dati

Il menu Dati contiene le seguenti funzionalità:

Trova 
Sostituisci
Rinomina
Collegamenti
Vai a...
Vai alla riga originale 
Estrai e ordina righe 
Ordina righe
Esporta righe... 
Importa righe...
Disponi colonne
Disponi tabelle
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Trova

La funzione Trova si trova cliccando sul menu Dati > Trova. Nella parte inferiore della tabella in cui
ci si trova, appare la sezione dove si trovano le opzioni per la ricerca dei dati.

Trova testo

Inserire il testo o il valore da cercare. Gli importi vanno inseriti senza il separatore delle migliaia.

Solo parole intere

Ricerca solo parole intere: ad esempio, se la parola da cercare è Tot, non troverà Totali.

Maiuscole/Minuscole

Attivando questa opzione, il programma distingue fra lettere maiuscole e lettere minuscole.

Solo zona selezione

Con questa opzione, l’informazione viene ricercata solo nella zona selezionata in precedenza.
Per iniziare la ricerca è necessario fare clic sul pulsante Cerca prossimo. Viene trovata la prima
informazione che corrisponde alla richiesta; per proseguire la ricerca e trovare le corrispondenze
successive, ripetere il comando Cerca prossimo, oppure usare il tasto F3.
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Sostituisci

La funzione Sostituisci, collegata con la funzione Trova, si attiva cliccando sul menu Dati →
Sostituisci. Nella parte inferiore della tabella in cui ci si trova, appare la sezione dove si trovano le
opzioni per la ricerca e la sostituzione dei dati.

Il testo da cercare e il testo da sostituire vanno inseriti nello stesso formato con cui viene visualizzato
nel campo di input. Gli importi vanno inseriti senza il separatore delle migliaia.

Trova testo

Inserire il riferimento da cercare.

Sostituire con

Inserire il nuovo riferimento.

Opzioni

Solo parole intere

Ricerca solo parole intere: ad esempio, se la parola da cercare è Tot, non troverà Totali.

Maiuscole/Minuscole

Attivando questa opzione, il programma distingue fra lettere maiuscole e lettere minuscole.

Solo zona selezione

Con questa opzione, l’informazione viene ricercata solo nella zona selezionata in precedenza.

Sostituisci tutti

Questo tasto esegue la sostituzione di tutti i dati contemporaneamente. Si usa quando occorre
cambiare dei dati che si ripetono nella tabella Conti, Categorie, Registrazioni o Codici IVA (per
esempio il numero di un conto, un codice IVA) si può usare anche la funzione Rinomina.
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Sostituisci

Sostituisce solo un dato alla volta.

Trova tutti

Cerca tutte le informazioni, in base alla parola chiave inserita, e le visualizza nella finestra informativa
in basso.

Trova successivo

Cerca l'informazione successiva.
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Aggiungere collegamenti ad allegati digitali

La funzione di collegare un documento digitale, salvato sul tuo computer o su internet, ad una riga di
registrazione, ti permette di aprire con un semplice click una ricevuta, una fattura o altro documento
direttamente nel file della contabilità. I tuoi documenti saranno sempre a tua disposizione e potrai
dire addio alla carta, passando ad una tenuta contabile completamente digitale.
Vedi anche Organizza al meglio i tuoi file contabili in locale, su rete o Cloud.

La funzione di collegare un documento digitale ad una riga è disponibile in tutte le
tabelle, anche per la tabella Conti, Articoli e altro.
Dall'anteprima di stampa, con l'Esportazione in PDF, il programma ti permette di includere
anche i file dei documenti digitali in PDF collegati. In fase di revisione, il revisore potrà aprire,
nel file della contabilità, anche il documento allegato (fattura, ricevuta, altro documento in
PDF).

Nomi e percorsi dei file 
Quando inserisci un percorso a un file questo può essere di due tipi:

Percorso assoluto
Un nome di file con percorso assoluto o più semplicemente "nome file assoluto", specifica
il percorso completo per accedere a un file, includendo l'unità disco, le cartelle e il nome
del file stesso. 
Descrivono esattamente dove si trova il file nel sistema di file.
Esempi di nomi file assoluti:

"C:/Documenti/Immagini/Foto.jpg" 
"/Documenti/Immagini/Foto.jpg" 

Se la cartella della contabilità viene spostata su un altro computer con un percorso
diverso, il file non verrà trovato.

Percorso relativo alla cartella del file della contabilità (Consigliato)
Per percorso relativo o più semplicemente "nome file relativo" si intendono i nomi dei file
che non sono assoluti, quindi NON iniziano con un "/". 
Per collegamenti con percorsi relativi si intendono relativi alla cartella dove si trova il file
della contabilità. 
I collegamenti rimangono validi anche se le cartelle vengono spostate o sincronizzate su
altri computer che hanno posizioni diverse, purché il file rimanga nella medesima
posizione relativamente al file della contabilità. 
Non include dettagli dell'unità disco o delle cartelle principali. Il nome inizia senza una
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barra.
Se il file è nella stessa cartella risulterà solo il nome del file "fattura.pdf"
Se il file è nella sottocartella "allegati" sarà "allegati/fattura.pdf". 
Se il file è nella cartella superiore sarà "../fattura.pdf".
Il simbolo "../" significa cartella superiore.

"../allegati/fattura.pdf" significa che il file è nella sottocartella "allegati" della
cartella superiore. 
"../../allegati/fattura.pdf" significa che il file è nella sottocartella "allegati" della
cartella di due livelli superiore. 

Errore File non trovato

Se il programma segnala che non trova il file il motivo può essere uno dei seguenti:

Il file è stato cancellato o spostato.
Sono stati copiati o sincronizzati i file su un altro computer e il nome del percorso al file è
assoluto.
Il file della contabilità è stato spostato e i nomi dei file contengono dei file relativi.
Il nome del file contiene dei caratteri non validi su altri sistemi operativi: 

Il programma usa il carattere "/" come separatore di percorso, ma accetta anche il "\".
Non devono contenere caratteri tipo "*"  che non possono essere usati nel nome dei file. 
Bisogna fare attenzione anche a non usare caratteri tipo "*&%" , validi su MAC o Linux,
ma non per Windows. 

Colonna Links
Le colonne DocLink (nella tabella Registrazioni) e Links (in tutte le altre tabelle) permettono di
inserire dei collegamenti a un file PDF esterno (normalmente la scansione di una ricevuta o di una
fattura).

La colonna Links normalmente non è visibile.
Per renderla visibile usa il comando Disponi colonne.
Una volta visualizzata la colonna Links puoi aggiungere il collegamento al documento digitale;
inoltre puoi modificare il nome del file direttamente nella cella dove è stato inserito il link, senza
dover modificare il file nella cartella dove si trova.
È meglio utilizzare nomi di file relativi alla cartella della contabilità (vedi paragrafo
precedente Nomi e percorsi file). 
Nella cella Links puoi inserire diversi tipi di contenuti:

Il nome file relativo o assoluto. 
Un collegamento ad una pagina o un file internet, preceduto dall'indicazione "https://" o
"http://".
Un Url schema personalizzato . 
Un link a una risorsa contenuta nelle risorse del programma, per esempio ":/image.png".
Un link a una risorsa contenuta nella tabella Documenti, per esempio
":documents:doc.pdf".
Un testo che inizia con il punto esclamativo "!", per indicare nell'auto-completamento in
quale percorso cercare i file (vedi paragrafo successivo Auto-completamento nella
colonna Links).
Un testo fra parentesi quadre [ ], che viene usato come ricerca per l'auto-completamento
quando si è in modifica.
Utile quando si creano delle regole  e si vuole indicare il testo per inserire il link e

https://developer.apple.com/documentation/xcode/defining-a-custom-url-scheme-for-your-app
https://www.banana.ch/doc/it/rules
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facilitare la ricerca.
Per aprire il documento collegato, clicca sul menu Dati > Collegamenti > Apri
collegamento, oppure clicca sull'icona che appare nell'angolo in alto a destra della cella
contenente il link.

Inserire un collegamento ad un file
Il link al documento si può inserire in tre modi:

Comando Aggiungi Collegamento

Vai sulla riga della tabella e clicca sul menu  Dati > Collegamenti > Aggiungi
collegamento.
Seleziona il file del documento da collegare e clicca sul bottone Apri (il programma inserisce
automaticamente il collegamento).
Il programma inserisce il percorso al file digitale anche nella colonna Links, anche se questa
non è visibile.
Il percorso del file viene convertito in forma relativa al file della contabilità.

Icona Aggiungi Collegamento

Nella tabella rendi visibile la colonna Links. Vedi: Disponi colonne
Clicca sul piccolo riquadro in alto a destra della cella.

 
Indica il percorso dove si trova il file scelto.

Inserire il nome del file direttamente nella cella

Il nome del file del documento digitale può essere inserito direttamente nella cella della colonna
DocLink, senza dover selezionare il file nella cartella dove si trova.
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Questa modalità ti permette di accelerare maggiormente il lavoro di inserimento.

Vai in modifica nella cella con un doppio clic.
Scrivi il nome del file o inseriscilo con il copia e incolla.
La funzione di auto-completamento elenca i file dei documenti non ancora collegati.
Per avere un elenco dei file disponibili, bisogna inserire almeno il nome di un file con il dialogo
di scelta file.

Auto-completamento nella colonna Links
Quando sei in modifica nella colonna Links il programma ti propone un elenco di file, in base alle
seguenti logiche:

Vengono proposti solo i file la cui estensione è inclusa fra le estensioni sicure.
Il nome del file contiene il testo inserito nell'editor.

Se il testo contiene dei testi separati da uno spazio, tutte i testi devono apparire nel nome
del file.
Se il testo è incluso fra parentesi quadre [ ] viene usato solo il testo senza le parentesi. 

Se il file è già usato nella colonna, non viene riproposto. 
Puoi iniziare con "*" per fare in modo che vengano proposti tutti i file, anche quelli già usati.
In questo modo si possono cercare file che sono già stati inclusi nell'elenco.
File che figurano nelle cartelle di ricerca.
File contenuti nelle cartelle già usate. 
Se si inserisce il file "allegati/fattura.pdf", proporrà i documenti che sono nella sottocartella
"allegati".
File che contengono il testo che stai inserendo.
La cartella non è stata esclusa con i comandi, indicati sotto.
File che non oltrepassano il numero di file previsti dal limite Smartfill.

Nomi speciali per auto-completamento

Puoi modificare la logica di ricerca, inserendo dei nomi di file che iniziano con il punto esclamativo "!".

!-**
Disabilità il completamento automatico e non propone nessun file.
Usare questo comando nel caso in cui, per dei motivi tecnici, l'accesso alle directory risulta
lento.
!allegati
Cerca i file solo nella sottocartella indicata. 
!+allegati
Il segno "+" cerca anche nella cartella indicata.
!-allegati
Il segno "-" esclude la cartella indicata. Ha precedenza sulle altre indicazioni.
Serve per escludere una cartella di un file usato o la cartella del file della contabilità.
Simboli speciali:

!.
Il punto "." indica la cartella dove si trova il file della contabilità.
Per escludere la cartella del file della contabilità, inserire il testo "!-.".
!cartella1*
Il testo "*" alla fine del nome della cartella include anche tutte le sotto cartelle.
Se ci sono molte sottocartelle con tanti file la ricerca può risultare rallentata.
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!*
Include la cartella dove si trova il file della contabilità e tutte le sotto cartelle.
!cartella1;cartella2
il punto e virgola ";" viene usato per inserire più cartelle.
!../cartella1
Il ".." fa riferimento alla cartella di livello superiore.

I testi per l'inclusione o esclusione cartelle per l'auto-completamento:

Devono essere inseriti nella colonna dove si inserisce il link al documento.
Possono essere inseriti in qualsiasi riga.
Determinano la ricerca per tutte le celle, anche quelle che vengono prima.

Modificare il collegamento
Procedi come per l'inserimento di un collegamento.

Rinominare il nome del file e il collegamento
Usa il comando:

Menu > Dati > Rinomina.

Il comando è attivo solo se all'interno della cella c'é un nome di file valido.

Il Rinomina è completamente diverso dal modificare il contenuto della cella, perché il programma
rinomina:

Il nome del file nella cartella in cui è salvato.
Tutti i collegamenti a quel documento nel file della contabilità (solo nel caso in cui le celle non
siano protette o bloccate).

In questo modo puoi modificare i nomi dei file senza dovere aprire il file manager.

La funzione Rinomina dal menu Dati è disponibile in Banana Contabilità Plus solo
con il piano Advanced  > passa ora al piano Advanced .

Aprire il collegamento
Ci sono due modi per aprire il collegamento:

Posizionati sulla riga e clicca su Dati > Collegamenti > Apri collegamento.
Oppure posizionati sulla cella della colonna Link e clicca sull'icona d'apertura.

Per motivi di sicurezza il programma apre solo i file con un'estensione sicura. Per maggiori

https://www.banana.ch/it/advanced
https://www.banana.ch/it/advanced
https://www.banana.ch/it/upgrade
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informazioni vai alla pagina Opzioni programma > sezione Gestione File, dal menu Strumenti.

Cancellare il collegamento
Ci sono due modi per cancellare il collegamento:

Posizionati sulla riga e clicca sul menu Dati > Collegamenti > Cancella collegamento.
Cancella il contenuto della cella Link con il tasto cancella.

Esporta in PDF (Includi allegati)
Quando si esporta in PDF il programma offre la possibilità di includere  anche i file allegati. 

Si rimanda alla documentazione Esporta in PDF per quanto riguarda questa funzionalità e le
limitazioni.

Altre risorse utili:
Creare dossier PDF con documenti digitali
Dove salvare i documenti digitali relativi alla contabilità
Scansiona documenti 
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Vari tipi di documento

Alla base della contabilità ci sono i documenti e giustificativi contabili. Il tipo di organizzazione
contabile dipende dalla dimensione dell'attività, dal volume dei documenti e dalle proprie necessità.

Qui di seguito diamo alcuni consigli organizzativi che riteniamo utili. 

Consigli per un'organizzazione ottimale
È importante distinguere e separare i diversi tipi di documenti:

Documenti di base: contratti d'affitto, d'abbonamento (telefonico), statuti, contratti
d'assicurazione e tutto quanto viene firmato una volta sola e ha rilevanza su più anni.
Questi documenti sono la base della vostra attività, devono essere inseriti in un raccoglitore
separato da custodire con cura.
Per documenti molto importanti (garanzie ricevute, ..) può essere utile fare una fotocopia e
tenere l'originale in una cassetta di sicurezza o in un luogo più sicuro. Non bucate i documenti
importanti ma metteteli in mappette trasparenti.
Documenti base relativi ai dipendenti: contratti di lavoro, assicurazioni del personale e
altro. Da tenere in un raccoglitore a parte.
Se la documentazione tende ad essere voluminosa, si consiglia di utilizzare un raccoglitore per
tematica
Dichiarazioni IVA: è utile tenere un raccoglitore apposito con le varie dichiarazioni che
presentate regolarmente (trimestrali, semestrali, annuali). I documenti relativi all'affiliazione IVA
o altri documenti generali è più utile conservarli insieme ai documenti base.
Giustificativi contabili dell'anno: si tratta di ricevute, fatture o altro che sono legati a una
spesa o a un incasso.
I giustificativi contabili devono essere tenuti in modo separato anno per anno. Per ogni anno
contabile avrete quindi un raccoglitore con i giustificativi contabili.

Giustificativi contabili
Un buon ordine quotidiano è il presupposto per registrare le operazioni contabili e avere sotto
controllo la situazione aziendale, come la liquidità, l'ammontare dei crediti e dei debiti, ecc.

Tutti i giustificativi contabili (ricevute, fatture, scontrini) devono essere conservati di regola per
almeno 10 anni. Ogni anno di regola si crea un nuovo raccoglitore.
Classifica e ordina per data i giustificativi contabili insieme alle relative ricevute bancarie di
pagamento/ bonifico.
Gli estratti conto devono essere tenuti insieme ai giustificativi.
Annota sul giustificativo (estratti e altro) un numero progressivo. Grazie a questo numero, da
inserire nella colonna Doc della tabella Registrazioni di Banana Contabilità Plus, riuscirai a
trovare velocemente il documento contabile partendo dalla contabilità.
Alla fine dell'anno stampa una copia del giornale e conservalo insieme ai giustificativi.

Salvataggio dei documenti in PDF
Tutti i documenti, sia che siano contratti, fatture, giustificativi di cassa, documenti del personale, è
sempre meglio scansionarli e salvarli in PDF. Nell'era digitale, l'uso della carta si è ridotto
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notevolmente e quasi tutta la documentazione è in formato elettronico.

Nei file generati da Banana Contabilità, i documenti digitali, come fatture e giustificativi, possono
essere integrati nella contabilità tramite i collegamenti digitali. Questo consente di avere accesso ai
documenti direttamente nella contabilità, ottimizzando i tempi per la ricerca e la visualizzazione,
facilitando anche il lavoro del revisore che può visionare i documenti immediatamente, senza
richiedere alcun documento.

Come indicato in precedenza, tutti i documenti devono organizzati in modo ordinato e con una
struttura che rispecchi la tematica. Lo stesso vale per i documenti digitali in PDF, che devono essere
archiviati nelle varie cartelle di lavoro, secondo una struttura chiara che consente di accedervi subito
e anche a distanza di anni.

Banana Contabilità a questo proposito, crea un dossier PDF che contiene tutti i dati della contabilità,
compresi i singoli PDF che sono stati collegati nelle registrazioni contabili. 

Per maggiori informazioni sul salvataggio dei file, consultare la pagina Gestione cartelle e file.

Due tipi di gestione contabile
In contabilità ci sono due criteri per registrare le operazioni contabili:

contabilità sull'incassato: le fatture vengono registrate solo al momento del pagamento
(fornitori) e dell'incasso (clienti).
contabilità sul fatturato: le fatture vengono registrate al momento del ricevimento (fatture
dei fornitori) e dell'emissione (fatture ai clienti).

In Svizzera, le piccole imprese non soggette a IVA possono contabilizzare sia con uno o l'altro metodo,
mentre le imprese soggette a IVA devono scegliere un criterio che deve essere autorizzato dall'Ufficio
IVA di Berna. In alcuni casi l'Ufficio IVA può imporre il criterio da utilizzare. Quando viene autorizzato
un determinato criterio non è possibile cambiare, a meno che non venga fatta espressa richiesta
presso le autorità competenti.

Contabilità sull'incassato

I costi e i ricavi vengono rilevati solo al momento in cui le fatture vengono pagate e incassate.

Tieni separate le fatture emesse da quelle che hai ricevuto.1.
Verifica periodicamente le fatture in sospeso da incassare.2.
Appena è trascorso il termine di pagamento invia un sollecito di pagamento.
Non lasciare trascorrere troppo tempo, preoccupati di incassare le fatture non pagate. È
un'attività che richiede tempo, ma è fondamentale.
Una volta che le fatture sono pagate inseriscile insieme ai normali giustificativi.3.

Contabilità sul fatturato

I costi e i ricavi si rilevano al momento in cui si emettono le fatture verso i clienti o si ricevono le
fatture dai fornitori.

Vedi anche:

Tenuta partitario Clienti e Fornitori.
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Tieni separate le fatture emesse da quelle che hai ricevuto.1.
Verifica periodicamente le fatture in sospeso da incassare.2.
Appena è trascorso il termine di pagamento invia un sollecito di pagamento.
Non lasciare trascorrere troppo tempo, preoccupati di incassare le fatture non pagate. È
un'attività che richiede tempo, ma è fondamentale.
Quando registri in contabilità l'emissione della fattura annota sulla fattura l'avvenuta3.
registrazione.
Nella registrazione in Banana Contabilità Plus utilizza la colonna Fattura della tabella
Registrazioni, per inserire il numero di fattura.
Una volta che le fatture sono pagate spostale nella sezione pagate e registrale in contabilità.4.
Quando hai registrato, annota sul documento l'avvenuta registrazione in contabilità (p.es. con
un visto).

Registrazioni / frequenza
È utile registrare la contabilità con una certa frequenza (giornalmente, settimanalmente,
mensilmente).
Consigliamo vivamente di non trascurare le registrazioni contabili per avere i dati sempre
aggiornati e valutare l'andamento della tua attività.
Scorrendo i vari costi puoi renderti facilmente conto delle diverse spese che hai fatto.
La contabilità non si tiene solo per il fisco.

 



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 156

Organizza al meglio i tuoi file contabili in
locale, su rete o cloud

Banana Contabilità Plus non ha un Cloud proprio, ma ti permette di usare il tuo. Viene installato sul
tuo computer e lavora localmente. I file però possono essere salvati dove vuoi, anche su Cloud.
Maggiori informazioni alla pagina Contabilità in Cloud.

I dati salvati in un unico file
I dati della contabilità sono salvati in un file.

I dati di ogni contabilità sono salvati in un file.
Di regola si tiene un file per ogni anno contabile.
Puoi attribuire al tuo file il nome che desideri.
Di regola il nome del file è composto dal nome della ditta e dall'anno contabile, seguito
dall'estensione Banana. Esempio: "ditta-2020.ac2"
Puoi salvare il file nella cartella che desideri,

una cartella locale
una cartella di rete.

Banana Contabilità Plus è come Excel: solo una persona alla volta può lavorare sul medesimo
file.
Fai quindi attenzione che altre persone non stiano lavorando sullo stesso file.
Se lavori su una rete locale di Windows e il file è in uso da parte di qualcun altro riceverai un
messaggio che il file è disponibile solo in lettura.
Per altri sistemi operativi non ci sono messaggi. Bisogna essere prudenti se si lavora in più
persone.
Se due persone lavorano in simultanea sullo stesso file, la persona che salva i dati sovrascrive
quelli precedenti. 

Crea la struttura ideale delle cartelle
Con una struttura appropriata delle cartelle dove salvi i tuoi file contabili e i tuoi documenti digitali ti
risulterà più facile gestirli e condividerli con altri.
Per creare le cartelle devi usare le funzioni messe a disposizione dal tuo sistema operativo (esempio
Explorer o Finder).

Consigli per organizzare al meglio i tuoi file:

Se gestisci più contabilità crea una cartella per ogni società o ente.
Se oltre ai file di contabilità tieni anche dei documenti digitali, crea una cartella separata per
ogni anno contabile. 
Ogni movimento della contabilità può essere collegato al file relativo al giustificativo contabile
digitale.

Salva i giustificativi dell'anno in una sotto cartella dell'anno corrente. In questo modo il
programma crea dei link relativi, che funzionano anche se usi dei file sincronizzati su
computer diversi.

Salva invece in una cartella separata i documenti di base, che non perdono la validità (esempio
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polizze assicurative, contratti di affitto, ...)

Esempio di struttura delle cartelle:

[Nome società] "Ditta"
In questa cartella crea poi le sotto-cartelle per i diversi anni contabili.

Base
Sotto-cartella dove tenere documentazioni o documenti digitalizzati che non perdono mai
la loro validità.
Puoi usare questa cartella anche per mettere il file dei Beni ammortizzabili.
2022
Sotto-cartella dove salvare il file contabile dell'anno corrente (ditta-2022.ac2), altri
documenti pertinenti all'anno corrente e alla fine dell'anno il dossier pdf.

Giustificativi
Sotto-cartella per i documenti elettronici, così che il percorso sia relativo al file della
contabilità e i documenti si aprano con un clic, anche su diversi sistemi operativi,
quando usi dei sistemi di sincronizzazione tipo Dropbox.

2023
Sotto-cartella dove salvare il file dell'anno successivo,

Giustificativi

Lavorare su una rete locale
Se la tua ditta usa una rete locale, puoi creare la struttura delle cartelle nella tua rete locale, in modo
che sia accessibile a più persone.

Sulla rete locale puoi generalmente attribuire anche dei diritti di accesso, quindi limitare il numero di
persone che possono accedere ai dati della contabilità.

Lavorare con sistemi Cloud
Se usi Dropbox, iCloud, OneDrive, GoogleDrive o un altro servizio simile, sul tuo computer verrà
creata una cartella che contiene i dati che sono sincronizzati.

Per poter lavorare su più computer, non dovrai fare altro che creare nella cartella dei dati
sincronizzati una sottocartella con i dati della ditta, usando la struttura indicata nel paragrafo
precedente. In automatico i file della contabilità e dei giustificativi saranno sincronizzati fra i diversi
sistemi.
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Condividere i dati con il tuo commercialista
I sistemi Cloud ti permettono anche di condividere i dati con altri. Devi creare la struttura di cartelle
come indicato sopra all'interno della cartella principale che viene sincronizzata. Usa il comando di
Dropbox per condividere la cartella con il tuo commercialista e questi potrà quindi vedere e
modificare i tuoi file.

Altre risorse utili:

Scansiona giustificativi
Aggiungi allegati digitali



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 159

Documenti di base

Un'organizzazione ottimale dei propri documenti è un elemento fondamentale per qualsiasi attività.
Alla pagina Vari tipi di documenti trovi importanti consigli. Qui di seguito ci soffermiamo sui
documenti base dell'azienda che che continuano ad avere una validità, e che devono quindi essere
conservati per un tempo illimitato.

Eccone qualche esempio:

Contratti per la presa in affitto o la concessione in affitto di un oggetto o di un bene immobile.
Contratti di leasing.
Documenti per l'apertura di un conto bancario.
Contratto d'assicurazione.
Contratto con compagnie telefoniche, gas, elettricità.
Accordo di commercializzazione.
Iscrizione a un servizio internet.
Contratto per l'assunzione di un dipendente.
Contratto d'acquisto di una proprietà immobile (terreno) o mobile (auto).

Regole per la conservazione
In Svizzera i documenti base devono essere custoditi per dieci anni successivi al termine del
contratto, salvo che la legge preveda una scadenza diversa.

Un contratto di affitto quindi deve essere conservato per tutto il periodo di validità del contratto.
Quando il contratto è scaduto, perché l'oggetto non è più in affitto o perché è stato sostituito da un
altro contratto, il documento deve essere archiviato per il tempo di archiviazione fissato dalla legge. 

I termini fissati dalla legge o dal contratto
L'archiviazione dei documenti serve a comprovare l'esistenza o l'inesistenza di un'obbligazione o è
richiesta dalla legge:

Obbligo di conservazione dei libri e documenti contabili. Di regola 10 anni.
Termine di garanzia. Termine entro il quale bisogna segnalare e richiedere la sistemazione dei
difetti.
Termine di prescrizione. Il tempo massimo che la legge prevede per un'azione legale. Il termine
per esempio per richiedere presso il tribunale il pagamento di una fattura scoperta. 
Obblighi derivanti da normative speciali. Per esempio in ambito bancario o del notariato, sono
applicabili prescrizioni specifiche.

Conservazione dei documenti con conservazione illimitata
I documenti devono essere archiviati e custoditi con cura in locali atti a tale scopo.

Devono essere conservati in locali che ne garantiscono la conservazione.
Per documenti importanti, è utile tenere delle copie, magari in formato digitale.
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Raccoglitore "Documenti di base"

Usare un raccoglitore per i "Documenti base".
Si possono eventualmente usare anche delle scatole apposite per l'archiviazione. Importante è
che i documenti siano facilmente reperibili:

Se hai tanti documenti di base è utile separarli secondo la controparte (nome
dell'affittuario, società assicurativa) o per tipologia (contratti assicurativi, bancari).
Inserisci nell'apposita separazione il contratto originale.

Più raccoglitori:
Contratti e altri documenti relativi all'affitto. Per un'immobiliare.
Contratti o documenti relativi all'assunzione di personale.
Puoi anche iniziare con un solo raccoglitore e poi aggiungerne altri.

Sostituzione dei documenti

Se un contratto viene sostituito è necessario tenere il contratto precedente. Il documento è
indispensabile nel caso in cui ci sia una contestazione a posteriori, ci sia una revisione o sia
necessario comprovare la spesa al fisco.

Per i documenti base archiviati è utile tenere un raccoglitore (o una scatola per archivio).

Questi documenti saranno raramente consultati.

Indica sull'etichetta documenti archiviati dall'anno 20XX, oppure contratti d'affitto o schede personale
archiviati:

Riponi i documenti in ordine di data d'archiviazione. 
Quando il raccoglitore è pieno, scrivi sull'etichetta fino all'anno 20XX.
Inizia un nuovo raccoglitore.

Documenti con valore storico
Può essere interessante tenere traccia di alcuni elementi storici per la ditta, o che sono utili per
riprendere delle idee.
Crea già subito un raccoglitore per i documenti storici:

Il primo contratto d'affitto.
La prima fattura che hai emesso.
Le foto dell'inaugurazione del negozio.
Il DVD con il primo video promozionale.
La foto del primo prototipo.
Una copia dei volantini di vendita.

Conservazione documenti in cassette di sicurezza
I documenti importanti, che sono di estremo valore per la ditta e sono indispensabili per comprovare
un credito, è bene custodirli in cassette di sicurezza.
Per accedere alla cassetta di sicurezza é necessario del tempo, quindi è utile tenere una copia dei
documenti presso di voi, in modo che possiate facilmente consultarne il contenuto.
Procedi nel modo seguente:

Prima di riporre il documenti nella cassetta di sicurezza fanne una copia.
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Inserisci la copia nei Documenti base, con una nota indicante che il documento originale si trova
nella cassetta di sicurezza.
Nella cassetta di sicurezza tieni i documenti importanti in un portadocumenti.

Conservazione digitale

Digitalizzazione di documenti cartacei

È utile tenere delle copie anche dei documenti base anche in formato digitale.

Puoi facilmente fare delle copie e conservarle in più posti.

Devi verificare caso per caso se è possibile sostituire un documento cartaceo con una copia digitale.
Prima di buttare l'originale cartaceo verifica che il documento digitalizzato abbia la medesima validità
e quali siano le procedure da seguire.
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Cartella per i giustificativi digitali

Grazie a Banana Contabilità Plus puoi eliminare l'uso della carta, conservando tutti i documenti
contabili, come fatture e ricevute, in formato digitale. Ogni riga della tabella, che riporta una
registrazione, può essere collegata al file PDF (o di altro formato); basta un semplice clic per avere
l'accesso immediato al contenuto.

È utile creare una cartella apposita dove salvare tutti i giustificativi in formato digitale. Consulta la
pagina Organizza i tuoi file per avere suggerimenti utili.
Per trovare facilmente i documenti ti consigliamo di usare sempre lo stesso metodo nel salvataggio
dei file digitali.

Nella cartella dove tieni il file della contabilità, crea una sottocartella con il nome "giustificativi".
Collegamenti con nomi relativi al file della contabilità.
Salvando i file in una sottocartella, Banana Contabilità crea dei link ai documenti che sono
relativi al file della contabilità. 

Anche se usi dei sistemi di sincronizzazione dei file, che sui computer hanno dei
percorsi diversi (es. Dropbox), potrai comunque sempre aprire il file.
Consigliamo di leggere attentamente la Sezione Nomi dei File in Collegamenti,
specialmente se ricevi l'errore "File non trovato". 

Consigliamo di creare una cartella dove salvare i giustificativi PDF per ciascun anno.
Questa scelta è la più efficace e i documenti sono ben organizzati.

Guarda la pagina Esportazione in PDF per includere gli allegati nel PDF e conoscere le relative
restrizioni applicabili. 

Per motivi di sicurezza, vengono inclusi solo gli allegati che si trovano nella stessa cartella
del file di contabilità o in una sottocartella. 
Non tutti i lettori PDF permettono di aprire dei file allegati.

 

L'immagine riporta un esempio di organizzazione cartelle dove salvare i giustificativi digitali
 

Salva in questa cartella tutti i giustificativi digitali che ricevi o che digitalizzi.

Consiglio: nomina i tuoi giustificativi con il formato "anno-mese-giorno+cliente o fornitore
+ tipo documento".
In questo modo i file saranno disposti in automatico in ordine progressivo e ti sarà più
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facile gestirli. 

Esempi:

2022-01-15-TIM-fattura.pdf
2022-01-31-Rossi Marco-fattura.pdf

Per la data è meglio usare quella del giustificativo.
Nella cartella, tutti i documenti risulteranno ordinati nella sequenza di data e saranno
facilmente rintracciabili.

Quando inserisci una registrazione collegala al suo corrispettivo digitale. Devi rendere visibile la
colonna DocLink.
Per visualizzare  il contenuto del documento digitale:

Posizionati sulla riga di registrazione che ti interessa.
Clicca sull'icona di apertura del file nella colonna DocLink
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Salva i tuoi file Banana anche sul Cloud

Tanti software oggi si basano e lavorano esclusivamente sul Cloud. Questo significa che per utilizzarli
occorre creare un proprio conto utente e inserire le proprie credenziali di accesso, senza necessità di
installazioni locali. Significa anche però che tutto ciò che viene fatto sul Cloud, inclusi i dati e i
documenti dell'utente sono salvati sui server di chi offre il servizio.

Banana Contabilità Plus lavora con il tuo Cloud
Banana Contabilità Plus non ha un Cloud proprio, ma ti permette di lavorare con il tuo! Il programma
viene installato sul tuo computer e lavora localmente; una scelta forse un po' contro-corrente, ma
riteniamo che i dati contabili siano particolarmente sensibili. La nostra azienda non ha alcun accesso
ai dati degli utenti.

Salva i dati dove vuoi

I tuoi dati e i tuoi file contabili appartengono esclusivamente a te. In Banana Contabilità, di solito ogni
anno contabile costituisce un file a sé, in formato .ac2.
Con Banana Contabilità Plus puoi scegliere liberamente dove salvare i tuoi dati: localmente, su
dispositivi esterni, su sistemi Cloud come Dropbox, iCloud, Onedrive, GoogleDrive, per condividerli
con altri.

In Banana Contabilità il salvataggio dei tuoi file sul Cloud è quindi una possibilità tra le
tante, una libera scelta.

Salva i tuoi file Banana sul Cloud
Banana Contabilità Plus ti permette di salvare i tuoi file anche in Cloud usando qualsiasi sistema di
gestione dei dati. Totale libertà di scelta, senza alcun costo supplementare.

Puoi scegliere il servizio Cloud che preferisci:
Dropbox, Apple iCloud, Microsoft OneDrive, GoogleDrive o qualsiasi altro servizio
pubblico.
Il tuo Cloud privato.
Se hai già un servizio Cloud  attivo non avrai oneri supplementari.

I dati della tua contabilità saranno sempre accessibili. 
Anche se il tuo abbonamento a Banana Contabilità Plus dovesse scadere, i tuoi dati
rimangono sempre in tuo possesso e accessibili.
Con  il piano Free di Banana Contabilità Plus puoi sempre leggere i contenuti dei file.
Puoi tenere delle copie su qualsiasi supporto, così da soddisfare i requisiti di legge di
tenuta e archiviazione dei dati contabili.

Puoi archiviare e condividere qualsiasi tipo di file:
I file della contabilità
I file dei giustificativi o altri documenti che colleghi alle righe di registrazione.
Altri file di Excel, Word, lettere, foto o altro, che sono relativi alla contabilità.

Puoi condividere i dati con altri
Usa le funzionalità di condivisione del tuo Cloud provider.
Puoi avere più persone che accedono ai dati.
Puoi attribuire dei permessi, solo lettura oppure scrittura.
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I dati possono essere accessibili direttamente dal web.
Puoi tenere la contabilità anche se non hai una connessione attiva su internet.

La limitazione che hai con Banana è che solo una persona alla volta può modificare lo stesso file di
contabilità. Se più persone salvano le modifiche vi è un conflitto che può risultare in perdita di dati. È
dunque una soluzione ideale per piccoli teams.

Imposta il servizio di gestione dati in Cloud
Per impostare il servizio Cloud devi seguire le istruzioni fornite dal tuo provider. Di regola il
procedimento è il seguente:

Crea l'account presso il servizio Cloud.
Installa sul tuo computer il programma per l'accesso ai dati Cloud.

Ti verranno chiesti i dati per accedere al tuo conto Cloud.
Questo programma creerà una cartella locale.
In questa cartella il programma sincronizzerà i dati con il sistema Cloud.
Quando fai delle modifiche localmente queste saranno replicate in automatico sul Cloud o
su altri apparecchi con cui ti sei collegato. 
Se non hai un collegamento Cloud puoi comunque lavorare sui tuoi file. Quando ti
ricolleghi, il programma risincronizzerà i file.
Il sistema Cloud ti permette di specificare quali cartelle e file sincronizzare in automatico.
Puoi accedere ai file sia dal tuo computer e sia da dispositivi mobili.

Installa il software Banana Contabilità Plus sul tuo computer.
Nella cartella locale del servizio Cloud:

Crea la cartella per la tua ditta o per la contabilità.
Quando crei un nuovo file di contabilità salvalo sotto la cartella che hai creato.
Crea delle sotto cartelle per organizzare al meglio i dati della contabilità.

I tuoi dati saranno così automaticamente sincronizzati in Cloud.
Puoi creare altre cartelle per altre ditte o organizzazioni.

Condividi la cartella dati con altri
Tutti i sistemi Cloud offrono la possibilità di condividere i dati con altri, funzione che può essere utile
per una piccola ditta o un'associazione. Per condividere i dati con altri la procedura è la seguente:

Crea un account con il servizio Cloud usato (di regola è gratuito).
Vai sulla cartella da condividere.

Con la funzionalità di condivisione indicha l'email dell'utilizzatore a cui deve essere
concesso l'accesso.

Puoi condividere con il numero di persone che desideri.
Puoi attribuire dei permessi di accesso (solo lettura, scrittura).

In automatico verranno anche condivise tutte le sotto cartelle.
L'utilizzatore può accedere ai dati:

Tramite l'interfaccia web
Installando sul suo computer il client di sincronizzazione dei dati

I dati saranno sincronizzati fra i diversi utenti.
Attenzione: non modificare contemporaneamente un file.
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Gestisci più ditte e condividi i dati con i clienti
Se gestisci più ditte è meglio organizzare le cartelle per facilitare la condivisione con altri. Qui ti
proponiamo una possibile organizzazione dei dati, puoi ovviamente scegliere la struttura che ritieni
più adatta.

Nella cartella locale del tuo sistema Cloud crea delle cartelle separate per ciascuno dei tuoi
clienti.
Per ogni cliente crea poi due sotto-cartelle :

Internal
Dove salvare i dati che non vuoi condividere.
Shared-[NomeDitta]

Salva qua i file che vuoi condividere con il tuo cliente.
Indica anche il nome della ditta, perché così il tuo cliente vedrà questo nome.

Condividi la cartella Shared con il tuo cliente, usando il sistema che ti mette a disposizione il
servizio Cloud.

Uso del Cloud da parte dei commercialisti
Se sei un commercialista e collabori con il tuo cliente per la tenuta della contabilità, i sistemi Cloud
possono aiutarti a rendere il processo molto semplice. 

Hai generalmente due possibilità:

Il cliente usa un proprio servizio Cloud e poi condivide i dati con te.
Tu hai un sistema Cloud sul quale salvi i dati dei clienti e condividi la cartella con il cliente.

Importante: servizio di backup dei dati
Lavorare con un sistema di sincronizzazione dei dati, è come lavorare con un sistema di rete. Quando
un utente cancella un file o una cartella dal suo computer locale, in automatico il file o la cartella
viene cancellato  anche dal Cloud. Allo stesso modo se qualcuno sovrascrive i dati, quelli precedenti
sono perduti.

È quindi importante che tu disponga di un servizio di backup:

Verifica per quanto tempo il tuo fornitore Cloud tiene delle copie dei tuoi dati cancellati. La
durata può variare in base al piano che scegli.
Il sistema ti può essere utile anche per premunirti anche da difetti hardware o attacchi
ransomware.
Può essere utile avere un sistema di backup locale, che salva i tuoi dati anche su disco.
È preferibile un sistema che impedisca la cancellazione di dati, con dei semplici comandi.

Altre risorse utili:

Organizzare le cartelle e i file della contabilità
Salvare i documenti e collegarli alle registrazioni
Digitalizzare i documenti cartacei e sincronizzarli automaticamente.
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Scansiona documenti con Dropbox o altro

Le app per gli smartphone di Dropbox e altri applicativi di sincronizzazione dati, oltre a permetterti di
condividere i file, consentono anche di fare la scansione di ricevute e salvarle direttamente in formato
pdf. Rispetto alla semplice foto, ritagliano i contenuti, usano il formato pdf e permettono di inserire
più documenti nello stesso file.



Avvia l'applicativo Dropbox (altri sistemi hanno funzioni equivalenti, che potrai facilmente
scoprire sul tuo telefonino).
Usa il comando "Scansiona documento"
Fotografa il documento.
Per facilitare il ritaglio automatico, inserisci la ricevuta in una mappetta trasparente che
contenga un foglio colorato o nero. 
Nell'anteprima hai a disposizione diversi comandi

Se necessario usa il comando Ruota l'immagine in modo che sia in verticale.
Puoi aggiungere un'altra pagina, ripetendo la scansione.

Scegli il formato pdf.
Dai il nome al file usando la data che leggi sul giustificativo.
Se non hai una tua sistematica, usa il formato anno-mese-giorno, il nome della controparte e
un'eventuale osservazione (2022-01-15-TIM-fattura.pdf").
Quando il file viene sincronizzato sul tuo computer.

Copialo nella directory dei giustificativi della contabilità.
All'interno della Tabella Registrazioni, vai sulla riga e Aggiungi il collegamento al
giustificativo digitale che hai appena scansionato.

Il comando Apri collegamento apre il file scansionato.
Se usi sistemi di sincronizzazione la cartella giustificativi deve essere una sottocartella rispetto
a quella dove si trova la contabilità in modo che Banana possa creare dei percorsi relativi.

Puoi anche digitalizzare documenti utilizzando uno scanner o una stampante multifunzione.
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Altre risorse utili

Cartella giustificativi
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Vai a

Il comando apre una finestra di dialogo che permette di spostarsi sulla riga desiderata.

Quando ci si trova in una tabella di selezione (per esempio in una scheda conto), con il comando Vai
alla riga origine, il programma riporta automaticamente alla riga corrispondente della tabella
Registrazioni.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 170

Il comando Rinomina di Banana Contabilità+

Il comando Rinomina è uno strumento utilissimo di Banana Contabilità Plus. Vi si accede dal menu
Dati e permette di apportare modifiche di un conto, di un codice IVA, di un codice articolo o di un link
alla propria contabilità senza dover cercare e sostituire manualmente ogni corrispondenza.

Disponibile in Banana Contabilità Plus solo con il piano Advanced . Passa ora dal
piano Professional al piano Advanced , o acquistalo direttamente .

Il comando Rinomina sostituisce il numero di conto, di categoria (tabella Conti e Categorie), il
codice IVA (tabella Codice IVA), il numero articolo (tabella Articoli) o il link (colonna Link o
DocLink) con il nuovo testo indicato in tutte le tabelle in cui si trova o viene utilizzato (tabelle e dati
Base). Nella rinomina dei link il comando aggiorna anche il nome del file collegato nella directory in
cui si trova.

Per rinominare:

Posizionarsi con il mouse sulla cella da modificare (numero di conto, categoria, codice IVA, link)
Cliccare sul menu Dati → Rinomina 
Nella finestra che appare inserire il nuovo riferimento che si vuole attribuire.

Successivamente il programma:

Verifica che non ci sia un numero di conto o gruppo uguale; se esiste un numero uguale il
programma dà un messaggio di avviso, chiedendo se si vuole continuare ugualmente. Se si
conferma ugualmente ci sarà la segnalazione di errore.
Cerca nelle tabelle dove è usato il numero di conto da rinominare e verifica che le righe non
siano protette o bloccate; se le righe sono bloccate avvisa che non può procedere con il
rinomina.
Sostituisce il numero conto, in tutti i posti dove è usato, tabelle e Proprietà file (dati base), con il
nuovo numero di conto specificato.

NOTA

Nel piano contabile non è possibile avere due numeri di conto identici. Il programma non effettua
alcun ricalcolo, ma semplicemente sostituisce i numeri di conto.

Rinomina un collegamento (link)
Banana Contabilità Plus permette di inserire, nella colonna Link della tabella Registrazioni, dei
collegamenti a dei giustificativi digitali (ricevute, fatture, scontrini, ...).

https://www.banana.ch/it/advanced
https://www.banana.ch/it/upgrade
https://www.banana.ch/it/upgrade
https://www.banana.ch/it/buy
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Il comando Rinomina permette di modificare il testo del collegamento inserito nella colonna Link. Il
programma cambia in automatico anche:

Il nome del file nella cartella in cui è salvato.
Tutti i collegamenti a quel documento nella contabilità.

Maggiori informazioni sui giustificativi digitali
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Importa righe

Questo comando viene usato per importare dati in qualsiasi tabella. 
Per importazioni più specifiche si veda il comando:

Importazione e automazione.
Per importare movimenti bancari, fatture o dati del libro cassa e applicare regole per il
completamento automatico delle registrazioni.

Importa Righe
Per importare le righe clicca sul menu Dati → Importa righe.

Attiva le opzioni desiderate della seguente finestra.

Nome file

Tramite il pulsante Sfoglia puoi selezionare il file da cui importare i dati.

Formato

L’area contiene la lista dei formati con cui è possibile importare i dati nella tabella: Testo, Formato
ASCII, CSV.
Seleziona quello che fa al caso.

Opzioni

Importa i dati dagli appunti

Attivando questa casella si importano i dati dagli appunti di Windows.

Completamento automatico dei valori

Quando in una contabilità più complessa, si devono importare delle righe da una contabilità meno
complessa, nelle righe importate alcune colonne rimarrebbero vuote; attivando questa funzione, il
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programma completa automaticamente i valori mancanti con quelli della contabilità corrente.

Intestazione campi

Nell’importazione dei dati viene inserita anche l’intestazione dei campi.

Unicode (Utf-8)

Selezionando la casella, tutti i dati sono importati in un formato leggibile dai programmi Unicode.

Documento correlato:

Importazione e automazione
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Estrai e ordina righe

Questa funzione è disponibile a partire dal menu Dati → Estrai righe e ordina righe...

A differenza del comando Ordina righe, il programma crea una tabella separata dove vengono
visualizzate le righe estratte. Pertanto, le righe della tabella principale non vengono modificate.

Sezione Estrai
Nella tabella estrai, puoi cliccare sul numero di riga (sottolineato) per ritornare alla riga della tabella
di origine.

Colonna

Si deve selezionare la colonna dalla quale si desidera estrarre le righe.

Criterio

Si deve selezionare il criterio da applicare per l'estrazione delle righe (es. maggiore, minore, uguale,
contiene testo, inizia per, finisce per....).

Valore

In questo campo bisogna introdurre il testo da usare come confronto, in relazione alla condizione (per
esempio, se la condizione è = uguale, inserendo come valore di confronto 25.01.2022, il programma
estrae tutte le registrazioni con data 25 gennaio 2022).
Il testo è una data se il campo scelto è Data, un valore numerico se il campo è un Importo, una parola
se la colonna è una Descrizione.

Aggiungi

Il bottone permette di aggiungere altri campi per la ricerca.
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Vuota lista

Il bottone permette di cancellare le impostazioni scelte per l'estrazione dei dati nelle varie liste.

Solo righe selezionate

Questa opzione è attiva solo quando sono state selezionate in precedenza delle righe e consente
l’ordinamento delle righe selezionate.

Riga totali

Se la funzione viene attivata, il programma visualizza la riga del totale per le righe estratte che hanno
un importo o un contatore tempo.

Sezione Ordina
Si indicano le colonne di ordinamento. Le opzioni sono uguali al comando Ordina righe.

Sezione Personalizzazione
Le spiegazioni di questa sezione sono disponibili alla seguente pagina web: Personalizzazione.

Esempio lista conti
Capita delle volte che si desidera avere una lista unicamente con i conti:

Spostarsi sulla tabella Conti.
Dare il comando Estrai e ordina righe
Nella casella Colonna scegliere Conto
Nella casella Criterio indicare Non vuoto.

Se si desidera avere i conti ordinati per la descrizione:

Spostarsi sulla sezione Ordina
Scegliere in Ordina Per la colonna Descrizione.

Se vuoi visualizzare solo determinate colonne, puoi creare una nuova vista con il comando Disponi
tabelle.
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Dialogo Ordina righe

Questo comando cambia l'ordinamento delle righe in modo permanente.
Si consiglia pertanto di fare molta attenzione prima di impartire un ordinamento, soprattutto quando
ci si trova nella Tabella Conti, perché potrebbe stravolgere la struttura del piano contabile.

Se si vuole ordinare le righe solo temporaneamente usare:

Filtra e Ordina righe temporaneo.
Estrai e ordina righe che copia i dati in una tabella temporanea.

Dialogo Ordina Righe
Questa funzione si attiva dal menu Dati → Ordina righe.

Le righe della tabella possono essere ordinate in base al contenuto delle colonne. È possibile
impostare fino a tre ordinamenti.

Ordina per

Si può scegliere dalla lista che appare il tipo di ordinamento desiderato.

Poi per

Permette di scegliere un ulteriore tipo di ordinamento rispetto a quello principale.

Crescente

L'ordinamento delle righe avviene in ordine crescente, tenendo conto del tipo di ordinamento scelto
(data, doc...).
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Decrescente

L'ordinamento delle righe avviene in ordine decrescente, tenendo conto del tipo di ordinamento scelto
(data, doc...)

Numero

Attivare questa opzione se la colonna scelta come criterio di ricerca contiene solo numeri.

Vuota tutto

Il bottone permette di cancellare le impostazioni scelte per l'ordinamento dei dati nelle varie liste.

Solo righe selezionate

Questa opzione è attiva solo quando sono state selezionate in precedenza delle righe e consente
l’ordinamento delle righe selezionate.
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Disponi colonne

Il comando si attiva dal menu Dati > Disponi colonne. Grazie a questo comando, le colonne
possono essere:

Visualizzate
Nascoste
Rinominate
Spostate a destra o a sinistra nelle varie tabelle.

Visualizza
Intestazione

Intestazione della colonna.

Intestazione 2

Questa intestazione viene usata dal programma solo per alcune colonne (es. colonna Importo).

Descrizione

È la descrizione della colonna. Questa descrizione viene visualizzata come tooltip.

Formato

È il formato di visualizzazione dei numeri, data e ora. Per maggiori dettagli consulta in basso a questa
pagina Specifiche formato.

Per cambiare il formato di immissione si devono modificare le impostazioni internazionali nel sistema
operativo.
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Larghezza

Definisce la dimensione orizzontale della colonna.

Stile colonna

Un valore che indica lo stile da applicare. Questo stile ha una priorità rispetto a quello della riga.

Allineamento

Si può scegliere tra allineamento a destra, a sinistra o centrale.

Testo a capo

L’opzione consente di visualizzare il testo inserito su più righe.

Protetto

L’intera colonna è protetta, impedendo d'inserire o modificare i dati.

Escludi dalla stampa

Attivando questa opzione, viene esclusa la colonna dalla stampa.

Visibile

Attivando questa opzione si rende visibile la colonna.

Le tabelle possono essere modificate. Si possono aggiungere delle colonne, cambiare le intestazioni,
variare le dimensioni delle colonne e l’ordine in cui esse appaiono.
Le colonne sono elencate nell’ordine di apparizione nella tabella utilizzata. Le colonne visibili sono
contrassegnate da un visto.

Sposta su, Sposta giù

Le colonne possono essere spostate a destra o a sinistra: basta cliccare sul nome del colonna e con il
bottone Sposta su, la colonna viene sostata verso sinistra; con il bottone Sposta giù, la colonna viene
spostata verso destra. Le colonne possono essere spostate anche semplicemente trascinandole con il
mouse.

Aggiungi colonna

Aggiunge colonne nella tabella attiva. Le colonne aggiunte dall'utente hanno una funzione puramente
informativa e il programma non esegue calcoli su eventuali dati numerici.
Se si aggiunge una colonna di tipo Importo in alcuni casi, i dati inseriti dall'utente, vengono usate nei
calcoli. Le colonne di tipo importo vengono sommate solo nelle seguenti tabelle:

Tabella Conti
Tabella Scheda conto
Tabella Estrai righe.

Elimina colonna

Consente di cancellare una colonna dall’elenco. Non è possibile però eliminare una colonna di
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sistema.

 Impostazioni
Nome

Inserire il nome del campo della colonna da aggiungere. Il programma inserisce automaticamente
nell'elenco la nuova colonna.

Nome Xml

Il nome della colonna per l’archiviazione Xml e per le estensioni.

Tipo dato

Si può scegliere tra i seguenti tipi di dati predefiniti: Testo, Numero, Importo, Data, Ora.

Lunghezza max e min

Lunghezza massima e minima della colonna.

Valore max e min

È possibile inserire dei valori massimi e minimi (numeri e caratteri).

Decimali

Si può definire il numero dei decimali della colonna.

Numero colonna

È un numero che viene attribuito automaticamente alla colonna, ma ha uno scopo puramente tecnico.

Tutto maiuscolo

Facendo click su questa opzione, i dati della colonna sono tutti convertiti in maiuscolo.

 Formato data e numeri per default nel tuo computer
Una volta installato, il programma prende per default le impostazioni del proprio sistema operativo.

Se nel programma si desidera cambiare le impostazioni della data, ora e formato dei numeri, occorre
modificare le impostazione nel Pannello di Controllo (Windows) o nelle Preferenze di Sistema (Mac).

Nel dettaglio le istruzioni per Windows:

Menu Avvio → Pannello di controllo
Sotto le Opzioni internazionali, cliccare su Cambia data, ora o formato dei numeri
Nella finestra di dialogo che appare, nella sezione Formati, si può cambiare il formato della
data
Per cambiare il formato dei numeri o valuta, dalla stessa finestra di dialogo, cliccare sul bottone
Impostazioni aggiuntive e poi sulle sezioni Numeri o valuta.

Nel dettaglio le istruzioni per Mac OS X:



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 181

Dal simbolo della mela di Apple (in alto a sinistra) scegliere il comando Preferenze di
Sistema
Nella finestra di dialogo che appare scegliere Data e ora
Dalla finestra che appare cliccare su Apri lingua e zona...→ Avanzate → (Generale), Data e
Ora 
dove è possibile cambiare il formato di numeri.

 Formato numeri e date in Banana Contabilità
Quando non si specificano dei formati particolari per la data, l'ora e i numeri, questi vengono
visualizzati con i formati propri del sistema operativo.

All'interno di Banana si può modificare solo il formato di visualizzazione.
Per cambiare il formato di immissione (quando si modifica un valore) si devono cambiare le
impostazione del proprio sistema operativo.

Per cambiare il formato occorre cliccare sul menu Dati → Disponi colonne e inserire nella casella
Formato, il tipo di formato desiderato. Qui di seguito sono elencati i tipi di formato con alcuni esempi
esplicativi:

Formato data Esempio data
d mm yy 1 01 15
dd m yy 01 1 15
ddd mmm yyyy ven gen 2015
dddd mmmm yyyy venerdì gennaio 2015
La lettera “d” (day) indica il giorno, la “m” (month) indica il mese, e la “y” (year) indica l’anno.
Formato ora Esempio ora
hh:mm:ss:zzz 04:04:36:089
h:m:ss:zz 4:4:36:89
Naturalmente è possibile invertire a piacere l’ordine degli elementi della data e dell’ora (p.es.: mm dd
yyyy).
Per quanto riguarda i separatori si possono scegliere fra tutti quelli disponibili sulla tastiera (ad
esempio: #, @, -, /, ., ecc.).
Formato numeri Esempio numeri
0. 259
0.00 258.85
0.000 258.848
In un campo numerico è possibile modificare il numero dei decimali secondo le proprie esigenze. I
calcoli sono effettuati con tutte le cifre decimali inserite. Un eventuale arrotondamento avviene solo
in visualizzazione.
Formato link Esempio link
:link: "receipts/office electricity october.pdf"
:file: "office electricity october.pdf"
:file:16: "office electrici"
:file:16:ellipsis "office electr..."
:file:-24:ellipsis: "...electricity october.pdf"
:link:symbol: ">>"
NB.: Il formato link viene unicamente applicato per la stampa su carta o su file pdf, non influisce sulla
visualizzazione a schermo.
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Nuova colonna

Dal menu Dati → Disponi colonne si possono aggiungere delle colonne proprie.

Nome 

Inserire il nome del campo della colonna da aggiungere.

Nome Xml

Il nome della colonna per l’archiviazione Xml e per le estensioni.

Tipo dato

Si può scegliere tra i seguenti tipi di dati predefiniti: Testo, Numero, Importo, Data, Ora.
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Disponi tabelle

Questo comando si attiva dal menu Dati > Disponi tabelle.

Le Tabelle
Sono gli elementi che contengono i dati in formato righe e colonne.
 
Le Viste
Sono indicate sotto ad ogni tabella.
Sono gli elementi che definiscono la visualizzazione delle colonne nella tabella.
Tramite le Viste è possibile definire quali colonne devono essere visibili, la sequenza di
visualizzazione e le modalità di visualizzazione delle colonne.

Per aggiungere delle tabelle si rimanda al comando Aggiungi nuove funzionalità.

Impostazioni Vista
Per ogni tabella è possibile impostare:

Nome
Il nome  della tabella nella lingua del file. Non deve contenere spazi o caratteri speciali.
Può essere cambiato solo per le tabelle aggiunte.
Nome Xml
Il nome che viene usato nella programmazione. Non deve contenere spazi o caratteri speciali.
Può essere cambiato solo per le tabelle aggiunte.
Intestazione
Il nome che appare nell'elenco delle tabelle.
Visibile
Indica se la tabella è visibile o meno.
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Gestione Vista
Nome

È possibile inserire un nuovo nome alla vista selezionata.

Nome Xml

Il nome della vista per l’archiviazione Xml. Per le viste di sistema, il nome Xml non può essere
cambiato.

Numero

È un numero attribuito dal programma per identificare la vista.

Visibile

Rende visibile una vista.

Di sistema

Se la casella è attiva si tratta di una vista di sistema e non può essere eliminata o modificata.

Disponi colonne...

Visualizza la finestra Disponi colonne per poter modificare le colonne sia a livello di visualizzazione
che di impostazione.

Imposta pagina

Si accede alla finestra delle impostazioni pagina.

Aggiungi vista

Aggiunge una nuova vista alla tabella dove ci si trova.

Elimina vista

Cancella la vista.

Imposta come predefinito

Definisce la vista che viene usata.
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Nuova vista

Dal menu Dati > Disponi tabelle > bottone Aggiungi Vista si possono aggiungere delle viste proprie
(non è previsto per le schede conto).

Nome vista

Inserire il nome della vista da aggiungere.

Nome vista Xml

Il nome della vista per l’archiviazione Xml.

Dopo la creazione, la nuova vista viene visualizzata nello stesso posto delle viste esistenti e verrà
aggiunta al lato destro delle altre.
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Menu Formato

Nel menu Formato sono presenti i seguenti comandi:

Stile predefinito
È lo stile predefinito usato dal programma.

Punti
Per definire la grandezza del carattere.

Grassetto e Italico
Mette in grassetto o in corsivo i testi della cella o delle celle selezionate.

Modifica lo stile predefinito
Per tutto il file vi è uno stile predefinito. Quando si aggiunge una nuova riga viene usato lo stile
predefinito.

Per cambiare lo stile predefinito:

assegnare ad una riga lo stile desiderato;
cliccare sul menu Formato → Modifica lo stile predefinito.

Tutte le righe con lo stile predefinito sono visualizzate nel nuovo stile.

Calcola altezza riga
Quando il testo di una riga è molto lungo, il comando Calcola altezza riga dal menu Formato,
permette di visualizzarlo completamente, adattando l’altezza della riga.
Per adattare l'altezza della riga al testo occorre:

attivare dal menu Dati → Disponi colonne;
selezionare il nome del campo che fa al caso
attivare la casella Testo a capo dalla sezione Visualizza
richiamare il comando Calcola altezza riga dal menu Formato ogni volta che se ne presenta
la necessità.

Il comando Calcola altezza righe è analogo al precedente, con la differenza che opera su tutte le
righe della tabella.

Calcola altezza righe
Comando analogo al precedente, con la differenza che opera su tutte le righe della tabella.
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Ripristina altezza righe
Riporta l'altezza delle righe selezionate alla misura standard.

Cambio pagina
È possibile inserire un cambio pagina in qualsiasi riga del documento in cui ci trova.
Per inserire un cambio pagina:

Posizionarsi con il cursore sulla prima riga della nuova pagina da creare.
cliccare sul menu Formato → Cambio pagina.

Per rimuovere un cambio pagina:

Posizionarsi sulla riga con un cambio pagina.
Aprire il menu Formato → disattivare Cambio pagina.
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Evidenziare le righe con i colori

La possibilità di colorare le righe permette di ritrovare molto più facilmente differenti tipi di
registrazione in un colpo d'occhio.

Per colorare le righe o i testi è necessario selezionarle e poi usare una delle seguenti icone:

La prima icona colora lo sfondo, mentre la seconda colora il testo.

Per disattivare il colore del riempimento basta selezionare la riga o le righe e cliccare su
Nessun colore 
Per disattivare il colore del testo posizionarsi sulla riga e selezionare Automatico, in questo
modo il colore torna al colore predefinito

Nessun colore e Colore automatico
Si consiglia di usare sempre Nessun colore e Colore automatico invece del bianco e del nero, perché
quando nel Menu Finestra > Aspetto > Tema del display si imposta il tema del programma abbiamo i
seguenti casi: 

Tema Luminoso, dove i testi sono visualizzati in nero
Tema Scuro, dove i testi sono visualizzati in bianco

Se si usa un colore di background chiaro, i testi saranno visualizzati in nero. Mentre se il background è
scuro, i testi saranno visualizzati in bianco.

Nel caso in cui si scegliesse il nero quale colore del testo ed il bianco quale sfondo, i colori assegnati
rimarrebbero gli stessi. I testi potrebbero dunque non essere più visibili nel caso si cambiasse tema.
Per evitare questa problematica, si dovrebbe selezionare Automatico per il testo e Nessun colore per
quanto riguarda lo sfondo. 

Quando si usa il filtro righe per visualizzare solo le righe colorate, il programma mostra tutte le righe
con dei colori, comprese le righe a cui è stato assegnato il colore bianco o nero. Se non si vuole
vedere queste righe bisogna selezionarle ed impostare Nessun colore come sfondo o Colore
automatico come testo. 
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Menu Strumenti

Il menu Strumenti contiene le seguenti funzionalità:

Info file
Aggiungi funzionalità
Crea copia file
Converti in nuovo file
Unione file
Opzioni programma
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Info file

Dal menu Strumenti → Info file vengono visualizzate le caratteristiche del file.

Colonne
Attivando la vista Completo vengono visualizzate anche le colonne Xml, grazie alle quali, se si
esporta la tabella, è possibile riprendere i valori in modo automatizzato.

Sezione: il nome del gruppo di valori.
ID: l'identificativo specifico e univoco del valore.
Descrizione: contiene una spiegazione del valore.
Le righe in grassetto sono i titoli della sezione che raggruppa i diversi elementi.
Valore: il valore formattato.
Sezione XML: il nome della sezione in inglese.
ID XML: l'ID in inglese.
Valore Xml: il contenuto del campo in formato Xml.

La Sezione XML e l'Id Xml permettono d'identificare in modo univoco il valore.
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Aggiungi/Rimuovi funzionalità

Il comando Aggiungi/Rimuovi funzionalità... si trova nel menu Strumenti.

Permette di aggiungere delle tabelle gestite completamente dall'utente.
Per aggiungere delle nuove funzionalità occorre selezionare la funzionalità che si necessita.

Le opzioni disponibili dipendono dal tipo di file.

Per approfondimenti sulle singole opzioni consultare:

Aggiungi e rimuovi funzionalità negli applicativi di contabilità.
Aggiungi e rimuovi funzionalità negli applicativi di produttività.
Tabella Documenti.
Tabella Semplice

http://www.banana.ch/doc/it/node/9289
http://www.banana.ch/doc/it/node/9289
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Tabella Documenti

La tabella Documenti consente d'includere nel file contabile dei documenti di testo, delle immagini
(incluso il logo) oppure degli scripts.

Può essere aggiunta dall'utente con due modalità diverse:

Dal menu Strumenti → Aggiungi nuove funzionalità → Tabella documenti.
Viene creata in automatico quando il programma deve salvare dei documenti (es. aggiunta del
logo o di allegati al  Rendiconto abbellito, Rendiconto abbellito con gruppi dal menu Report →
sezione Allegati ).

La tabella Documenti ha le seguenti colonne:

Id
È il nome del documento. L'Id è un testo libero ma dovrebbe essere univoco all'interno della
tabella.

I documenti che iniziano con "_" vengono utilizzati per funzionalità particolari del
programma.

"_budget.js"
Vi si inseriscono le funzioni proprie create per la tabella Preventivo.

L'id dlgmanageaddons è usato  per salvare l'immagine usata come logo.
l'id attachment_ viene usato per gli allegati nel bilancio abbellito.

Descrizione
Una breve descrizione del file (opzionale)
Allegati
Contiene il file. Cliccando sulla cella è possibile visualizzare o modificare il contenuto del file.
Ci sono questi tipi di contenuti possibili

Immagine (image/png, image/jpg)
Testo normale (text/plain)
Testo formattato html (text/html),
Testo formattato markdown (text/markdown),
Programma in javascript (text/javascript)
Foglio stile CSS (text/css).

http://www.banana.ch/doc/it/node/7994
http://www.banana.ch/doc/it/node/7994
http://www.banana.ch/doc/it/node/7994
http://www.banana.ch/doc/it/node/7994
http://www.banana.ch/doc/it/node/7994
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Aggiunta di un nuovo documento

Per inserire un nuovo documento nella tabella Documenti

Aggiungere una nuova riga.
Nella colonna Id scrivere il nome del file .
Nella colonna Descrizione si può scrivere il testo desiderato.
Nella colonna Allegati fare doppio clic sulla cella oppure selezionare il simbolo di modifica,
selezionare il tipo di documento che si desidera aggiungere. 

Vedi anche:

Aggiungere un documento HTML
Aggiungere un documento Markdown
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Editor Markdown

In Banana Contabilità Plus gli allegati di bilancio ora si possono inserire anche tramite linguaggio
markdown, oltre che in html. È molto comodo per inserire delle tabelle negli allegati.

Disponibile in Banana Contabilità Plus solo con il piano Advanced , o nei piani
Professional e Free con l'Advanced in modalità dimostrativa  (70 registrazioni) →
passa ora al piano Advanced .

Il Markdown è un linguaggio che permette di creare del testo formattato usando un normale editore di
testo e una sintassi semplice da scrivere e  leggere. 

In Banana Plus è possibile utilizzare questo linguaggio negli allegati della tabella Documenti e sono
supportate le specifiche GitHub Flavored Markdown .

Documentazione pubblicata da github.com:

Formattazione di base
Formattazione avanzata
Mastering Markdown

Aggiungere un documento Markdown
Selezionare la tabella Documenti
Aggiungere una nuova riga.
Nella colonna Id scrivere un nome che identifica il documento.

https://www.banana.ch/it/update
https://www.banana.ch/doc/it/appmsg_it_info_license_extended_startupmode
https://www.banana.ch/it/upgrade
https://github.github.com/gfm/
https://docs.github.com/en/articles/basic-writing-and-formatting-syntax
https://docs.github.com/en/articles/working-with-advanced-formatting
https://guides.github.com/features/mastering-markdown/


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 195

Nella colonna Descrizione si può scrivere il testo desiderato.
Nella colonna Allegati fare doppio clic sulla cella oppure selezionare il simbolo di modifica,
selezionare il tipo Testo Markdown. 

Aggiungere un allegato di bilancio con testo markdown

Esempio di sintassi markdown per creare una tabella
Per creare delle tabelle in markdown , il contenuto delle colonne deve essere dal segno barra
verticale, preceduto e seguito da uno spazio " | ".
Per l'allineamento della colonna si deve creare una riga con

Sinistra: semplici trattini (minimo tre trattini).
Centrato: trattini preceduti e seguiti dal duepunti ":---:".
Destra: trattini seguiti dal duepunti "---:"

# Notes to the Balance (Example)
The financial statements of Example have been prepared in accordance with the
International Financial Reporting Standards (IFRS).
## Cash Positions
| Account | Description | Current Year | Previous Year |
| :---: | --- | ---: | ---: |
| 1000 | Cash  | 23'000.00 | 17'000.00 |
| 1020 | Bank account| 9'000.00 | 1'000.00 |
| | **Total** | **32'000.00** | **18'000.00** |
## Other Fixed Assets
| Account | Description | Current Year | Previous Year |
| :---: | --- | ---: | ---: |
| 1000 | Machinery | 13'000.00 | 17'000.00 |
| 1020 | Furniture | 5'000.00 | 4'000.00 |
| | **Total** | **18'000.00** | **21'000.00** |

https://docs.github.com/en/github/writing-on-github/working-with-advanced-formatting/organizing-information-with-tables
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 Funzionalità al momento non disponibili
Queste funzioni, seppur richieste da alcuni utenti, non sono attualmente disponibili:

Inserire un link nel testo markdown

Elenco completo funzionalità al momento non disponibili

https://www.banana.ch/doc/it/features_not_available
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Editore HTML

Inserimento del campo ${...}
Permette di aggiungere del testo dinamico nel documento, come ad esempio il saldo di un conto o
una tabella di Banana. L'interfaccia API di Banana è consultabile alla pagina
https://www.banana.ch/doc/en/node/4714.
Il comando può essere inserito manualmente, oppure, tramite il comando Modifica > Inserisci
script.

Stampa di una riga vuota (inserire uno spazio tra i due apici)

${' '}

Stampa del saldo corrente del conto 1020

${Banana.Converter.toLocaleNumberFormat(Banana.document.currentBalance('1020'
,'','').balance);}

Stampa della tabella Conti, colonne conto, gruppo, descrizione, saldo.

${HTML
Banana.document.table('Accounts').toHtml(['Account','Group','Description','Ba
lance'],true);}

È possibile scrivere il codice javascript in un documento separato e fare riferimento allo script tramite
il comando Banana Include.
Gli scripts possono essere salvati nella tabella Documenti oppure in un file locale.

${Banana.include('documents:myscript1');rtnValue}
${Banana.include('c://temp//myscript16.js');rtnValue}



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 198

Inserimento di un'interruzione di pagina
Il comando può essere inserito manualmente o tramite il comando Modifica > Inserisci
interruzione pagina.

Testo nella prima pagina
${PAGEBREAK}
Testo nella seconda pagina

Risoluzione problemi
Quando si riprende il testo da fonti esterne (Word, pagine Internet, ...), usare il comando
Modifica > Incolla come testo non formattato. Questo comando evita problemi con la
formattazione HTML, che in alcuni in casi, impedisce la corretta visualizzazione.
Per gli esempi di questa pagina utilizzare il link Copy posto sulla destra in alto ad ogni esempio,
non utilizzare CTRL+C (o CMD+C).
Se il campo ${…} non funziona, verificare che non vi sia alcuna formattazione HTML (come
elementi <span>…</span> o altro) ed eventualmente rimuoverla dal codice Sorgente HTML.
Per rimuove la formattazione HTML esistente di un'intera pagina:

copiare il testo negli appunti (CTRL+C)
andare sul tab Sorgente HTML e cancellare tutto il contenuto
andare sul tab Pagina1 e incollare il testo copiato con il comando Modifica > Incolla
come testo non formattato.
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Tabella Semplice (Aggiungi funzionalità)

Il programma aggiunge al file esistente una tabella composta da queste colonne.

IdRiga
Descrizione
Note

Si usa per aggiungere codici per esempio per Progetti, o altre informazioni che si vogliono codificare.

Nelle altre tabelle si può poi aggiungere una colonna che si collega a questa tabella.
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Collegare delle tabelle

Aggiungi Colonna di collegamento
In Banana Contabilità Plus si possono creare dei collegamenti tra colonne di tabelle diverse, tramite la
colonna IdRiga (Rowld).

Il comando Strumenti > Aggiungi/Rimuovi funzionalità > Aggiungi colonna di collegamento
tabella crea una colonna di collegamento nella tabella dove ci si trova, con un' altra tabella esistente.

La colonna Descrizione viene aggiunta in automatico, ma se non serve può essere cancellata o
nascosta.

Il comando funziona solo se la tabella da collegare contiene la colonna "RowId".

Dialogo scegli tabella
Vengono visualizzato l'elencop delle tabelle che contengono la colonna "RowId" e che non sono già
state collegate a questa tabella.

Se la lista è vuota significa che non vi è nessuna tabella che può essere collegata.

Dialogo scegli colonna 
Vengono visualizzate tutte le colonne della tabella.

Scegliere la colonna dopo la quale si vogliono che siano aggiunte le colonne di collegamento. 

Collegamento fra tabelle
Per avere un collegamento tra una colonna di una tabella e un'altra di una tabella diversa, procedere
come segue:

Aprire il file dove aggiungere la tabella
Aggiungere la nuova tabella  "esempio Progetti"

Nella colonna Id della tabella aggiunta (Progetti), indicare la sigla progetto e nella colonna
Descrizione la descrizione del progetto.

Nella tabella Registrazioni collegare le colonne della tabella aggiunta (Progetti):
Dal menu Strumenti > Aggiungi/Rimuovi funzionalità > Aggiungi collegamento
tra tabelle.
Nel dialogo che si apre si può scegliere la posizione della colonna.
Confermare cliccando sul bottone OK. 
Vengono aggiunte e visualizzate le nuove colonne di collegamento, che iniziano con il
nome della tabella. 

ProgettiId dove si inserisce il codice corrispondente al contenuto della colonna
RowId. 
ProgettiDescription (colonna protetta) dove viene visualizzata la descrizione
relativa al codice inserito.  

Quando si cambia il contenuto della tabella Progetti, inserendo l'Id nell'altra tabella, il

http://www.banana.ch/doc/it/node/10032
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testo della descrizione verrà ripreso in automatico.
Se vengono cambiate le descrizioni nella tabella aggiunta (Progetti), per la ripresa in
automatico dei nuovi testi effettuare un ricalcolo o chiudere e riaprire il file.

Il programma in automatico collega le colonne che iniziano con lo stesso nomeXml di una tabella
tabella e sono seguiti da "Id" o "Description". 

Le colonne di collegamento si possono creare aggiungere manualmente attribuendogli i nomi
correttamente. 
Non usare questi nomi per delle colonne che non devono essere collegate. 
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Crea file da dati esterni

Banana Contabilità è in grado di trasformare dei file dati e convertirli in un file di Banana Contabilità,
in modo da accedere più facilmente al contenuto.

Per esempio:

Visualizza file CSV
Banana converte i file di tipo CSV e li visualizza in tabella.
Devi solo trascinare il file CSV nella finestra di Banana Contabilità e il file viene convertito in una
tabella semplice.
Visualizza estratti conto ISO 20022 o MT940
Il file viene convertito in un libro cassa e le operazioni vengono visualizzate come movimenti.
Basta trascinare il file in Banana.
Audit file for taxation .
Il file xml viene trasformato in una contabilità in partita doppia, con il relativo piano dei conti e
movimenti.
 

Estensioni per creare file
Le estensioni del tipo File Creator consentono di creare dei convertitori di file per tipi di dati specifici e
dare la possibilità all'utente di scegliere quale estensione usare.

https://www.banana.ch/en/audit-file-reader
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Visualizza estratti conto ISO 20022 o MT940

Il software Banana Contabilità permette di visualizzare e stampare il contenuto degli estratti conto nel
formato ISO20022 - camt052, camt053 (inclusa versione 4), camt054 - e MT940.
I movimenti dell'estratto conto elettronico, con descrizione, importo in entrata e uscita, sono
presentati in colonne separate e possono essere stampati o incollati in Excel.

Aprire il file ISO 20022 o MT940
Per aprire e vedere il file :

Scaricare l'estratto conto della propria banca nel formato ISO 20022.
Se si tratta di un file compresso, estrarre il file XML da visualizzare con una propria utility (p.es.
7zip).
Aprire Banana Contabilità.
Trascinare il file all'interno della finestra di Banana Contabilità: immediatamente Banana
visualizza tutti i movimenti con data, testo, importo e il saldo progressivo (il file viene aperto in
sola lettura).
I dati dell'estratto conto possono poi essere stampati o copiati in Excel o in altri programmi.

Ulteriori indicazioni

Il saldo iniziale presente nel file ISO 20022 viene inserito nella tabella conti.
Potete adattare la larghezza delle colonne con il mouse. 
Per allineare il testo della descrizione su più linee, usare il comando Formato → Calcola
altezza righe.
Per categorizzare i movimenti e ottenere i rendiconti, inserire le apposite categorie nella tabella
Categorie e visualizzare la colonna Categorie nella tabella Registrazioni con il comando
Disponi colonne. 
Oppure creare un nuovo file con un modello esistente e con le categorie e conti già impostati e
importare i dati dell'estratto conto come spiegato sulla pagina Importa file ISO 20022.
Nela modalità Free Version gratuita non si possono salvare i file con più di 70 movimenti.
 

Ulteriori informazioni
Per informazioni circa lo Standard ISO2002 si veda la pagina Importa file ISO 20022 in contabilità.
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Visualizza file CSV

Se si apre o se si trascina nella finestra di Banana un file del tipo CSV o JCSV, Banana crea in
automatico un file del tipo Tabella semplice, riprendendo le colonne e i dati contenuti nella tabella
CSV.
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Crea copia file

Il comando si attiva dal menu Strumenti → Crea copia file.

La funzione permette di creare un file nuovo, identico a quello esistente.  Si può scegliere di copiare il
file con le seguenti opzioni:

Tieni Saldi di apertura. Se la funzione viene attivata, nel nuovo file verranno riportati i saldi di
apertura del file copiato.
Tieni Registrazioni. Se la funzione viene attivata, nel nuovo file verranno riportate le
registrazioni del file copiato.
Tieni Registrazioni ricorrenti. Se la funzione viene attivata, nel nuovo file verranno riportate le
registrazioni ricorrenti del file copiato.

Questa funzione è molto utile quando si vogliono effettuare delle modifiche di prova e avere la
sicurezza di poter tornare indietro senza perdere dei dati.

Se le opzioni non vengono attivate viene creato un nuovo file solo con lo stesso piano contabile.

Il nuovo file si deve salvare con nome.
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Converti in nuovo file

Il comando si attiva dal menu Strumenti > Converti in nuovo file.

Nella finestra di dialogo che appare, il tipo di file su cui si sta lavorando risulta selezionato.
Viene anche elencata una lista di possibili scelte:

La funzione permette di convertire un file esistente (che non verrà modificato) in uno nuovo con
caratteristiche diverse. Pertanto è possibile:

Cambiare la lingua.
Cambiare l'arrotondamento.
Cambiare il tipo di file. Per esempio:

Passare da una contabilità senza IVA a una con IVA.
Passare da una contabilità in partita doppia ad una multimoneta.

È come se si creasse un file nuovo vuoto e poi si riportassero manualmente i dati.

Le caratteristiche del file esistente si possono vedere con il comando Strumenti > Info File.

Creazione e trasferimento dati
Il comando Strumenti > Converti in nuovo file:

Crea un nuovo file del tipo specificato con le impostazioni predefinite delle colonne.1.
Trasferisce i dati nel nuovo file procedendo alle conversioni necessarie.2.
Salva e indica il nome del nuovo file.3.

Nel caso si passi da un file con più opzioni ad uno che ne ha di meno, durante la conversione parte dei
dati verranno persi. Per esempio se si passa da una contabilità con IVA ad una contabilità senza IVA,
nella conversione verranno persi i dati delle colonne relative all’IVA.
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Passaggio dalla contabilità doppia alla multimoneta
È necessario che nelle Proprietà del file venga specificata la sigla moneta (che diventerà la
moneta base).
Scegliere come destinazione la contabilità con multimoneta
Il programma crea una contabilità multimoneta riprendendo i dati esistenti:

Le registrazioni avranno le colonne per la gestione multimoneta, come moneta quella di
base e cambio 1.0000
I conti esistenti nella tabella conti sono completati con la sigla moneta base:

Aggiungere i conti utile e perdite di cambio predefiniti.
Indicare nelle proprietà file i conti perdita e utile di cambio predefiniti.

La tabella cambi è vuota, pertanto si dovranno aggiungere le monete e i cambi utilizzati
nelle registrazioni.
Nella tabella conti aggiungere i conti in moneta estera.

Per cambiare la moneta di una contabilità consulta la pagina Proprietà file.

Passaggio da una contabilità senza IVA ad una con IVA
Scegliere come destinazione la contabilità con IVA che si desidera.
Il programma crea una contabilità con le colonne IVA riprendendo i dati esistenti:

Aggiungere i conti IVA nel piano contabile.
Le proprietà file relative all'IVA devono essere completate, in particolare indicare il conto
predefinito sul quale registrare l'IVA.
Dal menu Azioni > Importa in contabilità > Codici IVA si possono riprendere le aliquote in
vigore presenti nella tabella Codici IVA.

Parametri creazione nuovo file
Per maggiori informazioni su questo dialogo vedi:

Parametri creazione nuovo file
Aggiungi nuove funzionalità



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 208

Documenti correlati

Gestione IVA

Documentazione IVA a seconda del paese 

https://www.banana.ch/doc10/it/node/2619


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 209

Il comando Unione file di Banana
Contabilità+

La possibilità di unire insieme file contabili è di grande utilità; permette per esempio di riunire le
contabilità di sedi diverse di una stessa ditta, o di assorbire i conti di attività dislocate nel file
contabile della casa madre sia in ambito associativo che imprenditoriale.

Disponibile in Banana Contabilità Plus solo con il piano Advanced. Guarda tutte le funzioni
del Advanced . Passa ora al piano Advanced !

Il comando si attiva dal menu Strumenti > Unione File.

Con questa funzione è possibile unire due file, che appartengano però alla stessa applicazione (es.
due file di contabilità in partita doppia con IVA). Non è possibile unire file appartenenti ad applicazioni
diverse (es. un file di contabilità in partita doppia e un file di contabilità entrate / uscite).

Affinché l'unione di due file abbia un esito positivo è fondamentale che la numerazione dei conti sia
uguale per entrambi i file.

Per unire due file si procede come segue:

Aprire il file che conterrà i dati di entrambi i files
Selezionare dal menu Strumenti > Unione File
Selezionare il percorso e il nome del secondo file
Confermare l’operazione d’unione
Se i file, pur appartenenti alla stessa applicazione, non sono uguali (per esempio contabilità con
IVA e contabilità senza IVA) il programma segnala che ci saranno perdite di dati.

https://www.banana.c/it/advanced
https://www.banana.c/it/advanced
https://www.banana.c/it/advanced
https://www.banana.ch/it/upgrade
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Opzioni programma

Le opzioni programma si attivano dal menu Strumenti → Opzioni programma e contengono scelte
di natura tecnica del documento contabile.

Nelle pagine che seguono puoi trovare informazioni più dettagliate:

Interfaccia
Editor
Gestione file
Avanzato

Info sistema
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Generale

Le opzioni dell'interfaccia si attivano dal menu Strumenti → Opzioni programma → Interfaccia.

Opzioni Programma

Lingua

È la lingua d’uso del programma. È possibile cambiare questa impostazione se si desidera usare una
lingua diversa da quella predefinita oppure se quella predefinita non è disponibile.

Tipo di carattere

Si può scegliere il tipo di carattere.

% Zoom

Se si desidera che i dati nelle tabelle vengano visualizzati con una dimensione diversa, basta adattare
la percentuale Zoom.

La percentuale zoom può essere modificata anche con l'apposito strumento in basso a destra
sulla barra di stato.
Lo zoom ha come scopo quello di adattare il contenuto della tabella alla dimensione della
finestra.
Per la dimensione del testo dei menu, dialoghi e icone vengono usate le impostazioni del
sistema operativo, ma possono essere adattate anche dall'utente. 

Mostra numeri negativi in rosso

Nelle tabelle i numeri e gli importi negativi vengono visualizzati in rosso.
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Inizio

Controlla aggiornamenti

Collegamento diretto al sito www.banana.ch  alla pagina di download degli aggiornamenti.

Visualizza pagina iniziale

Viene visualizzata la pagina iniziale delle informazioni, relativa alle news.

Visualizza elenco ultimi file usati

Vengono visualizzati i file aperti di recente.

Avvia web server

Serve per accedere ai dati di Banana Contabilità da programmi esterni.

Per maggiori informazioni vedere Integrated Webserver (in inglese).

https://www.banana.ch/it/node/11181
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Editor

Le opzioni dell'Editor si attivano dal menu Strumenti → Opzioni programma → Editor.

Comportamento
Entra in modifica con singolo click

Se la funzione è attivata, per entrare in modifica è sufficiente un singolo click sulla cella già
selezionata.
Se la funzione non è attivata, per entrare in modifica è necessario un doppio click sulla cella.

Completamento automatico testo

Se la funzione è attivata, il programma seleziona automaticamente la prima proposta di testo che
trova nella lista a tendina e la inserisce automaticamente nella riga in cui ci si trova.

Somma durante la selezione

Attivando la casella, il programma somma gli importi selezionati. Disattivare questa funzione se la
somma istantanea dovesse rallentare certe operazioni. È possibile selezionare importi non adiacenti,
tenendo premuto il tasto Ctrl mentre si selezionano le singole celle con il tasto sinistro del mouse.

Su "Invio" vai alla riga successiva

Se la funzione viene attivata, premendo il tasto Enter, il cursore si posiziona nella stessa colonna della
riga successiva.
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 Inserimento
No. massimo annulla operazione

Digitare il numero massimo di operazioni che si desidera annullare tramite il menu Modifica → Annulla
operazione (si annulla un'operazione alla volta).

Limite righe completamento automatico - Smart fill

Durante l’inserimento dei dati, il programma legge i dati già immessi e cerca di suggerire come
completarli. Laddove vi sono molte righe, questa funzione può rallentare l’inserimento. Si può fissare
un limite di righe oltre il quale non usare il completamento automatico. L’assenza di valore (zero)
significa che il completamento automatico viene effettuato sempre.
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Gestione file

Le opzioni Gestione file si attivano dal menu Strumenti → Opzioni programma → Gestione file.

Salvataggio documenti

Questa sezione contiene le opzioni che seguono per il salvataggio dei documenti.

Salva automaticamente alla chiusura dei documenti

Se l'opzione è attivata, ad ogni chiusura del file, i dati verranno salvati.

Salva informazioni di recupero ogni

L’opzione consente il salvataggio automatico del file con frequenza (in minuti) da decidere. Il
programma salva i dati in un documento chiamato autobackup + nome file. Se il programma o il
computer si bloccano, è possibile recuperare i dati aprendo questo file e salvandolo con nome dal
menu File.

Crea copia di backup

Quando si salva su disco con lo stesso nome, la versione del file preesistente viene rinominata con
l’estensione BAK.
Maggiori informazioni sono disponibili alla pagina Salva.

 Estensione file

Estensione dei file considerati sicuri

Questa opzione definisce i tipi di file (es.: "pfd", "jpg", ...) e gli schemi url (es.: "http:", "x-devonthink-
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item:", ...) che permettono di aprirsi con il comando Apri collegamento nella colonna Links di ogni
tabella. Pertanto, impedisce di aprire file o gli schemi non ritenuti sicuri. Le estensioni vanno inserite
senza il punto '.' iniziale, mentre gli schemi vanno inseriti con un doppio punto ':' finale.

Ripristina valori predefiniti

Nel caso che determinate impostazioni fossero state modificate, cliccando su questo bottone il
programma ripristina le impostazioni di default.
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Avanzato

Le opzioni Avanzato si attivano dal menu Strumenti > Opzioni programma > Avanzato.

PDF

Attivare caratteri TrueType

Se questa opzione è attiva nella stampa dei files PDF viene utilizzato il tipo di carattere selezionato
nella scheda Interfaccia, altrimenti viene utilizzato un tipo di carattere nativo dei files PDF (Helvetica o
Times New Roman). Questa opzione va disabilitata qualora nei files PDF generati i testi,
risultino illeggibili.

Info Sistema

Apre il Dialogo Info di Sistema
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Menu Report

Comandi del menu Report nei vari applicativi
Nel menu Report sono presenti i comandi per ottenere la visualizzazione e la stampa di vari
documenti contabili. I comandi elencati variano a dipendenza dell'applicativo scelto.

Cliccando sui vari link vengono visualizzate le pagine web con le informazioni dettagliate dei vari
comandi.

Cash Manager
Schede conto / categoria
Giornale per periodo
Rendiconto abbellito
Rendiconto abbellito con gruppi
Report contabile
Riassunto IVA (solo per il Cash Manager con opzione IVA)
 

Entrate / Uscite
Schede conto / categoria
Giornale per periodo
Rendiconto abbellito
Rendiconto abbellito con gruppi
Report contabile
Clienti
Fornitori
Riassunto IVA (solo per Entrate / Uscite con opzione IVA)
 

Contabilità in partita doppia e Multimoneta
Schede conto
Giornale per periodo
Bilancio abbellito
Bilancio abbellito con gruppi
Report contabile
Riassunto IVA
Clienti
Fornitori
 

Foglio ore
Report mensile
 

Registro beni ammortizzabili
Visualizza giornale
Report articoli
Report registrazioni contabili
 

Magazzino
Schede magazzino
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Rubrica e indirizzi
Archivia dati

Biblioteche e collezioni
Visualizza articoli non restituiti
Archivia dati
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Menu Azioni

Nel menu Azioni sono presenti i seguenti comandi:

Ricalcola totali
Controlla contabilità 
Ordina registrazioni per data 
Visualizza scadenze
Registrazioni ricorrenti
Blocca registrazioni
Crea nuovo anno
Aggiorna saldi iniziali
Importa in contabilità

Cliccando sui vari link vengono visualizzate le pagine web con le informazioni dettagliate dei vari
comandi.
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Menu Estensioni

Le Estensioni  sono funzionalità del programma per elaborare reporting, calcoli, esportazioni,
importazioni, report fatture, richiami e altro.

Devono essere installate dall'utente, attraverso il menu Estensioni > Gestisci Estensioni  e
nell'ambito della funzionalità specifica, per esempio Importa in contabilità.

Il menu Estensioni elenca tutte le Estensioni già installate, utilizzabili con il file corrente aperto.
Scegliendo il comando, viene eseguita l'Estensione indicata.

Gestione Estensioni
Il comando Gestisci Estensioni permette di cercare, installare, cambiare impostazioni e disinstallare
delle Estensioni.

Installazione di una nuova Estensione
Per l'installazione di una nuova Estensione consultare la pagina Gestione Estensioni.

Informazioni tecniche sulle Estensioni
Alcune informazioni tecniche sulle Estensioni.

Sono dei programmi scritti nel linguaggio Javascript, che fanno uso delle API messe a
disposizione da Banana.
Sono molto sicure, non possono eseguire funzioni che hanno un impatto sul sistema operativo.
Estensioni singole:
file di testo, con estensione .js, che contiene un programma in Javascript, con le caratteristiche
indicate per essere un'Estensione di Banana Contabilità.
Pacchetto di Estensioni:
file compresso, con l'estenzione .sbaa, che può contenere diversi altri file, necessari
all'applicazione, come comandi, immagini, dialoghi. Un pacchetto può contenere diversi
comandi. Nel menu Estensioni viene indicato il titolo del pacchetto e i comandi che contiene.
Se si disabilita un pacchetto, tutte le Estensioni vengono disabilitate.

Requisiti per l'esecuzione delle Estensioni
I comandi per l'esecuzione delle Estensioni sono disponibili unicamente se il file corrente (quello su
cui si sta lavorando) ha le caratteristiche richieste dall'Estensione. Se manca una qualsiasi di queste
caratteristiche, l'Estensione non è visibile o non è eseguibile nel menu Estensioni.

Le Estensioni sono disponibili nel contesto specifico:
Produttività
Comandi che sono richiamabili dal menu Estensioni.
Importazione
Sono disponibili con il comando Importa in Contabilità.
Esportazione
Disponibili nel menu Estensioni. Alla fine l'utente deve indicare il nome con cui salvare il

http://www.banana.ch/doc/it/node/4702
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file.
Report fattura
Estensioni che preparano la stampa della fattura. Sono disponibili dal menu Report >
Clienti > Stampa fatture.
Report Richiamo
Estensioni che preparano la stampa del richiamo. Sono disponibili dal menu Report >
Clienti > Stampa richiami.
Report Estratto
Estensioni che preparano la stampa dell'estratto. Sono disponibili dal menu Report >
Clienti > Stampa estratti.

Associazione a un Tipo File.
Estensioni che richiedono che il file corrente sia per esempio un file di contabilità, oppure, uno
della partita doppia, o indirizzi. 
Associazione tramite una proprietà.
Certe Estensioni prevedono che siano eseguibili unicamente se nelle Proprietà del file, sezione
Varia, è indicata la parola richiesta.
Per esempio le stampe Elenco patrizi, con campi specifici, richiedono la proprietà Patriziato.

Abbonamento piano Advanced necessario
Alcune estensioni sono disponibili nei piani Free e Professional, mentre diverse altre richiedono il
piano Advanced . 
L'informazione sul piano richiesto è indicata nell'estensione stessa. 

Inoltre:

Il piano Advanced è richiesto per eseguire estensioni locali e scaricate da web.
Alcune estensioni che richiedono il piano Advanced possono essere usate anche con altri piani
solo fino a quando la contabilità ha un numero di registrazioni inferiore alle 70 righe.

Sviluppare un'Estensione propria
Chiunque può creare delle Estensioni che estendono le funzionalità del programma:

Sono necessarie delle conoscenze di programmazione.
È necessario avere il piano Advanced  di Banana Contabilità Plus.

Per sviluppare un'Estensione Banana è meglio partire da un progetto esistente. Ecco alcuni consigli:

Parti da un esempio disponibile sul sito github.com\BananaAccounting
Fai riferimento alla documentazione per sviluppatori, disponibile in lingua inglese.
Installa l'Estensione dal menu Estensioni > Gestisci Estensioni .

https://www.banana.ch/it/advanced
https://www.banana.ch/it/advanced
https://github.com/BananaAccounting
http://www.banana.ch/doc/it/node/4702
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Gestione Estensioni

Questo dialogo permette di installare, modificare le impostazioni e disinstallare le Estensioni.
Per utilizzare un'Estensione bisogna prima installarla.

Installazione di una nuova Estensione
Per installare un'Estensione procedere come segue:

Scegliere la lingua e la nazione.
Selezionare dal menu a sinistra Online.
Selezionare il tipo di Estensione  (es. produttività).
Cercare l'estensione desiderata fra quelle elencate; oppure nella casella Cerca digitare il nome
dell'estensione che si desidera.
Cliccare sul bottone Installa.
Cliccare sul bottone Chiudi.

Qui di seguito le Estensioni disponibili:

Le Estensioni installate sono visibili nel menu Estensioni.

Nota

Se nella finestra Estensioni non figura la lista completa delle estensioni, occorre aggiornarle o
estendere la ricerca, selezionando qualunque nazione, qualsiasi lingua e tutto.

Se si attiva Includi estensioni universali, nella lista delle estensioni figurano le estensioni
valide per qualsiasi nazione.

Se nella lista completa non si trova il formato della propria banca, occorre richiedere l'estratto conto

https://www.banana.ch/apps/it/node/8584
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nel formato universale ISO 20022. Presto, tutte le banche sostituiranno i vari formati (csv, MT940....)
con il formato standard europeo ISO 20022.

Elenco Estensioni
Viene mostrato l'elenco delle Estensioni installate e di quelle disponibili per l'installazione.

Il visto indica che l'Estensione è installata.
Titolo dell'Estensione.

Le estensioni che iniziano con "x" (es. "[xCH01]...", "[xUNI02]...") sono estensioni
considerate "deprecated", ovvero estensioni superate nate con vecchie versioni di
Banana che sono poi state sostituite da estensioni più recenti per Banana+.

Informazioni sulle Estensioni:
Descrizione
Link a maggiori informazioni, apre la corrispondente pagina internet.
Ultimo aggiornamento
La data e ora dell'Estensione.
Per le Estensioni locali (aggiunte da file) la data e ora del file.
Categoria
La tipologia dell'Estensione.
Nazione
La nazione per cui è utilizzabile. Internazionale significa che è utilizzabile in più nazioni.
Bottone Installa
Scarica l'Estensione e la mette a disposizione localmente.

Informazioni per le Estensioni installate:
Il simbolo ">" prima del visto indica che è un pacchetto Estensioni, contenente diversi
comandi.
Abilitata
Se non c'è il visto, l'Estensione non appare nel menu. Per un pacchetto si può disattivare
anche solo un comando.
Aggiorna automaticamente
Quando vi è una nuova versione disponibile viene scaricata automaticamente.
Ultimo aggiornamento.
La data delle pubblicazione dell'estensione.
Categoria. 
La categoria dell'estensione.
Nazione.
La nazione dell'estensione. Universale significa che non è legato a una nazione specifica.
Lingua.
La lingua dell'interfaccia dell'estensione.
 Canale predefinito *)
La versione dell'estensione. È possibile scegliere fra

Stable-Channel.
Le versioni rilasciate in via definitiva.
Beta-channel.
Le versioni rilasciate in prova, prima di diventare definitive, ma che devono ancora
essere messe a punto.
Dev-channel.
Le versioni in fase di sviluppo.

Canali disponibili *)
Quali versioni sono disponibili per questa estensione.
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Canale utilizzato*)
La versione in uso.
Se la versione del canale preferito non è disponibile, il programma sceglierà la versione
del canale dando precedenza nell'ordine Stabile, Beta e Developer. 
URI.

Se l'estensione è istallata localmente la posizione locale.
Se l'estensione è remota e non è stata istallata l'url remoto.

URI remoto
Se l'estensione è stata installata da remoto, l'Url del repository remoto.
Proprietà richieste
L'estensione, per potere essere eseguita, richiede che nel menu File > Proprietà del file
(dati base) > Varia   ci siano le proprietà Estensioni.
Bottone Applica proprietà
Inserisce la proprietà indicata nelle proprietà del file corrente.
Bottone Esegui
Esegue l'estensione. 
Questo bottone è visibile solo se il comando è eseguibile nel contesto attuale. 
Per esempio, un comando che richiede una contabilità multi-moneta, può essere eseguito
solo per un file multi-moneta.
Per eseguire una estensione propria è necessario avere un abbonamento al piano
Advanced  di Banana Contabilità Plus.
Bottone Impostazioni
Certe Estensioni permettono d'impostare i parametri per l'esecuzione. Le impostazioni
sono relative al file aperto corrente. Se si usa la medesima Estensione con un altro file si
devono inserire le impostazioni.
Per esempio, nei report fatture si indicano degli elementi necessari per la stampa.
Bottone Disinstalla
Disinstalla l'Estensione o il pacchetto.

Usare una versione di sviluppo
*) Queste funzionalità sono solo disponibili nella versione Dev-Channel di Banana Contablità Insider
Program . 

Se per l'estensione è disponibile una versione di sviluppo questa viene indicato nel "Canali
disponibile".
Nel "Canale predefinito" si può impostare il canale che si preferisce usare fra Stable, Beta o
Developer.
Nella "Canale usato" viene poi visualizzato il canale di sviluppo effettivamente usato.
Se il canale selezionato non è disponibile, viene usata la versione di livello superiore. Se non c'é
il Developer, viene usato il Beta e se non c'é questo lo Stable.

Ricerca Estensioni
Nell'elenco vengono visualizzate le Estensioni che corrispondono ai criteri selezionati:

Lingua
Nazione
Testo
Installata
Vengono visualizzate le Estensioni installate localmente.

http://www.banana.ch/doc/it/node/2573
http://www.banana.ch/doc/it/node/2573
https://www.banana.ch/it/advanced
https://www.banana.ch/it/advanced
https://www.banana.ch/it/insiderprogram
https://www.banana.ch/it/insiderprogram
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Online
L'elenco delle Estensioni disponibili online
Di sistema
L'elenco delle Estensioni. Queste si possono abilitare o disabilitare.

Dettagli
Viene visualizzato un dialogo con le seguenti informazioni:

Il file di origine dove si trova l'Estensione.
Il tipo di Estensione.
La data dell'Estensione.

Parametri
Se l'Estensione permette d'impostare i parametri a livello di programmazione, il bottone è attivo.
Ogni estensione ha i propri parametri. I parametri immessi sono salvati all'interno del file di
contabilità.

Modifica
Permette di modificare l'Estensione selezionata. Va alla cartella dove si trova il file dell'Estensione.

Rimuovi
Rimuove definitivamente l'Estensione selezionata. Non è possibile rimuovere i filtri installati a livello
di sistema o per tutti gli utenti.
Per il momento non è neanche possibile rimuovere delle Estensioni che sono contenute in un file con
l'estensione sbaa. Se si vuole rimuovere l'Estensione bisogna cancellare il file dell'Estensione.

Aiuto (a lato)
Porta alla pagina internet con informazioni sull'Estensione selezionata.

Aggiungi da file
Permette di installare un'Estensione da un file locale. Serve in particolare per lo sviluppo di nuove
Estensioni.
Per creare una estensione propria è necessario avere un abbonamento al piano Advanced  di
Banana Contabilità Plus.

Il file deve sempre trovarsi nella stessa cartella.
Se si modifica l'Estensione, il programma usa sempre l'ultima versione.

Aggiungi da URL
Aggiunge una nuova Estensione, partendo da un link ad un documento disponibile su internet.
Per creare una estensione propria è necessario avere un abbonamento al piano Advanced  di
Banana Contabilità Plus.

https://www.banana.ch/it/advanced
https://www.banana.ch/it/advanced
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Il file viene scaricato da internet.
Il file viene salvato nella cartella dei dati dell'utente.

Aggiorna
Scarica l'ultima versione dei filtri dal server di Banana Contabilità.
Le Estensioni scaricate non devono essere modificate in quanto saranno sovrascritte quando vengono
aggiornate.
Se vi sono nuove Estensioni, queste vengono aggiunte alla lista. I filtri importati non vengono
modificati.

Le Estensioni vengono installate nella cartella utente. Solo l'utente che ha importato o eseguito
l'aggiornamento visualizza le nuove Estensioni.
Per installare delle Estensioni per tutti gli utenti o a livello di sistema, è necessaria una procedura
manuale.

Banana Contabilità, ad ogni avvio dell'applicazione, esegue in automatico l'aggiornamento delle
Estensioni installate. Il controllo automatico viene eseguito una sola volta al giorno al primo avvio. 
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Impostazioni Estensioni

Alcune estensioni permettono di impostare dei parametri che sono usati dall'estensione.

I parametri si possono impostare e modificare con il dialogo.
All'avvio i parametri sono impostati con i valori predefiniti.
I parametri sono relativi al file della contabilità.
Un pacchetto di estensioni, può contenere più estensioni e potrebbero quindi esserci più
parametri per pacchetto.

Dialogo Impostazione Estensioni
Il contenuto del dialogo è diverso per ogni estensioni.
Qui di seguito viene mostrato quello del layout fattura UNI10.

Zona inserimento valori

Il dialogo impostazioni è strutturato come degli elementi che contengono dei sotto elementi, ciascuno
con:

Colonna Proprietà.
Sono elencate le opzioni che permettono di modificare le varie impostazioni nella colonna
Valore.

Colonna Valore.
Per ogni opzione esiste un valore associato nella colonna Valore. Cliccando si può inserire
un valore, cambiarne uno predefinito o cancellarne uno esistente.
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Bottoni

Al termine del dialogo ci sono i seguenti bottoni:

Aiuto.
Il bottone aiuto rimanda alla pagina di documentazione dell'estensione che si sta
utilizzando.

Ripristina valori predefiniti.
Cliccando su questo bottone vengono ripristinati tutti i valori predefiniti della colonna
Valore.

Annulla.
Annulla e chiude il dialogo senza che vengano fatte modifiche.

Ok.
Conferma e salva i parametri inseriti.
Se si è salvato erroneamente, si può ritornare alla situazione precedente con il comando
annulla operazione.

Accedere al dialogo impostazioni
È possibile accedere al dialgo impostazioni nei seguenti modi:

Dal menu Gestione Estensioni, cliccando sul bottone Impostazioni posizionato sulla destra.
Dal bottone Impostazioni nell'Anteprima di stampa del report generato dall'estensione.
Per le fatture, tramite il menu Report → Clienti → Stampa fatture , sezione Layout, bottone
Impostazioni.

http://www.banana.ch/doc/it/node/8295
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Installare un'Estensione in modalità offline

Per installare un'Estensione in modalità offline, procedere come segue:

Tramite un secondo computer connesso a internet, collegarsi alla nostra pagina web Estensioni.

Scaricare l'Estensione che si necessita (file .js o .sba) su una chiavetta USB o un altro
dispositivo.
Copiare l'Estensione sul computer senza connessione internet.
Dal computer senza connessione internet, aprire il programma Banana e il file della contabilità.
Cliccare sul menu Estensioni → Gestione Estensioni.
Cliccare sul bottone Aggiungi da file e selezionare il file indicando il percorso dove è stata
salvata l'Estensione.
L'Estensione figura ora sotto il menu Estensioni.

https://www.banana.ch/apps/en/banana-apps
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Stampa etichette

Dal menu Estensioni > Etichette > Stampa si possono stampare gli indirizzi. Attraverso le varie
sezioni, si possono scegliere varie impostazioni, dal formato etichette alla selezione degli indirizzi da
ordinare e stampare. Ogni impostazione può essere salvata tramite la Personalizzazione.

Per la spiegazione delle diverse sezioni consultare le pagine che seguono:

Opzioni
Etichetta
Estrai
Ordina
Personalizzazione
 

Esempio di stampa
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Opzioni

Posizione prima etichetta

Si può decidere la posizione della prima etichetta. I valori Orizzontale 1 e Verticale 1 si riferiscono
all’angolo in alto a sinistra del foglio.

Numero copie per ogni etichetta

Il valore iniziale 1 si riferisce ad una copia per ogni etichetta.

Avvisa se il testo accede l'etichetta
L'opzione è attiva per default. Se l'indirizzo eccede i margini dell'etichetta c'è un avviso.

Formato etichette

Si può selezionare uno dei formati delle etichette, presenti nella lista.
Se nella lista non è presente il formato desiderato, con il bottone Cambia si accede alla finestra di
dialogo Formati etichette e si scelgono le impostazioni desiderate.

Dati

Indicare la sorgente dove prendere i dati delle etichette da stampare:

Tabella - vengono stampati i dati della tabella corrente (Conti, Registrazioni, Preventivo, Totali,
Codici IVA) . Nel caso in cui sono state eseguite delle estrazioni di indirizzi, il programma
stampa solo gli indirizzi estratti.
Solo righe selezionate - vengono stampati solo gli indirizzi precedentemente selezionati.
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Etichetta

Lista campi

Sono elencati tutti i campi possibili per le etichette. S può inserire un nuovo campo in due modi
diversi:

Doppio click su di un elemento dell’elenco.
Click su di un elemento dell’elenco, confermando con il pulsante Aggiungi campo

Il campo selezionato viene inserito alla posizione del cursore nell’area Vista etichette. È possibile
inserire dei campi direttamente, scrivendo il nome del campo tra i caratteri minore o maggiore.

Vista etichetta

Visualizza la disposizione dei campi. Le stringhe "<NOME CAMPO>" vengono sostituite con il valore
corrispondente della tabella.

I segni maggiore e minore sono considerati dei delimitatori di campo. Per fare apparire nel testo il "<"
scrivere "\<" per ">" scrivere "\>" per "\" scrivere "\\".

Mantieni interruzione di riga e spazi
Se l'opzione è disattivata, in caso di spazi e righe vuote, il programmali non li prende in
considerazione.
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Estrai

La spiegazione di questa sezione è disponibile alla pagina Estrai righe del menu Dati.
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Ordina

La spiegazione di questa sezione è disponibile alla pagina Ordina righe del menu Dati.
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Personalizzazione

Le spiegazioni di questa finestra sono disponibili alla pagina Personalizzazione.
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Formati etichette

Dal menu Estensioni → Etichette → Formati si accede alle impostazioni delle etichette.

Il programma fornisce già una vasta gamma di formati di etichette predefiniti; è possibile inoltre
impostare, modificare i parametri per default e quelli personalizzati tramite il comando
Personalizzazioni (Predefinito) .
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Impostazioni pagina - Opzioni

Pagina
Margine Sinistro, Margine Destro, Margine Alto, Margine Basso
Inserire i margini in centimetri; se non viene inserito alcun valore, i margini risultano a zero.

Num. Etichette orizzontale
Inserire il numero delle etichette presenti sulla dimensione orizzontale del foglio delle etichette.

Num. Etichette verticale
Inserire il numero delle etichette presenti sulla dimensione verticale del foglio.

Stampa pagina orizzontale
Viene impostata la stampa della pagina in orizzontale.

Disponi etichette da destra a sinistra
Le etichette vengono stampate da destra a sinistra e dall'alto in basso.

Etichetta
Margine Sinistro, Margine Destro, Margine Alto, Margine Basso
È possibile lasciare un margine per ciascuna etichetta; i valori per i margini dell’etichetta vanno
inseriti in centimetri.

Centra il testo orizzontalmente
Se si seleziona la casella, il testo di ogni singola etichetta viene centrato orizzontalmente nello spazio
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dell’etichetta.

Centra il testo verticalmente
Se si seleziona la casella, il testo di ogni singola etichetta viene centrato verticalmente nello spazio
dell’etichetta.

Dimensione carattere

Base
Dimensione standard del carattere.

Automatica, ma non inferiore a
Il programma calcola per ogni etichetta la dimensione massima possibile dei caratteri, partendo da 14
punti sino ad arrivare ad 8 punti. Il calcolo viene effettuato considerando sia la dimensione
orizzontale, sia quella verticale. Se un’etichetta ha una riga molto lunga (o un numero di righe così
elevato) da non poter essere stampata interamente, viene inserito un messaggio d’avviso nella
finestra Messaggi. Anche se incompleta, l’etichetta viene stampata in ogni caso.

Nota

Le stampanti non stampano su tutta la superficie di un foglio perché hanno bisogno di un minimo di
margine; il programma cerca di adattare le singole etichette ai valori della pagina di stampa.
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Imposta pagina - Personalizzazione

Tutte le impostazioni attivate nella sezione Opzioni possono essere salvate tramite la
Personalizzazione e all'occorrenza visualizzate.
Per maggiori informazioni su questa sezione, consultare la pagina Personalizzazione .
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Menu Preferiti

I Preferiti sono delle visualizzazioni di stampe o report con impostazioni personalizzate.

Il menu Preferiti presenta l'elenco di tutte le Personalizzazioni create e che possono essere
facilmente richiamate in caso di necessità.

Il menu Preferiti non è visibile di default, ma appare quando l'utente crea delle personalizzazioni (la
prima volta occorre chiudere e riaprire il file contabile), indicando che queste devono apparire nel
menu.
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Come ottenere le Personalizzazioni

La Personalizzazione è una visualizzazione o una stampa con delle impostazioni personalizzate che
vengono memorizzate. All'occorrenza si possono riprendere i documenti personalizzati, senza ripetere
le impostazioni.

Le Personalizzazioni si ottengono dai seguenti menu e per i seguenti documenti :

 Report - per quanto concerne:
Schede conto
Bilancio abbellito
Bilancio abbellito per gruppi
Report contabile
Riassunto IVA

File per quanto concerne:
Crea dossier Pdf
Esporta file

Dati per quanto concerne
Estrai e ordina righe ed
Esporta righe

Estensioni - per le personalizzazioni degli indirizzi.

Come procedere

A dipendenza del documento da creare, si parte cliccando sul menu e sul comando appropriato
(Schede conto, Bilancio, Esporta file...).

Dalla finestra di dialogo che appare:

Cliccare nella sezione Personalizzazione.
Cliccare sul bottone Nuova.
Inserire il nome della nuova personalizzazione.
Attivare le opzioni del caso nelle varie sezioni.
Cliccare sul bottone Applica.
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Ogni personalizzazione creata, appare nel menu del comando corrispondente e può essere
modificata, rinominata, duplicata o eliminata.

Nome

Inserire un nome per identificare la personalizzazione (es. Bilancio trimestrale).

Descrizione

Inserire una descrizione per la personalizzazione.

Visualizza ogni volta questa finestra

Se la funzione viene attivata, quando si seleziona la personalizzazione dal menu, viene visualizzata la
finestra di dialogo che permette di modificare le impostazioni. Se non attivata, viene visualizzata
direttamente l'anteprima del documento richiesto (Bilancio, Report....).

Visualizza in comando ...(a dipendenza del comando in cui ci si trova)

Se la funzione è attiva, la personalizzazione appare nel menu del comando.

Visualizza in menu Preferiti

Se la funzione viene attivata, la personalizzazione apparirà nel Menu Preferiti .

Solo lettura

Se l'opzione viene attivata, non è possibile effettuare modifiche alle impostazioni.
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Nuova

Permette di creare una nuova personalizzazione.

Elimina

Permette di eliminare una personalizzazione.

Duplica

Permette di creare una copia identica (un duplicato) di una personalizzazione già esistente.

Importa

Permette l'importazione di una personalizzazione già esistente da un altro file di contabilità Banana
(.ac2).

Applica

Permette salvare le impostazioni scelte per la nuova personalizzazione.

Visualizzazione nel menu di partenza
A seconda del menu di partenza vengono visualizzate la personalizzazione predefinita e le
personalizzazioni salvate.

Personalizzazione (Predefinito)

È la personalizzazione usata per default dal programma, se non è stata ancora creata alcuna altra
personalizzazione.

Nell'esempio si tratta di una personalizzazione creata per il Report contabile.

Accesso diretto alle personalizzazioni
Nelle tabelle dove vengono visualizzate le personalizzazioni e nelle anteprime vengono riportati il
menu delle personalizzazioni e l'icona delle impostazioni, che permettono di passare facilmente
da una personalizzazione all'altra e di avere un accesso più rapido alle impostazioni, qualora occorre
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apportare delle modifiche.
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Menu Finestra

Nuova finestra
Il comando apre una nuova finestra con gli stessi contenuti della finestra già aperta.

Disponi affiancate
Con questo comando si possono vedere, all'interno del programma Banana Contabilità, i vari files
aperti contemporaneamente, disposti in modo affiancato. Se si dispone di due schermi, è anche molto
pratico aprire due volte il programma Banana Contabilità e in ognuno avere aperto un file contabile; si
dispone in questo modo di maggiore spazio visivo. Per maggiori informazioni vedi sotto.

Visualizzare due file contemporaneamente
I due file vengono visualizzati all'interno dello stesso programma. La finestra Info in basso cambia a
seconda del file in cui si sta lavorando con il cursore.

Ci sono due modalità per vedere due o più files contemporaneamente.

Aprire due file affiancati in Banana Contabilità

Aprire i due files tramite il menu File > Apri.
Cliccare sul menu Finestra > Disponi affiancate.

 

Aprire contemporaneamente due volte il programma Banana Contabilità

Aprire il programma Banana Contabilità due volte, a partire dall'avvio di Windows.
In ognuno dei programmi aprire un file contabile.

Ottima soluzione se si ha uno schermo largo o due schermi collegati allo stesso computer.

https://cdn.banana.ch/portal/repodata/ghba/doc10/italian/images/disponi_affiancate.png
https://cdn.banana.ch/portal/repodata/ghba/doc10/italian/images/disponi_affiancate.png
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Prossima finestra o Precedente finestra
I comandi permettono di passare da una finestra all'altra. Risulta molto utile anche il tasto di scelta
rapita Ctrl+Tab.

Avvisa messaggi, Segnale acustico, Vuota messaggi
Nella parte riservata ai messaggi si può scegliere se e come questi devono essere segnalati. Se si
attiva Vuota messaggi, vengono eliminati tutti i messaggi nella finestra informativa in basso.

Aspetto
Il comando permette di personalizzare l'interfaccia  e dispone delle seguenti opzioni:

Visualizza menu Sviluppo
Vedi approfondimenti su Menu Sviluppo.
Visualizza editor cella
Se la visualizzazione è disattivata, in alto sotto la barra degli strumenti non appare l'editor per
scrivere testi, ma è sempre possibile scrivere i testi all'interno di ogni cella.
Visualizza tasto editor riga
Se attivato viene visualizzato il tasto per modificare i contenuti delle righe. Cliccando sul tasto
editor riga in basso a destra, verrà visualizzata una finestra in cui sarà possibile modificare le
singole righe tramite una visualizzazione di tipo formulario. Questa modalità è stata pensata per
agevolare l'inserimento dei testi su device tablet o mobile.
Visualizza finestra informazioni
Se disattivata, non viene visualizzata la finestra in basso delle informazioni, grafici e messaggi
di errore.
Visualizza barra di stato
Se disattivata non viene visualizzata la barra di stato in fondo alla finestra, dove viene riportato
il numero di riga e l'impostazione dello zoom.
Tema del display
Questa opzione permette l'impostazione della funzionalità del dark mode nelle seguenti
modalità:

Predefinito di sistema - viene ripresa l'impostazione dal proprio sistema operativo.
Scuro - viene impostata la modalità scura.
Luminoso - viene impostata la modalità chiara.

Anteprima
Il comando permette di andare alla finestra di anteprima di stampa.

Pagina iniziale
Con il comando si può scegliere se visualizzare o meno la pagina iniziale.

Lista File aperti di recente
In basso al menu Finestra vengono elencati i file aperti di recente. Risulta selezionato il file in uso, gli
altri rimangono in sottofondo.

https://www.banana.ch/doc/fr/interface
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Menu Sviluppo

Disponibile in Banana Contabilità Plus solo con il piano Advanced  > passa ora al piano
Advanced .

Il menu Sviluppo è visibile solo se viene attivata l'opzione in:

Menu Finestra > Aspetto > Menu Sviluppo

Opzioni di sviluppo
Contiene opzioni utili agli sviluppatori di scripts, estensioni o pagine http per Banana Contabilità.

Attiva cattura immagine (Ctrl+3)
Se la funzione è attivata, con la combinazione dei tasti Ctrl + 3 si possono salvare le immagini delle
tabelle e delle finestre di dialogo del programma.
Vedi anche Cattura immagini.

Visualizza pannello Debug output
Se attivata il pannello 'Debug output' , nella parte bassa della finestra principale del
programma. In questo pannello vengono visualizzati tutti i messaggi di debug. I messaggi di
debug permettono di verificare il corretto funzionamento durante l'esecuzione di scripts, estensioni o
chiamate al web server. Essi sono indirizzati agli sviluppatori di scripts, estensioni o fogli http. Per
ulteriori informazioni consultare la pagina Debugging.

Con il tasto destro si attivano le diverse modalità di visualizzazione:

Livello Avvisi
Livello Debug
Vengono visualizzati anche i messaggi di programmazione.
Livello Info
Vengono visualizzati i messaggi principali.

Info sistema
Apre il Dialogo Info di Sistema.

https://www.banana.ch/it/update
https://www.banana.ch/it/upgrade
https://www.banana.ch/it/upgrade
http://www.banana.ch/doc/en/node/4735
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Cattura immagini

Questa funzione è disponibile utilizzando i tasti Ctrl+3. Facilita la cattura e il salvataggio di
un'immagine del programma.
Per poterla utilizzare occorre attivarla tramite il menu Sviluppo → Attiva cattura immagine (Ctrl+3).
È utile per preparare della documentazione, perché riprende la parte che interessa del programma.

Finestra cattura e ridimensiona
Permette di scegliere il tipo di cattura e anche di ridimensionare la finestra di Banana per adattarla
alle esigenze di creare delle immagini ottimali.

Cattura

Quando si cattura un'immagine si consiglia di usare lo zoom (90%) in modo che nell'immagine
risultino più dati, ma facendo in modo che i testi siano comunque leggibili.

Cattura tutto
Crea un'immagine della finestra completa di Banana.
Cattura finestra principale e dialogo
Comando visualizzato solo se si cattura un dialogo. Cattura la finestra Banana con il dialogo
sovrapposto.
Estrai dal Print Screen
Per creare immagini che visualizzano il Menu aperto, combox o altri elementi grafici che
scompaiono quanto si preme Ctrl+3.
Comando visualizzato solo se nel clipboard c'é una immagine della dimensione dello schermo.

Premere il tasto Print Screen così che il sistema operativa crea nel clipboard un'immagine
dello scremo.
Dare questo comando. Il programma estrae dall'immagine della clipboard della stessa
dimensione della finestra Banana.

Cattura tabella e finestra info
Cattura la tabella e la finestra info in basso (senza menu, toolbar e status bar).
Comando disponibile solo se è aperto un file.
Cattura tabella
Cattura la tabella fino al bordo della finestra interna.
Comando disponibile solo se è aperto un file.
Cattura colonne
Cattura solo la tabella, solo fino alla larghezza massima delle colonne (non include lo spazio
bianco).
Comando disponibile solo se è aperto un file.

Ridimensiona Windows to (pixel)

Ogni computer e schermo ha delle risoluzioni diverse. Il ridimensionamento permette di creare
immagini uniformi su diversi schermi.
Viene visualizzata la dimensione della finestra attuale in pixel e il rapporto larghezza altezza e
proposte diverse scelte.

(*) Ridimensiona alla dimensione suggerita tenendo conto della definizione dello schermo e
delle preferenze dei caratteri.
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Ridimensiona a 1920 x 1200 px -16x9. Dimensione usata per i video.
Ridimensiona a 1280x 720 px -16x9. Dimensione usata per immagini da pubblicare sul sito.

Nascondi / Visualizza componenti della finestra

Nel Menu Finestra  > Aspetto puoi scegliere quali elementi dell'interfaccia rendere visibili (toolbar,
l'info Window e la status bar) e quindi visualizzare più righe di registrazione.

Ridimensionamento e salvataggio immagine
Nota bene: una volta che si è cliccato sulla dimensione scelta, la finestra Banana apparirà nella
nuova dimensione. Poi, per catturare l'immagine nella nuova dimensione, si deve applicare di nuovo
CTRL-3 e scegliere Cattura tutto, Cattura tabella o Cattura colonne. o quello che volete.

Questo dialogo viene visualizzato dopo la cattura. Prima di salvare l'immagine su disco è possibile
decidere se deve essere ridimensionata.

La dimensione attuale dell'immagine.
(*) L'immagine rapportata alla larghezza di 1280 pixel (quella usata per pubblicare sul sito). Il
rapporto originale viene mantenuto.
Se si è catturato un dialogo, con una larghezza minore rispetto alla finestra di Banana, verrà
proposta una dimensione che mantiene la relazione rispetto alla dimensione 1280. In questo
modo quando si pubblicano le immagini sul sito avranno una larghezza sempre proporzionata.
(*) L'immagine rapportata alla larghezza di 1920 pixel (quella usata per dei video). Per i video
bisogna però ricordarsi che il rapporto 16x9 è obbligatorio.

L'immagine viene salvata nella clipboard, per cui si può incollarla in word o programmi di edizione
testi.

Dopo avere scelto da dimensione il programma visualizza il dialogo per salvare il file.

La directory è l'ultima usata.
Come nome del file viene proposto quella interna.
Il formato di salvataggio è PNG.
Se si annulla l'immagine rimane comunque salvata nella clipboard.

Windows - Rimuovere l'ombra dai dialoghi
Windows 8 e 10 "abbelliscono" i dialoghi inserendo un'ombreggiatura. Nella cattura dell'immagine si
vede quindi anche lo sfondo.

Per evitare che questo succeda:

Con il cerca dare il comando Sysdm.cpl.
Andare nella sezione Avanzato.
Effetti visuali Impostazioni.
Togliere il visto al Visualizza ombreggiatura.
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Info sistema

Questa sezione visualizza informazioni sul sistema operativo e l'ambiente di lavoro. Le informazioni
possono essere richieste dal supporto tecnico. In questo caso cliccare sul bottone Copia negli
appunti e incollare i dati nel messaggio di posta elettronica o nel formulario di contatto.
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Menu Aiuto

Il menu Aiuto permette di accedere ai seguenti comandi:

Guida utente - si accede alla documentazione che spiega le varie funzionalità del programma
e le tematiche contabili.
Tasti di scelta rapida  - contiene la lista di tutti i tasti di scelta rapida con la descrizione
dell'uso.
Controlla aggiornamenti - si collega al nostro sito per vedere se esistono versioni più recenti
del programma.
Centro di supporto  - si accede alla pagina web del supporto di Banana Contabilità.
Gestisci abbonamento 
Il dialogo per gestire l'abbonamento, indicante le seguenti informazioni:

Email con cui si è registrati e la possibilità di rimuoverla.
Versione in uso e la scadenza.
Link  per sbloccare la versione in uso con un codice product key.
Link per acquistare un abbonamento.
Link che verifica la disponibilità di un abbonamento aggiornato.

Informazioni su Banana Contabilità.
Apre una finestra che visualizza le informazioni tecniche, come la versione in uso, il numero di
serie, Copyright.....

https://www.banana.ch/it/download
https://www.banana.ch/it/download
https://www.banana.ch/it/support
https://www.banana.ch/it/support
https://www.banana.ch/doc/it/activate
https://www.banana.ch/doc/it/activate
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Tasti di scelta rapida

È possibile consultare la lista dei tasti di scelta rapida anche direttamente dal programma,
selezionando il comando Tasti di scelta rapida dal menu Aiuto.

Tasti di scelta rapida per Windows
Tasti di scelta rapida per Mac

 Tasti di scelta rapida per sistemi operativi Windows
Tasti funzioni contabili Descrizione
F9 Esegue un ricalcolo semplice.
Shift+F9 Esegue un ricalcolo globale.

F6 Questo tasto esegue diverse funzioni a seconda della colonna in cui ci si
trova e vengono spiegate nella finestra informativa.

Alt+ Clic sinistro Visualizza la scheda conto se su un numero di conto o la tabella estrai
righe.

. (Punto) In una colonna di tipo data inserisce la data del giorno corrente.
Tasti di modifica Descrizione
Invio, Tab Avanza di una cella confermando il testo digitato.
Alt+Invio Avanza di una riga confermando il testo digitato.
Shift+Tab Indietreggia di una cella confermando il testo digitato.
F2 Modifica del contenuto di una cella.

Doppio clic Modifica del contenuto di una cella. Nelle opzioni programma è possibile
selezionare di modificare il contenuto di una cella con un sigolo click.

Backspace, Spazio Cancella il contenuto della cella corrente ed entra in modifica.
Backspace Elimina il carattere precedente tornando indietro con il cursore.
Canc Cancella i caratteri seguenti.
Ctrl+C Copia il testo o le celle selezionati.
Ctrl+V Incolla il testo o le celle copiati.
Canc Cancella il contenuto della selezione.
non assegnato Cancella il testo dalla posizione del cursore alla fine della cella.
F4 Copia la cella precedente della medesima colonna.
Shift+F4 Copia la cella precedente della medesima colonna e avanza di una cella.
Ctrl+Shift+C Copia le righe selezionate.
Ctrl+Shift+V Inserisce le righe copiate.
Ctrl+- Cancella le righe selezionate.
Ctrl+D Duplica righe selezionate
Ctrl++ Inserisce righe al di sopra della posizione del cursore.
Ctrl+Invio, Ctrl+Invio Aggiunge una riga al di sotto della posizione del cursore.
Tasti di spostamento Descrizione
Sinistra Spostamento verso sinistra.
Destra Spostamento verso destra.
Su Scrorri in su.
Giù Scorri in basso.
Pag↑ Scorri una schermata verso l'alto.
Pag↓ Scorri una schermata verso il basso.
↖ Spostamento all'inizio della riga.
Fine Spostamento alla fine della riga.
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Ctrl+↖ Spostamento all'angolo superiore sinistro della tabella.
Ctrl+Fine Spostamento all'angolo inferiore destro della tabella.
Ctrl+Sinistra Spostamento verso sinistra fino al bordo dell'area dati corrente.
Ctrl+Destra Spostamento verso destra fino al bordo dell'area dati corrente.
Alt+Su Sposta righe su
Alt+Giù Sposta righe giù
Ctrl+Su Spostamento verso l'alto fino al bordo dell'area dati corrente.
Ctrl+Giù Spostamento verso il basso fino al bordo dell'area dati corrente.
Alt+Pag↓ Vista successiva.
Alt+Pag↑ Vista precedente.
Ctrl+Pag↓ Tabella successiva.
Ctrl+Pag↑ Tabella precedente.
Ctrl+Tab Passa alla finestra successiva.
Ctrl+Shift+Tab indietro Passa alla finestra precedente.

F5 Permette di spostarsi alla riga voluta, digitando nella finestra attiva il
numero di riga.

Shift+F5 Va alla riga d'origine.
Tasti di selezione Descrizione
Shift+Pag↑ Seleziona la colonna andando verso l'alto, pagina per pagina.
Shift+Pag↓ Seleziona la colonna andando verso il basso, pagina per pagina.
Shift+Sinistra Seleziona la riga verso sinistra.
Shift+Destra Seleziona la riga verso destra.
Shift+Su Seleziona la colonna verso l'alto.
Shift+Giù Seleziona la colonna verso il basso.
Shift+↖ Seleziona fino ad inizio riga.
Shift+Fine Seleziona fino a fine riga.
Ctrl+Shift+↖ Seleziona fino ad inizio finestra.
Ctrl+Shift+Fine Seleziona fino a fine finestra.
Ctrl+A Seleziona tutta la tabella.
Altri tasti Descrizione
Ctrl+F4 Chiude finestra attiva.
non assegnato Chiude il programma.
Ctrl+N Nuovo file.
Ctrl+S Salva.
Ctrl+O Apri.
Ctrl+P Stampa.
Esc Interrompe operazione in corso.
Ctrl+Z Funzione Annulla operazione.
Ctrl+Y Funzione Ripristina operazione.
Ctrl+F Trova.
F3 Trova successivo.
Shift+F3 Trova precedente.
Ctrl+B Grassetto.
Ctrl+I Italico.
F1 Visualizza guida.
Ctrl+3 Salva immagine del dialogo o tabella corrente.
Tastiera multimediale Eseguito tramite

Tasto funzione (ad es. F6)Premere il tasto fn così come il corrispondente tasto funzione (ad es. Fn +
F6).
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 Tasti di scelta rapida per sistemi operativi Mac (Apple)
I tasti di scelta rapida su computer Apple sono leggermente diversi da quelli Windows. La principale
differenza è che al posto del tasto Crtrl sulla tastiera Mac vi è il tasto Command. Trovi la lista
completa sotto il menu Aiuto → Tasti di scelta rapida.
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Informazioni su Banana Contabilità+

Nella finestra Informazioni (menu Aiuto → Informazioni su Banana Contabilità+), trovi diverse
informazioni sul programma.

Versione
È ben visibile il numero di versione che stai usando (es. 10.0.4) di Banana Contabilità+
Banana Contabilità Plus, numericamente è la versione 10, che verrà continuamente migliorata, per cui
ci saranno numerazioni supplementari 10.0.1, 10.0.2, ecc. per ogni release successiva.
Importante: per qualsiasi questione tecnica, prima di contattare il servizio di supporto, assicurati di
avere l'ultima release (scaricandola dalla nostra pagina di download )

Insieme al numero di versione trovi anche il numero di serie, l'indirizzo web e le informazioni di
Copyright.

Brevetti e informazioni legali
In questa sezione trovi nuovamente le informazioni di Copyright, i patent di Banana Contabilità e le
dichiarazioni di trademark.
Trovi anche l'indicazione di tutte le piattaforme di programmazione che utilizza il programma con le
relative licenze e copyright.

Riconoscimenti
In questa sezione vengono attribuiti i riconoscimenti a tutti coloro che hanno partecipato e
partecipano ancora attivamente allo sviluppo, manutenzione e promozione del nostro programma.

https://www.banana.ch/it/download
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Messaggi di errore

Quando il programma riscontra degli errori, compare una finestra di dialogo che li segnala:

Seleziona il bottone OK per visualizzare ogni singolo messaggio.
Attivando l'opzione Non segnalare, tutti i messaggi di errore segnalati dal programma
vengono salvati nella finestra Messaggi di errore.
Le informazioni sul bottone Aiuto sono disponibili al paragrafo Aiuto contestuale .

Avvisi e messaggi di errore
Elenco completo messaggi errore
Per informazioni sulla finestra dei messaggi vedi anche pagina Interfaccia.

Se il programma segnala degli errori
Consulta l'aiuto relativo all'errore segnalato: nelle finestre 'Info' e 'Messaggi' (dove appaiono i
messaggi di errore), di fianco al messaggio di errore, appare il simbolo . Cliccando su questo
simbolo, sarai collegato direttamente alla pagina online corrispondente all'errore, contenente le
possibili cause e soluzioni.
 
Se l'errore persiste:

Aggiorna il programma all'ultima versione disponibile, nella seguente pagina web
Download .
Ricontrolla la contabilità (menu Azioni).
In una contabilità multimoneta, controlla che siano state calcolate le differenze di cambio
(menu Azioni).

Disattivazione e Riattivazione avviso messaggi
Per disattivare/riattivare la visualizzazione del dialogo dei messaggi:

dal menu Finestra metti o togli il visto sul comando Avvisa messaggi.
dal menu Azioni lancia il comando Controlla contabilità.

https://banana.ch/doc/it/node/2740#aiuto_contestuale
https://www.banana.ch/doc/it/banana-error-details/it
https://www.banana.ch/it/node/11181
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Applicativi di Contabilità

Banana Contabilità Plus include vari applicativi per la gestione della contabilità, facili nell'uso e che
permettono di ottenere risultati immediati. Il Cash Manager è completamente gratuito, perché è
incluso nel piano Free di Banana Contabilità Plus; mentre gli altri applicativi sono gratuiti fino a 70
registrazioni nel piano Free e illimitati nei piani Professional e Advanced .

Guarda il video: ▶ Contabilità in 3 semplici passi

Gli applicativi contabili di Banana Contabilità Plus:

Cash Manager - Libro cassa
Il modo più semplice per gestire i movimenti
della cassa o di un altro conto patrimoniale,
con possibilità di classificare le entrate e le
uscite per categoria.

 

Contabilità Entrate e Uscite
Per tenere una contabilità completa con
diversi conti patrimoniali, con una  modalità
semplificata che non richiede conoscenze
del Dare e dell'Avere.

Contabilità in partita doppia
Usa la contabilità in partita doppia,
professionale per eccellenza, dalla struttura
personalizzabile. Le operazioni vengono
classificate indicando il conto Dare e Avere.

 

Contabilità in partita doppia multi-moneta
La contabilità in partita doppia con la
possibilità di tenere anche conti in diverse
monete. Gestisci facilmente più valute e
sfrutta la comodità del calcolo automatico
per le fluttuazioni di cambio.

Per tutti gli applicativi contabili sono disponibili diverse funzionalità. Ecco le principali:

Gestione IVA 
Gestione IVA automatizzata e personalizzabile.
Rendiconto IVA svizzero anche in formato XML da
caricare sul sito dell'AFC.

 

Previsione finanziaria 
Imposta il piano finanziario, della
liquidità e degli investimenti. Crea
simulazioni per essere sempre un passo
avanti.

https://www.banana.ch/it/buy
https://www.banana.ch/it/node/11354
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Fatturazione integrata
Crea/gestisci fatture nel tuo file contabile. Tutto
in uno per una gestione perfetta. Le fatture
vengono inserite come righe di registrazione.
Grafica personalizzabile, richiami ed estratti
conto.

 

Gestione clienti e fornitori
Funzioni fondamentali per tracciare le
proprie fatture e i propri pagamenti.
Applicabile sia alle contabilità sul
fatturato che sull'incassato.

Principali funzionalità contabili
I diversi applicativi contabili mettono a disposizione diverse funzionalità, che possono essere attivate
o aggiunte secondo necessità. 
Il programma mantiene la facilità d'uso in quanto, se una funzionalità non viene usata, non viene
attivata.

Fatturazione integrata alla contabilità

Inserimento fatture come normali righe di registrazioni.
Colonne per diversi contenuti, attinenti alle fatture.
Con o senza IVA.
Possibilità di modificare e correggere.
Stampa della singola fattura o di diverse fatture assieme con un semplice comando.
Scelta fra diversi formati di stampa disponibili e parametrizzabili.
Esportazioni in formato digitale tramite estensioni.
Richiami ed estratti conto personalizzabili.

Gestione IVA

Supporta qualsiasi specifica nazionale:

Tabella codici IVA per indicare le diverse aliquote e casistiche IVA. Supporta qualsiasi
operazione IVA.
Calcolo IVA in automatico, al netto o al lordo.
Rendiconti IVA di controllo.
Trasmissione elettronica dei dati IVA sulla piattaforma IVA della Confederazione Svizzera.
Estensioni nazionali per rendicontazione IVA in base ai requisiti delle autorità fiscali.

Pianificazione finanziaria

Per ditte esistenti o startup.
Inserimento della pianificazione tramite registrazioni di preventivo.
Prende a carico automaticamente le spese o le entrate ripetitive (affitto, stipendi, spese
bancarie, ecc.).
Possibilità d'indicare il codice articolo, quantità e prezzo.
Formule di calcolo in Javascript per automatizzare i valori dipendenti (calcolo interesse
sull'utilizzo effettivo di un prestito).
Il programma allestisce in automatico piani finanziari, completi di piano della liquidità, bilancio e
conto economico previsionale e movimenti previsionali su di un conto.
Proiezioni finanziarie automatiche su più anni.
Visualizzazione a scelta per periodo.
Confronto preventivo e consuntivo.
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Impostazione contabile

Il programma supporta qualsiasi moneta. La sigla della moneta è scelta dall'elenco o impostata
liberamente. 
Possibilità di cambiare il numero di decimali (generalmente 2), da 0 fino a 12 decimali per
gestire cripto-monete.
Periodo contabile impostato liberamente, sia come anno solare sia con data d'inizio e fine
diverse dall'anno solare.
Scelta libera della lingua della contabilità.

File e salvataggio dati (modalità simile a Excel)

Modalità applicata a tutti gli applicativi di Banana Contabilità:

Creazione nuovo file partendo da modelli preimpostati o da propri file.
I dati di un anno contabile sono salvati in un unico file.
Il file può risiedere su qualsiasi supporto, computer, rete, cloud o inviato per email.
Possibilità di gestire un numero illimitato di contabilità, di qualsiasi tipo.
Accesso ai dati in contemporanea da più utenti, solo una persona può invece aprire lo stesso file
in modifica.

Piano dei conti

Piano e struttura conti completamente personalizzabile.
Numero di conto e di gruppo numerici o alfa-numerici.
Possibilità di aggiungere note o altre colonne.
Raggruppamento e totali adattabili a qualsiasi schema di raggruppamento nazionale.
Saldo, movimento conto e totali visualizzati e sempre aggiornati.
Centri di costo e di profitto, per il controllo dettagliato dei costi e ricavi di attività specifiche o di
progetti.
Segmenti per la rendicontazione per settore (succursale).
Anagrafica clienti, con controllo fatture in sospeso, richiami ed estratti conto.
Anagrafica fornitori, controllo fatture pagate e in sospeso.
Gestione clienti e fornitori non a bilancio (con centro di costo) per contabilità gestite con il
metodo di cassa.
Conti fuori bilancio.

Registrazioni

Registrazioni singole o collettive (su più righe).
Metodo di competenza o di cassa.
Modo d'uso tipo Excel, selezione, copia e incolla, aggiunta righe, cerca e sostituisci.
Suggerimenti, auto-completamento e memorizzazione operazioni ripetitive per un'immissione
più veloce.
Numerazione documenti automatica o libera.
Possibilità di modificare i dati inseriti, disporre o aggiungere colonne e qualsiasi altra
informazione. 
Collegamento ai file delle ricevute digitali (pdf, immagini) e apertura del documento con un
click.
Importazione dati da estratti bancari:

Sono supportati diversi formati.
Possibilità di completare o rimuovere le operazioni importate. 
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Colorazione delle righe.
Possibilità di avere viste diverse delle colonne.
Informazioni contestuali circa il saldo del conto, differenze o errori.

Blockchain protezione delle registrazioni

Protezione dei movimenti inseriti con tecnologia di certificazione dati digitale (tipo Bitcoin).
Conforme ai requisiti di legge.
Invio dati al revisore con la certezza dell'impossibilità di manomissioni.

Report standard e personalizzati

Bilancio, Conto Economico, Giornale, Schede conto.
Salvataggi personalizzati di stampa.
Esportazione e collegamento dati verso Excel.

Grafici

Visione dell'evoluzione dei conti.
Confronto preventivo e consuntivo.
Visibili immediatamente mentre si registra. 

Controllo contabilità

Comando per un controllo contabilità, efficace ed accurato. In un attimo, la contabilità viene
ricalcolata come se si inserissero tutte le operazioni nuovamente.
Segnalazione di eventuali impostazioni sbagliate, differenze o errori.
Ogni segnalazione è collegata a una pagina di aiuto che spiega le cause e le soluzioni.
Possibilità di correggere sempre.

Chiusura e passaggio al nuovo anno

Procedura automatica per creare il file del nuovo anno, con riporto dei saldi e attribuzione
dell'utile.
Si può iniziare a lavorare sul nuovo anno, anche se non si è chiuso il precedente.
Comando per riprendere i saldi definitivi quando si è chiuso l'anno precedente.
Possibilità di aggiungere e stampare delle note di fine anno.
Comando per archiviare in Pdf tutti i dati e le stampe.

Varia

Creazione di nuovi file partendo da un file esistente.
Conversione da un tipo di file contabile ad un altro, per poter crescere e aggiungere
funzionalità.
Aggiunta altre tabelle:

Tabella Articoli:
Per indicare elementi da riprendere in fatturazione. 
Può servire come una piccola gestione inventario o titoli.

Tabella Documenti:
Per memorizzare delle immagini (logo della ditta) o dei documenti di testo (per
esempio programmi in Javascript).

Altre tabelle:
Si possono aggiungere delle tabelle dove inserire delle note o altre informazioni. Le
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tabelle possono essere personalizzate aggiungendovi delle colonne.

Report XBRL

Possibilità di creare delle istanze di file XBRL adatti alle diverse nazioni.
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La Contabilità in partita doppia

La Contabilità in partita doppia è un applicativo di Banana Contabilità Plus, per gestire i tuoi conti con
precisione e affidabilità, seguendo il metodo più riconosciuto e utilizzato a livello internazionale della
partita doppia. L'utilizzo richiede nozioni di contabilità.

È ideale per: imprese, organizzazioni e associazioni con e senza scopo di lucro, enti governativi,
liberi professionisti, lavoratori autonomi e altre entità economiche che necessitano un sistema
completo e professionale per tenere la contabilità in modo accurato e conforme agli standard
contabili. È ideale anche per le scuole per insegnare la contabilità. Tante scuole in tutto il mondo
usano già il nostro applicativo con successo.
 

▶ Video: Come iniziare una Contabilità in partita doppia
Scopri tutte le caratteristiche della Contabilità in partita doppia
Come iniziare

Basato sul metodo della partita doppia: La struttura del piano contabile si basa sui conti Attivi,
Passivi, Costi e Ricavi. Ogni transazione viene registrata in almeno due conti, con una parte registrata
come addebito su un conto e l'altra parte come accredito su un altro conto. Questo assicura che
l'equazione contabile fondamentale, attivo è uguale al passivo, sia sempre bilanciata.

Registrazioni automatizzate, veloci e precise: La tabella Registrazioni è il fulcro principale
dove si registrano tutti movimenti della contabilità. Il programma sulla base delle registrazioni riporta
in automatico i movimenti nelle schede dei conti utilizzati e aggiorna i saldi. Tutti i saldi dei conti
vengono aggiornati nella tabella Conti dove a colpo d'occhio si ha subito una visione dell'andamento
aziendale e della situazione finanziaria. 

Rendiconti professionali e accurati: sulla base delle registrazioni inserite, tramite le innovative
funzioni d'importazione automatica o inserite manualmente dall'utente, il programma elabora in
automatico in un istante il Bilancio, il Conto Economico, le Schede Conto, il Giornale, Budget e altre
rendicontazioni. 

Tante funzioni e maggiori automazioni innovative

Inizio immediato: Scegli uno dei tanti modelli  per le esigenze più svariate.
Registrazioni veloci: importazione dall'ebanking, memorizzazione di operazioni ripetitive con
Regole di autocompletamento .

https://www.banana.ch/it/node/11351
https://www.banana.ch/apps/it
https://www.banana.ch/doc/it/rules


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 266

Controlli immediati: con la colonna Saldo puoi vedere rapidamente se ci sono degli sbilanci tra
le colonne Dare e Avere e, da quale riga partono le differenze.
Saldi aggiornati dopo ogni registrazione, con indicazione del risultato d'esercizio.
Documenti allegati a portata di click: collega ogni registrazione al relativo documento digitale.
Importazione ed Esportazione dati.
Bilancio e Conto economico, Schede conto, Giornale in un clic.
Contabilità analitica per progetti, settori o attività particolari grazie ai Centri di costo/profitto e i
Segmenti.
Rendiconti IVA automatizzati con dati in Xml per l'inoltro online .
Crea il preventivo per la pianificazione finanziaria e quella relativa ai costi e ricavi e assicurati
un futuro senza incertezze.

Approfondimenti

Organizzare i documenti contabili
Contabilità sul fatturato o incassato
Gestione IVA
Contabilità doppia multimoneta

https://www.banana.ch/it/node/10878
https://www.banana.ch/area/it/node/11053
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Come iniziare una Contabilità in partita
doppia

▶ Video: Come iniziare una Contabilità in partita doppia . Scopri come creare una nuova contabilità
in partita doppia, adattare il piano dei conti, impostare un budget, inserire le registrazioni e stampare
il rendiconto.

 Creare una contabilità partendo da un modello
Banana Contabilità Plus include modelli per tutte le forme giuridiche, suddivisi per nazione e per
categoria. Possono essere aperti direttamente dal programma, dal menu File, comando Nuovo,
oppure possono essere scaricati dal nostro sito internet dalla pagina Modelli .

Qui di seguito viene spiegata la procedura d'inizio partendo da un modello direttamente dal
programma:

Menu File → Nuovo.1.
Seleziona la Regione, la categoria e il tipo di contabilità.2.
Dalla lista dei modelli che appare, sceglie quello che più si avvicina alle tue esigenze.3.
Clicca sul bottone Crea.4.

Nella casella Cerca inserendo una parola chiave, il programma visualizza i modelli che la contengono.

È anche possibile iniziare da un file vuoto, attivando l'opzione Crea file vuoto. In ogni caso, per
facilitare l'inizio ed evitare errori di raggruppamenti, consigliamo di iniziare sempre da un modello
esistente.

Maggiori informazioni per creare un nuovo file sono disponibili alla pagina Crea nuovo file.

Impostare le proprietà del file (dati base)
Dal menu File → Proprietà file (Dati base) indica il nome della ditta che deve apparire sulle
intestazioni delle stampe e su altri dati.
Seleziona la moneta base con la quale viene gestita la contabilità.

https://www.banana.ch/it/node/11351
https://www.banana.ch/apps/it
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Salvare su disco
Con il comando File → Salva con nome , vengono salvati i dati, assegnando un nome al file. Appare il
dialogo di salvataggio tipico del sistema operativo in uso.

Per il salvataggio consigliamo di usare il nome della ditta, seguito dall'anno "es.
Rossi_2020.ac2" per distinguerlo da altri file di contabilità.
Puoi tenere quante contabilità servono, ciascuna avrà il proprio nome.
Puoi scegliere il percorso e il supporto su cui salvare il file (salvare su disco, chiavetta o cloud).
Se prevedi di avere anche dei documenti collegati alla contabilità dell'anno in corso,
consigliamo di creare una cartella separata per ogni anno contabile dove raggruppare tutti i file.
Consulta anche la pagina organizzare i file .

Uso del programma in generale
Banana Contabilità Plus si ispira a Excel. Il modo d'uso e i comandi sono mantenuti il più possibile
simili a quelli di Microsoft Office.
Per informazioni sull'uso si rimanda alla spiegazioni circa l'Interfaccia del programma .

Personalizzare il piano dei conti
Nella tabella Conti puoi personalizzare il piano contabile secondo le tue esigenze.

È possibile:

Aggiungere ed eliminare dei conti esistenti (vedi aggiungere un nuova riga).
Cambiare i numeri di conto, la descrizione (es. inserire il nome del ccb della propria Banca),
inserire altri gruppi, ecc.
Per creare dei sottogruppi, consultare la pagina web Gruppi.
Definire dei Centri di costo o dei Segmenti che servono a catalogare in modo più dettagliato e
specifico gli importi.

http://www.banana.ch/doc/it/node/3909
http://www.banana.ch/doc/it/node/3909
http://www.banana.ch/doc/it/node/3909
https://www.banana.ch/it/node/11059
https://www.banana.ch/doc/it/interface
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Le Registrazioni
Le registrazioni devono essere inserite nella tabella Registrazioni e costituiscono il Libro Giornale.

Nelle apposite colonne:

Inserire la data.
Inserire il numero di documento, uguale a quello assegnato manualmente al documento
cartaceo. Questo consente di ritrovare facilmente i documenti, una volta contabilizzata
l'operazione contabile.
Inserire la descrizione.
Nel conto Dare inserire il conto di destinazione.
Nel conto Avere inserire il conto di provenienza.
Inserire l'Importo.
Nella contabilità con IVA, inserire l'Importo lordo e il codice IVA. Il programma scorpora l'IVA
separando il costo o il ricavo netto.

Rendi visibile la colonna Saldo nella tabella Registrazioni

La nuova colonna Saldo è una funzione utilissima: ti permette di vedere all'istante eventuali
differenze.
Per usare la colonna Saldo la devi rendere visibile tramite il menu Dati → Disponi colonne.

Guarda il Video: Colonna Saldo per rilevare le differenze contabili
Maggiori informazioni sulla colonna Saldo

https://www.banana.ch/it/node/11369
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Velocizzare l'inserimento delle Registrazioni

Puoi velocizzare l'inserimento delle registrazioni con le seguenti funzioni:

Immissione dati con autocompletamento - consente la ripresa in automatico dei dati già inseriti
in precedenza.
Registrazioni ricorrenti - memorizza i movimenti che si ripetono in una tabella e possono essere
riprese all'occorrenza.
Importazione dati dall'estratto bancario o postale - importa tutti i movimenti dall'estratto
bancario, postale o carta di credito, nel file della contabilità.

Registrazioni con IVA

Per poter registrare delle operazioni con IVA, all'inizio occorre:

Scegliere la contabilità in partita doppia con IVA dal menu File → Nuovo.
Scegliere uno dei Piani contabili già predisposti , in cui sia presente la tabella Codici IVA, con
tutti i codici IVA in vigore.
Per le registrazioni con IVA, consultare la pagina Registrazioni della gestione IVA.

Registrazioni composte

Per le Registrazioni composte, quelle che concernono addebiti e/o accrediti su più conti (es. quando si
pagano fatture diverse con il conto corrente bancario) occorre registrare su più righe:

Una riga per ciascun conto di addebito e/o accredito.
Quando tutti gli addebiti e accrediti sono stati inseriti non ci devono essere differenze.

Per maggiori dettagli, consultare la pagina Registrazioni composte.

Controllo fatture clienti e fornitori
Banana Contabilità Plus permette di tenere sotto controllo le fatture da incassare dai clienti e da
pagare ai fornitori. Gli approfondimenti sono disponibili alle pagine web seguenti:

Sottomenu Clienti
Sottomenu Fornitori

Le Schede conto
Le schede conto riportano in automatico tutti i movimenti registrati sullo stesso conto (Es. i movimenti
della cassa, banca, clienti, ecc...).

https://www.banana.ch/apps/it
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Per visualizzare la scheda di un conto, basta posizionarsi con il mouse sul numero di conto e cliccare
sul piccolo simbolo che appare in alto a destra della cella.

Schede conto per periodo

Per visualizzare le schede conto con i saldi riferiti ad un determinato periodo, procedere come segue:

Menu Report → Schede conto.
Nella sezione Periodo attivare Specificato, inserendo la data di inizio e di fine periodo.

Per maggiori informazioni consultare la pagina Periodo.

Stampare una scheda conto

Per stampare una scheda conto, basta visualizzare la scheda da qualsiasi tabella (Conti o
Registrazioni) e lanciare la stampa dal menu File.

Stampare tutte o alcune schede conto

Per stampare tutte o alcune schede conto, procedere come segue:

Menu Report → Schede conto,
 Selezionare le schede conto da stampare:
Tramite il filtro presente nella finestra, si può eseguire una selezione in automatico di tutti i
conti, centri di costo, segmenti, gruppi o semplicemente si possono selezionare solo i conti
desiderati.

Maggiori informazioni sono disponibili alla pagina Scheda conto.

Il Bilancio
Il Bilancio visualizza i saldi di tutti i conti patrimoniali, Attivi e Passivi, con l'indicazione del Capitale
proprio.
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Il Conto Economico
Il Conto Economico visualizza tutti i conti dei Costi e dei Ricavi, con l'indicazione dell'Utile o della
Perdita d'esercizio.

Stampa del Bilancio e del Conto economico
In Banana Contabilità Plus, il Bilancio e il Conto economico, possono essere stampati e visualizzati in
due modi diversi:

Nella modalità Bilancio Abbellito, viene visualizzato un bilancio con la semplice elencazione di
tutti i conti, senza distinzione dei Gruppi e Sottogruppi.
Nella modalità Bilancio Abbellito con gruppi, viene visualizzato il bilancio con i conti
suddivisi in gruppi e sottogruppi; inoltre ci sono tante funzionalità per personalizzare la
presentazione che non sono previste nel Bilancio Abbellito.

Per stampare il Bilancio e il Conto economico nelle due modalità:

Dal menu Report → Bilancio abbellito
Dal menu Report → Bilancio abbellito con gruppi

http://www.banana.ch/doc/it/node/3313
http://www.banana.ch/doc/it/node/3314
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Archiviazione dati in PDF
A fine anno, quando tutta la contabilità è stata completata, corretta e revisionata, si possono
archiviare tutti i dati contabili:

dal menu File → Crea dossier in Pdf .

Il Preventivo
Prima di iniziare un anno contabile si può elaborare la pianificazione finanziaria e il budget dei costi e
ricavi (o delle entrate e uscite), per avere sotto controllo la situazione economica e finanziaria della
propria ditta.

Il preventivo può essere impostato in due modi differenti:

Preventivo annuale impostato nella tabella Conti, colonna Preventivo . Per ogni conto viene1.
indicato l'importo di preventivo annuale. In questo caso, quando si elabora il Preventivo dal
menu Report → Rendiconto abbellito con gruppi, la colonna del preventivo riporta gli
importi che si riferiscono all'intero anno.
Preventivo impostato nella Tabella Preventivo. La tabella Preventivo si attiva dal menu2.
Strumenti → Aggiungi nuove funzionalità.
In questa tabella si registrano tutti i movimenti riferiti ai costi e ai ricavi (o entrate e uscite)
come se si dovessero registrare i movimenti nella tabella Registrazioni. Nel caso che si attivi
questa tabella, la colonna Preventivo della tabella Conti viene disattivata automaticamente.

Maggiori informazioni sono disponibili nella pagina Preventivo.

http://www.banana.ch/doc/it/node/2600
http://www.banana.ch/doc/it/node/9342
http://www.banana.ch/doc/it/node/9342
http://www.banana.ch/doc/it/node/9342
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Caratteristiche Contabilità in partita doppia

L'applicativo Contabilità in partita doppia soddisfa i criteri professionali per le società ed enti di
qualsiasi genere dove è richiesta per legge la tenuta della contabilità.

È uno strumento molto potente, ma anche flessibile e facile da usare, perché le diverse
funzionalità sono attivabili e disattivabili. Questo ti permette di gestire sia contabilità essenziali,
sia altre con piani conti strutturati su più livelli: con IVA, controllo clienti e fornitori, fatturazione,
centri di costo e segmenti.
Puoi sempre modificare, per cui tutti possono avere risultati perfetti. È ideale per il contabile
esperto che vuole lavorare velocemente e per chi inizia. Per questo motivo è usato per
insegnare la contabilità in molte scuole .

▶ Video: Come iniziare una Contabilità in partita doppia

Simile a Excel

Funzionalità e comandi simili a Excel

Tutti i dati che inserisci nelle tabelle sono sempre visibili e a portata di mano.
Lavori velocemente perché puoi selezionare, copiare e incollare, su più celle e più righe le
registrazioni che si ripetono.
Se sbagli puoi correggere annullando o ripristinando le operazioni.
Aggiungi quante righe vuoi senza limiti, o elimina le  righe di cui non hai bisogno.
Se hai sbagliato un valore, un conto, un codice IVA, una descrizione, con la funzione Cerca e
sostituisci correggi in un attimo
Non hai bisogno d'inserire formule perché i calcoli vengono aggiornati immediatamente e hai
una visualizzazione contestuale (come nei fogli di calcolo).
Tutto quello che si vede può essere stampato o esportato in PDF o altri formati.
Puoi impostare il  logo della tua azienda per personalizzare le intestazioni di stampa.
Le colonne sono personalizzabili, puoi modificarne la posizione, aggiungerne di nuove e
cambiarne la larghezza.
Lavora con il formato che ti è più congeniale.
Colora le righe per individuare subito le registrazioni che devi rivedere, far controllare al
commercialista o completare.

Basato su tabelle

La gestione della contabilità si concentra in tre tabelle, che si usano in modo simile alle tabelle di
Excel, ma che sono già completamente impostate e programmate con tutto quanto serve per tenere
la contabilità in modo veloce e sicuro. 

Tabella Conti
È dove imposti tutti i conti della liquidità, dei clienti, dei fornitori, ecc. e inserisci i saldi iniziali
(senza doverli registrare manualmente nella tabella Registrazioni). Puoi raggruppare più conti
insieme, come per esempio la cassa, la banca o la posta nel gruppo della liquidità, così in un
attimo hai i saldi aggiornati che puoi verificare immediatamente.
Tabella Registrazioni
È il cuore della tenuta contabile, dove si inseriscono o importano i movimenti. Le registrazioni
Dare e Avere, possono essere completate con ulteriori informazioni per gestire clienti e fornitori,

https://www.banana.ch/it/education
https://www.banana.ch/it/node/11351
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emettere fatture, gestire centri di costo/profitto, segmenti, quantità e prezzi e quant'altro sia
necessario. Scorrendo la tabella si ha una visione completa di tutti gli accadimenti. Si può
modificare in modo da avere una contabilità sempre perfetta.
Tabella Totali
Questa tabella presenta i totali per Gruppo e serve per controllare la quadratura contabile.

Ulteriori tabelle che si possono aggiungere e che supportano ulteriori funzionalità.

Tabella Preventivo
Usata per allestire previsioni finanziarie, con il metodo della partita doppia. È completa di piano
della liquidità, bilancio e conto economico previsionale, previsioni clienti, fornitori, investimenti,
progetti, segmenti per uno o più anni.
Tabella Codici IVA
Per impostare le aliquote e i parametri necessari da usare nella tabella Registrazioni per il
calcolo automatico dell'IVA e i rendiconti da presentare alle autorità fiscali.
Tabella Articoli
Per impostare un elenco di articoli da usare per la fatturazione. Il programma tiene nota delle
entrate e delle uscite.
Tabelle libere
Per fare fronte ad ulteriori necessità.

Inizio veloce

Modelli

La gestione della contabilità si concentra principalmente su tre tabelle, che si usano in modo simile
alle tabelle di Excel, ma che sono già completamente impostate e programmate con tutto quanto
serve per tenere la contabilità in modo veloce e sicuro:

Avvio facile e immediato, creando il file della tua contabilità partendo da un modello.
Se hai già un modello tuo in Banana Contabilità puoi riprenderlo con tutte le impostazioni e
utilizzarlo per una seconda contabilità.
Oltre 1000 modelli suddivisi per nazione e tipologia di utenza, personalizzabili e con
documentazione d'uso .
Ricerca facile e uso dei modelli direttamente nel programma .

Impostazione contabile

Per la tua contabilità imposta liberamente la moneta, scegliendola da un elenco di monete
mondiali o impostandola liberamente (cripto monete). 
Imposta liberamente un periodo contabile, anche su più anni e non legato al classico periodo
dal 1 di gennaio al 31 di dicembre.
Intestazioni e dati base contabilità impostate in un'unica finestra di dialogo, facile da
visualizzare.
Inserisci quanti decimali vuoi, da 0 a 27 (scelti al momento della creazione della contabilità) .
Puoi cambiare il numero dei decimali della contabilità durante l'anno senza problemi.

Multi-lingue

Hai libertà di scelta della lingua della contabilità, quando crei il tuo file . 
Personalizza le intestazioni delle colonne come desideri.
Puoi avere contabilità in più lingue contemporaneamente.

http://www.banana.ch/apps/it?combine=&langcode=it&country=All&category=All&type=All&op=Invia#
http://www.banana.ch/apps/it?combine=&langcode=it&country=All&category=All&type=All&op=Invia#
https://www.banana.ch/apps/it/node/9296#templateid
http://www.banana.ch/doc/it/node/2566
https://www.banana.ch/doc/it/install


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 277

Personalizza le Stampe anche per più lingue.

File e salvataggio dati

Hai tutti i dati salvati in un unico file, dove trovi facilmente tutto senza perdite di tempo.
Per ogni anno crei un File separato. Tutti i dati sono riferiti all'anno e non ci sono confusioni.
Attribuisci al file il nome che desideri.
Con una sola licenza puoi gestire un numero illimitato di contabilità. 
I dati rimangono in tuo completo possesso.
Salva i dati del su qualsiasi supporto, computer, rete, cloud o inviali per email . Puoi accedervi
ovunque tu sia.
Accesso in contemporanea da più utenti, dove però solo una persona può aprire il file in
modifica.
Rendi più sicura la tua contabilità inserendo una protezione con password.

Pianifica-Esegui-Controlla
Con lo stesso file e sempre con il metodo della partita doppia, puoi fare la contabilità, oppure le tue
previsioni o entrambi. Puoi facilmente usare il potente approccio gestionale Pianifica - Esegui -
Controlla .

 Metodo contabilità in partita doppia

Banana Contabilità ti permette di tenere la contabilità con il metodo internazionale della partita
doppia, conforme agli standard internazionali.
Soddisfa i criteri per la tenuta di qualsiasi contabilità.
Utilizzabile in qualsiasi nazione.
Registrazioni con colonne Dare e Avere.
Se nelle registrazioni ci sono degli sbilanci, hai la segnalazione della differenza.
Nelle colonne hai la visualizzazione degli importi nel formato usato dal tuo computer, senza
doverti abituare ad altri formati a te non congeniali.

Importi in dare in positivo e in avere in negativo.
Calcoli secondo l'equazione Dare - Avere = 0 .

Bilancio, Conto Economico e tutte le tipiche stampe contabili.
Stampe tutte personalizzabili.
Formato di visualizzazione a scelta.

Registrazioni secondo il principio di cassa o di competenza .
Proteggi i tuoi dati con la tecnologia all'avanguardia del blockchain (metodo brevettato) .
Il metodo della partita doppia è usato da molte scuole in tutto il mondo, per insegnare la
contabilità.

Piano dei conti

Piano conti completamente personalizzabile per rispondere meglio alle tue necessità .
Lo stesso piano conti lo utilizzi per la contabilità e per le previsioni finanziarie, patrimoniali e di
reddito.
Schema di Bilancio e Conto economico adattabili secondo la struttura e i contenuti di cui hai
bisogno.
Supporta qualsiasi schema di raggruppamento nazionale, internazionale o libero .
Conti fuori bilancio per la gestione delle partite che non devono essere incluse nel Bilancio, ma
che hai bisogno di annotare.
Scegli tu l'identificativo del conto liberamente (conto numerico o alfa-numerico, fino a 256

https://www.banana.ch/it/node/11059
http://www.banana.ch/it/pianifica-esegui-controlla
http://www.banana.ch/it/pianifica-esegui-controlla
https://www.banana.ch/it/node/10964
https://www.banana.ch/it/node/10968
http://www.banana.ch/doc/it/node/3353
http://www.banana.ch/it/education
http://www.banana.ch/it/education
http://www.banana.ch/doc/it/node/2629
https://www.banana.ch/it/node/9892
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caratteri).
La descrizione del testo puoi inserirla liberamente fino a 256 caratteri.
Non serve più inserire il bilancio iniziale e finale nelle scritture contabili
Inserisci i saldi direttamente nella colonna Apertura della tabella Conti e solo la prima volta che
usi Banana Contabilità. Negli anni successivi il riporto è automatico.
Saldo, movimento conto e totali visualizzati contestualmente e sempre aggiornati.
Ad ogni conto del cliente, fornitore, socio hai le colonne per inserire gli indirizzi e altri dati utili
che necessiti.
Aggiunta di altre colonne per note, raggruppamento o importi.
Se aggiungi delle colonne di tipo importo, queste sono totalizzate automaticamente.
Hai così la possibilità di creare delle colonne con dati propri e avere dettagli molto selettivi.

Registrazioni

Puoi inserire Registrazioni singole o composte.
Quelle singole le registri su un'unica riga, mentre quelle composte ti permettono di registrare
senza problemi operazioni che toccano più conti.
Puoi registrare sia con il Metodo di competenza o con quello di Cassa .
Quando registri ti vengono proposti i testi già inseriti. Basta un click per completare la
registrazione (auto-completamento ).
Segnalazione immediata di errore e differenze, con possibilità di completarli successivamente.
Memorizza le operazioni ripetitive per riprenderle quando si ripresentano senza doverle
riscrivere.
In tutte le tabelle hai delle colonne colonne predefinite che può rendere visibili a scelta.
Colonne quantità e prezzo, per fatturazione o controllo costi.
Auto-numerazione documenti con numerazioni diverse contemporaneamente.
Per avere documenti in ordine e sempre a portata di mano, collega ai file i giustificativi digitali
(pdf, immagini), e aprili con un click.
Inserisci testi liberi fino a 256 caratteri e anche su più righe.
Colora le righe per cercare subito le registrazioni che devi verificare o correggere in seguito,
oppure per segnalarle al revisore.
Aggiunta di colonne per inserire qualsiasi ulteriore informazione. 
Registrazioni su centri di costo / profitto.
Registrazioni su segmenti.
Salva la disposizioni delle colonne (viste) per visualizzare i contenuti per te più importanti.
Informazioni contestuali circa saldo del conto, differenze o errori.
Prima delle chiusure periodiche o di fine anno puoi usare le Registrazioni di verifica saldo.
Potrai individuare errori tra i saldi effettivi (es. saldi bancari fornite dall'estratto, e quelli della
contabilità). Ti accorgerai subito degli errori e puoi correggere per avere tutto in perfetto ordine.
Importazione movimenti:

Velocizza l'inserimento delle registrazioni importando i dati dagli estratti bancari digitali.
Puoi importare i movimenti nei diversi formati bancari .
Le righe importate possono essere modificate, completate o rimosse. 
Importa anche dati fatture o da altri programmi.

Previsione finanziaria

Se necessiti di creare un preventivo puoi attivare la funzione aggiungendo la tabella Preventivo.
Lavori senza difficolta con la stessa metodologia a cui sei già abituato, basata sul metodo della
partita doppia .
Previsioni finanziarie completi di piano della liquidità
Previsioni di Bilancio.

http://www.banana.ch/doc/it/node/2626
https://www.banana.ch/it/node/10968
http://www.banana.ch/doc/it/node/2740#autocompletamento
http://www.banana.ch/doc/it/node/2740#autocompletamento
https://www.banana.ch/apps/it/extensions?combine=&langcode=it&country=All&type=All&op=Invia#
https://www.banana.ch/it/previsione-finanziaria
https://www.banana.ch/it/previsione-finanziaria
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Previsioni di Conto economico.
Proiezioni automatica per più anni.
Inserimento della pianificazione tramite registrazioni di preventivo.
Entrate e uscite ricorrenti impostate con una sola registrazione.
Tutte le funzionalità disponibili in contabilità:

Registrazioni semplici o su più conti.
Previsioni per clienti
Previsioni per fornitori, IVA, Centri di costo e profitto, segmenti.
Quantità e prezzi.

Formule di calcolo in Javascript con accesso ai valori della previsione in corso :
Piano crescita della cifra d'affari.
Calcolo commissioni e costi in percentuali delle vendite.
Calcolo ammortamenti.
Calcolo interessi.
Utilizzo di variabili.

Valori di previsioni disponibili nelle stampe contabili:
Completamente personalizzabili.
Visualizzazioni previsioni per mese, trimestre, semestre, anno.
Confronti previsione e attuale.

Scheda conto con movimenti di previsione per conto o gruppo.

Bilancio e Conto Economico 

Rendiconti con dati consuntivi, o preventivi oppure con entrambi i dati e con indicazione degli
scostamenti.
Disposizione libera con gruppi e sottogruppi.
Risultati aggiornati visibili direttamente nella tabella conti.
Stampe personalizzabili:
Guarda il video tutorial  che mostra come creare e stampare il bilancio abbellito con gruppi.

Aggiunta del proprio logo.
Scelta delle colonne da includere.
Scelta delle sezioni da includere.
Stampa dettagliata o raggruppata.
Stampe  per solo un periodo.
Colonne con suddivisione per periodo (mese, trimestre, semestre, anno).
Valori anno precedente.
Valore di previsione confronto.
Colonne con suddivisione per segmento.
Aggiunta note allegate.
Raggruppamento come nel piano dei conti o secondo un proprio schema.
Salvataggio della personalizzazione.

Report tabellare (simile alle stampe personalizzabili, ma con i dati presenti nella tabella).
Esportazione in pdf per la conservazione dei dati ed esportazione in altri formati per una
rielaborazione dati.

Altre stampe contabili

Contenuto tabelle completamente stampabile o stampa anche solo per selezione.
Aggiunta del proprio logo per una personalizzazione dei documenti e delle stampe.
Giornale.
Schede con movimenti conto e gruppi:

Con i movimenti contabili o quelli di previsione.

http://www.banana.ch/doc/it/node/9314
https://www.banana.ch/it/node/11490


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 280

Per periodo.
Per Conto, Gruppo, Centro di Costo o Segmento.
Dati contabili o di previsione.
Disposizione colonne personalizzabile.

Esportazione in pdf o altri formati.

Grafici

Contestuali, a piè di tabella.
Diverse disposizioni.
Evoluzione dei conti e gruppi.
Valori contabili.
Previsione.
Anno precedente.
Scelta del tipo di grafico.

 Ulteriori gestioni
Il programma ti consente anche di aggiungere ulteriori informazioni alle registrazioni, in modo che gli
stessi dati ti servono anche per la gestione IVA, per il controllo dei clienti e fornitori, emissione di
fatture, avere rendiconti per progetti o settori d'attività e fare fronte ai diversi adempimenti societari
e fiscali.

Gestione IVA

Funzione attivabile a scelta (quando si crea una contabilità).
Tabella codici IVA per indicare le diverse aliquote e casistiche IVA.
Supporta qualsiasi specifica nazionale.
Può essere usato anche per gestire altri tipi di tasse di vendita (p.es. Sales tax Americana).
Inserimento in registrazione del Codice IVA.
Funzionalità di storno IVA (usando il Codice IVA preceduto dal segno meno).
Calcolo IVA dal netto o dal lordo.
Scomposizione e registrazione automatica sui conti IVA indicati .
Rendiconti IVA di controllo:

Per periodo o completo.
Con o senza movimenti.
A scelta con totali per aliquota, codice IVA, conto.

Estensioni nazionali per rendicontazione IVA in base ai requisiti delle autorità fiscali.

Gestione e controllo clienti

Funzione attivabile a scelta (aggiungendo i conti nel piano dei conti).
Controllo fatture e pagamento dei clienti.
Anagrafica cliente impostata nel piano dei conti.
Crea gruppi e totali per clienti in gruppi diversi.
Fatture aperte per cliente o completa.
Estratto conto movimento cliente e fatture aperte.
Riconciliazione automatica, fatture aperte.
Gestione clienti anche come Centri di costo (per principio di cassa).

https://www.banana.ch/area/it/node/10504
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Fatture ai clienti

Funzione attivabile a scelta (utilizzando la colonna numero fattura nella tabella registrazione)
Inserimento fatture direttamente nella tabella Registrazioni.
Richiede l'impostazione dell'anagrafica clienti.
Inserimento dei dati fatture come normali righe di registrazioni.
Vedi emissione e stampa fatture ai clienti.
Colonna per indicare quantità e prezzi.
Con o senza IVA.
Possibilità di modifica, correzione.
Stampa della singola fattura con un click o di diverse fatture assieme.
Scelta fra diversi layout di stampa .
Personalizzazione della fattura in base alle proprie preferenze .
Esportazioni in formato digitale tramite estensioni.
Richiami personalizzabili con estensioni.
Estratti conto clienti personalizzabili con estensioni.

Gestione fornitori

Funzione attivabile a scelta (aggiungendo i conti nel piano dei conti).
Anagrafica fornitori impostata nel piano dei conti.
Possibilità di raggruppare i fornitori in gruppi diversi.
Controllo fatture e pagamento ai fornitori.
Fatture aperte per fornitore o report completo.
Estratto conto movimento fornitore e fatture ancore aperte.
Riconciliazione automatica, fatture aperte.

Centri di costo e di profitto

Funzione attivabile a scelta (aggiungendo i conti centri di costo e profitto).
Per progetti, contabilità costi o di redditività.
Impostazione dei centri di costo direttamente nel piano dei conti.
Raggruppamento multi-livello.
Tre livelli di centri di costo e profitto.
Numero illimitato di centri di costo per livello.
Registrazione in negativo (con segno meno).
Reportistica come i conti di bilancio e conto economico:

Saldo costantemente aggiornato.
Report personalizzabili .
Scheda di tutti i movimenti con saldo progressivo.
Grafico contestuale.

Segmenti

Funzione attivabile a scelta (aggiungendo i conti segmenti).
Colonna segmenti
Per avere il bilancio e il conto economico di uno o più settori aziendali.
Impostazione dei segmenti direttamente nel piano dei conti .
Raggruppamento multi-livello.
Fino a 10 livelli di segmento.
Numero illimitato di segmenti per livello.
Saldo costantemente aggiornato.

https://www.banana.ch/apps/it/node/9034
https://www.banana.ch/apps/it/node/9514
http://www.banana.ch/doc/it/node/7218
http://www.banana.ch/doc/it/node/2622
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Reportistica come i conti di bilancio e conto economico:
Report personalizzabile.
Scheda di tutti i movimenti con saldo progressivo.
Grafico contestuale.

Bilancio e Conto economico per ogni segmento .

Tabella Articoli

Per fatture e con gestione integrata di magazzino o dei titoli.
Collegamento degli articoli ai movimenti della tabella Registrazioni.
Aggiornamento automatico movimenti in entrate e uscita.
Valore iniziale e finale.
Aggiunta di ulteriore colonne.

Controllo e chiusura

Segnalazioni errori e controllo contabilità

Comando per controllare la contabilità.
In un attimo, la contabilità viene ricalcolata come se si inserissero tutte le operazioni
nuovamente.
Segnalazione di eventuali impostazioni sbagliate, differenze o errori.
Ogni segnalazione è collegata a una pagina di aiuto che spiega le cause e la soluzione.
Verifica se il saldo del conto corrisponde a quello reale (cassa, banca, IVA) .
Possibilità di correggere.

Protezione delle registrazioni

Protezione righe.
Blocco dei movimenti inseriti con tecnologia di certificazione dati digitale (tipo Bitcoin).
Protezione con password.
Conforme ai requisiti di legge.
Invio dati al revisore con la certezza dell'impossibilità di manomissioni.
Sblocco movimenti con data.

Chiusura e nuovo anno

Procedura automatica per creare il file del nuovo anno.
Riporto dei saldi e attribuzione dell'utile.
Si può iniziare a lavorare sul nuovo anno, anche se non è  stato chiuso il precedente.
Comando per riprendere i saldi definitivi quando  è stato chiuso l'anno precedente.

Esportazione e archiviazione dati

Copia e incolla direttamente da e per Excel.
Esportazione tabelle in pdf e diversi altri formati.
Archiviazione delle stampe e dei dati contabili in pdf o altri formati.
Salvataggio del file contabile su qualsiasi supporto.

Estensioni e altre funzionalità

http://www.banana.ch/doc/it/node/3265#segmento
https://www.banana.ch/doc/it/node/9753/#checkbalance
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Aggiunta funzionalità

Aggiunta di nuove funzionalità.
Rimozione di funzionalità non più necessarie.
Conversione da un tipo contabile a un altro:

A contabilità con o senza IVA.
A contabilità con multi-moneta o viceversa.
Da contabilità entrata e uscite a doppia o viceversa.

Tabella Documenti

Per memorizzare delle immagini (logo della ditta) o dei documenti di testo (per esempio
programmi in Javascript).

Altre Tabelle aggiuntive

Aggiunta di altre tabelle dove inserire delle note o altre informazioni.
Le tabelle possono essere personalizzate aggiungendovi colonne.

Estensioni

Estensioni predefinite per diverse stampe e altre funzionalità .
Ricerca e istallazione veloce.
Estensioni personalizzabili.
Aggiornamento automatico.
Possibilità di creare e istallare delle proprie estensioni locali .

Documentazione completa
Ogni dialogo ed errore ha una propria pagina di documentazione accessibile con un clic .
Documentazione aggiornata costantemente .
Domande e risposte .
Documentazione disponibile anche in formato PDF.

http://www.banana.ch/apps/it/extensions
https://www.banana.ch/it/node/9386
https://www.banana.ch/doc/it/banana-error-details/it
https://www.banana.ch/doc/it/documentation
https://www.banana.ch/it/node/9340
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Proprietà file

Nelle proprietà file vengono definiti i parametri principali del file contabile, come l'intestazione, la
data di apertura e chiusura, la moneta base, l'indirizzo della ditta, il conto IVA, la password, ecc.

La finestra di dialogo delle Proprietà file ha diverse sezioni che vengono spiegate nelle pagine web
seguenti:

Contabilità
Opzioni
Indirizzo
IVA
Varia
Password
Testi
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La Struttura della tabella Conti

La tabella Conti è la cabina di regia della contabilità. Il modo d'uso è simile a quello di una tabella di
Excel.
Nella tabella Conti imposti tutto quanto serve per gestire la contabilità e avere una rapida panoramica
aggiornata della situazione finanziaria ed economica della tua azienda.

Tabella Conti già pronta all'uso
Ogni applicativo di contabilità Banana ha una una grande varietà di piani contabili, già pronti all'uso.
Basta scegliere il file, il cui modello soddisfi le proprie esigenze e ci si ritrova con la Tabella Conti già
impostata. I modelli di file possono essere scelti in base al tipo di attività e regolamentazione
giuridica.  

Hanno le seguenti caratteristiche:

Piano e struttura conti completamente personalizzabile.
Numero di conto e di gruppo numerici o alfa-numerici.
Possibilità di aggiungere note o altre colonne.
Raggruppamento e totali adattabili a qualsiasi schema di raggruppamento nazionale.
Saldo, movimento conto e totali visualizzati e sempre aggiornati.
Centri di costo e di profitto, per il controllo dettagliato dei costi e ricavi di attività specifiche o di
progetti.
Segmenti per la rendicontazione per settore (succursale).
Anagrafica clienti, con controllo fatture in sospeso, richiami ed estratti conto.
Anagrafica fornitori, controllo fatture pagate e in sospeso.
Gestione clienti e fornitori non a bilancio (con centro di costo) per contabilità gestite con il
metodo di cassa.
Conti fuori bilancio.
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Inserire e modificare i dati è semplice
Aggiungi e modifichi i conti in modo facile e veloce, semplicemente inserendo o cancellando la
riga.
Nel piano contabile non vi sono limiti per il numero di conti da aggiungere.
Ogni conto può essere impostato usando numeri o testi.
La descrizione può anche essere molto lunga.
I Gruppi e i Sottogruppi si possono disporre liberamente per formare il Bilancio e il Conto
Economico.
I saldi iniziali si inseriscono subito nella colonna apertura.
Si possono aggiungere delle colonne per inserire informazioni supplementari.
I conti possono essere rinominati e rimpiazzati in automatico anche nella tabella Registrazioni.
Le colonne degli importi sono aggiornate all'istante, basta un colpo d'occhio per sapere lo stato
della liquidità, capitale, vendite, utile.
Poi impostare le previsioni e avere il confronto con il consuntivo. 

Sistema di raggruppamento flessibile
Il sistema di raggruppamento è altamente flessibile e potente:

Permette d'impostare il piano dei conti secondo qualsiasi schema nazionale e di adattarsi
esattamente alle esigenze della ditta.
Se non si è soddisfatti della disposizione o numerazione dei conti e dei gruppi, queste si
possono facilmente cambiare.

La struttura presente nella tabella Conti, viene mantenuta anche nella presentazione del Bilancio e
del Conto economico.

Elementi principali

Sezioni 
Servono a indicare le suddivisioni del piano dei conti per la stampa del Bilancio, Conto
Economico, ecc..
Gruppi 
Ti permettono di creare degli elementi che totalizzano i conti e i sottogruppi a più livelli.
Conti 
Sono gli elementi della contabilità dove vengono registrati i movimenti. Si possono indicare in
Dare o in Avere a dipendenza della natura del  movimento, della destinazione o provenienza.
Ogni conto ha un numero o un'abbreviazione (numero di conto), una descrizione, la Bclasse e il
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gruppo di appartenenza, il saldo iniziale, saldo attuale, preventivo, ecc.. 

Anagrafica clienti e fornitori
Puoi avere i conti specifici per emettere fatture e controllare i pagamenti. Solitamente vengono
impostati alla fine del piano contabile. Possono essere impostati come Partitario con i totali collegati
al Bilancio, oppure come centri di costo e profitto, con tutti i dettagli ma senza collegamenti al
bilancio.

Conti clienti con relativa anagrafica.
Conti fornitori con relativa anagrafica.

Centri di costo e profitto
Per gestire progetti o avere dei dettagli precisi di un determinato evento, oppure per gestire i clienti e
fornitori sull'incassato.

Centri di costo e di profitto
Conti che hanno il numero preceduto da un punto ".", da una virgola "," o da un punto e virgola
";" e servono per attribuire gli importi delle registrazioni anche a dei conti supplementari
rispetto a quelli contabili di base.

Segmenti
Per avere dei rendiconti finanziari anche di diversi settori o attività in cui l'impresa opera.

Segmenti
Sono simili a dei sotto-conti che hanno il numero preceduto da un due punti ":" e servono ad
attribuire le operazioni contabili a delle sotto-categorie di conti.

Stampe avanzate
I seguenti comandi permettono di visualizzare e stampare in modi diversi i conti:

Report Contabile
Per selezionare i conti solo con il movimento, avere delle serie temporali o i conti raggruppati in
base al numero della BClasse o a uno schema di raggruppamento esterno.
Bilancio Abbellito 
Stampa tutti i conti delle contabilità divisi per classe: Attivi, Passivi, Costi e Ricavi.
Bilancio Abbellito per gruppi
Permette di stampare Attivi, Passivi, Costi e Ricavi con i sottogruppi di totalizzazione; si hanno
dei totali intermedi e i totali generali.
Stampe specifiche avanzate si hanno con le Estensioni Banana .
 

https://www.banana.ch/apps/it
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Le colonne del piano dei conti | Contabilità in
partita doppia

La tabella Conti è composta da diverse colonne. A dipendenza delle Viste, vengono visualizzate
contestualmente delle colonne. Ogni colonna ha una propria finalità.

Qui di seguito vengono spiegati i dati da inserire nelle colonne seguenti:

Sezione
Vengono inseriti dei codici specifici che, nel Bilancio abbellito con gruppi, permettono di avere
una suddivisione e di stampare solo certe sezioni del piano dei conti.

Gruppo
Viene indicato il codice che definisce la riga come totalizzazione di un gruppo o sottogruppo. Il
codice del gruppo viene poi inserito nella colonna "Somma in" per indicare la totalizzazione di
un conto o di un gruppo.

Conto
Si inserisce il numero di conto, centro di costo o segmento.
 
Descrizione
Un testo per indicare il nome del conto, del gruppo o della sezione.
 
Disabilita (presente nella vista Varia)

Inserendo 1, il conto non viene visualizzato nella lista di autocompletamento, ma può
essere utilizzato ugualmente nella tabella Registrazioni;
Inserendo 2, il conto è disabilitato e non può essere usato.
 

BClasse
Si indica:
1=Attivo, 2=Passivo, 3=Costi, 4=Ricavi. Maggiori dettagli sono disponibili alla pagina Conti.
 
Somma in (Gr)
Si indica il codice di un gruppo in modo che il programma totalizzi l'importo della riga nel
gruppo.
L'intestazione "Somma in" è stato adottato con la versione Banana Plus.
Il nome della colonna è rimasto Gr, per mantenere la compatibilità con le versioni precedenti
del programma.
 
Gr1 e Gr2
Si inseriscono dei codici di raggruppamento supplementari da usare con i file dei Report esterni.
 
Saldo d'apertura

Si inserisce il saldo del conto all'inizio dell'anno.
Gli importi in avere devono essere inseriti con il segno meno davanti.
La somma di tutti gli importi, quelli in dare (in positivo) e in avere (in negativo) dei conti
appartenenti alle classi 1,2,3 e 4 deve dare zero. Se i saldi d'apertura non si compensano
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viene indicata una differenza nella finestra d'informazione.
Se sono stati aggiunti dei conti e la differenza non è esatta, è necessario ricalcolare la
contabilità tramite il menu Azioni → Ricalcola contabilità .
Il saldo d'apertura, nei conti di bilancio, viene usato per calcolare il saldo attuale.
Se nella tabella Preventivo sono stati inseriti dei valori, il saldo di apertura viene utilizzato
dal programma per l'apertura della pianificazione finanziaria.
Per maggiori informazioni consultare la pagina Saldi iniziali della partita doppia.
 

Movimento dare e movimento avere (Colonne protette)
In queste colonne vengono riportati in automatico i totali delle colonne Dare a Avere della
tabella Registrazioni.

Se non ci sono errori, i totali delle due colonne sono a pareggio altrimenti, nella colonna
Saldo, viene visualizzata una differenza che bisogna verificare e correggere.
Nella riga con la dicitura Differenza deve essere zero, relativamente a queste due
colonne, è corretto che ci siano degli importi, l'importante è che questi siano uguali.
Consulta anche Basi matematiche della contabilità .
 

Saldo  (Colonna protetta)
Il saldo del conto include il saldo d'apertura e i movimenti in dare e in avere.
Il saldo dare è indicato in positivo, mentre il saldo in avere è indicato in negativo (segno meno).
 
Preventivo
Si inserisce l'importo del preventivo per il periodo corrente.

L'importo di preventivo per i costi (dare) deve essere inserito in positivo, per i ricavi in
negativo (avere).
Se è stata attivata la tabella Preventivo, la colonna Preventivo nella tabella Conti è
protetta e gli importi sono quelli calcolati in base alle registrazioni di preventivo.
 

Differenza Preventivo (Colonna protetta)
La differenza fra Saldo attuale e il Preventivo.
 
Precedente
Il saldo del conto alla fine dell'anno precedente.
Quando si usano i comandi Crea nuovo anno o Aggiorna saldi iniziali, in questa colonna vengono
ripresi i saldi finali presenti nella colonna saldo del file dell'anno precedente.
Se si crea una nuova contabilità e si vogliono delle stampe con gli importi dell'anno precedente,
questi devono essere inseriti manualmente in questa colonna.
 
Differenza Anno precedente (Colonna protetta)
La differenza fra il saldo e l'importo dell'anno precedente.
 
Partita IVA
Inserire il numero IVA se ci sono dei conti dei clienti o fornitori.
 
Codice IVA
Inserire il codice IVA che deve essere abbinato al conto per i calcoli dell'IVA. Quando nella
tabella Registrazioni, nella colonna dare o avere, si digita il conto a cui è stato abbinato un
codice IVA, questo viene ripreso in automatico e calcolati i relativi valori IVA.
 
Colonne indirizzi
Queste colonne si utilizzano per inserire gli indirizzi dei conti clienti  e fornitori. Se le colonne

http://www.banana.ch/doc/it/node/9753
https://www.banana.ch/it/node/10964
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non sono presenti, si possono aggiungere attivandole dal menu Strumenti → Aggiungi nuove
funzionalità → Aggiungi colonne indirizzi nella tabella Conti. 

Aggiungere o spostare le colonne
Se nel piano dei conti si aggiunge una colonna di tipo importo, il programma esegue la somma
degli importi, secondo lo schema di raggruppamento scelto.
Se vengono aggiunte delle colonne di tipo numero, queste non vengono totalizzate.
Con il comando Disponi colonne si possono aggiungere e rendere visibili delle colonne,
spostarne la sequenza e aggiungerne di proprie.
Con i comando Imposta pagina si può definire anche la disposizione di stampa (orizzontale o
verticale) e lo zoom.

Conti ordinati per descrizione o altro
Per ottenere liste dei conti ordinate in maniere diversa, usare il comando Estrai e ordina righe dal
menu Dati. Consigliamo di fare molta attenzione quando si ordinano le righe con criteri diversi per
non creare confusione nei raggruppamenti e nei totali.

Viste
Il piano dei conti viene creato con delle viste preimpostate. Le principali viste sono le seguenti:

Base  - sono visualizzate le colonne principali, per il raggruppamento e i saldi
Movimento - sono visualizzate le colonne con il Movimento Dare e Movimento Avere.
Preventivo - sono visualizzate le colonne Preventivo e Differenza Preventivo. 
Precedente - sono visualizzate le colonne Anno precedente e differenza anno precedente.
Varia - sono visualizzate le colonne Disabilita, Partita Iva e Codice fiscale.
Stampa - sono visualizzate la colonna conto, Descrizione e saldo.

Con il comando Disponi tabelle si possono personalizzare le viste e aggiungerne di nuove.
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Conti | Contabilità in partita doppia

I conti costituiscono la struttura principale su cui viene creata tutta la contabilità. Se si apre uno dei
modelli inclusi in Banana Contabilità , i conti sono già presenti nella tabella Conti e hanno tutte le
impostazioni che servono per registrare subito i movimenti nella tabella Registrazioni.

I conti presenti nella tabella Conti sono suddivisi come segue:

Conti di Bilancio - Attivi e Passivi.
Conti di Conto economico - Costi e Ricavi.
Anagrafica Clienti e Fornitori
Conti Centri di costo e di profitto - per la gestione di progetti o la tenuta del partitario Clienti /
Fornitori
Conti di Segmento - per la gestione di settori di attività o succursali.

La BClasse dei conti
La BClasse è fondamentale per la totalizzazione corretta degli importi e dei saldi. Nella colonna
BClasse ad ogni conto deve essere obbligatoriamente attribuito uno dei  valori che
seguono, indipendentemente dal numero di conto o dal gruppo di appartenenza:

1  -  per gli Attivi
2  - per i Passivi
3 - per i Costi
4 - per i Ricavi

I gruppi e i sottogruppi non hanno la BClasse, pertanto la cella della relativa colonna rimane vuota.

BClasse dei conti fuori bilancio
I conti fuori bilancio sono quelli i cui importi e saldi non rientrano nella totalizzazione dei conti di
Bilancio e del Conto Economico. Sono conti che vengono inseriti nel piano contabile per visualizzare
cauzioni e impegni condizionali.
I conti fuori bilancio devono avere la seguente BClasse:

5 - per Fuori bilancio Attivi
6 - per Fuori bilancio Passivi
7 - 10 - per Altri conti fuori bilancio

Aggiungere un nuovo conto
Nella tabella Conti, vista Base, si possono aggiungere nuovi conti.

Prima di aggiungere un conto è importante sapere:

Il numero di conto può essere composto da numeri, lettere e caratteri di separazione.
Non ci possono essere più conti con il medesimo numero, lettere o altri caratteri uguali.
Ogni conto deve avere un raggruppamento (Somma in) e una classe (BClasse).

Per aggiungere un conto procedere come segue:

https://www.banana.ch/apps/it
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Posizionarsi nella riga precedente a quella dove sarà inserito il nuovo conto.
Aggiungere una riga con il comando Modifica → Aggiungi riga .
Digitare nelle rispettive colonne il numero di conto, la descrizione, la BClasse (1 per gli attivi, 2
per i passivi, 3 per i costi e 4 per i ricavi), il numero di raggruppamento nella colonna Somma
in  che deve essere uguale a quello inserito per i conti appartenenti allo stesso Gruppo (colonna
Gruppo).

Avvertenza: se si inserisce una registrazione con un conto che non esiste nel piano dei conti e solo
dopo si crea il nuovo conto, si riceverà inizialmente un messaggio di errore; per eliminarlo è
necessario ricalcolare la contabilità con il comando Maiusc + F9 o tramite il menu Azioni → Ricalcola
contabilità .

Rinominare un conto
È una funzione molto utile perché permette di cambiare un conto e avere in contemporanea il
rimpiazzo nella tabella Registrazioni. Si evita di dover cambiare il conto ad ogni registrazione che
conteneva il conto precedente. Inoltre, consente anche di rinominare un gruppo o un codice IVA.

Nella tabella Conti posizionarsi sulla colonna Conto o Gruppo, oppure sulla colonna Codice
IVA della tabella Codici IVA.
Impartire il comando Dati → Rinomina. 
Indicare il nuovo numero di conto, gruppo, o codice IVA.

Il programma aggiorna in automatico la tabella Registrazioni con il nuovo numero o codice IVA.

Eliminare un conto
Se una contabilità è già avviata, prima di eliminare un conto, assicurarsi che nella tabella
Registrazioni non sia stato usato o che non abbia un saldo iniziale.

Posizionarsi sulla riga dove si trova il conto da eliminare.
Dare il comando Modifica → Elimina Righe.

Dopo avere eliminato un conto è opportuno impartire il comando dal menu Azioni →  Ricalcola . Se il
conto eliminato è in uso nelle registrazioni, il programma segnala un messaggio di errore.

I saldi iniziali dei conti
Il saldo iniziale di un conto viene indicato nella colonna Apertura.

I saldi in Dare (Attivi) sono indicati normalmente.
I saldi in Avere (Passivi) sono indicati con il segno meno (in negativo) davanti all'importo
Di regola si indicano i saldi iniziali solo dei conti Attivi e Passivi.

Per riportare in automatico i saldi di apertura per l'anno successivo, consultare la lezione Crea nuovo
anno.

Maggiori approfondimenti sui saldi iniziali sono disponibili alla pagina Saldi iniziali.
 

http://www.banana.ch/doc/it/node/2558#1
http://www.banana.ch/doc/it/node/2558#1
http://www.banana.ch/doc/it/node/2558#1
http://www.banana.ch/doc/it/node/9753
http://www.banana.ch/doc/it/node/9753
http://www.banana.ch/doc/it/node/9753
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Differenze nei saldi iniziali
Per avere una contabilità corretta, il totale dei saldi iniziali in Dare deve corrispondere al totale dei
saldi iniziali in Avere, in modo che non ci siano differenze.
Se il totale non corrisponde, nella finestra Info, vi sarà una segnalazione di differenza fra i saldi
iniziali.
Se sono stati cambiati dei numeri di conto e ci sono delle differenze, eseguire il Ricalcolo completo
della contabilità.
Quando si utilizza la prima volta Banana Contabilità, per creare il bilancio di apertura, è necessario
inserire manualmente i saldi iniziali (colonna Apertura), facendo attenzione a inserire i saldi dei
Passivi con il segno meno (-) davanti all'importo.

Maggiori dettagli sono disponibili alle pagine seguenti:

Differenze nei saldi iniziali  (Contabilità in partita doppia).
Differenze nei saldi iniziali (Contabilità multimoneta).
 

I conti Clienti e Fornitori
I conti clienti e fornitori possono essere inseriti direttamente nelle sezioni del Bilancio, elencando i
conti per ogni cliente e fornitore e creando due distinti gruppi di totalizzazione, uno negli Attivi per i
clienti, l'altro nei Passivi per i fornitori. Se la lista dei clienti e dei fornitori è molto estesa è possibile
creare un partitario clienti/fornitori alla fine del piano  contabile.

Ci sono diverse possibilità d'impostazione:

Impostazione direttamente nel Bilancio, elencando i clienti e i fornitori, rispettivamente negli
Attivi e nei Passivi.
Impostazione con il Partitario clienti/fornitori, alla fine del piano contabile, con la totalizzazione
riportata nel Bilancio
Questa impostazione è ideale per coloro che hanno la gestione IVA sul fatturato.
Impostazione con i centri di costo e di profitto, alla fine del piano contabile, senza totalizzazione
nel Bilancio
Questa impostazione è ideale per coloro che hanno la gestione IVA sull'incassato.

 Conti  con indirizzi
Nella tabella Conti, vista Indirizzi, ci sono le colonne per inserire gli indirizzi dei clienti, dei fornitori o
dei soci. Se mancassero le colonne della vista indirizzi, è possibile aggiungerle:

Menu Strumenti → Aggiungi nuove funzionalità → Aggiungi colonne indirizzi nella tabella conti.

Le colonne degli indirizzi sono fondamentali per poter gestire la fatturazione, i richiami e il controllo
dei pagamenti e degli incassi.

Maggiori dettagli sono disponibili alla pagina Indirizzi.

https://www.banana.ch/doc/it/contamsg_it_tot_teid11des
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I conti Centri di Costo e Profitto
Sono ideali per la gestione di progetti,  avere dei dettagli precisi su un determinato evento o per
qualsiasi altra esigenza.

Centri di costo e di profitto
Sono conti che hanno il numero preceduto da un punto ".", da una virgola "," o da un punto e
virgola ";" e servono per attribuire gli importi delle registrazioni anche a dei conti supplementari
rispetto a quelli contabili di base.
Tutti gli importi attribuiti ai centri di costo e di profitto sono distinti dal Bilancio e dal Conto
economico e servono puramente per fini informativi.

I Conti Segmenti
Per avere dei rendiconti finanziari anche di diversi settori o attività in cui l'impresa opera.

Segmenti
Sono simili a dei sotto-conti che hanno il numero preceduto da un due punti ":" e servono ad
attribuire le operazioni contabili a delle sotto-categorie di conti.
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Aggiungi, rinomina, elimina conti

Con Banana Contabilità sono possibili le personalizzazioni del piano contabile, aggiungendo o
eliminando conti.

Per aggiungere un nuovo conto, procedere come segue:

Posizionarsi nella riga precedente a quella dove si desidera inserire il nuovo conto.
Aggiungere una riga con il comando Modifica → Aggiungi riga .
Digitare nelle rispettive colonne:

Numero di conto.
Descrizione.
BClasse (1 per gli attivi, 2 per i passivi, 3 per i costi e 4 per i ricavi).
Numero di raggruppamento (colonna Somma in) che deve essere uguale a quello inserito
per i conti appartenenti allo stesso Gruppo di totalizzazione.

Se nella tabella Registrazioni si inserisce una registrazione, utilizzando un conto che non esiste, il
programma segnala un messaggio di errore; per eliminarlo è necessario aggiungere il conto nella
tabella Conti e ricalcolare la contabilità con il comando Maiusc + F9 o tramite il menu Azioni →
Ricalcola contabilità .

Aggiungere un nuovo gruppo
Se si desiderano dei nuovi gruppi di totalizzazione, procedere come segue:

Posizionarsi nella riga precedente a quella dove si deve aggiungere il nuovo gruppo.
Aggiungere una riga con il comando Modifica → Aggiungi riga .
Digitare nella colonna gruppo:

Numero di gruppo.
Descrizione del gruppo.
Numero di raggruppamento (colonna Somma in) dove si desidera che il nuovo gruppo sia
totalizzato.

Rinominare un conto, gruppo o codice IVA
È una funzione molto pratica che consente di rinominare un conto, un gruppo o un codice IVA e di
avere in automatico la sostituzione nella tabella Registrazioni e nel Preventivo senza doverli inserire
manualmente.

Per rinominare uno degli elementi procedere come segue:

Posizionarsi nella cella dove si trova il conto o il gruppo (tabella Conti) da rinominare.
Se si deve rinominare un codice IVA occorre posizionarsi nella tabella Codici IVA, sulla cella del
codice da sostituire.
Impartire il comando Dati → Rinomina. 
Indicare il nuovo numero di conto, gruppo o codice IVA.

http://www.banana.ch/doc/it/node/2558#1
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Eliminare un conto, un gruppo o codice IVA
Posizionarsi sulla riga che contiene l'elemento da eliminare.
Cliccare sul menu Modifica → Elimina Righe.
Confermare il numero di righe che si vuole eliminare.

Dopo avere eliminato un conto, un gruppo o un codice IVA è opportuno impartire dal menu Azioni il
comando Ricalcola contabilità. Se uno degli elementi eliminati è presente nelle registrazioni, il
programma segnala l'errore.

Quando si elimina un gruppo e non vengono eliminati tutti i conti appartenenti al gruppo eliminato,
per i conti rimasti occorre modificare il numero di raggruppamento nella colonna Somma in, altrimenti
vengono segnalati degli errori.
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Gruppi

Banana ha messo a punto un sistema di raggruppamento molto pratico e immediato, che permette
d'impostare nella tabella Conti la struttura del Bilancio, del Conto economico e di altre sezioni della
contabilità.

Il sistema di raggruppamento è flessibile perché permette di strutturare dei piani contabili per
qualsiasi nazione e nel contempo di adattarli alle esigenze specifiche dell'azienda. Si possono creare
piani e presentazioni di rendiconto semplici e più complessi, con più livelli di totalizzazione e per ogni
tipo di contabilità.

Con il raggruppamento vengono visualizzati immediatamente i totali dei saldi, dei movimenti e del
preventivo dei gruppi.

Come funziona
Per capire come funziona il sistema di raggruppamento Banana si rimanda alla pagina della nostra
documentazione:

Sistema Raggruppamento.
▶ Video: Sistema di raggruppamento e totalizzazione
   

Sistema di raggruppamento e di totalizzazione
Il sistema di raggruppamento si basa su due colonne della tabella Conti e Categorie:

Gruppo (Riga di totale)
Quando in una riga si inserisce un identificativo di gruppo, la riga diventa una riga di
totale.
In questa riga sono totalizzati gli importi delle righe che nella colonna Somma in
contengono l'identificativo del gruppo.
Nella riga dove è presente un gruppo non ci deve essere un conto.

Somma in 
Somma gli importi della riga nel gruppo indicato.
Per ogni riga di conto o di gruppo, si indica il gruppo in cui la riga deve essere totalizzata.
Deve essere uno dei numeri definiti nella colonna Gruppo.

https://www.banana.ch/it/node/11608
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Principali gruppi nella contabilità in partita doppia
Ogni modello di piano conti usa un proprio schema di totalizzazione. Qui di seguito sono spiegati i
principali gruppi della contabilità in partita doppia.

Nella contabilità in partita doppia la somma dei saldi Dare (in positivo) e Avere (in negativo) deve
essere sempre uguale a 0. In caso di differenze, la riga del gruppo 00 presenta un importo diverso da
zero.

La sequenza di calcolo per arrivare allo 00 è la seguente:

I conti con 1000 > gruppo 1 (Totale attivi) > Gruppo 00.
I conti con 2000 > gruppo 2 (Totale passivi) > Gruppo 00.
I conti con 4000 > gruppo 4 (Totale costi) > Gruppo 02 (risultato conto economico)  > Gruppo
206 (Utile anno corrente nel bilancio) > Gruppo 2 (Totale passivi) > Gruppo 00.
I conti con 3000 > gruppo 3 (Totale ricavi) > Gruppo 02 (risultato conto economico) > Gruppo
206 (Utile anno corrente nel bilancio) > Gruppo 2 (Totale passivi) > Gruppo 00.
Il gruppo 00 è la riga di controllo, dove vengono sommati tutti i saldi dei conti.

È la "Summa summarum" di tutti i saldi riportati nella tabella Conti in seguito alle
registrazioni inserite nella tabella Registrazioni.
Se la riga del gruppo 00 presenta una differenza (importo diverso da zero) significa che ci
sono degli errori:

Se la differenza è indicata nella tabella Conti, colonna Apertura (tutte le viste) ci
sono delle differenze nei saldi iniziali 
Se la differenza è indicata nella tabella Conti, colonna Saldo (tutte le viste) ci sono
delle differenze nella tabella Registrazioni. Nelle colonne Dare e Avere della vista
movimento, i totali non sono a pareggio.
Nel casi in cui viene segnalata la differenza impartire il comando Ricontrollo della
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contabilità. Questo comando suggerisce eventuali errori che bisognerà verificare e
correggere.

Nelle colonne Dare e Avere della vista Movimento (tabella Conti) vengono sempre riportati i
totali dei saldi. Se i totali nelle due colonne sono uguali non ci sono errori.

Il risultato del Conto economico viene sommato nel capitale proprio

Come si vede nell'esempio, il gruppo 02 (Utile perdita del conto economico) viene raggruppato nel
gruppo 206 (Risultato anno corrente).
Con questo raggruppamento abbiamo i seguenti vantaggi:

Nel Bilancio viene visualizzato il risultato d'esercizio dell'anno corrente.
Il totale dei Passivi rispecchia il totale degli Attivi (ammesso che non ci sia alcun errore
contabile).

Impostazione Struttura Piano Conti
Il piano contabile in Banana Contabilità può essere impostato principalmente in due modalità diverse:

    1. Struttura senza sottogruppi (o subtotali).

In questo caso, la struttura è molto semplice. Si elencano tutti i conti senza sottogruppi, e
totalizzando tutti i conti o le categorie nei gruppi principali:

Per la Contabilità in partita doppia:

Attivi
Passivi
Costi
Ricavi

Per la Contabilità Entrate / Uscite o Cash Manager (tabella Categorie):

Entrate
Uscite

    2. Struttura con sottogruppi

La struttura è più complessa. I conti o le categorie dei gruppi principali vengono suddivisi in più
sottogruppi, che a loro volta vengono totalizzati nei corrispondenti gruppi principali.

Qui di seguito presentiamo una struttura del piano contabile con un esempio di
Suddivisione con sottogruppi nella Contabilità in partita doppia. Ogni sottogruppo può essere
a sua volta :

Attivi

Sostanza circolante
Liquidità
Clienti
Magazzino

Sostanza fissa
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Mobili
Macchine e attrezzature
Computer, software.

Passivi

Capitale di terzi
Fornitori
Prestiti bancari
Altri debiti a breve termine
Debiti a lungo termine

Capitale proprio
Capitale proprio
Fondo di riserva
Utili e perdite riportate
Utile d'esercizio

Dalla tabella Conti, in qualsiasi momento, tramite il menu File > Stampa o Anteprima di stampa
puoi  stampare il piano dei conti o parte di esso. Sempre a partire dalla tabella Conti, selezionando la
vista Movimento, hai la stampa del bilancio di verifica.

Aggiungere un nuovo gruppo
Posizionarsi nella riga precedente a quella dove sarà inserito il nuovo gruppo
Aggiungere una riga con il comando Modifica > Aggiungi riga
Digitare nella colonna gruppo il numero di gruppo, la descrizione, e il numero di
raggruppamento nella colonna Somma in, dove si desidera che questo gruppo sia totalizzato.

Aggiungere un livello di totalizzazione

Con questo sistema si possono facilmente aggiungere dei livelli di totalizzazione.
Se vogliamo avere il sottogruppo dei conti liquidità:

Inserire una riga vuota subito dopo il conto bancario:
Inserire nella colonna Gruppo il valore 10.
Inserire nella colonna Somma in  il valore 1.

Nei conti 1000 fino 1020 indicare il raggruppamento Somma in = 10.
La sequenza di calcolo diventerà:
Il conto 1000 > gruppo 10 (Liquidità) > gruppo 1 (Totale attivi) > Gruppo 00. 

Il programma totalizza quanto segue:

Totalizza i conti in una riga di gruppo.
Per esempio il conto Cassa è  totalizzato nel gruppo Liquidità.
Totalizza un gruppo o sottogruppo in un altro gruppo, che a sua volta viene totalizzato in un
altro gruppo, costruendo così la struttura di calcolo del Bilancio e del Conto economico.
Per esempio il gruppo Liquidità viene totalizzato nel Totale Attivo che a sua volta verrà
totalizzato nel gruppo 00, nella riga di totale di controllo.

http://www.banana.ch/doc/it/node/2558#1
http://www.banana.ch/doc/it/node/2558#1
http://www.banana.ch/doc/it/node/2558#1
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Se si vuole inserire un altro sottogruppo "Sostanza circolante" si dovrà procedere nel medesimo
modo.

Aggiungere una riga vuota prima degli Attivi.
Nella nuova riga:

Indicare nella colonna Gruppo il numero 11.
Indicare nella colonna Somma in il numero 1.

Nelle righe Liquidità, Clienti e Inventario merci indicare il raggruppamento nella colonna
Somma in il numero 11.

Righe di titolo (con Somma in)

Anche nelle righe di titolo è utile indicare il raggruppamento Somma in (il gruppo della riga di totale)
a cui appartiene.
In questo modo, nelle stampe del Bilancio abbellito per gruppi, se i conti sono a zero non verrà
stampato il titolo.

Eliminare dei sottogruppi

Se il piano dei conti presenta dei sottogruppi che non si desiderano, è possibile eliminarli, basta
eliminare la riga del sottogruppo e cambiare il raggruppamento nella colonna Somma in di ogni
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conto che ne faceva parte.

Controllo della struttura

Una volta impostato il piano contabile si esegue il comando dal menu Azioni > Controlla contabilità. 
Se ci sono degli errori il programma li segnala.

Errore Ciclo infinito

Quando un Gruppo viene totalizzato in un Gruppo di livello inferiore, si crea un ciclo  infinito di errore.
Ci sarebbe un ciclo infinito se nell'esempio precedente il Gruppo attivo (1) fosse sommato nel Gruppo
10.
Il programma, dopo avere calcolato il Gruppo 1 sommerebbe l'importo nel gruppo 10 che a sua volta
sommerebbe nel Gruppo 1 e poi nel 10 all'infinito.

Conto economico con Utile lordo
Si può anche realizzare un conto economico scalare, cioè che parte dalla cifra d'affari e sottrae i costi.
Qui di seguito viene indicato l'esempio tratto dal piano dei conti PMI svizzero.

Documenti correlati:

Saldi iniziali
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Sezioni

Nella colonna Sezione deve essere presente una codifica che serve a determinare le varie
impostazioni delle stampe. Le varie poste che compongono il bilancio sono suddivise in più sezioni;
ogni sezione è come se fosse a sé stante.

Questa suddivisione in sezioni permette di poter scegliere se stampare tutto il Bilancio e il Conto
Economico, oppure scegliere quali sezioni stampare (es. solo il bilancio, o solo un gruppo, escludendo
dalla stampa gli altri componenti).

Qui di seguito presentiamo una tabella con la codifica da utilizzare nella tabella Conti, colonna
Sezione.

* Titolo 1 l'asterisco serve per separare le sezioni e viene inserito per le
intestazioni principali

** Titolo 2 da inserire per le intestazioni secondarie
1 Attivi da inserire nella riga del titolo Attivi
2 Passivi da inserire nella riga del titolo Passivi
3 Costi da inserire nella riga del titolo Costi
4 Ricavi da inserire nella riga del titolo Ricavi
01 Partitario Clienti da inserire nella riga del titolo Partitario clienti
02 Partitario Fornitori da inserire nella riga del titolo Partitario fornitori
03 Centri di Costo da inserire nella riga del titolo Centri di costo
04 Centri di Profitto da inserire nella riga del titolo Centri di profitto
# Note da inserire nella riga del titolo Note
#X Dati nascosti da inserire nella riga a partire dalla quale i dati devono essere nascosti

Il tipo di codifica impostato nella colonna Sezione serve a determinare le impostazioni delle stampe
per il Bilancio abbellito con gruppi.

Ogni sezione è stampata come se fosse una tabella a se stante.

Sezione Titolo 
* 
L'asterisco indica una nuova sezione. 

* Titolo 1 crea una sezione di livello 1.
Questa sezione reimposta a 1 il tipo di livello.
Può contenere sezioni o cartelle di livello 2.
È utile per raggruppare sezioni che devono essere stampate assieme come il Bilancio, che
contiene sia attivi che passivi.
 

** 
Il doppio asterisco indica una sezione di livello 2. 

* Titolo 2 crea una cartella di livello 2.

Quando si crea una nuova sezione di titolo, la sezione numerica viene impostata ad 1. 
Dopo una sezione di titolo bisogna quindi sempre reimpostare anche la sezione numerica desiderata.
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Sezioni numeriche 
Il numero di sezione determina:

Come sono stampati gli importi; gli importi possono essere visualizzati come nel piano dei conti
oppure invertiti.
Gli importi in avere (in negativo) se sono invertiti sono visualizzati in positivo, mentre quelli in
positivo sono visualizzati in negativo.
Quali colonne sono usate per visualizzare gli importi; si usa la colonna Saldo oppure la
colonna Movimento Periodo.

La colonna Saldo indica il saldo del conto in un determinato momento (saldo al 30
giugno).
La colonna Movimento Totale Periodo indica l'importo del movimento nel periodo
indicato; si usa per il conto economico e indica le spese o i ricavi per un certo periodo.

Le spiegazioni delle diverse sezioni sono le seguenti:

1 Attivi (importi come nel piano dei conti, colonna saldo).
2 Passivi (importi invertiti, colonna saldo).
3 Costi (importi come nel piano dei conti, colonna movimento totale).
4 Ricavi (importi invertiti, colonna movimento totale).
Questa sezione può essere usata anche da sola e comprendere sia i costi che i ricavi (Conto
economico a scalare). In questo caso i ricavi figureranno in positivo ed i costi in negativo.

Queste sezioni devono essere uniche. Può esserci solo una sezione, 1 Attivi o 2 Passivi. Per altre
sezioni, partitario o centri di costo si possono usare le sezioni simili.

Sezioni numeriche derivate
Si tratta di sezioni che si comportano come le sezioni principali:

01 Come Attivi (importi come nel piano dei conti, colonna saldo)
Si usa per il partitario clienti.
02 Come Passivi (importi invertiti, colonna saldo)
Si usa per il partitario fornitori.
03 Come Costi (importi come nel piano dei conti, colonna movimento totale)
Si usa per i centri di costo.
04 Come Ricavi (importi invertiti, colonna movimento totale)
Si usa per i centri di profitto.

Altre Sezioni
Ci sono altri tipi di sezioni:

# Serve a indicare la sezione note (stampa unicamente la descrizione)
Da usare per gli allegati di bilancio.
#X Sezione nascosta. Questa sezione non viene ripresa nella selezione delle sezioni e neppure
nella stampa. Serve a indicare una parte che non si vuole stampare.
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Disposizione e larghezza colonne in stampa
La disposizione e la larghezza delle colonne sono determinate in modo automatico dal programma:

Le sezioni 1, 2, 01, 02 sono stampate con i saldi alla data specificata.
Le sezioni 3, 4, 03, 04 sono stampate con i movimenti per il periodo.

Le sezioni del Bilancio
Per poter suddividere il Bilancio nelle varie sezioni, occorre inserire la codifica indicata nella colonna
Sezione:

Inserire un * sulla stessa riga del titolo Bilancio.
Inserire 1 sulla stessa riga del titolo Attivi.
Inserire 2 sulla stessa riga del titolo Passivi.

Le sezioni del Conto economico
Inserire un * sulla stessa riga del titolo Conto economico.
Inserire 4 sulla stessa riga del titolo Ricavi.
Inserire 3 sulla stessa riga del titolo Costi.
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Le sezioni nel Conto economico a forma scalare
Nel caso di un Conto economico a forma scalare, i gruppi dei costi e dei ricavi si alternano e di
conseguenza non c'è una netta distinzione tra la sezione dei costi e dei ricavi, pertanto inserire
unicamente:

Un * sulla stessa riga del titolo Conto economico
4 sulla riga vuota sottostante al Conto economico.

Le sezioni nel Partitario clienti/fornitori
La visualizzazione degli importi avviene come per gli attivi e i passivi. Questa codifica vale anche se i
clienti e fornitori sono impostati come centri di costo.

Inserire un * sulla stessa riga del titolo Partitario clienti/fornitori o su una riga vuota (come
nell'esempio).
Inserire 01 sulla stessa riga del titolo Partitario clienti
Inserire 02 sulla stessa riga del titolo Partitario fornitori
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Nel caso in cui figurino dei centri di costo e di profitto, occorre inserire:

un * nella stessa riga del titolo Centri di costo e di profitto o su una riga vuota.
03 sulla stessa riga del titolo Centri di costo o su una riga vuota (che precede i centri di
costo).
04 sulla stessa riga del titolo Centri di profitto o su una riga vuota (che precede i centri di
profitto).

Gli importi dei centri di costo verranno visualizzati in positivo come i costi; i centri di profitto verranno
visualizzati in negativo come i ricavi.

Documento correlato:

Bilancio abbellito con gruppi
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Passaggio a nuovo piano contabile

Di seguito viene spiegato come procedere per:

passare a un piano dei conti con una numerazione diversa,
riprendere e convertire i dati della contabilità esistente, comprese le registrazioni, nel nuovo
piano contabile.

Conversione per il nuovo anno
Se si vuole iniziare un nuovo anno con un nuovo piano dei conti, ci sono due possibilità:

Convertire l'anno precedente (2022) e poi creare il nuovo anno (2023).
Si avranno due file per il 2022 (quello che contiene la colonna Conti con i vecchi numeri di conti
e la colonna Conti_1 con i nuovi numeri di conto) e il file per il 2023 con unicamente il nuovo
piano dei conti.
Questo approccio è ideale per avere i piani dei conti dei due anni allineati.
In questo modo potete anche continuare a fare modifiche nell'anno 2022 e riprendere poi
successivamente i saldi iniziali nell'anno 2023.
Creare il nuovo anno (2023) e poi convertire il file dell'anno 2023 con i saldi riportati a nuovo.
Il file dell'anno 2022 rimarrà il medesimo. Per il 2023 si avrà un file intermedio, con il piano dei
conti vecchio, ma i saldi iniziali a nuovo. 
La conversione del file dell'anno 2023, può essere eseguita subito o anche dopo che sono state
immesse delle registrazioni. 
Avendo nel file dell'anno 2022 i vecchi numeri di conto, non potrete riprendere nel 2023
eventuali e ulteriori modifiche fatte nel 2022.

1. passo: Creare un nuovo file di contabilità
Creare un nuovo file:1.

menu File → Nuovo →  scegliere il modello di piano contabile già predefinito.
 Adattare il piano dei conti alle proprie necessità.2.

2. passo: Aggiungere i conti di abbinamento
Nella tabella Conti:1.

menu Dati → Disponi colonne
cliccare sul bottone Aggiungi
inserire la descrizione Conto_1.

Per ogni conto nuovo, nella colonna Conto_1, inserire il numero corrispondente del vecchio2.
piano dei conti.
Se il conto rimane uguale si può anche non indicarlo. 
Se si vogliono raggruppare più conti in uno, inserire i conti separati con un punto e virgola3.
"1000;1001".
In questo caso il conto 1000 è ripetuto altrimenti prenderebbe solo il 1001.
Se un conto deve essere suddiviso su più conti, bisogna invece procedere manualmente, vedi4.
sotto. 



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 309

3. passo: Avviare l'importazione
Attivare dal menu Azioni → Importa in contabilità → Importa File
Con il bottone Sfoglia selezionare il file della contabilità con il vecchio piano contabile

Cliccare su OK e passare alla prossima finestra di dialogo
Impostare le opzioni di importazione
Attivare l'opzione Converti numeri di conto, indicando che gli abbinamenti sono nel file di
destinazione.

Ripetere l'importazione

Se vengono segnalati degli errori, e si rende necessario ripetere l'importazione, occorre annullare
l'operazione di importazione, in modo che il file di partenza sia vuoto, altrimenti gli importi dei saldi
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saranno duplicati, sia nei saldi di apertura sia nella tabella registrazioni.
 

Suddivisione di un conto in più conti
Quando si passa a un piano dei conti più dettagliato, probabilmente è necessario anche suddividere
un conto su più conti.
Dopo l'importazione procedere manualmente nel modo seguente:

Nel piano dei conti suddividere gli importi di apertura, del budget, saldi precedenti di un conto
su diversi conti. 
Passare una ad una le registrazioni sul conto da suddividere e attribuire il conto più specifico, o
creare delle registrazioni supplementari se si necessita di suddividere un importo in importi più
dettagliati.
Procedere analogamente per le registrazioni della tabella preventivo. 

Risultato e possibili errori
Se il programma segnala degli errori (mancano conti o altro) bisognerà probabilmente annullare
l'operazione d'importazione, completare gli abbinamenti e poi ripetere l'operazione di importazione.

Il programma, per il fatto che si trova con piani dei conti diversi, non può in automatico fare
approfondite verifiche che tutti i dati siano stati importati e raggruppati correttamente.

È opportuno comunque controllare manualmente il risultato, facendo una verifica che i totali di
bilancio e conto economico siano corretti.
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Saldi iniziali (Apertura) | Contabilità in
partita doppia

Saldi di apertura quando si inizia una contabilità
Quando si utilizza la prima volta Banana Contabilità, per creare il bilancio di apertura è necessario
inserire manualmente i saldi iniziali.

Posizionarsi nella tabella Conti, vista Base, colonna Apertura.1.
Riportare manualmente i saldi iniziali dei conti2.

Attivi (valori in positivo)
Passivi (valori in negativo, con il segno meno "-" davanti all'importo).
Per l'uso di importi in negativo vedi anche Matematica della partita doppia .

Il totale Attivi sommato al totali Passivi (in negativo) deve dare zero.3.

Differenza saldi iniziali
All'apertura dell'anno contabile, i conti degli Attivi (in positivo) devono pareggiare con i conti dei
Passivi (negativi). In caso contrario, non si verifica la quadratura contabile e, nella finestra informativa
in basso, vengono segnalati dei messaggi di errore; in questo caso è necessario verificarne i motivi e
correggere, finché non scompare il messaggio Differenza nei saldi iniziali. Per maggiori
informazioni e soluzioni vedi:

Differenza saldi iniziali 

https://www.banana.ch/it/node/10964
http://www.banana.ch/doc/it/contamsg_it_tot_teid11des
http://www.banana.ch/doc/it/contamsg_it_tot_teid11des
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Saldi iniziali di Centri di costo
Nella tabella Conti, la colonna Apertura può essere usata anche per inserire i saldi iniziali dei Centri
di costo.

Saldi iniziali per i Segmenti
Per inserire i saldi iniziali dei segmenti, si devono invece effettuare delle registrazioni di apertura.
Maggiori dettagli sono disponibili alla pagina Segmenti.

Saldi iniziali per contabilità già iniziata
Se iniziate a fare una nuova contabilità, riprendendo il lavoro già fatto con altri programmi, avete due
possibilità: 

Iniziare la contabilità da inizio anno, inserendo i saldi di apertura a inizio anno (tabella Conti,1.
colonna Apertura) e i movimenti (tabella Registrazioni) che sono già stati registrati in
precedenza con altri programmi (vedi anche Ripresa dati da altri programmi). In questo modo
avete tutti i dettagli contabili in un file unico.
Partire dalla data di quando viene ripresa la contabilità:2.

Inserire i saldi iniziali (tabella Conti, colonna Apertura), riprendendo i valori dell'altra
contabilità.
Oltre a inserire i saldi d'apertura dei conti Attivi e Passivi, bisogna riprendere anche quelli
dei Costi (importi in positivo) e dei Ricavi (importi in negativo).
Il risultato d'esercizio fino a quel momento deve essere indicato nel conto Utile/Perdite
riportate.
Se si tratta di un utile, il saldo iniziale è da inserire in negativo, se invece è una perdita in
positivo.
Verificare che le somme dei saldi iniziali sia a zero, affinché il programma non segnali
alcuna differenza.
Inserire i nuovi movimenti nella tabella Registrazioni.

Saldi iniziali come registrazioni di apertura
I saldi iniziali possono essere inseriti anche come registrazioni di apertura nella tabella Registrazioni.

Per ogni registrazione di apertura, proseguire come segue:
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Indicare come data della registrazione, la data di inizio contabilità.
Nella colonna TipoDoc, inserire il codice "01".
Indicare il conto in Dare o in Avere e l'importo.
Il totale dei saldi d'apertura in Dare devono compensarsi con quelli in Avere.

I saldi di apertura inseriti come registrazioni sono usati quando si preparano dei report. Il  saldo di
apertura delle registrazioni viene sommato all'importo inserito nella colonna Apertura della tabella
Conti.

 Saldi anno precedente
Se iniziate una nuova contabilità, riprendendo una contabilità esistente, e volete che sulle stampe ci
siano anche i valori dell'anno precedente, è necessario inserire nella tabella Conti, vista
Precedente, colonna Precedente, i saldi finali dell'anno precedente:

Inserire i saldi finali dell'anno precedente dei conti Attivi.
Inserire i saldi finali dell'anno precedente dei conti Passivi (inserire il segno meno davanti
all'importo).
Inserire i saldi finali dell'anno precedente dei Costi.
Inserire i saldi finali dell'anno precedente dei Ricavi (inserire il segno meno davanti all'importo).

Ripresa saldi iniziali dal file anno precedente
Quando si passa al nuovo anno, il programma riporta in automatico i saldi di apertura per l'anno
successivo, Consultare la lezione Crea nuovo anno.

Se per qualche esigenza particolare, bisogna cambiare dei saldi di apertura, questi possono essere
modificati manualmente nella colonna Apertura della tabella Conti. Dopo ogni modifica bisogna
assicurarsi di non avere delle differenze di quadratura contabile. In ogni caso, consigliamo di eseguire
il riporto dei saldi iniziali con il comando Crea nuovo anno o, se la contabilità del nuovo anno è stata
già creata, utilizzare il comando Aggiorna saldi iniziali.

La scheda conto è automatica e non è possibile inserirvi direttamente il saldo d'apertura o effettuare
delle modifiche.

Per modificare un saldo di apertura di una scheda conto bisogna andare nella tabella Conti, colonna
Apertura, mentre per correggere dei movimenti, bisogna modificare la registrazione nella tabella
Registrazioni.
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Correggere il riporto dei saldi iniziali del Conto economico
Se per errore sono stati riportati i saldi iniziali dei conti del Conto economico, per correggere hai due
possibilità:

Vai nella tabella Conti, colonna Apertura, seleziona tutti i saldi iniziali dei conti del Conto
Economico e con il tasto cancella eliminali.
Dal menu Azioni → Aggiorna Saldi iniziali, seleziona il file dell'anno precedente e nella finestra di
dialogo Riporta saldi a nuovo, disattiva la casella del Conto economico per il riporto dei saldi nel
nuovo anno.

Stampa saldi iniziali
Per stampare i saldi iniziali:

Per stampare il contenuto della Tabella usare il comando Stampa/Anteprima, selezionando le
righe del bilancio.
Si possono usare anche le Stampe contabili e impostare la stampa solo per la parte del Bilancio
e la colonna apertura.
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Differenze ed errori nei saldi iniziali

All'apertura dell'anno contabile, i conti degli Attivi devono pareggiare con i conti dei Passivi. In caso
contrario, non si verifica la quadratura contabile e, nella finestra informativa in basso, vengono
segnalati dei messaggi di errore; in questo caso è necessario verificarne i motivi e correggere, finché
non verrà segnalato alcun messaggio, come Differenza nei saldi iniziali.

Ci possono essere diverse cause che portano ad una differenza o errori nei saldi iniziali:

Quando si usa il programma la prima volta, i passivi non sono stati inseriti con il segno meno1.
davanti all'importo.
tabella Totali.2.
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Tabella Registrazioni | Contabilità in partita
doppia

La tabella Registrazioni è il fulcro della contabilità, dove vengono inserite tutte le operazioni con
impatto finanziario ed economico. Simile a Excel, permette di visualizzare e ordinare facilmente i
movimenti, offrendo una chiara visione di tutti gli accadimenti.

Tutti i dati inseriti possono essere modificati per garantire una contabilità accurata e precisa. La
tabella Registrazioni è caratterizzata anche dalla Colonna Saldo , che facilita l'individuazione delle
differenze tra Dare e Avere e segnala la riga in cui si è generata la discrepanza. Inoltre, la finestra
informativa in basso evidenzia errori e differenze contabili.

Registrazioni semplici e composte
Le registrazioni semplici riguardano quelle operazioni contabili che si registrano su di un'unica
riga, con un conto in dare e un conto in avere; l'importo registrato nella colonna Importo sarà
registrato in automatico nei rispettivi conti di addebito e accredito. 

Le registrazioni composte sono quelle che concernono addebiti e/o accrediti su più conti (es.
quando si pagano fatture diverse con il conto corrente bancario). In quest'ultimo caso  occorre
registrare su più righe: una riga per ciascun conto di addebito e accredito. Quando tutti gli addebiti e
accrediti sono stati inseriti non ci devono essere differenze. Nelle registrazioni composte, l'importo di
ogni riga di registrazione viene riportato in automatico nel corrispondente conto, inserito nella
colonna Dare o Avere. Per maggiori dettagli, consultare la pagina Registrazioni.

Registrazioni con IVA
Per poter registrare delle operazioni con IVA è necessario avere impostato un tipo di file con le opzioni
e la tabella Codici IVA. Pertanto, quando si inizia, occorre:

scegliere una contabilità in partita doppia con IVA dal menu File → Nuovo.
aprire uno dei Piani contabili già predisposti con IVA .

Registrare i movimenti con IVA è semplice e veloce, basta inserire nella tabella Registrazioni, oltre ai
soliti dati, il codice IVA, definito nella tabella Codici IVA e specifico al tipo di operazione contabile. Con

https://www.banana.ch/doc10/it/node/9827
https://www.banana.ch/apps/it
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l'inserimento del codici il programma calcola in automatico gli importi IVA e li registra nel conto IVA in
automatico.

Puoi anche automatizzare l'inserimento del codice IVA, tramite la funzione collegare un codice IVA ad
ogni conto con movimenti soggetti a IVA. Per maggiori dettagli consultare la pagina Registrazioni
della gestione IVA.

Registrazioni al netto e al lordo d'IVA
Per registrare i movimenti contabili al netto o al lordo IVA, è necessario avere delle impostazioni nella
tabella Codici IVA. Solitamente la tabella Codici IVA è impostata per registrare i movimenti al lordo
IVA. 

Nelle Registrazioni con IVA al lordo, nella tabella Registrazioni si inserisce l'importo lordo e con
l'inserimento del codice IVA, il programma scorpora l'IVA dal conto dei costi e/o dei ricavi, calcola
l'imponibile che visualizza in un'apposita colonna e l'importo IVA viene automaticamente inserito nel
conto IVA in automatico, mentre nelle schede dei costi e ricavi vengono contabilizzati gli importi netti
(escluso IVA).

Nelle registrazioni con IVA al netto, nella tabella codici IVA, nella colonna Tipo importo si inserisce
1 (IVA esclusa). Contrariamente alla registrazione con IVA al lordo, nella colonna Importo si registra
l'importo netto; con l'inserimento dei codice IVA viene calcolata l'IVA sulla base dell'importo netto
inserito (imponibile).

Registrazioni incassato e fatturato
Con Banana Contabilità Plus puoi registrare sull'incassato (o principio di cassa), oppure sul fatturato (o
principio di competenza). A dipendenza del principio adottato, nella tabella Conti, cambiano le
impostazioni dei Clienti e dei Fornitori. 

Con le registrazioni sull'incassato, non vengono registrati i conti dei clienti e dei fornitori. I costi, i
ricavi e l'IVA vengono registrati nella contabilità nel momento dell'incasso o del pagamento.Per poter
tenere conto della situazione Clienti e Fornitori, nella tabella Conti, alla fine del piano contabile, questi
vengono impostati con i Centri di costo/profitto CC3 che non hanno alcuna influenza e non
figureranno nel Bilancio. Si tratta di una gestione separata a scopo unicamente informativo.

Con le registrazioni sul fatturato, i costi, i ricavi e l'IVA devono essere registrati al momento
dell'emissione della fattura ai clienti e al ricevimento della fattura dai fornitori. Questo implica la
registrazione dei conti Clienti e Fornitori. Nel piano contabile, nella tabella Conti, alla fine del piano
contabile, i partitari clienti e fornitori vengono impostati come conti attivi e passivi, pertanto
figureranno nel Bilancio. Maggiori dettagli disponibili alla pagina Metodo di Competenza e Cassa .

Registrazioni su Centri di costo e profitto
I Centri di costo e di profitto sono utilizzati per analizzare e monitorare le performance di diverse aree
o divisioni di un'azienda: unità organizzative, reparti e filiali, anche senza avere una correlazione fra di
loro. Per poterli utilizzare è necessario impostare nella tabella Conti, i conti dei Centri di costo e di
profitto. 

Nella tabella Registrazioni, nella vista Centri di costo, sono visualizzate le colonne previste dei tre
centri di costo, e per registrare occorre indicare il conto del centro di costo nella colonna specifica.

https://www.banana.ch/it/node/10968
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I centri di costo vengono anche utilizzati per impostare il partitario Clienti / Fornitori nella contabilità
sull'incassato  o per gestire i soci di un'associazione.

Registrazioni su Segmenti
I Segmenti sono utilizzati per avere una separazione sistematica dei costi e dei ricavi per unità,
dipartimento o succursale. Usando i segmenti si può avere il Conto economico suddiviso per unità,
dipartimento o succursale, senza creare dei conti specifici per ciascuna unità.

L'utilizzo prevede l'impostazione dei Segmenti nella tabella Conti. Per registrare i segmenti, nella
tabella Registrazioni, nelle colonne Dare e/o Avere, successivamente ai numeri di conto, si
inserisce il o i segmenti. Maggiori dettagli sono disponibili alla pagina Segmenti.

Registrazioni di verifica saldi
Per facilitare le verifiche dei saldi, affinché questi siano conformi a determinate condizioni di veridicità
e corrispondenza, come ad esempio nel caso dei saldi dei conti bancari che devono coincidere con i
saldi contabili dei corrispondenti conti, si possono impostare le Registrazioni di verifica
(#CheckBalance). 

Con il comando Controlla contabilità, il programma controlla tramite le registrazioni di verifica le
corrispondenze, e in caso di errori, segnala dei messaggi di errore nella finestra Messaggi. 

Registrazioni per creare le fatture 
Con Banana Contabilità Plus puoi generare le fatture da inviare ai tuoi clienti direttamente nel file
della tua contabilità. Puoi stampare le fatture con codice QR (per la Svizzera) o senza codice QR (per
altre nazioni).

Bastano pochi passaggi per creare le tue fatture:

Nella tabella Conti imposti la lista dei tuoi clienti, e per ogni cliente inserisci tutti i dati
(indirizzo, nazione, lingua..).
Nella tabella Registrazioni inserisci i dati delle fatture. 
Nelle Colonne quantità e prezzo inserisci i dati specifici della fattura
Completando i dati 

Inserimento veloce
Ci sono tante funzionalità che rendono molto veloce l'inserimento e la modifica dei dati:

Annullare e ripristinare.
Selezionare una o più celle e copiare/incollare.
Aggiungere, copiare, incollare e cancellare righe, singolarmente o in blocco.
Ricercare e sostituire testi.
Ordinare le righe per data.
Filtro per cercare facilmente i dati che hai bisogno e modificare direttamente.
Con il tasto F6 i valori della riga vengono completati, riprendendo quelli della riga uguale.
Il tasto F4  riprende i valori dalla riga precedenti.
La data viene completata con i valori della riga precedente.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 319

Nella colonna Doc ti viene suggerito il numero progressivo (con diversi contatori).
Nella colonna Conto dare o avere puoi ricercare il conto digitando la sua descrizione.
Nelle colonne degli importi puoi inserire formule, del tipo "30+25" e il programma inserisce il
risultato.

Maggiori informazioni sono disponibili alle pagine:

Celle
Registrazioni ricorrenti
Registrazioni automatiche

Importazione movimenti
Con l'importazione dei movimenti dagli estratti bancari, postali o dalle carte di credito, si velocizza
l'inserimento dei dati nella tabella Registrazioni e si evitano errori. I dati vengono ripresi esattamente
come si presentano sull'estratto conto. 

Nella versione di Banana Contabilità Plus, piano Advanced , si può utilizzare la funzione delle
Regole che permette in un istante di importare i movimenti dal conto bancario, postale o carta di
credito, registrando in modo completo con la contropartita, il codice IVA e centri di costo o profitto.

Oltre agli estratti conto, si possono importare i dati anche da altri programmi.
Il programma completa in automatico i valori mancanti.
Sono a disposizioni diversi  formati per l'importazione.
Si possono copiare e incollare dati da altri programmi.
I dati importati possono essere completati, modificati o eliminati.
Possibilità di programmare delle estensioni per importare qualsiasi tipo di file.

Maggiori informazioni sono disponibili alle pagine

Importa in Contabilità.
 Regole di auto-completamento .

Gestione di molteplici informazioni
Per ogni riga di registrazione si possono indicare molte informazioni:

La data valuta e quella del documento.
Un  numero progressivo di documento e di protocollo, o di riferimento esterno.
Altre informazioni supplementari che necessiti, aggiungendo delle colonne.
Collegamento al file del documento digitale.

Aggiungere e rimuovere collegamenti.
Aprire il collegamento e visualizzare il contenuto.

Gestione IVA (se nella creazione del file è stato scelta il tipo di contabilità con IVA):
Nella registrazione inserendo il codice IVA il programma calcola l'IVA in automatico.
Scompone e registra l'IVA sul conto designato.
Puoi definire se l'importo è al netto o al lordo IVA. 
Puoi indicare che si tratta di uno storno inserendo il segno meno "-" prima del codice IVA.
Puoi indicare una percentuale IVA che non è recuperabile.
Puoi codificare con codici supplementari casi particolari.

Centri di costo e profitto:
Fino a 3 centri di costo e profitto per ogni riga di registrazione.

https://www.banana.ch/it/buy
https://www.banana.ch/doc/it/rules
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Puoi registrare in negativo indicando il segno "-" davanti al conto centro di costo o
profitto.

Segmenti:
Per ogni conto dare o avere puoi indicare fino a 10 segmenti.

Gestione fornitori:
Gestione sia per principio di competenza (impostazione come partitario) che di cassa
(impostazione come centri di costi e profitto).
Gestione data di scadenza e di pagamento, per avere il report delle fatture aperte e
quelle pagate.

Gestione clienti:
Gestione sia per principio di competenza (impostazione come partitario) che di cassa
(impostazione come centri di costi e profitto).
Gestione data di scadenza e di pagamento, per avere il report delle fatture aperte e
quelle incassate.

Fatture ai clienti:
Inserimento dati per la creazione delle fatture.
Suggerimento del conto del cliente.
Quantità e prezzo (rendere le colonne visibili).

Per la fatturazione o controllo dei costi.
Calcolo automatico dell'importo.

Numero articolo (se attivata l'opzione)
Per collegarti alla tabella articoli.
Calcolo automatico delle quantità prodotti entrati e uscite.

Stampa fatture.
Indicazione di ulteriori informazioni necessarie alle stampe della fattura.

Scheda conto
Dalla tabella Registrazioni si può accedere a qualsiasi scheda conto, basta posizionarsi sulla cella del
conto (nella colonna Dare o Avere) e cliccare sul piccolo simbolo che appare nell'angolo in alto a
destra della cella.

Quando ci si trova nella scheda conto, cliccando sul numero di riga di un movimento si ritorna nella
tabella Registrazioni, esattamente sul movimento di origine.

Maggiori informazioni sulle schede conto sono disponibili alla pagina Scheda conto.

Verifica dati
L'inserimento dei valori è molto sicuro. Banana Contabilità ha delle funzioni che consentono la
rilevazione e la segnalazione automatica di errori.

Il programma verifica che i valori inseriti siano corretti.
Se vi è uno sbilancio tra le colonne Dare e Avere viene segnalato in rosso nella finestra Info.
Le registrazioni di cui non si è sicuri si possono lasciare in sospeso e completarle
successivamente.
Per ogni avviso di errore vi è una corrispondente pagina di aiuto (richiede la connessione
internet).
Nella finestra Info in basso hai le seguenti informazioni:

Descrizione, movimento e saldo dei conti usati.
Segnalazioni di errori messaggi d'errore con il link alla pagina di aiuto.
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Segnalazione differenza Dare e Avere.
Con la funzione del #checkbalance, inserendo i saldi effettivi della banca, puoi verificare subito
la corrispondenza dei saldi in contabilità ed evitare errori.
Con il comando Controlla contabilità, il programma ricontrolla tutti i dati inseriti e ti segnala
dimenticanze ed errori.
Puoi colorare le righe, cambiare font e metterle in grassetto.
Puoi proteggere le righe.
Blocco registrazioni con tecnologia blockchain.

Disposizione colonne
Per avere un inserimento dei dati a te più congeniale puoi disporre tutte le colonne secondo un ordine
proprio.

Puoi scegliere di:

Spostare le colonne verso destra o sinistra.
Visualizzare ulteriori colonne o nascondere quelle non necessarie.
Aggiungere colonne proprie
Memorizzare la disposizione delle colonne (viste).

Maggiori informazioni sono disponibili alla pagina Disponi colonne.
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Colonne e viste tabella Registrazioni |
Contabilità doppia

La tabella Registrazione ha una serie di viste con le colonne già impostate.

Colonne della tabella Registrazioni
Le colonne elencate qui di seguito e precedute da un * non sono di regola visibili. Per renderle visibili
usare il comando dal menu Dati → Disponi colonne.

Data
La data che viene inserita in questa colonna, è quella che il programma usa per attribuire la
registrazione a un periodo di competenza. La data deve essere riferita al periodo contabile definito
nelle Proprietà file (Dati base), dove nella sezione Opzioni si può indicarla come obbligatoria,
altrimenti il valore può essere vuoto. Se sono state bloccate le registrazioni, il programma segnala un
errore quando si inserisce una data inferiore o uguale alla data blocco.

*Data Documento
Si può indicare la data del documento, per esempio la data di emissione di una fattura.

*Data Valuta
Si può indicare la data valuta dell'operazione bancaria. Il valore viene importato da un estratto conto
in formato elettronico.

Documento
Il numero di giustificativo che di regola viene attribuito per identificare la registrazione contabile e si
riferisce al documento cartaceo. Quando si registra si consiglia di indicare sul documento un numero
progressivo, in modo che dalla registrazione si può facilmente risalire al documento contabile.
La funzione di auto-completamento suggerisce dei valori progressivi e dei codici di registrazione,
precedentemente impostati nella tabella registrazioni ripetitive.

Il programma propone il numero successivo di documento, che può essere ripreso con il tasto F6.

Progressione numerica, il programma incrementa semplicemente il valore più alto trovato nella
colonna Doc.

Progressione alfanumerica. Il programma incrementa la parte numerica finale, utile se si
vogliono tenere numerazioni separate per la cassa o la banca:

Se precedentemente è stato inserito  C-01 e si inizia a digitare C, il programma propone
C-02.
Se precedentemente è stato inserito  B104 e si inizia a digitare B, il programma propone
B105.
Se precedentemente è stato inserito  D10-04 e si inizia a digitare D, il programma
propone D10-05.

Nelle Registrazioni ricorrenti si possono predisporre delle registrazioni di gruppo che possono essere
riprese in blocco tramite un codice nella tabella Registrazioni.
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Per aggiungere una grande quantità di numeri di documento si può usufruire di Excel. Creare in Excel
la quantità desiderata di numeri di documento e copiare e incollare  nella colonna Doc della tabella
Registrazioni di Banana Contabilità.

*Documento protocollo
È una colonna supplementare da utilizzare quando si vuole attribuire un'altra numerazione alle
registrazioni o al documento. La funzione di auto-completamento suggerisce un valore progressivo
che ha lo stesso funzionamento della colonna Documento. Si usa per esempio:

Quando si necessita di attribuire un numero progressivo alle registrazioni, diverso dal numero di
documento.
Se le registrazioni sono inserite da altre persone, usando un altro file e poi queste sono
importate nella contabilità. In questo modo si può avere sia una numerazione progressiva
riferita alla contabilità sia il numero originale.

*Tipo Documento
Contiene un codice che il programma usa per identificare un tipo di registrazione. Se si desidera usare
dei codici propri è meglio aggiungere una nuova colonna.

01 - Nei report questa registrazione è considerata una registrazione d'apertura, quindi non
figura nel periodo, ma nei Saldi iniziali.
dal 10 al 19 - Codici per fatture clienti.
dal 20 al 29 - Codici per fatture fornitori.
dal 30 fino al 1000 -  Codici riservati per scopi futuri.

*Numero fattura
Si riporta il numero di fattura del cliente o del fornitore. Questa colonna è fondamentale perché viene
usata in in combinazione con la funzione di controllo fatture Clienti e Fornitori.

*Documento originale
Il numero di riferimento presente su un documento, per inserire per esempio il numero di una nota di
credito.

*DocLink Collegamento a file esterno
In questa colonna si inserisce un link a un file esterno, di regola al giustificativo contabile. Vedi
Inserire, modificare e aprire collegamenti.

Quando nella cella è stato inserito un collegamento, appare una piccola icona e cliccandovi il
programma apre il documento, ma solo se si tratta di un'estensione considerata sicura.
L'altra piccola icona permette d'inserire e modificare il collegamento.

 *Riferimento Esterno
L'eventuale numero di riferimento attribuito da un programma che ha generato questa operazione.
Questo valore può servire per controllare che una medesima operazione non sia stata importata due
volte.

Descrizione
Il testo della registrazione.
La funzione di auto-completamento suggerisce il testo di una registrazione già inserita, o inserita
l'anno precedente se è attiva l'apposita opzione.
Se si preme il tasto F6 il programma riprende i dati della riga precedente con la medesima
descrizione e completa i campi della riga attuale.

https://it.wikipedia.org/wiki/Copia_e_incolla
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Se la descrizione inizia con #CheckBalance, la registrazione viene considerata una registrazione per il
controllo del saldo.
Si veda a questo proposito la spiegazione nella pagina controllo contabilità.

*Note
Serve per aggiungere delle note alla registrazione.

Conto Dare
Il conto che viene addebitato.

Nel conto Dare si possono inserire anche dei segmenti, separati di regola da un ":" o un "-".
Inserendo il segno di separatore di segmento si passa immediatamente al segmento
successivo. 
Se si preme il tasto invio si termina invece l'input e si passa alla colonna successiva.
La funzione di auto-completamento propone i conti e i segmenti presenti nel piano contabile.
Invece del conto si può inserire un testo di ricerca. Il programma propone l'elenco dei conti che
contiene il testo in una delle colonne.

*Conto Dare Descrizione
La descrizione del conto inserito in dare, ripresa dal piano dei conti.

Conto Avere
Il conto che viene accreditato.

*Conto Avere Descrizione
La descrizione del conto inserito, ripresa dal piano dei conti.

Importo
L'importo che viene registrato sul conto Dare e Avere.

*Saldo
La colonna Saldo  indica la somma fra il Dare e l'Avere. Viene quindi visualizzato un importo solo per
le registrazioni su diversi conti. Al termine della registrazione il saldo deve essere a zero. Se un
importo si ripete significa che c'è un errore.

Le colonne IVA
Per le spiegazioni delle colonne IVA, consultare la pagina Registrazioni della gestione IVA .

CC1
Il conto di un Centro di costo preceduto dal "." da immettere senza il ".".
Se la sigla è preceduta dal segno meno "-P1", l'importo viene registrato in Avere.

*CC1 Descrizione
La descrizione del centro di costo ripresa dal piano dei conti.

CC2
Il conto di un Centro di costo preceduto dal "," da immettere senza il ",".
Se la sigla è preceduta dal segno meno "-P2", l'importo viene registrato in Avere.

*CC2 Descrizione
La descrizione del centro di costo ripresa dal piano dei conti.

CC3

https://www.banana.ch/doc10/it/node/9827
http://www.banana.ch/doc/it/node/3407#0
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Il conto di un centro di costo preceduto dal ";" da immettere senza il ";".
Se la sigla è preceduta dal segno meno "-P3" l'importo viene registrato in avere.

*CC3 Descrizione
La descrizione del centro di costo ripresa dal piano dei conti.

*Data Scadenza
La data entro la quale la fattura deve essere pagata. Per maggiori informazioni si vedano le pagine
Clienti e Fornitori.

*Data Pagamento
Si inserisce la data del pagamento, usata in combinazione con il comando visualizza scadenze.
Per usare le funzioni di controllo delle fatture clienti e fornitori si deve inserire una registrazione per
l'emissione della fattura e un'altra per il pagamento.

*Blocco Numero, Blocco Importo, Blocco Progressivo, Blocco Linea
Si veda la funzione Blocca registrazioni.

 Colonne aggiuntive
Dal menu Strumenti → Aggiungi nuove funzionalità → Aggiungi colonne Articoli nella tabella
Registrazioni  vengono aggiunte le seguenti colonne:

IdArticolo
L'identificatore dell'articolo della tabella Articoli. Se si inserisce un articolo presente nella tabella
Articoli, sono ripresi la descrizione, unità, prezzo unitario, codice IVA e conto.

Quantità
Il quantitativo che moltiplicato per il prezzo unitario dà il totale dell'importo (può essere anche un
numero negativo).

Unità
Una descrizione riferita alla quantità, per esempio: mq, ton, pz.

Prezzo/Unità
Il prezzo per ogni unità, che moltiplicato con la quantità dà il totale dell'importo (può essere anche un
numero negativo).

Se è stato inserito un valore nella colonna Quantità o Prezzo unitario, l'importo viene calcolato in base
ai contenuti di queste due colonne e convertito in un valore positivo.

 Aggiungere nuove colonne
Con il comando Disponi colonne è possibile rendere visibili delle colonne, nasconderle, spostarne la
sequenza, aggiungerne di supplementari o indicare che una determinata colonna non deve essere
stampata.

Le colonne aggiunte nella tabella Registrazioni sono visibili anche nella tabella Registrazioni
ripetitive, Scheda conto, Riassunto IVA senza renderle visibili.
Per visualizzare queste colonne nelle altre tabelle si dovrà usare il comando Disponi colonne.
Se nella scheda conto si aggiunge una colonna importo, gli importi inseriti vengono sommati.

http://www.banana.ch/doc/it/node/9290
http://www.banana.ch/doc/it/node/9290
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Viste
Quando si crea una nuova contabilità vengono create e visualizzate automaticamente le seguenti
viste:

Base - Colonne principali.
Centri di Costo - Colonne CC1, CC2 e CC3.
Scadenze - Colonne Data Scadenza e Data Pagamento
Blocco - Colonne del Blocco.

Con il comando Disponi Viste si possono personalizzare le viste e crearne di proprie aggiuntive.
Con il comando Imposta pagina si può cambiare la modalità di stampa della vista.
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Tipi di registrazioni

Registrazioni semplici (su di una riga)
Le registrazioni semplici sono quelle che riguardano due conti e vengono inserite ognuna su di una
sola riga.
Il numero di documento è diverso per ogni registrazione.

 

Registrazioni composte (su più righe)
Le registrazioni composte, quelle che riguardano più di due conti, devono essere registrate su più
righe. Si registra un conto per riga. La contropartita delle registrazioni deve essere inserita come
prima riga.
Il numero di documento e la data riportati sulle diverse righe sono uguali poiché si tratta della stessa
registrazione.

Nota:

Nelle registrazioni composte, le date delle righe di registrazione devono essere uguali altrimenti, in
caso di calcoli per periodo, ci possono essere delle differenze contabili.

Registrazioni d'apertura
I saldi d'apertura sono indicati normalmente nella tabella Conti.

Le registrazioni d'apertura sono necessari in casi particolari come:

Nella contabilità multi moneta, quando si necessita di avere dei cambi d'apertura diversi
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rispetto a quello indicato nella tabella Cambi, cambio d'apertura. Vedi Registrazioni d'apertura
in moneta estera.
Inserimento di Saldi d'apertura dei segmenti.

Le registrazioni d'apertura si creano inserendo delle registrazioni con data d'apertura uguale alla data
inizio contabilità e il codice 01 nella colonna DocTipo.

Le registrazioni d'apertura non cambiano il saldo d'apertura nella tabella conti.
Il saldo d'apertura inserito con delle registrazioni viene usato nelle stampe di bilancio, schede
conto.
Se per lo stesso conto vi è il saldo d'apertura e la registrazione del saldo d'apertura i due
importi verranno sommati. 
In questo modo si possono inserire delle registrazioni d'apertura che rettificano l'apertura di un
conto.
Quando si inseriscono saldi d'apertura nelle registrazioni bisogna fare in modo che la somma
del dare (positivo) e dell'avere (negativo) vadano ad azzerarsi.
Per ogni registrazione in dare ci deve essere una corrispettiva registrazione in avere.
Può essere utile avere un conto d'apertura che serve da contropartita per l'immissione degli
importi d'apertura.
Dopo tutte le registrazioni d'apertura, il saldo di questo conto dovrà ovviamente avere saldo
zero.

Quando si inseriscono i saldi d'apertura si indica generalmente solo il conto Dare o Avere. Si può però
anche indicare una contropartita che generalmente è un conto apposito per le aperture.
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Registrazioni saldi di verifica
(#CheckBalance)

Banana Contabilità Plus include nel comando Controlla contabilità la funzione del #CheckBalance per
la verifica e la corrispondenza dei saldi contabili.

Questo controllo è fondamentale per la veridicità della contabilità. La verifica dei saldi, oltre che alla
fine dell'esercizio contabile, si consiglia di eseguirla periodicamente a fine mese, per evitare che
eventuali saldi non corrispondenti vengano riportati sbagliati da mese in mese.

Per poter eseguire questo controllo, si procede come segue:

Si registra la data a cui si riferisce il saldo.
Nella colonna Descrizione si inserisce #CheckBalance seguito dall'importo corrispondente al
saldo da verificare (es. saldo effettivo presente in cassa, saldo bancario dell'estratto
bancario...).
Nel conto Dare indicare il conto su cui si effettua la verifica (conto bancario, cassa, conto IVA o
altro conto che si intende verificare).
Nella colonna Importo la cella deve essere vuota.

Il programma con questo comando, in caso di non corrispondenza dei saldi, segnala nella finestra
Messaggi i conti con i saldi non corrispondenti.
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Registrare gli assegni bancari

Per registrare l'emissione di assegni bancari è necessario inserire nelle passività un conto Assegni
emessi.

L'assegno viene emesso al momento di pagare un fornitore. Successivamente viene addebitato sul
conto corrente bancario.

La scheda conto Assegni emessi dopo le registrazioni.
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Registrare i movimenti della carta di credito
con acconti

Versamento acconto su carta di credito
Quando si versano degli acconti sulla carta di credito occorre verificare che nella tabella Conti sia
presente il conto Carta di credito, altrimenti occorre inserirlo nella sezione dei Passivi.

Il conto carta di credito si aggiunge nel gruppo o sottogruppo dei debiti a breve termine; se non ci
sono dei sottogruppi si elenca nei passivi.

Esempio:

Sul conto carta di credito è stato versato un importo di 1'000.-

In Dare si registra il conto carta di credito
In Avere si registra il conto bancario con cui viene eseguito il versamento.

Registrare la fattura della carta di credito
Quando arriva la fattura della carta di credito occorre registrare tutti i costi elencati nella carta di
credito e stornare il credito dal conto carta di credito.

Esempio:
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Riceviamo la fattura della carta di credito per un totale di 749.- CHF (dettagli: 479 CHF per acquisto
computer, 150.00 CHF per spese alberghiere, 120 CHF acquisto di materiale per ufficio) (Doc. 10).

Si registra su più righe:

In Dare si registrano tutti i costi che sono relativi alle spese elencate nella carta di credito; si
registra un costo per riga.
In Avere si registra il conto carta di credito.

Verificare il saldo del conto carta di credito

Ogni volta che si versano anticipatamente degli acconti sulla carta di credito e sono stati registrati
tutti i costi elencati sulla carta di credito, bisogna verificare che il saldo del conto carta di credito
corrisponda alla disponibilità presente ancora sulla carta di credito.
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Registrare i movimenti della carta di credito
sull'incassato e sul fatturato

Carta di credito e contabilità sull'incassato
Se non vengono effettuati degli acconti sulla carta di credito e la fattura viene pagata integralmente
tramite banca, la fattura della carta di credito, con la rilevazione dei costi viene registrata al momento
del pagamento.

Si registra su più righe:

Su tutte le righe che compongono la registrazione, inserire per ogni movimento la stessa data e
lo stesso Nr. di documento.
Nella colonna Dare inserire un conto per riga, riferito al costo o all'investimento della
transazione con carta si credito.
Inserire l'importo di ogni singola transazione registrata in Dare.
Nella colonna Avere inserire il conto della banca o posta con cui viene pagata la fattura.
Nella colonna Importo inserire l'importo totale pagato della fattura carta di credito .
Nel caso di assoggettamento IVA, nella colonna Cod.IVA inserire per ogni riga il codice IVA.

Dopo aver registrato tutti i movimenti verificare il saldo della carta di credito, semplicemente aprendo
la scheda conto della carta di credito.

Carta di credito e contabilità sul fatturato
Se le registrazioni della contabilità si basano sul fatturato, tutti i costi relativi agli acquisti con carta
di credito si registrano al momento del ricevimento della fattura carta di credito:

Su tutte le righe che compongono la registrazione, inserire per ogni movimento la stessa data e
lo stesso Nr. di documento.
In Dare si registrano tutti i conti relativi ai costi. Ogni costo va registrato su una riga.
Nella colonna Importo inserire l'importo della singola transazione registrata in Dare.
In Avere si registra il conto della carta di credito, come qualsiasi fornitore.
Nella colonna Importo inserire l'importo complessivo da pagare della carta di credito.
Nel caso di assoggettamento IVA, nella colonna Cod.IVA inserire per ogni riga il codice IVA.
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Quando la fattura della carta di credito viene pagata, si registra:

In Dare il conto della carta di credito (il debito si estingue).
In Avere il conto banca o posta con cui viene pagata la fattura.
Come importo si registra l'importo complessivo della carta di credito pagato.
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Importare i movimenti dalla carta di credito

Banana Contabilità prevede l'importazione dei movimenti dalla carta di credito nel file della
contabilità principale.

Bisogna assicurarsi che nel piano contabile sia presente il conto carta di credito e il conto di giro
da utilizzare in caso di versamento di acconti.

Installare il formato della propria banca
Per poter eseguire l'importazione è necessario che il formato dei dati, fornito dalla banca emittente
della carta di credito, sia compatibile con i formati previsti da Banana contabilità.

Per installare l'estensione relativa al formato dei dati rilasciati dalla banca emittente, procedere come
segue:

Menu Estensioni → Gestione Estensioni.
Selezionare la banca emittente della carta di credito e cliccare sul bottone Installa.
Il formato verrà visualizzato nella finestra di dialogo Importa in contabilità.

Importare i movimenti dalla carta di credito
Dopo aver installato l'estensione per il formato dei dati compatibile con Banana, per importare i dati
procedere come segue:

Menu Azioni → Importa in contabilità → Registrazioni:
Selezionare il tipo di formato della banca che ha emesso la carta di credito.

Con il bottone Sfoglia selezionare il file trasmesso dalla banca e confermare con OK.
Inserire il periodo e indicare il conto della carta di credito e confermare con OK.
Tutti i movimenti vengono importati nella tabella Registrazioni.
Per ogni riga inserire il conto di contropartita che si riferisce al movimento.

Importare i movimenti dalla carta di credito con acconti
versati
Quando  sulla carta di credito sono stati versati degli acconti, questi vengono registrati in contabilità.
In questo caso, dopo l'importazione dei dati della carta di credito vi è la problematica delle
registrazioni di versamento degli acconti. In questo caso sul conto carta di credito figura una doppia
registrazione:

Presenza del conto carta di credito come contropartita degli addebiti bancari per i versamenti
sulla carta di credito.
Presenza del conto carta di credito nei movimenti importati dalla carta di credito.

Per ovviare a questa sovrapposizione si utilizza, al momento dell'importazione, il conto di giro.

Come eseguire l'importazione:

Dalla finestra Azioni → Importa in contabilità → Registrazioni:

http://www.banana.ch/doc/it/node/4702
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Selezionare il tipo di formato della banca che ha emesso la carta di credito.
Con il bottone Sfoglia selezionare il file trasmesso dalla banca e confermare sul bottone OK.
Inserire il periodo e indicare il conto di giro. Confermare sul bottone OK.
Tutti i movimenti vengono importati nella tabella Registrazioni.
Per ogni riga inserire il conto della contropartita che si riferisce al movimento.
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Tabella Totali

La tabella Totali presenta i totali dei gruppi principali e serve per controllare la quadratura contabile.
Viene elaborata automaticamente dal programma e non è modificabile dall'utente.

Nella tabella Totali è possibile, a colpo d'occhio, avere un'idea della situazione della propria attività. Si
vedono i totali attivi, passivi, costi e ricavi e soprattutto si vede se si ha un utile o una perdita
d'esercizio.
Il gruppo 00 è molto importante perché permette subito di vedere se ci sono delle differenze di
quadratura.
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Stampe

Tutte le stampe del Bilancio, del Conto economico, e dei vari Report contabili sono disponibili dal
menu Report. Ogni comando dispone di varie opzioni per la personalizzazione delle varie stampe.

Bilancio abbellito con gruppi
Questo esempio è stato realizzato con le seguenti funzioni:

Bilancio abbellito con gruppi.
Impostazioni colonne per indicare quali colonne visualizzare (nell'esempio sono visualizzate le
colonne Corrente e Anno precedente).
Stile: Lugano (Gruppi evidenziati), Proprietà stile: Gruppi e totali: Colore.

Il Conto Economico
Il Conto Economico visualizza tutti i conti dei Costi e dei Ricavi, con l'indicazione dell'Utile o della
Perdita d'esercizio.
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Bilancio abbellito con preventivo
Questo esempio è stato realizzato con le seguenti funzioni:

Bilancio Abbellito.
Opzioni Includi in stampa: per indicare quale colonne visualizzare (nell'esempio sono
visualizzate la colonna Corrente, Preventivo).
Stile: Berlino, colonne colorate.

 Bilancio abbellito
Questo esempio è stato realizzato con le seguenti funzioni:

Bilancio Abbellito.
Opzioni Includi in stampa : per indicare quali colonne visualizzare (nell'esempio sono state
attivate le colonne Corrente, Precedente, Differenza %).
Stile: Berlino, colonne colorate.

Suddivisione per semestre
Questo esempio è stato realizzato con le seguenti funzioni:

Bilancio abbellito con gruppi.
Impostazioni colonne per indicare quali colonne visualizzare (Corrente e Preventivo).
Suddivisione → Suddivisione per periodo per impostare la suddivisione per semestre.
Stile: Lugano (Gruppi evidenziati), Proprietà stile: Gruppi e totali: Colore.
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Proprietà colonne colori per colorare le colonne in modo diverso.
 

Suddivisione per segmento
Questo esempio è stato realizzato con le seguenti funzioni:

Bilancio abbellito con gruppi.
Suddivisione → Suddivisione per segmento per scegliere il livello di segmento da visualizzare.
Stile  di stampa:
Per la stampa dei segmenti non è possibile impostare il colore delle colonne.

 
Archivio Pdf con tutti i dati della contabilità
Il file viene creato con un sommario che permette di accedere alle diverse stampe in modo semplice.

È previsto il salvataggio in PDF dei seguenti dati:

Bilancio e Conto economico.
Tabelle Conti, Registrazioni, Codici IVA, Totali.
Riassunti IVA.
Schede dei conti.

A fine anno, quando tutta la contabilità è stata completata, corretta e revisionata, si possono
archiviare tutti i dati contabili:
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dal menu File → Crea dossier in Pdf .

Se il file in PDF viene salvato su un CD non riscrivibile (da conservare assieme ai documenti contabili)
si soddisfano i requisiti di legge per l'archiviazione dei dati contabili.

Stampare una colonna supplementare
Per stampare nel Bilancio una colonna supplementare si usano le seguenti funzioni:

Aggiungere la nuova colonna nella tabella Conti, tramite il menu Dati → Disponi colonne
Bilancio abbellito con gruppi
Colonne - Avanzato, per attivare la visualizzazione della nuova colonna.

http://www.banana.ch/doc/it/node/2600
http://www.banana.ch/doc/it/node/2710
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Schede conto / Libro mastro

Le schede conto in termini contabili corrispondono al Libro Mastro. Contiene l'elenco completo dei
movimenti contabili che riguardano uno stesso conto, un centro di costo, un segmento o un gruppo.

Una scheda conto contiene le seguenti informazioni:

Il nome del conto rappresentato dalla scheda
La data dell'operazione finanziaria
Il tipo di operazione finanziaria (ad esempio, vendita, acquisto, pagamento, ricevimento)
L'importo 
La descrizione (ad esempio, il nome del fornitore o del cliente, la natura dei beni o dei servizi
acquistati o venduti).

Banana Contabilità riporta in automatico tutti i movimenti registrati nella tabella Registrazioni,
imputandoli ai conti specifici corrispondenti. Le schede conto, pertanto, vengono aggiornate ogni
volta che si registra un movimento nella tabella Registrazioni. 

Aprire la scheda conto
La scheda di un conto si può aprire con due modalità diverse:

Primo metodo

Questo metodo è consigliato quando si vogliono visualizzare e stampare tutte o diverse schede conto.

Cliccare dal menu Report → Schede conto

Si presenta una finestra di dialogo con le seguenti sezioni:

Conti
Periodo
Opzioni
Personalizzazione

http://www.banana.ch/doc/it/node/7217
http://www.banana.ch/doc/it/node/2729
http://www.banana.ch/doc/it/node/2604
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Per avere le informazioni dettagliate delle sezioni, cliccare sui corrispondenti link.

Secondo metodo

Cliccare sul piccolo simbolo che si presenta quando si seleziona la cella che contiene il numero
di conto o di gruppo.

Le Schede conto
Le schede conto riportano in automatico tutti i movimenti registrati sullo stesso conto (Es. i movimenti
della cassa, banca, clienti, ecc...).

Per visualizzare la scheda di un conto, basta posizionarsi con il mouse sul numero di conto e cliccare
sul piccolo simbolo che appare in alto a destra della cella.

Schede conto per periodo

Per visualizzare le schede conto con i saldi riferiti ad un determinato periodo, procedere come segue:

Menu Report → Schede conto.
Nella sezione Periodo attivare Specificato, inserendo la data di inizio e di fine periodo.

Per maggiori informazioni consultare la pagina Periodo.

Stampare una scheda conto

Per stampare una scheda conto, basta visualizzare la scheda da qualsiasi tabella (Conti o
Registrazioni) e lanciare la stampa dal menu File.

Stampare tutte o alcune schede conto

Per stampare tutte o alcune schede conto, procedere come segue:
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Menu Report → Schede conto,
 Selezionare le schede conto da stampare:
Tramite il filtro presente nella finestra, si può eseguire una selezione in automatico di tutti i
conti, centri di costo, segmenti, gruppi o semplicemente si possono selezionare solo i conti
desiderati.

Maggiori informazioni sono disponibili alla pagina Scheda conto. 

Aggiornare la scheda conto
La scheda conto è temporanea e viene calcolata al momento della richiesta. Se nella Tabella
Registrazioni, si cambiano o aggiungono delle registrazioni,  la scheda conto non viene aggiornata
simultaneamente.

Per aggiornare la scheda conto, in seguito a modifiche,  occorre impartire nuovamente il comando
Scheda conto, oppure se la scheda conto è ancora aperta, cliccare sul simbolo indicato
nell'immagine sottostante.

 Cancellare o modificare dati
Nelle schede conto o di gruppo non è possibile modificare o cancellare i dati direttamente. Se
sono necessarie delle modifiche, queste devono essere eseguite nella tabella Registrazioni o nella
tabella Preventivo (se riguardano delle registrazioni di preventivo) e, successivamente dopo il
ricalcolo, le modifiche vengono apportate automaticamente nella relativa scheda conto.

Se si è nella scheda conto e ci si accorge di un errore o di una modifica da fare, occorre:

All'interno della scheda conto, posizionarsi sul numero di riga che riguarda la modifica.
Doppio clic sul numero di riga e il programma rimanda in automatico alla tabella Registrazioni,
proprio sulla riga che riguarda la modifica.
Eseguire la modifica e ricalcolare la contabilità (tasti maiuscolo + F9).

Le modifiche vengono riportate in automatico nella scheda corrispondente.

La colonna Conto Selezionato
Nella colonna Conto Selezionato, che si può rendere visibile, a partire da qualsiasi scheda conto,
con il menu Dati → Disponi colonne , viene visualizzato il conto sul quale è avvenuto il movimento.
Quando si ottiene una scheda conto di uno o più conti, gruppi e segmenti, si vede esattamente il
conto usato.

http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
http://www.banana.ch/doc/it/node/2710
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La contropartita nella scheda conto
Nelle schede conto è visualizzata la colonna "Contrp" che indica il conto di contropartita che completa
la registrazione.

Quando ci sono delle registrazioni su diversi conti (registrazioni su più righe), come nell'esempio
sottostante, e vi è un conto registrato in Dare e più conti registrati in Avere, o viceversa, il
programma deduce la possibile contropartita con la seguente logica:

Nella prima riga di registrazione, il conto 5000 è considerato la contropartita comune delle
registrazioni successive.

Nella scheda conto 5000, la registrazione multipla (Stipendi lordi per il mese di dicembre) ha
come contropartita  il simbolo [*]. Non è possibile avere l'indicazione della contropartita
direttamente nella scheda conto poiché il conto ha diverse contropartite (1020, 5700, 5730).
Per questo motivo nella colonna della contropartita il programma indica il simbolo [*] che
significa registrazione su diversi conti.

Nelle schede conto delle successive righe di registrazione (1020, 5700, 5730), la contropartita
(comune) è indicata fra parentesi quadre [5000], ed indica una contropartita dedotta.
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Schede di gruppi o classi
Nella scheda conto di un gruppo o di una classe  sono raggruppate tutte le registrazioni di quei conti
che appartengono al gruppo o alla classe selezionata.
I conti del gruppo o della classe possono essere visualizzati rendendo visibile la colonna
ContoSelezionato.  

 Scheda conto del Preventivo
Se nella tabella del Preventivo sono state inserite le registrazioni di preventivo e possibile avere le
schede conto o di gruppo del preventivo:

Menu Report → Schede conto → Attiva Registrazioni di preventivo .

http://www.banana.ch/doc/it/node/2846
http://www.banana.ch/doc/it/node/2846#registrazioni_preventivo
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Stampare il Libro Mastro (schede conto)
Per stampare le schede:

Menu Report, comando Schede conto;
Attraverso il Filtro si possono selezionare in automatico tutte le schede conto da stampare o in
parte (es. solo conti, centri di costo, segmenti)
Nelle diverse sezioni Periodo, Opzioni, Personalizzazioni si attivano le funzioni desiderate
(es. periodo, un conto per pagina....)
Confermare con OK, dopo aver impostato le opzioni desiderate.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 348

Le spiegazioni delle sezioni si trovano nelle pagine che seguono: Conti, Periodo e Opzioni.
Appariranno a video le schede conto selezionate.

Per stampare cliccare sul menu File, comando Stampa.

Quando nel file della contabilità è presente la tabella Preventivo, si può scegliere quali movimenti
visualizzazione (registrazioni effettive oppure registrazioni preventivo).

Inserire un logo nelle schede conto
A partire da Banana 9, è possibile inserire un logo anche nella stampa delle schede conto. Dopo aver
creato il dettaglio della scheda conto, tramite il menu Report → Schede conto, andare
nell'Anteprima di stampa menu File → Anteprima di stampa. Selezionare l'icona dell'Impostazione
di pagina e nella finestra di dialogo che si apre, alla voce Logo, indicare il vostro logo (invece della
voce nessuno).
Vedi anche la pagina su come inserire il Logo.

Salvare le impostazioni
Se vi capita di stampare regolarmente le schede di taluni conti, per esempio tutte quelle delle
vendite, è utile creare una personalizzazione apposita.

Andate nella sezione personalizzazione
Create una nuova personalizzazione con il bottone Nuova
Indicate nella descrizione il nome, per esempio "Conti vendita"
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Selezionate i conti che desiderate stampare
Impostate le opzioni di visualizzazione della scheda. È possibile selezionare e modificare la
vista, tra quelle disponibili, ma non crearne una nuova. Se si modifica la disposizione di una
colonna, ad esempio cambiandone l'intestazione, questa verrà applicata alla vista associata di
tutte le personalizzazioni.

Tutte le volte che volete stampare i conti selezionate la personalizzazione creata.

Imposta pagina
In Imposta pagina potete specificare i margini e altre impostazioni della pagina.
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Conti

Si accede a questa finestra di dialogo dal menu Report → Schede conto (vedi pagina Schede conto).

Conti
In questa sezione appare la lista di tutti i conti.

Seleziona tutti

Attivando la funzione vengono selezionate tutte le schede conto presenti nel piano contabile.

Se si desidera stampare una scheda conto o una selezione di schede conto, selezionare solo i conti da
stampare.

Selezione dei conti con il mouse

Cliccando sul nome del conto, viene selezionato il conto e la selezione precedente annullata.
Cliccando sulla casella di spunta del conto (all'interno del checkbox) viene
selezionato/deselezionato il conto e la selezione precedente rimane invariata.
Per selezionare contemporaneamente più conti adiacenti, basta cliccare sul primo, tenere
premuto il tasto  sinistro del mouse e spostarsi con il mouse sull'elenco.
Per la selezione multipla di più conti non adiacenti, tenere premuto il tasto Ctrl o Cmd (su
Mac). Il tasto Shift mantiene la selezione.

Selezione dei conti con la tastiera

Usando la barra spaziatrice (tasto spazio), viene selezionato/deselezionato il conto e la
selezione precedente annullata.
Per la selezione multipla di più conti, tenere premuto il tasto Ctrl o Cmd (su Mac), mentre ci
si sposta con i tasti freccia su/giù e barra spaziatrice. Il tasto Shift mantiene la selezione.

Cerca

L'opzione consente la ricerca immediata di uno o più conti. Nella casella si inserisce il numero di conto
o la descrizione del conto; il programma filtra i conti che hanno i valori di ricerca inseriti.
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Si possono inserire anche più conti da visualizzare contemporaneamente, oppure, combinare conti e
segmenti (vedi spiegazioni sviluppatori in inglese):

1000|1001 - visualizza i movimenti dei conti 1000 e 1001.
1000:01 - visualizza tutti i movimenti del conto 1000 con il segmento 01.

Ordina per numero di conto

Se si attiva l'opzione, si ha un ordinamento dei conti secondo la selezione che si applica nel Filtro (in
basso alla finestra di dialogo). Per esempio, se ci sono dei conti, centri di costo o segmenti con delle
sigle, questi vengono elencati in ordine alfabetico.

Filtro

Questa funzione permette di filtrare una selezione o tutte le schede conto, in particolare:

Conti, centri di costo e segmenti - se non viene eseguita alcuna selezione, sono filtrati per
default.
Conti - sono esclusi eventuali centri di costo e segmenti.
Conti, Centri di costo - sono esclusi eventuali segmenti.
Centri di costo - sono esclusi i conti ed eventuali segmenti.
Segmenti - sono esclusi conti ed eventuali centri di costo.
Gruppi - vengono visualizzati tutti i gruppi; occorre selezionare i gruppi da stampare.
Classi - vengono visualizzate tutte le classi; occorre selezionare le classi da stampare.

 Registrazioni effettive o di preventivo
Quando nel file della contabilità è presente la tabella Preventivo, si può scegliere di visualizzare e
stampare:

Registrazioni effettive
Per la visualizzazione dei movimenti della tabella Registrazioni.
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Registrazioni preventivo
Per la visualizzazione dei movimenti della tabella Preventivo.
Se non è presente la tabella Preventivo, ma sono stati inseriti degli importi nella colonna
Preventivo della tabella Conti (Vista Preventivo), questi vengono convertiti in importi mensili.
La suddivisione eseguita dal programma si basa sulla data di inizio e di fine della contabilità (se
la durata è 1 anno, la suddivisione è di 12 mensilità).
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Scheda conto Gruppo 00 - Differenza nelle registrazioni
Quando ci sono delle differenze nelle registrazioni (vedi errore Differenza Dare - Avere), per capire
dove si trova l'errore si visualizza la scheda conto del Gruppo 00 (o quella del gruppo che nel tuo
piano dei conti include tutti i conti della BClasse 1, 2, 3 e 4).
Appare l'elenco di tutti i movimenti con il saldo progressivo, che dopo ogni registrazione deve andare
a zero. A partire dalla riga dove il saldo non è più a zero c'è la differenza.

Visualizzazione del dettaglio delle registrazioni

Utilizzando la scheda conto Gruppo 00, é possibile anche visualizzare il dettaglio delle registrazioni. 

Una volta effettuato la selezione della scheda conto Gruppo 00, appare l'elenco dei movimenti, é da
selezionare una colonna qualunque, doppio click sulla colonna e appare la schermata per selezionare
le colonne visibili, selezionare la colonna "MovimentoImporto". Fatta questa modifica, nella schermata
aperta dalla scheda conto Gruppo 00 apparirà la colonna Movimento in CHF con il dettaglio degli
importi specifici.

Doppio click su una colonna:

Seleziona la colonna "MovimentoImporto":
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Successivamente, si aggiungerà una nuova colonna "Movimento CHF" che mostrerà il dettaglio degli
importi dei singoli movimenti. Questa modifica può essere utile quando ad esempio si ha effettuato
una registrato che comprende l'IVA e si vuole avere il dettaglio della registrazione di tale importo,
tenendo separata l'IVA. 

Registrazione della fattura con IVA:

Dettaglio della registrazione della fattura con IVA con Scheda conto 00 e la colonna
"MovimentoImporto" attivati:



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 355

Sezione Periodo Scheda Conto

Le informazioni sulla sezione Periodo sono identiche a quelle della Sezione Periodo - Bilancio Abbellito
per gruppi.
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Opzioni

Dal menu Report → Schede conto → Opzioni si accede alle varie opzioni che possono essere
incluse o escluse dalla visualizzazione e dalla stampa.

Righe prima del fine pagina
Comando creato per evitare che un conto sia stampato in parte su una pagina e in parte sulla pagina
successiva. Se la scheda conto da stampare non ha almeno un numero di righe pari al valore inserito
nella casella Righe prima del fine pagina, la scheda viene stampata totalmente nella pagina
seguente.

Un conto per pagina
Vistando questa funzione, in fase di stampa ogni scheda conto viene stampata su una pagina nuova
(anche quelle con pochi movimenti).

Ripetere le intestazioni di colonna
Vistando questa funzione, le intestazioni di colonna si ripetono per ogni conto, all’interno della pagina.

Includi conti senza movimento
Vistando questa funzione vengono stampate anche le schede conto senza movimenti.

Vista
Si può selezionare la vista per le colonne da includere nella visualizzazione e nella stampa delle
schede conto:

Base
IVA
Centri di costo
Scadenze

Se non si specifica nessun criterio, viene mantenuto l’esatto ordinamento presente nella tabella
Registrazioni.

Colonna ordinamento
Nella scheda conto, le registrazioni si possono ordinare secondo diversi criteri di data:
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Data documento.
Data valuta.
Data scadenza.
Data pagamento.
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Libro giornale

In Contabilità il  "giornale" è un registro contabile in cui vengono registrate tutte le transazioni
finanziarie di un'azienda in ordine cronologico. È uno strumento fondamentale per la registrazione
delle operazioni contabili e svolge un ruolo cruciale nel processo di tenuta dei libri contabili.

In Banana Contabilità il Giornale è rappresentato dalla tabella Registrazioni, dove viene eseguito
l'inserimento dei movimenti in ordine cronologico. È da questa tabella che il programma fornisce un
registro dettagliato e completo di tutte le attività finanziarie dell'azienda e costituisce la base per la
preparazione di altri documenti contabili come il libro mastro e il bilancio e il Conto Economico.

Ogni transazione viene registrata attraverso annotazioni dettagliate, suddivise in delle colonne
specifiche:

Data: La data in cui è avvenuta la transazione.1.
Descrizione: Una breve descrizione della transazione, che indica la natura dell'operazione2.
contabile.
Conto addebitato: Il conto contabile addebitato per l'importo della transazione.3.
Conto accreditato: Il conto contabile accreditato per l'importo della transazione.4.
Importo: L'importo della transazione.5.

Le stampe del giornale possono essere generate sia per selezione sia dal comando che consente di
definire anche un periodo.

Maggiori informazioni sono disponibili alle pagine seguenti.

Ci sono differenti modi per stampare il Libro giornale:

Posizionarsi nella tabella Registrazioni e cliccare sull'icona che indica l'anteprima di stampa e
cliccare poi sull'icona stampa.
Dalla tabella Registrazioni, selezionare dal menu File > Anteprima di stampa > icona Stampa.
Dal menu Report > Giornale per periodo.

Periodo
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Si può scegliere se stampare tutto, oppure un determinato periodo. Per la stampa di un periodo
specifico, inserire la data d'inizio e la data di fine.

Ordinamento

Nella sezione Colonna per ordinamento è possibile scegliere in base a quale tipo di data ordinare e
stampare il giornale.

Personalizzare la stampa del Libro Giornale
Per personalizzare la stampa del libro giornale si può cambiare la disposizione e l'intestazione delle
colonne. Le informazioni si trovano alla pagina Disponi colonne; mentre le opzioni da includere nella
stampa si trovano nella pagina di spiegazione Imposta pagina.
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Bilancio abbellito

Il Bilancio rappresenta la situazione patrimoniale (Attivi e Passivi) ad un preciso momento. La
differenza tra attivi e passivi determina il capitale proprio. In Banana Contabilità il Bilancio abbellito
ha le seguenti caratteristiche:

Il raggruppamento dei conti avviene secondo il contenuto della colonna BClasse.
Il Bilancio abbellito (menu Report) visualizzato in anteprima,  può essere salvato nel formato
PDF, HTML, MS Excel e Copia negli appunti.
È possibile calcolare, visualizzare e stampare il bilancio a fine anno, o per un determinato
periodo.
Le registrazioni senza data sono conteggiate come aperture e non compaiono nella stampa del
conto economico.

Per calcolare, visualizzare e stampare il Bilancio abbellito cliccare sul menu Report > Bilancio
Abbellito. Appare una finestra con diverse sezioni che permettono di impostare i parametri della
stampa.

Vedi esempio di stampa

Stampa pagine e Includi in stampa
In queste sezioni attivando le varie opzioni elencate si possono scegliere quali contenuti visualizzare e
stampare nel Bilancio abbellito.

L'opzione "Saldi anno precedente" è disponibile solo se nella sezione Periodo è selezionato il campo
Tutto. Se viene invece definito un periodo specifico, l'opzione non è attiva. In questo caso, al posto di
questo report si dovrebbe utilizzare il Bilancio abbellito con gruppi.

Intestazioni pagina
Righe 1-4
Righe a disposizione per definire l’intestazione del Bilancio.

Logo
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È possibile inserire il logo nell'intestazione di tutte le pagine del report.
Se nel menu File > Imposta logo è stato aggiunto uno o più loghi, è possibile selezionarne uno dalla
lista.
Nel caso in cui non è stato aggiunto alcun logo, tramite il bottone Modifica si può aggiungere il logo.

Stampa numero di pagina 
Se l'opzione è attivata viene inserito il numero in progressione a piè di pagina.

Stampa data
Se l'opzione è attivata, viene inserita la data a piè di pagina.

Pagina copertina
Stampa pagina copertina 
Attivando la funzione viene stampata la pagina di copertina.

Logo
È possibile inserire il logo nella pagina di copertina del report.
Se nel menu File > Imposta logo è stato aggiunto uno o più loghi, è possibile selezionarne uno dalla
lista. Nel caso in cui non è stato aggiunto alcun logo, tramite il bottone Modifica si può aggiungere il
logo.

Intestazioni colonne
Le caselle poste in fondo alla finestra di dialogo del Bilancio Abbellito vengono utilizzate per inserire le
intestazioni dell'anno corrente e precedente nella stampa.
Le prime due caselle in verticale si riferiscono alle date del bilancio, le seconde a quelle del conto
economico.

Al momento, quando si apre la finestra di dialogo del Bilancio Abbellito non sono ben visibili le caselle
per inserire l'anno corrente e precedente.

Per visualizzare le caselle menzionate bisogna scorrere fino in fondo la barra di scorrimento verticale,
posta sul lato destro della finestra di dialogo.

Anno corrente
Inserire la data finale della contabilità corrente.

Anno precedente
Inserire la data finale della contabilità dell’anno precedente.

Quando si passa al nuovo anno dal menu Azioni > Crea nuovo anno, l'intestazione dell'anno
precedente non viene adattato in automatico, pertanto bisogna modificarlo manualmente. In futuro
questa problematica verrà risolta.

Dialogo non completamente visibile
Per visualizzare completamente la finestra di dialogo del Bilancio Abbellito, scegliere una delle due
procedure:

Ingrandire la finestra di dialogo
Far scorrere la barra di scorrimento, posta sul lato destro della finestra, verso il basso.
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Altre sezioni
Le spiegazioni delle altre sezioni sono disponibili alle seguenti pagine web:

Periodo
Stile
Testi
Margini
Personalizzazione

http://www.banana.ch/doc/it/node/2604
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Bilancio abbellito con gruppi

Banana contabilità calcola, visualizza e stampa il Bilancio e il Conto Economico in automatico. Si tratta
di documenti finanziari fondamentali, utilizzati dalle imprese per monitorare e rendicontare le proprie
attività finanziarie ed operative.

Il Bilancio e il conto economico possono essere personalizzati sia in base al periodo sia per le colonne
da visualizzare. Possono essere generati Bilanci per mese, trimestre, semestre e anno. Inoltre, quando
si sceglie un periodo (es. semestre)  i dati possono essere suddivisi anche per periodi (mese,
trimestre).

Il Bilancio Abbellito con gruppi, viene visualizzato il bilancio con i conti suddivisi in gruppi e
sottogruppi; inoltre ci sono tante funzionalità per personalizzare la presentazione che non sono
previste nel Bilancio Abbellito.

▶ Video: Bilancio abbellito con gruppi

Per stampare il Bilancio e il Conto economico nelle due modalità:

Dal menu Report → Bilancio abbellito
Dal menu Report → Bilancio abbellito con gruppi

Il Conto Economico

Il Conto Economico visualizza tutti i conti dei Costi e dei Ricavi, con l'indicazione dell'Utile o della
Perdita d'esercizio.

https://www.banana.ch/it/node/11490
http://www.banana.ch/doc/it/node/3313
http://www.banana.ch/doc/it/node/3314
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Il Bilancio abbellito per gruppi, rispetto al Bilancio abbellito, si differenzia per le seguenti
caratteristiche:

Visualizza dettagliatamente anche i sottogruppi.
Offre la possibilità di escludere dei gruppi o dei conti (per esempio visualizzare solo il totale del
gruppo e non i conti che compongono il totale).
Nella sezione Piano conti → Sezioni si possono selezionare i conti da includere o da escludere
nella stampa.
È possibile scegliere con quale suddivisione visualizzare un periodo (es. nel primo semestre
scegliere se ottenere una suddivisione per mese o per trimestre).
Possibilità di avere una suddivisione per segmenti.

Per calcolare, visualizzare e stampare il Bilancio abbellito per gruppi cliccare sul menu Report →
Bilancio Abbellito per gruppi: appare una finestra con diverse sezioni che permettono di impostare
i parametri della stampa.

 caratteristiche: 

Rendiconti con dati consuntivi, o preventivi oppure con entrambi i dati e con indicazione degli
scostamenti.
Disposizione libera con gruppi e sottogruppi.
Risultati aggiornati visibili direttamente nella tabella conti.
Stampe personalizzabili:
Guarda il video tutorial  che mostra come creare e stampare il bilancio abbellito con gruppi.

https://www.banana.ch/it/node/11490
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Aggiunta del proprio logo.
Scelta delle colonne da includere.
Scelta delle sezioni da includere.
Stampa dettagliata o raggruppata.
Stampe  per solo un periodo.
Colonne con suddivisione per periodo (mese, trimestre, semestre, anno).
Valori anno precedente.
Valore di previsione confronto.
Colonne con suddivisione per segmento.
Aggiunta note allegate.
Raggruppamento come nel piano dei conti o secondo un proprio schema.
Salvataggio della personalizzazione.

Report tabellare (simile alle stampe personalizzabili, ma con i dati presenti nella tabella).
Esportazione in pdf per la conservazione dei dati ed esportazione in altri formati per una
rielaborazione dati.

Vedi esempio di stampa

Domande frequenti
Se escludo i gruppi con saldo zero, rimangono comunque le righe dei titoli che fanno
riferimento al gruppi escluso; come posso toglierle?
Andare nelle Sezioni e mettere il visto Nascondi riga alle righe di titolo che si vogliono
escludere.
Vorrei escludere la visualizzazione della dicitura del periodo nei titoli ("1.Semestre
2013") delle stampe; come faccio?
Andare nella sezione Intestazione e togliere il visto dalla Stampa periodo
Nella pagina di copertina, quando si hanno dei titoli lunghi, vorrei poter scegliere di
suddividere i testi su due righe e inserire il grassetto. È possibile?
Non è possibile cambiare il tipo di carattere della pagina di titolo.
Certi importi non sono inclusi nel periodo indicato. Come mai?
Le registrazioni senza data sono conteggiate come registrazioni di apertura e non compaiono
nella stampa del conto economico. Inserire la data a tutte le registrazioni.
I gruppi di totale che contengono tutti i conti di classe 3 e 4 vengono rinominati con
il testo utile o perdita a dipendenza del risultato d'esercizio. Come posso cambiare
questo testo?
Andare nelle Sezioni e riscrivere il testo originale nella casella Testo alternativo della riga
interessata.
Se è attiva l'opzione Visualizza anno precedente, e nel file dell'anno precedente ci
sono dei gruppi che non ci sono nell'anno corrente, saranno segnalati degli errori. È
possibile rimediare?
Per stampare il bilancio con i dati dell'anno precedente e corrente i gruppi dell'anno precedente
devono esserci anche nell'anno corrente.
Come faccio a mettere dei fine pagina ?
Andare nelle Sezioni e nel gruppo selezionare inizia su nuova pagina.
Come posso visualizzare i dati dell'anno precedente se esso è più lungo dell'anno
standard?
Nella finestra di dialogo del Bilancio abbellito per gruppi, sotto la voce "Colonne", per la sezione
riguardante il Conto Economico cliccare sul pulsante "Avanzato", all'interno della finestra
"Colonne" cliccare su "Aggiungi". A questo punto nella finestra "Stampa Colonne" attivare
l'opzione "Prior". Chiudere quindi tutte le finestre premendo il tasto "ok". All'interno della



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 366

finestra "Colonne", cliccando sul tasto "proprietà" se necessario è possibile personalizzare
l'intestazione delle colonne.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 367

Intestazione

Nella sezione Pagina → Intestazioni ci sono le opzioni per intestare le pagine e il logo nella stampa
del Bilancio e del Conto economico.

Intestazione
Intestazione 1, Intestazione 2, Intestazione 3, Intestazione 4
Inserire i testi che si desiderano avere come intestazioni nelle stampe. Le intestazioni inserite
vengono riportate sulla prima pagina (pagina copertina) e su ogni foglio come intestazioni principali.

Logo
È possibile inserire il logo nell'intestazione di tutte le pagine del report.
Se nel menu File→Imposta logo è stato aggiunto uno o più loghi, è possibile selezionarne uno dalla
lista.
Nel caso in cui non è stato aggiunto alcun logo, tramite il bottone Modifica si può aggiungere il logo.

Stampa periodo e/o suddivisione
Questa funzione è attiva solo quando è stato inserito un periodo. Disattivando la funzione, il periodo
non viene indicato nei titoli delle stampe.

Piè di pagina
Stampa numeri di pagina
Attivando la funzione, nella stampa figurano i numeri di pagina.

Stampa data
Attivando la funzione viene stampata la data.

Copertina
Stampa pagina di copertina
Attivando la funzione viene stampata la pagina di copertina.

Logo:
È possibile inserire il logo nella pagina di copertina del report.
Se nel menu File→Imposta logo è stato aggiunto uno o più loghi, è possibile selezionarne uno
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dalla lista. Nel caso in cui non è stato aggiunto alcun logo, tramite il bottone Modifica si può
aggiungere il logo.
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Layout

Nella sezione Pagina → Layout si imposta la dimensione del carattere e l'orientamento della pagina
per la stampa del Bilancio e del Conto economico.

Dimensione carattere
In base al valore inserito varia la visualizzazione della stampa.

Orientamento pagina
Si seleziona l'orientamento della pagina: automatico, orizzontale e verticale.
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Logo

Dal menu File → Imposta Logo è possibile inserire un logo e definirne le impostazioni (larghezza,
altezza e allineamento). Possono essere create e salvate Personalizzazioni anche con diverse
impostazioni del logo.
Questa funzione è un'alternativa semplificata all'impostazione del logo tramite la Tabella
Documenti.

È possibile inserire il logo nell'intestazione di tutte le pagine del report.
Se nel menu File→Imposta logo è stato aggiunto uno o più loghi, è possibile selezionarne uno dalla
lista.
Nel caso in cui non è stato aggiunto alcun logo, tramite il bottone Modifica si può aggiungere il logo.
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Margini

Nella sezione Pagina → Margini si impostano i margini per la stampa del Bilancio e del Conto
economico.

Alto, Basso, Sinistro, Destro
È la distanza tra il bordo del foglio e il contenuto.

Intestazione
È la distanza tra l'intestazione e il contenuto.

Piè di pagina
È la distanza tra il piè di pagina e il contenuto.

Aumenta i margini all'area di stampa
Nel caso in cui la stampa superi i margini della pagina, attivando la funzione, il contenuto viene
stampato entro i margini.
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Sezioni

La sezione Sezione mostra come è strutturato e suddiviso il piano dei conti. 
La struttura è impostata usando la colonna Sezione nel piano dei Conti. 

Permette di impostare: 

Degli elementi da stampare assieme. 
Dei cambi pagina.
Degli elementi da escludere dalla stampa. 

Come nella tabella Conti
Nella visualizzazione e nella stampa del Bilancio abbellito per gruppi, l'impostazione è come nella
tabella Conti.

Cliccando sulla freccia a sinistra si vedono i componenti della sezione. Normalmente sono visualizzati
solo i gruppi con un saldo. Per vedere anche i gruppi con saldo a zero andare nella sezione Righe e
cliccare su visualizza gruppi con saldi a 0. 

A dipendenza della selezione ci possono essere differenti sezioni:

Sezione 1, 2, 3, 4, 01, 02, 03, 04... si riferiscono alle principali poste che compongono il Bilancio.
Sezione di conto, riferite al conto selezionato.
Sezione di gruppo, quelle che si riferiscono al gruppo selezionato.
 

Sezione*
Se si seleziona una sezione (contrassegnata da un asterisco), sono possibili le seguenti opzioni:

Nascondi sezione
Cliccare sulla sezione che non si desidera visualizzare.

Nascondi riga
Cliccare sulla riga che non si desidera visualizzare.
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Inizia su pagina nuova 
Cliccare sull'intestazione che si desidera avere su una nuova pagina e attivare la funzione.

Testo alternativo 
Inserire un testo alternativo, nel caso in cui se ne voglia uno diverso per la sezione o la riga
selezionata.

Se si seleziona una sezione di numero (1, 2, 3, 4.....) o un gruppo si presentano le opzioni
supplementari:

Gruppo per il calcolo percentuale (%) 
È visibile quando si seleziona una sezione (attivi, passivi, costi, ricavi....).
È il gruppo che serve da base per il calcolo della percentuale dei conti e gruppi della sezione. 

Determinato dal software.
Il gruppo è stabilito dal programma. Di regola è l'ultimo gruppo della sezione (totale attivi,
passivi, costi e ricavi).
Gruppo indicato dall'utente.
Per il Conto economico scalare, bisogna indicare un gruppo (per esempio il totale vendite).

È possibile indicare su quale gruppo deve basarsi il calcolo %.

Nascondi righe di livello inferiore
Se si seleziona un gruppo e si attiva questa funzione, le righe di livello inferiore di questo gruppo non
saranno visualizzate nel Bilancio.

Visualizza come conto
Se si seleziona un gruppo e si attiva questa funzione, il gruppo viene visualizzato come conto.
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Report contabile esterno
Stampare il Bilancio abbellito per gruppi, in base alla struttura di un File Report contabile.

File report contabile
L'opzione permette di richiamare il file del Report contabile esterno, tramite il bottone Sfoglia.

Colonna raggruppamento
Colonna nella quale i conti fanno riferimento ai gruppi definiti nel report contabile esterno. Colonne
disponibili: Gr1, Gr2, Somma in, BClasse e GrIva.
La scelta dell'opzione è attiva solo se non è stata utilizzata la colonna Conti (tabella Conti) nel file del
report contabile esterno.

Segnala manca raggruppamento
Controlla se tutti i conti appartengono ad un gruppo presente nel report contabile esterno.
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Righe

Nella sezione Piano conti → Righe si può scegliere di stampare i seguenti elementi: Conti, Conti
con saldo zero, Conti con movimento, Gruppi con saldo 0, Righe vuote.
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Impostazioni colonne della partita doppia

La sezione Piano conti > Colonne contiene le opzioni più importanti per la personalizzazione delle
colonne da visualizzare e stampare nel Bilancio e nel Conto economico e le Note.

Bilancio, Conto economico e Note

Se vengono attivate le varie opzioni, nella visualizzazione e nella stampa dei report verranno inclusi i
seguenti dati:

Numero di conto
Oltre alla descrizione del conto figurano anche i numeri di conto.

Corrente
Il saldo o movimento nella moneta base, riferito al periodo selezionato o alla suddivisione del periodo.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 377

Colonne (Avanzato)

Questo dialogo ti permette di vedere l'elenco delle diverse colonne come appaiono nel report e di
personalizzarne la visualizzazione, come le intestazioni e i colori del testo o dello sfondo.

È possibile modificare l'elenco delle colonne con i bottoni Aggiungi o Rimuovi:

Colonne tabella Conti
Elenco completo delle colonne presenti nella tabella Conti
Importi contabilità [A]
Elenco delle colonne calcolate per il periodo contabile corrente. (A=Actual)
Importi preventivo [B]
Elenco delle colonne calcolate sulla base delle registrazioni presenti nella tabella Budget.
(B=Budget)

Sono possibili le seguenti opzioni:

Nascondi/Visualizza colonna.
Con il visto puoi nascondere o rendere visibile una colonna che è indicata nell'elenco.
Cambia sequenza.
Usa i bottoni Sposta su e Sposta giù oppure trascina la colonna con il mouse.
Aggiungi una nuova colonna.
Puoi includere nel report delle altre colonne della tabella Conti oppure una delle colonne
calcolate dal report.
Rimuovere la colonna dall'elenco.
Con il bottone Elimina. Puoi sempre aggiungerla nuovamente.
Cambiare colori del testo e sfondo.
Cambiare le intestazioni della colonna e altre proprietà.
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Colonne aggiungi

Nelle stampe di  Bilancio, nel Conto economico e nelle Note si possono aggiungere ulteriori colonne.
Le opzioni sono disponibili dal menu Report → Bilancio abbellito per gruppi → Colonne → bottone
Avanzato →  Aggiungi.

Elenco colonne disponibili
Nel dialogo sono elencate tutte le colonne che si possono includere nel report:

Colonne presenti nella tabella Conti.
Colonne con importi Contabilità.
Colonne con importi di Preventivo.

Attivando la colonna dall'elenco, questa viene aggiunta al report. Nel dialogo Avanzato puoi cambiare
sequenza e intestazioni.

Togliendo il visto la colonna viene rimossa dal report.

Colonne presenti nella tabella Conti
Puoi includere qualsiasi colonna della tabella conti, per esempio:

Note.
Descrizione supplementare.
Descrizione in un'altra lingua.
Colonne importi o di altro genere aggiunte da te.

Importi contabilità
Sono le colonne con gli importi calcolati dal programma, dei saldi d'apertura e dei movimenti
immessi, per il periodo indicato o per il periodo della suddivisione.

Importo in divisa del conto
Visibile solo per i file multimoneta. Vengono visualizzati anche i saldi dei conti in moneta estera.
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Corrente
Vengono visualizzati i saldi dell'anno corrente.

Apertura
Vengono visualizzati i saldi di apertura.

Precedente (periodo)
Vengono visualizzati i saldi del periodo precedente (mese, trimestre, semestre.....).

Anno precedente
Vengono visualizzati i saldi dell'anno precedente.

YTD (Year To Date)
Questa colonna è solamente disponibile nel Conto Economico. Vengono visualizzati i saldi dall'inizio
dell'anno fino alla data dell'ultima registrazione.

Importi Preventivo
Sono le colonne con gli importi calcolati dal programma sulla base degli importi preventivi immessi
nella tabella Conti, o di quelli immessi nella tabella Preventivo. Se è stata creata la tabella
Preventivo e sono state inserite delle righe, per il calcolo vengono usati i dati della tabella
Preventivo, anche se sono stati immessi dei valori nella colonna Preventivo della tabella Conti. 
Vedi anche informazioni sul Preventivo.

Preventivo (Periodo corrente)
Vengono visualizzati gli importi relativi alle previsioni del periodo corrente.

Preventivo Precedente
Vengono visualizzati gli importi relativi alle previsioni del periodo precedente al corrente.

Preventivo anno precedente
Vengono visualizzati gli importi relativi alle previsioni per il periodo uguale al corrente, ma dell'anno
precedente.

 Annotazioni periodo di calcolo
Il programma non è in grado di calcolare i valori per periodi che si accavallano fra i diversi anni
contabili o per anni con date inizio e fine che non combaciano.
Per ottenere i saldi dell'anno precedente che superano un anno solare, attivare la colonna Prior.
Questa colonna sostituisce la colonna "Anno precedente", che mostra solo i saldi dell'anno precedente
dall'01.01.xx al 31.12.xx.
Si arriva a questa colonna dal menu Report → Bilancio abbellito per gruppi → Colonne → bottone
Avanzato → Aggiungi. Cliccando sull'intestazione Colonne tabella conti viene visualizzato l'elenco
di tutte le colonne definite nella tabella Conti. Attivare la colonna Prior.
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Intestazione e opzioni (Proprietà colonne)

In questa sezione ci sono le opzioni per cambiare le intestazioni delle colonne nei report.

Intestazioni

Riga 1/ Riga 2 / Riga 3
Si possono cambiare le intestazioni delle colonne, selezionando Testo e digitando nella casella la
nuova intestazione.
Se si seleziona Colonna, nell'intestazione apparirà il nome della colonna selezionata.

Opzioni

Visibile
Se si attiva la casella, l'intestazione della colonna viene visualizzata.

Visualizza come colonna totali
Se attivata, la funzione visualizza gli importi come la colonna totali.
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Colori | Proprietà colonne

Si accede alla finestra di dialogo dal menu Report → Bilancio abbellito per gruppi → Colonne →
bottone Avanzato  → Proprietà →  Colori. Ci sono le opzioni per cambiare i colori dei testi e delle
colonne.

Cambia
Tramite questo bottone è possibile cambiare il colore del testo e dello sfondo.

Colore predefinito
Tramite questo bottone si ripristina il colore predefinito per il testo e per lo sfondo.
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Suddivisione

Dalla sezione Piano Conti → Suddivisione si accede alle opzioni per scegliere la suddivisione del
periodo (anno, semestre, trimestre, mese).

Nessuno
Sono presentati in stampa solo i dati del periodo complessivo.

Suddivisione per periodo
Con la suddivisione per periodo, il programma crea delle colonne per i periodi indicati. Per ogni
periodo si vedranno le medesime colonne per il periodo complessivo. 

La funzione permette di visualizzare i dati del periodo per:

giorno
mese
bimestre
trimestre
quadrimestre
semestre
anno
5 anni
10 anni.

Nelle intestazioni delle colonne figura il periodo scelto.

Per non avere un numero eccessivo di colonne in stampa:

Limitare il numero di elementi che si vogliono  stampare. 
Indicare un Periodo più corto.
Indicare il numero massimo di periodi.
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Crea periodi per tutto l’anno
Quando il periodo contabile non coincide con l’anno solare, ma si desiderano visualizzare ugualmente
tutti i mesi, è sufficiente attivare questa funzione.

Colonna Totali
Questa funzione crea una colonna Totali dei periodi selezionati nel conto economico e nella vista
Totali.

Numero massimo di divisioni
Il numero massimo di periodi è per default 36. In casi particolari, se si volessero statistiche particolari
molto dettagliate e su lunghi periodi si può manualmente cambiare questo valore. Un numero
massimo di periodi molto alto può rallentare il programma.

 

Suddivisione per Segmento
I segmenti permettono di avere rendiconti per una certa sezione della ditta. I Segmenti sono definiti
nel piano dei conti. Con la suddivisione per periodo il programma crea delle colonne per i diversi
segmenti. Per ogni segmento si vedranno le medesime colonne per il periodo complessivo.

Ogni suddivisione prende il nome dell'intestazione data nel piano contabile. Vengono visualizzati i dati
della suddivisione (in base alla selezione).

L'opzione Suddivisione per Segmento è attiva solo se nella tabella conti sono stati impostati i
segmenti.

Si possono selezionare :

Tutti i segmenti - In questo modo quando si aggiungono dei nuovi segmenti saranno
automaticamente aggiunti alla stampa.
Vuoto - Viene visualizzato l'importo non attribuito ad alcun segmento.
Scelta dei segmenti - Indica solo i segmenti che vuoi vedere in stampa.
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Colonna Totali
Con la selezione della casella si hanno i totali del segmento selezionato.

Intestazione segmento
Si sceglie cosa deve apparire come intestazione della colonna nei segmenti.
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Periodo

Nella sezione Piano conti → Periodo si può limitare l'elaborazione dei dati, visualizzazione e stampa
solo ad un periodo indicato o, nel caso si tratti di un preventivo, permette di ottenere previsioni su più
anni.

Tutto

Sono inclusi tutti i movimenti della contabilità.

Periodo specificato

Si intende il periodo specificato, indicando la data di inizio e di fine.

Per ottenere previsioni su più anni, occorre inserire nelle Proprietà file, dati base (menu File), come
data di fine quella relativa all'anno futuro, fino a quando si desidera la previsione. Inserire la data
inizio e fine periodo anche nella sezione Periodo del Bilancio abbellito con gruppi.
Per avere delle previsioni oltre il periodo della contabilità, nella tabella Preventivo, i movimenti
devono avere un codice di ripetizione. 
La previsione sarà visualizzata nella colonna Preventivo.
 

Movimenti senza data

Se nella contabilità sono stati inseriti movimenti senza data, questi sono considerati solo se si
seleziona Tutto.
Se invece si inserisce p.es. dal 1.gennaio fino al 31 dicembre, i movimenti senza data non sono
visualizzati nel report.
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Stile

Questa sezione di dialogo include l'opzione per la scelta dei modelli e il formato numeri per la stampa
del Bilancio e Conto economico. Ogni modello si può personalizzare cambiando le proprietà dello stile
e i colori. Le colonne si possono ancora personalizzare nella sezione Colonne.

Usa Stile
A livello grafico sono predisposti diversi modelli di Bilancio abbellito con gruppi. Selezionandone uno,
si avrà il Bilancio abbellito del modello prescelto.

Proprietà stile
Per ogni stile è possibile definire il colore delle linee e degli sfondi.

Valore / Cambia... / Predefinito
Queste funzioni permettono di cambiare lo stile o ripristinare quello standard.

Ignora formattazione linee
Se la funzione è attiva, non viene mantenuta la formattazione.
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Formati numero

Nella sezione Stile si possono cambiare i formati dei numeri e il tipo di visualizzazione per i numeri
negativi.

Dividi per 1'000
Nel caso in cui vi siano delle cifre particolarmente grandi, attivando la funzione, vengono eliminati tre
zeri.

Visualizza centesimi
Attivando la funzione vengono visualizzati i centesimi.

Visualizza importi a zero
Attivando la funzione è possibile scegliere se visualizzare gli importi a zero con il numero 0,00 oppure
con il simboio -,-

Numeri negativi
I numeri negativi possono essere visualizzati con il segno meno davanti all'importo, dopo l'importo,
oppure con l'importo entro le parentesi tonde. Si può attivare l'opzione di avere i numeri negativi in
rosso.
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Testi

Dalla  sezione Stile → Testi si possono cambiare i testi delle intestazioni fisse che il programma usa
nelle stampe.

Per cambiare il valore basta fare un doppio clic sulla cella Valore corrispondente alla chiave da
modificare e inserire il nuovo testo.
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Allegati

Dalla sezione Stile → Allegati si possono aggiungere dei testi da stampati assieme al rendiconto.

I testi sono stampati dopo i dati di bilancio.
Ogni documento inizia su una nuova pagina.

Documenti
Sono elencati tutti i documenti presenti nella tabella Documenti del tipo Html o testo.

Puoi spostare la sequenza fra i diversi report, trascinando l'elemento con il mouse.
Vengono stampati solo i documenti con il visto.

Modifica

Visualizza un editor di testi che permette di inserire e modificare il testo.

Aggiunge

Aggiunge un documento HTML vuoto.
Per aggiungere documenti di testo semplice o markdown usare gli appositi comandi nella tabella
Documenti.

Se non vi è ancora la tabella Documenti il programma la aggiunge.

Elimina

Elimina l'elemento e il testo contenuto. È come eliminare una riga dalla tabella Documenti.
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Aggiungere un allegato con testo markdown
Aggiungere un nuovo documento con testo markdown come spiegato alla pagina Editore
Markdown
Vistare nell'elenco allegati il documento con testo markdown.

Note
La stampa di testo markdown è disponibile solo con l'abbonamento Advanced.
Questa funzionalità non è presente nelle versioni precedenti.
Se il file è aperto con una versione precedente del programma verrà segnalato che il file non è
completamente compatibile.
Se si modifica questa sezione e si dà l'OK, per annullare l'operazione, si deve dare più volte il
comando Annulla.
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Personalizzazione

Le Personalizzazioni ti permettono di creare e salvare impostazioni di stampa e di richiamarle
successivamente.

Si veda la pagina relativa alle Personalizzazioni.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 392

Rendiconti su più anni

Un rendiconto su più anni permette di comparare in modo semplice e immediato l'evoluzione della
propria attività. Banana Contabilità è in grado di visualizzare nello stesso rendiconto i saldi fino a due
anni precedenti.

Per poter visualizzare i saldi su più anni è necessario che nelle Proprietà file, dati base →
Opzioni → File anno precedente, sia indicato correttamente il percorso del file dell'anno precedente,
altrimenti Banana Contabilità non è in grado di recuperare i saldi dei periodi contabili precedenti che
risulterebbero quindi vuoti.

Nell'esempio che segue diamo le indicazioni per ottenere un rendiconto degli anni 2022, 2021 e 2020.
Ecco come procedere:
 

Menu Report → Rendiconto abbellito con gruppi...
Sezione Colonne, mettere il visto su Corrente e Anno precedente.
Bottone Avanzato (cliccare sul bottone sia per il Bilancio che per il Conto economico).

Dalla finestra che si apre cliccare sul bottone Aggiungi, per aggiungere una colonna.

Scorrere in basso la lista fino a vistare -2 Years (dobbiamo andare 2 anni indietro, rispetto
all'anno corrente).
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Confermare con OK per ottenere il rendiconto.
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Stampe in PDF di fine anno

  Archivio Pdf con tutti i dati della contabilità
Il file viene creato con un sommario che permette di accedere alle diverse stampe in modo semplice.

È previsto il salvataggio in PDF dei seguenti dati:

Bilancio e Conto economico.
Tabelle Conti, Registrazioni, Codici IVA, Totali.
Riassunti IVA.
Schede dei conti.

Se il file in PDF viene salvato su un CD non riscrivibile (da conservare assieme ai documenti contabili)
si soddisfano i requisiti di legge per l'archiviazione dei dati contabili.

Questo esempio è stato realizzato con le seguenti funzioni:

Menu File → Crea Dossier in Pdf.

Stampare una colonna supplementare
Per stampare nel Bilancio una colonna supplementare si usano le seguenti funzioni:

Aggiungere la nuova colonna nella tabella Conti, tramite il menu Dati → Disponi colonne
Bilancio abbellito con gruppi
Colonne - Avanzato, per attivare la visualizzazione della nuova colonna.

http://www.banana.ch/doc/it/node/2710
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Report contabile

Il comando Report contabile dal menu Report visualizza e stampa gli importi dei conti con un
determinato raggruppamento, per un periodo determinato o per suddivisione.
Le registrazioni senza data sono conteggiate come aperture e non compaiono nella stampa del
Conto economico.

Stampa del logo nel report contabile
Per ottenere dei report contabili con logo, dopo aver creato il report contabile, occorre:

Menu File → Anteprima di stampa → selezionare Impostazione di pagina
nella finestra di dialogo che si apre, alla voce Logo, indicare il logo (invece della voce nessuno).

Vedi anche la pagina su come inserire il Logo.

Base
Report
Si seleziona il raggruppamento desiderato:

Come nella tabella conti - si ottiene un Report con l'elencazione come nella tabella conti e
con le colonne Apertura e Saldo.
Conti per classe - si ottiene un Report con l'elencazione dei conti, ma senza sottogruppi.
Report contabile esterno  - il report viene visualizzato tramite un raggruppamento
predisposto in un file separato (creato dal Menu File → Nuovo → Gruppo Contabilità in Partita
Doppia - Report contabile).

Opzioni
Si scelgono quali conti includere o escludere dal Report:

Visualizza solo totali gruppi - vengono visualizzati solo i totali dei raggruppamenti.
Includi conti con movimento - vengono inclusi solo i conti che hanno un movimento.
Includi conti con saldo a 0 - vengono inclusi anche i conti che hanno il saldo a zero.
Escludi gruppi senza conti - vengono esclusi i gruppi che hanno unicamente dei conti con
saldo a zero.
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Altre Sezioni
Le spiegazioni delle altre sezioni sono disponibili alle seguenti pagine web:

Periodo
Suddivisione
Personalizzazione

Report risultato
Viene creata una nuova tabella dove sono visualizzati i risultati.
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Riassunto IVA (solo per file con opzioni IVA)

Le informazioni sul Riassunto IVA sono disponibili alla pagina Riassunto IVA.
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Tabella Preventivo

Nella Tabella Preventivo si inseriscono i movimenti della pianificazione finanziaria. È simile alla
tabella Registrazioni, ma ha delle colonne specifiche che aiutano a velocizzare e rendere più facile la
pianificazione .
Puoi anche modificare i dati come desideri, per avere delle previsioni affidabili e sempre
perfettamente aggiornate.

Per maggiori informazioni sulla tabella Preventivo, consultare le pagine:

Tabella Preventivo nella sezione pianificazione finanziaria .
Buget e pianificazione finanziaria.



http://www.banana.ch/doc/it/node/9344
http://www.banana.ch/doc/it/node/9344
http://www.banana.ch/doc/it/node/9313
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Chiusure | Contabilità in partita doppia

Per chiusure della contabilità si intendono tutte quelle operazioni di controllo, di assestamenti e di
delimitazioni temporali, eseguite alla fine dell'anno, prima di preparare il bilancio d'esercizio
definitivo.

Aspetti tecnici e nuovo anno
Con Banana Contabilità ogni anno contabile ha un proprio file separato, tecnicamente non c'è il
concetto di chiusura contabile:

Quando inizia un nuovo anno si crea un nuovo file con il comando Crea nuovo anno.
Si può continuare a lavorare contemporaneamente sia sul file dell'anno nuovo, sia su quello
dell'anno precedente. Una volta terminate le operazioni di chiusura, nel file del nuovo anno si
riprendono i saldi aggiornati, con il comando Aggiorna saldi iniziali.

Aspetti fiscali
Prima di chiudere la contabilità bisogna effettuare tutta una serie di operazioni che hanno implicazioni
fiscali. Bisogna assestare il conto merci, registrare gli ammortamenti, i ratei attivi e passivi, effettuare
le dichiarazioni dell'IVA, stabilire come e su quali conti deve essere ripartito l'utile ed effettuare tante
altre operazioni di verifica e controllo.

Dal punto di vista del programma, l'ammontare dell'utile è indifferente a fine anno, cambia invece
molto dal punto di vista fiscale. Questi aspetti devono essere verificati con il proprio fiscalista e
commercialista. La prima volta che gestisci una contabilità può essere utile, prima di procedere alle
chiusure, consultare un esperto per capire quali siano le esigenze. I commercialisti solitamente sono
molto impegnati tra la fine dell'anno e i mesi che precedono la scadenza del termine di presentazione
delle imposte; pertanto può essere utile trovarsi con il proprio commercialista o inviargli la contabilità
qualche mese prima della chiusura per sapere come procedere.

Comando controllo della contabilità
Banana Contabilità consente di registrare velocemente e anche di lasciare delle operazioni in sospeso
senza interrompere il proseguo del lavoro.

Il comando Azioni > Controlla contabilità esegue tutta una serie di verifiche, come se si inserissero
nuovamente i dati dall'inizio, e nel momento che vengono rilevati degli errori o delle differenze,
queste vengono segnalate.

Si consiglia di usare il comando Controlla contabilità con una certa regolarità e tutte le volte che ci
sono delle differenze o segnalazioni di errori, dei cambiamenti importanti (cambi iniziali, codici IVA) e
specialmente prima di chiudere la contabilità.

Controlli e verifiche
Verifica dei saldi di apertura

Nella tabella Conti, nelle colonne Apertura e Saldo, alla riga "Differenza deve essere zero "

https://www.banana.ch/doc/it/contamsg_it_tot_teid11des
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non ci deve essere alcun importo, altrimenti bisogna trovare l'errore e correggere per avere la
quadratura del bilancio iniziale.
Nota: nella vista Movimento, nelle colonne Dare e Avere, è normale che ci siano degli importi.
Assicurarsi che i transitori attivi e passivi dell'anno precedente risultino chiusi.
Verificare che i saldi di apertura siano conformi a quelli finali dell'anno precedente già
revisionati e dichiarati all'Ufficio di tassazione.
Per la contabilità multi-moneta si veda l'apposita pagina Saldi d'apertura contabilità multi-
moneta .

Verifica corrispondenza dei saldi contabili

La prima verifica è senza dubbio quella di accertarsi che il saldo contabile dei conti corrisponda alla
realtà. Il saldo del conto cassa deve corrispondere con quello dello stato della cassa effettivo. Il saldo
dei conti bancari, carte di credito, prestiti o averi deve corrispondere con quello dell'estratto conto. Lo
stesso vale per tutti gli altri conti con cui si hanno dei risconti, IVA, fornitori, ecc.

Se vi è una differenza bisogna scoprirne il motivo e completare o il saldo iniziale o le registrazioni.

Differenze nella tabella Registrazioni

Nella tabella Registrazioni (finestra Info in basso) verificare che non ci siano segnalate delle
differenze. Oltre alle funzioni presenti nel comando Controlla contabilità, Banana Contabilità Plus,
presenta nella tabella Registrazioni la colonna Saldo, che permette di rilevare tutte le righe dove si
vengono a creare delle differenze. Basta un rapido scorrimento della colonna per individuare subito le
differenze contabili e correggere, senza riportare errori nel nuovo anno.

Differenze tra saldi bancari degli estratti conto e saldi contabili (funzione CheckBalance)

Questo controllo è fondamentale per la veridicità della contabilità. Consigliamo di eseguire la verifica
dei saldi, #CheckBalance, oltre che alla fine dell'esercizio contabile, anche periodicamente a fine
mese, per evitare che eventuali saldi non corrispondenti vengano riportati sbagliati da mese in mese.
Le informazioni sulle Registrazioni di verifica dei saldi sono disponibili alla pagina Registrazioni saldi di
verifica.

Contabilità multi-moneta
Se si sta usando una contabilità in multi-moneta si devono anche impostare i cambi di chiusura e
registrare gli utili e le perdite di cambio non realizzate. Per questo si rimanda a:

Chiusure e controlli contabilità multi-moneta.

Registrazioni contabili di chiusura
A fine esercizio, prima di passare al nuovo anno, ci sono delle operazioni contabili di chiusura da
eseguire. Si tratta di registrazioni di assestamento, rettifiche di valore e conguagli relativi ai contributi
del personale. Qui di seguito ricordiamo le principali:

Importare i movimenti del conto cassa nel file della contabilità
Questa operazione è prevista solo nel caso in cui la cassa venga tenuta separatamente su un file
distinto dalla contabilità.
Dopo che l'importazione è avvenuta, verificare che il saldo del conto cassa nel file principale della
contabilità, sia corrispondente al saldo del file della cassa. Questa verifica si può effettuare anche con

http://www.banana.ch/doc/it/node/9858
http://www.banana.ch/doc/it/node/9858


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 401

la funzione Check Balance, descritta nel paragrafo precedente.

Importare i movimenti degli stipendi nel file della contabilità
Questa operazione è prevista solo nel caso in cui gli stipendi vengano gestiti con un gestionale
specifico che permette di importare i movimenti nel file di Banana Contabilità Plus.
L'importazione si esegue dal menu Azioni > Importa in contabilità > Importa movimenti con
intestazione colonne.
Ricordarsi di inserire la registrazione della quota tredicesima di dicembre, se questa non viene creata
dal gestionale stipendi.

Assestamento conto Delcredere
Le aziende che registrano sul fatturato, se prevedono delle perdite presunte, devono assestare il
conto Delcredere.

Ammortamenti
Al 31.12 bisogna rilevare il deprezzamento dei beni mobili e immobili e valutare eventuale
l'ammortamento accelerato per quei beni soggetti a una rapida obsolescenza.
Puoi utilizzare il nostro applicativo Registro beni ammortizzabili che crea in automatico le registrazioni
di ammortamento e puoi riprenderli nel file della contabilità.

Assestamento magazzino
L'applicativo Magazzino permette di avere dei conteggi precisi sia per pezzi sia per valore, aiutandoti
a determinare più velocemente l'assestamento del tuo magazzino.

Rilevare le fatture dei clienti e dei fornitori aperti al 31.12
Per facilitare la procedura, con la funzione delle fatture aperte per cliente e fatture aperte per
fornitore puoi rapidamente rilevare i valori al 31.12.

Consumo proprio
Se nell'azienda vi è l'uso di un'auto aziendale, registrare il consumo proprio con il codice IVA
appropriato.

Chiusure e dichiarazione IVA
Prima di inoltrare la dichiarazione IVA, consigliamo le seguenti verifiche:

Utilizzare il comando Controlla Contabilità. In caso di errori e differenze trovi i messaggi nella
finestra informativa in basso, nella sezione Messaggi.
Verificare che nella colonna Saldo della tabella Registrazioni che non ci siano differenze.
Controllare i saldi bancari se sono corrispondenti a quelli inviati dalla banca.
Verificare che il conto IVA in automatico dopo aver stornato il saldo nel conto IVA dovuta (IVA da
pagare all'AFC) sia a zero. Nel conto IVA dovuta deve risultare l'importo da versare o l'importo a
credito da ricevere.
Prima di inoltrare l'ultima dichiarazione IVA, visualizzare nuovamente i rendiconti IVA degli altri
trimestri per controllare che gli importi versati all'AFC siano ancora corrispondenti a quelli
visualizzati.
Utilizzare il comando del Riassunto IVA per visualizzare i vari report e creare una stampa in PDF
per l'archiviazione dei dati. In caso di controlli fiscali saranno utili.

Assestare il conto Imposte alla fonte
Dopo aver conteggiato e registrato gli stipendi di dicembre, in base al conteggio inviato all'Ufficio
imposte alla Fonte, registrare l'assestamento.
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Rimborsi per quadri superiori
Se previsti, nello stipendio di dicembre includere l'importo previsto dalle autorità fiscali come
rimborso forfettario.

Assestamento conto Privato
Verificare il saldo del conto privato. In caso di rapporti di debito/credito fra l’azienda e il/i proprietario/i
(o persone vicine) registrare gli interessi attivi o passivi secondo quanto previsto dal contratto di
prestito o secondo le direttive fiscali vigenti.

Assestamento conto Imposte e tasse
Verificare che gli acconti pagati durante l'anno si riferiscano all'anno in corso. I pagamenti di imposte
che concernono anni precedenti, bisogna registrarli a chiusura dei relativi accantonamenti che
risultano nel conto “Imposte dirette” (patrimoniale). Se il saldo degli accantonamenti non è sufficiente
o è eccessivo, la differenza deve essere registrata come costo/ricavo straordinario o relativo a periodi
precedenti.

Registrazione conguagli AVS/AD/IPG/AD

Durante l'anno, nel conto dei contributi AVS, solitamente vengono registrati gli acconti pagati
alla Cassa Cantonale di Compensazione AVS (in Dare) e le quote trattenute sugli stipendi ai
dipendenti (Avere).
Se durante l’anno gli assegni familiari pagati ai dipendenti sono stati registrati in un conto
dedicato, per esempio nel conto “Contributi assegni familiari”, per riconciliare la contabilità con
il conteggio di chiusura AVS e registrare il relativo assestamento si può girare il saldo di questo
conto sul conto Contributi AVS/AD.

Registrare i conguagli previdenziali Lainf, Lainf complementare, LPP
Con la registrazione degli ultimi stipendi di dicembre e il pagamento delle tredicesime, occorre
stampare la lista degli stipendi con l'indicazione di tutti gli stipendi lordi. Il lordo complessivo AVS devi
comunicarlo alle assicurazioni del personale, che determineranno eventuali conguagli da pagare.

Inviare il file al commercialista per le chiusure
Se le chiusure e/o le verifiche vengono eseguite dal tuo fiduciario, basta inviare il file della tua
contabilità creato con Banana Contabilità Plus per email oppure salvare i dati su una chiavetta USB.

Se il tuo fiduciario ha Banana Contabilità, basta trasmettere il file ac2 per email o tramite
chiavetta usb. Puoi anche salvare il tuo file e i documenti digitali in una cartella condivisa con il
tuo fiduciario su Dropbox. Non dovrai più portare dal fiduciario pesanti classeurs per la
documentazione cartacea. Inoltre, il fiduciario lavorerà velocemente senza dover andare a
cercare nella documentazione cartacea.
Se non possiede Banana Contabilità puoi creare un PDF dei dati contabili, tramite il menu File >
Crea dossier PDF e trasmettere per email la documentazione. Il fiduciario ti indicherà tutte le
modifiche e aggiunte da registrare per chiudere correttamente l'esercizio contabile.
In alternativa, il tuo fiduciario può aprire il file della tua contabilità usando il piano  Free di
Banana Contabilità Plus, scaricandolo dalla nostra pagina di Download . Se il tuo file ha più di
70 registrazioni non potrà aggiungere registrazioni o fare modifiche, ma potrà comunque
vedere tutti i dati, ottenere il dettaglio di ogni conto con un semplice click sopra il numero di
conto, ecc. e consigliarti su possibili correzioni o miglioramenti.

http://www.banana.ch/it/download
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Blocco delle registrazioni
Una volta eseguite le registrazioni di chiusura e di verifica, è consigliato di bloccare le registrazioni.

Azioni > Blocca registrazioni .
Le righe di registrazione saranno numerate e avranno un codice blockchain che ne garantisce la
sicurezza.

Stampe di fine anno
Per le stampe di fine esercizio contabile trovi le informazioni, cliccando sui seguenti link:

Schede conto
Libro giornale
Bilancio abbellito con gruppi

Guarda il video tutorial  che mostra come creare e stampare il bilancio abbellito con
gruppi.

Report contabile
Riassunto IVA
Stampe in PDF di fine anno

Dossier PDF
Il comando Creare dossier PDF ti permette di avere tutti i documenti dell'intero esercizio contabile
(schede conto, giornale, rendiconti IVA, report mensili, trimestrali e annuali...) in un unico file PDF.

Puoi archiviare i dati contabili, salvando il file della contabilità e le stampe in PDF. Eventualmente, fai
delle copie di sicurezza su un'unità di disco esterno.

Documentazione per la revisione
Alla pagina Preparare la documentazione per la revisione abbiamo pubblicato una serie di appunti e
suggerimenti sulla documentazione da inviare al revisore. La completezza della documentazione è
una buona base per rendere il lavoro del revisore più efficiente e veloce.

Ripartizione utile/perdita
In Banana Contabilità, la ripartizione dell'utile o della perdita, avviene in automatico al passaggio del
nuovo anno. Per maggiori informazioni consultare la pagina Aggiorna saldi iniziali.

http://www.banana.ch/doc/it/node/3353
https://www.banana.ch/it/node/11490
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Preparare la documentazione per la revisione

Prima di preparare la documentazione da inviare al revisore, vi consigliamo di consultare le
informazioni suggerite alla pagina Chiusure. Oltre alle informazioni inerenti all'uso delle funzioni del
programma, sono state indicate una serie di verifiche e controlli da eseguire prima della chiusura
dell'esercizio.

Le ditte soggette all'obbligo di revisione devono inviare al revisore una serie di documenti e file.
Di anno in anno ci si dimentica facilmente di quello che bisogna inviare al revisore. A questo proposito
suggeriamo di preparare una checklist, annotando tutti i documenti richiesti dal revisore negli anni
passati e le operazioni di chiusura e di rettifiche da eseguire.

Per facilitare questo compito, già durante l'anno, si possono prevedere alcune semplici operazioni che
facilitano il lavoro sia a chi tiene la contabilità, sia a chi deve fare la revisione. Consigliamo quanto
segue:

Creare una cartella per archiviare i documenti digitalizzati.
Salvare con nome tutti i documenti digitalizzati della contabilità dell'esercizio in corso.
Scansionare i giustificativi

Digitalizzare tutte le fatture, i giustificativi di cassa, i conteggi dei contributi AVS,
previdenziali e assicurativi.

I documenti digitali, come fatture e giustificativi, possono diventare parte integrante del file della
contabilità. Banana Contabilità permette di inserire il documento digitalizzato sulla riga della
registrazione contestuale. Il revisore cliccando sul link del documento digitale apre il documento e
può vederne i contenuti senza perdite di tempo per cercare le informazioni nel cartaceo.

Stampe in PDF da inviare al revisore
Qui di seguito ricordiamo una serie di documenti fondamentali da inviare al revisore.

Dichiarazioni per il personale dipendente

Dichiarazione dei salari AVS inviata al 31.12 e conguaglio di fine anno
Dichiarazione per assegni anticipati (già inclusa nella Dichiarazione Salari AVS)
Giornale salari dipendenti
Schede conto salari dipendenti
Certificati di  salario
Dichiarazione Lainf inviata al 31.12 e conguaglio di fine anno
Dichiarazione Lainf complementare inviata al 31.12 e conguaglio di fine anno
Dichiarazione Indennità malattia inviata al 31.12 e conguaglio di fine anno
Estratto conteggio LPP al 31.12
Dichiarazioni trimestrali Imposte alla fonte e conteggio di fine anno.

Estratti e conteggi bancari/postali

Estratti bancari e postali finali al 31.12
Conteggi bancari al 31.12 per eventuale imposta preventiva
Estratti conto dei prestiti al 31.12
Estratti degli investimenti al 31.12
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Copia formulario 103 inviato all'AFC per il pagamento dell'imposta preventiva

Dichiarazioni IVA

Conteggi IVA di ogni trimestre
Dichiarazioni IVA di ogni trimestre
Riconciliazione cifra d'affari con dichiarazioni IVA
Eventuali formulari di rettifiche IVA.

Documenti chiusure contabili

Elenco delle fatture aperte dei clienti al 31.12 
Elenco delle fatture aperte dei fornitori al 31.12
Valutazione del magazzino e assestamento al 31.12 
Dettagli ratei e risconti attivi/passivi
Dettagli immobilizzi e ammortamenti (tabelle, schede…..). Eventuale ammortamento
accelerato.
Calcolo imposte

Documenti ufficiali

Verbale Assemblea Ordinaria anno precedente
Verbali Assemblee straordinarie
Notifica di tassazione anno precedente
Copia dell’ordine di pagamento dell’imposta preventiva e del formulario 103 presentato all’AFC
per eventuali dividendi corrisposti
Conferma valori per polizza Assicurazione stabile
Documenti in caso di attivazione brevetti
Copie dei contratti di leasing e locazione
Copie dei nuovi contratti di prestito
Calcolo delle spese per altri accantonamenti a lungo e breve termine
Rapporto annuale dell'anno in esame
Appendice (con spiegazioni) del bilancio e conto economico

Esportazione dati
Le normative contabili prevedono che i dati della contabilità siano messe a disposizione dei revisori e
ispettori in formato digitale.
Banana Contabilità è conforme a queste normative perché:

Il revisore può usare il piano free di Banana Contabilità per aprire il file della contabilità.
Tutti i dati contabili sono facilmente visibili nella tabella.
I dati possono essere copiati e incollati direttamente in altri programmi.
È possibile esportare i dati in diversi formati direttamente dalla tabella.
Crea dossier pdf esporta tutti i dati della contabilità in un formato ideale per la lettura.

Estensioni per presentazione ed esportazione dati
Ci sono diverse estensioni per la presentazione l'esportazione dei dati in formati specifici.

Audit File Reports  crea dei report che possono essere utili al revisore e che possono essere
copiati e incollati in Excel.

https://www.banana.ch/apps/en/node/9510
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Standard Audit File - for taxation .
Esportazione dei dati in XML e altri formati secondo le direttive dell'OECD e per determinate
nazioni.
Ricercare nelle estension i se ci sono delle estensioni specifiche per la propria nazione.

Altre informazioni utili
Qui di seguito segnaliamo i link dove sono disponibili altre informazioni utili per una gestione ottimale
della contabilità e dei documenti:

Contabilità avanzata
Business Planning
Blockchain

Cartella giustificativi
Organizzare i file
Conservazione perpetua

https://www.banana.ch/en/audit-file-reader#countries
https://www.banana.ch/apps/it/extensions
https://www.banana.ch/it/node/11283
https://www.banana.ch/it/node/10970
https://www.banana.ch/it/node/11252
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Riconciliazione cifra d'affari con rendiconti
IVA

La riconciliazione della cifra d'affari con i rendiconti IVA è un processo contabile che permette di
verificare che i dati riportati nelle dichiarazioni IVA corrispondano alle registrazioni contabili
dell'impresa. 

Verifiche prima della Riconciliazione Cifra d'Affari e IVA
A fine anno, uno dei conteggi che il revisore richiede, è quello della riconciliazione annuale tra la cifra
d'affari dichiarata con i rendiconti IVA e la cifra d'affari risultante in contabilità.

Prima di verificare la Riconciliazione della Cifra d'affari con i Rendiconti IVA, è necessario procedere
alle seguenti verifiche:

Verificare l'IVA sulle Vendite e sugli Acquisti:
Con Banana contabilità puoi, anche a distanza di tempo, generare nuovamente il fac-simile del
Rendiconto IVA di un trimestre e confrontarlo con quello inviato. 

Puoi pertanto:

Calcolare l'IVA dovuta sulle vendite effettuate e confrontarla con l'importo riportato nella
dichiarazione IVA.
Calcolare l'IVA detraibile sugli acquisti e confrontarla con l'importo riportato nella dichiarazione
IVA.

In alternativa, è possibile creare il fac-simile del formulario IVA annuale, in modo da confrontarlo con i
totali degli importi dichiarati nei formulari IVA dei quattro trimestri. In caso ci fossero delle differenze,
è necessario individuare in quale trimestre si sono generate e procedere con le rettifiche. 
 

Riconciliare la cifra d'affari con la Dichiarazione IVA
Nel formulario IVA trasmesso all'AFC, ogni trimestre risulta la cifra d'affari, l'IVA dovuta, IVA
recuperabile e l'IVA da pagare del trimestre.

Pertanto, per determinare eventuali differenze tra l'ammontare della cifra d'affari annuale dichiarata e
quella presenta nella contabilità (tabella Conti), consigliamo di utilizzare un foglio di calcolo Excel,
dove riportare in colonne separate i dati seguenti:

Cifra d'affari di ogni trimestre risultante dalla contabilità. Per facilitare la determinazione della
cifra d'affari del trimestre, eseguire il Report contabile con suddivisione trimestrale, e verificare
il gruppo che totalizza i conti dei ricavi lordi).
IVA dovuta ricalcolata per ogni trimestre con la funzione del Riassunto IVA o con l'Estensione
IVA .
Inserire una colonna "Differenze cifra d'affari ", dove calcolare le differenze tra la cifra d'affari
dichiarata e quella contabile.
Inserire una colonna "Differenze IVA", dove calcolare la differenza tra l'importo IVA dichiarato e
quello ricalcolato. 

https://www.banana.ch/apps/it/node/9715
https://www.banana.ch/apps/it/node/9715
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Analizzare le Discrepanze:
Se nel confronto ci sono delle differenze, occorre:

Identificare e analizzare le cause che hanno determinato eventuali differenze nella cifra d'affari
e/o nella rendicontazione IVA.
Correggere eventuali errori e inviare all'AFC il formulario di rettifica.
Nel documento della riconciliazione IVA, per ogni differenza giustificare l'importo. Si rivela utile
in questo caso includere anche le registrazioni dove sono stati fatti degli errori o quelle che
hanno determinato le differenze (es. registrazioni senza codice IVA).

Qui di seguito indichiamo un esempio di uno schema molto semplice per determinare eventuali
differenze. Ognuno può gestire il foglio di calcolo come meglio crede.

Cause principali di differenze nella cifra d'affari

Come regola di Base, in Banana Contabilità tutte le registrazioni che hanno un codice IVA,
contribuiscono al calcolo IVA e alla determinazione degli importi nelle relative cifre del Rendiconto
IVA.  Nelle registrazioni ci possono essere varie cause che determinano delle discrepanze nel
confronto della cifra d'affari:

Se ad una registrazione con IVA, manca il codice IVA, il corrispondente importo IVA e
l'imponibile IVA non vengono presi in considerazione nel formulario fac-simile IVA. Nella
contabilità, invece, essendoci una registrazione di vendita registrata sul conto vendita, l'importo
determina cifra di affari.
Sono state aggiunte delle registrazioni con codice IVA dopo aver inoltrato i dati IVA all'AFC.
Sono state eliminate delle registrazioni con IVA, anche accidentalmente, dopo aver inoltrato i
dati IVA.
Sono state inserite delle registrazioni con data sbagliata, e sono andate a finire nel trimestre già
conteggiato.
Se ci sono degli storni e non è stato utilizzato il corrispondente codice IVA con il segno meno
davanti.
Sono stati inseriti dei codici IVA su assestamenti e operazioni di chiusura che normalmente non
devono avere il codice IVA
Su degli storni di vendita all'estero è stato inserito erroneamente il codice VE-0. In questo caso
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si verifica una discrepanza, dovuta al fatto che se la vendita viene stornata è registrata in Dare,
quindi va come una diminuzione della cifra d'affari, al contrario con il codice VE-0, l'importo
della vendita viene percepita dal programma come parte integrante della cifra d'affari, quindi
viene aggiunta.

Preparare un Rapporto di Riconciliazione
Documentare il processo di riconciliazione, indicando le differenze rilevate e le correzioni
apportate.
Redigere un rapporto dettagliato che evidenzi tutte le fasi del processo di riconciliazione e i
risultati ottenuti.

Strumenti Utili

Software Contabile: Banana Contabilità permette di creare nuovamente, anche a distanza di
tempo, i fac-simile formulari IVA, i riassunti IVA, il report dei conti su base annuale e con
suddivisione periodica. Questo facilita il confronto dei dati a distanza per trovare discrepanze o
errori nel calcolo dell'IVA e della cifra di affari.
Foglio di Calcolo: Creare un foglio di calcolo (es. Excel) dove è possibile copiare e incollare i
dati da Banana per tracciare e confrontare i dati delle vendite, degli acquisti e delle
dichiarazioni IVA.

Consigli

Controlli Periodici: effettuare controlli periodici della riconciliazione per evitare accumuli di
errori e discrepanze nel lungo periodo.
Precisione e Attenzione ai Dettagli: la riconciliazione richiede un'attenzione particolare ai
dettagli e una verifica accurata di tutti i dati.
Supporto di un Professionista: Considerare il coinvolgimento di un commercialista o di un
consulente fiscale per garantire la correttezza del processo.
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Aggiorna saldi iniziali | Contabilità doppia

Il comando Aggiorna saldi iniziali (menu Azioni) riprende i dati dal file dell'anno precedente e
aggiorna i saldi d'apertura di quello attuale. 

Quando usare il comando Aggiorna saldi iniziali
Il comando Aggiorna saldi iniziali si usa nei seguenti casi:

È stato creato il nuovo anno con il comando Crea nuovo anno, ma sono state fatte ancora delle
modifiche nell'anno precedente (aggiunte o modificate registrazioni, aggiunto conti..).
Si è deciso di cambiare la ripartizione dell'utile o la perdita d'esercizio.

Controllo della contabilità anno precedente
Per evitare che ci siano differenze fra i saldi di chiusura e quelli di apertura dell'anno successivo, è
importante, prima del comando, assicurarsi di aver effettuato tutti i controlli, le verifiche e tutte le
registrazioni contabili di chiusura come indicato nella pagina Chiusure.

 Dialogo Aggiorna saldi iniziali
Accedi a questa finestra dal menu Azioni > Aggiorna saldi iniziali
Devi inserire il percorso del file da dovere riprendere i saldi dell'anno precedente:

Il programma propone il nome del file salvato.
Se è cambiato il nome del file o il percorso, usa il comando Sfoglia.

 

Operazioni effettuate dal comando
Il comando riprende i dati dall'anno precedente, senza modificarne i contenuti. Questo comando può
quindi essere ripetuto senza alcun impatto sul file dell'anno precedente.

Il comando esegue le medesime operazioni indicate nel Crea nuovo anno, eccetto quelle riferite alla
creazione del file.

Se per errore sono stati riportati i saldi iniziali dei conti del Conto economico, per
correggere, segui le informazioni presenti nella pagina Differenze saldi iniziali  (punto 5 Soluzioni).

https://www.banana.ch/doc/it/contamsg_it_tot_teid11des?portal=banana


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 411

Modifica piano conti anno precedente
Se dopo avere creato il nuovo anno aggiungi dei conti nell'anno precedente e riprendi i saldi, il
programma segnala dei messaggi di errore. In questo caso, è necessario:

Inserire i nuovi conti anche nel file del nuovo anno.
Ripetere il comando Aggiorna i saldi iniziali.

Puoi allineare il piano dei conti usando il comando Importa Conti.

Modifica piano conti anno corrente
Se dopo avere creato il nuovo anno modifichi la numerazione dei conti, quando farai il comando
Aggiorna saldi d'apertura il programma segnala che non trova i conti. 
In questo caso, è necessario aggiornare il saldo dei conti manualmente:

Colonna Apertura (tabella Conti > vista Base)
Colonna Precedente (tabella Conti > vista Precedente)



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 412

Creare il nuovo anno | Contabilità in partita
doppia

Il comando Azioni > Aggiorna saldi iniziali prepara un file per l'anno nuovo sulla base del file della
contabilità che si sta per chiudere. Il comando non modifica il file attuale, quindi può essere eseguito
senza effetto alcuno.

Logica passaggio al nuovo anno
Con Banana Contabilità si ha un file separato per ogni anno. Quando inizia il nuovo anno la logica
operativa è la seguente:

Con il comando Azioni > Crea nuovo anno, il programma crea un nuovo file per l'anno,
usando lo stesso piano dei conti, le impostazioni e i saldi dell'anno corrente che si sta per
chiudere.

Una volta creato il file del nuovo anno salvarlo con il nuovo nome.
L'operazione di creazione del nuovo file può essere ripetuto se si decide di non salvare il
file.

Si  può lavorare contemporaneamente sui due file:
Su quello nuovo si andranno a inserire i movimenti del nuovo anno. Si potranno anche
apportare modifiche al piano dei conti, IVA o altro, senza influenzare quello precedente.
Su quello dell'anno precedente si continueranno a inserire le operazioni per completare
l'anno ed effettuare le operazioni tipiche delle chiusure, verifica dei saldi, stampa dei
bilanci ecc.

Nel file del nuovo anno, con il comando Azioni > Aggiorna saldi iniziali, si riprendono le
modifiche che sono state fatte nel file dell'anno precedente. Questa operazione è da fare al più
tardi quando non ci sono più modifiche nell'anno precedente.

Una volta creato il file del nuovo anno, chi ha abbonamento al Piano Professional di Banana
Contabilità Plus, vedrà apparire nella finestra info il messaggio Piano Advanced in modalità di
dimostrazione  fintanto che non raggiungerà le 70 righe di registrazioni.

Controllo e chiusura della contabilità anno precedente
Prima di aggiornare i saldi iniziali, per evitare che ci siano differenze fra i saldi di chiusura e quelli di
apertura dell'anno successivo, è importante assicurarsi di aver effettuato tutti i controlli, le verifiche e
tutte le registrazioni contabili di chiusura. Si rimanda alla pagina:

Controllo e chiusura contabilità in partita doppia .
Chiusura e cambi per la contabilità multi-moneta.
Informazioni specifiche per l'impostazione dei cambi di chiusura e la registrazione degli utili e
perdite di cambio non realizzate.

Operazioni effettuate dal comando crea nuovo anno
Il comando crea nuovo anno esegue in automatico le seguenti operazioni, tenendo conto dei
parametri impostati dall'utente:

http://www.banana.ch/doc/it/appmsg_it_info_license_extended_startupmode
http://www.banana.ch/doc/it/appmsg_it_info_license_extended_startupmode
http://www.banana.ch/doc/it/node/3307
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Crea un nuovo file (senza nome) con il piano dei conti e le impostazioni uguali a quello aperto,
senza registrazioni.
Copia i dati della colonna saldi del file attuale nella colonna Apertura del nuovo file (solo per le
classi indicate).
Somma l'utile o la perdita dell'anno precedente al saldo di apertura del conto o dei conti di
bilancio indicati per la ripartizione (solitamente si indica il conto Utili/Perdite riportati).
Copia per tutti i conti di Bilancio i dati della colonna Saldi del file attuale nella colonna Anno
precedente del nuovo file.
Aggiorna le proprietà del file:

Imposta la data di inizio e fine esercizio, aggiungendo 1 anno a quelle esistenti.
Nella sezione Opzioni imposta il nome del file dell'anno precedente e attiva l'opzione di
usare le registrazioni dell'anno precedente per l'autocompletamento.

Nella contabilità multi-moneta immette come cambi di apertura i cambi di chiusura dell'anno
precedente.
Se ci sono dei dati nella tabella Preventivo, riporta i movimenti nel nuovo anno tenendo conto
delle impostazioni.
Se è attivata l'opzione Segmenti, crea delle registrazioni di apertura per i segmenti.

 Dialogo Crea nuovo anno
 Il dialogo Crea nuovo anno permette di specificare i parametri per la creazione del file del nuovo
anno:

Riporta saldi di apertura dei conti
Vengono riportati i saldi di apertura degli elementi attivati:

Bilancio
Riporta i saldi dei conti attivi, passivi e capitale proprio. Questa opzione deve essere generalmente
attivata.

Conto economico (sconsigliato)
I saldi dei conti costi e ricavi NON devono essere riportati nell'anno nuovo.
Attivare questa opzione solo in casi particolari e solo se si è certi di quello che implica.

Fuori bilancio
Riporta i conti con la BClasse (5 e 6).
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Centri di costo
Sono da attivare solo nel caso in cui i centri di costo servono per gestire delle posizioni che devono
continuare nel tempo, come per esempio clienti, fornitori e soci.

Centri di costo CC1
Quelli che iniziano con il punto ".".

Centri di costo CC2
Quelli che iniziano con la virgola ",".

Centri di costo CC3
Quelli che iniziano con il punto e virgola ";".
Per maggiori informazioni consultare la pagina Centri costo/profitto.

Segmenti
I saldi di apertura dei Segmenti  vengono creati con delle registrazioni di apertura nelle tabella
Registrazioni.

Per maggiori informazioni vedi la pagina Segmenti.
Il programma crea una registrazione per ogni abbinamento conto e segmento, riprendendo
esattamente la situazione finale dell'anno precedente.
È preferibile non inserire dei saldi d'apertura dei segmenti usando la colonna Apertura. Se
nell'anno precedente si è fatto questo, il programma riporterà nuovamente il saldo nella
colonna Apertura del nuovo anno.

Nota: per le operazioni di assestamento come per esempio la rilevazione e la chiusura dei conti
transitori, queste devono essere registrate manualmente.

 Ripartizione utile/perdita
Al momento del riporto dei saldi iniziali nel nuovo anno, ai conti di riporto dell'utile vengono sommate
gli importi indicati. 

Totale da ripartire
Il programma indica automaticamente l'importo dell'utile o della perdita da ripartire.

Conti
Selezionare il conto o i conti (fino a tre) in cui deve essere ripartito il risultato d'esercizio. Nel caso in
cui ci fossero più conti per la destinazione del risultato di esercizio, occorre inserire l'importo
manualmente nelle apposite caselle.

Se viene indicato un solo conto, l'importo verrà automaticamente inserito nel conto selezionato dalla
lista.
Il programma aggiorna automaticamente i saldi iniziali.  Il totale attivi corrisponde esattamente al
totale passivi.

Ripartizione del risultato d'esercizio su un numero di conti maggiore di tre
In questo caso ripartire in automatico il risultato d'esercizio solo sul conto Utili e perdite riportati e
andare avanti con la creazione del nuovo anno.
Nel nuovo anno (nuovo file), nella tabella Registrazioni, eseguire una registrazione multipla per
stornare il risultato d'esercizio dal conto Utili e perdite riportati ai conti desiderati.
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Posticipare la ripartizione l'utile o la perdita d'esercizio

Nel caso non si voglia ancora ripartire il risultato d'esercizio, si può passare comunque alla creazione
del nuovo anno, cliccando sul bottone OK. In seguito si può procedere a ripartire il risultato d'esercizio
dal menu Azioni > Aggiorna saldi iniziali. Il programma visualizza la stessa finestra che appare con il
comando Crea nuovo anno.

Salvare il nuovo file 
Il programma crea un nuovo file di contabilità per il nuovo anno:

Conferma i Dati base del nuovo anno. Il programma riprende le intestazioni dell'anno
precedente e inserisce in automatico la data iniziale e finale del nuovo anno.
Clicca sul menu File > Salva con nome, indicando la cartella dove intendi memorizzare il
nuovo file contabile. Si consiglia di inserire come nome il nome della ditta e l'anno.
Vedere anche Organizzare i file della contabilità.

Se ci sono differenze o altri messaggi di errore, si può anche non salvare il file creato e ripetere
l'operazione di creazione del file del nuovo anno successivamente.

Messaggio Piano Professional con funzioni Advanced fino a
70 righe
Il messaggio che appare nel Piano Professional in uso, Piano attivo: Piano Professional. Le
funzioni del piano Advanced sono disponibili fino a 70 righe, conferma unicamente che le
funzioni del piano Advanced sono anche attive e si ha la possibilità di beneficiare gratuitamente delle
stesse, fino a 70 righe di registrazione, senza interferire in alcun modo con l'utilizzo del piano
Professional, dove si può continuare a registrare senza alcun limite. Questo messaggio scompare in
automatico quando si superano le 70 righe.

Aggiornare i saldi iniziali
Dopo aver salvato il file per il nuovo anno ed effettuate le modifiche nell'anno precedente, clicca sul
menu Azioni> Aggiorna saldi iniziali , per riprendere i saldi iniziali e ripartire nuovamente l'utile.

Questa operazione può essere ripetuta più volte ed è possibile eseguirla in tutta sicurezza, infatti
l'integrità dei dati durante il passaggio al nuovo anno è garantita e non vi è alcuna perdita di dati.

Se con l'anno nuovo si vuole passare a una contabilità di altro tipo (con multi-moneta o con IVA)
procedere con la creazione del nuovo file e poi usare il comando Strumenti > Converti in nuovo file .

Se si vuole invece creare una copia del file, senza riportare i saldi, usare il comando Strumenti > Crea
copia file .

Modificare i saldi riportati a nuovo
Una volta che i saldi sono stati riportati nel nuovo anno (nuovo file), se ci fosse la necessità di
modificare i saldi di apertura, questi possono essere modificati manualmente, cambiando gli importi
nelle seguenti colonne:

Apertura della tabella Conti.

http://www.banana.ch/doc10/it/node/9735
http://www.banana.ch/doc/it/node/2723
http://www.banana.ch/doc/it/node/9661
http://www.banana.ch/doc/it/node/9661
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Precedente, per i saldi relativi all'anno precedente. 
Nella tabella Registrazioni per i Segmenti.

Se hai effettuato modifiche nel file dell'anno precedente, clicca sul menu Azioni >Aggiorna saldi
iniziali , per riprendere e aggiornare nuovamente i saldi di apertura.

http://www.banana.ch/doc10/it/node/9735
http://www.banana.ch/doc10/it/node/9735
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Come riclassificare il bilancio e il conto
economico

La riclassificazione del bilancio e del conto economico in Banana Contabilità Plus avviene tramite i
Report contabili esterni.

Il Report contabile esterno è un tipo di file all'interno del quale si imposta una specifica presentazione,
indicando le modalità di raggruppamento dei conti, diversa da quella del piano contabile.
Lo schema di raggruppamento creato viene abbinato alla contabilità per estrarre e totalizzare i conti
scelti per la riclassificazione del bilancio e del conto economico secondo la nuova presentazione.

Il report contabile esterno, oltre ad essere utilizzato per una riclassificazione del bilancio e del conto
economico o di altri report, può essere utilizzato anche per passare a un piano contabile diverso e
trasferire i relativi saldi. Maggiori dettagli sono disponibili alla pagina Cambia piano contabile.

La riclassificazione del bilancio e del conto economico tramite il Report contabile esterno è
unicamente disponibile con il piano Advanced di Banana Contabilità+ .

Riclassificazione del bilancio e del conto economico
Ci sono due possibili modalità di riclassificazione:

Riclassificazione in base ai gruppi indicati
Questa modalità è utile quando si vogliono raggruppare i conti con criteri diversi, per esempio,
presentare il bilancio e il Conto economico secondo uno schema di raggruppamento diverso da
quello indicato nella tabella Conti.

Nel Report si crea lo schema di raggruppamento.
Per ogni conto della tabella Conti della contabilità, nella colonna GR1 (o altra colonna), si
indica il gruppo nel quale il conto deve essere raggruppato.
Quando si esegue il Report sono ripresi nel report tutti i conti contrassegnati con dei
gruppi presenti nel file report.

Riclassificazione in base ai conti indicati
Questa modalità è utile quando non si vogliono i report di tutti i conti, ma solo quelli di alcuni
conti selezionati.

Nel Report si indicano i conti della tabella Conti del file della contabilità che si desiderano
includere.
Quando si esegue il Report, vengono ripresi i conti indicati.

 Crea un file Report contabile
Per creare un file di Report contabile:

Menu File > Report contabile
Si può scegliere fra uno schema esistente o partire da uno nuovo
Una volta creato salvare il file con un proprio nome.

https://www.banana.ch/it/buy
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Le colonne del Report contabile
Il file Report contabile include le medesime colonne che si trovano nel piano dei conti del file della
contabilità e servono per creare i Raggruppamenti e i Totali.

Sezione
Questa colonna viene utilizzata per indicare il valore da utilizzare nella presentazione.
Per le diverse possibilità si veda la Documentazione relativa alle sezioni.

Gruppo
Viene indicato il gruppo dove totalizzare i conti della contabilità o un gruppo del report.

Conto (visibile solo nella vista Completo)
Il conto che deve essere incluso nel report.

Se vi sono dei conti, al momento dell'esecuzione verranno ripresi solo i conti indicati.
Se non è indicato alcun conto, verranno ripresi i conti collegati tramite il gruppo.
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Descrizione
Descrizione del raggruppamento o della riga stessa.

Somma In
Nella colonna Somma In viene indicato in quale totale la riga deve essere totalizzata.

Tot
Se si imposta "Sì", viene visualizzata solo la riga di totale e non i conti che ne fanno parte.
Vedi Visualizza solo totali gruppi nel Report contabile.

Tieni
Normalmente, nel report sono incluse le righe di totale che hanno dei conti con dei saldi.
Se si imposta Sì, in questa colonna la riga viene comunque sempre visualizzata. Può essere applicata
sia per i totali sia per i conti.

Con.Mov.
Si applica ai gruppi che hanno un saldo a zero.
La riga viene visualizzata se durante il periodo vi sono stati dei movimenti.

Crea un Report collegato tramite il gruppo
Nel Report si crea un sistema di gruppi e sottogruppi, come si desidera.
Nella tabella Conti si indica, nella colonna Gr1 o Gr2, il gruppo nel quale il conto deve essere
totalizzato.
Se la colonna colonna Gr1, (o quella preferita) non si vede, renderla visibile con il comando
Disponi colonne.
I conti che non hanno alcun abbinamento non saranno inclusi nel Report.
Eseguire il report tramite i comandi:

Bilancio abbellito con gruppi (menu Report)
Sezione Piano dei Conti > Report contabile esterno

 Crea un Report che riclassifica solo certi conti della
contabilità
Questa modalità si attiva se nel report è indicato anche un solo conto.
Non inserire alcun conto se si vuole che il report venga eseguito nella modalità gruppo. 
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Nel file report si indicano:

I conti della contabilità che si desiderano raggruppare.
Solo i conti indicati saranno inclusi nel report.
I gruppi in cui si vuole raggruppare i conti.

Il Report contabile si può eseguire tramite i comandi:

Menu Report > Bilancio abbellito con gruppi
Selezionare nella sezione Piano conti > Sezioni > Report contabile esterno.

Menu Report, scegliere la sezione Base e l'opzione Report contabile esterno.
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La Contabilità multi-moneta

La Contabilità in partita doppia multi-moneta è un applicativo di Banana Contabilità Plus, per gestire
conti in qualsiasi moneta estera. 

È ideale per: per chi lavora all'estero, o con l'estero e chiunque abbia operazioni finanziarie che
coinvolgono più valute e desideri gestire in modo efficiente la contabilità in diverse valute; piccole e
medie imprese con fornitori o clienti internazionali, aziende di import ed export, società di servizi
finanziari, investitori, viaggiatori e turisti per tenere traccia delle loro spese durante i viaggi.

Maggiori informazioni sono disponibili alle pagine seguenti:

▶ Video: Come iniziare una contabilità multi-moneta
Multi-moneta
Caratteristiche
Come iniziare

Stesso Applicativo della contabilità in partita doppia, ma con la possibilità di gestire nello stesso file
anche più conti in diverse monete.

Maggiore operatività con la Contabilità Multi-moneta: Gestione di più conti in valuta estera in
un unico file; non servono file supplementari per registrare conti in moneta estera. Nel piano contabile
contabile puoi impostare liberamente conti in moneta base e conti in moneta estera. 

Flessibilità nei cambi: Nella tabella Cambi imposti i cambi liberamente, sia cambi fissi che variabili,
cambi diversi per una stessa moneta. Possibilità di avere uno storico cambi. Puoi cambiare il cambio
anche direttamente nella tabella Registrazioni, nella colonna destinata al cambio.

Calcoli e differenze di cambio automatici: Nelle registrazioni con monete estere, i controvalori in
moneta base sono calcolati in automatico. Un semplice comando calcola e registra automaticamente
le differenze di cambio. 

Rendiconti completi anche in una seconda moneta: Vengono generati in automatico il Bilancio,
il Conto economico, il Giornale e le Schede conto, con l'indicazione dei valori nella moneta estera e
nella moneta base.

https://www.banana.ch/it/node/11353
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Potente e immediato nei calcoli

Basato sulla Contabilità in partita doppia
Gestione di conti in qualsiasi moneta estera
Calcoli e differenze di cambio automatizzate
Schede conto con valori in moneta base e moneta estera, Giornale, Report
Bilanci anche in una seconda moneta
Previsioni finanziarie multimoneta.

La documentazione della contabilità multimoneta
La contabilità multimoneta si basa sulla contabilità in partita doppia, ma con l'aggiunta della gestione
multimoneta. Pertanto, per tematiche mancanti o per approfondimenti nella documentazione
multimoneta, si consiglia di consultare le pagine della Contabilità in partita doppia.

Elementi fondamentali della contabilità multimoneta
Piano dei conti, proprietà file e tabella Cambi
In Banana Contabilità Plus tutti i modelli di contabilità in partita doppia multimoneta hanno i conti per
gli utili e le perdite di cambio già impostati nel piano contabile e anche nelle Proprietà file. Si consiglia
di scegliere un modello di contabilità in partita doppia multimoneta (con o senza IVA) già impostato e
modificare il piano contabile secondo le proprie necessità, aggiungendo o modificando i conti in valuta
estera e impostando la tabella cambi con le sigle delle monete estere, in base ai conti in moneta
estera presenti nel piano dei conti.

Per maggiori approfondimenti consigliamo di consultare le pagine seguenti:

Impostare il piano dei conti
Gruppi e sottogruppi
Proprietà file - sezione moneta estera
Impostare la Tabella Cambi

Registrazioni
Le operazioni contabili devono essere eseguite come le registrazioni della contabilità in partita doppia

Vari tipi di registrazione
Differenze di cambio

Stampe

Schede conto
Giornale
Bilancio abbellito
Bilancio abbellito con gruppi
Report contabili

Convertire la contabilità doppia in una multi-moneta
Se durante l'anno hai bisogno di convertire la tua contabilità in partita doppia in una multi-moneta,
non c'è problema. Consulta la pagina Converti in nuovo file per aggiungere le funzionalità
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multimoneta alla contabilità in partita doppia.

Approfondimenti
Organizzare i documenti contabili
Come iniziare una contabilità multi-moneta
Lavora con diverse lingue
Gestione IVA

https://www.banana.ch/doc10/it/node/9650
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Come iniziare una contabilità multi-moneta

▶ Video: Come iniziare una contabilità multimoneta . Scopri come creare una nuova contabilità
multi-moneta in partita doppia, adattare il piano dei conti, impostare un budget, inserire le
registrazioni e stampare il rendiconto.

Creare una contabilità partendo da un modello
Banana Contabilità Plus include modelli per tutte le forme giuridiche, suddivisi per nazione e per
categoria. Possono essere aperti direttamente dal programma, dal menu File, comando Nuovo,
oppure possono essere scaricati dal nostro sito internet dalla pagina Modelli .

Qui di seguito viene spiegata la procedura d'inizio partendo da un modello direttamente dal
programma:

Menu File → Nuovo.1.
Selezionare la Regione, la categoria e il tipo di contabilità multimoneta (con o senza IVA).2.
Dalla lista dei modelli che appare, scegliere il modello che più si avvicina alle proprie esigenze.3.
Cliccare sul bottone Crea.4.

Si può cercare il modello inserendo una parola chiave nella casella Cerca; il programma visualizza i
modelli contenenti la parola chiave immessa.

È anche possibile iniziare da un file vuoto, attivando l'opzione Crea file vuoto. Per facilitare l'inizio ed
evitare errori di raggruppamenti, consigliamo di iniziare sempre da un modello esistente.

Maggiori informazioni per creare un nuovo file sono disponibili alla pagina Crea nuovo file.

Impostare le proprietà del file (dati base)
Dal menu File → Proprietà file (Dati base)  impostare nelle varie sezioni dati richiesti.

https://www.banana.ch/it/node/11353
https://www.banana.ch/apps/it
http://www.banana.ch/doc/it/node/1567
http://www.banana.ch/doc/it/node/1567
http://www.banana.ch/doc/it/node/1567
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Sezione Contabilità

Indica il nome della ditta che apparirà sulle intestazioni delle stampe e su altri dati.
Inserisci la sigla moneta per la contabilità.
Sceglila dalla lista oppure inseriscila digitandola manualmente.

Salvare il file su disco
Con il comando File → Salva con nome , salva i dati assegnando un nome al file. Appare il dialogo di
salvataggio tipico del tuo sistema operativo.

Consigliamo di usare il nome della ditta seguita dall'anno "ditta-20xx.ac2" per distinguerlo da
altri file di contabilità.
Puoi tenere quante contabilità ti servono, ciascuna avrà quindi il proprio nome.
Puoi scegliere il percorso e il supporto (salvare su disco, chiavetta o cloud).
Se prevedi di avere anche dei documenti collegati alla contabilità dell'anno in corso, si
suggerisce di creare una cartella separata per ogni anno contabile dover raggruppare tutti i file.
Consulta anche la pagina organizzare i file .

Uso del programma in generale
Banana Contabilità Plus si ispira a Excel. Il modo d'uso e i comandi sono mantenuti il più possibile
simili a quelli di Microsoft Office.
Per capire come muoverti nel programma ti consigliamo di visitare la pagina dell'interfaccia del
programma.
La contabilità viene tenuta all'interno di tabelle.

La tabella Cambi
Nella tabella Cambi si impostano le sigle delle monete e i cambi che verranno usati nella tabelle
Conti e Registrazioni.

http://www.banana.ch/doc/it/node/3909
https://www.banana.ch/it/node/11059
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Personalizzare il piano dei conti
Nella tabella Conti personalizza il piano contabile secondo le tue esigenze:

Aggiungi ed elimina dei conti esistenti (vedi aggiungere un nuova riga)
Cambia i numeri di conto, la descrizione (es. inserisci il nome del ccb della tua Banca), inserisci
altri gruppi, ecc.
Per creare dei sottogruppi consulta la pagina sui Gruppi.

La tabella Registrazioni
Le registrazioni in multimoneta devono essere inserite nella tabella Registrazioni e costituiscono il
Libro Giornale.
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Velocizzare l'inserimento delle Registrazioni
Per velocizzare l'inserimento delle registrazioni si utilizzano le seguenti funzioni:

Immissione dati con autocompletamento - consente la ripresa in automatico dei dati già inseriti
in precedenza.
Registrazioni ricorrenti - permette di memorizzare in un'apposita tabella le registrazioni
ripetitive
Importazione dati dall'estratto bancario o postale - per importare in automatico i movimenti
dall'estratto bancario, postale o carta di credito.

Rendi visibile la colonna Saldo nella tabella Registrazioni
La nuova colonna Saldo è una funzione utilissima: ti permette di vedere all'istante eventuali
differenze.
Per usare la colonna Saldo la devi rendere visibile tramite il menu Dati → Disponi colonne.

Guarda il Video: Colonna Saldo per rilevare le differenze contabili
Maggiori informazioni sulla colonna Saldo

Controllo fatture clienti e fornitori
Banana Contabilità Plus permette di tenere sotto controllo le fatture da pagare e quelle emesse da
incassare. Consulta al riguardo:

Sottomenu Clienti
Sottomenu Fornitori

Le Schede conto
La scheda conto riporta tutti i movimenti registrati sullo stesso conto (Es. cassa, banca, clienti, ecc...).

Per visualizzare la scheda di un conto, basta posizionarsi con il mouse sul numero di conto e cliccare
sul piccolo simbolo blu che appare.

Schede conto per periodo

Per visualizzare le schede conto con i saldi riferiti ad un determinato periodo, vai su:

Menu Report → Schede conto → sezione Periodo → Specificato
Inserisci la data di inizio e di fine periodo.

https://www.banana.ch/it/node/11369
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Per maggiori informazioni consulta la pagina Periodo.

Stampare le schede conto

Per stampare una scheda conto, basta visualizzare la scheda da qualsiasi tabella (Conti o
Registrazioni) e lanciare la stampa dal menu File.

Per stampare diverse o tutte le schede conto, clicca sul menu Report → Schede conto e seleziona le
schede conto da stampare. Tramite il filtro presente nella finestra, si può eseguire una selezione in
automatico di tutti i conti, i centri di costo, i segmenti, i gruppi, ecc..

Maggiori informazioni sono disponibili alla pagina Scheda conto.

Il Bilancio e il Conto Economico
Il Bilancio visualizza i saldi di tutti i conti patrimoniali, Attivi e Passivi. La differenza tra Attivi e
Passivi determina il Capitale proprio.

La visualizzazione e la stampa del Bilancio si esegue dal menu Report → Bilancio Abbellito o
Bilancio Abbellito per gruppi.

Il comando Bilancio Abbellito elenca semplicemente tutti i conti senza distinzione dei Gruppi
e Sottogruppi.
Il comando Bilancio Abbellito con gruppi elenca i conti con la suddivisione dei gruppi e
sottogruppi; inoltre presenta tante funzionalità per personalizzare la presentazione che non
sono previste nel Bilancio Abbellito.

Archiviazione dati in PDF
A fine anno, quando tutta la contabilità è stata completata, corretta e revisionata, si possono
archiviare tutti i dati contabili con il comando Crea dossier in PDF.

http://www.banana.ch/doc/it/node/3314
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Il Preventivo
Prima di iniziare un anno contabile, si possono preventivare le spese e ipotizzare le entrate, in modo
da avere sotto controllo la situazione economica e finanziaria della propria ditta.

Il preventivo può essere impostato in due modi differenti:

Nella tabella Conti, colonna Preventivo. Per ogni conto viene indicato l'importo di preventivo1.
annuale.
In questo caso, quando si elabora il Preventivo dal menu Report > Bilancio abbellito per gruppi

, la colonna Preventivo riporta gli importi che si riferiscono all'intero anno.
 Nella tabella Preventivo, che si attiva dal menu Strumenti > Aggiungi nuove funzionalità.2.
In questa tabella si registrano tutti i preventivi di spesa e di entrata con delle registrazioni. Nel
caso che si attivi questa tabella, la colonna Preventivo della tabella Conti viene disattivata
automaticamente.
In questo caso si può impostare un preventivo dettagliato che tenga conto delle possibili
variazioni durante l'anno e nei diversi periodi dell'anno.

Maggiori informazioni sono disponibili nella pagina Preventivo.

http://www.banana.ch/doc/it/node/3314
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Caratteristiche della Contabilità multimoneta

Con Banana Contabilità multi-moneta lavori facilmente a livello internazionale nella lingua che vuoi e
con i conti in valuta estera di cui hai bisogno. La struttura è sempre a tabelle, simile a Excel e con
tutte le facilitazioni degli altri applicativi Banana. Il funzionamento si basa sulla metodologia della
Contabilità in partita doppia. Nel caso hai bisogno della gestione IVA puoi sempre attivare le
funzionalità dell'IVA.

Si rivela particolarmente interessante per coloro che hanno delle attività con l'estero, per le
associazioni che in genere operano in tutto il mondo o hanno dei progetti o semplicemente per coloro
che nella propria contabilità hanno dei conti in moneta estera.

▶ Video: Come iniziare una contabilità multimoneta

Tante funzioni per la Multi-moneta
Gestisci quanti conti vuoi in moneta estera
Non hai bisogno di avere gestioni separate per gestire conti in altre monete. Nel piano contabile
dove hai tutti i conti della contabilità, inserisci i conti in moneta estera, per le differenze di
cambio imposti i cambi nella tabella cambi e sei pronto a registrare.
Puoi impostare qualsiasi moneta, codici monete standard o definiti liberamente (per usare
qualsiasi moneta virtuale).
Decimali moneta configurabili da 0 a 28. Generalmente si usano 2 decimali, ma si può
impostare la contabilità per usare 0 decimali, oppure 3 decimali (Tunisia) o di più se si usa per
le cryptovalute. 9 decimali (Bitcoin) o 18 (Ethereum)
Stessa metodologia della contabilità in partita doppia
Lavori con lo stesso metodo della contabilità in partita doppia, pertanto registri i dare e in avere
e avrai tutti i report e i dettagli di una contabilità professionale.
Calcolo automatico del cambio
Nel momento in cui registri un conto in moneta estera, non hai bisogno di calcolare
manualmente il controvalore in moneta estera, il programma calcola il cambio
automaticamente. Puoi inserire il cambio sia aggiornando il cambio nella tabella Cambi, sia
direttamente nella tabella Registrazioni nella colonna Cambio.
Registrazioni in diverse monete
Puoi registrare tutti i casi possibili di registrazione in moneta estera, anche giroconti e
operazioni che non includono la moneta base. Questo permette di avere nella contabilità
operazioni anche complesse.
Report completi con Bilancio, Conto Economico
Nel Bilancio e Conto Economico, per i conti in moneta estera hai la visualizzazione dei saldi sia
in moneta estera, sia del controvalore nella moneta base (moneta nazionale).
Se hai rapporti di lavoro con l'estero e devi presentare il bilancio e il conto economico in una
seconda moneta, questo è possibile senza creare report separati in Excel, basta andare nella
tabella Conti, nella vista moneta2 e hai la visualizzazione di tutti i conti nella seconda moneta e
anche nella moneta base.

Guarda il video tutorial  che mostra come creare e stampare il bilancio abbellito con
gruppi.

Schede conto con importi in moneta estera e moneta base
Le schede conto puoi visualizzarle con le colonne degli importi in moneta base e in moneta
estera. Questo permette di valutare i saldi in entrambe le monete.

https://www.banana.ch/it/node/11353
https://www.banana.ch/it/node/11490
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Cambi liberi nella tabella Cambi
Puoi impostare i cambi per le varie esigenze: cambi variabili, cambi fissi, cambi diversi per una
stessa moneta per gestire per esempio gli investimenti e senza influenzare conti con la stessa
moneta.
Differenze di cambio in automatico
Quando necessiti di calcolare le differenze di cambio, basta aggiornare il cambio nella tabella
Cambi e impartire il comando; le differenze verranno inserite automaticamente nella tabella
Registrazioni.
Preventivi possibili anche con la Multi-moneta
Nel file della contabilità Multi-moneta puoi preventivare la liquidità anche dei conti in moneta
estera, nonché tutte le previsioni legate agli aspetti patrimoniali ed reddituali. Puoi stampare
Bilanci e report previsionali, oppure combinati, con le colonne del Peventivo, Consuntivo e
relativi scostamenti.
Controllo automatico per differenze di cambio non registrate
Se usi il comando Controlla Contabilità non avrai più differenze di cambio non registrate, perché
nel caso queste sussistano, ti verranno segnalate. La funzione si rivela particolarmente
importante per evitare di avere differenze di cambio nei saldi di apertura quando crei il nuovo
anno.
Bilanci, Conti economici e Report, anche in una seconda moneta.

La contabilità multi-moneta, basandosi sulla partita doppia ha tante altre caratteristiche identiche alla
partita doppia, che trovi alla pagina seguente:

Caratteristiche della Contabilità in partita doppia.
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Teoria della contabilità multi-moneta

In questa sezione vengono spiegate le nozioni e le problematiche relativi ai cambi.
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Cambi e problematiche contabili

Ogni nazione possiede una propria moneta e per ottenere altre monete è necessario acquistarle
dando in cambio le proprie. Il prezzo di una moneta rispetto ad un'altra si dice tasso di cambio.
Cambiare i soldi significa convertire gli importi da una moneta all'altra.

Il cambio (tasso di cambio) è il fattore che indica il tasso di conversione e varia costantemente.

Ad esempio, al 1 gennaio

1 Euro (EUR) corrispondeva 1,22637 US Dollar (USD)
1 US Dollar corrispondeva a 0,81529 Euro
1 EUR corrispondeva a 1,08222 Swiss Franc (CHF)
1 EUR corrispondeva 126,52 Japanese Yen (JPY)

Moneta base

Gli importi riferiti a monete diverse non possono essere sommati direttamente. Occorre una moneta
base a cui fare riferimento e utilizzarla per le somme.
Il principio della contabilità vuole che la somma dei saldi “Dare” deve corrispondere a quella dei saldi
“Avere”. Per verificare che la contabilità sia bilanciata, ci deve essere una moneta unica con cui fare
le somme.
Se si hanno diverse monete si deve prima di tutto definire quale sarà la moneta base. Una volta scelta
la moneta base ed aver fatto delle operazioni non è più possibile cambiarla. Per cambiarla si deve
chiudere la contabilità e aprirne una nuova con una moneta base diversa.
La moneta base serve anche a stabilire il bilancio e a calcolare l'utile o la perdita dell’esercizio.

Ogni importo ha un controvalore in moneta base

Per poter fare le somme e verificare che le operazioni bilancino, è necessario che per ogni transazione
vi sia il controvalore in moneta base. In questo modo si può controllare che il totale dei movimenti
Dare corrisponda al totale dei movimenti Avere.
Se la moneta base è EUR e si hanno movimenti in dollari, per ogni movimento in dollari bisognerà
indicare il controvalore in EUR. Tutti gli importi EUR verranno sommati per verificare il bilanciamento.

Moneta del conto

Ogni conto ha una sigla di moneta che indica in quale moneta sarà gestito il conto.
Bisogna quindi indicare quale sarà la moneta del conto. Ogni conto avrà il saldo espresso nella sua
moneta originale.
Su questo conto saranno permessi solo movimenti in quella moneta. Se il conto è in Euro, su questo
conto vi potranno essere solo movimenti in Euro; se il conto è in USD, su questo conto ci potranno
essere movimenti solo nella moneta USD.
Quando occorre gestire dei movimenti in YEN, si deve avere un conto, la cui sigla sia YEN.

Saldo conto in moneta base

Per ogni conto in moneta viene mantenuto, oltre al saldo in moneta estera, anche il saldo in moneta
base, per calcolare il bilancio in moneta base.
La scheda del conto bancario USD dovrà corrispondere esattamente all'estratto bancario per quanto
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riguarda gli importi USD.
Per ogni movimento contabile viene sempre specificato il valore in moneta base. Se il conto è in USD
vi saranno nei movimenti oltre agli importi in USD, anche il controvalore in EUR. Il saldo EUR sarà dato
dalla somma di tutti i movimenti espressi in EUR. Il saldo attuale in moneta base dipenderà dai fattori
di cambio usati per calcolare i controvalori EUR dei singoli movimenti.
Se a un dato giorno si prende il saldo effettivo in USD e lo si converte in EUR al cambio del giorno, si
otterrà un controvalore diverso dal saldo del conto in moneta base. Questa differenza è dovuta al
fatto che i cambi giornalieri utilizzati nei movimenti sono diversi dal cambio del giorno.
Vi è quindi una differenza fra il valore effettivo al cambio del giorno e il saldo contabile in moneta
base. Questa differenza contabile è detta differenza di cambio.
La differenza fra il saldo in moneta base e il valore calcolato deve essere registrata, in fase di
chiusura della contabilità, come utile o perdita di cambio.  

Bilanci in un'altra moneta (moneta 2)

Tutti i resoconti contabili vengono calcolati in moneta base. Se si prendono i valori in moneta base e
si cambiano in un'altra moneta si ottengono dei bilanci in un'altra moneta.
Il programma ha la colonna Moneta2, dove tutti i valori vengono immessi in automatico e presentati
nella moneta specificata come Moneta2.
La logica di conversione degli importi è la seguente:

Se la moneta 2 è uguale alla moneta del conto o dell'operazione, viene usato il valore originale.
Se il conto è USD e la Moneta2 è USD, viene usato l'importo in USD.
In tutti gli altri casi viene usato l'importo in moneta base e cambiato in Moneta2.
Viene usato il cambio del giorno. Anche per i movimenti passati, il controvalore in Moneta2
viene espresso in base all’ultimo cambio e non a quello storico, utilizzato il giorno del
movimento.

Bisogna prestare attenzione al fatto che un bilancio convertito in un'altra moneta presenterà delle
piccole differenze nei totali. Spesse volte, il controvalore di una somma non è uguale alla somma dei
controvalori scomposti, come si nota nell'esempio seguente:

 Moneta base EURMoneta 2 USD
   
Cassa 1.08 1.42
Banca 1.08 1.42
Totale Attivi 2.16 2.84
   
Capitale proprio2.16 2.85
Totale Passivi 2.16 2.85

Nella moneta base il totale attivi pareggia con il totale passivi. È lecito presentare un bilancio che ha
delle differenze, purché sia comprensibile e venga indicato che è stato calcolato partendo da un'altra
moneta.

Tabella Conti, Vista Moneta2
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Convertire delle monete

Variabilità dei cambi
La compravendita di monete avviene su un mercato libero. Il prezzo (tasso di cambio) viene fissato in
base alle regole della domanda e dell'offerta. Le differenze nel controvalore possono essere più o
meno importanti a seconda delle fluttuazioni del tasso di cambio.

Negli esempi che seguono i cambi non quelli reali del giorno, ma sono fittizi per spiegare la
problematica.

Data Cambio EUR/USDControvalore EUR
di USD 1000.00 Modifica controvalore rispetto al 01-01

01-011.32030 1'320.03
31-031.33350 1'333.50 13.47
30-061.34750 1'347.50 27.47
30-091.42720 1'427.20 107.17

Il cambio
ll cambio è riferito alla moneta base. Ci sono sempre due diversi valori di cambio fra due monete, a
seconda della moneta che viene usata come moneta base.

Per le monete USD ed Euro ci sono quindi due diversi cambi:

Se la base di cambio è EUR allora il cambio è 1.32030
1 Euro (EUR) corrispondeva a 1.32030 US Dollar (USD)
Se la base di cambio è USD allora il cambio è 0.75800
1 US Dollar corrispondeva a 0.75800 Euro

Nel presente documento si userà di regola l'Euro come moneta base, a cui verranno rapportate le
altre monete.

Cambio inverso
Avendo il cambio EUR/USD di 1.32030, si trova il cambio USD/EUR dividendo 1 per il tasso di cambio.

Cambio Cambio inverso
1/cambio Cambio inverso arrotondato a 6 cifre

EUR/USD 1.320300.75800 0.758000

I controvalori calcolati con un cambio inverso possono risultare diversi da quelli originali a causa degli
arrotondamenti.

Cambio Cambio inversoControvalore 10000
cambio originale

Controvalore 10000
cambio inverso Differenza

EUR/USD 1.320300.75800 13'203.00 13'192.61 10.39

Bisogna evitare di usare cambi inversi per non avere differenze.
Per esempio per il passaggio all’Euro è stato vietato l'uso di cambi inversi .
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Moltiplicatore
Vi sono delle monete che hanno cambi molto ampi.

Sempre al 1 gennaio

1 US Dollar = 670,800 Turkish Lira
1 Turkish Lira (TRL) = 0.00000149 US Dollar (USD)

Invece di usare tanti zeri si può dire che

1000 Turkish Lira (TRL) = 0.00149 US Dollar (USD)

Il moltiplicatore è in questo caso 1000 invece di 1.

Precisione
Di regola si specifica un cambio con una precisione di almeno 6 cifre dopo la virgola.
Ci sono però casi dove è necessario usare una precisione maggiore

1 Turkish Lira (TRL) = 0.00000149 US Dollar (USD)

Quando si cambia la precisione e si arrotonda il cambio in maniera diversa, cambiano anche gli
importi. La precisione con cui si specifica il cambio è molto importante.

Taglio minimo
Specialmente per le banconote si usano tagli minimi. Per i Franchi Svizzeri si usa di regola come taglio
minimo cinque centesimi (0.05). Quando si effettuano dei cambi, per esempio EUR/CHF:

1 EUR = 1.60970 Franco Svizzero

EUR Cambio Controvalore
effettivo in CHFArrotondamento a taglio minimo CHFDifferenzaCambio effettivo

10.001.6097016.09 16.10 0.01 1.61

Calcolo dei cambi e dei controvalori
Quando l'Euro è la moneta base

Fattore di cambio EUR/USD è 1.32030
1 Euro (EUR) corrisponde 1.32030 US Dollar (USD).

Calcolo del controvalore:
Si moltiplica l'importo in moneta base per il fattore di cambio:

EUR 100 per 1.32030 = USD 132.03

Calcolare l'importo in moneta base:

Si divide la moneta di destinazione per il cambio:

USD 132.03 diviso 1.32030 = EUR 100

Calcolare il fattore di cambio:
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Si divide l'importo in moneta base per l'importo moneta destinazione:

EUR 100 diviso USD 132.03 = 0.7574

Cambio di acquisto e di vendita
Le banche effettuano la compravendita di monete e mantengono un margine di guadagno. Applicano
dei tassi di cambio diversi a dipendenza se acquistano o vendono una determinata valuta.

Vendita: la banca riceve moneta locale e dà (vende) moneta estera.

Acquisto: la banca riceve (acquista) moneta estera e dà moneta locale.

Cambio moneta e cambio banconote (Aggio)
Cambio moneta: cambio per movimenti scritturali (da un conto all'altro).
Cambio banconote: cambio per banconote.
Aggio: commissione per convertire un importo scritturale in contanti.

Per il cambio moneta, le banche mantengono un margine minore (differenza acquisto/vendita)
rispetto a quello delle banconote. Quando si desidera trasformare un valore scritturale (avere su un
conto) in moneta contante, la banca applica una commissione detta aggio.

Differenze ricambiando in moneta base
Quando si cambia un importo in un'altra moneta ci si aspetta che cambiando all'inverso si ottiene il
medesimo importo di partenza.

Importo baseCambio ControvaloreRitorno
100.00 1.32030132.03 100.00

Non sempre cambiando il controvalore si ottiene il medesimo importo. A causa degli arrotondamenti
ci possono essere casi dove non si può avere il medesimo valore di ritorno.

Importo base EURCambio Controvalore USDRitorno EURDifferenza EUR
328.67 1.32030433.94 328.66
328.68 1.32030433.95 328.67 0.01
328.69 1.32030433.96 328.68 0.01

Differenze totali scomposizioni
Non sempre il totale del controvalore delle componenti di un importo, dà il medesimo controvalore
dell'importo complessivo.
In questo esempio, l'importo di 2.16 EUR dà un controvalore in USD di 2.85. Scomponendo l'importo e
sommando i due controvalori si ottiene 2.84.

Importo EURCambio Controvalore USD
2.16 1.320302.85
1.08 1.320301.42
1.08 1.320301.42
Totale 2.16 2.84
Differenza 0.01

Queste differenze matematiche non possono essere eliminate se non registrandole appropriatamente.
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Rivalutazioni e differenze di cambio

I tassi di cambio variano costantemente e di riflesso varia il controvalore in moneta base. Tra un
periodo e l’altro ci saranno inevitabilmente degli utili o perdite di cambio non realizzate, dovute alle
differenze di cambio.

Le differenze di cambio non sono degli errori contabili, ma semplicemente degli aggiustamenti di
valori che si rendono necessari per mantenere il valore contabile in sincronia con le fluttuazioni.

Al momento dell'apertura, i valori della colonna saldo sono uguali a quelli presenti nella colonna
apertura. Quando vi sono movimenti, questi aggiornano i valori nella colonna saldo.

La colonna saldo calcolato contiene il controvalore in moneta base del saldo del conto, al cambio del
giorno (quello della tabella cambi). La differenza fra il saldo in moneta base e il saldo calcolato è la
differenza di cambio, ovvero l'utile o la perdita  non ancora realizzata.
 

 Apertura
moneta

Apertura
controvalore
EUR

Saldo Moneta base
EUR

Saldo calcolato
EUR
al 30.03.XX

Differenza
di cambio

Cambio 1.32030 1.32030 1.30150
Cassa EUR 93.80 93.80 93.80 93.80
Banca USD100.00 75.74 75.74 76.83 1.09
Immobili EUR 1'000.001'000.00 1'000.00 1'000.00
Totale Attivi 1'169.54 1'169.54 1'170.63
Prestito USD-500.00 -378.70 -378.70 -384.17 -5.47
Capitale proprioEUR -790.84 790.84 -790.84 -790.84
Totale Passivi -1'169.54 -1'169.54 -1'175.01
Perdita -4.38 -4.38

Al 30 marzo il cambio EUR/USD è diverso rispetto all’inizio dell’anno. Nell'esempio qui presentato, non
vi è stato alcun movimento contabile durante il trimestre. La situazione contabile non si è modificata
rispetto all’inizio dell’anno. Nonostante ciò il totale del bilancio aggiornato con i cambi a fine marzo,
risulta diverso rispetto a quello d’inizio anno. L'avere bancario e il prestito in USD hanno un valore
diverso in EUR. Si hanno delle conseguenze contabili nonostante non ci siano stati movimenti.

Nella situazione presentata, si nota che l'Euro rispetto al dollaro vale meno, rispetto al valore che
aveva all’inizio dell’anno. Il dollaro quindi vale di più rispetto all'Euro.

Il controvalore dell’avere del conto in USD é maggiore rispetto al valore d’inizio anno. Si ha un
patrimonio maggiore e quindi un utile di cambio.

Nei passivi risulta un prestito di USD 500.00. Il controvalore in EUR è maggiore rispetto al valore
immesso ad inizio anno. Il valore del prestito essendo aumentato per via del cambio, comporta una
perdita per la differenza.

Nel seguente esempio facciamo l'ipotesi che vi sia stata un’evoluzione opposta. Si suppone che l'Euro
si è apprezzato e quindi vale di più rispetto al USD. Il controvalore in EUR di una somma in dollari è
minore del controvalore ad inizio anno.
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Apertura
moneta

Apertura
controvalore
EUR

Saldo calcolato
EUR
ipotetico 30.03.XX

Differenza
di cambio

Cambio 1.32030 1.36150
Cassa EUR 93.80 93.80 93.80
Banca USD100.00 75.74 73.44 -2.30
Immobili EUR 1'000.001'000.00 1'000.00
Totale Attivi 1’169.54 1'167.24
Prestito USD-500.00 -378.70 -367.24 11.46
Capitale proprioEUR -790.84 -790.84 -790.84
Totale Passivi -1’169.54 -1'158.08
Utile 9.16 9.16

Con un apprezzamento dell'Euro rispetto al dollaro, si ha di conseguenza un deposito bancario in USD
con un controvalore EUR inferiore rispetto ad inizio anno. Il patrimonio è diminuito e quindi vi è una
perdita.

Il prestito in USD ha un controvalore in EUR inferiore. Un minor debito è un vantaggio per la società e
quindi vi è un utile di cambio.

Utile di cambio
Si ha un utile di cambio quando:

Aumenta il controvalore degli attivi (aumento degli investimenti)
Diminuisce il controvalore dei passivi (diminuzione dei prestiti).

Perdite di cambio
Si ha una perdita di cambio quando:

Diminuisce il controvalore degli attivi (diminuiscono gli investimenti)
Aumenta il controvalore dei passivi (aumentano i prestiti)

Caratteristiche contabili delle differenze di cambio
I cambi possono evolversi in diversi modi. Spesso salgono e poi ridiscendono. In contabilità vige il
principio che i valori iscritti nel bilancio devono essere reali. Quando si presenta un bilancio si devono
indicare i controvalori dei conti esteri al cambio del giorno della presentazione.

La differenza di cambio viene calcolata come se si dovesse convertire definitivamente l'importo in
moneta base. In realtà, non vi è nessuna conversione definitiva e quindi si tratta unicamente di una
rettifica contabile.

Cambio di chiusura

A fine anno è necessario redigere il bilancio completo. Si deve quindi aggiornare il cambio con il
cambio di chiusura. È necessario inoltre registrare in modo definitivo le differenze di cambio,
altrimenti all’apertura ci saranno delle differenze.

Registrare le differenze di cambio
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Saldo
moneta

Saldo
contabile
EUR

Saldo calcolato
EUR
ipotetico 30.03.XX

Differenza
di cambio

Cambio 1.32030 1.36150
 

Banca USD100.00 75.74 73.44 -2.30
Registrazione differenza di cambioEUR -2.30
Banca USD100.00 73.44 73.44 0.00

Come si vede nell'esempio qui riportato, il saldo della Banca è di USD 100.00. In contabilità risulta
valutato a 75.74 EUR. Il valore odierno effettivo è però di EUR 73.44. Vi è una differenza in moneta
base di EUR 2.30. La registrazione deve quindi diminuire l'importo in EUR. Si procederà con un
movimento che addebita il conto Banca e accredita il conto perdite di cambio per EUR 2.30

Come si nota il saldo effettivo del conto Banca USD 100.00 non viene modificato. La registrazione
modifica unicamente il saldo in moneta base.

Con la registrazione della differenza di cambio si deve far in modo che il controvalore in moneta base
corrisponda al controvalore effettivo calcolato al cambio del giorno o di chiusura.

Il valore nella moneta del conto non viene a modificarsi. Si deve quindi procedere con una
registrazione che varia unicamente il saldo in moneta base del conto specifico.

Come contropartita si avrà il conto utile o perdite di cambio.
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Operazioni al cambio di acquisto

Registrazioni su conti valutati al cambio d’acquisto
Quando le posizioni, valutate al cambio d’acquisto (storici), sono aumentate o diminuite si deve
calcolare il cambio della tabella cambio tenendo conto delle evoluzione degli apporti.

Importo USDCambioControvalore EURTotale USD Totale EUR Cambio
storico

Acquisizione partecipazione100'000.00 0.7580 75'800.00 100'000.00106'202.000.9416
Aumento partecipazione 50'000.00 0.8792 56'870.00 150'000.00163'072.000.919839
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Investimenti e cambi speciali

Investimenti valutati al cambio d’acquisto

Certi investimenti (partecipazioni, immobili all'estero) sono valutati al cambio d’acquisto (quello
storico) e non al cambio corrente. Gli utili e le perdite di cambio non vengono contabilizzati fintanto
che non sono effettivamente realizzati. Bisogna evitare quindi che i conti vengano valutati al cambio
corrente.
Per poter evitare una rivalutazione al cambio corrente, bisogna creare nella tabella Conti una moneta
supplementare (p.es. USD1) con il cambio fisso. È fondamentale che nella colonna Fisso della tabella
Cambi, vista Completo, per ogni valuta con cambio fisso, si deve inserire Sì, altrimenti la valuta e il
relativo conto vengono rivalutati ugualmente.

Questa moneta verrà quindi usata unicamente per conto specifico (es. USD1) con il cambio fisso.

Quando si dovrà fare un passaggio dal conto USD al conto USD1 si deve procedere esattamente come
se fossero in effetti due monete diverse. Per questo motivo si dovrà usare una registrazione su due
righe.
 

Apertura con cambi speciali

Inserendo i saldi iniziali nella colonna Apertura, gli importi in moneta estera verranno convertiti nella
moneta base al cambio d'apertura.
Se questo sistema non fosse sufficientemente flessibile perché si necessitano diversi cambi speciali o
vi sono differenze d'arrotondamento, l'apertura può essere effettuata manualmente con delle normali
registrazioni, indicando gli importi e i cambi desiderati per ciascun conto. In questo caso, la colonna
“Apertura” della tabella Conti verrà lasciata vuota.
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Proprietà file contabilità multi-moneta

Si veda anche la pagina Proprietà File (Dati Base), per informazioni circa le altre sezioni del dialogo.

Conto per utili di cambio
Si seleziona dalla lista dei conti, il conto Utili di cambio presente nel Piano dei conti.
È possibile scegliere solo fra i conti della classe 3 e 4 che sono in moneta base.

Nella tabella Conti è anche possibile specificare il conto differenze di cambio per ogni singolo conto.

Conto per perdite di cambio
Si seleziona dalla lista dei conti, il conto perdite di cambio presente nel piano dei conti.

Moneta2
Si può selezionare una moneta estera per visualizzare i saldi dei conti in una moneta diversa dalla
moneta base.
Nella lista è possibile aggiungere una nuova moneta nel modo seguente:

inserire nella tabella Cambi una nuova riga e nella colonna Moneta Rif. inserire la moneta
base della contabilità, nella colonna Moneta, inserire la moneta desiderata.
Nel menu File > Proprietà file dati base, nella sezione Moneta sarà inclusa anche la moneta
aggiunta e potrà essere definita anche come moneta2.

Decimali importi moneta 2
Il numero dei decimali con cui arrotondare gli importi della moneta 2.

Conversione degli importi in Moneta 2
La moneta 2 viene visualizzata nella vista Moneta2 della tabella Conti ed utilizzata quando si desidera
avere una stima di tutti i saldi dei conti, anche quelli in moneta base, nella moneta estera, definita
come moneta 2.
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Serve solo a scopo informativo, per conoscere i valori del bilancio e del conto economico in una
moneta diversa dalla moneta base, in un determinato momento. La conversione si basa sul cambio
impostato nella tabella cambi, colonna Cambio. Se nella tabella Cambi si modifica il cambio della
moneta 2, gli importi in moneta 2 verranno ricalcolati.
La conversione può portare a delle differenze fra i saldi in moneta e quelli in moneta 2. Maggiori
informazioni sono disponibili alla pagina Tematiche cambi .

La conversione degli importi in Moneta 2 tiene conto della moneta del conto, con la seguente logica:

Se la moneta 2 è uguale alla moneta del conto, viene utilizzato l'importo nella moneta del
conto.
Se la moneta 2 è uguale alla moneta base, viene utilizzato l'importo in moneta base.
Se l'importo è in una qualsiasi altra moneta, l'importo in moneta base viene convertito in
Moneta 2 al cambio attuale, impostato nella tabella Cambi, colonna Cambio. Per la conversione
non vengono quindi usati i cambi storici.

https://www.banana.ch/doc/it/cambi_problematiche_contabili_6
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Tabella Cambi

Nella tabella Cambi vengono inserite la moneta base (moneta della contabilità) e le monete estere
con tutti i relativi parametri. 

Prima di impostare la tabella Cambi è necessario aver impostato, nella tabella Conti, i conti in moneta
estera con relative sigle e definire la moneta base nel menu File > Proprietà file dati base.

Cambi senza data e con data
Ci sono due tipi di impostazioni dei cambi:

Righe di cambio senza data1.
Le righe di cambio senza data vengono utilizzate come cambi di riferimento per convertire le
monete estere in moneta base al cambio attuale. 
Vengono utilizzate:

Quando non esiste uno storico cambi (cambi con data).1.
Per definire i cambi ufficiali di chiusura e calcolare le differenze di cambio al 31.12 (fine2.
esercizio contabile).
In fase di chiusura, per il calcolo delle differenze di cambio, devono essere usate
obbligatoriamente le righe di cambio senza data. 
 

Cambio attuale e di chiusura
È il cambio inserito nella colonna Cambio dove viene inserito il tasso di
cambio attuale o quello di chiusura a fine anno.
Questo cambio viene proposto automaticamente nelle registrazioni, quando
viene inserito il conto relativo alla moneta estera e non esiste un cambio
storico per questa moneta (righe cambio con data).
Se si modifica il cambio nella tabella Cambi, i cambi e gli importi
precedentemente usati nelle righe di registrazione non vengono modificati.
Ogni volta che vengono registrati dei movimenti in moneta estera, le
differenze di cambio che si generano vengono visualizzate nella colonna
Saldo calcolato della tabella Conti (vista Saldo); esse e sono la base per il
calcolo delle differenze di cambio e per la conversione in Moneta 2.
Cambio di chiusura:

Viene usato come cambio per le registrazioni differenze di cambio.
Diventa il cambio d'apertura quando si Crea un nuovo anno.

Cambio Apertura
È il cambio inserito nella colonna Apertura e si utilizza solo nei seguenti casi:

Alla creazione di un nuovo file multi-moneta in Banana Contabilità Plus. 
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Quando si crea il nuovo anno, il cambio di apertura viene ripreso in
automatico, secondo il cambio di chiusura dell'anno precedente (colonna
Cambio).
Il cambio di apertura viene utilizzato in automatico nella tabella Conti per
convertire gli importi di apertura della moneta estera negli importi di apertura
della moneta base della contabilità.
Se si modifica il cambio d'apertura bisogna ricalcolare la contabilità.
 

 Righe di cambio con data (cambi storici)2.
Quando nella tabella Cambi vengono inserite delle date, e nella tabella Registrazioni i
movimenti in moneta estera sono registrati in base ad una data definita nella tabella Cambi, il
programma sceglie il cambio con data uguale o minore più prossima alla data della riga di
registrazione.

Il programma utilizza il cambio storico:
Quando si inseriscono delle registrazioni ad una data specifica e nella tabella
Cambi esiste un cambio storico.
Quando si creano le differenze di cambio e viene specificato di usare il cambio
storico nel dialogo Calcola differenze di cambio.
Nelle righe di cambio della tabella Cambi che hanno uno storico cambi non deve
essere inserito un cambio di apertura (colonna C. Apertura).

Colonne della tabella Cambi
Tutte le colonne disponibili per la tabella Cambi sono visibili nella vista Completo.

Data

La riga senza una data viene utilizzata come cambio di riferimento quando manca una storico cambi
(cambi senza data).

Moneta Riferimento

È la moneta di partenza (moneta base) per il cambio delle monete estere (EUR nell’esempio).

Moneta

È la moneta di destinazione (moneta estera), il cui valore valore viene convertito nella moneta di
riferimento.

Testo

Inserire un testo per indicare la moneta estera.

Fisso

Vero o falso. Se si tratta di un cambio fisso, nella colonna inserire inserire Sì. 
In questo caso per la moneta estera con cambio fisso viene utilizzato sempre lo stesso cambio finché
non viene modificato. Solitamente, viene applicato un cambio fisso quando ci sono dei conti, il cui
valore non deve subire continue fluttuazioni (esempio Investimenti immobiliari).

Molt. (Moltiplicatore)

Il moltiplicatore normalmente è 1, 100 o 1000, e serve per ottenere il cambio effettivo. Il
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moltiplicatore viene usato per le monete che valgono unitariamente poco, per evitare di inserire
cambi con molti zeri.
Nei nostri modelli, nella tabella Cambi, colonna Moltiplicatore viene usato il moltiplicare negativo
(-1).

In questo caso:

Nella colonna Moneta di riferimento si inserisce la moneta base della contabilità
Nella colonna Moneta si inserisce la moneta in valuta estera.

Quando nelle colonne Moneta di riferimento e Moneta le sigle delle monete vengono invertite
bisogna inserire nella colonna Moltiplicatore 1 (cambio positivo).

Se sono state già inserite delle registrazioni con la medesima moneta, non modificare il
moltiplicatore, altrimenti il programma segnalerà errori nelle registrazioni dovuti a cambi errati.

Cambio

Il cambio attuale o di chiusura della moneta rispetto alla moneta di riferimento.
Serve anche per calcolare le differenze di cambio. Prima di calcolare le differenze di cambio è
necessario aggiornare il cambio in questa colonna, secondo il cambio di chiusura ufficiale.

Il cambio e il moltiplicatore vengono applicati secondo le seguenti formule:

Con moltiplicatore > 0
Importo moneta = Importo moneta rif. * (cambio / |molt.|).
Con moltiplicatore < 0
Importo moneta rif. = Importo moneta * (cambio / |molt.|).

Cambio d’apertura

È il cambio al momento dell’apertura. Da indicare solo nella riga senza data.

Viene usato per convertire l’importo di apertura delle monete estere in quello d’apertura della
moneta base della contabilità.
Deve corrispondere al cambio di chiusura dell'anno precedente.
Quando si passa al nuovo anno, il cambio di apertura viene aggiornato in automatico secondo il
cambio di chiusura dell'anno precedente inserito nella colonna cambio (tabella Cambi).
Se i cambi di chiusura non sono uguali a quelli di apertura, il totale attivi e passivi potrà
risultare diverso, vedi pagina Differenze nei saldi iniziali.
Il cambio di apertura non deve essere mai cambiato durante l'anno, altrimenti si creano
delle differenze di cambio nel totale dei saldi iniziali
Il cambio di apertura non deve avere una data.

Minimo

Il cambio minimo accettato. Se nelle registrazioni viene utilizzato un cambio minore c’è un avviso.

Massimo

Il cambio massimo accettato. Se nelle registrazioni viene utilizzato un cambio maggiore c’è un avviso.
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Decimali

Il numero dei decimali con cui arrotondare gli importi della moneta estera.

Modifiche dei cambi
I cambi attuali delle monete estere possono essere modificati nella tabella Cambi, colonna Cambio,
nelle righe senza una data. In questo caso, quando nella tabella Registrazioni viene registrato un
movimento con un conto in moneta estera, il programma riprende in automatico il cambio impostato
nella tabella Cambi. Se si modifica un cambio nella tabella Cambi non ci saranno ripercussioni nelle
registrazioni già inserite; il nuovo cambio viene utilizzato per le registrazioni future. 

È possibile modificare il cambio anche direttamente nella tabella Registrazioni, inserendo
manualmente il cambio desiderato nella colonna Cambio. Questo cambio non modifica il cambio
presente nella tabella Cambi.  

Nei casi che seguono, modificando il cambio si hanno delle ripercussioni:

Modifica del cambio d'apertura:
Se viene modificato il cambio di apertura, ricalcolando la contabilità, il saldo iniziale dei conti in
moneta base sarà ricalcolato con il nuovo cambio.
Attenzione quindi a modificare i cambi di apertura in presenza di saldi iniziali. 
Se si modificano i cambi di apertura e ci sono saldi iniziali, è importante effettuare un Ricalcolo
completo della contabilità.
Modifica del moltiplicatore:

Se viene cambiato il moltiplicatore di una moneta già utilizzata nella tabella Registrazioni,
ricalcolando la contabilità, il programma segnala un avviso.
Occorre reinserire l'importo della registrazione e quello in moneta base corretto.
Quando si ricalcola la contabilità vengono ricalcolati di conseguenza i saldi di apertura in
moneta base.

Cambi diretti
I cambi diretti sono quelli dove si indica sulla stessa riga la moneta base e la moneta estera.
Nell'esempio sottostante il cambio diretto è EUR → USD.

Cambi indiretti
I cambi indiretti sono quelli dove non si specifica un cambio diretto fra due monete (uso
sconsigliato).
Il cambio viene dedotto dal programma sulla base di altre combinazioni di monete inserite.
Nell'esempio il cambio EUR → USD non è stato definito, e il programma lo deduce combinando il
cambio EUR → USD e USD → EUR.
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Il programma supporta cambi indiretti. Si consiglia di usare unicamente dei cambi diretti  ed
evitare di usare dei conti dove non è specificato il cambio in modo diretto fra la moneta base e la
moneta del conto. Con i cambi indiretti e possibile che non sia sempre chiaro il cambio che viene
applicato.

Storico cambi
Come indicato precedentemente, se un cambio ha una data, il programma lo considera come cambio
storico.
Nei casi qui di seguito indicati, il programma sceglie il cambio con data uguale o minore più prossima
alla data della riga di registrazione:

Quando si inseriscono delle registrazioni, se c'è un cambio storico, viene proposto e usato come
cambio predefinito.
Quando si Creano le differenze di cambio e viene specificato di usare il cambio storico.
Nelle righe con data, il cambio d'apertura non viene usato.

È possibile importare cambi da un altro file .ac2 o copiare/incollare cambi storici da Excel.
Se si importano diversi cambi storici a posteriori, cioè quando si sono già eseguiti movimenti contabili,
affinché il programma utilizzi i cambi importati, invece che quelli immessi in sede di registrazione,
occorre semplicemente cancellare manualmente i cambi delle registrazioni, nella colonna Cambio
della tabella Registrazioni.

Cambio medio mensile
Quando si inserisce un cambio medio mensile, questo deve essere inserito manualmente nella tabella
Cambi, in una riga senza data. Nelle tabella Registrazioni, per i conti in valuta estera, il cambio medio
verrà sempre ripreso finché non verrà aggiornato nuovamente nella tabella Cambi.

Per il cambio medio mensile si consiglia di consultare la pagina dei cambi proposti dalla
Confederazione .

https://www.estv.admin.ch/estv/it/home/imposta-sul-valore-aggiunto/rendiconto-iva/iva-corsi-delle-valute-estere/corsi-medi-mensili/corsi-medi-mensili-attuale.html
https://www.estv.admin.ch/estv/it/home/imposta-sul-valore-aggiunto/rendiconto-iva/iva-corsi-delle-valute-estere/corsi-medi-mensili/corsi-medi-mensili-attuale.html
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Cambi non compatibili da versioni precedenti

Quando la moneta base è inserita come moneta di riferimento, i cambi con moltiplicatore maggiore di
1 possono presentare delle differenze di calcolo tra Banana Plus e le versioni precedenti. In questi rari
casi, aprendo un file contabile di una versione precedente, viene visualizzato un avviso e il file viene
aperto in sola lettura.

Per ottenere i medesimi importi occorre correggere il moltiplicatore e il cambio come segue:

Aprire il file in Banana Plus e confermare l'avviso.
Ricontrollare la contabilità (maius + F9).
Gli avvisi "moltiplicatore registrazione non è quello della tabella cambi" possono essere ignorati.
Verificare i saldi e il risultato d'esercizio che non abbiano delle differenze rispetto a quanto
visualizzato nelle versioni precedenti. Se non ci sono differenze è sufficiente salvare la
contabilità con un nuovo nome, altrimenti è necessario proseguire con i seguenti passaggi:
Nella tabella cambi, per i cambi con moltiplicatore maggiore di uno, correggere il cambio
moltiplicandolo per il valore del moltiplicatore e impostare il moltiplicatore a 1. Per esempio, se
abbiamo un moltiplicatore di 100 e un cambio di 0.9944608, correggere il cambio in 99.44608 e
il moltiplicatore in 1.
Ricalcolare la contabilità (maius + F9).
Gli avvisi "moltiplicatore registrazione non è quello della tabella cambio" possono essere
ignorati, oppure è possibile eliminarli, cliccando nella corrispondente riga di registrazione
sull'importo in moneta base e premendo il tasto F6
Verificare che i saldi e il risultato d'esercizio corrispondano a quelli indicati nelle versioni
precedenti.
Salvare il file con un nuovo nome
A questo punto potete impostare i cambi e il moltiplicatore nella forma desiderata, inversa o
diretta, con o senza moltiplicatore, verificando dopo ogni modifica i saldi e il risultato
d'esercizio.
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Tabella Conti | contabilità multi-moneta

A differenza della Contabilità in partita doppia, la Contabilità Multimoneta presenta la tabella Cambi e
le colonne per il calcolo degli importi e saldi in moneta estera.

Raggruppamento della tabella Conti
Per il sistema di raggruppamento di Conti e Gruppi si rimanda alla pagina Sistema Raggruppamento. 

Impostare la moneta base
La moneta base viene impostata dal menu File > Proprietà file.

Moneta del conto
Ogni conto ha una sigla moneta, che può essere quella della moneta base o una sigla di una moneta
estera, indicata nella tabella Cambi .

I conti Attivi e Passivi, oltre alla moneta base (nell'esempio EUR) possono essere impostati in diverse
monete estere.

Conti in monete estere
I conti in moneta estera vengono impostati nella tabella Conti. Nella colonna Moneta, per ogni
conto in moneta estera si deve inserire la sigla della moneta.
Nella tabella Cambi, per ciascuna moneta estera, devono essere riportate le sigle delle monete
estere, impostate nella tabella Conti e, inserito il cambio di apertura.
Nell'esempio che segue, la moneta base è EUR. La sigla della moneta base EUR appare nelle
intestazioni delle colonne con gli importi in moneta base.
 
Conti in moneta base (moneta della contabilità)
I conti in moneta base vengono impostati nella tabella Conti. Nella colonna Moneta si deve
inserire la sigla della moneta base.

I conti dei costi e dei ricavi, oltre alla moneta base (nell'esempio EUR), possono essere impostati in
diverse monete estere

http://www.banana.ch/doc/it/node/3334
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Spiegazione delle colonne - contabilità multi-moneta
Moneta
Inserire la sigla della moneta del conto. Per i conti in moneta estera, la sigla deve essere presente
anche nella tabella cambi.

Aper.moneta
Per ogni conto viene inserito il saldo iniziale, sia che si tratti di un conto in moneta base che in
moneta estera.

Apertura (moneta base)

Colonna protetta usata dal programma.
Il saldo iniziale in moneta base viene calcolato dal programma.
Per i conti in moneta base viene riportato il saldo di apertura della colonna Aper.moneta.
Per i conti in moneta estera viene riportato il saldo presente nella colonna Aper.moneta,
convertito in base al cambio presente nella tabella cambi, nella riga senza data, colonna
Apertura.

Saldo moneta

Colonna protetta usata dal programma.
Il saldo in moneta base è dato dal saldo di apertura e dagli importi delle registrazioni in moneta
base
Per i conti in moneta estera, il saldo è convertito in base al cambio presente nella tabella
Cambi.

Saldo

Colonna protetta usata dal programma.
Il saldo è calcolato dal programma e corrisponde alla somma del saldo di apertura (per i conti in
moneta estera è il saldo convertito in moneta base) e dagli importi delle registrazioni in moneta
base e in moneta estera (importi convertiti secondo un cambio, presente nella tabella cambi).

Saldo calcolato

Colonna protetta usata dal programma.
È il saldo in moneta del conto convertito al cambio attuale (cambio della tabella cambi della riga
senza data).
In questa colonna, i saldi dei conti in moneta, convertiti  in moneta base possono differire da
quelli della colonna Saldo, poiché sono presenti le differenze di cambio.
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 Conto differenze di cambio

Visibile nella vista Varia.
In questa colonna, per un determinato conto, si può inserire un conto utile o perdita di cambio.
Il conto indicato verrà usato dalla procedura Crea registrazioni differenze di cambio, al posto dei
conti utile e perdita di cambio, definiti nel menu File proprietà file  (contabilità Multimoneta).
Nella colonna Conto differenza di cambio si può specificare:

"0;0" Significa che per questo conto non deve essere calcolata la differenza di cambio.
Si usa per i cambi storici che non devono cambiare.
Due conti separati da punto e virgola, "Conto perdita di cambio; Conto Utile di
cambio", per esempio "6949;6999".
Se vi è una perdita sarà usato il primo conto, se vi è un utile il secondo. 
"Un conto solo" per esempio "6949"
Sarà sempre usato questo conto sia che ci sia un utile o una perdita di cambio.

I saldi iniziali
Le informazioni su come inserire i saldi di apertura nella contabilità multimoneta sono disponibili alla
pagina Saldi iniziali nella contabilità Multimoneta.

Conti utile e perdita di cambio
Nel piano dei conti si devono inserire i conti predefiniti per l'utile e la perdita di cambio da riportare
poi nel menu File Proprietà file → Moneta estera.

I conti per le differenze di cambio devono avere la BClasse 3 (Costi - perdita di cambio) o 4 (Ricavi -
utile di cambio).

Personalizzare il piano dei conti
Nella tabella Conti personalizza il piano contabile secondo le tue esigenze:

Aggiungi ed elimina dei conti esistenti (vedi aggiungere un nuova riga)
Cambia i numeri di conto, la descrizione (es. inserisci il nome del ccb della tua Banca), inserisci
altri gruppi, ecc.
Per creare dei sottogruppi consulta la pagina sui Gruppi.

http://www.banana.ch/doc/it/node/8375
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Per visualizzare la scheda di un conto, basta posizionarsi con il mouse sul numero di conto e cliccare
sul piccolo simbolo blu che appare.

Schede conto per periodo

Per visualizzare le schede conto con i saldi riferiti ad un determinato periodo, vai su:

Menu Report → Schede conto → sezione Periodo → Specificato
Inserisci la data di inizio e di fine periodo.

Per maggiori informazioni consulta la pagina Periodo.

Stampare le schede conto

Per stampare una scheda conto, basta visualizzare la scheda da qualsiasi tabella (Conti o
Registrazioni) e lanciare la stampa dal menu File.

Per stampare diverse o tutte le schede conto, clicca sul menu Report → Schede conto e seleziona le
schede conto da stampare. Tramite il filtro presente nella finestra, si può eseguire una selezione in
automatico di tutti i conti, i centri di costo, i segmenti, i gruppi, ecc..

Maggiori informazioni sono disponibili alla pagina Scheda conto.

Rivalutazione conti e cambi storici

I cambi sono fluttuanti. L'effettivo controvalore in moneta base di un conto in moneta estera varia a
seconda delle oscillazioni dei cambi.

Il controvalore di un conto in moneta estera è calcolato sulla base del cambio d'apertura e dei cambi
che sono indicati nelle registrazioni. Perché questo valore corrisponda al controvalore del cambio
odierno bisogna rivalutare il conto.
La rivalutazione avviene tramite il calcolo delle differenze di cambio. Con il calcolo in automatico delle
differenze di cambio, il programma inserisce un importo in moneta base (differenza di cambio) in
modo che il saldo in moneta base risulti uguale al controvalore (colonna saldo calcolato).  

Questa operazione di allineamento viene fatta alla fine dell'anno, prima di chiudere la contabilità o
quando si desidera stampare un bilancio con dei valori di cambio che corrispondono alla realtà del
giorno. Si veda il comando differenze di cambio.
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Ci sono dei conti (relativi per esempio ad investimenti o partecipazioni) per i quali si usa un cambio
storico. Per cambio storico si intende un cambio che non varia nel tempo.

Per avere dei cambi che non variano ci sono due modi:

Creare nella tabella cambi una sigla moneta supplementare (p.es. USD2) a cui si attribuisce un
cambio fisso.

Nella descrizione moneta, indicare che si tratta di un cambio storico.
Questa moneta deve poi essere usata per il conto con il cambio storico e ovviamente
anche nelle registrazioni che riguardano il conto.
Per ogni nuovo conto con un cambio storico diverso, creare una nuova sigla moneta.
Si possono creare quante sigle monete si necessitano per i diversi conti con cambi storici.
Modificare il cambio del conto storico se ci sono ulteriori acquisti o vendite che richiedono
un adattamento del valore, creando nel contempo una registrazione per l'utile o la perdita
di cambio.

Inserire i saldi iniziali come registrazioni d'apertura nella tabella Registrazioni.
Invece di usare la colonna saldi d'apertura, i saldi d'apertura sono inseriti come delle
registrazioni. Si può attribuire il cambio d'apertura che si desidera.
Nella colonna Conto differenza di cambio, inserire il valore "0;0" che permette al conto
di non essere rivalutato.

Totali gruppi in moneta estera
La colonna importi in moneta non ha normalmente totali in quanto ha poco senso sommare valori in
diverse monete.

Se avete un gruppo che raggruppa solo conti in una precisa moneta, potete indicare la sigla moneta a
livello di gruppo e, nella tabella conti, il programma somma questi importi. Se ci sono conti con sigle
monete diverse non figurerà alcun importo (non viene neanche segnalato alcun errore).
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Cambiare la moneta base nella contabilità
multi-moneta

In una contabilità multimoneta tutti gli importi sono indicati nella moneta del conto e nella moneta
base. Se si cambia la moneta base tutti i cambi e gli importi in moneta base devono essere
nuovamente inseriti manualmente.

Il cambio della moneta base è meglio farlo all'inizio dell'anno quando non ci sono ancora operazioni.
Si può comunque farlo anche durante l'anno, qui di seguito viene spiegato come procedere se si
vuole, per esempio, passare da una contabilità in EUR a una in USD:

Salvare il file con un altro nome.
Nelle Proprietà file:

Indicare la nuova moneta base. 
Togliere il riferimento al file anno precedente (sezione 'Opzioni').

Nella Tabella Cambi indicare i cambi riferiti alla moneta base:
Se ci sono tante registrazioni da convertire, può essere utile, nella tabella cambi, inserire
dei cambi medi, indicando la data di inizio mese.
Nelle registrazioni il programma riprenderà il cambio storico.

Nel Piano dei conti:
Sostituire la sigla moneta con quella nuova.
Si può selezionare la colonna e usare il comando Dati → Sostituisci .
Se ci sono saldi iniziali bisogna indicarli nella nuova moneta.
Le colonne saldo anno precedente, budget e altro devono pure essere convertite.

Nella Tabella Registrazioni:
Se ci sono registrazioni, procedere alle rettifiche riga per riga:

Per le registrazioni i cui importi sono già nella moneta corretta, con il tasto F6
sull'importo, il programma ricalcola il valore in moneta base. 
Per le altre registrazioni inserire il valore corretto nella moneta base e poi premere il tasto
F6.

Nella Tabella Preventivo:
procedere come per le registrazioni.
Dare il comando Ricontrolla contabilità  dal menu Azioni, sistemare eventuali errori e ridare
il comando Controlla contabilità fin quando non ci sono più segnalazioni. 

http://www.banana.ch/doc/it/node/2672
http://www.banana.ch/doc/it/node/2672
http://www.banana.ch/doc/it/node/2672
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Registrazioni contabilità multi-moneta

Con l' applicativo di contabilità multimoneta è possibile registrare anche i movimenti con conti in
moneta estera. Nella Tabella Registrazioni si inseriscono, oltre ai movimenti in valuta base, anche
quelli in valuta estera: si indicano tutti gli elementi della registrazione, l'importo e il conto in moneta
estera, il cambio che si applica alla registrazione, mentre l'importo in moneta base viene dato in
automatico per conversione in base al cambio inserito.

Spiegazioni colonne
Nella Tabella Registrazioni della contabilità multimoneta, rispetto a quella della contabilità in
partita doppia, sono presenti le seguenti colonne supplementari:

Imp. moneta
È l'importo della moneta secondo quella specificata nella colonna sigla moneta.
Questo importo è utilizzato dal programma per aggiornare il saldo in moneta del rispettivo
conto.
Moneta
È la sigla della moneta a cui si riferisce l'importo.
La sigla moneta deve essere o la moneta base, specificata nelle proprietà file (menu File),
oppure la sigla moneta di un conto in moneta estera, indicato nelle colonne CtDare o CtAvere.
Si può anche usare una moneta diversa, purché il CtDare e il CtAvere indicati siano conti in
moneta base. In questo caso l'importo in moneta è usato come riferimento, ma non sarà usato
contabilmente.
Cambio
Serve a convertire l'importo della moneta estera nel controvalore della moneta base.
Importo in moneta base
È l'importo della registrazione espresso in moneta base.
Questo importo è utilizzato dal programma per aggiornare il saldo in moneta base del rispettivo
conto.
Moltiplicatore cambio
Normalmente non è visibile nella vista. Questo valore è il moltiplicatore del cambio.

Consigli utili
Premendo il tasto F6 mentre ci si trova sulla colonna Importo in moneta, il programma
riscrive tutti i valori con la logica spiegata prima, come se non esistesse alcun valore. Questa
funzione è utile se si cambia il CtDare o il CtAvere.
Nel caso in cui esista una registrazione con un singolo conto in moneta base (nelle registrazioni
composte) e nella colonna Moneta la sigla sia stata cambiata in moneta estera, per aggiornare
il cambio occorre posizionarsi sulla cella Moneta e premere F6.
Smart fill per la colonna Cambi
Il programma propone diversi cambi, riprendendoli dalla tabella Cambi o dai cambi utilizzati in
precedenza nelle registrazioni.

Tipi di registrazione multi-moneta
Tutti gli importi, sia in moneta base che in moneta estera devono essere inseriti sempre nella colonna
Imp. Moneta.
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Per quanto attiene ai cambi, moltiplicatore e cambi storici, si rimanda alla pagina Tabella cambi.

Attenzione: negli esempi di registrazione, la moneta base è Euro.

Per ogni registrazione ci sono due conti (conto dare e conto avere). Il programma permette di avere
per ogni riga di registrazione una sola moneta estera. Ci possono quindi essere queste combinazioni
dirette:

Registrazione fra due conti in moneta base con importo in moneta base (nell'immagine
la registrazione n.1 nella colonna Doc 1)
La moneta del conto dare e avere è quella di base.
Registrazione fra due conti in moneta base con importo in moneta estera (Doc 2)
I conti indicati in dare e avere sono in moneta base, ma la sigla moneta (colonna moneta) e
l'importo moneta indicati nella riga di registrazione non sono in moneta base, ma in una moneta
estera.
Per inserire la moneta estera si deve cambiare manualmente la sigla moneta base proposta in
automatico.
Si usa quando si va all'estero e si cambia del denaro per pagare nella valuta locale. In questo
caso nella contabilità non abbiamo un conto specifico.
Per il calcolo del saldo  (essendo tutte e due in moneta base) è usato solo l'importo della
colonna moneta base.
Registrazione fra un conto in moneta estera e uno in moneta base (Doc 3)
La moneta deve essere quella del conto in moneta estera.
Per il calcolo del saldo del conto in moneta estera, il programma usa l'importo in moneta estera
e per il saldo in moneta base è usato l'importo in moneta base.
Registrazione fra due conti con la stessa moneta estera (Doc 4)
La moneta deve essere uguale a quella dei conti usati (USD1 e USD2). Per aggiornare il cambio
occorre posizionarsi sulla cella Moneta e premere F6.
Registrazione con due conti che hanno la moneta estera diversa (Doc 5)
Per esempio la banca fa un'operazione di cambio fra due monete estere.
In questo caso è necessario registrare su due righe (con la stessa data).
L'importo in moneta base deve essere necessariamente uguale. È utile usare un cambio vicino
alla realtà per evitare eccessive differenze di cambio.
Perché gli importi in moneta base, nelle due righe siano uguali, bisogna indicare manualmente
l'importo in moneta base e lasciare che sia il programma a calcolare il cambio.
Registrazioni differenze di cambio (Doc 6)
Lo scopo di questa registrazione è quello di riallineare il saldo del conto in moneta base al
controvalore del conto in moneta estera al cambio odierno.
Si registra sul conto in moneta solo l'importo in moneta base relativo alla differenza di cambio.
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Sono generate in automatico con il comando Calcola differenze di cambio.
Per gli utili di cambio, il programma inserisce in automatico il conto da rivalutare in dare e
il conto utili di cambio in avere, presente nelle Proprietà file, dati base, oppure nel conto
indicato nella colonna Differenze di cambio della vista Varia (previsto per uno o più
conti specifici).
Per le perdite, il programma inserisce in automatico il conto da rivalutare in avere e il
conto perdite di cambio in dare, presente nelle Proprietà file, dati base (menu File),
oppure nel conto indicato nella colonna Differenze di cambio della vista Varia (previsto
per uno o più conti specifici).
L'importo in moneta è lasciato vuoto
La sigla moneta è la moneta base
Nella colonna importo in moneta base si indica l'importo della rivalutazione del conto
(utile o perdita)

 Stabilire il cambio
È il contabile che decide il cambio da utilizzare per ogni singola operazione. Di regola valgono le
seguenti regole:

Per le operazioni normali si usa il cambio del giorno.
Per le operazioni di compravendita di moneta si usano i valori indicati dall'ufficio cambio o dalla
banca.
Nel programma si inserisce prima l'importo in moneta e poi l'importo in moneta base ed è il
programma che calcola il cambio. Il cambio indicato dalla banca potrebbe essere leggermente
diverso perché le banche indicano un cambio arrotondato a pochi decimali.
Se si fanno diverse operazioni sempre al medesimo cambio è utile aggiornare il cambio nella
tabella Cambi, in modo che il programma lo possa riprendere in automatico.
Per operazioni estere soggette all'IVA è possibile che l'autorità nazionale prescriva un cambio
standard. Nel caso, inserire questo cambio nella colonna Cambio della registrazione.
Per l'acquisto di immobili o partecipazioni si usa il cambio storico. In questo caso è necessario
creare nella tabella Cambi una sigla moneta (p.es. USD2) con il cambio storico, che non subirà
le fluttuazioni di cambio.
Si possono creare delle sigle moneta per tutti i cambi storici che si desiderano.

 Registrazioni con IVA
In una contabilità multimoneta con IVA, per registrare correttamente senza segnalazioni di errori, è
fondamentale che Il conto IVA e il conto dal quale viene scorporata l'IVA siano in moneta base. Non è
possibile applicare un codice IVA su un conto in moneta estera.
 

Per registrare operazioni con IVA che hanno come contropartita dei conti in moneta estera si devono
usare due righe di registrazione:

Prima si registra l'importo dell'acquisto su un conto d'appoggio in moneta base e si applica il
relativo codice IVA.
L'importo in moneta base deve essere calcolato usando il cambio conformemente alle
prescrizioni dell'amministrazione delle contribuzioni.
In una seconda riga si azzera il conto d'appoggio e come contropartita si mette il conto in
moneta estera.
L'importo usato per questa registrazione, sia in moneta base che in moneta estera, dovrà
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essere quello al netto dell'IVA.
Ovviamente si dovrà usare il medesimo cambio della registrazione precedente.

Nell'esempio, la moneta base è EUR. Si ipotizza un acquisto nazionale, ma con il pagamento da un
conto in moneta estera (USD).

 Registrazioni con IVA e moneta estera
Nelle registrazioni con conti in moneta estera, è possibile registrare l'IVA con importo al lordo (Tipo
importo 0, IVA inclusa).
Se si inseriscono dei valori al netto (Tipo importo 1, IVA esclusa) il programma segnala un errore in
quanto il calcolo del valore al lordo, risulterebbe in molti casi non corretto per via dell'arrotondamento
dell'IVA e del cambio. 
In questi casi si consiglia di inserire il valore al lordo. Vedi anche Spiegazioni in merito all'errore .

Automatismi durante l'inserimento delle registrazioni multi-
moneta
Quando si inserisce una nuova registrazione si devono completare i dati nelle colonne citate in
precedenza.

Se si modificano certi valori della riga di registrazione, il programma completa la registrazione con i
valori predefiniti. Se questi valori non soddisfano le proprie esigenze, questi devono essere modificati
nella riga di registrazione.

La modifica dei valori della tabella Cambi non ha alcuna ripercusione sulle righe di registrazione già
inserite. Quindi se si modifica il cambio nella tabella Cambi, questo non avrà alcuna influenza sulle
registrazioni già inserite. 

Quando si inserisce l'importo in moneta e c'é almeno il CtDare o il CtAvere e non ci sono altri
valori, il programma opera come segue:

la sigla moneta viene ripresa dal conto utilizzato, dando priorità al conto non in moneta
base;
viene ripreso il cambio definito nella tabella Cambi con la seguente logica:

viene ripreso il cambio storico con la data minore o uguale a quella della data della
registrazione
se non viene trovato un cambio storico, viene ripreso il cambio della riga cambi
senza data

Viene ripreso il moltiplicatore definito nella tabella Cambi o 1 se è si tratta della moneta
base.
Viene calcolato l'importo in moneta base.

Quando si modifica l'importo in moneta (e ci sono già gli altri valori) il programma opera come
segue:

https://www.banana.ch/doc/it/doppiamsg_it_wrnivabaseimponibileconimportononindivisabase
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viene calcolato l'importo in moneta base con il cambio esistente
Se si modifica la sigla moneta il programma opera some segue:

viene ripreso il cambio con il moltiplicatore e calcolato l'importo in moneta base (come
sopra).

Se si modifica il cambio il programma opera come segue:
viene calcolato l'importo in moneta base usando il cambio immesso.

Se si modifica l'importo in moneta base il programma opera come segue:
viene ricalcolato il cambio.

Finestra Info
Nella finestra info il programma indica:

Eventuali differenze fra totale movimenti dare e totale movimenti avere in moneta base.
Indicazioni circa l'uso del tasto F6.

Per i conti relativi alla riga di registrazione su cui ci si trova, il programma indica sempre nella finestra
Info:

numero di conto
descrizione del conto
importo della registrazione in moneta base
saldo attuale del conto in moneta base
sigla della moneta del conto
importo della registrazione in moneta del conto (se non in moneta base)
saldo attuale del conto in moneta (se non in moneta base)
 

Registrazioni per saldi d'apertura
Per la contabilità multi-moneta, quando si inseriscono i saldi d'apertura nella tabella Conti, il
programma converte l'importo in moneta base, usando il cambio di apertura definito nella tabella
Cambi, colonna Cambio d'apertura.
Per usare dei cambi storici nei saldi d'apertura, si può creare un'altra sigla moneta oppure creare
delle registrazioni nella tabella Registrazioni con i saldi d'apertura. In questo modo si possono usare
dei cambi diversi per i conti.

Inserire una registrazione per ogni conto con saldo di apertura (Attivi e Passivi), indicando la
data d'inizio della contabilità e il conto in dare o in avere.
Nella colonna DocTipo inserire il valore "01" per indicare che è un valore di apertura.

Nei calcoli e stampe di Banana Contabilità, questo importo sarà inserito come saldo di
apertura. 
La registrazione non aggiorna però la colonna saldo di apertura nella tabella Conti.

Da considerare se si usano registrazioni di apertura:

Per evitare la rivalutazione dei conti al cambio attuale, nella tabella Conti, per il conto che non
deve essere rivalutato, inserire "0;0" nella colonna Conti differenza di cambio.
Il programma permette di inserire i saldi di apertura sia nella tabella Conti sia delle
registrazioni di apertura (Attivi e Passivi) nella tabella Registrazioni.
In entrambi i casi gli importi sono considerati nei calcoli e se si tratta del medesimo conto
vengono sommati.
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Si sconsiglia di usare i due metodi contemporaneamente per evitare errori e differenze difficili
da trovare. 
Le registrazioni di apertura devono essere inserite manualmente.
Eventuali differenze dare e avere, sono indicate come differenza nelle registrazioni.

Ripresa dati da versioni precedenti
Nella versione 4 o precedenti, l'assenza di una sigla moneta nella tabella Registrazioni veniva
interpretata come divisa Base.
Nella versione 7, ogni registrazione deve avere la propria sigla moneta, pertanto, quando si passa
dalla versione 4 alla versione 7, nel file occorre completare le registrazioni dove manca la sigla
moneta. Per questo, è necessario aggiungere una nuova colonna Moneta alla tabella Registrazioni,
eseguendo il comando Disponi colonne dal menu Dati.
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Crea registrazioni differenze di cambio

Registrare le differenze di cambio
Per gli aspetti teorici si veda Rivalutazioni e differenze di cambio .

Le registrazioni differenze di cambio sono delle registrazioni che pareggiano il saldo di un conto
in moneta estera con il saldo calcolato in moneta base della contabilità. Si tratta in sostanza di
rivalutare i valori in moneta base, con eventuali utili o perdite dovuti alle fluttuazioni dei cambi.
Se non si registrano queste differenze di cambio, quando si passa
all'anno successivo potrebbero risultare delle differenze nel bilancio d'apertura.
Le registrazioni differenze di cambio possono essere calcolate, alla chiusura della contabilità o
durante il periodo contabile (per esempio alla fine di un trimestre). In questo caso sono utili i
cambi storici che permettono di avere diversi cambi a date specifiche.
Il programma calcola la differenza di cambio sulla base dei saldi alla data specificata.
È possibile quindi calcolare la differenza di cambio a una data, anche se si sono inserite
registrazioni successive alla data indicata.
Per ulteriori spiegazioni si veda anche la Segnalazione "Differenze di cambio non registrate ".
Le differenze di cambio non vengono calcolate sui conti appartenenti al conto economico. Gli
utili /perdite di cambio, generate dalle differenze di cambio, sono elementi di natura finanziaria
e non operativa, pertanto non vengono inclusi nella determinazione del reddito operativo o del
conto economico.

Dialogo Calcola differenze di cambio
Il comando Crea registrazioni differenze di cambio... del menu Azioni calcola gli apprezzamenti
e deprezzamenti per i conti in moneta estera.

Data per le registrazioni delle differenze di cambio

Il programma è in grado di calcolare la differenza di cambio a una data anche se ci sono delle
registrazioni oltre la data.

Inserire la data per registrare le differenze di cambio.
Il programma propone come data, la data finale del mese corrente, relativa all'ultima
registrazione inserita.

https://www.banana.ch/doc/it/rivalutazioni_differenze_cambio
https://www.banana.ch/doc/it/node/7528/
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Se ci sono registrazioni differenze di cambio per la stessa data il programma chiede se si
vogliono sostituire.
Il programma considera le registrazioni differenze di cambio esistenti se hanno la data,
doc, descrizione, conti e moneta uguali e non c'é alcun importo in moneta del conto.

Numero di documento

Inserire il numero di documento (che sarà usato per completare la colonna Doc) per le registrazioni
delle differenze di cambio create.

Opzione Usa cambi storici (righe cambi con data)

Se questa opzione non è attivata:
Nella tabella Cambi non ci sono cambi storici (con data).
In questo caso viene usato il Cambio della Tabella cambi delle righe che non hanno data.
Quando vengono calcolate le differenze di cambio bisogna fare attenzione che il cambio
venga aggiornato.

Se questa opzione è attivata:
Il programma propone la data che trova sulla Riga cambio della tabella Cambi che sarà
usata dal programma per il calcolo delle differenze di cambio.
È il cambio della tabella Cambi con la data uguale o precedente a quella indicata.
Alla chiusura della contabilità, per le differenze di cambio, è meglio che questa opzione
non venga attivata.
Se alla chiusura della contabilità, si decide di utilizzare un cambio storico per il calcolo
delle differenze di cambio, questo deve essere modificato secondo il cambio attuale,
altrimenti si ha un messaggio che le differenze di cambio non sono state registrate anche
se queste lo sono.

Valori usati per la creazione delle registrazioni
Per spiegazioni ulteriori si rimanda alla pagina Registrazioni contabilità multimoneta. 

Importo della registrazione

Sono create delle registrazione differenza di cambio unicamente per i conti in moneta estera
che alla data specificata hanno un saldo in moneta base diverso rispetto a quello calcolato.
Come importo in moneta base viene usata la differenza fra il saldo del conto in moneta base e il
saldo del conto in moneta estera convertito in moneta base. 

Saldo del conto

Per il calcolo della differenza di cambio sono usati i saldi in moneta del conto e in moneta base alla
data specificata.

Conti utile e perdita di cambio o soppressione calcolo differenza di cambio

Come conti utile e perdita di cambio sono utilizzati, in ordine di precedenza:

I conti specifici indicati nella colonna Conto differenza di cambio del piano dei conti o il valore1.
che indica che per il conto non deve essere calcolata alcuna differenza di cambio
I conti utile o perdita di cambio indicati nelle proprietà file (Multi moneta).2.
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Posizione inserimento righe

Se quando si da il comando e ci si trova sulla tabella Registrazioni, le righe vengono inserite alla
posizione del cursore.
Altrimenti sono inserite alla fine o alla posizione precedente se vanno a sostituire quelle già esistenti.

Prima di usare il comando
Assicurarsi che nelle Proprietà file  del menu File, sezione Moneta estera siano indicati i conti1.
utile e perdite di cambio, dove devono essere registrate le differenze di cambio. È possibile
indicare lo stesso conto sia per gli utili sia per le perdite di cambio.
Assicurarsi che i conti in moneta estera siano aggiornati e che il saldo in moneta estera di2.
questi conti (p.es. bancari) corrisponda al saldo indicato dalla banca.
Aggiornare i cambi correnti della tabella Cambi.3.

Cambi di chiusura:
Inserire il cambio di chiusura nella colonna Cambio, sulle righe senza data. È
importante non cambiare mai il cambio nella colonna Apertura, poiché questo è
stato utilizzato come cambio di apertura al 01.01, altrimenti cambierebbero i saldi
iniziali dei conti.
Se i cambi non vengono aggiornati nelle righe senza data, ci saranno delle
differenze di cambio nei saldi d'apertura del nuovo anno.
Per la chiusura è necessario usare i cambi ufficiali (vedi link che seguono al
prossimo paragrafo).

Cambi storici:
Puoi inserire una riga per il cambio a un certo momento.

Cambi ufficiali
Per le chiusure e per l'IVA si devono usare i cambi ufficiali indicati dall'autorità fiscale o dalla propria
banca nazionale.

Svizzera
Cambi per una precisa data .
Cambi medi mensili per l'IVA

Cambi d'apertura del nuovo anno
Per fare in modo che i saldi d'apertura del nuovo anno in divisa base corrispondano esattamente ai
saldi di chiusura dell'anno precedente i cambi d'apertura del nuovo anno, indicati nella tabella Cambi,
devono essere uguali a quelli usati per la chiusura, quindi:

https://www.ictax.admin.ch/extern/it.html#/ratelist/2021
https://www.estv.admin.ch/estv/it/home/imposta-sul-valore-aggiunto/rendiconto-iva/iva-corsi-delle-valute-estere/corsi-medi-mensili.html
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I cambi di chiusura devono essere indicati nella colonna Cambio delle righe senza data.
I cambi d'apertura devono essere indicati nella colonna Apertura delle righe senza data

La procedura di creazione nuovo anno o di ripresa saldi anno precedente, copia i cambi di chiusura
(colonna Cambio, righe senza data) dell'anno precedente nel cambi d'apertura (Tabella Cambi,
colonna Apertura, righe senza data) del file nuovo anno.

Differenze di cambio con i centri di costo
Il comando Crea registrazioni differenze di cambio non include eventuali differenze di cambio
presenti nei centri di costo in moneta diversa da quella della contabilità. Queste differenze devono
essere registrate manualmente a fine anno. La registrazione deve presentare unicamente l'importo in
divisa della contabilità; indicare dapprima questo importo, poi il centro di costo interessato e la
moneta del centro di costo. Al momento d'inserimento della moneta l'importo in divisa della
contabilità verrà cancellato e dovrà quindi essere reinserito.
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Preventivo

Nella Tabella Preventivo si inserisce la pianificazione finanziaria. L'inserimento delle registrazioni è
identico a quello della tabella Registrazioni.
A dipendenza del tipo di contabilità ci possono essere diverse colonne per il Preventivo.
Sono previste delle colonne anche per inserire Quantità e Prezzi e Formule di calcolo.

Per maggiori informazioni sul Preventivo, consultare la pagina Tabella Preventivo.
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Saldi iniziali | Contabilità Multimoneta

Saldi di apertura quando si inizia con Banana Contabilità
Quando si utilizza la prima volta Banana Contabilità, per creare il bilancio di apertura è necessario
inserire manualmente i saldi iniziali.

Prima di procedere con l'inserimento dei saldi iniziali è importante eseguire delle impostazioni
fondamentali:

Tabella Cambi

Nella tabella Cambi impostare le monete estere e il corrispondente cambio di apertura,
riferito alla moneta base.
Il cambio di apertura si inserisce solo la prima volta che si utilizza Banana Contabilità, poi negli
anni successivi, con la creazione del nuovo anno in automatico, tramite il menu Azioni → Crea
nuovo anno, viene aggiornato in automatico, in base al cambio finale del file dell'anno
precedente
Il cambio di apertura deve essere sempre indicato in una riga senza data e non deve essere mai
modificato, salvo errori o casi particolari.
I cambi di apertura devono essere uguali a quelli di chiusura dell'anno precedente. Vedi
Differenza saldi iniziali .

Tabella Conti

Assicurarsi che nel piano contabile (Conto Economico) sia presente il conto per registrare le
differenze di cambio e che questo sia stato indicato nel menu File → Proprietà File (Dati Base) →
Moneta estera.
I saldi iniziali devono essere inseriti nella tabella Conti, colonna Aper.moneta, vista Base, sia
quelli che si riferiscono alla moneta base, sia quelli in moneta estera.
La colonna Apertura (moneta base) è protetta.  Il programma calcola automaticamente il
controvalore in moneta base secondo il cambio di apertura indicato nella tabella cambi.
I saldi dei Passivi devono essere inseriti con il segno meno davanti all'importo.
Dopo aver inserito i saldi di apertura del bilancio, controllare che il totale Attivi sia uguale a
quello dei Passivi per avere la quadratura contabile. Nel caso ci siano delle differenze nei saldi
di apertura, occorre controllare e correggere.

Posizionarsi nella tabella Conti, vista Base, colonna Apertura.1.
Riportare manualmente i saldi iniziali dei conti Attivi e Passivi. I saldi Passivi vanno inseriti2.
con il segno meno davanti all'importo.
Controllare che il totale Attivi sia uguale al totali Passivi per avere la quadratura contabile. Nel3.
caso che ci siano delle differenze nei saldi di apertura, occorre controllare e correggere .

https://www.banana.ch/doc/it/contamsg_it_tot_teid11des
https://www.banana.ch/doc/it/contamsg_it_tot_teid11des
https://www.banana.ch/doc/it/contamsg_it_tot_teid11des
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Saldi iniziali di Centri di costo e Segmenti
Nella tabella Conti, la colonna Apertura può essere usata anche per inserire i saldi iniziali dei Centri
di costo.

Per inserire i saldi iniziali dei segmenti, si devono invece effettuare delle registrazioni di apertura.
Maggiori dettagli sono disponibili alla pagina Segmenti.

Iniziare con Banana Contabilità durante l'anno
Se iniziate a fare una nuova contabilità, riprendendo il lavoro già fatto con altri programmi, avete due
possibilità: 

Iniziare la contabilità da inizio anno, inserendo i saldi di apertura a inizio anno (tabella Conti,1.
colonna Apertura) e i movimenti (tabella Registrazioni) che sono già stati registrati in
precedenza con altri programmi (vedi anche Ripresa dati da altri programmi). In questo modo
avete tutti i dettagli contabili in un file unico.
Partire dalla data di quando viene ripresa la contabilità:2.

Inserire i saldi iniziali (tabella Conti, colonna Apertura), riprendendo i valori dell'altra
contabilità.
Oltre a inserire i saldi d'apertura dei conti Attivi e Passivi, bisogna riprendere anche quelli
dei Costi (importi in positivo) e dei Ricavi (importi in negativo).
Il risultato d'esercizio fino a quel momento deve essere indicato nel conto Utile/Perdite
riportate.
Se si tratta di un utile, il saldo iniziale è da inserire in negativo, se invece è una perdita in
positivo.
Verificare che le somme dei saldi iniziali sia a zero, affinché il programma non segnali
alcuna differenza.
Inserire i nuovi movimenti nella tabella Registrazioni.

 Saldi iniziali come registrazioni di apertura
I saldi iniziali possono essere inseriti anche come registrazioni di apertura nella tabella Registrazioni,
sia per tutti i conti di bilancio sia per alcuni categorie di conti, come quelli dei segmenti, che devono
essere registrati manualmente nella tabella Registrazioni.

Per ogni registrazione di apertura, proseguire come segue:

Indicare come data della registrazione, la data di inizio contabilità.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 472

Nella colonna TipoDoc, inserire il codice "01".
Indicare il conto in Dare o in Avere e l'importo.
Il totale dei saldi d'apertura in Dare devono compensarsi con quelli in Avere.

I saldi di apertura inseriti come registrazioni sono usati quando si preparano dei report.
Quando ci sono dei saldi iniziali nella colonna Apertura della tabella Conti e si registrano anche
manualmente i saldi di apertura di alcuni conti nella tabella Registrazioni (es. saldi iniziali segmenti),
questi vengono sommati in automatico a quelli presenti nella colonna Apertura della tabella Conti.

L'inserimento tramite registrazioni può essere utile se vi è la necessità di usare dei cambi di apertura
diversi da quelli della tabella cambi. Se si usa questa procedura, bisogna essere ben in chiaro quali
siano le implicazioni contabili e legali. 

Saldi anno precedente
Se iniziate una nuova contabilità, riprendendo una contabilità esistente, e volete che sulle stampe ci
siano anche i valori dell'anno precedente, è necessario inserire nella tabella Conti, vista
Precedente, colonna Anno Precedente, i saldi finali dell'anno precedente:

Inserire i saldi finali dell'anno precedente dei conti Attivi.
Inserire i saldi finali dell'anno precedente dei conti Passivi (inserire il segno meno davanti
all'importo).
Inserire i saldi finali dell'anno precedente dei Costi.
Inserire i saldi finali dell'anno precedente dei Ricavi (inserire il segno meno davanti all'importo).
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Chiusure | Contabilità multi-moneta

Alla fine dell'esercizio contabile, prima di passare al nuovo anno, oltre a verificare che non ci siano
errori e differenze nella contabilità, è necessario eseguire una serie di operazioni di chiusura. Queste
sono molto importanti perché oltre a dare una visione aziendale corretta e completa, hanno delle
implicazioni anche dal punto di vista fiscale.

Aspetti tecnici e nuovo anno
Con Banana Contabilità ogni anno contabile ha un proprio file separato, tecnicamente non c'è il
concetto di chiusura contabile:

Quando inizia un nuovo anno si crea un nuovo file con il comando Crea nuovo anno.
Si può continuare a lavorare contemporaneamente sia sul file dell'anno nuovo, sia su quello
dell'anno precedente. Una volta terminate le operazioni di chiusura, nel file del nuovo anno si
riprendono i saldi aggiornati, con il comando Aggiorna saldi iniziali.

Aspetti fiscali
Prima di chiudere la contabilità bisogna effettuare tutta una serie di operazioni che hanno implicazioni
fiscali. Bisogna assestare il conto merci, registrare gli ammortamenti, i ratei attivi e passivi, effettuare
le dichiarazioni dell'IVA, stabilire come e su quali conti deve essere ripartito l'utile ed effettuare tante
altre operazioni di verifica e controllo.

Dal punto di vista del programma, l'ammontare dell'utile è indifferente a fine anno, cambia invece
molto dal punto di vista fiscale. Questi aspetti devono essere verificati con il proprio fiscalista e
commercialista. La prima volta che gestisci una contabilità può essere utile, prima di procedere alle
chiusure, consultare un esperto per capire quali siano le esigenze. I commercialisti solitamente sono
molto impegnati tra la fine dell'anno e i mesi che precedono la scadenza del termine di presentazione
delle imposte; pertanto può essere utile trovarsi con il proprio commercialista o inviargli la contabilità
qualche mese prima della chiusura per sapere come procedere.

Comando controllo della contabilità
Banana Contabilità consente di registrare velocemente e anche di lasciare delle operazioni in sospeso
senza interrompere il proseguo del lavoro.

Il comando Azioni > Controlla contabilità esegue tutta una serie di verifiche, come se si inserissero
nuovamente i dati dall'inizio, e nel momento che vengono rilevati degli errori o delle differenze,
queste vengono segnalate.

Si consiglia di usare il comando Controlla contabilità con una certa regolarità e tutte le volte che ci
sono delle differenze o segnalazioni di errori, dei cambiamenti importanti (cambi iniziali, codici IVA) e
specialmente prima di chiudere la contabilità.

Operazioni di controllo e verifiche
Prima di stampare i bilanci definitivi è importante procedere con le operazioni di verifica:
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Verifica dei saldi di apertura

Differenze nei saldi di apertura
I saldi di apertura devono corrispondere a quelli dell'anno precedente e deve esserci il pareggio
tra i conti attivi e passivi, altrimenti la contabilità non è corretta.
Nella tabella Conti, nelle colonne Apertura e Saldo, alla riga "Differenza deve essere zero "
non ci deve essere alcun importo, altrimenti bisogna trovare l'errore e correggere per avere la
quadratura del bilancio iniziale.
Nota: nella vista Movimento, nelle colonne Dare e Avere, è normale che ci siano degli importi.
Differenze nei cambi di apertura
Di regola i cambi di apertura vengono impostati all'inizio dell'anno. Può capitare che alcune
verifiche siano state lasciate in sospeso; pertanto prima di chiudere la contabilità è importante
assicurarsi che:

il cambio a inizio anno sia uguale a quello finale del 31.12 dell'anno precedente,
Il cambio utilizzato sia quello fornito dall'Amministrazione Federale, come indicato qui di
seguito.

Differenze tra saldi bancari degli estratti conto e saldi contabili (funzione
CheckBalance).
È importante verificare la corrispondenza dei saldi bancari, postali, carte di credito e di altri
conti che hanno a che fare con le dichiarazioni fiscali.
Differenze nella tabella Registrazioni
Nella finestra informativa in basso non ci devono essere segnalazioni di differenze. Banana
Contabilità Plus, presenta nella tabella Registrazioni la colonna Saldo, che permette di rilevare
tutte le righe dove si vengono a creare delle differenze.
Assicurarsi che i transitori attivi e passivi dell'anno precedente risultino chiusi.
Verificare che i saldi di apertura siano conformi a quelli finali dell'anno precedente già
revisionati e dichiarati all'Ufficio di tassazione.
Per la contabilità multi-moneta si veda l'apposita pagina Saldi d'apertura contabilità multi-
moneta .
Spiegazioni dettagliate si trovano nella pagina Chiusure della contabilità in partita doppia .
Il comando Azioni > Controlla contabilità esegue tutta una serie di verifiche e segnala le
differenze e gli errori.

Registrazioni contabili di chiusura
A fine esercizio, prima di passare al nuovo anno, ci sono delle operazioni contabili di chiusura da
eseguire. Si tratta di registrazioni di assestamento, rettifiche di valore e conguagli relativi ai contributi
del personale. Qui di seguito ricordiamo le principali:

Importare i movimenti del conto cassa nel file della contabilità
Questa operazione è prevista solo nel caso in cui la cassa venga tenuta separatamente su un file
distinto dalla contabilità.
Dopo che l'importazione è avvenuta, verificare che il saldo del conto cassa nel file principale della
contabilità, sia corrispondente al saldo del file della cassa. Questa verifica si può effettuare anche con
la funzione Check Balance, descritta nel paragrafo precedente.

Importare i movimenti degli stipendi nel file della contabilità
Questa operazione è prevista solo nel caso in cui gli stipendi vengano gestiti con un gestionale
specifico che permette di importare i movimenti nel file di Banana Contabilità Plus.
L'importazione si esegue dal menu Azioni > Importa in contabilità > Importa movimenti con
intestazione colonne.

https://www.banana.ch/doc/it/contamsg_it_tot_teid11des
http://www.banana.ch/doc/it/node/9858
http://www.banana.ch/doc/it/node/9858
http://www.banana.ch/doc/it/node/3307
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Ricordarsi di inserire la registrazione della quota tredicesima di dicembre, se questa non viene creata
dal gestionale stipendi.

Assestamento conto Delcredere
Le aziende che registrano sul fatturato, se prevedono delle perdite presunte, devono assestare il
conto Delcredere.

Ammortamenti
Al 31.12 bisogna rilevare il deprezzamento dei beni mobili e immobili e valutare eventuale
l'ammortamento accelerato per quei beni soggetti a una rapida obsolescenza.
Puoi utilizzare il nostro applicativo Registro beni ammortizzabili che crea in automatico le registrazioni
di ammortamento e puoi riprenderli nel file della contabilità.

Assestamento magazzino
L'applicativo Magazzino permette di avere dei conteggi precisi sia per pezzi sia per valore, aiutandoti
a determinare più velocemente l'assestamento del tuo magazzino.

Rilevare le fatture dei clienti e dei fornitori aperti al 31.12
Per facilitare la procedura, con la funzione delle fatture aperte per cliente e fatture aperte per
fornitore puoi rapidamente rilevare i valori al 31.12.

Consumo proprio
Se nell'azienda vi è l'uso di un'auto aziendale, registrare il consumo proprio con il codice IVA
appropriato.

Chiusure e dichiarazione IVA
Prima di inoltrare la dichiarazione IVA, consigliamo le seguenti verifiche:

Utilizzare il comando Controlla Contabilità. In caso di errori e differenze trovi i messaggi nella
finestra informativa in basso, nella sezione Messaggi.
Verificare che nella colonna Saldo della tabella Registrazioni che non ci siano differenze.
Controllare i saldi bancari se sono corrispondenti a quelli inviati dalla banca.
Verificare che il conto IVA in automatico dopo aver stornato il saldo nel conto IVA dovuta (IVA da
pagare all'AFC) sia a zero. Nel conto IVA dovuta deve risultare l'importo da versare o l'importo a
credito da ricevere.
Prima di inoltrare l'ultima dichiarazione IVA, visualizzare nuovamente i rendiconti IVA degli altri
trimestri per controllare che gli importi versati all'AFC siano ancora corrispondenti a quelli
visualizzati.
Utilizzare il comando del Riassunto IVA per visualizzare i vari report e creare una stampa in PDF
per l'archiviazione dei dati. In caso di controlli fiscali saranno utili.

Assestare il conto Imposte alla fonte
Dopo aver conteggiato e registrato gli stipendi di dicembre, in base al conteggio inviato all'Ufficio
imposte alla Fonte, registrare l'assestamento.

Rimborsi per quadri superiori
Se previsti, nello stipendio di dicembre includere l'importo previsto dalle autorità fiscali come
rimborso forfettario.

Assestamento conto Privato
Verificare il saldo del conto privato. In caso di rapporti di debito/credito fra l’azienda e il/i proprietario/i
(o persone vicine) registrare gli interessi attivi o passivi secondo quanto previsto dal contratto di
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prestito o secondo le direttive fiscali vigenti.

Assestamento conto Imposte e tasse
Verificare che gli acconti pagati durante l'anno si riferiscano all'anno in corso. I pagamenti di imposte
che concernono anni precedenti, bisogna registrarli a chiusura dei relativi accantonamenti che
risultano nel conto “Imposte dirette” (patrimoniale). Se il saldo degli accantonamenti non è sufficiente
o è eccessivo, la differenza deve essere registrata come costo/ricavo straordinario o relativo a periodi
precedenti.

Registrazione conguagli AVS/AD/IPG/AD

Durante l'anno, nel conto dei contributi AVS, solitamente vengono registrati gli acconti pagati
alla Cassa Cantonale di Compensazione AVS (in Dare) e le quote trattenute sugli stipendi ai
dipendenti (Avere).
Se durante l’anno gli assegni familiari pagati ai dipendenti sono stati registrati in un conto
dedicato, per esempio nel conto “Contributi assegni familiari”, per riconciliare la contabilità con
il conteggio di chiusura AVS e registrare il relativo assestamento si può girare il saldo di questo
conto sul conto Contributi AVS/AD.

Registrare i conguagli previdenziali Lainf, Lainf complementare, LPP
Con la registrazione degli ultimi stipendi di dicembre e il pagamento delle tredicesime, occorre
stampare la lista degli stipendi con l'indicazione di tutti gli stipendi lordi. Il lordo complessivo AVS devi
comunicarlo alle assicurazioni del personale, che determineranno eventuali conguagli da pagare.

Nella contabilità multi-moneta, come per la contabilità in partita doppia, prima di passare al nuovo
anno, sono necessarie delle operazioni contabili di chiusura. Si tratta di registrazioni di assestamento,
rettifiche di valore e conguagli relativi ai contributi del personale.

Alla pagina Chiusure nella contabilità in partita doppia sono elencate le operazioni di chiusura sia ai
fini contabili, sia fiscali.

Qui di seguito vengono trattate le tematiche relative alle registrazioni di chiusura per le differenze di
cambio.

Cambi di fine esercizio e utili/perdite non realizzati
Per ottenere il bilancio, i conti in moneta estera devono essere convertiti in moneta base al cambio
del momento o a quello storico. La variazione dei cambi porta a degli utili o perdite di cambio non
realizzate. Queste devono essere registrate con il seguente comando dal menu Azioni:

Crea registrazioni differenze di cambio.
Si rimanda a questa pagina per tutta la tematica dell'impostazione dei cambi e calcolo
degli utili e perdite non realizzate.
Si ricorda che i cambi di chiusura devono essere inseriti nella tabella Cambi nelle
righe dei cambi senza data. Questi cambi vengono ripresi dal programma per il calcolo
dei saldi d'apertura del nuovo anno. Se vengono inseriti dei cambi con delle date, vi
saranno differenze nei saldi d'apertura del nuovo anno.
Se nella tabella Cambi ci sono delle righe con la data (storico cambi), alla chiusura della
contabilità, per il calcolo delle differenze di cambio, si consiglia di non attivare l'opzione
Usa cambi storici (righe con data), affinché il programma utilizzi come cambio di chiusura,
quello aggiornato che si trova all'inizio della tabella cambi, nelle righe senza data
(colonna Cambio).
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Dopo la rilevazione delle differenze di cambio, i saldi in moneta base risultano attualizzati in base al
cambio di chiusura, inserito nella tabella Cambi (righe senza data). Nel piano contabile, i saldi
presenti nella colonna Saldo sono uguali a quelli della colonna Saldo Calcolato.

Inviare il file al commercialista per le chiusure
Se le chiusure e/o le verifiche vengono eseguite dal tuo fiduciario, basta inviare il file della tua
contabilità creato con Banana Contabilità Plus per email oppure salvare i dati su una chiavetta USB.

Se il tuo fiduciario ha Banana Contabilità, basta trasmettere il file ac2 per email o tramite
chiavetta usb. Puoi anche salvare il tuo file e i documenti digitali in una cartella condivisa con il
tuo fiduciario su Dropbox. Non dovrai più portare dal fiduciario pesanti classeurs per la
documentazione cartacea. Inoltre, il fiduciario lavorerà velocemente senza dover andare a
cercare nella documentazione cartacea.
Se non possiede Banana Contabilità puoi creare un PDF dei dati contabili, tramite il menu File >
Crea dossier PDF e trasmettere per email la documentazione. Il fiduciario ti indicherà tutte le
modifiche e aggiunte da registrare per chiudere correttamente l'esercizio contabile.
In alternativa, il tuo fiduciario può aprire il file della tua contabilità usando il piano  Free di
Banana Contabilità Plus, scaricandolo dalla nostra pagina di Download . Se il tuo file ha più di
70 registrazioni non potrà aggiungere registrazioni o fare modifiche, ma potrà comunque
vedere tutti i dati, ottenere il dettaglio di ogni conto con un semplice click sopra il numero di
conto, ecc. e consigliarti su possibili correzioni o miglioramenti.

Blocco delle registrazioni
Una volta eseguite le registrazioni di chiusura e di verifica, è consigliato di bloccare le registrazioni.

Azioni > Blocca registrazioni .
Le righe di registrazione saranno numerate e avranno un codice blockchain che ne garantisce la
sicurezza.

Stampe di fine anno
Per le stampe di fine esercizio contabile trovi le informazioni, cliccando sui seguenti link:

Schede conto
Libro giornale
Bilancio abbellito con gruppi

Guarda il video tutorial  che mostra come creare e stampare il bilancio abbellito con
gruppi.

Report contabile
Riassunto IVA
Stampe in PDF di fine anno

Dossier PDF
Il comando Creare dossier PDF ti permette di avere tutti i documenti dell'intero esercizio contabile
(schede conto, giornale, rendiconti IVA, report mensili, trimestrali e annuali...) in un unico file PDF.

Puoi archiviare i dati contabili, salvando il file della contabilità e le stampe in PDF. Eventualmente, fai
delle copie di sicurezza su un'unità di disco esterno.

http://www.banana.ch/it/download
http://www.banana.ch/doc/it/node/3353
https://www.banana.ch/it/node/11490
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Documentazione per la revisione
Alla pagina Preparare la documentazione per la revisione abbiamo pubblicato una serie di appunti e
suggerimenti sulla documentazione da inviare al revisore. La completezza della documentazione è
una buona base per rendere il lavoro del revisore più efficiente e veloce.

Ripartizione utile/perdita
In Banana Contabilità, la ripartizione dell'utile o della perdita, avviene in automatico al passaggio del
nuovo anno. Per maggiori informazioni consultare la pagina Aggiorna saldi iniziali.
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Stampe

Tutte le stampe del Bilancio, del Conto economico, e dei vari Report contabili sono disponibili dal
menu Report. Ogni comando dispone di varie opzioni per la personalizzazione delle varie stampe.

Le stampe hanno le stesse caratteristiche della contabilità in partita doppia, ma con la visualizzazione
delle colonne e dei valori delle monete estere, cambi e controvalori in moneta base.

Principali stampe disponibili:

Scheda conto
Bilancio abbellito
Bilancio abbellito con gruppi
Report contabili
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Scheda conto contabilità multi-moneta

Colonne della scheda conto
Nella scheda conto ci sono tre gruppi di colonne. Nelle intestazioni delle colonne movimento dare,
avere e riporto, sono indicate le  sigle delle rispettive monete.

Moneta base
Sono indicati il saldo d'apertura, i movimenti e il saldo nella moneta base.
Moneta del conto
Sono indicati i movimenti nella moneta del conto.
Nel caso di conti in moneta base questi valori sono uguali a quelli della moneta base. 
Moneta 2
I movimenti del conto sono convertiti nella Moneta 2. La logica di conversione degli importi
dipende dalla moneta del conto, vedi Conversione in moneta 2 nella pagina Proprietà file Multi-
moneta.
Per la scheda conto gli importi dei i movimenti sono converti con la seguente logica:

Per le righe d'apertura o di riporto viene convertito il saldo del conto. 
Per i movimenti

Sono convertiti gli importi dare, avere in Moneta 2.
Il saldo del conto in Moneta 2 viene calcolato sommando gli importi in Moneta 2
risultati dalle conversioni.
È possibile che il saldo finale del conto in Moneta 2, non sia uguale al saldo del
conto in moneta, convertito in Moneta 2. Si veda a riguardo di possibile differenze di
arrotondamento la pagina tematiche cambi .

Moneta dell'operazione.
Non è visibile se non è uguale alla moneta del conto o non è in moneta Base. Se su un
conto si registra in una moneta diversa di quella del conto, ma uguale alla Moneta 2, gli
importi in Moneta 2 non saranno quelli originali, ma quelli convertiti dalla moneta base.

Viste scheda conto
Nella scheda conto multimoneta ci sono diverse viste, ognuna delle quali visualizza contestualmente
determinate colonne. Passando da una vista all'altra variano le colonne.

È possibile modificare la disposizione delle colonne e creare ulteriori viste. Maggiori dettagli sulle viste
sono disponibili al seguente link: Disponi tabelle.

Modifica dei dati
Nella scheda conto non è possibile modificare i dati. Cliccando sul numero di riga (sottolineato) si
ritorna alla riga della tabella di origine (Registrazioni o Budget) dove è possibile modificare i dati .
Maggiori informazioni sono disponibili alla pagina Schede conto (paragrafo Aggiornare la scheda
conto).

Finestra Info
In basso nella finestra info vengono indicati i valori dei conti relativi alla registrazione su cui ci si

https://www.banana.ch/doc/it/cambi_problematiche_contabili_6


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 481

trova.

Numero di conto
Descrizione conto
Importo registrazione sul conto in moneta base
Saldo attuale del conto in moneta base
Sigla moneta del conto
Importo registrazione sul conto in moneta del conto
Saldo attuale del conto in moneta del conto
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Bilancio abbellito contabilità multi-moneta

Il bilancio abbellito nella contabilità multi-moneta si esegue come quello della contabilità in partita
doppia. Le informazioni sono disponibile al seguente link: Bilancio abbellito.

La differenza consiste nel fatto che i conti in valuta estera riportano sia gli importi in moneta estera
sia quelli convertiti in moneta base.
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Bilancio abbellito con gruppi contabilità
multi-moneta

Il bilancio abbellito con gruppi nella contabilità multi-moneta si esegue come quello della contabilità in
partita doppia. Le informazioni sono disponibile al seguente link: Bilancio abbellito per gruppi.

Guarda il video tutorial  che mostra come creare e stampare il bilancio abbellito con gruppi.

La differenza consiste nel fatto che i conti in valuta estera riportano sia gli importi in moneta estera
sia quelli convertiti in moneta base.

https://www.banana.ch/it/node/11490
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Report contabili contabilità multi-moneta

I report contabili nella contabilità multimonta si eseguono come quelli della contabilità in partita
doppia. Le informazioni sono disponibili alle seguenti pagine web: Report contabile; Report contabile
esterno.
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Nuovo anno | Contabilità multi-moneta

Prima di passare al nuovo anno assicurarsi di aver effettuato tutti i controlli, le verifiche e le
registrazioni di chiusura come indicato nelle seguenti pagine

Chiusure della contabilità in partita doppia.
Chiusure nella contabilità multi-moneta per la problematica dei cambi.

Tutte le informazioni contabili relativi all'apertura del nuovo esercizio sono presenti nella pagina

Crea nuovo anno della contabilità in partita doppia.

Qui di seguito ci limiteremo a dare le informazioni inerenti alle problematiche dei cambi nella
contabilità multi-moneta.

Creazione nuovo esercizio contabile
Quando si passa al nuovo esercizio contabile, il programma riporta in automatico i saldi di apertura
nell'anno successivo. Maggiori dettagli sono disponibili alla pagina Crea nuovo anno.

Anche nella contabilità multi-moneta si può decidere di passare al nuovo anno, anche se non si è
chiuso definitivamente l'anno precedente (perché devono essere ancora fatte delle registrazioni, non
sono state ancora calcolate le differenze di cambio, oppure non è stato ripartito il risultato
d'esercizio).
È importante però che prima di chiudere definitamente l'anno, nell'esercizio che si sta per chiudere
vengano calcolate le differenze di cambio, dal menu Azioni → Calcola differenze di cambio .

Successivamente, nel nuovo esercizio già creato in precedenza, si possono attualizzare i saldi di
apertura dal menu Azioni → Aggiorna saldi iniziali.

Differenze nei saldi iniziali
Nel caso in cui nel nuovo esercizio contabile ci fossero delle differenze nei saldi iniziali, consigliamo di
effettuare tutte le verifiche e i controlli suggeriti nella pagina Controlli e verifiche.

Se le differenze sono dovute a delle differenze dei cambio non calcolate nell'esercizio precedente,
seguire le indicazioni alla pagina Differenze nei saldi iniziali.

Stampa saldi iniziali
Per stampare i saldi iniziali:

Per stampare il contenuto della Tabella usare il comando Stampa/Anteprima, selezionando le
righe del bilancio.
Si possono usare anche le Stampe contabili e impostare la stampa solo per la parte del Bilancio
e la colonna apertura.

http://www.banana.ch/doc/it/node/7176
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Differenze saldi iniziali | Contabilità
Multimoneta

Nelle contabilità che includono dei conti in moneta estera, prima di procedere con alla chiusura
dell'esercizio contabile, è necessario registrare le differenze di cambio.

Attenzione
Se le differenze di cambio non vengono registrate, all'apertura del nuovo anno (dal menu Azioni >
Crea nuovo anno), o quando si aggiornano i saldi iniziali (dal menu Azioni > Aggiorna saldi iniziali), il
programma segnala una differenza nei saldi iniziali nel nuovo esercizio contabile.

Per ovviare a questa problematica ci sono due possibili soluzioni:

Nel caso in cui l'esercizio contabile non sia stato ancora chiuso in modo definitivo (e se1.
previsto anche revisionato):

Inserire nella tabella Cambi, colonna Cambio, nelle righe dei cambi senza data, i cambi
ufficiali al 31.12 (oppure i cambi di chiusura previsti dallo statuto della società).
Attivare dal menu Azioni > Crea registrazioni differenze di cambio.
Aprire il file dell'anno nuovo e Aggiornare i saldi iniziali.
 

Nel caso in cui l'esercizio contabile sia stato chiuso in modo definitivo (e se previsto2.
anche revisionato):

Aprire il file del nuovo esercizio appena creato.
Inserire negli Attivi o nei Passivi (tabella Conti), in caso di una differenza di cambio
positiva o negativa, un nuovo conto Differenze di cambio non calcolate, oppure
semplicemente registrare l'importo nel conto 1090 Conto di trasferimento (come
nell'esempio sottostante).
Nella colonna Apertura moneta inserire l'importo corrispondente alla differenza di
cambio.

http://www.banana.ch/doc/it/node/7176
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Nella contabilità del nuovo esercizio, nella tabella Conti, colonna Apertura moneta, si è così
generato un saldo relativo alle differenze di cambio che deve essere assestato.
Per assestare la differenza si procede come segue:

Nella tabella Registrazioni, al 1° di gennaio (oppure nella data di apertura prevista
statuariamente) si deve registrare l'importo della differenze di cambio nel conto
Differenze di cambio non calcolate o come nell'esempio nel conto 1090 conto di
trasferimento, usando come contropartita il conto differenze di cambio (Utili e/o perdite di
cambio) presente nel conto economico.

Dopo la registrazione di assestamento delle differenze di cambio, il conto utilizzato deve avere saldo
0, o pari ad un importo corrispondente al saldo prima della registrazione delle differenze di cambio.

Nel caso in cui si trattasse di un utile di cambio, l'importo della differenza deve essere inserito in un
conto dei passivi, oppure negli attivi, ma con il segno meno davanti all'importo.

  

Questo importo, che inizialmente grava sul Conto Economico del nuovo esercizio, viene poi annullato
alla prima operazione di aggiornamento dei cambi che potrebbe essere fatta in base alle proprie
esigenze nel corso dell’anno. Ciò non fosse, nel caso di aggiornamento dei cambi solo a fine esercizio,
la posizione del conto Utili e/o Perdite di Cambio verrebbe comunque correttamente adeguata.

Attenzione:
Nel caso di aggiornamento dei cambi solo alla chiusura dell’esercizio, il Bilancio e Conto Economico
intermedi sarebbero “influenzati” dall’importo della Differenza di Cambio relativa all’assestamento
dell’Apertura.
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Contabilità con criptovalute

Banana Contabilità permette di gestire la contabilità in qualsiasi moneta, comprese le criptomonete
Bitcoin, Ethereum, ...., e le ICO (Initial Coin Offering) con qualsiasi sigla. Ogni moneta può avere fino 
a 27 decimali e cambi impostati liberamente.
In questo modo si hanno sempre valori ed estratti conti esatti.
Si può tenere la contabilità in qualsiasi moneta base, EUR, US$, Bitcoin e gestire conti in qualsiasi
moneta.

Singola moneta o più monete
Quando si inizia a tenere una contabilità bisogna decidere se si vuole usare una sola moneta o se si
ha necessità di gestire conti in diverse monete.
Il Cash Manager e la contabilità Entrate / Uscite di Banana Contabilità permettono di gestire una sola
moneta alla volta, mentre la Contabilità in partita doppia multi-moneta permette di gestire conti in più
monete. 

Nelle Proprietà file (Dati base) della contabilità, si specifica la moneta base. Il programma propone
una lista di monete predefinite, e si può scegliere quale moneta indicare.

Nella contabilità multi-moneta gli importi sono indicati nella moneta del conto e nella moneta base.
Gli importi in moneta base possono essere sommati assieme e pertanto servono per preparare il
bilancio, il conto economico e tutti i diversi report.

Se si imposta una contabilità multi-moneta, nella Tabella Cambi si indicano tutte le monete che
servono, con il relativo tasso di cambio rispetto alla moneta base. Puoi gestire monete nazionali o
criptovalute, senza limitazione alcuna, usando qualsiasi sigla.

Cambiare il numero di decimali della contabilità
Per evitare differenze di arrotondamenti, il numero di decimali della contabilità viene definito al
momento della creazione del file. Tutti gli importi sono arrotondati allo stesso modo e si evitano così
differenze di arrotondamento, come spesso capita con Excel.

Quando si inizia una nuova contabilità è meglio partire da un modello esistente, che generalmente è
impostato con 2 decimali.
Se si gestisce una contabilità o dei conti con un numero di decimali maggiori, bisogna convertire il file
con il seguente comando:

Menu Strumenti → Converti in nuovo file

Il programma crea una copia del file con dei nuovi Parametri creazione nuovo file, in questa fase si
può indicare il numero di decimali appropriato. Per le contabilità multi-moneta si indicano:

Il numero di decimali per importi in moneta base.
Il numero di decimali per importi in moneta estera.

http://www.banana.ch/doc/it/node/1723
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Impostare il numero di decimali per importi in moneta
estera
Quando si imposta una contabilità in partita doppia multi-moneta occorre indicare l'arrotondamento
per gli importi in moneta estera.
Il numero di decimali in moneta estera generalmente non deve essere minore del numero di decimali
in moneta base.
Se si gesticono delle criptovalute come ETH, quando si converte il file, bisogna indicare il valore 18.

Le diverse sigle delle monete devono essere indicate nella tabella Cambi, con il relativo cambio di
apertura e il cambio corrente.

Per ogni conto, definito nella tabella Conti, si indica la sigla della moneta.

Nella colonna Importo Moneta gli importi sono visualizzati con il numero di decimali massimo, anche
per le monete che non usano così tanti decimali. Se si vuole avere un numero minore di decimali,
impostare nel formato della colonna il numero di decimali che si desiderano. Per esempio con
"0.00000" visualizza solo 6 decimali.

Monete e numero di decimali
Nella relativa pagina di wikipedia trovi le sigle delle diverse monete  con il numero di decimali usato.

Generalmente le monete usano 2 decimali.
Monete con 0 decimali:

BIF Burundian Franc
CLP Chilean peso
DJF Djiboutian franc
GNF Guinean franc
ISK  Icelandic króna
JPY Japanese yen
KRW South Korean won
PYG  Paraguayan guaraní
RWF Rwandan franc
UGX  Ugandan shilling
UYI  Uruguay Peso en Unidades Indexadas
VUV  Vanuatu vatu

https://en.wikipedia.org/wiki/ISO_4217
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XOF CFA franc BCEAO
XPF CFP franc (franc Pacifique)

Monete con 3 decimali:
BHD Bahraini dinar
IQD Iraqi dinar
JOD Jordanian dinar
KWD Kuwaiti dinar
LYD Libyan dinar
TND Tunisian dinar

Monete con 4 decimali
UYW Unidad previsional

Criptomonete

C'è una moltitudine di criptomonete, ciascuna con il proprio nome e sigla .

Non vi è l'indicazione del numero di decimali. Le più conosciute sono:

BTC Bitcoin con 9 decimali
ETH  Ethereum 18 decimali
Molte altre monete virtuali sono basate sull'Ethereum blockchain, e necessitano di 18 decimali.

Nella finestra di dialogo dei Parametri per la creazione di un nuovo file (vedi sopra), indica il numero
di decimali appropriato per la moneta base che desideri.

https://github.com/crypti/cryptocurrencies
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La Contabilità Entrate / Uscite

La Contabilità Entrate e Uscite di Banana Contabilità Plus gestisce in modo semplice e veloce
professionale le entrate e le uscite su diversi conti. Pur essendo intuitiva è comunque di livello
professionali, in quanto basata sullo stesso motore di calcolo della contabilità in partita doppia. Si
ottengono quindi facilmente bilanci, rendiconti entrate e uscite e consente anche di gestire centri di
costo e profitto, segmenti, previsioni finanziarie e molto altro. 

Ideale per chi si avvicina alla contabilità
Aiuta a capire la contabilità, infatti riescono a tenere la contabilità anche persone che pensano di non
essere in grado.  

Imprese di piccole dimensioni, per semplificare la gestione delle finanze ed avere rendiconti
professionali.
Liberi professionisti e autonomi, per monitorare le loro entrate e uscite in maniera più
intuitiva e immediata.
Associazioni, Curatele e altri enti non profit, per tenere la contabilità lavorando
velocemente, grazie a tante funzioni che automatizzano molti processi di lavoro, ottenendo
rendiconti chiari e precisi.
Contabilità ausiliarie di progetti o immobili, per tenere la contabilità di cantieri, progetti,
affitti o altro.
Famiglie, per tenere traccia delle spese e delle entrate e gestire il bilancio e il budget
familiare.

Come iniziare con la Contabilità Entrate / Uscite
Per un avvio facile e immediato consulta le nostre risorse:

▶ Video: Come iniziare una Contabilità Entrate/Uscite
Guarda i modelli Entrate / Uscite disponibili

Puoi aprire il modello che più si avvicina alla tue esigenze e creare fin da subito il file per la tua
contabilità. Inserisci i saldi iniziali e sei già operativo. Per maggiori informazioni visita la pagina
generica di Come iniziare con Banana Contabilità Plus.

La tabella Registrazioni
La tabella Registrazioni è il fulcro della tenuta contabile delle Entrate / Uscite.

Nella tabella Registrazioni inserisci i movimenti in entrata e uscita. L'inserimento è estremamente
facile e intuitivo, anche per chi non ha conoscenze contabili. 

https://www.banana.ch/it/node/11352
https://www.banana.ch/apps/it?combine=&langcode=it&country=All&category=All&type=241&publisher=All&op=Invia#
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Basata su Entrate e Uscite: la struttura delle tabelle ha delle colonne dove i dati appaiono ordinati
ed omogenei. Le colonne e le funzioni sono personalizzabili; si possono evidenziare le righe e grazie
all'innovativa funzione del Filtro puoi trovare subito i dati, modificare e correggere. 

Ci sono delle colonne principali, già predefinite, in cui inserire:

La data della registrazione
Eventuale nr. di documento
L'importo in entrata o in uscita
Il conto su cui è avvenuto il movimento (cassa, banca, posta, cliente o fornitore).
La categoria o meglio il motivo dell'entrata o l'uscita

Inserimento di allegati digitali: nella tabella Registrazioni puoi rendere visibile anche la colonna
DocLink, che ti permette di aggiungere lo scontrino o la fattura ad ogni movimento in formato PDF,
garantendo la disponibilità immediata dei documenti in caso di verifiche future o per trasmetterli al
commercialista.

Veloce inserimento delle Registrazioni: per velocizzare l'inserimento delle registrazioni puoi
utilizzare diverse funzioni: dall'Immissione dati con autocompletamento, alle Registrazioni ricorrenti,
l'importazione dei movimenti bancari o anche l'impostazione di Regole per l'importazione automatica

. In un batter d'occhio hai la contabilità completa e puoi dedicare maggiormente all'attività
produttiva della tua azienda.

Categorizzazione entrate e uscite: i movimenti vengono assegnati a specifiche categorie o classi
di spesa e guadagno. Questo aiuta a organizzare e analizzare le informazioni finanziarie in modo più
semplice.

Contabilità senza differenze: la colonna Saldo è una funzione utilissima, ti permette di vedere
all'istante eventuali differenze.
Per usare la colonna Saldo la devi rendere visibile tramite il menu Dati > Disponi colonne.

Tipologie di registrazioni
Come per qualsiasi tipo di file, anche nelle Entrate / Uscite sono possibili le seguenti tipologie di
registrazioni:

Registrazioni semplici, eseguite su di una sola riga
Registrazioni composte, eseguite su più righe
Registrazioni con IVA, possibili nella Contabilità Entrate / Uscite con IVA 

https://www.banana.ch/doc/it/rules
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Creare le fatture 
Anche nella Contabilità Entrate / Uscite, nonostante la sua semplicità, puoi generare le fatture da
inviare ai tuoi clienti. Puoi stampare le fatture con codice QR (per la Svizzera) o senza (altre nazioni).

Bastano pochi passaggi per creare le tue fatture:

Nella tabella Conti, imposti la lista dei tuoi clienti, e per ogni clienti inserisci tutti i dati
(indirizzo, nazione, lingua..).
Nella tabella Registrazioni, inserisci i dati delle fatture. Completando anche i dati nella
colonna Conto (nr. di conto ) e nella colonna Categoria (nr. di categoria), non solo puoi creare
e stampare la fattura, ma allo stesso tempo l'hai già contabilizzata.

Ulteriori gestioni
Il programma ti consente anche di aggiungere ulteriori dati nelle registrazioni, in modo che gli stessi
dati ti servano anche per:

Gestione IVA
Controllo dei Clienti e Fornitori
Centri di costo e Segmenti per avere rendiconti per progetti o settori d'attività.
Preventivo

Report e Stampe
Dopo ogni registrazione, il programma aggiorna in automatico tutti i saldi dei Conti e delle
Categorie.

Puoi ottenere rendiconti precisi e di facile comprensione, schede conto e categorie, giornale e
previsioni.

Dal menu Report > Rendiconto abbellito o Rendiconto abbellito con gruppi, ottieni i tuoi
rendiconti in un attimo. Sono anche possibili Rendiconti per periodo.

Il Rendiconto abbellito visualizza tutti i conti e le categorie senza gli eventuali sottogruppi
Il Rendiconto abbellito con gruppi visualizza tutti i conti e le categorie anche con i sottogruppi

https://www.banana.ch/apps/it/node/9718
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Ulteriori stampe 

Dal menu Report sono possibili le seguenti stampe:

Libro giornale
Schede conto
Report contabile

Archivio dati in PDF
A fine anno, quando tutta la contabilità è stata completata, corretta e revisionata, puoi archiviare tutti
i dati contabili con il comando dal menu File > Crea dossier in PDF .

Differenze rispetto alla contabilità in partita doppia
Nella contabilità in partita doppia tutti i conti sia patrimoniali che del conto economico si trovano
unicamente nella tabella Conti. Nella contabilità Entrate / Uscite, per rendere più semplice e intuitivo
l'uso, i conti sono stati strutturati su due tabelle:

Tabella Conti - elenco dei conti patrimoniali:
I propri averi sono indicati in positivo
I debiti sono indicati in negativo
Il patrimonio netto è calcolato come differenza fra gli averi e i debiti.

Tabella Categorie - elenco dei conti per le spese e le entrate:
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Le voci di spesa sono in negativo
Le voci di entrata sono in positivo
L'utile o la perdita sono calcolati come differenza fra i valori positivi e negativi. 

Le Registrazioni

Tutti i movimenti giornalieri sono inseriti nella tabella Registrazioni, sia per la contabilità in partita
doppia sia in quella Entrate / Uscite. Tra le due contabilità esiste però una sostanziale differenza nelle
colonne, ovvero:

Nella contabilità Entrate / Uscite ci sono due colonne specifiche:
Conto - dove vengono registrati i conti patrimoniali che hanno dei movimenti in base alle
spese sostenute o alle entrate ricevute.
Categoria - dove vengono registrati le categorie di spesa e di entrata. È possibile avere
anche un conto quando si tratta di giroconti bancari e postali.

Nella contabilità in Partita doppia ci sono le seguenti colonne specifiche:
Dare - dove si registrano gli aumenti di attivi e diminuzioni di passivi e i costi.
Avere - dove si registrano le diminuzioni di attivi e gli aumenti dei passivi e i ricavi.
 

Informazioni comuni alla contabilità doppia
Nelle pagine della documentazione Entrate e Uscite trovi informazioni dettagliate e specifiche. Per
tutte le funzioni di carattere generale si rimanda alla documentazione della contabilità in partita
doppia. In particolare:

Aggiungere, rinominare o cancellare un conto
Inserire raggruppamenti
Ricalcola contabilità
Blocca registrazioni
Crea nuovo anno

Esempi di modelli Contabilità Entrate / Uscite
Qui di seguito i modelli più usati:

Contabilità per famiglia | Entrate / Uscite  (Svizzera)
Contabilità per curatela | Entrate / Uscite  (Svizzera)
Libero professionista | Contabilità Entrate / Uscite  (Svizzera)
Enti Terzo Settore con Rendiconto di Cassa | Entrate / Uscite  (Italia)
Enti Terzo Settore con Rendiconto di Cassa - Solo conti Liquidità | Entrate / Uscite (Italia)
Bilancio familiare e Conti di casa | Entrate e Uscite (Universale)
Contabilità/Preventivo Ristorante | Entrate / Uscite  (Universale)

https://www.banana.ch/apps/it/node/9439
https://www.banana.ch/apps/it/node/8246
https://www.banana.ch/apps/it/node/4967
https://www.banana.ch/apps/it/node/9431
https://www.banana.ch/apps/it/node/9435
https://www.banana.ch/apps/it/node/9105
https://www.banana.ch/apps/it/node/9066
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Tabella Conti - Contabilità entrate e uscite

La tabella Conti presenta la situazione patrimoniale, dove si inseriscono:

I conti patrimoniali, compresi eventuali conti dei clienti, fornitori.
I gruppi di totalizzazione.
Nell'esempio che segue, nella tabella Conti, tutti i conti sono raggruppati nel Gruppo 1 (Totale
patrimonio). I conti attivi vengono sommati ai conti passivi e la differenza determina il
Patrimonio netto.
Per maggiori informazioni sul sistema di raggruppamento, si rimanda alla pagina Gruppi della
Contabilità in partita doppia. 
I saldi d'apertura.

Nella tabella Conti vengono visualizzati i saldi dei conti, le colonne dei movimenti in entrata e uscita
e il preventivo. Si ha quindi una visione immediata e costantemente aggiornata della situazione
patrimoniale. I valori patrimoniali attivi sono indicati in positivo, quelli passivi (i debiti) sono in
negativo.

Le colonne della tabella Conti
Qui di seguito vengono elencate le principali colonne della tabella Conti. La visualizzazione delle
colonne cambia in base alla Vista selezionata.

È possibile aggiungere delle colonne supplementari sia di sistema sia colonne proprie tramite il menu
Dati > Disponi colonne.

Sezioni
Si inserisce un asterisco per il cambio di sezione. Ad esempio per distinguere il Totale patrimonio dai
centri di costo.
I valori inseriti nella tabella Sezioni sono fondamentali per la presentazione del Bilancio abbellito con
gruppi.
Maggiori dettagli sulle Sezioni sono disponibili alla pagina web Sezioni.
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Gruppo 
Vengono inseriti dei valori che totalizzano le categorie che hanno lo stesso raggruppamento nella
colonna Somma in. Sono fondamentali per la totalizzazione.

Conto
Si inserisce il numero o sigla del conto da gestire (cassa, banca, posta).

Descrizione
Si inserisce una descrizione relativa al conto inserito. Questa descrizione viene ripresa in automatico
nella colonna Descrizione conto della tabella Registrazioni (se visualizzata).

Somma in (Gr)
Si indica il codice di un gruppo in modo che il programma totalizzi l'importo della riga nel gruppo.
L'intestazione "Somma in" è stato adottato con la versione Banana Plus.
Il nome della colonna è rimasto Gr, per mantenere la compatibilità con le versioni precedenti del
programma.

Apertura
Solo la prima volta che si usa un file nuovo o si usa per la prima volta Banana contabilità, occorre
inserire il saldo di apertura. All'inizio del nuovo anno con l'apertura in automatico, i saldi dei conti
viene aggiornato automaticamente.

Entrate
La colonna è protetta e riporta il saldo delle registrazioni in entrata. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Uscite
La colonna è protetta e riporta il saldo delle registrazioni in uscita. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Saldo
La colonna è protetta e riporta il saldo complessivo tra le entrate e le uscite. Dopo ogni registrazione il
saldo è aggiornato in automatico

Sezioni

Le Sezioni  presenti nella tabella conti e/o categorie permettono di definire un insieme di conti e
categorie che si desiderano stampare tramite il comando Report > Rendiconto abbellito con
gruppi.

Le sezioni sono indicate nella colonna sezioni della tabella conti e della tabella categorie
Un * (asterisco) indica l'inizio della sezione
Un ** (doppio asterisco) indica l'inizio di una sottosezione.
Un # indica l'inizio della sezione note
Una sezione finisce quando ne inizia un'altra
A differenza della contabilità in partita doppia non si possono usare sezioni di tipo numerico
Se non è stata indicata alcuna sezione, la prima volta che si usa il comando, il programma la
inserirà in automatico

Nella tabella Conti "Situazione Patrimoniale"
Nella tabella Categoria "Risultato operativo"

È utile creare delle sezioni separate se si hanno dei centri di costo, segmenti oppure dei
partitari clienti o fornitori.
In questo modo si possono stampare dei rapporti solo di quello che interessa.

http://www.banana.ch/doc/it/node/3317
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Personalizzare la tabella Conti
Nella tabella Conti puoi personalizzare i conti patrimoniali, secondo le tue necessità:

Si possono cambiare i numeri di conto
Si può cambiare la descrizione
Nella colonna Apertura, inserisci il saldo iniziale.

I saldi di apertura dei conti passivi devono essere inseriti con il segno meno davanti all'importo.
Questa operazione viene effettuata solo la prima volta che si usa Banana Contabilità Plus, poiché ogni
volta che il programma crea un nuovo anno (menu Azioni > Crea nuovo anno) il saldo di apertura
viene aggiornato automaticamente.

Schede conto per periodo
Per visualizzare le schede conto con i saldi riferiti ad un determinato periodo, clicca sul menu Report
> Schede conto e, nella sezione Periodo attivare Periodo specificato, inserendo la data di inizio e
di fine periodo. Per maggiori informazioni consulta la pagina Periodo.

Stampare le Schede conto
Per stampare una scheda conto, basta visualizzare la scheda da qualsiasi tabella (Conti o
Registrazioni) e lanciare la stampa dal menu File.

Per stampare diverse o tutte le schede conto, clicca sul menu Report > Schede conto e
seleziona le schede conto da stampare. Tramite il filtro presente nella finestra, si puoi eseguire una
selezione in automatico di tutti i conti, i centri di costo, i segmenti, i gruppi, ecc. Maggiori informazioni
sono disponibili alla pagina Scheda conto.
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Conto risultati d'esercizio anni precedenti
Nella contabilità Entrate / Uscite la riga di totalizzazione che raggruppa le entrate e le uscite indica
direttamente il patrimonio netto o capitale proprio, di conseguenza non c'è l'esigenza di avere un
conto specifico.

Se si desidera visualizzare l'ammontare dei risultati d'esercizio degli anni precedenti, è necessario
aggiungere un conto Risultati d'esercizio anni precedenti. L'assegnazione dell'importo deve
essere fatto manualmente nella colonna Apertura (tabella Conti) all'inizio di ogni anno.
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Tabella Categorie entrate e uscite

La tabella Categorie presenta la situazione delle Entrate e uscite.
Si impostano liberamente:

Le Categorie delle spese e delle entrate.
Eventuali centri di costo e profitto.
I gruppi di totalizzazione.
Per maggiori informazioni sul sistema di raggruppamento si rimanda alla pagina Gruppi della
Contabilità in partita doppia.

Nell'esempio ci sono tre raggruppamenti principali:

Gruppo 4 - Totalizza tutte le categorie che nella colonna Somma in hanno come
raggruppamento 4 (Totale entrate).
Gruppo 3 - Totalizza  tutte le categorie che nella colonna Somma in hanno come
raggruppamento 3 (totale uscite).
Gruppo 00 - Totalizza i gruppi 4 e 3 (Totale entrate e Totale uscite) che determinano il Risultato
d'esercizio.

Le colonne della tabella Categorie
Qui di seguito vengono elencate le principali colonne della tabella Categorie. La visualizzazione delle
colonne cambia in base alla Vista selezionata.

È possibile aggiungere delle colonne supplementari sia di sistema sia colonne proprie tramite il menu
Dati > Disponi colonne.

Sezione
Viene inserito un asterisco nella riga dove viene inserito un titolo, che sarà poi ripreso nel Rendiconto
abbellito con gruppi (nel nostro esempio l'asterisco è inserito sulla riga del titolo Risultato).

Se oltre alle entrate e alle uscite sono previste altre sezioni, ad esempio centri di costo e di profitto,
nella colonna Sezioni, sempre sulla riga del titolo, può essere inserito un altro asterisco. Maggiori
dettagli sono disponibili alla pagina web Sezioni.

Gruppo
Viene inserito un identificativo (numero o sigla) uguale a quello inserito per ogni categoria nella
colonna Somma in. Serve a totalizzare gli importi di tutte le categorie appartenenti allo stesso
raggruppamento della colonna Somma in (nell'esempio, il Gruppo 4 totalizza tutte le categorie di
entrata e il Gruppo 3 totalizza tutte le categorie d'uscita).

Categoria
Si inserisce il numero di categoria che identifica l'uscita o l'entrata.

Descrizione
Si inserisce una descrizione per identificare la categoria di entrata o di uscita. Questa descrizione
viene ripresa in automatico nella colonna Descrizione categoria della tabella Registrazioni (se
visualizzata).
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Somma in (Gr)
Si indica il codice di un gruppo in modo che il programma totalizzi l'importo della riga nel gruppo.
L'intestazione "Somma in" è stato adottato con la versione Banana Plus.
Il nome della colonna è rimasto Gr, per mantenere la compatibilità con le versioni precedenti del
programma.
Ogni categoria ha un identificativo che serve a definire in quale gruppo deve essere totalizzata
(nell'esempio tutte le categorie di entrata, nella colonna Somma in, hanno il raggruppamento 4,
perché sono totalizzate nel Gruppo 4, Totale entrate).

Entrate
La colonna è protetta e riporta il saldo delle registrazioni in entrata. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Uscite
La colonna è protetta e riporta il saldo delle registrazioni in uscita. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Saldo
La colonna è protetta e riporta il saldo complessivo tra le entrate e le uscite. Dopo ogni registrazione il
saldo è aggiornato in automatico.

 Personalizzare la tabella Categorie
Nella tabella Categorie puoi personalizzare le categorie di entrata (guadagni / ricavi) e di uscita
(spese/costi).
I numeri delle categorie possono essere cambiati, come anche le descrizioni.
Le categorie, all'inizio dell'anno, non devono avere nessun saldo di apertura, per poter determinare il
risultato d'esercizio corrispondente all'anno.

La Scheda Categoria
La scheda categorie permette di avere un elenco completo dei movimenti contabili che riguardano la
stessa categoria.
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Per aprire una scheda categorie clicca sulla cella dove figura il numero di categoria e ancora
un clic sul piccolo simbolo blu che figura in alto a destra della cella.
Per aprire più schede categorie occorre selezionare il comando Schede conto dal menu
Report.
Per aggiornare le schede categorie, in seguito a delle modifiche nella tabella Registrazioni,
clicca sul simbolo blu, delle due frecce circolari, che si trova in alto a destra della scheda
categorie.

Stampare le schede Categorie
Per stampare una scheda categoria, basta visualizzare la scheda da qualsiasi tabella (Categorie o
Registrazioni) e lanciare la stampa dal menu File.

Per stampare diverse o tutte le schede categorie, clicca sul menu Report  > Schede conto e
seleziona le schede delle categorie da stampare. Tramite il filtro presente nella finestra, si puoi
eseguire una selezione in automatico di tutti i conti, i centri di costo, i segmenti, i gruppi, ecc.
Maggiori informazioni sono disponibili alla pagina Scheda conto.
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Registrazioni Entrate/Uscite

Le registrazioni di entrate e uscite vengono immesse nella tabella Registrazioni, che è il fulcro
centrale per la tenuta della contabilità. In questa tabella i movimenti sono sempre visibili e in perfetto
ordine, in modo da avere una visione chiara delle operazioni registrate. Inoltre, tutti i dati inseriti
possono essere modificati e corretti in qualsiasi momento.

Le colonne della tabella Registrazioni
Qui di seguito vengono elencate le principali colonne della tabella Registrazioni. La visualizzazione
delle colonne cambia in base alla Vista selezionata.

È possibile aggiungere delle colonne supplementari sia di sistema sia colonne proprie tramite il menu
Dati > Disponi colonne.

Data
Si inserisce la data della registrazione in entrata o in uscita

Doc
Si inserisce un numero di Doc. Solitamente si riporta lo stesso numero di documento assegnato al
documento cartaceo; questo permette a distanza di tempo di ritrovare facilmente i documenti.

Descrizione
Si inserisce una descrizione per identificare la registrazione in entrata o in uscita.

Entrate
Inserire l'importo in entrata.

Uscite
Inserire l'importo in uscita.

Conto
Inserire i conti patrimoniali (cassa, banca, posta, clienti, fornitori..).

Se è un'entrata, l'importo verrà registrato in positivo sul conto.
Se è un'uscita, l'importo verrà registrato in negativo sul conto.

Categoria
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Inserire il motivo dell'entrata o dell'uscita; può essere una categoria definita nella tabella Categorie
oppure un conto presente nella tabella Conti.

Inserimento di una categoria:
Serve per attribuire l'entrata o uscita a una voce di spesa. Il segno della categoria segue quello
del conto.

Se è un'entrata, l'importo viene registrato in positivo.
Se è un'uscita, l'importo viene registrato in negativo.

Inserimento di un conto:
Serve per spostare importi da un conto patrimoniale ad un altro (es. prelevamenti, versamenti,
...). Sul conto inserito nella colonna Categoria l'importo viene quindi inserito all'inverso. La
registrazione funziona come quella della contabilità in partita doppia:

Se è un'entrata, l'importo viene registrato in negativo.
Se è un'uscita, l'importo viene registrato in positivo.

Descrizione Categoria
In questa colonna viene ripresa in automatico la descrizione della categoria, inserita nella tabella
Categorie.
Se nella tabella Categorie viene modifica la descrizione di una categoria, per visualizzare il nuovo
testo nella colonna Descrizione categoria della tabella Registrazioni, è necessario ricalcolare la
contabilità.

Inserire le Registrazioni
Nella tabella Registrazioni si registrano i movimenti in entrata e uscita fra conti e categorie. Ci sono
colonne diverse per inserire i dati delle operazioni da registrare:

Data: la data della registrazione.
Doc.: numero di documento.
Descrizione: la descrizione dell'operazione.
Entrate/Uscite: l'importo in entrata o in uscita.
Conto: viene inserito uno dei conti patrimoniali (cassa, banca, posta, clienti, fornitori....).
Categoria: viene inserito il motivo dell'entrata o dell'uscita, ovvero una categoria di ricavo o
spesa oppure un conto di contropartita per dei movimenti patrimoniali.

Dopo ogni registrazioni, l'importo viene riportato in automatico nella scheda conto e categoria. Nella
colonna categoria si può inserire un conto di una categoria o anche un conto della tabella Conti:

Se nella colonna Categoria si indica una categoria, l'importo viene registrato nella categoria
come entrata e uscita. 
Se nella colonna Categoria si indica un conto, l'importo viene registrato all'inverso (con il segno
invertito). Se è in uscita invece come positivo. In questo modo si possono fare operazioni fra
due conti patrimoniali (come nel caso di un giroconto).
Non è possibile invece fare operazioni in entrata e uscita di due categorie con una registrazione
sola.
Bisogna usare due righe di registrazione, senza usare la colonna Conto, con la prima riga in
entrata e la seconda in uscita.

Si possono anche registrare operazioni composte, uscita da un conto con più categorie. In questo caso
si usano più righe: sulla rima riga si registra il conto  senza categoria e nelle righe successive si
registrano le categorie e senza conto.
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La Contabilità entrate e uscite permette di gestire operazioni in modo simile a quella della contabilità
doppia, eccetto per movimenti fra due Categorie che richiedono due righe di registrazione. 

Velocizzare l'inserimento delle Registrazioni
Per velocizzare l'inserimento delle registrazioni si utilizzano le seguenti funzioni:

Immissione dati con auto-completamento - consente la ripresa in automatico dei dati già inseriti
in precedenza.
Registrazioni ricorrenti - permette di memorizzare in un'apposita tabella le registrazioni
ripetitive.
Importazione dati dall'estratto bancario o postale - per importare in automatico i movimenti
dall'estratto bancario, postale o carta di credito.

Registrazione di spese o entrate
Quando si registra un movimento si deve indicare:

nella colonna Conto il conto da dove l'importo entra o esce.
nella colonna Categoria si indica invece la categoria di spesa o entrata.

Nella scheda conto e categoria l'importo sarà registrato in positivo se è un'entrata e in negativo se è
un'uscita.

Movimenti fra conti patrimoniali
Nella colonna Categoria è possibile inserire anche un conto patrimoniale, presente nella tabella Conti.

Per esempio, per registrare un'entrata nella cassa da un prelevamento in banca, la registrazione si
esegue nel modo seguente:

Nella colonna Entrate si inserisce l'importo in entrata.
Nella colonna Conto viene inserito il conto Cassa.
Nella colonna Categoria viene inserito il conto Banca.

In questo caso, il programma andrà a registrare l'importo in positivo nel conto Cassa (che aumenta) e
in negativo nel conto Banca (che diminuisce).

Grazie a questa modalità di registrazione si possono registrare su una sola riga di registrazione
qualsiasi movimento diretto fra due conti patrimoniali, come per la partita doppia (vedi esempio
dell'immagine sopra, prima registrazione).

Registrazione su più righe
Quando si deve registrare un'operazione che deve essere suddivisa su più conti o categorie, si devono
inserire più righe di registrazione.

Qui di seguito proponiamo un esempio (vedi registrazione Doc. 11).
Tramite cassa vengono pagate più fatture.
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Inserire la stessa data e lo stesso numero di documento in tutte le righe che interessano la
stessa registrazione. Questo permette di individuare una registrazione che ha più movimenti.
Nella prima riga inserire l'importo complessivo, nella colonna Uscite se si tratta di un
pagamento, nella colonna Entrate se si tratta di un incasso.
Nella colonna Conto, inserire il conto della liquidità (conto tramite il quale si paga o si incassa).
La colonna Categoria nella prima riga rimane vuota.
Nelle righe successive inserire su ogni riga l'importo della fattura pagata o incassata
(rispettivamente colonna Uscite e colonna Entrate).
Ogni fattura verrà registrata su una riga.
La colonna Conto rimane vuota.
Nella colonna Categoria inserire per ogni riga la categoria per identificare la voce di uscita o di
entrata del movimento.

Esempi di registrazioni con IVA
Per poter gestire i movimenti con IVA, è necessario aver impostato un modello di Entrate / Uscite con
le opzioni IVA .

Colonne supplementari per l'IVA

A dipendenza del tipo di contabilità Entrate / Uscite impostato (con o senza IVA) ci sono delle colonne
supplementari dove vengono inseriti i dati IVA.

Cod.IVA
Inserire il codice IVA che si riferisce a una vendita o a un costo. Deve essere un codice presente nella
tabella Codici IVA.

https://www.banana.ch/apps/it?combine=&langcode=it&country=All&category=All&type=254&op=Invia#
https://www.banana.ch/apps/it?combine=&langcode=it&country=All&category=All&type=254&op=Invia#
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Per la spiegazione delle altre colonne IVA sono disponibili maggiori dettagli alla pagina Registrazioni
con IVA.

Scheda conto/categoria
Nella scheda conto o categoria, la presentazione dei movimenti è del tutto simile a quella della tabella
Registrazioni.
Se si aggiungono nuove registrazioni o se si effettuano dei cambiamenti (sempre eseguiti nella tabella
Registrazioni), è possibile aggiornare la scheda conto cliccando sul simbolo Aggiorna (freccia blu
arrotondata, posizionata nella parte destra della finestra).



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 509

Registrare i movimenti della carta di credito

Sono sempre molto più frequenti gli acquisti con carta di credito, non solo nelle aziende ma anche
nelle famiglie. Per avere un maggiore controllo delle spese per gli acquisti con carta di credito occorre
registrare i movimenti nella propria contabilità. A questo proposito occorre verificare che nella tabella
Conti ci sia il conto carta di credito, altrimenti occorre aggiungerlo.

Registrare i movimenti della carta di credito con acconti
Il conto carta di credito è un conto di debito e si inserisce nella colonna Conto.

Nella contabilità Entrate/Uscite, ogni volta che si effettuano dei versamenti di acconti sulla carta di
credito, occorre registrare come segue:

Inserire la data, la descrizione.
Nella colonna delle Uscite, registrare l'importo in uscita.
Nella colonna Conto, inserire il conto di liquidità (banca, posta).
Nella colonna Categoria, inserire il conto carta di credito.

Quando arriva la fattura della carta di credito e le spese risultano coperte dagli acconti versati,
occorre registrare i movimenti della carta di credito per rilevare i costi sostenuti e stornare il credito.

In questo caso si registra su più righe:

Inserire per ogni movimento sempre la stessa data e lo stesso numero di documento.
Inserire la descrizione che indica il tipo di spesa.
Nella colonna Uscite inserire l'importo totale pagato della carta di credito.
Nella colonna Conto inserire il conto carta di credito.
Nelle righe successive per registrare ogni singola spesa pagata con carta di credito, registrare
nella colonna uscite l'importo della spesa, e nella colonna Categoria, la categoria di spesa.

Dopo aver registrato tutti i movimenti verificare il saldo della carta di credito (aprire la scheda conto
della carta di credito).
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Saldi iniziali nella contabilità Entrate/Uscite

Saldi di apertura quando inizi con Banana Contabilità
La prima volta che crei un file nuovo con Banana Contabilità, i saldi di apertura devono essere inseriti
manualmente nella tabella Conti, colonna Apertura.

Gli importi dei conti patrimoniali positivi (cassa, banca, clienti, mobili, ecc) devono essere
inseriti normalmente nella colonna Apertura.
Gli importi dei conti patrimoniali negativi (debiti, prestiti, ecc.) devono essere inseriti con il
segno meno davanti all'importo nella colonna Apertura.

Quando si passa al nuovo anno, tramite il comando Crea nuovo anno, Banana contabilità riporta in
automatico tutti i saldi di apertura della tabella Conti.

Iniziare con Banana Contabilità durante l'anno
Se iniziate a fare una nuova contabilità, riprendendo il lavoro già fatto con altri programmi, avete due
possibilità: 

Iniziare la contabilità da inizio anno, inserendo i saldi di apertura a inizio anno (tabella Conti,
colonna Apertura) e i movimenti (tabella Registrazioni) che sono già stati registrati in
precedenza con altri programmi (vedi anche Ripresa dati da altri programmi). In questo modo
avete tutti i dettagli contabili in un file unico.
Partire dalla data di quando viene ripresa la contabilità:

Inserire i saldi iniziali (tabella Conti, colonna Apertura), riprendendo i valori dell'altra
contabilità.
Oltre a inserire i saldi d'apertura dei conti patrimoniali nella tabella Conti,  bisogna
inserire anche i saldi delle entrate (in positivo) e delle uscite (in negativo) nella tabella
Categorie.
Inserire i nuovi movimenti nella tabella Registrazioni.
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 Saldi anno precedente
Se iniziate una nuova contabilità, riprendendo una contabilità esistente, e volete che sulle stampe ci
siano anche i valori dell'anno precedente, è necessario inserire nella tabella Conti, vista
Precedente, colonna Anno Precedente, i saldi finali dell'anno precedente:

Inserire i saldi finali dell'anno precedente dei conti Patrimoniali positivi.
Inserire i saldi finali dell'anno precedente dei conti Patrimoniali negativi (inserire il segno meno
davanti all'importo).
Inserire i saldi finali dell'anno precedente delle Entrate.
Inserire i saldi finali dell'anno precedente delle Uscite (inserire il segno meno davanti
all'importo).

Creazione nuovo anno
Quando si passa al nuovo anno, il programma riporta in automatico i saldi di apertura per l'anno
successivo, Consultare la lezione Crea nuovo anno.

Stampa saldi iniziali
Per stampare i saldi iniziali:

Usate il comando Stampa/Anteprima per stampare il contenuto della Tabella, selezionando le
righe della tabella Conti.
Potete usare anche le Stampe contabili e impostare di stampare solo la parte di Rendiconto e la
colonna apertura.
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Preventivo

Il preventivo nella contabilità Entrate / Uscite può essere impostato in due modi diversi:

Colonna Preventivo
Tabella tabella Preventivo da impostare tramite il menu Strumenti aggiungi Nuove funzionalità

.

Colonna Preventivo
Nella colonna Preventivo, della vista Preventivo - si inseriscono gli importi su base annuale. Se si
utilizza la colonna Preventivo, non deve essere usata la tabella Preventivo.

Tabella Preventivo
Nella tabella Preventivo si esegue la pianificazione finanziaria.

Le previsioni vengono inserire come se fossero delle normali registrazioni, come nella tabella
Registrazioni.
Si possono anche inserire Quantità e Prezzi e anche delle Formule di calcolo.

Per maggiori informazioni sul Preventivo, consultare la pagina Tabella Preventivo.

http://www.banana.ch/doc/it/node/7923


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 513

Stampe

Informazioni immediate
Nelle tabelle Conti e Categorie vengono visualizzati immediatamente i saldi di tutti i conti, le entrate e
le uscite.
Dopo ogni singola registrazione, i saldi vengono aggiornati in automatico e non occorre richiamare dei
report per avere la situazione sotto controllo, ma basta semplicemente posizionarsi
nelle tabelle Conti o Categorie.

Stampe avanzate
Tutte le stampe si eseguono dal menu Report, dove si trovano le funzioni per le varie stampe:

Libro Giornale - comando Giornale per periodo. Si può visualizzare e stampare tutto il periodo o
un periodo determinato.

Schede conto, categorie o gruppi - Comando Schede conto / categoria. Si possono selezionare
tutte le schede o solo una selezione.
Nella sezione Periodo si determina il periodo e nella sezione Opzioni si possono attivare varie
opzioni da includere o escludere dalla stampa. La sezione Personalizzazione permette di
memorizzare le stampe con determinate opzioni e all'occorrenza riprenderle senza ripetere le
impostazioni di stampa.

Rendiconto abbellito - comando Rendiconto abbellito. Si può stampare anche per periodo e si
possono includere nella stampa varie opzioni, nonché comporre delle personalizzazioni.

Rendiconto abbellito con gruppi -  Comando Rendiconto abbellito con gruppi. Si può stampare
anche per periodo e si possonono includere nella stampa varie opzioni, nonché comporre delle
personalizzazioni.

Report Contabile - Comando Report contabile. Nella tabella Conti viene visaulizzato il report con
le opzioni richieste. Sono possibili report per periodo, anche con il confronto dei periodi o anni
precedenti; ogni periodo può avere delle suddivisioni e si possono memorizzare le
personalizzazioni.
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Scheda conto / categoria - Entrate / Uscite

La scheda conto o categoria, contabilmente corrisponde al mastrino ed è l'elenco completo dei
movimenti contabili che riguardano uno stesso conto, una stessa categoria, un centro di costo, un
segmento o un gruppo.

Aprire la scheda conto
Vi sono due metodi per aprire e stampare una scheda conto o categoria:

Primo metodo

Questo metodo è consigliato quando si vogliono visualizzare e stampare tutte o diverse schede
conto/categoria.

Cliccare dal menu Report > Schede conto/categoria
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Si presenta una finestra di dialogo con le seguenti sezioni:

Conti/Categorie
Periodo
Opzioni
Personalizzazione

Per avere le informazioni dettagliate delle sezioni, cliccare sui corrispondenti link.

Secondo metodo

Questo metodo si può utilizzare quando bisogna aprire solo una scheda alla volta all'interno delle
tabelle.

Cliccare sul piccolo simbolo che si presenta quando si seleziona la cella che contiene il numero
di conto, di categoria o di gruppo.

 Aggiornare la scheda conto
La scheda conto o categoria è temporanea e viene calcolata al momento della richiesta. Se nella
Tabella Registrazioni, si cambiano o aggiungono delle registrazioni,  la scheda conto non viene
aggiornata simultaneamente.

Per aggiornare la scheda conto, in seguito a modifiche,  occorre impartire nuovamente il comando
Scheda conto/categoria, oppure se la scheda conto è ancora aperta, cliccare sul simbolo indicato
nell'immagine sottostante.

Nota

Nella scheda conto, categoria o di gruppo non è possibile modificare i dati. All'interno della scheda
conto, con un doppio clic sul numero di riga, il programma passa nella corrispondente riga della
tabella Registrazioni o del Preventivo.

http://www.banana.ch/doc/it/node/7217
http://www.banana.ch/doc/it/node/2729
http://www.banana.ch/doc/it/node/2604
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La colonna Conto Selezionato
Nella colonna Conto Selezionato, che si può rendere visibile, a partire da qualsiasi scheda conto,
dal menu Dati > Disponi colonne, viene visualizzato il conto sul quale è avvenuto il movimento.
Quando si ottiene una scheda conto di uno o più conti, categorie, gruppi e segmenti, si vede
esattamente il conto usato.

La Colonna Contropartita
Nelle schede conto o categorie è visualizzata la colonna Contrp che indica il conto di contropartita
che completa la registrazione.

Schede di gruppi o classi
Nella scheda conto di un gruppo o di una classe sono raggruppate tutte le registrazioni di quei conti
che appartengono al gruppo o alla classe selezionata.
I conti o le categorie del gruppo o della classe possono essere visualizzati rendendo visibile la colonna
ContoSelezionato.  

Stampare le schede conto (Libro Mastro)
Per stampare una scheda conto:
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visualizzare la scheda da qualsiasi tabella (Conti o Registrazioni) e lanciare la stampa dal menu
File.

Per stampare più schede conto:

Menu Report > Schede conto
Attraverso il Filtro si possono selezionare in automatico tutte le schede conto da stampare o in
parte (es. solo conti, centri di costo o segmenti).
Nelle diverse sezioni Periodo, Opzioni, Personalizzazioni si attivano le funzioni desiderate (es.
periodo, un conto per pagina....).
Confermare con OK, dopo aver impostato le opzioni desiderate.
Appariranno a video le schede conto selezionate. Per stampare cliccare sul menu File >
Stampa.

Stampare Schede conto per periodo
Per visualizzare le schede conto con i saldi riferiti ad un determinato periodo:

clicca sul menu Report > Schede conto
nella sezione Periodo attivare Specificato, inserendo la data di inizio e di fine periodo. 

Per maggiori informazioni consulta la pagina Periodo.

Stampare le Schede conto del Preventivo
Se nella tabella del Preventivo sono state inserite le registrazioni di preventivo e possibile avere le
schede conto o di gruppo del preventivo:

Menu Report > Schede conto/categoria > attiva Registrazioni di preventivo.
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Impostazioni Conti e Categorie nel Rendiconto abbellito con
gruppi
Nella finestra di dialogo si può impostare come stampare i conti e le categorie

Inserire un logo nelle schede conto
A partire da Banana 9, è possibile inserire un logo anche nella stampa delle schede conto.

Dopo aver creato il dettaglio della scheda conto procedere come segue:

Menu Report > Schede conto
Menu File > Anteprima di stampa.
Nella finestra di dialogo che si apre, alla voce Logo, indicare il vostro logo (invece della voce
nessuno).
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Sono disponibili delle informazioni più dettagliate alla pagina Impostazioni logo.

Salvare le impostazioni
Se capita di stampare regolarmente le schede di determinati conti, per esempio tutte quelle delle
vendite, è utile creare una personalizzazione apposita:

Menu Report > Schede conto > sezione Personalizzazione
Cliccare sul bottone Nuova
Indicare nella descrizione il nome, per esempio "Conti vendita"
Selezionare i conti che desiderate stampare
Dal menu File > Imposta pagina  si possono determinare i margini e altre impostazioni della
pagina.

Tutte le volte che bisogna stampare i conti, selezionare la personalizzazione creata.

 

http://www.banana.ch/doc/it/node/2605
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Libro giornale - Contabilità Entrate / Uscite

Le registrazioni nell'applicativo Entrate /Uscite, come in tutti gli applicativi di Banana Contabilità,
vengono inserite nella tabella Registrazioni. Se si desidera stampare il Libro giornale (elenco di tutti i
movimenti) si può procedere in due modi diversi:

Dalla tabella Registrazioni:
selezionare dal menu File → Imposta pagina (per impostare tutte le opzioni di stampa)
ritornare al menu File → Stampa.

Dal menu Report → Giornale per periodo.

Giornale per periodo
Banana Contabilità, attraverso il menu Report → Giornale per periodo, dà la possibilità di stampare
il Giornale con i movimenti di tutto il periodo o del periodo selezionato, inserendo la data d'inizio e di
fine periodo.

Le informazioni sulla sezione Periodo sono disponibili alla pagina Periodo delle funzioni comuni .

http://www.banana.ch/doc/it/node/2602
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Nella sezione Colonna per ordinamento è possibile scegliere in base a quale tipo di data ordinare e
stampare il giornale.
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Rendiconto abbellito

Il rendiconto abbellito rappresenta una sintesi della situazione patrimoniale ed economica
dell'esercizio. Si tratta di una funzione presente nella Contabilità entrate / uscite.

Il Rendiconto abbellito viene calcolato e visualizzato tramite dal menu Report > Rendiconto
abbellito.
Il Rendiconto abbellito, visualizzato in anteprima,  può essere salvato nel formato PDF, HTML,
MS Excel e messo in Copia negli appunti.
È possibile calcolare, visualizzare e stampare il rendiconto a fine anno, o per un determinato
periodo.

Intestazione pagina
Righe 1-4

Righe a disposizione per definire l’intestazione del Rendiconto.
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Logo

È possibile inserire il logo nell'intestazione di tutte le pagine del report.
Se nel menu File > Imposta logo è stato aggiunto uno o più loghi, è possibile selezionarne uno dalla
lista.
Nel caso in cui non è stato aggiunto alcun logo, tramite il bottone Modifica si può aggiungere il logo.

Intestazione colonna
Data iniziale

Inserire la data iniziale della contabilità corrente.

Data finale

Inserire la data finale della contabilità.

Anno precedente

Inserire la data finale della contabilità dell’anno precedente.

Pagina copertina
Pagina copertina

Attivando la funzione viene stampata la pagina di copertina.

Logo

È possibile inserire il logo nella pagina di copertina del report.
Se nel menu File > Imposta logo è stato aggiunto uno o più loghi, è possibile selezionarne uno dalla
lista. Nel caso in cui non è stato aggiunto alcun logo, tramite il bottone Modifica si può aggiungere il
logo.

Stampa pagine
Attivando le caselle si definiscono le opzioni che si desiderano stampare nel Rendiconto:

Conti

Vengono stampati i conti.

Pagina iniziale

Viene stampata la pagina iniziale con l’intestazione del documento.

Categorie

Vengono stampate le categorie

Fine pagina dopo conti

I conti e le categorie vengono stampati su due pagine distinte.
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Includi in stampa
Vistando le caselle si scelgono le opzioni che devono figurare nella stampa.
Alcune di queste opzioni non sono disponibili (es. Saldi preventivo), se viene selezionato un periodo
specifico nella sezione Periodo.

Altre sezioni
Per le altre sezioni consultare le seguenti pagine:

Periodo
Stile
Testi
Margini
Personalizzazione
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Rendiconto abbellito con gruppi

La funzione permette di ottenere il Rendiconto abbellito con gruppi, con tutte le opzioni presenti nella
contabilità in partita doppia.

Il rendiconto abbellito con gruppi, permette di:

Includere in stampa tutti i gruppi presenti nelle tabelle conti e categorie.
Escludere singolarmente dei gruppi o dei conti.
Selezionare una suddivisione per periodo
(per esempio nel primo semestre scegliere se avere una suddivisione per mese o trimestre).
Selezionare una suddivisione per segmenti.

Qui di seguito sono indicate solo le spiegazioni pertinenti alla contabilità entrate e uscite, per la
documentazione completa si rimanda alle spiegazioni del Bilancio abbellito con gruppi.
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Report contabile

Con questo comando vengono visualizzati gli importi dei conti con un determinato
raggruppamento, per un periodo determinato o per suddivisione.
Le registrazioni senza data sono conteggiate come aperture e non compaiono nella stampa del
conto economico.

Visualizza

Si seleziona il raggruppamento desiderato:

Conti - il Report presenterà l'elencazione di tutti i conti con le seguenti colonne: apertura,
entrate, uscite e saldo del conto
Categorie - il Report presenterà l'elencazione di tutte le categorie con le seguenti colonne:
apertura, entrate, uscite e saldo della categoria.

Opzioni

Si seleziona quali conti includere o escludere:

Escludi conti - verranno stampati solo le categorie
Includi conti senza movimento - verranno stampati anche i conti che non hanno dei
movimenti
Includi conti con saldo a 0 - verranno stampati anche i conti che hanno un saldo zero
Escludi gruppi senza conti - vengono esclusi i gruppi che hanno dei conti con saldo a zero.
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Altre sezioni
Per le altre sezioni consultare le seguenti pagine web:

Periodo
Suddivisione
Personalizzazione
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Riassunto IVA (solo per file con opzioni IVA)

Le informazioni sul Riassunto IVA sono disponibili alla pagina web Riassunto IVA.
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Creare un nuovo anno | Contabilità Entrate e
uscite

Il comando Crea nuovo anno prepara un file per l'anno nuovo sulla base del file della contabilità che si
sta per chiudere. Il comando non modifica il file attuale, quindi può essere eseguito senza effetto
alcuno.

Logica passaggio al nuovo anno
Con Banana Contabilità si ha un file separato per ogni anno. Quando inizia il nuovo anno la logica
operativa è la seguente:

Con il comando Azioni > Crea nuovo anno, il programma crea un nuovo file per l'anno,
usando lo stesso piano dei conti, le impostazioni e i saldi dell'anno corrente che si sta per
chiudere.

Una volta creato il file del nuovo anno, salvarlo con il nuovo nome.
L'operazione di creazione del nuovo file può essere ripetuto se si decide di non salvare il
file.

Si  può lavorare contemporaneamente su entrambi i file:
Su quello nuovo si andranno a inserire i movimenti del nuovo anno. Si potranno anche
apportare modifiche al piano dei conti, IVA o altro, senza influenzare quello precedente.
Su quello dell'anno precedente si continueranno a inserire le operazioni per completare
l'anno ed effettuare le operazioni tipiche delle chiusure, verifica dei saldi, stampa dei
bilanci ecc.

Nel file del nuovo anno, con il comando Azioni  > Aggiorna saldi iniziali, si riprendono le
modifiche che sono state fatte nel file dell'anno precedente. Questa operazione è da fare al più
tardi quando non ci sono più modifiche nell'anno precedente.

Una volta creato il file del nuovo anno, chi ha abbonamento al Piano Professional di Banana
Contabilità Plus, vedrà apparire nella finestra info il messaggio Piano Advanced in modalità di
dimostrazione  fintanto che non raggiungerà le 70 righe di registrazioni.

Controllo e chiusura della contabilità anno precedente
Prima di aggiornare i saldi iniziali, per evitare che ci siano differenze fra i saldi di chiusura e quelli di
apertura dell'anno successivo, è importante assicurarsi di aver effettuato tutti i controlli, le verifiche e
tutte le registrazioni contabili di chiusura. Si rimanda alla pagina:

Controllo e chiusura contabilità in partita doppia .

A differenza della contabilità in partita doppia, quando viene chiuso l'esercizio di contabilità Entrate e
Uscite, non vi è alcun utile o perdita da ripartire. La differenza tra le categorie delle entrate e delle
uscite nel nuovo esercizio viene indicata come aumento o decremento del patrimonio.

Operazioni effettuate dal comando crea nuovo anno
Il comando crea nuovo anno esegue le operazioni che seguono, tenendo conto dei parametri
impostati dall'utente:

http://www.banana.ch/doc/it/appmsg_it_info_license_extended_startupmode
http://www.banana.ch/doc/it/appmsg_it_info_license_extended_startupmode
http://www.banana.ch/doc/it/node/3307
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Crea un nuovo file (senza nome) con il piano dei conti e le impostazioni uguali a quello aperto,
senza registrazioni.
Copia i dati della colonna saldi del file attuale nella colonna Apertura del nuovo file (solo per le
classi indicate).
Copia per tutti i conti del Rendiconto i dati della colonna Saldi del file, nella colonna Anno
precedente del nuovo file.
Aggiorna le proprietà del file:

Imposta la data di inizio e fine esercizio, aggiungendo 1 anno a quelle esistenti.
Nella sezione Opzioni imposta il nome del file dell'anno precedente e attiva l'opzione di
usare le registrazioni dell'anno precedente per l'autocompletamento.

Se ci sono dei dati nella tabella Preventivo, riporta i movimenti nel nuovo anno tenendo conto
delle impostazioni.

Ripartire il risultato d'esercizio

Nella contabilità Entrate / Uscite non vi è la necessità di ripartire l'utile o la perdita d'esercizio, poiché
il totale patrimonio nella tabella Conti rappresenta già il capitale netto o capitale proprio.

Se tuttavia ci fosse questa esigenza occorre impostare un conto specifico nella tabella Conti. Per
maggiori dettagli consultare il paragrafo Conto Risultati d'esercizio anni precedenti.
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Aggiorna saldi iniziali | Contabilità Entrate /
Uscite

  Il comando Aggiorna saldi iniziali riprende i dati dal file dell'anno precedente e aggiorna i saldi
d'apertura di quello attuale. 

Quando usare il comando Aggiorna saldi iniziali
Il comando Aggiorna saldi iniziali si usa nei seguenti casi:

È stato creato il nuovo anno con il comando Crea nuovo anno, ma l'esercizio non è stato ancora
completato.
Sono state fatte delle modifiche nell'anno precedente (aggiunte o modificate registrazioni,
aggiunto conti..).

Controllo della contabilità anno precedente
Per evitare che ci siano differenze fra i saldi di chiusura e quelli di apertura dell'anno successivo è
importante, prima del comando, assicurarsi di aver effettuato tutti i controlli, le verifiche e tutte le
registrazioni contabili di chiusura come indicato nella pagina Chiusure della contabilità in partita
doppia.

 Dialogo Aggiorna saldi iniziali
Accedi a questa finestra dal menu Azioni → Aggiorna saldi iniziali.
Inserire il percorso del file da dove riprendere i saldi dell'anno precedente:

Il programma propone il nome del file salvato.
Se il nome del file o il percorso è cambiato, usa il comando Sfoglia.

 

Operazioni effettuate dal comando
Il comando riprende i dati dall'anno precedente, senza modificarne i contenuti. Questo comando può
essere ripetuto senza alcun impatto sul file dell'anno precedente.

Il comando esegue le medesime operazioni indicate nel Crea nuovo anno, eccetto quelle riferite alla
creazione del file.
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Modifica piano dei conti dell'anno precedente
Se dopo avere creato il nuovo anno aggiungi dei conti nell'anno precedente e riprendi i saldi, il
programma segnala dei messaggi di errore. In questo caso, è necessario:

Inserire i nuovi conti anche nel file del nuovo anno.
Ripetere il comando Aggiorna i saldi iniziali.

Puoi allineare il piano dei conti usando il comando Importa Conti.
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Il Cash Manager

Il Cash Manager (o Libro Cassa) è un applicativo di Banana Contabilità Plus, per gestire la cassa o
qualsiasi altro conto. È gratuito e senza limiti perché è incluso nel piano Free di Banana Contabilità
Plus.  È ideale per:

Famiglie - per tenere sotto controllo le spese e le entrate e pianificare un budget familiare.
Ragazzi e Studenti - per imparare a gestire le prime spese ed essere consapevole dei propri
risparmi.
Aziende e Associazioni - per preventivare e gestire le entrate e le uscite della cassa, tenere la
prima nota e gestire la cassa in un file separato dalla contabilità.

Consulta le nostre risorse per un avvio facile e immediato:

▶ Video: Come iniziare un Libro Cassa (Cash Manager)
Guarda i modelli di Cash Manager disponibili

Come iniziare con il Cash Manager
Per un inizio facile e veloce, scegli un nostro modello di Cash Manager e salvalo con nome. Per
maggiori informazioni visita la pagina generica di Come iniziare con Banana Contabilità Plus.

Nella tabella Registrazioni sei subito operativo e puoi inserire i movimenti in entrata e uscita.
L'inserimento è estremamente facile e intuitivo, anche per chi non ha conoscenze contabili. 

La tabella Registrazioni
La tabella Registrazioni è il fulcro della tenuta contabile del Cash Manager. 
Permette di ottenere:

Chiarezza e ordine delle colonne: grazie all'impostazione tabellare hai sempre una visione
immediata e completa dei dati inseriti.
Ci sono delle colonne principali, già predefinite, in cui inserire:

La data della registrazione
Eventuale nr. di documento
L'importo in entrata o in uscita
La categoria per l'entrata o l'uscita

https://www.banana.ch/it/free
https://www.banana.ch/it/free
https://www.banana.ch/it/node/11389
https://www.banana.ch/apps/it?combine=&langcode=it&country=All&category=All&type=255&publisher=All&op=Invia#
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L' inserimento di allegati digitali: nella tabella Registrazioni puoi rendere visibile anche la
colonna DocLink, che ti permette di aggiungere lo scontrino o la fattura ad ogni movimento in
formato PDF, garantendo la disponibilità immediata dei documenti in caso di verifiche future o
per trasmetterli al commercialista.
Effettuare sempre eventuali correzioni: in caso di errori puoi correggere facilmente,
assicurando risultati sempre corretti e accurati.

Velocizzare l'inserimento delle registrazioni
Banana Contabilità Plus offre diverse funzioni per accelerare il processo di inserimento dati, come
segue:

L' Auto-completamento: nella colonna Descrizione, digitando i primi caratteri, il programma
suggerisce automaticamente movimenti simili già inseriti in precedenza e premendo F6,
completa il movimento attuale con i dati selezionati. 
Le Registrazioni ricorrenti: é possibile memorizzare le registrazioni ripetitive in un'apposita
tabella, ripresa dal menu Azioni > Registrazioni ricorrenti, e riprenderle con un solo click,
risparmiando tempo e semplificando il lavoro.

Report e Stampe
Dopo ogni registrazione, il programma aggiorna in automatico tutti i saldi dei conti della tabella
Categorie e del conto. Puoi facilmente stampare rendiconti e report per un facile monitoraggio delle
entrate e delle uscite e dello stato della liquidità disponibile sul conto cassa. 

Rendiconti professionali e accurati con un semplice comando:

Dal menu Report > Rendiconto abbellito o Rendiconto abbellito con gruppi, ottieni i tuoi
rendiconti in un attimo. Sono anche possibili Rendiconti per periodo.

Il Rendiconto abbellito visualizza tutti i conti e le categorie senza gli eventuali sottogruppi.
Il Rendiconto abbellito con gruppi visualizza tutti i conti e le categorie anche con i sottogruppi.
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Archiviazione dati in PDF
Tutti i dati della contabilità, per un certo periodo di anni, devono essere sempre disponibili, sia ai fini
fiscali sia per eventuali esigenze interne. 

Archiviazione semplice e completa. Dal menu File > Crea dossier in PDF, è possibile archiviare
facilmente tutti i dati contabili in un unico documento PDF. Questo permette di conservare in modo
ordinato e completo l'intera contabilità dell'anno, facilitando l'accesso e la consultazione dei dati in
futuro.

Informazioni comuni ad altri applicativi
Nelle pagine della documentazione del Cash Manager trovi informazioni dettagliate e specifiche. Per
informazioni di carattere generale puoi consultare la documentazione della contabilità in partita
doppia. In particolare:

Aggiungere, cancellare un conto
Rinominare un conto
Inserire raggruppamenti
Centri di costo e Profitto
Segmenti
Colonna Saldo

Stampe

Registrazioni
Schede conto
Rendiconto abbellito
Rendiconto abbellito con gruppi
Report contabile
Riassunto IVA
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Tabella Conti del Cash Manager

La tabella Conti del Cash Manager contiene un solo conto e non è possibile aggiungere altri conti.

Le colonne della tabella Conti

Qui di seguito vengono elencate le principali colonne della tabella Categorie. La visualizzazione delle
colonne cambia in base alla Vista selezionata.

È possibile aggiungere delle colonne supplementari sia di sistema sia colonne proprie tramite il menu
Dati > Disponi colonne.

Gruppo 
La colonna rimane vuota.

Conto
Si inserisce il numero o sigla del conto da gestire (cassa, banca, posta).

Descrizione
Si inserisce una descrizione relativa al conto inserito. Questa descrizione viene ripresa nella colonna
Descrizione conto della tabella Registrazioni (se visualizzata).

Apertura
Solo la prima volta che si usa un file nuovo o si usa per la prima volta Banana contabilità, occorre
inserire il saldo di apertura. All'inizio del nuovo anno con l'apertura in automatico, il saldo del conto
viene aggiornato automaticamente.

Entrate
La colonna è protetta e riporta il saldo delle registrazioni in entrata. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Uscite
La colonna è protetta e riporta il saldo delle registrazioni in uscita. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Saldo
La colonna è protetta e riporta il saldo complessivo tra le entrate e le uscite. Dopo ogni registrazione il
saldo è aggiornato in automatico.
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Tabella Categorie Cash Manager

La tabella Categorie presenta la situazione delle Entrate e Uscite.

Tabella Categorie
Nella colonna Categorie, per ogni entrata e uscita, vengono impostate le relative categorie.
Oltre alla colonna Categorie, ci sono colonne per impostare:

Le sezioni 
I gruppi di totalizzazione. 
Per maggiori informazioni sul sistema di raggruppamento si rimanda alla pagina Sistema
Raggruppamento.
Eventuali centri di costo e profitto.

Nell'esempio ci sono tre raggruppamenti principali:

Gruppo 4 - Totalizza tutte le categorie che nella colonna Somma in hanno come
raggruppamento 4 (Totale entrate).
Gruppo 3 - Totalizza  tutte le categorie che nella colonna Somma in hanno come
raggruppamento 3 (totale uscite).
Gruppo 00 - Totalizza i gruppi 4 e 3 (Totale entrate e Totale uscite) che determinano il Risultato
d'esercizio.

Le colonne della tabella Categorie

Qui di seguito vengono elencate le principali colonne della tabella Categorie. La visualizzazione delle
colonne cambia in base alla Vista selezionata.

È possibile aggiungere delle colonne supplementari sia di sistema sia colonne proprie tramite il menu
Dati > Disponi colonne.

Sezione
Viene inserito un asterisco nella riga dove viene inserito un titolo, che sarà poi ripreso nel Rendiconto
abbellito con gruppi (nel nostro esempio l'asterisco è inserito sulla riga del titolo Risultato operativo).

Se oltre alle entrate e alle uscite sono previste altre sezioni, ad esempio centri di costo e di profitto,
nella colonna Sezioni, sempre sulla riga del titolo, può essere inserito un altro asterisco. Maggiori
dettagli sono disponibili alla pagina web Sezioni.

Gruppo
Viene inserito un identificativo (numero o sigla) uguale a quello inserito per ogni categoria nella
colonna Somma in. Serve a totalizzare gli importi di tutte le categorie appartenenti allo stesso
raggruppamento (nell'esempio, il Gruppo 4 totalizza tutte le categorie di entrata e il Gruppo 3
totalizza tutte le categorie d'uscita).

Categoria
Si inserisce il numero di categoria che identifica il tipo di spesa o di entrata.
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Descrizione
Si inserisce una descrizione per identificare la categoria di entrata o di uscita. Questa descrizione
viene ripresa in automatico nella colonna Descrizione categoria della tabella Registrazioni (se
visualizzata).

Somma in (Gr)
Si indica il codice di un gruppo in modo che il programma totalizzi l'importo della riga nel gruppo.
L'intestazione "Somma in" è stato adottato con la versione Banana Plus.
Il nome della colonna è rimasto Gr, per mantenere la compatibilità con le versioni precedenti del
programma.
Ogni categoria ha un identificativo che serve a definire in quale gruppo deve essere totalizzata
(nell'esempio tutte le categorie di entrata, nella colonna Somma in, hanno il raggruppamento 4,
perché sono totalizzate nel Gruppo 4, Totale entrate).

Entrate
La colonna è protetta e riporta il saldo delle registrazioni in entrata. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Uscite
La colonna è protetta e riporta il saldo delle registrazioni in uscita. Dopo ogni registrazione il saldo è
aggiornato in automatico.

Saldo
La colonna è protetta e riporta il saldo complessivo tra le entrate e le uscite. Dopo ogni registrazione il
saldo è aggiornato in automatico.

Personalizzare la tabella Categorie
Nella tabella Categorie personalizza le categorie di entrata e di uscita, secondo le tue necessità. È
possibile:

Cambiare i numeri di categoria
Cambiare la descrizione
Eliminare o aggiungere delle categorie
Inserire o eliminare dei sottogruppi

Tutti i saldi delle categorie determinano il risultato d'esercizio (guadagno o perdita) e per questo
motivo a inizio anno non devono avere alcun saldo.

Aggiungere nuove categorie

Se hai la necessità di aggiungere delle nuove categorie in un gruppo già esistente, procedi come
segue:

Inserisci delle righe vuote (menu Modifica > Inserisci Righe vuote) prima della riga del
Gruppo di totalizzazione
Inserisci nella colonna Categoria il numero o sigla della categoria
Inserisci la descrizione per identificare la categoria
Inserisci nella colonna Somma in, lo stesso numero di raggruppamento delle altre categorie,
appartenenti allo stesso Gruppo di totalizzazione.
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Aggiungere dei sottogruppi

Per aggiungere dei nuovi sottogruppi, procedi come segue:

Inserisci delle righe vuote (menu Modifica > Inserisci righe vuote) nella zona dove desideri
inserire il nuovo sottogruppo
Nell'ultima riga vuota inserisci nella colonna Gruppo un numero o sigla per la totalizzazione
(vedi riga 45 nell'esempio "34 - Costi personali")
Inserisci la descrizione per identificare il nuovo sottogruppo
Inserisci nella colonna Somma in il Gruppo di totalizzazione (nell'esempio "3 - Totale costi").

Eliminare delle categorie e dei sottogruppi

Per eliminare delle categorie o dei sottogruppi occorre selezionare le righe con le categorie e il
sottogruppo da eliminare e impartire il comando Elimina righe dal menu Modifica.
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Saldi iniziali | Cash Manager

È necessario inserire il Saldo iniziale solo la prima volta che usi Banana Contabilità Plus.

Saldi di apertura quando inizi con Banana Contabilità
La prima volta che si crea un nuovo file di Cash Manager con Banana Contabilità, il saldo di apertura
della cassa deve essere inserito manualmente nella tabella Conti, colonna Apertura.

Gli anni successivi, con il passaggio al nuovo anno tramite il menu Azioni > Crea nuovo anno, il
saldo di apertura viene riportato in automatico.
Non è possibile inserire più di un conto; per questo devi utilizzare la Contabilità entrate / uscite.

Iniziare con Banana Contabilità durante l'anno
Se inizi a fare una nuova contabilità riprendendo il lavoro già fatto con altri programmi, hai due
possibilità: 

Iniziare la contabilità da inizio anno, inserendo il saldo di apertura a inizio anno (tabella Conti,
colonna Apertura) e i movimenti (tabella Registrazioni) che sono già stati registrati in
precedenza con altri programmi (vedi anche Ripresa dati da altri programmi). In questo modo
hai tutti i dettagli contabili in un file unico.
Partire dalla data di quando viene ripresa la contabilità:

Inserire il saldo iniziale (tabella Conti, colonna Apertura), riprendendo il saldo di apertura
dall'altra contabilità.
Oltre a inserire il saldo d'apertura della cassa nella tabella Conti, bisogna inserire anche i
saldi delle entrate (in positivo) e delle uscite (in negativo) nella tabella Categorie.
Inserire i nuovi movimenti nella tabella Registrazioni.

Saldi anno precedente
Se inizi una nuova contabilità riprendendo una contabilità esistente, e vuoi che sulle stampe ci siano
anche i valori dell'anno precedente, è necessario inserire nelle tabelle Conti e Categorie > vista
Precedente > colonna Anno Precedente, i saldi finali dell'anno precedente:

Inserire il saldo finale dell'anno precedente del conto Cassa (tabella Conti).
Inserire i saldi finali dell'anno precedente delle Entrate (tabella Categorie).
Inserire i saldi finali dell'anno precedente delle Uscite (tabella Categorie), inserire il segno meno
davanti all'importo).
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Creazione nuovo anno
Quando si passa al nuovo anno, il programma riporta in automatico i saldi di apertura per l'anno
successivo. Consulta la pagina Crea nuovo anno.

Stampa saldi iniziali
Per stampare i saldi iniziali:

Usa il comando Stampa/Anteprima (menu File) per stampare il contenuto della Tabella,
selezionando le righe del bilancio,
Puoi usare anche le Stampe contabili e impostare di stampare solo la parte di Rendiconto e la
colonna apertura.

 



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 543

Tabella Preventivo del Cash Manager

Nella tabella Preventivo si esegue la pianificazione finanziaria.

Prima di iniziare un anno contabile, si possono preventivare le spese e ipotizzare le entrate, in modo
da avere sotto controllo la situazione economica e finanziaria.

Il preventivo può essere impostato in due modi differenti:

Nella tabella Categorie, colonna Preventivo. Per ogni categoria viene indicato l'importo di1.
preventivo annuale.
In questo caso, quando si elabora il Preventivo dal menu Report, comando Rendiconto
abbellito per gruppi, la colonna del Preventivo riporta gli importi che si riferiscono all'intero
anno.
 Nella tabella Preventivo, che si attiva dal menu Strumenti > Aggiungi nuove funzionalità >2.
Aggiungi tabella Preventivo.
In questa tabella si registrano tutti i preventivi di spesa e di entrata con delle registrazioni. Nel
caso che si attivi questa tabella, la colonna Preventivo della tabella Conti viene disattivata
automaticamente.
In questo caso si può impostare un preventivo dettagliato che tenga conto delle possibili
variazioni durante l'anno e nei diversi periodi dell'anno.
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Crea nuovo anno

È possibile passare al nuovo anno in automatico nelle seguenti modalità:

Aprire il file dell'anno appena terminato e dal menu Azioni > Crea nuovo anno.
Confermare i dati base delle Proprietà file.
Salvare il file con nome.

Il programma riprende in automatico:

Il conto, riportando il saldo iniziale.
Le categorie vengono riprese senza riportare un saldo iniziale, poiché si inizia da zero, per poter
determinare il risultato d'esercizio del nuovo esercizio.
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Tabella Registrazioni del Cash Manager

I movimenti del Cash Manager vengono inserite nella tabella Registrazioni.

Ci sono delle apposite colonne per inserire:

la data
il numero di documento
la descrizione
l'importo in entrata o in uscita
la categoria relativa all'entrata o all'uscita e presente nella tabella Categorie
Nel caso le registrazioni siano soggette a IVA, inserisci nella colonna Cod. IVA, il codice IVA. I
codici IVA sono elencati nella tabella Codici IVA.

Velocizzare l'inserimento delle Registrazioni
Per velocizzare l'inserimento delle registrazioni si utilizza:

la funzione dell'Immissione dati con autocompletamento che consente la ripresa in automatico
dei dati già inseriti in precedenza
la funzione delle Registrazioni ricorrenti (menu Azioni) che permette di memorizzare in
un'apposita tabella le registrazioni ripetitive.

Esempi di registrazioni senza IVA
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Esempi di registrazioni con IVA

Scheda categoria
Dopo aver inserito le registrazioni, per visualizzare i movimenti di una categoria, eseguire un clic sul
piccolo simbolo blu che figura in alto a destra della cella.

Nella scheda Categoria, la presentazione dei movimenti è del tutto simile a quella della tabella
Registrazioni.
Se si aggiungono nuove registrazioni o se si effettuano dei cambiamenti (sempre eseguiti nella tabella
Registrazioni), è possibile aggiornare la scheda di una categoria, cliccando sul simbolo Aggiorna
(simbolo blu, delle due frecce circolari, posizionata nella parte destra della finestra).
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Stampe

Informazioni immediate
Nelle tabelle Conti e Categorie vengono visualizzati immediatamente i saldi del conto e delle
categorie delle entrate e delle uscite.
Dopo ogni singola registrazioni, i saldi vengono aggiornati in automatico e non occorre richiamare dei
report per avere la situazione sotto controllo, ma basta semplicemente posizionarsi nella tabella
Conti e Categorie.

Stampe avanzate
Tutte le stampe si eseguono dal menu Report, dove si trovano le funzioni per le varie stampe:

Libro giornale - comando Giornale per periodo. Si può visualizzare e stampare tutto il periodo o
un periodo determinato.
Schede conto, categorie o gruppi - Comando Schede conto / categoria. Si possono selezionare
tutte le schede o solo una selezione.
Nella sezione Periodo si determina il periodo e nella sezione Opzioni si possono attivare varie
opzioni da includere o escludere dalla stampa. La sezione Personalizzazione permette di
memorizzare le stampe con determinate opzioni e all'occorrenza riprenderle senza ripetere le
impostazioni di stampa.
Rendiconto abbellito - comando Rendiconto abbellito. Si può stampare anche per periodo e si
possono includere nella stampa varie opzioni, nonché comporre delle personalizzazioni.
Rendiconto abbellito con gruppi -  Comando Rendiconto abbellito con gruppi. Si può stampare
anche per periodo e si possono includere nella stampa varie opzioni, nonché comporre delle
personalizzazioni.
Report contabile - Comando Report contabile. Nella tabella Conti viene visaulizzato il report con
le opzioni richieste. Sono possibili report per periodo, anche con il confronto dei periodi o anni
precedenti; ogni periodo può avere delle suddivisioni e si possono memorizzare le
personalizzazioni.

Esempio di stampa per Rendiconto abbellito con gruppi
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Scheda conto / categoria del Cash Manager

La scheda conto o categoria corrisponde al mastrino e permette di avere un elenco completo dei
movimenti contabili che riguardano uno stesso conto, una stessa categoria, un centro di costo, un
segmento o un gruppo.

Aprire la scheda conto
Vi sono due metodi per aprire e stampare una scheda conto o categoria:

Primo metodo

Questo metodo è consigliato quando si vogliono visualizzare e stampare tutte o diverse schede
conto/categoria.

Dal menu Report > Schede conto/categoria

Si presenta una finestra di dialogo con le seguenti sezioni:

Conti/Categorie
Periodo
Opzioni
Personalizzazione

Per avere le informazioni dettagliate delle sezioni, cliccare sui corrispondenti link.

http://www.banana.ch/doc/it/node/7217
http://www.banana.ch/doc/it/node/2729
http://www.banana.ch/doc/it/node/2604
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Secondo metodo

Questo metodo si può utilizzare quando bisogna aprire solo una scheda alla volta all'interno delle
tabelle.

Cliccare sul piccolo simbolo che si presenta quando si seleziona la cella che contiene il numero
di conto, di categoria o di gruppo.

Aggiornare la scheda conto
La scheda conto o categoria è temporanea e viene calcolata al momento della richiesta. Se nella
Tabella Registrazioni, si cambiano o aggiungono delle registrazioni, la scheda conto non viene
aggiornata simultaneamente.

Per aggiornare la scheda conto, in seguito a modifiche, occorre impartire nuovamente il comando
Scheda conto/categoria, oppure se la scheda conto è ancora aperta, cliccare sul simbolo indicato

nell'immagine sottostante .

Nota

Nella scheda conto, categoria o di gruppo non è possibile modificare i dati. All'interno della scheda
conto, con un doppio clic sul numero di riga, il programma passa nella corrispondente riga della
tabella Registrazioni o del Preventivo.

La colonna Conto Selezionato
Nella colonna Conto Selezionato, che si può rendere visibile, a partire da qualsiasi scheda conto,
dal menu Dati > Disponi colonne, viene visualizzato il conto sul quale è avvenuto il movimento.
Quando si ottiene una scheda conto di uno o più conti, categorie, gruppi e segmenti, si vede
esattamente il conto usato.
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Schede di gruppi o classi

Nella scheda conto di un gruppo o di una classe sono raggruppate tutte le registrazioni di quei conti
che appartengono al gruppo o alla classe selezionata.
I conti o le categorie del gruppo o della classe possono essere visualizzati rendendo visibile la colonna
Conto Selezionato.  

Scheda conto del Preventivo
Se nella tabella del Preventivo sono state inserite le registrazioni di preventivo e possibile avere le
schede conto o di gruppo del preventivo:

Menu Report > Schede conto/categoria > Registrazioni di preventivo.
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Stampare le Schede conto (Libro Mastro)
Per stampare le schede:

Menu Report > Schede conto
Attraverso il Filtro si possono selezionare in automatico tutte le schede conto da stampare o in
parte (es. solo conti, centri di costo o segmenti).
Nelle diverse sezioni Periodo, Opzioni, Personalizzazioni si attivano le funzioni desiderate (es.
periodo, un conto per pagina....).
Confermare con OK, dopo aver impostato le opzioni desiderate.

Appariranno a video le schede conto selezionate. Per stampare cliccare sul menu File > Stampa.

Inserire un logo nelle schede conto
A partire da Banana 9, è possibile inserire un logo anche nella stampa delle schede conto.

Dopo aver creato il dettaglio della scheda conto procedere come segue:

Menu Report > Schede conto
Menu File > Anteprima di stampa.
Nella finestra di dialogo che si apre, alla voce Logo, indicare il vostro logo (invece della voce
nessuno).

Sono disponibili delle informazioni più dettagliate alla pagina Impostazioni logo.
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Salvare le impostazioni
Se capita di stampare regolarmente le schede di determinati conti, per esempio tutte quelle delle
vendite, è utile creare una personalizzazione apposita:

Menu Report > Schede conto > sezione Personalizzazione
Cliccare sul bottone Nuova
Indicare nella descrizione il nome, per esempio "Conti vendita"
Selezionare i conti che desiderate stampare
Dal menu File > Imposta pagina  si possono determinare i margini e altre impostazioni della
pagina.

Tutte le volte che bisogna stampare i conti, selezionare la personalizzazione creata.

 

http://www.banana.ch/doc/it/node/2605
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Libro giornale Cash Manager

Giornale
Le registrazioni nel Cash Manger, come in tutti gli applicativi di Banana Contabilità, vengono inserite
nella tabella Registrazioni. Se si desidera stampare il Libro giornale (elenco di tutti i movimenti) si può
procedere in modi diversi:

Dalla tabella Registrazioni cliccare sull'icona che indica l'anteprima di stampa e poi sull'icona
stampa.
Dalla tabella Registrazioni, selezionare dal menu File > Anteprima di stampa > icona Stampa.
Dall menu Report > Giornale per periodo.

Giornale per periodo
Banana Contabilità, attraverso il menu Report > Giornale per periodo, dà la possibilità di stampare il
Giornale con i movimenti di tutto il periodo o del periodo selezionato, inserendo la data d'inizio e di
fine periodo.

Le informazioni sulla sezione Periodo sono disponibili alla pagina Periodo delle funzioni comuni .

http://www.banana.ch/doc/it/node/2602
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Nella sezione Colonna per ordinamento è possibile scegliere in base a quale tipo di data ordinare e
stampare il giornale.
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Rendiconto abbellito

Per visualizzare il Rendiconto abbellito e il Rendiconto abbellito con gruppi, clicca sul menu Report >
Rendiconto abbellito o Rendiconto abbellito con gruppi. Sono anche possibili dei rendiconti
anche per periodo.

Il Rendiconto abbellito visualizza tutti i conti e le categorie senza gli eventuali sottogruppi
Il Rendiconto abbellito con gruppi visualizza tutti i conti e le categorie anche con i sottogruppi

Ulteriori informazioni sul Rendiconto abbellito sono disponibili alla pagina Rendiconto abbellito delle
Entrate / Uscite, perché sono analoghe. 
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Rendiconto abbellito con gruppi

Le informazioni sul Rendiconto abbellito con gruppi sono identiche  a quelle del Rendiconto abbellito
con gruppi delle Entrate /Uscite
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Report contabile

Le informazioni del Report contabile del Cash Manager sono identiche a quelle del Report contabile
delle Entrate / Uscite.
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Riassunto IVA (solo per file con opzioni IVA)

Le informazioni sul Riassunto IVA sono disponibili alla pagina web Riassunto IVA.
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Funzionalità contabili aggiuntive

Tutte le funzioni che ti servono
Il programma include una serie di funzioni per gestire in modo semplice e professionale la tua attività.
I nostri utenti sono molto soddisfatti nel risparmiare tempo, per delle pratiche contabili che altrimenti
risulterebbero complesse. Risparmierai anche denaro perché ridurrai il lavoro e i  costi del  tuo
consulente finanziario.

Bilanci e Report immediati
Stampa velocemente e in ogni momento tutti i report che ti servono:

Schede Conto
Bilancio & Conto Economico
Giornale dei movimenti
Budget e molto altro!

Fatture con codice QR
Inserisci le fatture come semplici registrazioni, indicando il numero della fattura e il conto del cliente.
Se hai diversi prodotti puoi anche usare le colonne Quantità, Unità e Prezzo unitario.

Con un comando le tue registrazioni diventano fatture professionali, pronte per essere stampate o
inviate per email ai tuoi clienti.
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Gestione clienti e fornitori
Grazie ai modelli già pronti con il partitario clienti e fornitori, puoi gestire il tutto in modo ottimale:
inserisci semplicemente nella registrazione il conto del tuo cliente o del fornitore.

Ottieni l'anagrafica completa di fornitori e clienti e tieni sotto controllo i pagamenti e gli incassi

Gestione IVA
Massima semplicità: indica nei movimenti il codice dell'aliquota IVA e a tutto il resto pensa il
programma!

Ottieni in pochi click il formulario IVA svizzero, riassunti dettagliati per periodo, per codice IVA, conto
e percentuale, sia solo per totali che con tutte le registrazioni.
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Centri di costo e Segmenti
Evidenzia settori particolari della tua attività in modo semplice ed efficiente ottenendo un livello di
dettaglio superiore!

Centri di costo e i Segmenti di Banana Contabilità Plus offrono la possibilità di vedere i dettagli di
progetti, eventi, manifestazioni, cantieri, soci e altre specifiche attività, oppure di evidenziare i costi e
i ricavi per unità, dipartimento o succursale.

Budget e Piano della Liquidità
Crea facilmente il tuo budget per un efficace controllo dei costi e un occhio al futuro!

Nella tabelle Budget inserisci delle registrazioni previsionali con la data futura e indicane la
ripetitività. Il programma proietta le tue previsioni per mese, trimestre, semestre, anno e su diversi
anni. 

Un ottimo strumento per anticipare i tempi e prendere provvedimenti tempestivi per raggiungere al
meglio i tuoi obiettivi. 

Importazione e automazione
Grazie alle innovative funzioni di importazione dati dagli estratti bancari e l'automatizzazione delle
righe memorizzate con le Regole, fare la contabilità diventa semplice, immediato e si evitano errori.

Al momento dell'importazione, per ogni movimento che si presuppone si ripeta nel futuro, si crea una
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regola, inserendo il conto di contropartita, il codice IVA, eventuale centro di costo o profitto. Nelle
importazioni successive, tutti i movimenti che hanno delle corrispondenze con le regole, vengono
inserite e completate dal programma in automatico, riducendo così drasticamente i tempi
d'inserimento dati.

 Stampe particolari grazie alle Estensioni
Le Estensioni sono programmi aggiuntivi che estendono le funzionalità di Banana Contabilità Plus.
Grazie ad esse puoi anche ottenere:

Attestato di donazione per le associazioni
Elenco libri per le biblioteche
Analisi di bilancio e flussi di cassa
Gestione del portafoglio titoli
Gestione di costruzioni e ristrutturazioni

Molte di queste estensioni richiedono il piano Advanced.
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Personalizzazione della tabella Registrazioni

La tabella Registrazioni è il fulcro della contabilità e può essere personalizzata per supportare una
molteplicità di funzioni, come per esempio inserendo quantità e prezzi, IVA, centri di costo e profitto e
molto altro ancora.

La tabella può essere personalizzata visualizzando o aggiungendo colonne, in modo tale che certe
funzionalità siano attive solo quando si ha la necessità.

Impostazione predefinita
La tabella Registrazioni è impostata con delle colonne standard, come Data, Descrizione, ecc, che
sono già visibili all'apertura del file. L'utente può decidere quali colonne rendere visibili e
personalizzarle con il comando dal menu Dati > Disponi Colonne .
Ci sono delle colonne specifiche per il tipo di file aperto. Ad esempio, nella contabilità in partita doppia
ci sono le colonne Conto Dare e Conto Avere, mentre nella contabilità Entrate e Uscite, ci sono le
colonne di Conto e Categoria.

Le colonne comuni a tutte le contabilità sono spiegate in modo esauriente nella pagina Colonne
tabella Registrazione della Contabilità in partita doppia, ovvero: 

Colonne per inserire date diverse
Data valuta, data documento, data scadenza o data presumibile.
Documenti
Colonne per inserire riferimenti ai documenti o protocollo.
Note e osservazioni
Per aggiungere informazioni supplementari di ogni genere.
Collegamenti (link) a file di documenti
Per visualizzare immediatamente i corrispettivi dei movimenti.
Tipo Documento.
Per indicare il tipo di registrazione (per esempio 01 significa saldo d'apertura).
Numero di fattura

http://www.banana.ch/doc/it/node/2710
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Per tenere nota delle fatture inviate ai clienti.
Per emettere fatture a clienti (fatturazione integrata).
Per tenere nota delle fatture ricevute dai fornitori.

Centri di costo e profitto
Per suddividere i costi e ricavi in conti specifici per progetti o altro.
Segmenti
Per avere rendiconti di succursali o settori aziendali.

Di seguito le colonne presenti solo in determinati tipi di contabilità:

Gestione dell'IVA
Colonne presenti solo nelle contabilità con IVA.
Contabilità multimoneta
Colonne presenti solo nelle contabilità in partita doppia con multi-moneta.

Personalizzare la visualizzazione
Puoi adattare la visualizzazione della tabella alle tue specifiche esigenze, come segue:

Con il comando Dati > Disponi colonne
Cambiando la larghezza e la formattazione delle colonne.
Cambiando l'ordine in cui vengono visualizzate le colonne.
Rendendo visibili o nascondendo colonne già presenti.

Creare o modificare nuove viste con delle impostazioni di visualizzazione (Disponi Tabelle).

Aggiungere colonne supplementari
Puoi aggiungere delle colonne supplementari a seconda delle tue esigenze. Le opzioni sono: 

Aggiungere delle colonne preimpostate con dei significati ben precisi
Per esempio le colonne relative alle quantità, prezzo unitario (come spiegato nel prossimo
paragrafo).
Aggiungere delle colonne libere (Dati > Disponi colonne)
Per inserire qualsiasi altra informazione necessaria.
Aggiungere delle colonne e collegarle a delle tabelle aggiunte dell'utente
È possibile aggiungere delle tabelle supplementari, per esempio la tabella Progetti, e poi creare
una colonna dove inserire il nome del progetto.

Colonne aggiuntive quantità e prezzi
Puoi inserire i quantitativi e prezzi direttamente nel file della contabilità.

Le colonne specifiche vengono visualizzate dal menu Strumenti > Aggiungi e rimuovi funzionalità.
Vengono aggiunte in blocco le seguenti colonne:

Identificativo articolo
Che si collega all'articolo presente nella tabella Articoli.
Quantità. Un valore numerico.
Prezzo unitario.
Descrittivo quantità.
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Se inserisci un valore nella colonna quantità o il prezzo, il programma calcola in automatico l'importo,
moltiplicando i due valori.

Queste colonne si prestano ad essere usate per diversi scopi:

Per gestire quantitativi e prezzi per la contabilità dei costi.
Per specificare gli elementi di una fattura.
Per inserire i movimenti di articoli indicati nella tabella Articoli o per gestire l'acquisto e vendita
di titoli (vedi estensione Portafoglio ).

Collegamento alla tabella Articoli

La tabella Articoli è una sorta di mini-magazzino integrato nella contabilità, dove: 

Puoi indicare l'elenco dei prodotti, quantità e prezzi.
Quando inserisci un articolo in una riga della tabella Registrazioni, il programma riprende in
automatico la descrizione e il prezzo di vendita.
Se inserisci dei movimenti nella tabella Registrazioni inserendo le quantità, il programma
aggiorna la quantità attuale nella tabella Articoli.

Colonne aggiuntive gestione pagamenti
Puoi aggiungere delle colonne per gestire al meglio i tuoi ordini di pagamento. 

Si aggiungono dal menu Strumenti > Aggiungi e rimuovi funzionalità.
Si rimanda alla spiegazione Gestione Pagamenti.

Colonne aggiuntive data fine, ripetizione
Puoi inoltre aggiungere delle colonne specifici per inserire movimenti automatici nella tabella
Registrazioni ricorrenti.

Si aggiungono dal menu Strumenti > Aggiungi e rimuovi funzionalità.
Si rimanda alla spiegazione Registrazioni automatiche.

Tabella Registrazioni ricorrenti
La tabella Registrazioni ricorrenti ha le medesime colonne e disposizioni della tabella Registrazioni. Se
si cambia la visualizzazione delle colonne nella tabella Registrazioni, questa verrà cambiata anche
nella tabella Registrazioni ricorrenti.

https://www.banana.ch/apps/it/node/9486
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Il sistema di raggruppamento in Banana
Contabilità+

Il sistema di raggruppamento di Banana Contabilità Plus serve per totalizzare gli importi di conti e
gruppi in modo facile e veloce. Il programma ti offre la massima flessibilità per creare tutti i livelli di
totalizzazione che vuoi. 

Il raggruppamento è uno strumento molto potente per calcolare i totali in modo automatico.

Dove viene utilizzato
Nelle tabelle Conti e Categorie per definire la struttura del Bilancio e del Conto economico. 
Nella tabella Codici IVA per raggruppare i codici IVA.
Nella tabella Articoli dell'Applicativo Magazzino.
Nella tabella Articoli dell'Applicativo Registro beni ammortizzabili.

▶ Video: Sistema di raggruppamento e totalizzazione
 

Come funziona
Il raggruppamento si basa sempre su due colonne:

La colonna Gruppo, dove si indicano gli identificativi dei gruppi, che possono essere testuali o
numerici.
La colonna Somma In, dove per ogni riga di conto o di gruppo si indica il Gruppo di
totalizzazione.

Ogni riga del gruppo è una riga di totale, dove:

I saldi dei gruppi sono la somma delle righe che, nella colonna Somma In, contengono il nome
del gruppo.
Il programma calcola i totali di tutte le colonne che contengono importi (tipo Importo), sia quelle
predefinite (Apertura, Saldo, ecc.) sia quelle aggiunte manualmente.

Il raggruppamento permette di creare molti livelli di totalizzazione.

https://www.banana.ch/it/node/11608
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La logica del programma
Per capire la logica, presentiamo un esempio di una piccola parte del piano dei conti. Per i conti
Cassa, Posta e Banca creiamo il gruppo Liquidità:

Nella riga sottostate dei conti della liquidità, nella colonna Gruppo, si inserisce il nome del
gruppo Liquidità.
Nella colonna Descrizione, si inserisce la descrizione del gruppo.
Per fare in modo che il programma possa aggiornare i saldi del gruppo Liquidità, bisogna
indicare quali conti devono essere totalizzati.
Nella colonna Somma In del conto Cassa, Posta e Banca si inserisce il nome del gruppo
Liquidità. I saldi del gruppo si aggiornano immediatamente.  

Con la stessa logica possiamo anche raggruppare i gruppi. Infatti, anche i gruppi possono essere
totalizzati in altri gruppi di livello superiore.
Supponiamo di aggiungere un gruppo in cui raggruppare e quindi totalizzare il gruppo della Liquidità.

Nella riga sottostate del gruppo Liquidità, nella colonna Gruppo, si inserisce il nome del gruppo
Attivi.
Nella colonna Descrizione, si inserisce la descrizione del gruppo.
Per fare in modo che il programma possa aggiornare i saldi del gruppo Attivi, bisogna indicare
quali gruppi devono essere totalizzati.
Nella colonna Somma In del gruppo Liquidità si inserisce il nome del gruppo Attivi. I saldi del
gruppo si aggiornano immediatamente.
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Seguendo questa logica è possibile creare una struttura con gruppi e sottogruppi per tutto il piano
contabile, in modo da creare piani contabili adatti a qualsiasi nazione ed esigenza specifica.

La stessa identica logica può anche essere applicata per raggruppare i codici IVA nella tabella Codici
IVA, e anche per raggruppare gli articoli nella tabella Articoli del Magazzino e del Registro beni
ammortizzabili.

Ampio uso del sistema di totalizzazione
Il sistema di totalizzazione è molto flessibile:

In un Gruppo si possono sommare Conti e Gruppi.
Ai testi dei titoli si può attribuire il gruppo di appartenenza. 
Si può usare qualsiasi genere di numerazione (numerica e/o delle lettere).
Si possono creare fino a 100 livelli di totalizzazione.
La totalizzazione del gruppo è indipendente dalla sequenza delle righe:

La riga di totale può essere definita prima e dopo le righe dei conti o gruppi.
La riga di totale può essere definita anche in una posizione completamente staccata dalle
righe dei conti e dei gruppi, come nel caso del partitario Clienti / Fornitori.

Lo stesso conto non può essere totalizzato contemporaneamente in due Gruppi.
Il sistema si usa anche per totalizzare i Centri di costo e i Segmenti.
 

La totalizzazione delle colonne importo

La procedura di calcolo totalizza le colonne del tipo importo.
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Vengono totalizzate le colonne importo definite dal sistema.
Vengono totalizzate le colonne importo aggiunte dall'utente.

La sequenza di calcolo

Il programma calcola i totali nel modo seguente:

Azzera i valori delle colonne importi delle righe di Gruppo.
Somma gli importi delle righe dei Conti nelle righe di Gruppo (primo livello di calcolo).
Somma il saldo delle righe dei Gruppi nei Gruppi di livello superiore.
Ripete l'operazione finché tutti i livelli sono calcolati.

Quando un Gruppo viene totalizzato in un Gruppo di livello inferiore, motivo per cui si crea un ciclo 
infinito di errore.

Controllo e segnalazione errori
Quando si creano dei raggruppamenti il programma controlla e segnala eventuali errori, in modo da
poterli subito correggere. 

Quando nella colonna Somma In è stato indicato un gruppo inesistente, il programma segnala l'errore
"Gruppo non trovato". In questo caso è sufficiente:

Creare il gruppo nella colonna Gruppo
Ricontrollare la contabilità con il comando Controlla contabilità 
Ricalcolare tutti i totali con il comando Ricalcola totali. 
 

Rinomina i gruppi
Con il comando Rinomina si possono rinominare in automatico i nomi dei gruppi già esistenti, senza
dover cambiare manualmente le corrispondenze nelle colonne Gruppo e Somma In.

Stampe
Quando si stampano il Bilancio, il Conto Economico o altri report che contengono dei raggruppamenti,
la stampa riporta l'ordine dei raggruppamenti così come sono stati impostati nelle varie tabelle.
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Gestione Clienti

La gestione Clienti di Banana Contabilità Plus consente di registrare, organizzare, gestire le
informazioni dei clienti e permette di tenere traccia delle transazioni e dei pagamenti dei clienti, delle
scadenze di pagamento e delle informazioni di contatto. Puoi monitorare i pagamenti dei clienti, con
l'aggiornamento dello stato del pagamento delle fatture emesse nonché inserire e stampare fatture.

La gestione Clienti è una delle funzionalità di Banana Contabilità Plus disponibile in tutti gli applicativi
contabili, ma principalmente usata nella contabilità in partita doppia.

Guarda anche la gestione dei Fornitori.

Registrare i movimenti dei clienti
La tabella Registrazioni  è il fulcro di Banana Contabilità e viene usata per registrare tutte le
operazioni, incluse i movimenti dei clienti, semplicemente indicando il conto del cliente. Lavori
velocemente perché puoi selezionare, copiare e incollare i movimenti dei clienti già inseriti in
precedenza. Se fai degli errori puoi correggere quindi è facile registrare:

Emissioni di fatture
Incassi dei clienti
Note di credito o storni
Creazioni di fatture

Ci sono colonne dove inserire varie informazioni, ovvero:

La data dell'operazione, di scadenza, di aspettativa e di pagamento.
Il numero fattura.
Il Conto Dare e Avere dove indicare il conto cliente e la contropartita.
L'importo.
I codici IVA per il calcolo automatico dell'IVA. 
Collegamenti a documenti digitali (per esempio la fattura emessa al cliente, o delle annotazioni
in pdf).

Conti clienti
I conti dei clienti sono utilizzati per registrare tutti i movimenti relativi ai clienti di un'azienda.

Le funzioni principali dei conti clienti sono le seguenti:

Creare un conto per ogni clienti e tenere traccia di tutte le transazioni effettuate.

http://www.banana.ch/doc/it/node/2630
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Registrare le fatture emesse per ogni cliente.
Registrare i pagamenti dei clienti e associarli alle fatture emesse.

In Banana Contabilità:

I conti dei clienti e gli indirizzi (nome, cognome, nome società, indirizzo, lingua del  cliente,
partita IVA, ecc..) vengono impostati nella tabella Conti.
I movimenti contabili sui conti vengono inseriti nella tabella Registrazioni.
Dopo ogni registrazione, tutti i saldi dei conti clienti (tabella Conti) vengono automaticamente
aggiornati e hai immediatamente una visione d'insieme dei saldi ancora da incassare.

 Registrazioni fatture emesse
La fattura viene utilizzata per fini contabili e fiscali, poiché consente di registrare in modo accurato i
ricavi e le spese dell'azienda, e di calcolare le imposte sulle vendite o sull'acquisto.

Se emetti le fatture in Word, Excel o altri programmi, puoi registrare l'avvenuta emissione in
contabilità in modo da sapere qual è il dovuto del cliente ed eventualmente inviare richiami.

In Banana Contabilità le fatture vengono contabilizzate nella tabella Registrazioni :

Inserendo la data e la descrizione
Inserendo un numero di fattura
Registrando nel conto Dare il conto del cliente e nel conto Avere il ricavo
Indicando il codice IVA per le vendite o i servizi. I calcoli e gli importi IVA vengono inseriti in
automatico.

Con la contabilizzazione della fattura, il programma in automatico crea la fattura e la stampa.

Creazione e stampa fatture
Direttamente nella tabella Registrazione, puoi anche inserire dei movimenti per creare fatture come
semplici registrazioni nella tabella Registrazioni.

Inserendo il conto Dare e Avere, oltre che alla stampa della fattura, in contemporanea hai la
contabilizzazione della stessa nel file della contabilità.

http://www.banana.ch/doc/it/node/2630
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Dal Menu Report > Clienti > Stampa fattura, è possibile:

Visualizzare la fattura in anteprima e stamparla.
Scegliere il Layout di stampa  e impostare altre informazioni che servono a personalizzare la
stampa, come il Codice QR.

Sono possibili maggiori personalizzazioni con il piano Advanced .

Registrazioni incassi
In Banana contabilità gli incassi si registrano nella Tabella Registrazioni con una delle seguenti
modalità:

Registrazione manuale:
Si registra la data e la descrizione
Nella colonna Fattura, inserendo il conto del cliente, in un menu a tendina vengono
visualizzate le fatture ancora aperte, basta selezionare la fattura incassata e premendo il
tasto invio, il programma inserisce in automatico il conto del cliente in Avere, e l'importo
della fattura. Basta poi inserire il conto della liquidità in Dare per completare la
registrazione.

Importazione dati dagli estratti conto con le Regole .
Il programma importa i dati dagli estratti conto ISO 20022  e con l'uso delle Regole il
programma inserisce la registrazione completa, inserendo tutti i dati, senza dover
intervenire manualmente.

Fatture aperte

Le fatture aperte per cliente sono fatture emesse che rimangono aperte o in sospeso perché il cliente

https://www.banana.ch/apps/it/node/9034
https://www.banana.ch/it/buy
https://www.banana.ch/doc/it/rules
http://www.banana.ch/doc/it/node/8785
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deve ancora effettuare il pagamento completo.

Le fatture aperte per cliente possono essere gestite tramite un registro contabile che tiene traccia
delle fatture emesse, delle scadenze di pagamento e dei pagamenti ricevuti. In questo modo, il
venditore può monitorare la situazione finanziaria di ogni cliente e inviare dei solleciti di pagamento
nel caso in cui le fatture rimangano aperte per troppo tempo.

È importante notare che le fatture aperte per cliente possono influire sulla liquidità dell'azienda del
venditore, in quanto il denaro legato a queste fatture non è ancora stato incassato.

Banana Contabilità genera in automatico il report delle fatture aperte dove puoi verificare
immediatamente quali fatture sono ancora da incassare e di quale cliente, nonché l'ammontare totale
delle fatture scoperte.

Ci sono due tipi di report:

Fatture aperte per cliente, dove vengono elencate tutte le fatture aperte per ogni cliente.1.
Fatture aperte per scadenza, dove vengono elencate le fatture aperte in ordine di scadenza.2.

La data di scadenza di una fattura può essere impostata in modi diversi. Maggiori informazioni sono
disponibili alla seguente pagina Scadenze e termini di pagamento.

 Scheda conto

Le schede conto sono documenti utilizzati in contabilità che riportano le transazioni finanziarie di
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un'azienda. Ogni scheda rappresenta un conto specifico nel registro contabile generale dell'azienda e
contiene informazioni dettagliate sulle transazioni che riguardano quel conto, come la data
dell'operazione finanziaria, il tipo di operazione, l'importo e la descrizione dell'operazione.

In Banana contabilità, sulla base dei dati inseriti nella tabella Registrazioni, il programma in
automatico elabora la Scheda conto per ogni cliente, dove vengono riportati il saldo di apertura, tutti i
movimenti e relativo saldo finale. Puoi avere la scheda conto anche per periodo.

Richiami
I richiami di pagamento sono utilizzati per richiedere ai clienti il pagamento delle fatture scadute o in
sospeso.

Attraverso la funzione dei richiami di pagamento si accelera il processo di pagamento dai clienti,
riducendo i ritardi, e allo stesso tempo si gestisce efficacemente il flusso di cassa.

Banana Contabilità mette a disposizione delle funzioni per:

Identificare le fatture scadute o in sospeso.
Generare il richiamo di pagamento.
Personalizzare i richiami di pagamento.

In Banana Contabilità Plus puoi stampare i richiami in due modalità diverse:

Con i Layout Richiami
Stampa riepilogo richiami (lista fatture scadute).
Stampa senza bollettino di pagamento QR.
Personalizzazioni limitate.
Funzione disponibile in Banana Contabilità Plus - qualsiasi piano (escluse limitazioni piano
Free).

Con il layout Fattura
Stampa con bollettino di pagamento QR.
Personalizzazioni previste dai layout.
Richiede la versione di Banana Contabilità Plus Dev-Channel  e il piano Advanced .

http://www.banana.ch/doc/it/node/8296
http://www.banana.ch/doc/it/node/9997
https://www.banana.ch/it/insiderprogram
https://www.banana.ch/it/advanced
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Note di credito

La nota di credito è un documento contabile utilizzato per correggere o annullare una fattura già
emessa. Può essere emessa per una serie di motivi:

Rimborso di un pagamento in eccesso
Riduzione del prezzo di un prodotto o servizio
Reso di un prodotto
Correzione di un errore di fatturazione

In Banana Contabilità contabilizzi le note di credito nella tabella Registrazioni, inserendo nel conto
Dare il conto del ricavo e nel conto Avere il conto del cliente; il codice IVA deve essere inserito con il
segno meno davanti, in modo da stornare contemporaneamente l'importo IVA.

Il programma utilizza la registrazione contabile della nota di credito per creare in automatico la
stampa della nota di credito .

Impostare e utilizzare le funzionalità clienti e fatture
Impostare i conti per una contabilità sul fatturato (principio di competenza) oppure1.
Impostare i conti per una contabilità sull'incassato (principio di cassa).2.
Configurare le impostazioni clienti.3.
Impostare la tabella registrazioni e registrare le fatture.4.
Resoconti fatture aperte, scadute o emesse.5.

http://www.banana.ch/doc/it/node/8295
http://www.banana.ch/doc/it/node/9371
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Creare le fatture.6.

Note
Contabilità multimoneta: i resoconti si basano sui saldi in divisa del conto del cliente, per cui eventuali
differenze di cambio non vengono considerate.
Nella tabella Fatture emesse sono elencate anche le registrazioni differenze di cambio, nelle altre
stampe invece quello che fa stato è unicamente l'importo in moneta del cliente.

File d'esempio
Clienti e fornitori.ac2

https://www.banana.ch/apps/it/node/8521
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Indirizzi | Partitario Clienti/Fornitori | Soci

Nella tabella Conti, nella vista Indirizzi, sono presenti le colonne per gestire gli indirizzi dei clienti,
dei fornitori o dei soci di un'associazione.
I dati relativi agli indirizzi sono fondamentali per la gestione delle fatture, dei richiami e del controllo
degli incassi e dei pagamenti.
Normalmente le colonne relative alla gestione Indirizzi non sono presenti nella tabella Conti, ma è
possibile aggiungerle.

Se nella tabella Conti, mancano le colonne per per gestire i dati degli indirizzi, è possibile aggiungerle:

Menu Strumenti → Aggiungi nuove funzionalità → Aggiungi colonne Indirizzi nella tabella Conti.

Se manca la colonna IBAN, il tuo file contabile ha una vecchia configurazione e devi convertirlo con il
comando Strumenti > Converti in nuovo file...

Nella tabella Conti il comando aggiunge:

La vista Indirizzo nella quale sono visualizzate le colonne per inserire i dati degli indirizzi.

Per modificare la vista o la disposizione delle colonne vai al comando Disponi colonne.

 Le colonne della vista Indirizzo
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Prefisso

Inserire sigla di cortesia (Signor, Signora, Dottor o altro).

Nome

Il nome del cliente, del fornitore o del socio.

Cognome

Il nome del cliente, del fornitore o del socio.

Organizzazione

Inserire il nome della ditta, dell'associazione.

Via

La via dove risiede il cliente, il fornitore o il socio.

Extra

Colonna per inserire altri dati dell'indirizzo, come per esempio la casella postale, o per inserire un
indirizzo molto esteso.

CAP

Il codice di avviamento postale.

Località

Il nome della città del cliente, fornitore o socio.

Nazione

La nazione inerente alla città.
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Codice Nazione

La siglia della nazione.

Lingua

È possibile definire la lingua per ogni conto del cliente, fornitore o socio. Questo consente di
visualizzare e stampare i documenti (es. fattura) nella loro lingua di appartenenza. 
Indicare:

de - per tedesco
fr -  per francese
it - per italiano
en - per inglese
es - per spagnolo
nl - per olandese
zh - per cinese
pt - per portoghese
ru - per russo

Tel.Principale

Numero di telefono fisso

Mobile

Numero di telefono cellulare

Fax

Nr. di fax

Email lavoro

indirizzo email.

www

indirizzo del sito internet del cliente, fornitore, associazione.

Nascita

La data di nascita del cliente, fornitore, associazione.

Giorni

Si inserisce un numero di giorni entro il quale deve avvenire l'incasso, il pagamento.

Limite

Se viene fatto un credito, viene indicato il limite di credito, o di debito se si tratta di un fornitore.
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Banca

Il nome della banca del cliente, del fornitore o del socio.

IBAN

Numero di IBAN della banca del cliente, del fornitore o del socio.

Clearing

Il codice identificativo della banca cliente, del fornitore o del socio.
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Gestione prestazioni convenute (fatturato)

Introduzione
In Banana è possibile gestire i clienti sia sul fatturato che sull'incassato. Una spiegazione dettagliata è
disponibile alla pagina Contabilità sul fatturato o incassato .

Qui di seguito viene spiegato come impostare il gruppo e i conti dei clienti, in modo tale da poter
avere un elenco delle fatture separate per ogni cliente.

Se si hanno poche fatture e non si vuole tenere un dettaglio per cliente, è anche possibile avere un
solo conto dove registrare tutte le fatture dei clienti. In questo caso, l'elenco delle fatture sarà
raggruppato per l'insieme dei clienti e non per singolo cliente.

Impostare il gruppo e i conti dei clienti
Il partitario clienti con relativi conti e/o gruppi si inseriscono alla fine del piano contabile con una
sezione separata.

Per creare il partitario occorre aggiungere le seguenti impostazioni:

Una sezione * (intestazione)  (vedi sezioni).
Una sezione 01 per i clienti (vedi sezioni).
I conti clienti che si desiderano (vedi aggiungere un nuovo conto). Ogni cliente è una riga del
piano dei conti e ha un proprio numero di conto. La numerazione dei conti è libera (vedi Conti),
tuttavia si consiglia di utilizzare unicamente cifre, in particolare per la gestione dei pagamenti.
Un gruppo dove sono totalizzati tutti i conti clienti.
Questo gruppo è a sua volta totalizzato in un gruppo presente negli attivi.

In alternativa, i conti e/o i gruppi dei clienti possono essere inseriti direttamente nella sezione degli
attivi.

Il totale clienti (110) viene sommato nel gruppo riepilogativo 110 della colonna Somma in.
Lo stesso numero o codice, utilizzato nella colonna Somma in (110) deve essere impostato nella
colonna Gruppo degli Attivi, per il riporto del totale Clienti nel Bilancio.
La numerazione dei gruppi è libera (vedi Gruppi).

Registrare l'emissione di fattura
La fattura emessa si registra inserendo i seguenti dati nelle rispettive colonne:

Data della fattura e eventuale numero di documento
Numero di fattura - È molto importante inserire il numero della fattura nella colonna Fattura,
perché serve per l'automatismo dei vari report dei clienti e per chiudere in automatico la fattura
aperta del cliente quando si registra il pagamento.
Conto del cliente in Dare e conto del ricavo in Avere

https://www.banana.ch/area/it/node/11053
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Il codice IVA corrispondente alle vendite.

Registrare un incasso
Per registrare l'incasso di una fattura del cliente ci sono due modalità :

Registrare manualmente l'incasso della fattura del cliente.1.
Registrazione in automatico con importazione dei dati dall'estratto conto in formato ISO 20022.2.

L'incasso di una fattura del cliente si registra inserendo i seguenti dati nelle rispettive colonne:

Nella colonna Data inserire la data dell'incasso della fattura.
Nella colonna Tipo inserire 11 (Pagamento dal cliente).
Nella colonna Fattura inserire il numero della fattura pagata.

Facendo doppio clic nella cella il programma visualizza l'elenco delle fatture aperte.
In alternativa cliccare sul tasto F2. Se il tasto F2 non funzionasse, attivare le impostazioni
clienti, inserendo il gruppo del Partitario Clienti, dal menu Report → Clienti → Impostazioni

.
Selezionare il numero della fattura incassata. Il programma inserisce automaticamente:

Nella colonna Descrizione, la descrizione del pagamento.
Nella colonna Avere, il conto del cliente.
Nella colonna Importo, l'importo della fattura.
Se l'importo inserito non è comprensivo dell'IVA e i clienti sono impostati come
centri di costo, dovete configurare i centri di costo correttamente affinché utilizzino
l'importo con IVA in Proprietà file (dati base), sezione IVA. Vedi anche Importo IVA
con i centri di costo.

Nella colonna Dare, inserire manualmente la contropartita (il conto bancario dove è stato
incassato l'importo).

Registrare una nota di credito
Affinché l'importo venga dedotto dalla fattura iniziale è necessario utilizzare lo stesso numero
di fattura.

Se il documento di rettifica (ad esempio una nota di credito) presenta una numerazione diversa
che bisogna comunque tenere a disposizione, scrivere tale riferimento in un'altra colonna, ad
esempio Doc. Originale
Inserire i dati per le colonne Data, Doc., Doc.Originale, Descrizione
Nella colonna Dare registrare il conto dei ricavi (lo  stesso utilizzato per la fattura al cliente);
nella colonna Avere registrare il conto del cliente 
Inserire l'importo e nella colonna Codice IVA inserire il codice delle vendite preceduto dal segno
meno, in modo tale che l'operazione IVA sia stornata, oppure usare un Codice IVA apposito per
le note di credito (impostato nella tabella Codici IVA ).

Nota: per stampare la nota di credito da inviare al cliente, bisogna indicare nella colonna TipoDoc :
12, vedi Inserimento di una nota di credito.

http://www.banana.ch/doc/it/node/9913
http://www.banana.ch/doc/it/node/4651
http://www.banana.ch/doc/it/node/3406
http://www.banana.ch/doc/it/node/9828
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Gestione prestazioni ricevute (incassato)

È possibile gestire il partitario clienti e fornitori sull'incassato  con i Centri di costo e di profitto.

Si consiglia di usare il centro di costo CC3 (conti preceduti dal punto e virgola ";").
È necessario impostare il gruppo dei clienti dal menu Report → Clienti → Impostazioni.

Per gli utenti svizzeri che hanno l'IVA sull'incassato, questa impostazione permette di
gestire l'IVA in modo ottimale e conoscere i dettagli per i clienti e fornitori.

Con questa impostazione i saldi dei centri di costo non appariranno nel Bilancio, ma si avranno
ugualmente tutti i dati e i report per scopi interni.

Registrare l'emissione di fattura
Quando si emette la fattura, si registra come segue:

Nella colonna Data, inserire la data della fattura.
Nella colonna Doc, inserire il numero di documento se disponibile.
Nella colonna Fattura, inserire il numero di fattura.
Nella colonna Descrizione, inserire una descrizione.
Nelle colonne Dare, Avere e Codice IVA non inserire alcun dato.
Nella colonna Importo, inserire l'importo lordo senza alcun codice IVA.
Il codice IVA nel caso della gestione sull'incassato si registra quando viene incassata la fattura.
Nella colonna CC3, inserire il conto CC3 del cliente senza il ";" (es. 10004)

Registrare un incasso
Quando si incassa una fattura, si registra come segue:

Nella colonna Data, inserire la data dell'incasso della fattura.
Nella colonna Doc, inserire il numero di documento se disponibile.
Nella colonna Fattura, inserire il numero di fattura incassata.
Nella colonna Descrizione, inserire una descrizione.
Nella colonna Dare, inserire il conto bancario (o altro conto di liquidità).
Nella colonna Avere, inserire il conto del ricavo corrispondente alla fattura.
Nella colonna Importo, inserire l'importo lordo.
Nella colonna Codice IVA, inserire il codice IVA delle vendite o della prestazione fatturata.
Nella colonna CC3, inserire il conto CC3 del cliente senza il ";" con il segno meno "-" davanti al
conto (es. -10004).

Nella fatturazione integrata con la contabilità Entrate / Uscite, con partitario clienti impostato con i
centri di profitto, l'opzione Registra (+/-) i centri di costo come la categoria non deve essere attivata,
perché nell'emissione della fattura non sono indicati il conto e la categoria.

https://www.banana.ch/it/node/10968#contabilit_sullincassato_principio_di_cassa
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Maggiori informazioni sono disponibili alla pagina Clienti e fornitori con l'IVA sull'incassato.

 Registrare una nota di credito sull'incasso
Affinché l'importo venga dedotto dalla fattura iniziale è necessario utilizzare lo stesso numero
di fattura.

Se il documento di rettifica (ad esempio una nota di credito) presenta una numerazione diversa
che bisogna comunque tenere a disposizione, scrivere tale riferimento in un'altra colonna, ad
esempio Doc. Originale
Inserire i dati per le colonne Data, Doc., Doc.Originale, descrizione
Lasciare vuote le colonne Dare e Avere
Inserire l'importo e nella colonna CC3, inserire con il segno - il centro di costo del cliente.

Nota: per stampare la nota di credito da inviare al cliente, bisogna indicare nella colonna TipoDoc :
12, vedi Inserimento di una nota di credito.

https://www.banana.ch/area/it/node/10506#A
http://www.banana.ch/doc/it/node/9828
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Impostazioni clienti

Per attivare le opzioni del menu Clienti occorre impostare il gruppo dei clienti dal menu Report →
Clienti → Impostazioni.

Qui di seguito si spiegano le funzionalità relative ai clienti, ma si applicano anche per quelle dei
fornitori (Report → Fornitori→ Impostazioni), i dialoghi che seguono sono identici.

Senza l'indicazione del gruppo, nelle impostazioni del menu Clienti, tutte le funzionalità sono
disattivate.

Generale
Gruppo o conto

Selezionare il gruppo o il conto generico che contiene l'elenco dei clienti o fornitori. Il gruppo o il conto
dev'essere già presente nella tabella Conti.

Maggiori dettagli per impostare il partitario clienti o fornitori:

Impostare il partitario clienti e Impostare il partitario fornitori (sul fatturato).
Impostare il partitario clienti e Impostare il partitario fornitori (sull'incassato).

Scadenza fatture (in giorni)

Per il calcolo della scadenza fatture il programma utilizza in ordine di priorità:

La data di scadenza, se è stata immessa nella riga di registrazione.
Se per lo stesso numero di  fattura ci sono più date, il programma prende in considerazione
quella più recente.
Se viene indicato il numero di giorni nella colonna TerminePagamentoInGiorni della tabella
Conti, la data della registrazione è aumentata dal numero di giorni impostato. 
La data della registrazione aumentata dai giorni indicati nel dialogo d'impostazione.

Includi movimenti precedenti (anni)

Se 0 il programma non visualizzerà le fatture dell'anno precedente, ma solo i saldi di apertura
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del conto cliente.
Se 1 il programma includerà nella scheda cliente anche le fatture dell'anno precedente.
Se 2 o oltre il programma includerà nella scheda cliente anche le fatture degli anni prima.

Avanzato

Collegamento al documento fattura

Si possono salvare le fatture (pdf, doc o altro) e inserire il link nella casella Collegamento al
documento fattura. Nella tabella Registrazioni, colonna Fattura, se viene indicato il numero di
fattura, il programma apre il documento, permettendo di accedere al contenuto.

Il link può contenere:

Il nome XML <DocInvoice> o di un'altra colonna contenuto fra <>. 
Se usate il comando "<DocInvoice>.pdf" e siete sulla riga con il numero fattura 100, il
programma cercherà di aprire il file "100.pdf". Potete anche far precedere il nome del file dal
nome di una catella.
È possibile utilizzare qualsiasi estensione di file. Questa deve essere tuttavia presente
nell'elenco estensione dei files considerati sicuri (Strumenti → Opzioni programma → Avanzato).
È possibile indicare anche un percorso prima del nome campo che contiene il nome del
documento da aprire.
Con il link "c://temp//<DocInvoice>.pdf" e il numero di fattura 100, il programma cerca e apre il
file c:\temp\100.pdf.
Il nome della cartella è relativo a quello dove si trova il file della contabilità.

Testo alternativo per autocompletamento pagamento (Payment %1)

L'inserimento del pagamento di una fattura può essere facilitato dal completamento automatico del
pagamento, attivabile tramite il tasto F2 nel campo Fattura della tabella Registrazioni. 

Il completamento automatico completa le colonne di registrazione, come numero di fattura,
descrizione, importo, conti. Nella colonna Descrizione è possibile modificare il testo 'Pagamento'
seguito dalla descrizione della prima riga della fattura (%1), indicando il testo desiderato.

Arrotondamento fattura (moneta base)

Indicare l'importo minimo per l'arrotondamento del totale fattura. Ad esempio:
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0.01 arrotonda il totale della fattura al centesimo, 0.10 arrotonda ai 10 centesimi.

Se il campo è vuoto, il totale delle fatture in CHF viene arrotondato ai 5 cts., per le altre divise
l'arrotondamento è al centesimo.

Disattiva l'autocompletamento dei dati della fattura

Questa opzione viene solitamente disattivata quando ci sono molte registrazioni in contabilità e
l'inserimento dei dati risulta rallentato dalla visualizzazione dell'elenco delle fatture aperte nel campo
Fattura della tabella Registrazioni.

Apertura di un documento fattura
Posizionatevi nella tabella Registrazioni, colonna Fattura, nella cella dove è stato inserito il link
del documento da aprire.
Con il tasto destro del mouse aprite il menu contestuale.
Scegliete il comando Apri collegamento fattura.
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Operazioni diverse clienti

Per gestire al meglio i clienti, qui di seguito spieghiamo delle funzionalità e impostazioni molto
importanti per velocizzare il lavoro e ottenere i report correttamente.

Visualizzare la colonna Fattura nella tabella Registrazioni
Completamento automatico dei dati della fattura
Comandi Estrai righe fattura e apri collegamento fattura
Abilitare le colonne indirizzi (opzionale)
Impostare la data di scadenza delle fatture
Configurare le impostazioni clienti

 Visualizzare la colonna Fattura nella tabella Registrazioni
Se la colonna Fattura non è visibile nella tabella Registrazioni, la si può attivare dal Menu Dati →
Disponi colonne → colonna DocFattura.

È molto importate inserire il numero di fattura per diversi automatismi del programma che riguardano
l'elaborazione dei vari report e la chiusura dell'importo nella scheda del cliente quando la fattura
viene incassata.

Nella colonna Fattura, cliccando sulla cella si accede alla fattura salvata in Pdf

 Completamento automatico dei dati della fattura

Quando si registra un incasso o una rettifica di una fattura emessa, il programma propone dei
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suggerimenti per completare la registrazione in modo automatico. Si procede nel seguente modo:

Creare una nuova riga di registrazione, aggiungendo la data e l'eventuale numero di
documento.
Nella colonna Fattura premere il tasto F2:

Apparirà l'elenco delle fatture ancora aperte. Se si scrive un numero di fattura o un
numero cliente, l'elenco verrà filtrato in base al testo inserito.
Selezionare la fattura che si desidera dall'elenco e premere Enter. Il programma
completerà in automatico la registrazione con la descrizione, il conto dare o conto avere e
l'importo. Naturalmente i dati possono essere modificati manualmente.

È possibile indicare oltre alla data anche il conto cliente prima di premere F2 per visualizzare
l'elenco delle fatture aperte, in questo caso l'elenco sarà filtrato con il conto cliente presente
nella riga di registrazione.

Note

L'elenco visualizzato nella colonna Fattura include sia le fatture dei clienti sia quelle dei fornitori. Una
fattura di un fornitore può avere lo stesso numero di una fattura di un altro fornitore, poiché il criterio
di visualizzazione considera oltre al numero di fattura anche il numero del conto fornitore.
 

 Comandi Estrai righe fattura e apri fattura

Il comando Estrai righe fattura visualizza i movimenti della fattura selezionata.
Il comando è disponibile cliccando sul simbolo blu in alto a destra della cella oppure con il tasto destro
del mouse.

 Il comando Apri collegamento fattura esegue il testo definito nelle impostazioni clienti (Report -
Clienti - Impostazioni - Avanzato - Collegamento al documento fattura).

Nella linea di comando è possibile indicare anche altre colonne presenti nella tabella utilizzando il loro
nome XML.

Se appare il messaggio 'File con estensione considerata non sicura', aggiungere l'estensione (ad
esempio .doc) tramite il comando Strumenti - Opzioni programma, Avanzato, Estensione file.
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 Abilitare le colonne indirizzi (opzionale)
Si può fare in modo che nel piano dei conti ci siano delle colonne per inserire l'indirizzo e altri dati del
cliente:

Andare nel menu Strumenti - Aggiungi nuove funzionalità
Scegliere il comando Aggiungi colonne indirizzi nella tabella conti.
(Se non vedete questa opzione nella lista è perché questa funzionalità è già stata attivata).

Il programma aggiunge nella tabella conti:

Una vista Indirizzi dove sono visibili le colonne aggiunte.
Le colonne che permettono di inserire i dati dell'indirizzo e altre informazioni.

Per rendere visibili una o più di queste colonne, anche nelle altre viste usare il comando
Dati - Disponi colonne.
Per creare altre viste con solo determinate colonne usare il comando Disponi
Tabelle (menu Dati).

Selezionare la tabella Conti, vista Indirizzo e aggiungere le informazioni che si desiderano ai conti
clienti.

 Impostare la data di scadenza delle fatture
Per impostare/modificare le date di scadenza delle fatture potete intervenire su tre livelli con priorità
maggiore per il primo livello. Le date di scadenza saranno visualizzate nello scadenzario pagamenti e
stampate sui documenti fattura. 

1. livello - impostazione della scadenza sul singolo documento fattura

Nella riga di registrazione della fattura, tabella Registrazioni, vista Scadenze, è a disposizione una
colonna Scadenza. Se la data è impostata, avrà priorità sulle date impostate nel secondo e terzo
livello.

2. livello - impostazione della scadenza sul singolo conto cliente/fornitore

Per impostare una scadenza generica a livello di cliente, ad esempio +20 giorni dalla data di
emissione del documento, selezionare il conto cliente nella tabella Conti, vista Indirizzo, colonna
Giorni (PaymentTermInDays) e impostare il numero di giorni desiderato.

3. livello - impostazione generale

Con il comando Report → Clienti →Impostazioni è possibile stabilire le scadenze che saranno applicate
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a tutto il gruppo di clienti/fornitori.

 Configurare le impostazioni clienti
Selezionare il comando comando Report → Clienti →Impostazioni.
Importante è indicare nel "Gruppo o conto", il gruppo del piano dei conti dove sono raggruppati
i diversi conti dei clienti.
Per la spiegazione delle diverse opzioni vedi Impostazioni clienti/fornitori
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Elenco fatture clienti

Visualizzare le fatture emesse ai clienti
Comando: Report → Clienti → Fatture emesse...

Questo dialogo è identico sia per il menu Clienti sia per quello dei Fornitori.
Qui di seguito si spiegano le funzionalità relative ai clienti, ma si applicano anche ai fornitori.

Tutti i clienti

Visualizza gli estratti conto di tutti i clienti che appartengono al gruppo definito nelle impostazioni
clienti/fornitori

Solo cliente selezionato

Visualizza l'estratto conto del cliente selezionato che appartiene al gruppo definito nelle impostazioni
clienti/fornitori

Visualizzare le fatture aperte
Comando: Report → Clienti → Fatture aperte per clienti.

In questa tabella vengono visualizzate le fatture che hanno un saldo aperto.

Per le contabilità multidivisa, se sono presenti differenze di cambio non registrate per un determinato
cliente, verrà visualizzata una riga di 'Aggiustamento differenze di cambio' che pareggia il saldo
dell'elenco fatture aperte con il saldo della scheda conto.
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Visualizzare le fatture scadute
Comando: Report → Clienti → Fatture aperte per data scadenza.

In questa tabella vengono visualizzate le fatture che hanno un saldo aperto, raggruppate per periodo
di scadenza.

La data di scadenza di una fattura può essere impostata in modi diversi. Maggiori informazioni sono
disponibili alla seguente pagina Scadenze e termini di pagamento.
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Stampa estratti

Per visualizzare questa finestra è necessario configurare le impostazioni dei clienti.

Si accede alla stampa degli estratti dal menu Report > Clienti > Stampa estratti.

È fondamentale installare il layout Estratto conto cliente per la stampa dell'estratto. Ci sono due
modalità:

Dal menu Estensioni > Gestisci estensioni seleziona il layout Estratto conto cliente dalla
lista delle estensioni e cliccare sul bottone Installa.
Da menu Report > Clienti > Stampa estratti > Altri layouts  seleziona il layout Estratto
conto cliente.

Data documento

Data stampata sul documento. Non è possibile impostare una data precedente alla data dell'ultima
registrazione esistente.

Layout

Permette l'installazione del layout per l'estratto conto.
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Esporta PDF
Il programma visualizza l'anteprima degli estratti, e con l'opzione Esporta PDF si può poi creare il file
che contiene tutti gli estratti o dei PDF per ogni estratto.
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Dialogo Stampa Richiami

Funzionalità disponibile con Banana Contabilità Plus - qualsiasi piano (escluse limitazioni
del piano Free )

 Si accede alla stampa dei richiami dal menu Report → Clienti → Stampa richiami.

Il programma crea in automatico i richiami a partire dalle fatture scadute.

Oltre alla creazione delle stampe, il programma crea direttamente delle registrazioni nella
tabella Registrazioni, che servono per la ricostruzione dello storico dei richiami emessi.
Queste registrazioni riportano la data del documento e il tipo di documento (es. 16-1 primo
richiamo, 16-2 secondo richiamo e 16-3 terzo richiamo).

Utilizza ultimi richiami di pagamento

Se nella tabella Registrazioni sono presenti delle registrazioni di richiamo con la data indicata,
vengono riproposti questi richiami per la stampa.

Crea nuovi richiami di pagamento

Per tutte le fatture giunte a scadenza, nella tabella Registrazioni vengono create in automatico delle
registrazioni di richiamo che permettono la stampa dei richiami.

 

http://www.banana.ch/it/buy
http://www.banana.ch/it/buy
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Richiami di pagamento

Vengono proposte le fatture giunte a scadenza, le quali possono essere disattivate se non si desidera
inviare il richiamo.

 

Modello

Sono disponibili due modelli di richiamo, uno con logo e uno senza (vedi Imposta Logo). Non è
possibile includere il bollettino di pagamento, inserire note e testi liberi. Se hai bisogno del bollettino
usa la funzione Richiami dialogo Stampa Fatture.

Gestione estensioni

Per aggiornare i modelli con quelli più recenti oppure per aggiungere i propri modelli personalizzati
vai al menu Estensioni.
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Permette di impostare i parametri dello stile selezionato.
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Visualizza scadenze

Gestione clienti e fornitori
Per una gestione automatica del controllo fatture emesse o ricevute è meglio utilizzare le funzionalità
del  Menu clienti e Menu fornitori.

Abbinare una scadenza a una riga di registrazione
In alternativa al sistema di gestione clienti e fornitori, o per altri scopi di controllo (molto più
semplicistici), si può inserire manualmente, nella riga di registrazione,  anche la data di pagamento
nella colonna Pagamento.

È una modalità operativa di controllo semplificata.

Dal menu Dati → Disponi colonne, rendere visibili le colonne DataScadenza e DataPag.

Inserire quindi nella colonna Scadenza, la data di scadenza della fattura. Quando si registra il
pagamento della fattura, inserire nella colonna Pagamento la data di pagamento.

La data di scadenza di una fattura può essere impostata in modi diversi. Maggiori informazioni sono
disponibili alla seguente pagina: Scadenze e termini di pagamento.

Comando Visualizza scadenze
Con il comando Visualizza scadenze del menu Azioni, il programma visualizza nella tabella
Scadenze le righe di registrazioni che hanno una data di scadenza e nessuna data di pagamento.

Per ottenere uno scadenzario in automatico (poste aperte Clienti e Fornitori), consultare la pagina
Elenco fatture clienti.
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Fatturazione integrata nella contabilità

La fatturazione integrata di Banana Contabilità Plus usa il sistema di registrazione delle fatture clienti
direttamente nella tabella Registrazioni. Permette di creare le stampe, anche personalizzabili,
partendo dalle registrazioni dei movimenti dei clienti.

Puoi stampare sia le fatture per la Svizzera con bollettino QR e fatture internazionali per
altre nazioni, anche in valuta estera senza bollettino QR. 

▶ Video Come iniziare con la fatturazione integrata

Creare le fatture
La tabella Registrazioni  è il fulcro di Banana Contabilità e viene usata anche per emettere le fatture.
Niente di più semplice: per creare una fattura inserire una normale registrazione che addebiti il
cliente. 

Banana Contabilità permette di creare fatture anche in moneta estera.

Le colonne principali per la fatturazione:

Data - data fattura.
Fattura - numero di fattura.
Descrizione - descrizione dell'elemento da fatturare. 
Se ci sono più elementi da fatturare, devi usare una riga supplementare che ha lo stesso
numero di cliente.
Dare - conto del cliente.
Avere - conto del ricavo.
Importo - importo fattura. 
Puoi anche indicare la quantità, il prezzo unitario e il programma calcola l'importo.
Codice IVA - codice IVA relativo al ricavo.

Vantaggi
Con la fatturazione integrata di Banana Contabilità semplifichi il lavoro amministrativo, riducendo il
tempo necessario per la gestione delle fatture, dei clienti e delle registrazioni contabili:

I dati inseriti della fattura sono sempre gli stessi sia per la fatturazione che per la
contabilizzazione, riducendo la possibilità di errori e omissioni.
Banana Contabilità genera automaticamente i documenti contabili correlati, come registri IVA,

https://www.banana.ch/it/node/11345
http://www.banana.ch/doc/it/node/2630
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conto dei clienti, registri degli incassi.
Hai una visione più accurata e in tempo reale dei tuoi clienti con saldi costantemente
aggiornati.
Tanti automatismi per rendere facile il lavoro e con risultati professionali immediati:

Ripresa automatica degli indirizzi dai contatti per non dover inserire nuovamente i dati
nella fattura.
Nessun calcolo manuale. Tutti i calcoli sono automatici, sempre precisi ed aggiornati.
Impostazione della lingua, moneta, numero di decimali e arrotondamento per ogni singola
fattura.
Visualizzazione scadenze.

Differenze con l'applicativo Offerte e Fatture
La fatturazione integrata è una funzione aggiuntiva inclusa in tutti gli applicativi di
contabilità: partita doppia, Entrate / Uscite, Multimoneta, Cash Manager.

Offerte e Fatture è un applicativo distinto da tutti gli altri applicativi contabili e viene
utilizzato solo per creare offerte e fatture. Non esiste alcuna connessione con il file della contabilità.

La fatturazione integrata è ideale per fatturare delle prestazioni o delle vendite, senza l'esigenza di
avere nella fattura molti dettagli strutturati:

Gli elementi e i dettagli da fatture (quantità, prezzi, unità, ecc) si registrano unicamente nella
tabella Registrazioni.
Nell'applicativo Offerte e fatture è presente la tabella Fatture con un Dialogo Fattura dove si
trovano varie colonne e opzioni per dettagliare le varie posizioni e i dati da inserire. Sotto
questo aspetto, l'applicativo Offerte e Fatture è molto più flessibile e completo perché permette
maggiori personalizzazioni.
Nella tabella Registrazioni oltre ai dati per la fatturazione, inserendo il conto Dare e Avere, la
registrazione resta contabilizzata nel file della contabilità, senza dover registrare la fattura
successivamente. È ideale per gestire la contabilità sul fatturato.
Nelle Offerte e Fatture i dati non vengono contabilizzati, quindi occorre registrare la fattura nel
file della contabilità. 
Nella fatturazione integrata non è possibile creare delle offerte. È possibile creare e stampare
una fattura con il titolo "Offerta" (al posto di Fattura).
L'applicativo Offerte e Fatture è specifico anche per creare Offerte.

Tabella Articoli
La Tabella Articoli  consente di gestire il catalogo degli articoli, tenere traccia delle quantità
disponibili, dei prezzi di vendita e di acquisto.

In questa tabella vengono inseriti i dati per la gestione degli articoli o i servizi da fatturare. Ad ogni
articolo viene assegnato un Id identificativo, e si possono creare dei raggruppamenti di articoli e
servizi della stessa categoria.
Ci sono a disposizione varie colonne per avere informazioni complete e dettagliate:

Articolo (IdArticolo): il codice dell'articolo.
Descrizione: la descrizione dell'articolo.
Gruppo di appartenenza
Conto (per la contabilizzazione)
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Codice IVA della vendita
Unità: una sigla per definire il tipo a cui si riferisce la quantità (pezzi, ore...)
Vendita: il prezzo unitario di vendita.
Costo di acquisto.

La tabella Articoli è collegata alle colonne Articoli  della tabella Registrazioni.

L'utilizzo della tabella Articoli velocizza l'inserimento dei dati della fattura nella tabella Registrazioni.
Indicando l'ID (codice articolo), il programma riprende automaticamente la descrizione, unità e prezzo
unitario. Inserendo la Quantità viene calcolato e inserito il prezzo complessivo da fatturare.

 Stampa fattura con bollettino QR Svizzero
Dopo aver inserito i dati delle fatture nella tabella Registrazioni, puoi creare e stampare le fatture con
i Layout di stampa .

Dal Menu Report > Clienti > Stampa fattura:

Scegli il Layout CH10 con codice QR svizzero  per la Svizzera.
Personalizzi la stampa. Con il piano Advanced  sono possibili maggiori personalizzazioni.
Visualizzi la fattura in anteprima.Puoi salvarla in PDF ed inviarla in formato elettronico o
stamparla.

Se si utilizza questo Layout viene stampato il bollettino con QR svizzero sulla fattura e i dati di
rifermento appariranno sugli estratti conto. Puoi importare i dati dei pagamenti dei clienti dalla banca
con l'apposita estensione Estratto bancario Camt ISO 20022 Svizzera (Banana+) . Hai sotto controllo
gli incassi delle fatture.

È possibile stampare la fattura con bollettino QR anche senza importo e senza indirizzo, lasciando un
riquadro vuoto per inserire i dati manualmente. Maggiori informazioni alla pagina Personalizzazione
QR-Code , paragrafo Includi/escludi dalla stampa.

Con la stessa registrazione, dalla finestra di dialogo Stampa fattura, nella sezione Preferenze
Layout > Stampa come puoi anche scegliere di stampare Bollettini di consegna, Offerte e Richiami.

http://www.banana.ch/doc/it/node/9290
https://www.banana.ch/apps/it/node/9034
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/it/buy
https://www.banana.ch/apps/it/node/9660
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9388
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Stampa fattura internazionale
Dopo aver inserito i dati delle fatture nella tabella Registrazioni, puoi creare e stampare le fatture con
i Layout di stampa .

Dal Menu Report > Clienti > Stampa fattura:

Scegli il Layout universale UNI11
Personalizzi la stampa. Con il piano Advanced  sono possibili maggiori personalizzazioni.
Visualizzi la fattura in anteprima, puoi salvarla in PDF ed inviarla in formato elettronico o
stamparla.

Con la stessa registrazione, dalla finestra di dialogo Stampa fattura, nella sezione Preferenze
Layout > Stampa come puoi anche scegliere di stampare Bollettini di consegna, Offerte e Richiami.

Struttura della fattura
In questa immagine vedi come è strutturata la fattura:

https://www.banana.ch/apps/it/node/9034
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/it/buy
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Logo
Hai la possibilità d'inserire un
logo personalizzato dal menu File
→ Imposta logo

 
Intestazione
Dati intestazione fattura ripresi
dal menu File → Proprietà file
(Dati base) → Indirizzo

 
Indirizzo del cliente
Indirizzo cliente ripreso dalla
tabella Conti, vedi Impostare i
conti clienti.

 
Dati della fattura
Inserire il contenuto della fattura
nella tabella Registrazioni, vedi
Inserire le fatture.

 

Testi liberi
Testo iniziale, note e saluti
utilizza Colonna Tipo; testi a fine
fattura vai al menu Report →
Clienti → Stampa fatture →
Opzioni layout.

 

QR-Code svizzero
Le  impostazioni si possono
definire solo per la Svizzera,
unicamente con il layout [CH10]
Layout con codice QR svizzero .

Gestione clienti
La Gestione clienti  ti consente di registrare, organizzare e gestire le informazioni dei clienti,tenendo
traccia delle transazioni e dei pagamenti dei clienti, delle scadenze di pagamento e delle informazioni
di contatto. Puoi monitorare i pagamenti dei clienti, con l'aggiornamento dello stato del pagamento
delle fatture emesse nonché inserire e stampare fatture.

In Banana Contabilità i dati dei clienti si impostano nella tabella Conti.

Per poter creare le fatture è necessario:

Definire il Partitario dei clienti
Partitario clienti con gestione sul fatturato 
Partitario clienti con gestione sull'incassato 

Creare le fatture, inserendo le registrazioni nella tabella Registrazioni, addebitando il conto del
cliente.

Con una serie di funzioni puoi gestire:

Incassi delle fatture inserendoli nella tabella Registrazioni:
Inserimento manuale dell'incasso

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9338
http://www.banana.ch/doc/it/node/4657
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Inserimento automatico tramite importazione dei movimenti dagli estratti conto ISO
20022 . Con la fatturazione su Banana i conti clienti possono essere inseriti
automaticamente attraverso l'estrazione del conto cliente dal numero di riferimento. Con
l'uso delle Regole  il programma inserisce tutti i dati delle registrazioni per gli addebiti e,
eventualmente anche per gli accrediti, senza dover intervenire manualmente.

Richiami
Con i Layout Richiami
Con il layout Fattura

Creare la fattura da un centro di profitto
Quando il partitario clienti viene impostato con i centri di profitto (contabilità sull'incassato) , nelle
registrazioni delle fatture si utilizza la colonna del centro di profitto CC3.

Nelle apposite colonne della tabella Registrazioni indicare:

La data.
Il numero di fattura.
La descrizione dell'elemento da fatturare, che vuoi che appaia in fattura.
Se ci sono più elementi da fatturare, usi un'altra riga che ha lo stesso numero di cliente.
Nel conto Dare non registrare alcun conto
Nel conto Avere non registrare alcun conto
L'importo. Puoi anche indicare la quantità, il prezzo unitario e il programma calcola l'importo.
Nella colonna CC3 inserire il conto di centro di profitto del cliente (tabella Conti).

Funzionalità al momento non disponibili
Queste funzionalità, richieste da utenti, non sono per il momento disponibili:

Invio fatture automatizzato per email.
Creazione di offerte.
Il programma permette di stampare una fattura con l'indicazione "Offerta".
Creazione di bollettini di consegna.
Il programma permette di stampare una fattura con l'indicazione "Bollettino di consegna".
Collegamento del file della contabilità con l'applicativo magazzino.
Collegamento con il file Foglio ore.
Creazione di fatture in moneta estera con IVA in moneta base (es. fatture in EUR con IVA in
CHF).

Come alternativa, se vuoi emettere fatture in modo separato dalla contabilità (utile per la contabilità
sull'incassato) e anche preparare offerte, puoi usare l'applicativo  Offerte e Fatture.

http://www.banana.ch/doc/it/node/8785
http://www.banana.ch/doc/it/node/8785
https://www.banana.ch/doc/it/rules
http://www.banana.ch/doc/it/node/8296
http://www.banana.ch/doc/it/node/9997
http://www.banana.ch/doc/it/node/9371
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Elenco completo funzionalità al momento non disponibili

Approfondimenti
Stampa Fatture e gestione IVA (incassato e fatturato) .
Stampare le fatture nella lingua del cliente.
Definire la scadenza di una fattura.
Tutte le estensioni con la fatturazione QR .

File di esempio
Esempio di fatturazione in contabilità entrate-uscite
Esempio di fatturazione in contabilità doppia
Esempio di fatturazione impostando i clienti come centri di costo
Utile in caso di fatture con l'IVA sull'incassato (clienti e fornitori impostati con il centro di costo
CC3).

https://www.banana.ch/doc/it/features_not_available
https://www.banana.ch/it/node/10885
http://www.banana.ch/apps/it/node/9645
https://www.banana.ch/apps/it/node/8564
https://www.banana.ch/apps/it/node/8455
https://www.banana.ch/apps/it/node/8714
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Impostare il file per la fatturazione

Ci sono due modalità per predisporre il file contabile alla fatturazione:

Creare un Nuovo file di contabilità partendo da un modello predefinito.1.
Adattare il tuo file di contabilità esistente.2.

Nuovo file di contabilità
Sono a disposizione diversi modelli con il partitario clienti preimpostato. I tipi di contabilità che
supportano la creazione di fatture sono:

Contabilità in partita doppia con o senza IVA.
Contabilità multi-moneta con o senza IVA.
Contabilità entrate-uscite con o senza IVA.

Puoi creare un nuovo file della contabilità per la fatturazione come segue:

Menu File → Nuovo.
Seleziona la Regione e la lingua.
Nel campo Filtra per, digita Fatture.
Nella sezione a destra, seleziona uno dei modelli.
Salva il file con nome.

Segui tutte le indicazioni presenti nella pagina Fatturazione.

Nelle tipologie di contabilità con IVA, per impostare correttamente il file, consigliamo di consultare le
spiegazioni della pagina Stampa fatture e gestione IVA .

 Adatta il tuo file di contabilità esistente
Se hai già un tuo file, ma non è ancora predisposto per creare le fatture, devi aggiungere determinate
funzionalità e impostazioni, necessari per stampare le fatture:

Inserisci i dati della società nei Dati base

Nel menu File → Proprietà file (dati base) → Indirizzo, imposta l'indirizzo della tua società,
che sarà ripreso nell'intestazione della fattura.
Se hai un logo che vuoi utilizzare, consulta la pagina Imposta logo.

 Imposta l'elenco dei clienti nella tabella Conti

Nella tabella Conti, imposta il partitario clienti.
Aggiungi e visualizza le colonne indirizzi dei clienti.

Nella tabella Conti, seleziona la vista Indirizzo e inserisci gli indirizzi dei clienti.
Se la vista Indirizzo non è visibile, aggiungila tramite il menu Strumenti → Aggiungi
nuove funzionalità → Aggiungi colonne indirizzi nella tabella Conti.

Configura le impostazioni clienti nel menu Report → Clienti → Impostazioni.

https://www.banana.ch/it/node/10885
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Aggiungi le colonne che ti servono nella tabella Registrazioni

Nella tabella Registrazioni rendi visibili le colonne per la fatturazione:
Menu Dati → Disponi colonne e visualizza la colonna DocTipo e DocFattura.
Aggiungi le colonne per la quantità e il prezzo unitario (opzionale).
Menu Strumenti → Aggiungi nuove funzionalità → Aggiungi colonne Articoli nella
tabella Registrazioni.
Aggiungi la tabella Articoli (opzionale).
Ti  serve per tenere un elenco dei tuoi articoli e serve come una mini gestione del
magazzino.
Menu Strumenti → Aggiungi nuove funzionalità → Aggiungi tabella Articoli.

Nelle tipologie di contabilità con IVA, per impostare correttamente il file, consigliamo di consultare le
spiegazioni della pagina Stampa fatture e gestione IVA .

Fatture gestite in un file separato, solo per le fatture
Se vuoi gestire le fatture in modo separato dalla contabilità devi creare un nuovo file. Nel piano dei
conti si inseriscono solo i conti dei clienti, necessari per la fatturazione. Nella tabella Registrazioni si
inseriscono le registrazioni di fatturazione.
Questo approccio è indicato per coloro che:

Registrano le fatture sull'incassato. Nel file della contabilità si registra solo l'importo che si
è incassato.
Desiderano una gestione fatture completamente staccata, per esempio, le associazioni che
devono inviare le quote di adesione ai soci.

Come creare un file separato per la gestione delle fatture:

Scarica il file d'esempio , aprilo e adattalo alle tue esigenze.1.
In alternativa puoi partire da un qualsiasi modello esistente e adattarlo, come indicato in
precedenza, per l'uso delle fatture.
Controlla che siano presenti tutte le impostazioni e le colonne spiegate nel paragrafo2.
precedente.
 

https://www.banana.ch/it/node/10885
https://www.banana.ch/apps/it/node/8455
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Inserire le fatture nelle righe di registrazione

I dati della fattura si inseriscono nella tabella Registrazioni. Per ogni nuova fattura inserire una nuova
riga di registrazione.

Indicare la data della registrazione
Il numero fattura

Nel caso della fatturazione con QR Svizzero con conto IBAN  usare solo numeri o lettere,
senza spazi, separatori o altri caratteri.
Nel caso della fatturazione con QR Svizzero con QR-IBAN  usare solo numeri senza spazi,
separatori o altri caratteri. 
Se non si usa il QR Svizzero il numero fattura può essere a libera scelta

Il testo della descrizione (prodotti, servizi, consulenze...) che apparirà sulla fattura del cliente
Nel conto Dare inserire il numero del conto cliente
Nel conto Avere inserire la contropartita (conto Vendite, Consulenza o altro)
Inserire l'importo
Nei casi di assoggettamento all'IVA, inserire il Codice IVA con la percentuale IVA applicabile.
Vedi Stampa fatture e gestione IVA

Fattura su più righe

Quando ci sono più elementi da fatturare (diversi articoli o prestazioni o entrambi) occorre registrare
su più righe (un elemento per riga):

Inserire una nuova riga di registrazione per ogni elemento che desideri stampare sulla fattura.
Su ogni riga aggiuntiva, ripetere la data e il numero fattura, uguali alle righe precedenti.

 Colonne base tabella Registrazioni fatture

Data
La fattura riporterà la data indicata in questa colonna. Tutte le righe che appartengono al documento
devono riportare la medesima data.

Fattura
Per la gestione delle fatture deve essere indicato obbligatoriamente un numero di fattura nella
colonna Fattura e un conto clienti che appartenga al partitario nella colonna CtDare (oppure CC3 se
si gestiscono i clienti sull'incassato).

https://www.banana.ch/apps/it/node/9381
https://www.banana.ch/apps/it/node/9387
https://www.banana.ch/area/it/node/11092
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Colonne facoltative

Tipo
Nella colonna Tipo si possono definire delle righe di dettaglio, come ad esempio delle righe di
totalizzazione o un termine di pagamento specifico di una fattura. Questa colonna non è visibile di
default, ma occorre visualizzarla tramite il menu Dati → comando Disponi colonne e vistando la
colonna DocTipo.

Quantità
È la colonna dove viene indicata la quantità della merce o del servizio venduti. Per aggiungere la
colonna quantità utilizzare il menu Strumenti → Aggiungi nuove funzionalità → Aggiungi
colonne Articoli nella tabella Registrazioni.

Unità
Si inserisce il genere di unità (ad esempio 'pz', 'h', 'm', 'kg').

Prezzo unità
Si inserisce il prezzo unitario riferito alla merce o al servizio. In questo caso il programma calcola
automaticamente l'importo complessivo in base alle quantità inserite nella colonna Quantità.

Fatture e gestione IVA
In Banana Contabilità, l'inserimento dei dati della fattura cambia in base si si registra la contabilità
sull'incassato o sul fatturato.

Maggiori dettagli sono disponibili alla pagina Stampa fatture e gestione IVA .

https://www.banana.ch/apps/it/node/9760
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Sconti e ribassi

Per inserire in una fattura uno sconto o ribasso, aggiungere una nuova riga e inserire:

Data della fattura.
Numero della fattura.
Descrizione dello sconto o ribasso.
Conti nelle colonne Dare e Avere. È importante invertire i conti rispetto alla registrazione di
vendita.
Quando il partitario clienti / fornitori è impostato con i centri di costo e si hanno delle
registrazioni con sconti e ribassi, affinché l'importo venga stornato, occorre invertire il segno dei
centri di costo.
In caso di IVA indicare il codice IVA con il segno negativo, in modo tale che l'IVA venga dedotta,
oppure, se presente usare il codice IVA per lo sconto e i ribassi.
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Impostare lingua cliente

I layout predefiniti includono le seguenti lingue: italiano, tedesco, inglese, francese, olandese.

I testi delle fatture vengono stampati nella lingua del cliente, a condizione che questa sia impostata
nella colonna Lingua (tabella Conti, vista Indirizzo).
La lingua è un codice ISO generalmente di 2 lettere  minuscole (it=italiano, de=tedesco,
en=inglese, fr=francese, nl=olandese).

Se per il cliente non è stata indicata la lingua viene usata quella della contabilità, definita nel menu
File → Proprietà file (dati base) → Varia.

https://it.wikipedia.org/wiki/ISO_639-2
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Scadenze e termini di pagamento

La data di scadenza di una fattura può essere impostata in modi diversi:

Scadenza generale - stessa scadenza per tutte le fatture
Dal menu Report → Clienti → Impostazioni → Generale → Scadenza fatture, indicare il
periodo (in giorni) dopo il quale la fattura è considerata scaduta. Ad esempio, se la data del
documento è del 10 di maggio, inserendo 10 giorni, la data di scadenza sarà del 20 maggio.
Scadenza per cliente - specifico per ogni cliente
Nella tabella Conti, è disponibile la colonna TerminePagamentiInGiorni (se non visibile,
attivarla dal menu Dati → Disponi colonne). In questa colonna potete impostare il periodo (in
giorni) dopo il quale la fattura è considerata scaduta.
Scadenza specifica per fattura
Nella tabella Registrazioni, vista Scadenze, è visibile la colonna Scadenza, potete indicare la
data di scadenza direttamente in questa colonna.

Testo alternativo per il termine di pagamento
Per ogni fattura è possibile definire un testo libero come termine di pagamento che sostituisce il
testo della data di scadenza. Per maggiori dettagli consultare la pagina Inserimento avanzato -
colonna Tipo.
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Stampa fatture in altre monete

Con Banana Contabilità Plus puoi stampare fatture anche in moneta estera.

Fatture in moneta estera da inviare a clienti esteri
Impostazioni necessarie:

Aprire uno dei nostri modelli di contabilità multi-moneta.
Impostare nella tabella Conti, nel partitario clienti, i clienti con la moneta estera. Le fatture
vengono stampate nella moneta del conto del cliente.
Se vuoi inviare fatture in monete diverse allo stesso cliente devi creare, per lo stesso cliente,
dei conti in diverse monete (tabella Conti).
Per la stampa delle fatture da inviare all'estero utilizzare il layout UNI11 .

Fatture in moneta estera con IVA in moneta base
Normalmente non è possibile inserire una fattura in moneta estera con l'IVA in moneta base. Si può
ovviare a questa problematica con le procedure seguenti:

Fatture in moneta estera con IVA sull'incassato

Aprire uno dei nostri modelli di contabilità multi-moneta con IVA con partitario centri di costo
CC3 .
Impostare nella tabella Conti, i clienti in moneta estera come centri di costo CC3 (;).
Se vuoi inviare fatture in monete diverse allo stesso cliente devi creare, per lo stesso cliente,
dei conti in diverse monete (tabella Conti).
Nella tabella Registrazioni devi inserire i dati della fattura su più righe:

Nella  prima riga:
Nella colonna Importo inserire l'importo al netto IVA (senza inserire alcun conto in
dare e avere).
Nella colonna CC3 inserire il conto del centro di costo del cliente in moneta estera.

Nella seconda riga:
Nella colonna Importo inserire l'importo IVA in moneta estera (senza inserire alcun
conto in dare e avere), calcolando manualmente l'importo IVA in moneta estera.
Nella colonna CC3 inserire il conto del centro di costo del cliente in moneta estera.

Per la stampa delle fatture con codice QR svizzero utilizzare il layout CH10 .

Registrare l'incasso:

Nella colonna Dare inserire il conto della liquidità.
Nella colonna Avere inserire il conto del ricavo.
Nella colonna Cod. IVA inserire il codice IVA della vendita.
Nella colonna CC3 inserire il conto del centro di costo del cliente in moneta estera con segno
negativo.

Esempio registrazione fattura in moneta estera (EUR) con IVA sull'incassato in moneta base (CHF):

https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/it/node/10879
https://www.banana.ch/it/node/10879
https://www.banana.ch/apps/it/node/9338
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Fatture in moneta estera con IVA sul fatturato

Aprire uno dei nostri modelli di contabilità multi-moneta con IVA e con partitario clienti.
Nella tabella Conti, impostare i clienti in moneta estera sia come partitario (Conti) e sia
come centri di costo CC3 (;).
Nella tabella Registrazioni devi inserire i dati della fattura su più righe:

Nella  prima riga inserire l'emissione della fattura normalmente:
La data, la descrizione, nel conto Dare il conto del cliente in moneta estera e nel
conto Avere il ricavo, l'importo al lordo IVA e il codice IVA della vendita.
Il numero della fattura non deve essere inserito.

Nella seconda riga:
Nella colonna Importo inserire l'importo della fattura al netto IVA (senza inserire
alcun conto in dare e avere).
Nella colonna CC3 inserire il conto del centro di costo del cliente in moneta estera
Nel caso in cui si utilizzano le colonne Quantità, Unità e Prezzo unità, il prezzo
unitario deve essere al netto dell'IVA.

Nella terza riga:
Nella colonna Importo inserire l'importo IVA in moneta estera (senza inserire alcun
conto in dare e avere), calcolando manualmente l'importo IVA in moneta estera.
Nella colonna CC3 inserire il conto del centro di costo del cliente in moneta estera.

Le righe con i centri di costo vengono utilizzate semplicemente per cerare la fattura in moneta estera
con IVA.

Registrare l'incasso:

Nella colonna Dare inserire il conto della liquidità.
Nella colonna Avere inserire il conto del cliente in moneta estera.
Nella colonna CC3 inserire il conto del centro di costo del cliente in moneta estera con segno
negativo.

Esempio registrazione fattura in moneta estera (EUR) con IVA sul fatturato in moneta base (CHF):
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Inserimento avanzato colonna Tipo

La colonna TipoDoc della tabella Registrazioni può essere usata per definire dei comandi specifici per
la visualizzazione di determinati dati nella stampa della fattura.
Per utilizzare la colonna, occorre prima visualizzarla dal menu Dati → Disponi colonne, vistare la
colonna DocTipo.

Inserire dei dati
Una volta visualizzata la colonna è possibile procedere con l'inserimento dei dati. Per farlo è
necessario:

Aggiungere una riga vuota dopo i dati della fattura.
Nella colonna Data, inserire la data della fattura.
Nella colonna Tipo, inserire il comando desiderato (vedi la tabella sottostante).
Nella colonna Fattura, inserire il numero della fattura.
Nella colonna Descrizione, inserire i dati che devono figurare nella fattura.

Fattura al cliente
Digitando 10: nella colonna Tipo vengono elencate tutte le opzioni possibili per personalizzare i dati
della fattura.

Dati fattura Colonna Tipo Colonna Descrizione

Indirizzo cliente
Quando si desidera un indirizzo di fatturazione
diverso da quello indicato nella tabella Conti (vista
Indirizzo), è possibile specificarlo utilizzando le
opzioni appropriate.
Su ogni riga si definisce un elemento dell'indirizzo
(nome, cognome, indirizzo...).

10:adr:fna
10:adr:lna
10:adr:bna

10:adr:str1
10:adr:str2
10:adr:str3
10:adr:cod

10:adr:cit
10:adr:sta
10:adr:cou

Inserire il nome
Inserire il cognome
Inserire il nome
ditta/organizzazione
Inserire la riga 1 dell'indirizzo
Inserire la riga 2 dell'indirizzo
Inserire la riga 3 dell'indirizzo
Inserire Codice avviamento
postale
Inserire la località
Inserire lo stato/provincia
Inserire la nazione

Indirizzo spedizione

10:sadr:pna
10:sadr:fna
10:sadr:lna
10:sadr:str1
10:sadr:cod

10:sadr:cit

Inserire il prefisso
Inserire il nome
Inserire il cognome
Inserire riga 1 dell'indirizzo
Inserire Codice avviamento
postale
Inserire la località

Saluti
Dopo la tabella dei dettagli della fattura è possibile
aggiungere una riga di testo per i saluti finali. Vedi
anche Esempi fatture .

10:gre Inserire il testo dei saluti

https://www.banana.ch/apps/it/node/9398#doctype_beg_not_gre
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Dati fattura Colonna Tipo Colonna Descrizione
Note finali
Dopo la tabella dei dettagli della fattura e prima
dei saluti, è possibile aggiungere una o più righe di
testo per eventuali note. Vedi anche Esempi
fatture .

10:not Inserire il testo delle note

Ordine data 10:ordd Inserire la data dell'ordine
Ordine numero 10:ordn Inserire il numero dell'ordine
Parametri (avanzato)
Quando si desidera stampare dati personalizzati
nella fattura, è possibile utilizzare il comando
apposito.
È rivolto ad utenti con conoscenze di
programmazione JavaScript, e permette di
modificare il layout della fattura in modo da
utilizzare i parametri indicati con questo comando.
Per maggiori informazioni consultare Printing
custom data (solo in inglese).

10:par Inserire i parametri personalizzati

Termine di pagamento
Quando si desidera indicare un testo alternativo
come termine di pagamento, inserire il testo
desiderato. Sulla fattua sarà riportato questo
termine.

10:ter Inserire il testo alternativo per il
termine di pagamento

Testo iniziale 10:beg
Inserire il testo iniziale della
fattura visualizzato prima del
titolo della fattura

Titolo
Quando non si desidera utilizzare il titolo della
fattura predefinito è possibile specificare un titolo
diverso.

10:tit Inserire il testo per il titolo della
fattura

Sottototali articoli
Nella tabella dei dettagli della fattura è possibile
inserire dei totali intermedi per gli articoli. Vedi
anche Esempi fatture .

10:tot
10:tot:0
10:tot:1
10:tot:2

Inserire il sottototale di livello 0
(tot e tot:0 è sempre di livello 0)
Inserire il sottototale di livello 1
Inserire il sottototale di livello 2

Testo intestazione/titolo
Nella tabella dei dettagli della fattura si possono
aggiungere intestazioni per raggruppare gli
articoli. Vedi anche Esempi fatture .

10:hdr

Inserire il testo che si desidera
aggiungere ai dettagli della
fattura.
Lasciare vuoto per aggiungere
una riga vuota.

 Totali intermedi

Per poter inserire dei totali intermedi, occorre inserire delle righe supplementari nella tabella
Registrazioni:

Nella colonna Tipo inserire 10: e scegliere dal menu a tendina :tot, figurerà la dicitura 10:tot.
Inserire ancora : e scegliere :1
Nella colonna Descrizione inserire la descrizione appropriata al totale (es. Totale merce)
Inserire il numero di fattura (se non viene inserito il numero di fattura, il totale non verrà
stampato).

https://www.banana.ch/apps/it/node/9398#doctype_beg_not_gre
https://www.banana.ch/apps/it/node/9398#doctype_beg_not_gre
https://www.banana.ch/apps/it/node/9398#doctype_hdr_tot
https://www.banana.ch/apps/it/node/9398#doctype_hdr_tot
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Esempio fattura con totali intermedi

 Testo alternativo per il termine di pagamento

Per ogni fattura è possibile definire un testo libero come termine di pagamento che sostituisce il testo
della data di scadenza.

Inserire nella tabella Registrazione una riga supplementare con lo stesso numero di fattura
Nella colonna Tipo occorre inserire 10: e selezionare :ter dal menu a tendina che appare,
pertanto figurerà la dicitura 10:ter
Nella colonna Descrizione inserire il testo (es. 30 giorni netto, 60 giorni ecc..).

Quando verrà stampata la fattura figurerà il valore assegnato come termine di pagamento.

Ulteriori personalizzazioni 

Altre opzioni di personalizzazione come ad esempio la definizione delle coordinate bancarie o i saluti
finali, sono disponibili nel dialogo della stampa fatture
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Come fare per la stampa della fattura

La stampa della fattura può essere personalizzata e adattata alle specifiche esigenze.

Inserire i dati dell'indirizzo della ditta (mittente)
Nel menu File > Proprietà file (Dati base) > Indirizzo, imposta l'indirizzo della tua società.

Per impostare la posizione dell'indirizzo nella stampa della fattura, consultare il paragrafo Impostare
posizione indirizzo cliente.

Impostare l'elenco dei clienti nella tabella Conti
Nella tabella Conti, imposta il partitario clienti.
Visualizza le colonne indirizzi dalla vista Indirizzo e inserisci gli indirizzi dei clienti.
Se la vista Indirizzo non è visibile, aggiungila tramite il menu Strumenti > Aggiungi nuove
funzionalità > Aggiungi colonne indirizzi nella tabella Conti.
Configura le impostazioni clienti nel menu Report > Clienti > Impostazioni.

Riprendere gli indirizzi dei clienti da Excel
Quando i dati dei clienti si trovano su un file Excel, questi possono essere riportati facilmente nella
tabella Conti, vista Indirizzo.

Si presuppone che nella tabella Conti, alla fine del piano contabile, ci sia il partitario clienti o soci
impostato. Assicurati di avere abbastanza righe vuote per inserire i dati copiati da Excel.

Procedi nel seguente modo:

Seleziona da Excel la colonna con i dati da copiare e usa il comando Copia (Ctrl+C).
Vai in Banana, tabella Conti (vista Indirizzo), posizionati nella colonna corrispondente e
impartisci il comando Incolla (Ctrl+V o Incolla dal menu Modifica).
Ripeti questa operazione per tutte le colonne dell'indirizzo (Conto, Nome, Cognome,
Organizzazione, Via, Cap, Località, Codice nazione, Lingua).
I dati corrispondenti alle colonne menzionate sono necessarie per la stampa della fattura.
Se nel file Excel non hai tutte le colonne menzionate, devi aggiugere le informazioni mancanti
manualmente.

Impostare la lingua dei clienti
Puoi stampare le fatture nella lingua dei clienti. Per farlo devi prima impostare la lingua del cliente.

Impostare posizione logo e indirizzo mittente
Per impostare il logo bisogna:

Caricare l'immagine del logo nel menu File > Imposta logo .
Per utilizzare il logo nella fattura, nelle Impostazioni della fattura  devi attivare la casella Logo
e inserire il nome della personalizzazione che hai utilizzato, rispettando maiuscole e minuscole,

https://www.banana.ch/doc10/it/node/9182
https://www.banana.ch/apps/it/node/9365#intestazione
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nel campo Nome Logo.

Puoi ad esempio posizionare il logo sulla sinistra e l'indirizzo sulla destra e cambiare le dimensioni del
logo.

L'indirizzo del mittente, se non vengono modificate le impostazioni predefinite, viene inserito a destra,
indipendentemente dalla presenza del logo.

Se si desidera impostare l'indirizzo del mittente a sinistra senza alcuno logo, consultare la pagina
seguente:

Fattura senza logo e indirizzo intestazione a sinistra .

Personalizzare indirizzo nell'intestazione fattura
Lo stile dell'indirizzo del mittente nell'intestazione della fattura (colore, dimensione, carattere..) viene
impostato predefinito dal programma.

Il Piano Advanced di Banana Contabilità Plus  consente di personalizzare lo stile dell'indirizzo. Per
maggiori informazioni consultare la pagina Esempi (solo in lingua inglese) .

Impostare le informazioni fattura
Le informazioni fattura sono informazioni relative alla data, numero cliente, data scadenza, ecc. che si
trovano di regola subito sotto l'intestazione e vicino all'indirizzo del cliente.
I layout CH10  e UNI11  permettono di definire quali informazioni della fattura includere e quali
invece escludere dalla stampa. Nella pagina Impostazioni fattura  trovi le indicazioni.

Per gli altri layout di stampa (CH01-CH09 / UNI01-UNI08), le informazioni non sono modificabili.

Impostare data di scadenza fattura
La data di scadenza predefinita nel programma è di 30 giorni dalla data di emissione della fattura.

Se si vuole cambiare la data di scadenza, procedere come segue:

Aggiungere una riga alla fattura nella tabella Registrazioni.
Nella colonna Data, inserire la data della fattura.
Nella colonna DocTipo  inserire 10:ter (:ter Termine di pagamento).
Nella colonna Fattura, inserire il numero della fattura.
Nella colonna Descrizione inserire la scadenza desiderata (es. "10 giorni").

Nelle informazioni della fattura apparirà il testo inserito.

 Impostare posizione indirizzo cliente
I layout CH10  e UNI11 permettono di definire la posizione dell'indirizzo del cliente e la sequenza
degli elementi dell'indirizzo. Nella pagina Impostazioni fattura  trovi le indicazioni.

Per gli altri layout di stampa (CH01-CH09 / UNI01-UNI08), la posizione e la composizione dell'indirizzo
del cliente non sono modificabili.

https://www.banana.ch/apps/it/node/9398#fattura_senza_logo_e_indirizzo_intestazione_a_sinistra
https://www.banana.ch/it/advanced
https://www.banana.ch/apps/en/node/9417
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#informazioni
https://www.banana.ch/doc10/it/node/9828
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#indirizzo_cliente
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 Impostare l'indirizzo di spedizione
Per inserire un indirizzo di spedizione, oltre all'indirizzo del cliente, procedere come segue:

Usare la colonna Tipo  della tabella Registrazioni, comando 10:sadr.
Aggiungere una riga alla fattura nella tabella Registrazioni.
Nella colonna Data, inserire la data della fattura.
Nella colonna Tipo inserire:

10:sadr:fna per il nome.
10:sadr:lna per il cognome.
10:sadr:str1 per l'indirizzo (via e numero).
10:sadr:cod per il codice avviamento postale.
10:sadr:cit per la località.

Nella colonna Fattura, inserire il numero della fattura.
Nella colonna Descrizione inserire il testo da visualizzare.

Con i layout CH10  e UNI11 , vai nelle Impostazioni fattura > sezione Indirizzo cliente  e
spunta la voce Indirizzo di spedizione.
Vengono ripresi e inseriti sulla stampa della fattura i dati inseriti tramite la colonna Tipo della
tabella Registrazioni.

Impostare titolo/oggetto
Per inserire il titolo/oggetto della fattura, hai due possibilità:

Usare la colonna DocTipo  della tabella Registrazioni, comando 10:tit.
Per ogni fattura si definisce un titolo.
Vale per qualsiasi layout di stampa.
Se si usa la colonna DocTipo, questa ha sempre la priorità rispetto alle eventuali
impostazioni dei layout (vedi prossimo punto).

Con i layout CH10  e UNI11,  si può inserire il testo nelle Impostazioni fattura , sezione
Testi, Titolo fattura.

Il titolo si applica a tutte le fatture stampate con il layout in questione.
Si applica solo se non è stato definito alcun titolo come da primo punto.

Se non inserisci alcun testo, il programma utilizza il testo predefinito.

Impostare testo iniziale
Per inserire il testo iniziale della fattura, hai due possibilità:

Usare la colonna DocTipo  della tabella Registrazioni, comando 10:beg.
Per ogni fattura si definisce un testo iniziale.
Vale per qualsiasi layout di stampa.
Se si usa la colonna DocTipo, questa ha sempre la priorità rispetto alle eventuali
impostazioni dei layout (vedi prossimo punto).

Con i layout CH10  e UNI11, inserire il testo nelle Impostazioni fattura , sezione Testi,
Testo iniziale.

Il testo si applica a tutte le fatture stampate con il layout in questione.
Si applica solo se non è stato definito alcun testo iniziale come da primo punto.

https://www.banana.ch/doc10/it/node/9828
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#indirizzo_cliente
https://www.banana.ch/doc10/it/node/9828
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/doc10/it/node/9828
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365
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Impostare i dettagli fattura
Utilizza la tabella Registrazioni per inserire i dati delle fatture.

Vedi anche Sconti e ribassi.

Con i layout CH10  e UNI11  decidi quali colonne visualizzare nella stampa. Vedi come fare nella
pagina Impostazioni fattura > Dettagli fattura .

Per gli altri layout di stampa (CH01-CH09 / UNI01-UNI08), le colonne non sono modificabili.

 Impostare testi finali
Per inserire il testo finale della fattura:

Dal menu Dialogo stampa fatture.
Sezione Opzioni.
Selezionare la lingua nella quale si stampa la fattura.
Inserire il testo nel campo Testo finale.
Il testo inserito viene applicato a qualsiasi layout di stampa si utilizza.

I layout CH10  e UNI11  permettono di definire il testo finale anche tramite le Impostazioni fattura
.

Inserire il testo nelle Impostazioni fattura > Sezione Testi > Testo finale .
Viene applicato a ogni fattura dello stesso file .ac2 creata con il layout.
Sostituisce l'eventuale testo impostato dal menu Dialogo stampa fatture > Opzoni > Testo
finale.

Per impostare dei testi finali diversi per ogni fattura, occorre utilizzare la colonna DocTipo  della
tabella Registrazioni:

Nella colonna DocTipo, inserire 10:not (Note).
Nella colonna Descrizione, inserire il testo finale desiderato. Il testo inserito apparirà su un'unica
riga.
Per aggiungere altre righe di note, occorre ripetere l'inserimento nelle colonne DocTipo e
Descrizione su più righe.

Impostare numero di conto bancario
Se non utilizzi il QR-Code, nel testo finale devi inserire il numero del conto bancario come riferimento
per il pagamento della fattura.

Vedi il capitolo Impostare testi finali per inserire il numero del conto bancario.

Impostare IBAN per la stampa QR-Code Svizzero
Se desideri creare fatture QR con conto IBAN, devi:

Utilizzare il Layout CH10  per Banana Contabilità Plus
Impostare il conto IBAN
Impostare la stampa del QR-Code Svizzero

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#dettagli_fattura
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/apps/it/node/9365#sezione_testi_per_ogni_lingua
https://www.banana.ch/doc10/it/node/9828
http://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9381#inserimento_numero_conto_iban
https://www.banana.ch/apps/it/node/9388
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Nella pagina QR-Fattura con conto IBAN  trovi maggiori informazioni per le impostazioni delle fatture
QR con conto IBAN.

Impostare QR-IBAN per la stampa QR-Code Svizzero
Se desideri creare fatture QR con conto QR-IBAN, devi:

Utilizzare il Layout CH10  per Banana Contabilità Plus
Impostare il conto QR-IBAN
Impostare la stampa del QR-Code Svizzero

Nella pagina QR-Fattura con QR-IBAN  trovi maggiori informazioni per le impostazioni delle fatture
QR con conto QR-IBAN.

Stampare la fattura con bollettino QR senza importo e
indirizzo
Se desideri stampare una fattura senza indicare l'importo e l'indirizzo sul bollettino QR, trovi maggiori
informazioni alla pagina Personalizzazione QR-Code , paragrafo Includi/escludi dalla stampa.

Stampare bollettino QR senza importo e indirizzo
Se desideri stampare solo il bollettino QR senza importo e senza indirizzo del cliente, devi:

Utilizzare l'estensione QR-Fattura senza importo e indirizzo .
Impostare la moneta, l'indirizzo e il conto IBAN .
Creare il bollettino con codice QR .

Vedi anche come stampare una Fattura senza importo .

Impostare stili e colori
I layout di stampa delle fatture  hanno anche un'impostazione per definire:

Tipo di carattere.
Inserire il nome del carattere (es. Arial, Helvetica, ecc).

Colori.
Si può usare la denominazione in inglese (black, yellow, white, blue, red, ecc.).
Oppure il valore esadecimale (HEX) preceduto dal segno # (es. #000000, #009FE3,
#FF00EA).
I codici dei colori si trovano facilmente su internet. Ad esempio, puoi consultare la tabella
al sito https://www.w3schools.com/cssref/css_colors.asp .

I layout CH10  e UNI11 , in più hanno anche un'impostazioni fattura  per definire la dimensione
del carattere.

Impostare dei testi in grassetto
Con i layout CH10  e UNI11  si può applicare il grassetto  ai testi della fattura.

https://www.banana.ch/apps/it/node/9381
http://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9387#inserimento_numero_conto_qriban
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9387
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9401
https://www.banana.ch/apps/it/node/9401#impostazione_moneta_indirizzo_e_iban
https://www.banana.ch/apps/it/node/9401#crea_il_bollettino_con_codice_qr
https://www.banana.ch/apps/it/node/9398#fattura_senza_importo
https://www.banana.ch/apps/it/node/9034
https://www.w3schools.com/cssref/css_colors.asp
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#bold_text
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 Inserire immagini nelle fatture
Il Piano Advanced di Banana Contabilità Plus  consente di aggiungere delle immagini nelle fatture da
inviare ai clienti.

Questa funzionalità rende la fattura ancora più personalizzabile e il cliente che la riceve ha una
visione ancora più completa e chiara sulla fatturazione degli articoli.

Abbiamo diverse pagine informative sull'inserimento di immagini nelle fatture. Consigliamo di
consultarle per capire la procedura o per approfondire la problematica.

Le nostre risorse sono le seguenti:

Customize invoice print with Javascript 
Fatture con foto prodotti

Chiudere le fatture incassate
Per chiudere le fatture aperte ci sono due modalità:

Chiusura con registrazione manuale
Chiusura con importazione dei dati ISO 20022 (Svizzera)

Altre risorse
Personalizzazione della stampa della fattura .

https://www.banana.ch/it/advanced
https://www.banana.ch/apps/en/node/9396#print_images_of_items
https://www.banana.ch/apps/en/node/9396#print_images_of_items
https://www.banana.ch/it/node/11439
https://www.banana.ch/apps/it/node/9514
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Stampa fatture

La stampa delle fatture è altamente personalizzabile e adattabile a tutte le esigenze:

Puoi scegliere il Layout di stampa .
Puoi personalizzare la stampa della fattura, cambiando le impostazioni.
Sono a disposizione diversi layout per stampa fatture , qui quelli consigliati:

Il layout CH10 per tutti gli utenti in Svizzera  (Con QR-Code svizzero).
Il layout UNI11 per tutti gli utenti di altri paesi . (Uguale al CH10, ma senza il QR-Code).

Per maggiori informazioni sulla personalizzazione, vedi:

Personalizza layout di stampa fattura
Trovi tutte le informazioni per iniziare a creare una stampa secondo le tue esigenze.
Pagina personalizzazione layout CH10  (valido anche per l'UNI11).

Attivazione e personalizzazione QR-Code stampa fattura Svizzera .

Con il piano Advanced di Banana Contabilità Plus  è anche possibile mandare in
stampa diverse fatture allo stesso tempo e ottenere PDF singoli per ognuna di
esse! Per maggiori informazioni visita la pagina Stampa fatture o estratti clienti in PDF
separati.

Dialogo stampa fatture
 Si accede al dialogo della stampa fatture dal menu Report > Clienti > Stampa fatture.

Da questo dialogo:

http://www.banana.ch/apps/it/node/9034
http://www.banana.ch/apps/it/node/9034
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9514
https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/it/buy
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Selezionare la fattura o le fatture che vuoi stampare.
Impostare il layout da usare per la stampa della fattura.
Accedere alle impostazioni del layout per personalizzare la stampa.

Una volta scelte le opzioni di stampa, con il bottone OK la fattura viene visualizzata nella finestra
anteprima di stampa.

Dall'anteprima della fattura è possibile:

Stampare la fattura.
Salvare la fattura in PDF in modo da poter essere comodamente inviate via email.
Salvare la fattura in altri formati.
Accedere al Dialogo Stampa Fatture.

 Sezione Stampa
Numeri fattura

Si possono stampare fatture singole o multiple:

Per la stampa singola indicare il numero della fattura.
Per Ia stampa multipla indicare i numeri delle fatture separati da virgole (es. 1,3,6).
Per la stampa di una sequenza (da...a...) indicare i numeri separati da un trattino (es. 1-3).
Se il numero della fattura contiene già un trattino (es. 2016-1), questa dev'essere racchiusa tra
parentesi graffe {} per distinguere la numerazione da un intervallo di documenti, {2016-1}-
{2016-3}.

Fatture dal

L'opzione permette di determinare la stampa delle fatture incluse nel periodo. Devono essere inserite
una data iniziale e una data finale.

Fatture non stampate

Vengono stampate le fatture che nella colonna Stampata della tabella Registrazioni non hanno
contenuto. Pertanto vengono stampate tutte le fatture non ancora stampate.

Layout

L'opzione permette di cambiare il layout della fattura. Sono a disposizione una serie di layout
predefiniti .

Preferenze del layout

Per poter utilizzare le preferenze del layout occorre:

Banana Contabilità Plus  (Versione 10.1.7 o successiva)
Piano Advanced

L'opzione permette di impostare le preferenze offerte dal layout selezionato.
Se viene selezionato un layout che non prevede alcuna preferenza, questa sezione non viene
visualizzata nel dialogo.

http://www.banana.ch/apps/it/node/9034
http://www.banana.ch/apps/it/node/9034
https://www.banana.ch/it/download
https://www.banana.ch/it/update
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Stampa come
Puoi selezionare la tipologia di documento che desideri stampare, le scelte sono:

Automatico: stampa il documento in formato fattura.
Bollettino di consegna con importi: stampa il documento come bollettino di consegna.
Bollettino di consegna senza importi: stampa il documento come bollettino di
consegna, senza mostrare gli importi ed il totale.
Offerta: stampa il documento come offerta.
Fattura Proforma: stampa il documento come fattura proforma.
Fattura: Stampa il documento in formato fattura.
Bollettino QR: stampa solo il bollettino QR (unicamente per il layout CH10 ).
1. richiamo: Stampa il documento come primo richiamo.
2. richiamo: Stampa il documento come secondo richiamo
3. richiamo: Stampa il documento come terzo richiamo

Il tipo di documento scelto non viene salvato per la volta successiva, viene invece impostato
nuovamente su "automatico".

Le preferenze del layout sono offerte dai seguenti layout:

[CH10] Layout con codice QR svizzero
[UNI11] Layout 11 Fattura Programmabile 

Altri layouts

Questo bottone rimanda alla finestra di dialogo Gestione Estensioni, dove è possibile installare nuovi
layout, aggiornare quelli già in uso con le versioni più recenti, oppure aggiungere i propri layout
personalizzati.

Impostazioni

Permette di accedere al dialogo delle impostazioni del layout selezionato, dove è possibile
personalizzare la stampa della fattura. Ogni layout ha le proprie impostazioni personalizzabili.

Aggiorna Colonna Stampato dopo la stampa

La colonna è visibile con il comando Dati > Disponi colonne.

Aggiorna la colonna Stampata della tabella Registrazioni con il testo 1 dopo l'anteprima della fattura.
Questo permette all'opzione Seleziona fatture non stampate di selezionare le fatture con il
contenuto della colonna vuota.

 Sezione Opzioni
In questa sezione si possono aggiungere dei testi specifici per ogni lingua, per esempio, per
indicare dei saluti finali o le coordinate bancarie per il pagamento. A seconda della lingua del cliente,
il programma visualizzerà a fine fattura i testi salvati per la lingua indicata.

Si può inserire unicamente un solo tipo di testo, uno per ogni lingua.

I testi inseriti in questa sezione vengono ripresi nella stampa di tutte le fatture, con qualsiasi layout di
stampa si utilizzi.

Per inserire un testo finale:

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9423
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Menu Report > Clienti > Stampa fatture.
Nella sezione Opzioni, inserire il testo desiderato.
Confermare con OK.

Il testo inserito apparirà nell'anteprima di stampa della fattura.

Inserire diversi tipi di testi finali
Per inserire nelle fatture diversi tipi di note, consultare la pagina:

Impostare testi finali

Esporta PDF
Il programma visualizza l'anteprima le fatture, con il comando Esporta PDF si può poi creare il file che
contiene tutti gli estratti o dei PDF per ogni estratto.
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Stampa Bollettino di consegna

Con la Fatturazione integrata quando si crea una fattura questa è automaticamente registrata nella
contabilità e nel conto del cliente.
È possibile stampare una fattura con la dicitura "Bollettino di consegna" con i dati della stessa fattura,
utilizzando i layout CH10  e UNI11 .

Non è invece possibile creare unicamente una registrazione per il bollettino di consegna senza
ripercussioni contabili, che non addebiti il conto del cliente e non accrediti gli altri conti.

Requisiti per poter utilizzare le preferenze del layout:

Banana Contabilità Plus  (release 10.1.7 o successive).
Il piano Advanced

Come stampare un Bollettino di consegna
Nella tabella Registrazioni seleziona la riga dove si trova il bollettino di consegna e procedi come
segue:

Menu Report > Clienti > Stampa fatture
Seleziona il Layout CH10 o UNI11
All'opzione Stampa come, seleziona:

Bollettino di consegna con importi 
In questo caso vengono inclusi nel bollettino importi nei dettagli e importo totale.
Bollettino di consegna senza importi
Nel bollettino vengono visualizzati solo i dettagli relativi alla merce spedita, senza alcun
importo.

Conferma con OK.

Indirizzo spedizione
Quando si stampa il bollettino di consegna con un indirizzo diverso da quello della fatturazione,
l'indirizzo di consegna deve essere inserito nella tabella Registrazioni, utilizzando la colonna Tipo.

In questo caso, nel bollettino di consegna verrà stampato l'indirizzo inserito nella tabella
Registrazioni e non quello del relativo cliente che invece si trova nella tabella Conti, vista Indirizzi.

Personalizzazione della stampa
Tutte le impostazioni che caratterizzano il Layout CH10 e UNI11 vengono mantenute anche nella
stampa del bollettino di consegna.

Per modificare le impostazioni, vai nelle Impostazioni del Layout di stampa .

Nella sezione Testi > Bollettino di consegna puoi definire i testi iniziali e finali nel bollettino di
consegna.

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/it/download
https://www.banana.ch/it/download
https://www.banana.ch/it/update
https://www.banana.ch/apps/it/node/9365
http://www.banana.ch/apps/it/node/9365#deliverynote_reminder_texts
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Esempio di stampa:
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Stampa Offerte

 

Con la Fatturazione integrata quando si crea una fattura questa è automaticamente registrata nella
contabilità e nel conto del cliente.
È possibile stampare una fattura con la dicitura "Offerta" con i dati della stessa fattura, utilizzando i
layout CH10  e UNI11 .

Non è invece possibile creare unicamente una registrazione di sola Offerta senza ripercussioni
contabili, che non addebiti il conto del cliente e non accrediti gli altri conti.

Requisiti per poter utilizzare le preferenze del layout per scegliere la dicitura "Offerte":

Banana Contabilità Plus  (release 10.1.7 o successive).
Il piano Advanced

Come stampare un'offerta
Nella tabella Registrazioni seleziona la riga dove si trova la registrazione dell'offerta e procedi come
segue:

Menu Report > Clienti > Stampa fatture
Seleziona il Layout CH10 o UNI11
All'opzione Stampa come, seleziona Offerta
Conferma con OK.

L'offerta viene sempre stampata senza il bollettino QR svizzero.

Personalizzazione della stampa
Tutte le impostazioni che caratterizzano il Layout CH10 e UNI11 vengono mantenute anche nella
stampa dell'offerta.

Per modificare le impostazioni, vai nelle Impostazioni del Layout di stampa .

Nella sezione Testi > Offerta  puoi definire i testi iniziali e finali dell'offerta.

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/it/download
https://www.banana.ch/it/update
https://www.banana.ch/apps/it/node/9365
http://www.banana.ch/apps/it/node/9365#deliverynote_reminder_texts
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Stampa Richiami

In Banana Contabilità Plus puoi stampare i richiami in due modalità diverse:

Stampa richiami dal dialogo Stampa Richiami.
La stampa del richiamo si basa sul saldo aperto del conto del cliente.
Funzione disponibile in Banana Contabilità Plus - qualsiasi piano (escluse limitazioni piano
Free).
Utilizza il layout Richiamo pagamento (Banana+)  (stampa senza bollettino di
pagamento QR).
Personalizzazioni limitate.

Stampa richiami dal dialogo Stampa Fatture.
La stampa del richiamo viene creata partendo dalla fattura non pagata.
Non utilizzare questa modalità se il conto cliente ha un saldo parziale aperto che non
corrisponde ad una determinata fattura.
Richiede Banana Contabilità+  (versione 10.1.7 o successive) e il piano Advanced .
Utilizza il layout Fattura CH10  (con stampa QR code) e UNI11 .
Personalizzazioni previste dai layout.

https://www.banana.ch/apps/it/node/9658
https://www.banana.ch/it/download
https://www.banana.ch/it/update
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
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Stampa Richiami dal dialogo Stampa Fatture

Banana Contabilità Plus, con i layout CH10  e UNI11 , permette di stampare anche i richiami.

Requisiti per poter utilizzare le preferenze del layout:

Banana Contabilità+  (versione 10.1.7 o successive).
Il piano Advanced

Sulla base dei dati delle fatture, inseriti nella tabella Registrazioni, si possono stampare i richiami.

Come stampare il richiamo
Nella tabella Registrazioni seleziona la riga dove si trova la fattura per la quale devi stampare il
richiamo e procedi come segue:

Menu Report > Clienti > Stampa fatture
Seleziona il Layout CH10 o UNI11
All'opzione Stampa come, seleziona una delle seguenti opzioni:

1. richiamo
2. richiamo
3. richiamo

Conferma con OK

Personalizzazione della stampa
Tutte le impostazioni che caratterizzano il Layout CH10 e UNI11 vengono mantenute anche nella
stampa dei richiami.

Per modificare le impostazioni, vai nelle Impostazioni del Layout di stampa .

Nella sezione Testi → Richiamo  puoi definire i testi iniziali e finali nel richiamo.

 Esempio di stampa:

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/it/download
https://www.banana.ch/it/update
https://www.banana.ch/apps/it/node/9365
http://www.banana.ch/apps/it/node/9365#deliverynote_reminder_texts
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Registrazione incasso fatture

Per chiudere lo stato delle fatture aperte dei clienti ci sono due modalità:  

Registrare manualmente l'incasso della fattura del cliente.1.
Registrazione in automatico con importazione dei dati dall'estratto conto in formato ISO 20022.2.

Registrazione manuale dell'incasso
Per registrare manualmente gli incassi delle fatture, consultare i paragrafi delle seguenti pagine:

Registrazione sul fatturato
Registrazione sull'incassato.

Registrazione importazione dei dati ISO 20022 (Svizzera)
Per chiudere automaticamente le fatture aperte dei clienti con l'importazione dei dati dall'estratto
conto, è necessario:

Scaricare e salvare sul proprio computer i dati in formato ISO 20022 direttamente dal sito della
banca.
Sono supportati file nei formati ISO 20022 camt052, camt053 e camt054 per le specifiche
svizzere .
Installare l'estensione Estratto bancario Camt ISO 20022 Svizzera (Banana+) .
Impostare alcuni parametri dell'estensione .
Importare i movimenti selezionando l'estensione Estratto bancario Camt ISO 20022
(Svizzera).

Con l'importazione, il programma crea delle registrazioni in automatico nella tabella Registrazioni e
inserisce i dati nelle corrispondenti colonne:

Nella colonna Data, la data dell'incasso della fattura.
Nella colonna Fattura, il numero di fattura estratto dal numero di riferimento QR (vedi
parametri ).
Nella colonna Descrizione, il numero di riferimento QR.
Nella colonna Avere, il conto cliente estratto dal numero di riferimento QR (vedi parametri );
Il conto cliente estratto verrà salvato come conto/categoria o centro di costo in base ai
parametri.
Nella colonna Importo, l'importo della fattura.
Nella colonna Dare, il conto della contropartita (il conto bancario dove è stato incassato
l'importo) se questo è stato abilitato durante l'importazione.

Per maggiori informazioni, vedi la pagina Estratto bancario Camt ISO 20022 (Svizzera) .

Riferimenti QR
I codici dei riferimenti QR sono spiegati alle seguenti pagine:

Con il conto IBAN viene utilizzato il tipo Riferimento Structured Creditor Reference (SCOR) .

https://www.banana.ch/apps/it/node/9660#swiss_specifications
https://www.banana.ch/apps/it/node/9660#swiss_specifications
https://www.banana.ch/apps/it/node/9660
https://www.banana.ch/apps/it/node/9660#parametri
https://www.banana.ch/apps/it/node/8984#parametri
https://www.banana.ch/apps/it/node/8984#parametri
https://www.banana.ch/apps/it/node/9660
https://www.banana.ch/apps/it/node/9660
https://www.banana.ch/apps/it/node/9381#riferimento_creditor_reference
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Con il conto speciale QR-IBAN viene utilizzato il tipo Riferimento QRR .

https://www.banana.ch/apps/it/node/9387#riferimento_qr_qrr
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Modificare conto cliente e numero fattura

 Quando si modifica il numero di cliente sia nel partitario sia nei centri di costo/profitto, o il numero di
fattura, bisogna fare molta attenzione e valutare che non ci siano fatture aperte degli anni precedenti.

Modifica conto cliente senza saldi iniziali
È possibile rinominare il conto cliente con il comando Rinomina.

Nel caso ci fossero delle registrazioni già fatte con il vecchio conto, queste verranno aggiornate in
automatico con il nuovo conto cliente.

Si consiglia di rinominare un conto cliente all'inizio dell'anno e quando non ci sono fatture aperte.

Modifica del conto cliente con saldi iniziali
Quando si rinominano dei conti clienti che hanno dei saldi iniziali (fatture aperte) non è possibile
rinominare semplicemente il conto, ma è necessario creare un conto aggiuntivo con la nuova
numerazione. Il saldo d'apertura verrà spostato dal vecchio conto al nuovo conto con una
registrazione contabile.

Nella tabella Conti, aggiungere il nuovo conto con la nuova numerazione

Nella tabella Registrazioni, creare la registrazione per stornare il saldo iniziale dal vecchio conto
al nuovo conto.
Se nel nuovo anno ci sono fatture che fanno riferimento al vecchio conto, queste possono
essere attribuite al nuovo conto, cambiando il numero di conto per ogni singola registrazione
che lo utilizza. Fare molta attenzione se le fatture sono già state inviate al cliente o pagate, o il
numero di documento include anche il numero cliente.

Dal menu Report → clienti → Fatture aperte per cliente, viene visualizzato il report con la
chiusura del vecchio conto e il trasferimento del saldo sul nuovo conto.
Il conto con la vecchia numerazione, avendo saldo zero, potrà essere cancellato nell'anno
successivo, quando il saldo iniziale sarà a zero.
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Modifica del numero fattura già registrata/emessa
Se si vuole cambiare il numero di una fattura non ancora pagata ci sono due possibilità:

Sostituire il numero fattura direttamente nella registrazione originale della fattura.

Questa procedura non è consigliata se la fattura con il vecchio numero è stata registrata nel file
dell'anno precedente.

Stornare la registrazione di emissione della fattura.
Nella colonna Fattura, inserire il numero fattura.
Nella colonna Tipo inserire 15 (chiudi documento cliente).
Nella colonna Dare, inserire un conto di trasferimento.
Nella colonna Avere, inserire il conto del cliente.
Nella colonna Importo, inserire l'importo.

Questa procedura è consigliata se la fattura con il vecchio numero è stata registrata nel file dell'anno
precedente.
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Note di credito

Le note di credito hanno un TipoDoc proprio, diverso dalle fatture.

Inserisci la registrazione come se fosse una fattura.
Nella colonna Fattura devi indicare il nr. di fattura a cui si riferisce la nota di credito. 
I conti seguiranno la logica di registrazione di una nota di credito. Di conseguenza l'importo del
documento sarà in negativo.
Nella colonna TipoDoc inserire 12.
Inserisci nella colonna Descrizione il testo che apparirà nei dettagli della Nota di credito.
Con alcuni layout di stampa di Banana 9 viene comunque stampata la dicitura Fattura, per
cambiare:

Inserisci una nuova riga con lo stesso numero fattura e il TipoDoc 12:tit. 
Nella colonna Descrizione inserisci Nota di credito.

Stampare la nota di credito

Si usa lo stesso comando per la stampa delle fatture: Reports → Clienti → Stampa fatture.
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Emissione fattura e IVA sull'incassato

La procedura di Banana Contabilità prevede di inserire il codice IVA sempre sulla riga dove si registra
il ricavo. Quando si è soggetti all'IVA sull'incassato, il conto di ricavo di conseguenza si registra al
momento dell'incasso. La gestione dei clienti viene tenuta con il centro di profitto CC3.

In questo caso per poter registrare il cliente e l'emissione della fattura è necessario:

Nel piano contabile impostare il partitario clienti con il centro di profitto CC3
Nelle impostazioni del menu clienti selezionare il gruppo del centro di profitto CC3
Al momento che si emette la fattura, registrare:

l'importo
nella colonna CC3 inserire il cento di profitto CC3  (nessun conto in dare e in avere)
sulla stessa riga inserire il codice IVA di vendita tra parentesi quadre [V77].
Il codice IVA inserito fra parentesi quadre permette di visualizzare l'importo IVA nella
fattura, senza la sua contabilizzazione che avviene quando sarà registrato l'incasso.
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Arrotondamenti importi fatture

Nel caso in cui nella stampa della fattura ci siano degli arrotondamenti, è necessario riportare
l'arrotondamento nella contabilità, altrimenti il programma segnala l'errore, indicando la differenza da
registrare. 

Dal menu Report > Clienti > Impostazioni > Avanzato è possibile impostare l'arrotondamento della
fattura ai centesimi desiderati, ma solo in moneta base.

Se non si desidera arrotondare l'importo della fattura, occorre impostare l'arrotondamento nel campo
Arrotondamento fattura (moneta base) a 0.01; il totale della fattura sarà corrispondente
all'importo della registrazione.

Registrare arrotondamento positivo partitario clienti
Quando c'è un arrotondamento in positivo, nella tabella Registrazioni registrare come segue:

Nella colonna Data, inserire la data della fattura.
Nella colonna Fattura, inserire il numero della fattura.
Nella colonna Descrizione, inserire una descrizione.
Nella colonna Dare, inserire il conto del cliente.
Nella colonna Avere, inserire la contropartita (conto Vendite, Consulenza o altro).
Nella colonna Importo, inserire i centesimi dell'arrotondamento.
 

Registrare arrotondamento negativo partitario clienti
Quando c'è un arrotondamento in negativo, nella tabella Registrazioni registrare come segue:

Nella colonna Data, inserire la data della fattura.
Nella colonna Fattura, inserire il numero della fattura.
Nella colonna Descrizione, inserire una descrizione.
Nella colonna Dare, inserire la contropartita (conto Vendite, Consulenza o altro).
Nella colonna Avere, inserire il conto del cliente.
Nella colonna Importo, inserire centesimi dell'arrotondamento.
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Registrare arrotondamento positivo centri di costo (CC3)
Quando c'è un arrotondamento in positivo, nella tabella Registrazioni registrare come segue:

Nella colonna Data, inserire la data della fattura.
Nella colonna Fattura, inserire il numero della fattura.
Nella colonna Descrizione, inserire una descrizione.
Nella colonna Dare, lasciare vuoto
Nella colonna Avere, lasciare vuoto
Nella colonna Importo, inserire centesimi dell'arrotondamento.
Nella colonna CC3, inserire il centro di costo del cliente.
 

Registrare arrotondamento negativo centri di costo (CC3)
Quando c'è un arrotondamento in negativo, nella tabella Registrazioni registrare come segue:

Nella colonna Data, inserire la data della fattura.
Nella colonna Fattura, inserire il numero della fattura.
Nella colonna Descrizione, inserire una descrizione.
Nella colonna Dare, lasciare vuoto
Nella colonna Avere, lasciare vuoto
Nella colonna Importo, inserire centesimi dell'arrotondamento.
Nella colonna CC3, inserire il centro di costo del cliente con il segno meno davanti.
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Gestione Fornitori

La gestione Fornitori consente di registrare, organizzare, gestire le informazioni dei fornitori e
permette di tenere traccia delle transazioni e dei pagamenti ai fornitori, delle scadenze di pagamento
e delle informazioni di contatto. Puoi controllare le scadenze delle fatture da pagare, quelle pagate e il
saldo del conto di ogni fornitore, nonché il saldo aperto totale.

La gestione Fornitori è una delle funzionalità di Banana Contabilità Plus disponibile in tutti gli
applicativi contabili, ma usata prevalentemente nella contabilità in partita doppia.
Guarda anche la gestione Clienti.

Le impostazioni dell'anagrafica fornitori prevedono sia la gestione sul fatturato sia quella
sull'incassato. Si possono gestire anche conti di fornitori in valuta estera.

La funzione dei pagamenti delle fatture dei fornitori via e-banking è disponibile solo nel piano
Advanced .

Registrare i movimenti dei fornitori
La tabella Registrazioni  è il fulcro di Banana Contabilità e viene usata per registrare tutte le
operazioni, incluse i movimenti dei fornitori, semplicemente indicando il conto del fornitore. Lavori
velocemente perché puoi selezionare, copiare e incollare i movimenti dei fornitori già inseriti in
precedenza. Se fai degli errori puoi sempre correggere.

I movimenti dei fornitori registrati nella tabella Registrazioni sono le seguenti:

Ricevimento delle fatture
Pagamento delle fatture
Note di credito o storni ricevuti
Gestione pagamenti via e-banking

Ci sono colonne dove inserire varie informazioni, ovvero:

La data dell'operazione, di scadenza, e di pagamento.
Il numero fattura.
Il Conto Dare e Avere dove indicare il conto fornitore e la contropartita.
L'importo.
I codici IVA per il calcolo automatico dell'IVA. 
Collegamenti a documenti digitali (per esempio la fattura ricevuta dal fornitore, o delle

https://www.banana.ch/it/advanced
https://www.banana.ch/it/advanced
http://www.banana.ch/doc/it/node/2630
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annotazioni in pdf).

Conti fornitori
I conti dei fornitori sono utilizzati per registrare tutti i movimenti relativi ai fornitori di un'azienda.

Le funzioni principali dei conti fornitori sono le seguenti:

Creare un conto per ogni fornitore e tenere traccia di tutte le transazioni effettuate.
Registrare le fatture ricevute per ogni fornitore.
Creare un ordine di pagamento E-banking, direttamente dalla registrazione della fattura del
fornitore.
Registrare i pagamenti ai fornitori e associarli alle fatture ricevute.
Ottenere degli elenchi per il controllo dei pagamenti.

In Banana Contabilità Plus:

I conti dei fornitori e gli indirizzi (nome, cognome, nome società, indirizzo, partita IVA, ecc..)
vengono impostati nella tabella Conti.
I movimenti contabili sui conti vengono inseriti nella tabella Registrazioni.
Dopo ogni registrazione, tutti i saldi dei conti fornitori (tabella Conti) vengono automaticamente
aggiornati e hai immediatamente una visione d'insieme dei saldi aperti ancora da pagare.

Registrare fatture ricevute
La fattura ricevuta dal fornitore viene utilizzata per fini contabili e fiscali, poiché consente di registrare
in modo accurato i costi e le spese dell'azienda, e di calcolare l'IVA.

In Banana Contabilità le fatture vengono contabilizzate nella tabella Registrazioni :

Inserendo la data e la descrizione
Inserendo un numero di fattura
Registrando nel conto Dare il conto del costo e nel conto Avere il conto del fornitore.
Indicando il codice IVA per gli acquisti di merce o i servizi. I calcoli e gli importi IVA vengono
inseriti in automatico.

Registrare i pagamenti
In Banana contabilità gli pagamenti si registrano nella Tabella Registrazioni con una delle seguenti
modalità:

Registrazione manuale:
Si registra la data e la descrizione
Nella colonna Fattura, inserendo il conto del fornitore, in un menu a tendina vengono
visualizzate le fatture ancora aperte, basta selezionare la fattura ricevuta dal fornitore e
premendo il tasto invio, il programma inserisce in automatico il conto del fornitore in
Dare, e l'importo della fattura. Basta poi inserire il conto della liquidità in Avere per
completare la registrazione.

Importazione dati dagli estratti conto con le Regole .

http://www.banana.ch/doc/it/node/2630
https://www.banana.ch/doc/it/rules
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Il programma importa i dati dagli estratti conto ISO 20022  e con l'uso delle Regole il
programma inserisce la registrazione completa, inserendo tutti i dati, senza dover
intervenire manualmente.

Fatture aperte

Le fatture aperte per fornitore sono quelle ricevute, ancora ancora da pagare.

Le fatture aperte dei fornitori possono essere gestite tramite un registro contabile che tiene traccia
delle fatture emesse, delle scadenze di pagamento e dei pagamenti ricevuti. In questo modo, il
venditore può monitorare la situazione finanziaria di ogni cliente e inviare dei solleciti di pagamento
nel caso in cui le fatture rimangano aperte per troppo tempo.

È importante notare che le fatture aperte dei fornitori influenzano la liquidità dell'azienda, in quanto si
deve tenere conto del denaro da impiegare per il pagamento di queste fatture.

Banana Contabilità genera in automatico il report delle fatture aperte dove puoi verificare
immediatamente quali fatture sono ancora da pagare e di quale fornitore, nonché l'ammontare totale
delle fatture scoperte.

Ci sono due tipi di report:

Fatture aperte per fornitore, dove vengono elencate tutte le fatture aperte per ogni1.
fornitore.

2. Fatture aperte per scadenza, dove vengono elencate le fatture aperte in ordine di scadenza.

La data di scadenza di una fattura può essere impostata in modi diversi. Maggiori informazioni sono
disponibili alla seguente pagina Scadenze e termini di pagamento.

Scheda conto

Le schede conto sono documenti utilizzati in contabilità che riportano le transazioni finanziarie di
un'azienda. Ogni scheda rappresenta un conto specifico nel registro contabile generale dell'azienda e
contiene informazioni dettagliate sulle transazioni che riguardano quel conto, come la data
dell'operazione finanziaria, il tipo di operazione, l'importo e la descrizione dell'operazione.

In Banana contabilità, sulla base dei dati inseriti nella tabella Registrazioni, il programma in
automatico elabora la Scheda conto per ogni fornitore, dove vengono riportati il saldo di apertura,
tutti i movimenti e relativo saldo finale. Puoi avere la scheda conto anche per periodo.

http://www.banana.ch/doc/it/node/8785
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Impostare e utilizzare le funzionalità fornitori
Impostare i conti per una contabilità sul fatturato (principio di competenza).1.
Impostare i conti per una contabilità sull'incassato (principio di cassa).2.
Configurare le impostazioni fornitori (spiegazione come per i clienti).3.
Impostare la tabella registrazioni e registrare le fatture fornitori.4.
Resoconti fatture fornitori aperte, scadute o ricevute.5.

Note
Nella Contabilità  multimoneta i resoconti si basano sui saldi in divisa del conto del fornitore, per
cui eventuali differenze di cambio non vengono considerate.
Nella tabella Fatture ricevute, sono elencate anche le registrazioni differenze di cambio, nelle
altre stampe invece a fare stato è unicamente l'importo in moneta del fornitore.
La colonna Descrizione dei resoconti riprende la prima riga di registrazione per ogni fattura.
Per le contabilità sull'incassato è possibile impostare un partitario fornitori con i centri di costo.

File d'esempio
Menu clienti e fornitori.ac2

https://www.banana.ch/doc/files/Menu_clienti_fornitori_19052015_1.ac2
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Gestione sul fatturato (principio di
competenza)

Introduzione
In Banana Contabilità è possibile gestire i fornitori sia sul fatturato che sull'incassato. Una spiegazione
dettagliata è disponibile alla pagina Contabilità sul fatturato o incassato .

Qui di seguito viene spiegato come impostare il gruppo e i conti dei fornitori, in modo tale da poter
avere un elenco delle fatture separate per ogni fornitore.

Se si hanno poche fatture e non si vuole tenere un dettaglio per fornitore, è anche possibile avere un
solo conto dove registrare tutte le fatture dei fornitori. In questo caso, l'elenco delle fatture sarà
raggruppato per l'insieme dei fornitori e non per singolo fornitore.

Impostare il gruppo e i conti dei fornitori
I conti e/o i gruppi dei fornitori possono essere inseriti come dei conti normali direttamente nel piano
dei conti, nella sezione dei passivi.

È anche possibile creare una sezione separata con il partitario fornitori. In questo modo, nei passivi
risulterà solo il totale del gruppo fornitori e nel partitario saranno invece presenti tutti i conti dei
fornitori.

Per creare il partitario in una sezione separata, occorre aggiungere alla fine del piano dei conti:

Una sezione * (intestazione)  (vedi sezioni)
Una sezione 02 per i fornitori (vedi sezioni)
I conti fornitori che si desiderano (vedi aggiungere un nuovo conto). Ogni fornitore è una riga
del piano dei conti e ha un proprio numero di conto. La numerazione dei conti è libera (vedi
Conti), tuttavia si consiglia di utilizzare unicamente cifre, in particolare per la gestione dei
pagamenti.
Un gruppo dove sono totalizzati tutti i conti fornitori.
Questo gruppo è a sua volta totalizzato in un gruppo presente nei passivi

Il totale fornitori viene sommato nel gruppo riepilogativo 200A della colonna Somma in.
Lo stesso numero o codice, utilizzato per il raggruppamento Somma in (200A) deve essere
impostato nella colonna Gruppo dei Passivi, per il riporto del totale Fornitori nel Bilancio.
La numerazione dei gruppi è libera (vedi gruppi).

https://www.banana.ch/area/it/node/11053
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Registrare una fattura ricevuta

Registrare un pagamento
Inserire la data di registrazione
Posizionarsi sul campo Fattura e premere il tasto F2 oppure fare un doppio click sulla cella.
Apparirà la lista delle fatture ancora aperte.
Selezionare la fattura del fornitore pagata e premere Enter.
Il programma completerà la registrazione con i campi Descrizione, Conto Dare ed Importo.
Finché non verrà inserito il conto della contropartita, il programma segnalerà la differenza  nella
registrazioni.

Registrare una nota di credito
Affinché l'importo venga dedotto dalla fattura iniziale è necessario utilizzare lo stesso numero
di fattura. Se il documento di rettifica (ad esempio una nota di credito) presenta una numerazione
diversa che bisogna comunque tenere a disposizione, scrivere tale riferimento in un'altra colonna, ad
esempio Doc. Originale.
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Gestione sull'incassato (principio di cassa)

Impostare il partitario fornitori con i centri di costo
Per gli utenti svizzeri che hanno l'IVA sull'incassato, questa impostazione permette di
gestire l'IVA in modo ottimale.

È possibile gestire il partitario clienti e fornitori come centri di costo (vedi anche la  pagina Centri di
costo e di profitto). Una spiegazione dettagliata è disponibile alla pagina Contabilità sul fatturato o
incassato .

Si consiglia di usare il centro di costo CC3 (conti preceduti dal punto e virgola ";")
I saldi dei centri di costo non appariranno quindi nel Bilancio.

Registrazioni

Le informazioni sono disponibili alla pagina Clienti e fornitori con l'IVA sull'incassato.

https://www.banana.ch/area/it/node/11053
https://www.banana.ch/area/it/node/11053
https://www.banana.ch/area/it/node/10506#A
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Operazioni diverse fornitori

Le varie funzionalità elencate hanno le stesse modalità di quelle dei fornitori. Pertanto, per gli
approfondimenti si rimanda alle relative pagine dei clienti.

Visualizzare la colonna Fattura nella tabella Registrazioni
Vedi Clienti-Visualizzare la colonna Fattura.

Completamento automatico
Vedi Clienti-Completamento automatico.

Comandi Estrai righe fattura e apri collegamento fattura
Vedi Clienti-Comandi estrai righe fattura.

Inserire gli indirizzi (opzionale)
Vedi Clienti-Abilitare le colonne indirizzi.

Configurare le impostazioni fornitori
Selezionare il comando Report → Fornitori → Impostazioni.
Importante è indicare nel "Gruppo o conto", il gruppo del piano dei conti dove sono raggruppati
i diversi conti dei fornitori.
Per la spiegazione delle diverse opzioni vedi Impostazioni clienti/fornitori
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Elenco fatture fornitori

Visualizzare le fatture ricevute
Comando: Report → Fornitori → Fatture ricevute dai fornitori

In questa tabella vengono visualizzate tutte le fatture che appartengono al partitario fornitori oppure
ad un singolo fornitore.

Visualizzare le fatture aperte
Comando: Report → Fornitori → Fatture aperte per fornitore.

In questa tabella vengono visualizzate unicamente le fatture che hanno un saldo aperto.

Per le contabilità multidivisa, se sono presenti differenze di cambio non registrate per un determinato
fornitore, verrà visualizzata una riga di 'Aggiustamento differenze di cambio' che pareggia il saldo
dell'elenco fatture aperte con il saldo della scheda conto.

Visualizzare le fatture per data di scadenza
Comando: Report → Fornitori → Fatture aperte per data scadenza.

In questa tabella vengono visualizzate unicamente le fatture che hanno un saldo aperto, raggruppate
per periodo di scadenza.
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Ordini di pagamento per le fatture dei
fornitori

La nuova funzionalità Pagamenti consente di creare ordini di pagamento (pain.001) a partire da un
elenco di registrazioni oppure dalla lettura di codici QR di fatture ricevute.

I file pain.001 sono dei messaggi XML che contengono i dettagli per effettuare i pagamenti e possono
essere inviati agli istituti finanziari che riconoscono questo formato. Banana Contabilità Plus supporta
gli standard di pagamento svizzeri.

Ulteriori informazioni Ordini di pagamento pain.001

Prerequisiti e note importanti
Attualmente la funzionalità Pagamenti:

È disponibile nell'ultima versione di Banana Accounting+ Dev Channel
Richiede il piano Advanced . Se non si dispone di questa licenza puoi chiedere un
codice promozionale valido 1 mese tramite il formulario di contatto
È in Beta Test, vi chiediamo quindi di controllare e segnalarci qualsiasi
problema

Come creare l'ordine di pagamento (pain.001)
Apri il file della contabilità (contabilità in partita doppia o contabilità entrate-uscite) o scarica il1.
nostro file di esempio Payments_2022_en.ac2 .
 
Verifica che nella tabella Conti, sia presente la vista Indirizzi.2.
Puoi aggiungerla utilizzando il comando Strumenti > Aggiungi/Rimuovi
funzionalità... > Aggiungi colonne indirizzi nella tabella Conti.
Se le colonne nella vista Indirizzi sono diverse (ad es. manca la colonna IBAN, consulta la
documentazione Vista Indirizzi
 
Installa le funzionalità di pagamento  tramite il comando Strumenti > Aggiungi/Rimuovi3.
funzionalità.
 

Imposta il conto bancario d'addebito, che verrà utilizzato quando si crea l'ordine di pagamento.4.
Nella tabella Conti, vista Indirizzo, seleziona il conto d'addebito e completa i seguenti dati:

- Nome, cognome o ragione sociale (titolare del conto bancario)
- IBAN (conto IBAN del conto bancario o postale da addebitare)
- Bank clearing (codice BIC dell'istituto finanziario da addebitare)

Controlla e aggiorna nella tabella Conti, vista Indirizzo, l'indirizzo e le informazioni di5.
pagamento dei fornitori. 
Se non disponi di un elenco fornitori, impostalo in base alla nostra spiegazione nella sezione

http://www.banana.ch/apps/it/node/9327
http://www.banana.ch/it/insiderprogram
http://www.banana.ch/it/buy
https://www.banana.ch/it/contact_form?obj=support&app=bananaPlus
http://github.com/BananaAccounting/Switzerland/raw/master/payments/doc/Payments_2022_it.ac2
http://www.banana.ch/doc/it/node/9870
http://www.banana.ch/apps/it/node/9327
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Fornitori .
Se effettui pagamenti mediante scansione di codici QR, non è necessario configurare gli
indirizzi, poiché tutte le informazioni per il pagamento sono contenute nel codice QR.

 
Inserisci nella tabella Registrazioni le fatture degli acquisti oppure scansiona i codici QR delle6.
fatture.

 
Inserisci e completa i dati di pagmento cliccando direttamente sulla cella Payment Data.7.
Assicurati che tutte le transazioni da pagare siano completate con i dati di pagamento. 
Se l'elenco dei fornitori è vuoto (Account ID) è necessario configurare l'estensione Pagamenti,
impostando il gruppo Fornitori, vedi Estensione pagamenti (configurare l'estensione)

http://www.banana.ch/doc/it/node/4738
https://www.banana.ch/apps/it/node/9327
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Seleziona il comando Reports > Fornitori > Crea file di pagamento8.

 
Completa con il nome del titolare del conto da addebitare, il relativo IBAN e codice BIC.  Se hai9.
precedentemente inserito questi dati nella tabella Conti, essi verranno proposti
automaticamente.
Se desideri visualizzare i singoli pagamenti che costituiscono l'ordine nell'estratto del conto
bancario, seleziona l'opzione "Registrazione singola".
Premi sul tasto Successivo.  
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Indica il nome del file che conterrà l'ordine di pagamento. Se non si specifica il percorso del file,10.
l'ordine verrà salvato nella stessa cartella del file contabile. Premi sul tasto Fine.
Nota: in Banana Contabilità non è possibile collegarsi direttamente alla banca per trasmettere il
file, è necessario salvare prima il file sul proprio computer e in seguito eseguire l'upload,
utilizzando il portale web o l'applicativo dell'istituto finanziario.

 
Dopo aver salvato il file di pagamento, verrà inserita una riga nella tabella Registrazioni,11.
contenente l'oggetto payment/file. Si può visualizzare nuovamente il file con il doppio clic sulla
cella Dati Pagamento o cliccando sull'icona di modifica posizionata in alto a destra della cella.
Non è più possibile apportare modifiche al file di pagamento. 
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Quando si crea un ordine di pagamento, in Banana non vengono create le rispettive12.
registrazioni di pagamento, poiché il file deve essere inviato alla banca e il pagamento non è
ancora confermato (es. se il conto di addebito è errato, gli ordini non verranno eseguiti). Per
inserire le registrazioni di pagamento consigliamo di importare in Banana il file ISO 20022
Svizzera  fornito dalla banca. Per visualizzare i pagamenti singolarmente sull'estratto conto,
deve essere attivata l'opzione "Registrazione singola", altrimenti sull'estratto conto verrà
visualizzato solo l'importo totale.

https://www.banana.ch/apps/it/node/9660
https://www.banana.ch/apps/it/node/9660
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Crea file di pagamento

Il comando Report→ Fornitori→ Crea file di pagamento crea un file XML contenente le istruzioni
per effettuare dei pagamenti.  Si basa sugli oggetti di tipo payment/data presenti nella tabella
Registrazioni. Il file XML verrà salvato nella cartella indicata al momento del salvataggio e verrà
creato un oggetto di tipo payment/file  nella tabella Registrazioni.  

Avviso di addebito

In Banana sono possibili le seguenti combinazioni di avviso d'addebito:

Ordine Collettivo (Collective order) e Conferma dettagliata (Detailed confirmation)
selezionata
Ordine collettivo (unico importo sull'estratto conto), riceverai una conferma d'addebito
dettagliata    
batchbookg=true    prtry=CWD
 
Ordine Collettivo (Collective order) e Conferma dettagliata (Detailed confirmation)
deselezionata
Ordine collettivo (unico importo sull'estratto conto) senza ricevere una conferma d'addebito
dettagliata
Codici impostati nel file pain.001: batchbookg=true, prtry=CND
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Registrazione singola (Individual booking) e Conferma dettagliata (Detailed
confirmation) selezionata
Ordine singolo (ogni pagamento sarà visibile sull'estratto conto), riceverai una conferma
d'addebito dettagliata
Codici impostati nel file pain.001: batchbookg=false, prtry=SIA
 
Registrazione singola (Individual booking) e Conferma dettagliata (Detailed
confirmation) deselezionata
Ordine singolo (ogni pagamento sarà visibile sull'estratto conto) senza ricevere una conferma
d'addebito dettagliata
Codici impostati nel file pain.001: batchbookg=false, prtry=NOA
 

È importante verificare con l'istituto bancario che l'avviso di addebito richiesto sia accettato e
informarsi su eventuali commissioni da pagare. 
È consigliato inoltre selezionare sempre l'opzione 'conferma dettagliata', altrimenti potrebbe
verificarsi il caso che sul vostro conto venga addebitato un importo complessivo senza conoscerne i
dettagli.
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Scansione codici QR

Il comando Report > Fornitori > Scan QR Code visualizza il dialogo Scan code, il quale permette di
immettere uno o più codici QR e creare in seguito i files di pagamento pain001 e le registrazioni
contabili.

Lettura dei codici QR
Per leggere i codici QR in Banana sono possibili le seguenti modalità:

utilizzare un lettore di codici QR con interfaccia USB e simulazione input tastiera. Abbiamo
testato il lettore Datalogic QuickScan, maggiori informazioni sono disponibili alla pagina scanner
configuration . 
scansionare i singoli codici QR-Code con un app del cellulare, copiare i dati nella clipboard e
incollarli nel dialogo Scan code di Banana.
copiare un elenco di codici QR nella clipboard separati da punto e virgola, senza
aggiungere spazi o ritorni a capo (...EDP;SPC...), e incollarli nel dialogo Scan code di Banana. 

Associare un conto fornitore a partire dai dati QR
Se desideri associare i dati del codice QR ad un conto fornitore, sono possibili le seguenti situazioni:

il fornitore è già presente nella tabella Conti 
Quando si scansiona il codice QR, il conto fornitore viene selezionato in automatico nel dialogo
Payment Data, se il nome presente nella colonna Organizzazione della tabella Conti,
corrisponde al nome presente nel codice QR.
Se nel dialogo Payment Data, l'elenco dei fornitori è vuoto, è necessario configurare
l'estensione Pagamenti impostando il gruppo Fornitori, vedi Estensione pagamenti (configurare
l'estensione)
il fornitore non è presente nella tabella Conti
devi aggiungere manualmente il nuovo conto fornitore direttamente nella tabella Conti.
Non è comunque necessario avere un conto fornitore per ogni singolo pagamento. Si possono
effettuare i pagamenti senza indicare i conti nella tabella Registrazioni e registrare
contabilmente solo quando il pagamento è stato effettuato, riprendendo i dati dall'estratto

https://www.banana.ch/apps/en/node/9657
https://www.banana.ch/apps/en/node/9657
https://www.banana.ch/apps/it/node/9327
https://www.banana.ch/apps/it/node/9327
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conto CAMT della banca. 
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Elenco pagamenti

Il comando Report→ Fornitori→ Elenco pagamenti visualizza tutti i pagamenti inclusi nei files di
pagamento.

Payment List



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 667

La Gestione IVA di Banana Contabilità+

Banana Contabilità Plus semplifica la gestione IVA, automatizzando il calcolo, la registrazione e la
presentazione delle dichiarazioni alle autorità fiscali. Funzioni all'avanguardia riducono gli errori
manuali, garantendo conformità fiscale. Modelli predefiniti con opzioni IVA e codici già impostati sono
disponibili per tutti gli applicativi contabili, secondo le aliquote in vigore.

Per la Svizzera sono già presenti le nuove aliquote IVA per il 2024 . È disponibile la
nuova estensione IVA  per la presentazione delle dichiarazioni in formato digitale.

Gestione IVA Svizzera
▶ Video: Dichiarazione IVA Svizzera

Gestione IVA Italia

Registrare i movimenti con IVA
Con Banana Contabilità la gestione IVA è molto semplice perché completamente automatizzata. Le
transazioni con IVA si registrano nella tabella Registrazioni, il fulcro principale di tutta la contabilità,
inserendo ad ogni transazione IVA il corrispondente codice IVA, riferito alla vendita o all'acquisto,
secondo le aliquote in vigore.
Sono disponibili diverse colonne già impostate, la cui visualizzazione può essere personalizzata.

Inoltre il programma offre:

Contabilizzare diverse aliquote IVA nella stessa registrazione.
Aggiungere nella colonna Link il PDF della fattura.

Nella tabella Registrazioni ci sono delle Colonne IVA specifiche per le varie informazioni relative
all'IVA.

Per registrare un'operazione con IVA, inserire i seguenti dati:

La data della registrazione.
Il numero fattura.
Nella colonna Link è possibile inserire il collegamento digitale al documento contabile PDF.
Il Conto Dare e Avere dove indicare il conto e la contropartita.
L'importo.
Il codice IVA relativo all'acquisto o alla vendita (codici presenti nella tabella Codici IVA). 

https://www.banana.ch/it/node/11557
https://www.banana.ch/apps/it/extensions?combine=IVA+svizzera&langcode=All&country=All&type=All&op=Invia#
https://www.banana.ch/it/node/10870
https://www.banana.ch/it/node/11401
https://www.banana.ch/area/it/node/10155
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Per ogni registrazione il programma esegue i seguenti automatismi:

Registra in modo accurato l'IVA pagata sugli acquisti e quella incassata sulle vendite.
Calcola automaticamente l'importo IVA.
Scompone l'importo IVA dal costo o dal ricavo.
Riporta sui conti IVA gli importi IVA, imponibile e importo IVA.

Conti e impostazioni IVA già predefiniti
Nei modelli con IVA di Banana Contabilità Plus i conti IVA sono già impostati nella tabella Conti. Nei
passivi sono presenti il conto IVA scomposizione in automatico e il conto IVA dovuta (o Conto
Erario IVA). 

Per velocizzare le registrazioni con IVA, nella tabella Conti è possibile impostare il codice IVA ad ogni
conto che ha delle movimentazioni IVA. Questa impostazione permette di automatizzare l'inserimento
del codice IVA nel momento in cui si digita il conto nella tabella Registrazioni.
Maggiori approfondimenti sono disponibili alla pagina Abbinare il codice IVA al conto.

Tabella Codici IVA
Nella Tabella Codici IVA sono definiti i codici IVA relativi alle aliquote in vigore e altri parametri per il
calcolo dell'IVA.

Ci sono delle colonne dove impostare codici IVA per il calcolo dell'IVA al lordo, al netto o solo
per importo IVA.
Sono presenti sia i codici IVA per il metodo effettivo, sia per il metodo forfettario
I modelli svizzeri hanno la tabella Codici IVA già impostata:

con i codici IVA relative alle aliquote in vigore
per ogni codice IVA, nella colonna GR1, è  impostata la cifra di riferimento che consentirà
di riportare nel facsimile rendiconto IVA e anche nel file Xml i dati IVA da trasmettere
all'Amministrazione Federale delle Contribuzioni (AFC).

Per ogni nazione sono presenti i file con i codici IVA già impostati sulla base delle esigenze di
rendicontazione nazionale.

Report e dichiarazioni IVA automatizzati
Il programma genera in automatico diversi rapporti con riepiloghi molto dettagliati per codice IVA,
conto, percentuali, registrazioni e periodo. I riassunti IVA possono essere personalizzati, visualizzando

http://www.banana.ch/doc/it/node/3826
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le colonne specifiche ai dati che si desidera ottenere. I riassunti IVA sono utili per capire la
movimentazione dell'IVA (IVA dovuta, recuperabile e da versare) e consentono un controllo efficace e
in caso di controlli da parte delle autorità fiscali sono disponili dettagli mirati per facilitare  il lavoro di
verifica.
Maggiori informazioni sono disponibili alla pagina Riassunto IVA.

Le funzioni IVA di Banana Contabilità Plus offrono diversi vantaggi:

Efficienza
Si evita di preparare manualmente calcoli e rendiconti risparmiando tempo e sforzo
Calcoli e rendiconti precisi
Si evitano errori perché i calcoli vengono eseguiti automaticamente in modo accurato dal
programma sulla base dei dati registrati dal sistema.
Conformità alle normative in vigore
Il programma è aggiornato in base alle aliquote in vigore. Basta aggiornare la tabelle Codici IVA
e i calcoli e i rendiconti vengono eseguiti correttamente e in modo coerente con le normative.
Estensioni Rendiconti IVA nazionali
Sono dei moduli aggiuntivi, diversi per nazione, che stampano o esportano i dati dell'IVA nel
formato richiesto dalle autorità fiscali. Si rimanda alla documentazione IVA nazionale .
Archiviazione delle stampe IVA
Tutte le stampe con i dati IVA possono essere salvate in PDF o altri formati e archiviati.
L'archiviazione consente di avere i dati sempre disponibili in caso di controlli fiscali.

Modalità di calcolo
Banana Contabilità è un potente strumento di calcolo e anche nella gestione IVA puoi sfruttarne le
potenzialità per avere calcoli e conteggi IVA sempre precisi e corretti.

Sono previsti due modalità di calcolo:

Metodo Effettivo - calcoli e contabilizzazione dell'IVA sull'incassato e fatturato
Metodo aliquote saldo - calcoli e contabilizzazione IVA in base alle aliquote concesse dal fisco.

Metodi di contabilizzazione
Fatturato
Prevede la tenuta di un partitario clienti e fornitori. 
I costi e i ricavi, con il relativo codice IVA, si registrano al momento dell'emissione e del
ricevimento della fattura.

http://www.banana.ch/doc/it/node/9719
https://www.banana.ch/it/node/10874
https://www.banana.ch/it/node/10875
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Maggiori informazioni sono disponibili alla pagina Come gestire l'IVA sul fatturato .
 
Incassato
Non è obbligatorio tenere un partitario clienti e fornitori, ma se si desidera averlo ugualmente, è
importante impostarlo con i centri di costo.
I costi e i ricavi, con il relativo codice IVA, si registrano al momento dell'incasso o del
pagamento.
Maggiori informazioni sono disponibili alla pagina Clienti e fornitori con IVA sull'incassato .

 Funzionalità al momento non disponibili 
Queste funzionalità non sono al momento disponibili:

Nella contabilità multi-moneta il conto sul quale l'IVA viene registrata al netto (generalmente un
conto dei Ricavi e Costi) deve essere in moneta base.
Non è possibile dedurre l'IVA da conti che non sono in moneta base.
L'importo IVA è calcolato dal programma e ricalcolato quando si lancia il comando Ricalcola
contabilità. In questo modo il revisore o chi controlla la contabilità ha la certezza che i calcoli
sono sempre eseguiti con la stessa logica. 
Per gli arrotondamenti IVA, non è possibile inserire un importo IVA diverso rispetto a quello
calcolato dal programma. Generalmente si tratta di importi IVA che in fattura sono stati
arrotondati, anche di pochi centesimi. 

Elenco completo funzionalità al momento non disponibili
 

Approfondimenti
IVA doganale per importazioni
IVA su servizi esteri - Reverse charge
Arrotondamento IVA
Gestione IVA CH e EU  
Converti in nuovo file con IVA

https://www.banana.ch/it/node/11368
https://www.banana.ch/it/node/10879
https://www.banana.ch/doc/it/features_not_available
https://www.banana.ch/it/node/10883
https://www.banana.ch/it/node/10882
https://www.banana.ch/it/node/10908
https://www.banana.ch/it/node/10872
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Documentazione IVA a seconda del paese

Nella sezione di ogni nazione trovi la documentazione più specifiche sull'IVA.
Qui di seguito sono elencate le tematiche IVA disponibili in lingua Italiana.

Gestione IVA Svizzera
Pagine informative specifiche per la Svizzera:

Tabella codici IVA Svizzera
Come registrare l'IVA
Preparare la dichiarazione IVA
Usare l'Estensione IVA Svizzera
Amministrazione fiscale UE  (per le imprese che dichiarano l’IVA sia in Svizzera che
nell’UE)

Gestione IVA Italia
Pagine informative specifiche per l'Italia:

Tabella codici IVA Italia
Come registrare l'IVA
Preparare la dichiarazione IVA
Usare l'Estensione IVA Italia

Estensioni rendiconti IVA nazionali
Per talune nazioni ci sono delle Estensioni che si possono installare facilmente e consentono di
stampare o esportare il rendiconto IVA nel formato richiesto dalle autorità.

Le estensioni per l'IVA di ogni nazione funzionano in abbinamento alla tabella Codici IVA della nazione.

https://www.banana.ch/it/node/10870
https://www.banana.ch/it/node/10908
https://www.banana.ch/area/it/node/10155
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Nozioni teoriche

L'IVA (Imposta sul valore aggiunto) è una tassa che grava sul consumatore finale. Ogni soggetto IVA
deve calcolare e versare periodicamente l'imposta allo Stato.

Ogni Stato ha delle proprie aliquote IVA che vengono stabilite in percentuali diverse a seconda del
tipo di merce o servizio. Certe merci e servizi sono esenti o escluse.

Le percentuali IVA variano a seconda delle necessità finanziarie dello Stato, pertanto sono soggette a
cambiamenti nel corso degli anni.
 

Aliquota IVA
Negli esempi che seguono sono state utilizzate delle aliquote generiche:

10 % aliquota normale
4% aliquota ridotta
0% operazioni escluse o non soggette a IVA
 

Calcolo dell'IVA
Prezzo netto x percentuale IVA = Importo IVA

Esempio:
Prezzo netto 300
Aliquota 10%
Importo IVA = 300 x 10 / 100 = 30
 

Calcolo del prezzo lordo
Prezzo netto + Importo IVA = Prezzo lordo

Esempio:
300 + 30 = 330

A volte si conosce l’importo lordo ed è necessario calcolare l’importo netto e l’IVA.
 

Calcolo del prezzo netto
Prezzo Lordo / (100 + aliquota IVA) x 100 = Prezzo netto

Esempio:
330 / (100 + 10) x 100 = 300

Il prezzo netto rappresenta il costo (acquisto) o il ricavo (vendita) della ditta.
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Calcolo dell'Importo IVA
Prezzo lordo - prezzo netto = Importo IVA

Esempio:
330 - 300 = 30

oppure

330 – [330 / (100 + 10) x 100] = 30

L’importo IVA rappresenta il debito (nelle vendite) o il credito (negli acquisti) verso lo Stato.
 

Calcolo dell'aliquota IVA
Importo IVA / Importo netto x 100 = Aliquota IVA

Esempio:
30 / 300 x 100 = 10%

oppure

[330 - 330 / (100 + 10) x 100]/100 = 10%

Altro esempio:
20 / 400 x 100 = 5%

Questa modalità di calcolo si applica quando non si conosce l’aliquota.
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Proprietà file (IVA)

Questa sezione è presente soltanto nelle contabilità con IVA.

Si accede alla sezione IVA per l'impostazione dei conti IVA dal menu File > Proprietà file (dati
base) > IVA.

Conto IVA

Viene impostato come predefinito, il conto IVA scomposizione in automatico, presente nel piano
contabile. Per gli utenti svizzeri corrisponde al conto IVA, rendiconto. In questo caso non è
necessario inserire nella Tabella codici IVA il conto IVA.

Con l'impostazione del solo conto IVA scomposizione in automatico, tutte gli importi IVA, sia delle
vendite sia degli acquisti, confluiscono rispettivamente in avere e in dare di questo conto e non è
necessario impostare il conto IVA recuperabile. A fine trimestre, il saldo del conto IVA scomposizione
in automatico viene girato nel conto IVA da pagare (o Erario conto IVA).

Conto IVA Recuperabile

Se non viene impostato come unico conto IVA, il conto IVA scomposizione in automatico, si imposta il
conto IVA recuperabile. In questo caso non occorre inserire il conto nella tabella Codici IVA.

Arrotondamento IVA

Si definisce come devono essere arrotondati gli importi IVA; se si inserisce per esempio 0.05, gli
importi IVA vengono arrotondati ai multipli di 0.05.

Centro di Costo 1 (CC1), 2 (CC2), 3 (CC3)

Per ogni tipo di Centro di Costo è possibile scegliere quale importo usare per la registrazione nel
centro di costo:

Usare l’importo della registrazione.
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Usare l’importo con IVA inclusa
(Nel caso di centri di costo usati per conti clienti o fornitori).
usare l’importo senza IVA
Impostazione se il centro di costo è usato per dei costi o ricavi. 

Nota

se si modifica uno di questi parametri si dovrà ricalcolare la contabilità.

Documenti correlati:

Gestione IVA.
Centri di costo e di profitto.
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Tabella codici IVA

Le impostazioni nella tabella Codici IVA permettono di definire tutti quei parametri che sono
necessari per gestire le modalità delle registrazioni con IVA. Le impostazioni riguardano:

IVA dovuta o da recuperare.
Importo della registrazione al lordo, al netto o importo IVA al 100% (IVA doganale).
Percentuale IVA da applicare.
Il conto dove deve essere registrata l'IVA.
L'arrotondamento speciale per ogni codice.
Il metodo raggruppamento e totalizzazione.

La tabella Codici IVA ha una vista Base e una vista Completo. La differenza è dovuta al fatto che la
vista Completo presenta alcune colonne per impostare opzioni particolari, non presenti in quella base.

Modalità di calcolo
I parametri indicati nella tabella IVA sono usati per calcolare l'IVA delle singole registrazioni.
Nelle registrazioni non si possono cambiare i parametri stabiliti nella tabella Codici IVA. Questa
modalità assicura che i calcoli IVA siano corretti e uniformi sempre.
Avvertenza: se il valore di un codice IVA, già usato nelle registrazioni viene modificato, le modifiche
non saranno immediate, ma è necessario attivare il comando dal menu Azioni > Controlla contabilità.
Quando si modifica la tabella IVA il programma, per precauzione, fa apparire una segnalazione nella
finestra Info che invita a un ricalcolo completo.

La Tabella che segue si riferisce ai codici utilizzati secondo le normative svizzere.

Descrizione dettagliata delle colonne
Nelle seguenti colonne, inserire i seguenti dati:

Gruppo: una sigla o un numero che indichi il gruppo d'appartenenza dei codici.
Per maggiori informazioni sul sistema di raggruppamento si rimanda alla pagina Sistema
Raggruppamento.
Cod.IVA:

Codici IVA normali.
La sigla per identificare e riprendere il codice IVA nelle registrazioni.
Codici preceduti da due punti ":":
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Non sono dei codici IVA. Si utilizzano nella tabella Registrazioni per specificare con
maggiore dettaglio delle casistiche IVA (es.: nelle registrazioni del Reverse Charge si
usano contemporaneamente due codici IVA, separati da due punti, affinché il programma
calcoli l'importo IVA a debito e a credito).

Descrizione: un testo per la descrizione del codice IVA o del Gruppo.
Disabilita:
Permette di disabilitare dei codici IVA che non si usano. Facilita l'immissione dei dati nella
tabella Registrazioni.

1 - il codice IVA non è visibile nella lista di auto-completamento (tabella Registrazioni), ma
può essere ugualmente utilizzato;
2 - il codice IVA non è visibile nella lista di auto-completamento e non deve essere
utilizzato.

Somma in: sigla o numero del Gruppo in cui la riga di un codice deve essere totalizzata.
Gr1: questa colonne viene utilizzata per dei raggruppamenti specifici.
Nell'immagine sono presenti i raggruppamenti per la codifica delle cifre del Rendiconto IVA
svizzero.
Gr2: sigla per raggruppamenti ulteriori.
IVA dovuta:
Se nella cella di questa colonna viene indicato SÌ significa che l'IVA è a debito (dovuta
all'Erario).
Se la cella viene lasciata vuota, si intende che l'IVA è a credito (da recuperare).
Tipo importo:
Il codice indica come dev'essere inteso l'importo IVA nella registrazione.

0 (o cella vuota) - l'importo della registrazione è IVA inclusa.
1 = IVA esclusa - l'importo della registrazione è IVA esclusa.
2 = importo IVA - l'importo della registrazione è importo IVA al 100 %.
Il tipo di importo 2 è utilizzato in particolare per contabilizzare l'IVA doganale pagata o
addebitata sulla fattura dello spedizioniere. Maggiori dettagli sulla registrazione sono
disponibili alla pagina:
IVA doganale per importazioni.

% IVA: aliquota da applicare per il codice IVA.
%Non ded.:
La parte di IVA che non è deducibile in percentuale. Da usare quando l'IVA su certe spese non è
deducibile completamente. Modifiche a questo campo vengono riprese solo per le nuove
registrazioni.
% sul Lordo: di regola si lascia vuoto. Si deve inserire SÌ solo se l'aliquota IVA deve essere
applicata sull'importo lordo (compreso IVA) e non sull'imponibile (per esempio per aliquote
forfettarie).
Conto IVA: Il conto sul quale viene registrata l'IVA scomposta in automatico.
Se la cella del conto IVA è vuoto viene usato il conto generale definito nelle Proprietà file (menu
File).
Arroton. Min: valore minimo d'arrotondamento.
Se è vuoto viene usato l'arrotondamento indicato nei dati base della contabilità.
Non avvisare: vi sono delle registrazioni particolari che il programma potrebbe interpretare
come sbagliate, ma che in effetti sono corrette. Per evitare che il programma segnali gli avvisi
di errore, immettere Sì al codice che interessa.

Ricalcolo della contabilità
Quando si ricalcola la contabilità e le registrazioni non sono bloccate, il programma riprende nelle
registrazioni i parametri IVA assegnati a ogni codice. Pertanto, se un'impostazione di un codice IVA è

https://www.banana.ch/it/node/10883
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stata modificata, la modifica viene ripresa nelle rispettive colonne delle registrazioni che non sono
modificabili dall'utente.

È per questo motivo che, quando si fanno delle modifiche nella tabella Codici IVA, il programma
segnala che è necessario rifare un ricalcolo completo.

Aggiunta di una nuova aliquota 
Quando viene introdotta una nuova aliquota, occorre aggiungere una riga, dove inserire il nuovo
codice IVA con la nuova aliquota, facendo attenzione a inserire correttamente il raggruppamento. È
consigliabile non modificare un codice IVA già utilizzato nelle registrazioni.

Codici IVA per prestazioni di servizi erogate all'estero
Nella tabella Codici IVA si possono impostare, in gruppi separati, dei codici IVA per le prestazioni di
servizi erogati all'estero, con delle aliquote specifiche alla nazione in cui si opera e per le quali l'IVA è
dovuta anche agli stati esteri.

Per ogni nazione si imposta il codice IVA corrispondente che può essere totalizzato in un gruppo
proprio oppure in un gruppo di totalizzazione che si riferisce all'IVA da versare agli Stati esteri.

Per visualizzare gli importi da versare, andare al menu Report > Riassunto IVA e selezionare il codice
specifico per nazione o il gruppo di totalizzazione per l'IVA da versare agli stati esteri.

Per l'IVA da versare agli stati esteri non è possibile effettuare la trasmissione per via elettronica.

Raggruppamenti propri
Creando dei gruppi propri con livelli multipli di totalizzazione è possibile ottenere i totali che servono
per la dichiarazione dell'IVA.
Quando nel riassunto IVA si attiva l'opzione usa raggruppamenti propri, il programma calcola i
totali esattamente nella sequenza indicata nella tabella Codici IVA.
I raggruppamenti si usano per avere dei totali per gruppo di registrazioni, per esempio, i totali di tutte
le esportazioni, importazioni.

Documento correlato:

Importare la tabella codici IVA
Documentazione IVA nazionale, 
Link a documentazione IVA specifica per la Svizzera, Italia e altre nazioni.

https://www.banana.ch/it/node/10872
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Collegare il codice IVA al conto

Nelle contabilità con IVA, nella tabella Conti, per automatizzare l'inserimento del codice, è possibile
abbinare un codice IVA ai conti che si riferiscono a dei movimenti con IVA; nella tabella Registrazioni,
digitando il conto, il programma inserisce automaticamente il codice IVA e completa le colonne con i
dati dell'IVA.

Per l'abbinamento dei codici:

Cliccare sulla vista Varia. La colonna Cod.IVA è visibile per default in questa vista.
Se si desidera visualizzare la colonna Cod.IVA nella vista Base, occorre cliccare sul menu Dati
> Disponi colonne.
Inserire nella colonna Cod.IVA, i codici IVA relativi ai conti. Se il codice IVA viene inserito tra
parentesi quadrate, come ad esempio [V81], l'IVA apparirà solo sulle fatture emesse e non sarà
scorporata nella contabilità.

Nota: se le aliquote IVA sono cambiate (vedere Nuove Aliquote IVA 2024 ), i valori inseriti nella
colonna Cod.IVA devono essere aggiornati manualmente.
Lo stesso vale per le registrazioni già inserite (tabella Registrazioni, colonna Cod.IVA), che devono
essere sostituite manualmente in ogni riga di registrazione (o utilizzando il comando Sostituisci per
modificarle tutte insieme).

https://www.banana.ch/apps/it/node/9727
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Arrotondamento IVA

Il sistema IVA svizzero, per il calcolo dell'IVA, prevede che questa venga calcolata al centesimo, senza
arrotondamenti.

Per coloro che hanno la necessità di avere un arrotondamento degli importi IVA per i centesimi, è
prevista la seguente procedura:

Nella tabella Registrazioni, registrare normalmente applicando il codice IVA appropriato
Nella riga successiva, in dare e in avere registrare il conto dei costi o dei ricavi, utilizzato nella
riga precedente
Nella colonna importo registrare i centesimi da arrotondare
Nella colonna Codice IVA, inserire un codice IVA con tipo importo 2 (importo IVA al 100%),
esempio M81-2
Quando i centesimi devono essere portati in diminuzione, inserire il codice con il segno meno
davanti "-M81-2".
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Impostare i conti IVA

Cosa sono i conti IVA?
I conti IVA sono delle schede contabili dove vengono registrati in automatico gli importi IVA, in base
alle impostazioni del codice IVA nella tabella Codici IVA.

Quando si usa un codice IVA, il programma calcola in automatico, in base ai valori della registrazione i
seguenti dati:

Imponibile e l'importo IVA.
Importo dell'imponibile sul conto Dare.
Importo dell'imponibile sul conto Avere.
Importo IVA da registrare sul conto IVA.

In basso nella finestra informativa, spostando il mouse sulla registrazione, sono visibili quali importi
sono registrati sui diversi conti.

Conto IVA generale (automatico)
Se il conto IVA viene impostato come predefinito nel menu File > Proprietà file > IVA, questo viene
usato tutte le volte che vi è una registrazione con un codice IVA. In questo caso nella tabella Codici
IVA non devono essere impostati i conti IVA per i vari Codici IVA.

Conti IVA Recuperabile e Dovuta
Nella Tabella Codici IVA, colonna Conto IVA, a secondo del codice IVA (attivo o passivo) si può
indicare il conto IVA recuperabile o il conto IVA dovuta. In questo caso, se nella tabella Codici IVA
vengono impostati questi conti specifici, nelle Proprietà file, sezione IVA non dev'essere impostato il
conto IVA predefinito (conto IVA generale - automatico).

Usare un unico conto IVA o diversi conti IVA?
Nella contabilità si deve separare la parte attiva da quella passiva. Se l'IVA recuperabile è
compensata con quella dovuta, nel bilancio deve figurare unicamente l'importo IVA effettivamente
dovuto.
Da un punto di vista contabile, nella maggior parte dei casi, non è indispensabile, anzi è meglio avere
un solo conto IVA.
Ai fini della reportistica è utile però avere le diverse tipologie di operazioni IVA separate. Nei
programmi che non usano dei codici IVA è necessario separare ogni operazione su dei conti separati.
Con Banana Contabilità, grazie ai codici IVA e al Riassunto IVA, è possibile ottenere dei dettagli molto
più significativi  pur usando anche un solo conto IVA:

Movimenti e totali (IVA imponibile, importo IVA, IVA contabilizzata) per singolo codice IVA.
Movimenti e totali per percentuale IVA.
Movimenti e totali per conto IVA.
Movimenti e totali per importo dovuto e recuperabile.

Ai fini del controllo delle operazioni IVA non è necessario usare più conti IVA separati.
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Banana Contabilità lascia la scelta di usare il conto generale, impostato nelle Proprietà file, o diversi
conti IVA, impostati nella tabella Codici IVA.

Vantaggi dell'uso di un singolo conto IVA

Dopo diversi anni abbiamo visto che l'uso di un conto IVA unico risulta molto più intuitivo e, per i piani
dei conti svizzeri si è perciò scelto di usare un singolo conto IVA (2201, IVA rendiconto), ovviamente
lasciando la possibilità a ciascuno di modificare le impostazioni.

Bilancio e conto economico molto più semplice da leggere (non ci sono tanti conti IVA).
Possibilità di avere conti (per esempio dei ricavi) nei quali registrare operazioni con diverse
aliquote IVA.
Si sa immediatamente il dovuto IVA senza dover sommare assieme diversi conti.
Visione immediata di tutte le operazioni IVA.
Nella scheda conto IVA, sono indicate tutte le operazioni IVA in Dare e in Avere.

Vantaggi dell'uso di più conti IVA

Se si usano dei codici IVA, la registrazione su uno specifico conto IVA è una ripetizione di
un'informazione che si ha già con il codice IVA e con il relativo riassunto dettagliato.

In nazioni come la Germania si usa avere un conto IVA diverso per ogni genere di operazione, in modo
tale che la dichiarazione dell'IVA può essere fatta usando i saldi delle singole schede conto IVA.

In questi casi, per compatibilità con questo sistema, si rileva utile avere dei conti IVA diversi per ogni
codice IVA.

Chiusura conti IVA a fine periodo
Alla fine del periodo di calcolo dell'IVA, è utile chiudere i conti IVA di debito e di credito e spostare il
saldo su unico conto. Questo permette:

Definire contabilmente quanto è il dovuto esatto da versare o recuperare.
Ad ogni nuovo periodo, il conto "2201, IVA rendiconto" ricomincia da zero, facilitando il controllo
su eventuali differenze ed errori.

Per la chiusura periodica del conto "2201, IVA rendiconto", consultare la pagina Chiusura periodica e
pagamento IVA.
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Registrazioni con IVA

In Banana Contabilità, nei piani contabili predisposti per la Svizzera, sono già predisposti i conti IVA e
le aliquote IVA attualmente in vigore. In particolare, il conto 2201 IVA rendiconto (conto IVA
scomposizione in automatico) è impostato sia nel piano contabile sia nelle Proprietà file (dati base) >
Sezione IVA. In questo caso nella Tabella codici IVA non occorre inserire alcun conto IVA.

Se non vengono utilizzati i piani contabili già predisposti in Banana, è necessario accertarsi che nel
proprio piano contabile siano presenti i conti IVA. Consigliamo di utilizzare il conto 2201 IVA
rendiconto (conto IVA scomposizione in automatico) inserendolo nelle Proprietà file (dati base) >
Sezione IVA.

Nella tabella Codici IVA sono presenti dei codici per le vendite, gli acquisti e i servizi. Al momento
della registrazione occorre utilizzare il codice IVA appropriato.

Il programma scompone automaticamente gli importi relativi all'IVA e li contabilizza nel conto IVA
rendiconto o nel conto IVA appropriato, indicato dall'utente.

Se il codice IVA viene inserito tra parentesi quadrate, come ad esempio [V81], l'IVA apparirà solo sulle
fatture emesse e non sarà scorporata nella contabilità.

 

Le colonne IVA della tabella Registrazioni (Vista completo)
Per la spiegazione delle colonne principali della tabella Registrazioni, consultare la pagina Colonne e
Viste.

Nella contabilità in partita doppia con IVA o nella contabilità entrate e uscite sono presenti le seguenti
colonne IVA:

Cod.IVA: per ogni registrazione soggetta a IVA si inserisce il codice IVA presente nella tabella
Codici IVA. Nelle operazioni di Reverse Charge, possono essere usati due codici IVA separati dal
simbolo ":".
%IVA: il programma riprende automaticamente dalla tabella Codici IVA, l'aliquota relativa al
codice immesso. Se l'importo è preceduto dal segno "+/-" si tratta di un'operazione di Reverse
Charge.
IVAExtraInfo: un codice relativo a informazioni supplementari IVA, per l'uso in casi molto
particolari.
Si può mettere una sigla per identificare determinate casistiche IVA.
Il programma propone delle scelte corrispondenti ai codici IVA che iniziano con due punti ":" .
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%Eff.: il programma immette automaticamente la percentuale riferita all'importo netto
(importo imponibile). È diversa dalla percentuale applicata quando quest'ultima viene calcolata
sull'importo lordo (aliquota saldo).
Imponibile: una volta inserito il codice IVA, il programma indica automaticamente l'importo
imponibile (senza IVA).
Importo IVA: viene indicato automaticamente dal programma l'importo IVA.
Cto.IVA: viene indicato in automatico il conto sul quale viene registrata l'IVA (per la Svizzera
normalmente il conto 2201 IVA, rendiconto), precedentemente inserito nelle Proprietà File (Dati
base), sezione IVA (menu File).
Tipo importo:
È un codice che indica come viene considerato l'importo della registrazione.

0 (o cella vuota), l'importo della registrazione è IVA inclusa.
1 = IVA esclusa, l'importo della registrazione è IVA esclusa.
2 = importo IVA, l'importo della registrazione è importo IVA al 100 %.
Tipo Importo non modificabile: Modalità predefinita.

La colonna è protetta.
Il programma usa il valore associato della tabella Codici IVA.
Quando si modifica il valore nella tabella codici IVA e si ricalcola tutto, il programma
riprende il nuovo valore associato a questo codice IVA.

Tipo Importo modificabile: questa opzione si attiva con  il comando Aggiungi nuove
funzionalità. L'attivazione dell'opzione non può essere annullata.

Quando si modifica il codice IVA, il programma riprende il tipo importo associato a
questo codice. 
Il valore può essere modificato manualmente.
Se si ricalcola la contabilità, viene mantenuto il valore indicato nella tabella
Registrazioni.

%Non.Ded.: la percentuale di non deducibilità.
Il programma riprende la %Non.Ded. associata ad un codice presente nella tabella Codici
IVA.
Si può modificare il valore anche manualmente.

IVA Contab.: è l'importo IVA registrato nel conto IVA.
Viene calcolato dal programma in base all'importo della registrazione, il tipo di importo e la
percentuale non deducibile.
Partita IVA: Il codice o numero IVA del cliente o del fornitore.
Quando viene inserita una registrazione con IVA è possibile inserire la partita IVA della
controparte. Se nella tabella Conti, vista Indirizzi, per i conti dei clienti e dei fornitori viene
inserita la partita IVA, questa viene ripresa in automatico nella tabella Registrazioni, colonna
Partita IVA.
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Registrazioni con IVA

Prima di registrare le operazioni soggette a IVA occorre tenere presente tutte le informazioni indicate
nelle pagina Registrazioni.

Per registrare un movimento con IVA è molto semplice:

Inserire la data, il numero di documento e il numero di fattura nelle rispettive colonne
Inserire la descrizione, il conto Dare e il conto Avere
Inserire l'importo lordo (compreso IVA)
Inserire il codice IVA previsto per il tipo di registrazione (acquisti, vendite, investimenti..) e
presente nella tabella Codici IVA.

 

Come correggere le registrazioni con IVA
In caso di errore in una registrazione con IVA, è possibile correggere direttamente sulla riga della
registrazione, a condizione che non sia stata inoltrata alcuna dichiarazione IVA o non sia stato
eseguito alcun blocco della contabilità.

Se invece, la contabilità è stata bloccata, oppure è stata inoltrata la dichiarazione IVA, non è possibile
cancellare la registrazione sbagliata, ma si devono eseguire delle registrazioni di storno e
successivamente quelle di rettifica.

Per stornare le operazioni con IVA, occorre:

Registrare su una nuova riga, invertendo in Dare e in Avere i conti utilizzati nella registrazione
sbagliata.
Registrare lo stesso importo.
Inserire come codice IVA, lo stesso codice utilizzato, ma con il segno meno davanti (es. -V81)
Registrare la registrazione con i conti, l'importo e il codice IVA corretti

A dipendenza dell'entità dell'errore, occorre informarsi presso l'Ufficio IVA competente, che
generalmente consiglia di scaricare un formulario apposito per rettificare l'IVA del periodo precedente
già inoltrato.

Come registrare solo l'importo IVA
Ci sono casi in cui è necessario registrare solo l'importo IVA, come per esempio quando si riceve
dall'assicurazione auto un indennizzo.
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In questi casi, si registra come segue:

Inserire la data, il numero di documento e la descrizione.
Nella colonna Avere inserire il conto con il quale viene pagato l'importo IVA (il conto Dare
rimane vuoto).
Nella colonna Importo inserire l'importo IVA da pagare.
Nella colonna del codice IVA inserire il codice IVA I81-2 (codice IVA relativo all'importo IVA
100%).
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Registrazione con diverse aliquote IVA

Ci possono essere dei casi in cui l'importo complessivo è composto da più importi imponibili con
aliquote IVA diverse. In questo caso si  registra su più righe.

Per la registrazione occorre:

Suddividere l'importo complessivo nei vari importi, ognuno dei quali è soggetto ad una aliquota
IVA specifica.
Su ogni riga registrare l'importo (importo con IVA) e inserire il codice IVA con l'aliquota
specifica.
Terminata la registrazione controllare che la somma dei singoli importi lordi e gli importi IVA
siano corrispondenti al totale della fattura.

Esempio

IVA ESENTE

Quando nella fattura l'importo totale soggetto a IVA è composto da una parte imponibile e da una
parte esente IVA, bisogna registrare su più righe come nel caso precedente, applicando il codice IVA
esente, presente nella tabella Codici IVA.
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Storni / Nota di credito

Quando ci sono delle operazioni di storno per delle note di credito o di debito, o semplicemente per
rettificare delle registrazioni già registrate in precedenza e i cui importi sono soggetti a IVA, nella
registrazione di storno, bisogna stornare anche l'IVA.

Per la registrazione:

Invertire in Dare e in Avere i conti che sono stati utilizzati nella registrazione precedente, alla
quale si riferisce la nota di credito.

Per stornare l'IVA ci sono due possibilità:

Far precedere il segno meno davanti al codice IVA (es. -V81).
Utilizzare uno dei codici che fanno riferimento a degli sconti, impostati già nella tabella Codici
IVA.

Con queste procedure l'importo IVA viene rettificato. 

Esempio di una nota di credito su vendite

Quando si vende merce e il cliente riscontra un difetto, normalmente si emette una nota di credito a
suo favore. La nota di credito comporta una diminuzione di ricavo e di conseguenza un recupero IVA.

Registriamo una vendita per un importo di CHF 12'000.-, IVA inclusa del 8.1%. Per un difetto della
merce venduta, concediamo al cliente una nota di credito per un importo di CHF 200.-

Nella registrazione della nota di credito emessa al cliente:

Sono stati invertiti i conti della vendita, alla quale la nota di credito si riferisce
Per il recupero IVA sulla nota di credito si registra il codice IVA delle vendite, preceduto dal
segno meno.
 

Esempio di una nota di credito su acquisti

Nel caso in cui riceviamo una nota di credito da un fornitore, la procedura per la registrazione è
analoga:

Si invertono i conti utilizzati per l'acquisto.
Si inserisce lo stesso codice IVA utilizzato per l'acquisto, preceduto dal segno meno.
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Registriamo una fattura di acquisto merce per CHF 3'000.-, IVA inclusa del 8.1%. Per un difetto della
merce acquistata, il fornitore ci concede uno sconto di CHF 300.- emettendo relativa nota di credito.

Nella registrazione della nota di credito ricevuta dal fornitore:

Sono stati invertiti i conti dell'acquisto, al quale la nota di credito si riferisce.
Per il recupero IVA sulla nota di credito si registra il codice IVA  degli acquisti, preceduto dal
segno meno.
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Rendiconto periodico e pagamento IVA

Azzeramento del conto 2201, IVA Rendiconto a fine
trimestre
A fine periodo, il saldo del conto 2201, IVA Rendiconto (scomposizione in automatico) deve essere
azzerato, stornando l'importo nel conto IVA dovuta (o Erario conto IVA).

Questa operazione comporta:

Azzeramento del saldo conto 2201, IVA Rendiconto (scomposizione in automatico).
Riversamento saldo IVA nel conto IVA dovuta (O Erario conto IVA).

Se risulta un debito IVA, il saldo IVA viene registrato in Avere del conto IVA dovuta; in
Dare del conto IVA scomposizione in automatico il saldo si azzera.
Se risulta un credito IVA, il saldo IVA viene registrato in Dare del conto IVA dovuta; in
Avere del conto IVA scomposizione in automatico il saldo si azzera.

 

Registrazione azzeramento conto 2201, IVA Rendiconto a
fine trimestre

Pagamento saldo conto IVA dovuta
Quando l'importo IVA viene pagato all'AFC, il saldo del conto IVA dovuta si azzera.

Per la registrazione:
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Inserire la data, il numero di documento e la descrizione nelle rispettive colonne.
Nella colonna Dare, inserire il conto IVA Dovuta.
Nella colonna Avere, inserire il conto della liquidità.
Nella colonna Importo, inserire l'importo IVA dovuta pagato.

Con questo sistema è possibile avere un controllo del saldo di ogni trimestre e in caso di errore è
possibile individuare in quale periodo il saldo non è più corrispondente.

Registrazione del pagamento IVA dovuta

Nota

La procedura spiegata è relativa al pagamento dell'IVA registrata con il metodo effettivo e vale anche
per la modalità dell'IVA forfettaria con scorporo.
Per coloro che hanno registrato l'IVA con il metodo dell'aliquota saldo senza scorporo IVA possono
trovare delle informazioni specifiche alla pagina web Assestamento contabile e pagamento IVA .

Scheda del conto 2200 IVA dovuta dopo la registrazione di pagamento

Come registrare un credito IVA (Svizzera)
Se a fine periodo, calcolando il formulario IVA, l'IVA precedente è maggiore dell'IVA dovuta, il conto
IVA rendiconto presenta un saldo in dare.

Per azzerare il conto IVA rendiconto occorre pertanto registrare:

in dare il conto IVA dovuta
in avere il conto IVA scomposizione in automatico

Generalmente, in Svizzera il credito IVA viene rimborsato alla ditta, senza la necessità di riportare il
credito IVA nel periodo successivo.

Nel momento in cui l'IVA viene rimborsata, si registra:

in dare il conto della liquidità
in avere il conto IVA dovuta (il saldo va a zero)

https://www.banana.ch/it/node/10876#5
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Registrazione IVA con il Reverse Charge

L'IVA con il Reverse Charge
Normalmente l'IVA è posta a carico del venditore della merce. Il Reverse Charge, o inversione
contabile, è il termine che si usa per indicare che l'imposta sull'IVA è messa a carico dell'acquirente.
Il Reverse Charge si usa principalmente quando si acquistano merci o servizi all'estero, che non sono
state tassate in dogana. In questi casi, il venditore che esporta viene esonerato dall'applicazione
dell'IVA, mentre l'acquirente che importa deve assoggettarla ed eventualmente dedurla. Oltre agli
acquisti all'estero ci sono altri casi di assoggettamento al Reverse Charge, ogni Nazione, nella propria
legislazione fiscale, contempla casi diversi.
Quando si registra l'IVA con il Reverse Charge:

Si deve assoggettare l'operazione in modo che questa risulti con IVA dovuta.
Se l'IVA è anche deducibile si deve registrare anche la parte dell'IVA deducibile.

Prerequisiti del software
La possibilità di registrare l'operazione soggetta al Reverse Charge, assoggettamento e
recupero IVA, su di un'unica riga, è disponibile nella versione Banana Contabilità Plus .

Reverse Charge solo con assoggettamento
Se si deve assoggettare l'operazione di acquisto merce o servizi, ma non si ha la possibilità di dedurre
l'IVA:

Indicare nella registrazione il codice IVA dovuta, adeguato al caso.

L'assoggettamento con il Reverse Charge senza deduzione si usa generalmente nel caso in cui si è al
beneficio di un regime forfettario oppure quando il tipo di spesa non è considerato deducibile.

Reverse Charge con assoggettamento e deduzione IVA
Se l'importo IVA dovuta è uguale a quello dell'IVA deducibile, si può registrare il Reverse Charge su
un'unica riga di registrazione, inserendo contemporaneamente sia il codice per l'IVA dovuta sia quello
per l'IVA recuperabile.

Si usano i codici IVA già predefiniti e non è necessario modificare la tabella IVA.
Nella riga del movimento con IVA Reverse Charge, inserire nella colonna Codice IVA, i due codici
IVA predefiniti e separati dal segno ":" due punti.
I due codici IVA devono essere complementari, affinché il risultato vada a compensarsi.

Uno dei due codici deve essere impostato con IVA dovuta e l'altro con IVA recuperabile.
L'aliquota IVA e anche tutti gli altri parametri di calcolo devono essere uguali.
Se i Codici IVA non hanno gli stessi parametri, viene visualizzato un errore.

La sequenza dei codici non è rilevante, si può mettere prima l'uno o l'altro.
Se si tratta di un'operazione di storno, il primo codice IVA deve essere preceduto dal segno "-"
meno.
Lo storno si usa per annullare un'operazione registrata in modo non corretto. In questo caso si
registra mantenendo gli stessi elementi,  ma invertendo la registrazione normale:

http://www.banana.ch/it/download
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Il codice IVA dovuta viene registrato come recuperabile.
Il codice IVA recuperabile viene registrato come dovuta.

Nelle colonne IVA, gli importi sono preceduti dal segno "+/-", ciò significa che gli importi vanno
a compensarsi ai fini IVA.
Nella scheda conto e nel riassunto IVA ci sono dei movimenti separati per il movimento dare e il
movimento avere.

Esempi di registrazione con Reverse Charge

Qui di seguito sono indicati alcuni esempi di operazione Reverse Charge con assoggettamento IVA
dovuta e recuperabile:

Operazioni di assoggettamento e deduzione IVA.
Operazioni di storno (cancellation) con i codici IVA preceduti dal segno "-".

Nota: gli esempi che figurano nell'immagine sottostante sono puramente indicativi. Questi codici
devono essere adattati in base alle aliquote della propria nazione. Ulteriori informazioni:  

Applicazione del Reverse Charge in Svizzera
Applicazione del Reverse Charge in Italia .  

Reverse Charge con conto in divisa estera
Quando la fattura si presenta in una divisa diversa dalla divisa della contabilità, la registrazione di
deve eseguire su due righe:

sulla prima riga si registra la fattura in  moneta estera 
sulla seconda riga si registra l'assoggettamento e la deduzione dell'IVA riprendendo l'importo
calcolato nella divisa della contabilità.

Reverse Charge con aliquote differenti
Quando nell'assoggettamento dell'IVA dovuta e recuperabile sono previste aliquote diverse oppure
l'IVA è parzialmente deducibile, la registrazione si deve eseguire su più righe:

Su una riga si inserisce il Codice IVA dovuta (assoggettamento).
Su un'altra riga si inserisce il Codice IVA recuperabile.

Reverse charge con il metodo aliquota saldo/forfetaria (CH)
In questo caso non è possibile registrare l'IVA in deduzione, poiché non è possibile recuperare l'IVA
sugli acquisti. Va comunque registrato l'assoggettamento dell'IVA.

https://www.banana.ch/it/node/10882
https://www.banana.ch/it/node/10848
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Riassunto IVA

Il Riassunto IVA è un giornale che riporta i movimenti e i saldi IVA, in base ai parametri impostati e
alle opzioni selezionate. 
Viene elaborato in automatico dal programma e può essere salvato e archiviato in Pdf, rivelandosi
molto utile in occasione di verifiche IVA, revisioni e controlli fiscali, anche a distanza di anni. 

Per gli utenti che non desiderano avere delle automazioni per la gestione e la trasmissione online dei
dati IVA, il Riassunto IVA diventa fondamentale per poter calcolare gli importi IVA da inserire
manualmente nel Rendiconto svizzero cartaceo o sul portale svizzero dell'AFC.

Se si desidera avere un'automazione completa del Rendiconto IVA svizzero e della
trasmissione elettronica dei dati IVA, accelerando e semplificando di molto il lavoro, consigliamo
di utilizzare le nuove estensioni IVA 2024 , disponibili nel piano Advanced di Banana Contabilità Plus

.

Il Riassunto IVA si ottiene cliccando dal menu Report > Riassunto IVA

Le seguenti opzioni se attivate permettono di includere nel Riassunto IVA i seguenti dati:

Includi movimenti

Sono inclusi tutti i movimenti con IVA.

Includi totali per conti

Sono inclusi i totali delle operazioni con IVA, raggruppati per singolo conto.

https://www.banana.ch/apps/it/node/9715
https://www.banana.ch/apps/it/node/9715
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Includi totali per codici

Sono inclusi i totali delle operazioni con IVA, raggruppati per singolo codice IVA.

Includi totali per percentuali

Sono inclusi i totali delle operazioni con IVA per ogni singola aliquota.

Includi codici non utilizzati

Sono inclusi anche i codice non utilizzati presenti nella tabella Codici IVA.

Usa il proprio raggruppamento (gruppo e Gr)

Le operazioni con IVA vengono raggruppate in base al raggruppamento della tabella Codici IVA.

Ordina registrazione per

Questa funzione permette di ordinare le registrazioni in base all’opzione prescelta (data, doc.,
descrizione, ecc....).

Report Parziale

Specificando un codice o un gruppo e vistando le apposite caselle, si ottiene il totale delle operazioni
con IVA:

solo codice indicato (tramite selezione dalla lista)
solo gruppo indicato (tramite seleziona dalla lista)

Altre sezioni
Le informazioni per le altre sezioni sono disponibili alle seguenti pagine web:

Periodo
Personalizzazione

Riassunto IVA / movimenti con i totali per codici

Il totale presente nell'ultima riga del Riassunto IVA deve corrispondere al totale del conto IVA
scomposizione in automatico, della colonna saldo, a condizione che entrambi si riferiscano allo stesso
periodo.

I dati del riassunto IVA possono essere anche ripresi e rielaborati da altri programmi (p.es. Excel,
XSLT) ed essere presentati in formati, simili ai moduli del fisco.

Per la Svizzera è possibile ottenere in automatico un documento simile al formulario da inviare
all'Ufficio IVA che riporta per ogni cifra l'importo da inserire.

https://www.banana.ch/apps/it/node/9715
https://www.banana.ch/apps/it/node/9715
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Centri di costo e di profitto

I Centri di costo e di profitto di Banana Contabilità Plus sono utilizzati per analizzare e
monitorare le performance di diverse aree o divisioni di un'azienda: unità organizzative, reparti e
filiali, anche senza avere una correlazione fra di loro. Consentono di catalogare le registrazioni
secondo criteri diversi rispetto ai conti normali. L'obiettivo principale è quello di minimizzare i costi
operativi, e ottimizzare i ricavi, garantendo al contempo la qualità e l'efficienza delle prestazioni. In
Banana Contabilità Plus la funzione dei centri di costo e di profitto è disponibile in tutti gli applicativi.

I centri di costo e di profitto sono utilizzati solo a scopi di informazione interna per monitorare e
controllare i costi operativi, pertanto non fanno parte del Bilancio.

Se desideri avere un Bilancio suddiviso per progetti, settori o filiali, ti consigliamo di utilizzare i
Segmenti.

▶ Video: Centri di costo e di profitto

 Registrare i movimenti sui centri di costo/profitto
In Banana Contabilità i centri di costo/profitto si registrano nella tabella Registrazioni, indicando nelle
apposite colonne i conti relativi ai centri di costo/profitto, impostati nella tabella Conti. I centri di costo
sono attribuiti alla riga di registrazione e possono essere usati contemporaneamente ai segmenti.

Elenchiamo gli usi più frequenti:

Catalogare delle spese specifiche
Manifestazioni ed eventi
Clienti, fornitori, Soci
Dettaglio supplementare per certe spese (p.es. spese accessorie)

Le colonne per inserire i dati si trovano nella vista Centri di costo. Se non sono visibili si possono
visualizzare, in qualsiasi vista, dal menu Dati > Disponi colonne. Sono disponibili 3 colonne diverse: 
CC1, CC2, CC3, ognuna delle quali è indipendente l'una dall'altra.

Per la registrazione procedere inserendo:

La data, la descrizione e gli altri elementi usuali
Il conto Dare e Avere
L'importo ed eventuale codice IVA

https://www.banana.ch/it/node/11496
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Nella colonna appropriata (CC1, CC2, CC3) inserire il conto del centro di costo/profitto senza la
punteggiatura che lo precede.
Per registrare sul centro di costo/profitto in avere si deve inserire il centro di costo preceduto
dal segno meno.

Nella contabilità Entrate/Uscite e nel Cash manager si può impostare l'opzione Registra (+/-) i centri di
costo come la categoria  affinché i centri di costo seguano il segno della categoria.

Se un importo complessivo deve essere suddiviso su più centri di costo/profitto del medesimo livello,
si devono creare più righe di registrazione; ad ogni riga si indica l'importo che deve essere imputato
al centro di costo/profitto e il relativo conto.

Conti dei centri di costo/profitto
I conti dei centri di costo si impostano nella tabella Conti, ad eccezione del Cash Manager che prevede
l'impostazione unicamente nella tabella Categorie.

I Centri di Costo e profitto (CC) sono dei conti preceduti dal punto ".", virgola",", punto e
virgola";" .
Ci sono 3 livelli di centri di costo:

CC1 preceduti dal punto "."
CC2 preceduto dalla virgola ","
CC3 preceduto dal punto e virgola ";"

Ogni livello è indipendente dall'altro.
Per ogni livello ci può essere un numero illimitato di conti centri di costo/profitto.
Si può usare un livello superiore senza usarne uno inferiore. 
Possono essere numerici o alfabetici.
Possono avere un proprio raggruppamento distinto da quello dei conti normali.    
Per lo stesso livello di centro di costo si possono creare dei sottogruppi.    
Attenzione a non abbinare gruppi di centri di costo con altri gruppi di livello diverso o di conti
normali o di segmenti.
Ogni centro di costo ha una propria scheda conto, completa di movimenti e saldo.
La registrazione sul centro di costo è indipendente dal conto registrato in dare o avere.    
Si può registrare su dei centri di costo anche se non vi è alcun conto nella colonna dare e avere
(come nel caso del partitario clienti/fornitori con IVA sull'incassato).

Impostare i conti centri di costo/profitto
Per impostare i centri di costo/profitto nella tabella Conti procedere come segue:

http://www.banana.ch/doc/it/node/2569#CC_segno_categoria
http://www.banana.ch/doc/it/node/2569#CC_segno_categoria
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Creare una sezione apposita per i centri di costo alla fine del piano contabile:
Inserire una Sezione con l'asterisco "*" per il cambio di sezione e nella colonna
Descrizione inserire il titolo centri di costo e profitto.
Nella riga successiva, nella colonna Sezione, inserire 03 per i centri di costo e 04 per i
centri di profitto e la relativa descrizione.

Aggiungere delle righe per i centri di costo:
Nella colonna Gruppo, inserire il gruppo di appartenenza.
Nella colonna Conto inserire i conti dei centri di costo/profitto, preceduti da un punto per
quelli da registrare nella colonna CC1 (nella tabella registrazioni), da una virgola per
quelli da registrare nella colonna CC2 e dal punto e virgola per quelli da registrare nella
colonna CC3.
Nella colonna Somma in indicare il gruppo nel quale sommare gli importi.
Nella multi-moneta si deve specificare anche la moneta del conto.

Aggiungere i gruppi dei centri di costo.
In un gruppo totalizzare unicamente un livello specifico.
Come per i conti normali si possono creare più livelli.

Importo IVA con i centri di costo
Nelle Proprietà file (dati base), sezione IVA si possono impostare gli importi dei centri di costo con le
seguenti opzioni:

Usa l'importo della registrazione - L'importo del centro di costo sarà registrato come l'importo
della registrazione.
Usa l'importo IVA esclusa - L'importo del centro di costo è registrato al netto dell'IVA.
Usa l'importo IVA inclusa - L'importo del centro di costo è registrato al lordo dell'IVA.

Scheda conto del Centro di costo
Per ogni centro di costo puoi ottenere ha la scheda conto con i relativi movimenti contabili e il saldo.

A differenza di tutti gli altri conti, il conto centro di costo non ha una contropartita. Se si desidera
visualizzare la contropartita consigliamo di usare i Segmenti.

Per visualizzare tutte le schede conto dei centri di costo, cliccare sul menu Report > Schede conto >
Centri di costo  (opzione Filtro).

Differenze tra Centri di costo/profitto e Segmenti
I Centri di costo e di profitto sono delle un'unità dove vengono attribuiti e accumulati dei costi o dei
profitti con lo scopo di monitorare una specifica area aziendale (dipartimenti, divisioni, progetti, unità
operative o anche macchinari specifici) per migliorare l'efficienza e la gestione delle spese e hanno
una finalità interna di controllo.

I Segmenti, invece vengono attribuiti ad una parte dell'attività aziendale per scopi di reporting
esterno e analisi strategiche. Vengono utilizzati per analizzare i profitti e altre metriche finanziarie
in diverse aree aziendali, mercati, clienti e altre dimensioni aziendali per valutarne la performance
economica.

Obiettivo: i centri di costo si concentrano sulla gestione e controllo dei costi, mentre i
segmenti si concentrano sulla valutazione delle performance finanziarie complessive.

http://www.banana.ch/doc/it/node/2726
http://www.banana.ch/doc/it/node/2726
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Focus: i centri di costo sono generalmente utilizzati per analisi interne dettagliate dei costi,
mentre i segmenti sono spesso utilizzati per reportistica esterna e decisioni strategiche.
Struttura: i centri di costo possono essere qualsiasi unità operativa interna che sostiene costi,
mentre i segmenti sono definiti in base a criteri strategici come linee di prodotto o mercati.
Contabilità: i centri di costo sono principalmente rilevanti nella contabilità analitica, mentre i
segmenti sono più rilevanti nella contabilità gestionale e finanziaria.

Differenze nelle impostazioni e nelle registrazioni

In Banana Contabilità le impostazioni e le registrazioni dei centri di costo/profitto e dei segmenti sono
diverse:

Tabella Conti

Si possono impostare fino a 3 centri di costo/profitto CC1, CC2, CC3 e per ognuno si può avere
un numero illimitato di centri di costo/profitto. Vengono inseriti nella colonna Conto della tabella
Conti con la virgola, il punto e il punto e virgola (rispettivamente  CC1, CC2, CC3) davanti al
numero di conto (o sigla del conto).
I Segmenti possono essere impostati fino a 10 livelli ed ogni livello può avere un numero
illimitato di segmenti. Vengono inseriti nella colonna Conto della tabella Conti, con doppio punto
(:, ::, :::, ecc..) davanti la sigla o il numero che definisce il segmento.

Tabella Registrazioni

I Centri di costo/profitto si registrano unicamente nelle colonne CC1, CC2, CC3 della vista Centri
di costo. Si registra il conto senza la punteggiatura davanti.
I Segmenti si registrano nelle colonne Dare e Avere, dopo il conto principale (es. 4000:P1).
Questo significa che l'importo registrato nella colonna Importo viene assegnato al conto 4000 e
anche al segmento P1). In alternativa possono essere registrati nella colonna specifica
Segmento della tabella Conti. 

Report

Con i Centri di costo/profitto non è possibile avere un Bilancio e un report contabile.
Con i Centri di costo/profitto si può ottenere la scheda conto per ogni centro di costo e di
 profitto. 
Nella tabella Conti è possibile visualizzare la totalizzazione dei diversi gruppi di centri di costo e
di profitto.
Con i Segmenti è possibile avere il bilancio con la suddivisione dei livelli, indicante l'utile o la
perdita per segmento.
Nella tabella Conti è visibile anche il totale dei diversi gruppi di segmenti e si possono
visualizzare le schede conto dei diversi Segmenti. Sono possibili anche dei Report contabili.
Con i Segmenti si può ottenere anche il Report multilivello che combina conti e segmenti, ma si
devono usare delle estensioni specifiche. 

Approfondimenti
Gestire i soci di un'associazione
Clienti e fornitori con IVA sull'incassato     
 

https://www.banana.ch/area/it/node/10506
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Segmenti

I Segmenti sono una funzionalità di Banana Contabilità Plus disponibile in tutti gli
applicativi.

I Segmenti sono utilizzati per avere una separazione sistematica dei costi e dei ricavi per unità,
dipartimento o succursale. Usando i segmenti si può avere il Conto economico suddiviso per unità,
dipartimento o succursale, senza creare dei conti specifici per ciascuna unità.
Per esempio, un museo può usare i segmenti per sapere a quanto ammontano i ricavi, i costi del
personale, l'allestimento di ogni singola mostra.

Nelle registrazioni, i segmenti seguono il conto, a differenza dei Centri di costo che invece sono
specifici per registrazione e si usano per delle categorizzazioni meno strutturate (per esempio tutte le
spese di una manifestazione o gli acquisti per una determinata finalità). 

Si possono usare contemporaneamente sia i centri di costo che segmenti.

▶ Video: Segmenti

Caratteristica dei Segmenti
I segmenti sono dei conti preceduti da due punti ":".
Per la denominazione dei conti, si possono usare sia numeri che lettere.
Ci possono essere fino a 10 livelli di segmenti.
Il livello si determina con il numero di due punti che precede la sigla.

:LU segmento di livello 1
::P1 segmento di livello 2
:::10 segmento di livello 3

Per ogni livello ci può essere un numero illimitato di segmenti.
I diversi livelli di segmento sono indipendenti uno dall'altro.
I segmenti non hanno BClasse e non hanno la sigla della moneta.
Il calcoli relativi ai segmenti sono nella divisa base.
Nelle registrazioni, il segmento segue il conto dare e avere.
Non ci possono essere registrazioni su segmenti senza un conto.
Si possono avere le schede conto delle registrazioni sui singoli segmenti.

Impostare i Segmenti
I segmenti devono essere impostati nella Tabella Conti, colonna conto, alla fine del piano contabile.

Inserire nella colonna Sezione un asterisco per definire la sezione relativa ai segmenti.
Nella colonna Descrizione digitare il titolo dei Segmenti.
Inserire la descrizione dei segmenti di primo livello e nella colonna Conto inserire:

I segmenti del primo livello, inserendo per ognuno un codice per l'identificazione,
preceduto da : (due punti).
I segmenti del secondo livello (ed eventualmente del terzo livello), come quelli del primo
livello, con la differenza che nella colonna Conto, i codici dei segmenti devono essere
preceduti da :: o da :::, a dipendenza del livello.

https://www.banana.ch/it/node/11508
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Segmento non assegnato
Se nelle registrazioni, si inserisce il conto dare o avere, senza indicare un segmento, il valore viene
registrato nel segmento "vuoto" o non assegnato.
Nel piano dei conti si può indicare una descrizione al segmento non assegnato, inserendo come conto
il testo ":{}".

Saldo e scheda conto segmento 

Il segmento è una suddivisione di quanto registrato su un conto. 

L'importo registrato per il segmento segue sempre quello del conto. 
Generalmente, il segmento viene usato per suddividere il bilancio o il conto economico. 
Menu Report > Report contabile o Report con Gruppi > Sezione Suddivisione, attivare l'opzione
Suddivisione per Segmento.
Il saldo del segmento che figura nella tabella conti è il totale dei movimenti sul segmento. 

Il saldo sarà a zero (vuoto), se nelle registrazioni lo stesso segmento viene usato sia per il
conto dare e per il conto avere, oppure se si inserisce il segmento nella colonna
Segmento. 
Il saldo sarà presente solo nel caso in cui venga usato il segmento esclusivamente con
conti di Conto Economico o di Bilancio. 

Nella scheda conto del segmento appaiono tutti i movimenti.
Se sulla stessa registrazione il segmento è usato sia con il conto dare e il conto avere,
oppure si inserisce il segmento nella colonna Segmento, il movimento apparirà due volte,
una in dare e una in avere.

Registrazioni
I segmenti si registrano nella Tabella Registrazioni, facendo seguire il conto principale dal conto del
segmento.

Quando si deve registrare un segmento appartenente a più livelli, occorre far seguire il conto
principale dal segmento di primo livello e continuare con quello del secondo livello.
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  Colonna Segmento
Questa colonna consente d'inserire i segmenti in maniera del tutto independente rispetto al conto.

La colonna Segmento è nascosta e se la si vuole usare deve essere resa visibile, tramite il
menu Dati > Disponi colonne.
I segmenti inseriti nella colonna Segmento sono applicati ai conti usati nella registrazione, nelle
colonne CtDare, CtAvere, Conto IVA, se per questi non è stato specificato un segmento.
Si può usare la colonna Segmento e inserire anche dei segmenti nelle colonne CtDare e
CtAvere.
Quando si usa la colonna segmento l'importo viene registrato sul segmento sia in dare che in
avere, motivo per cui il saldo del segmento nella tabella conti risulterà a zero.

Movimenti fra Segmenti
Generalmente, la suddivisione dei costi viene fatta per ogni singola registrazione contabile. Ci sono
però delle situazioni dove i costi è meglio registrarli in un conto e poi suddividerli per segmenti solo
alla fine dell'anno. È il caso per esempio dei costi amministrativi, che sono suddivisi in una
percentuale fra i diversi settori della ditta.
Si procede quindi in questo modo:

Durante l'anno si registrano le operazioni, indicando i conti nella colonna Dare e Avere, ma
lasciando vuoto il segmento, oppure, attribuendo tutto l'importo a un solo segmento.
Per esempio tutti i costi di cancelleria saranno registrati senza il segmento. 
Alla fine dell'anno, si inseriscono delle registrazioni per l'attribuzione della quota parte di ogni
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segmento ad un preciso conto dei costi o dei ricavi:
Nella registrazione, nelle colonna Dare e Avere si registra sempre lo stesso conto.
Si indicano i segmenti di provenienza (che potrà essere anche assente) e quello di
destinazione. 
Per esempio, per l'attribuzione dei costi di cancelleria ai diversi settori:

Ci devono essere tante registrazioni quanti sono i settori.
Per ogni riga, il conto avere non ha alcun segmento.
Il conto dare ha il segmento relativo al settore.
L'importo corrisponde alla quota parte dei costi di cancelleria da attribuire allo
specifico settore.

Si procede con queste registrazioni per assegnare a ogni settore la quota parte di costi
non ancora attribuiti.

Saldi d'apertura dei Segmenti
I segmenti che hanno un saldo di apertura devono essere inseriti preferibilmente come delle
registrazioni, affinché possano essere abbinati a un conto. Se nella colonna Apertura (tabella Conti)
si inserisce il saldo iniziale di un segmento, questo è attribuito al segmento "{} non assegnato ".

Per attribuire dei saldi di apertura ai singoli segmenti e al relativo conto si devono inserire delle
registrazioni di apertura (tabella Registrazioni).

Nella colonna DocTipo (Type) ci deve essere il valore 01.
La data deve essere uguale alla data d'inizio della contabilità.

Con la registrazione di apertura dei segmenti, l'importo viene eliminato dal segmento "vuoto" e
attribuito al segmento specifico.
Se il saldo da ripartire è negativo (avere), il conto senza segmento deve figurare nella colonna CtDare
e quello con il segmento nella colonna CtAvere.

Esempio di registrazione per apertura dei segmenti

Se per ipotesi, come importo di apertura del conto 1000 abbiamo un saldo di 100.00 (senza
segmento, quindi l'importo viene attribuito al segmento vuoto) e questo deve essere attribuito a due
segmenti (segmento 01 per 80.00 e segmento 02 per 20.00), dobbiamo procedere come segue:

Le registrazioni di apertura hanno la data d'inizio della contabilità e nella colonna DocType il
valore 01.
La prima registrazione di apertura del segmento ha nella colonna CtDare il conto 1000:Events e
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nella colonna CtAvere il conto 1000. L'importo è 80.00. 
La seconda registrazione di apertura ha nella colonna CtDare il conto 1000:Courses e nella
colonna CtAvere il conto 1000. L'importo è 20.00. 

Comando Crea nuovo anno

Il comando Crea nuovo Anno o Riprendi saldi d'apertura crea in automatico le registrazioni d'apertura
di tutti i livelli di segmenti.
Quando non si devono riportare i saldi di apertura di un livello di segmento, occorre cancellare le
rispettive registrazioni d'apertura che il programma ha creato in automatico.

Uso del segno "-" come separatore
Nelle registrazioni si può usare il segno "-" come separatore, invece del segno":".

Nelle proprietà file (dati base) attivare l'opzione Usa il segno meno (-) come separatore dei
segmenti.
Nelle registrazioni usare quindi il segno meno come separatore.
Se si usa il segno "-" come separatore del segmento, non si devono usare conti che contengono
dei trattini.

Report
I report per segmenti si possono ottenere per diversi documenti contabili:

Bilancio abbellito per gruppi
Report contabile
Scheda conto
Report multi-livello
Per ottenere dei report che combinano conti e segmenti (p.es. tutte le spese della succursale LU
del P1) si devono usare le funzionalità delle Estensioni Banana.
 

Report suddivisione per livello

Nel Bilancio abbellito per gruppi, nella sezione Suddivisione indicare il livello di segmento che si vuole
utilizzare. 
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Report riassuntivo

È un resoconto di tutti i segmenti impostati nella sezione Piano dei conti con un'eventuale
suddivisione per periodo o per segmento.

Report segmento non assegnato

Il segmento "vuoto" raggruppa tutti gli importi registrati senza specificare un segmento. È possibile
impostare il titolo di questo segmento indicandolo nella tabella conti. Selezionare inoltre l'opzione
Intestazione segmento: Descrizione nella sezione Suddivisione
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Differenze tra Segmenti e Centri di costo/profitto
I Segmenti vengono attribuiti ad una parte dell'attività aziendale per scopi di reporting esterno e
analisi strategiche. Vengono utilizzati per analizzare i profitti e altre metriche finanziarie in diverse
aree aziendali, mercati, clienti e altre dimensioni aziendali per valutarne la performance economica.

I centri di costo e di profitto sono delle un'unità dove vengono attribuiti e accumulati dei costi o dei
profitti con lo scopo di monitorare una specifica area aziendale (dipartimenti, divisioni, progetti, unità
operative o anche macchinari specifici) per migliorare l'efficienza e la gestione delle spese e hanno
una finalità interna di controllo.

Obiettivo:  i segmenti si concentrano sulla valutazione delle performance finanziarie
complessive, mentre i centri di costo si concentrano sulla gestione e controllo dei costi.
Focus: i segmenti sono spesso utilizzati per reportistica esterna e decisioni strategiche, mentre
i centri di costo sono generalmente utilizzati per analisi interne dettagliate dei costi.
Struttura: i segmenti sono definiti in base a criteri strategici come linee di prodotto o mercati,
mentre i centri di costo possono essere qualsiasi unità operativa interna che sostiene costi.
Contabilità: i segmenti sono più rilevanti nella contabilità gestionale e finanziaria, mentre i
centri di costo sono principalmente rilevanti nella contabilità analitica.

Differenze nelle impostazioni e nelle registrazioni

In Banana contabilità le impostazioni e le registrazioni dei centri di costo/profitto e dei segmenti sono
diverse:

Tabella Conti

I Segmenti possono essere impostati fino a 10 livelli ed ogni livello può avere un numero
illimitato di segmenti. Vengono inseriti nella colonna Conto della tabella Conti, con doppio punto
(:, ::, :::, ecc..) davanti la sigla o il numero che definisce il segmento.
Si possono impostare fino a 3 centri di costo/profitto CC1, CC2, CC3 e per ognuno si possono
avere un numero illimitato di centri di costo/profitto. Vengono inseriti nella colonna Conto della
tabella Conti con la virgola, il punto e il punto e virgola (rispettivamente  CC1, CC2, CC3)
davanti al numero di conto (o sigla del conto).

Tabella Registrazioni

I segmenti si registrano nelle colonne Dare e Avere, dopo il conto principale (es. 4000:P1).
Questo significa che l'importo registrato nella colonna Importo viene assegnato al conto 4000 e
anche al segmento P1). In alternativa possono essere registrati nella colonna specifica
Segmento della tabella Conti. 
I Centri di costo/profitto si registrano unicamente nelle colonne CC1, CC2, CC3 della vista Centri
di costo. Si registra il conto senza la punteggiatura davanti.

Report

Con i Segmenti è possibile avere il bilancio con la suddivisione dei livelli, indicante l'utile o la
perdita per segmento.
Nella tabella Conti è visibile anche il totale dei diversi gruppi di segmenti e si possono
visualizzare le schede conto dei diversi Segmenti. Sono possibili anche dei Report contabili.
Con i segmenti si può ottenere anche il Report multilivello che combina conti e segmenti, ma si
devono usare delle estensioni specifiche. Con i Centri di costo/profitto non è possibile avere un
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Bilancio e un report contabile.
Con i Centri di costo/profitto si può ottenere la scheda conto per ogni centro di costo e di
 profitto. 
Nella tabella Conti è possibile visualizzare la totalizzazione dei diversi gruppi di centri di costo e
di profitto.

Approfondimenti
Gestire dei progetti
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Come gestire progetti, settori e filiali

Con la funzione dei Segmenti è possibile gestire settori diversi di un'impresa o diversi progetti di
un'associazione e ottenere per ciascuno il bilancio e il conto economico completo, con la suddivisione
dei ricavi, dei costi e dell'utile o perdita.

I segmenti sono impostati nel piano dei conti. Quando si inserisce una registrazione, si indica anche il
segmento. I segmenti possono essere usati anche per gestire succursali, divisioni o ambiti di attività.
Un museo può usarli per avere rendiconti delle diverse mostre, un'agenzia di trasporto per avere i
rendiconti per ogni singolo veicolo.

Impostare i segmenti nel piano dei conti
È utile per un'impresa con diverse succursali, che organizza eventi e corsi e vuole rendiconti separati
per ogni campo di attività e succursale. 

Primo livello campo d'attività, conti preceduti da due punti ":".

Corsi
Eventi

Secondo livello le succursali, conti preceduti da un doppio due punti "::":

Roma
Milano
Altri

Generalmente è più comodo usare delle sigle anziché del nomi lunghi.

Guarda il video: Segmenti

Registrare su segmenti
I segmenti vengono inseriti nella tabella Registrazioni nelle colonne del Dare e Avere
successivamente ai numeri di conto.

https://www.banana.ch/it/node/11508
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I segmenti possono essere registrati, facendoli precedere dopo il conto, sia da due punti (:) sia
dal segno (-).
Se si desidera registrare i segmenti con il segno meno davanti al conto del segmento si deve
attivare l'opzione Usa il segno meno (-) come separatore dei segmenti, presente nel
menu File, comando Proprietà file (dati base) → Opzioni.  

Conto economico per segmento
Il rendiconto per segmento si ottiene dal menu:

Report → Bilancio abbellito con gruppi .
Nella sezione Piano dei conti e nelle Sezioni si sceglie la sezione Conto economico.

Attivare Suddivisione per Segmento
Selezionare il segmento del quale si desidera ottenere il bilancio (nell'esempio per progetto o
per filiale)

http://www.banana.ch/doc/it/node/3314
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Report per settore

In questo report appaiono i diversi settori. La colonna con l'* è quella dei valori non assegnati a
nessun segmento.

Report per Filiale

Nel report figurano i ricavi, i costi, e l'utile per le diverse succursali.
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Budget e Piani della liquidità

Tutti gli applicativi di Banana Contabilità Plus includono il potente e innovativo strumento di
Previsione finanziaria, basata sul metodo della partita doppia. Puoi avere facilmente bilanci
previsionali, piani finanziari, di liquidità, e di investimento.

Visione sul futuro
Le previsioni finanziarie, con il metodo della contabilità in partita doppia, ti permettono di avere una
visione completa sul futuro dell'impresa. Puoi immaginarti quale sarà la situazione prima che le
cose accadano, con la possibilità di prendere provvedimenti tempestivi. Utilizzando le
previsioni finanziarie dai un valore aggiunto alla tua gestione aziendale.

▶ Video: Contabilità e Budget Entrate/Uscite
▶ Video: Contabilità e Budget in partita doppia
▶ Video: Contabilità e Budget Multi-moneta

Previsioni finanziarie alla portata di tutti
Il sistema di pianificazione basato sul metodo della partita doppia è incredibilmente potente e alla
portata di tutti.

La pianificazione è completamente integrata nella contabilità.
Usa lo stesso piano dei conti della contabilità.
Non c'è bisogno d'impostare un nuovo file, basta aggiungere i movimenti del preventivo.
Le previsioni si eseguono con delle registrazioni di preventivo.
Si usa la collaudata metodologia contabile della contabilità in partita doppia. I costi e i ricavi
possono essere specificati in dettaglio. 
Si hanno previsioni di Conto Economico e di Bilancio.
Si vede come evolveranno le vendite, i costi, l'utile, la liquidità e l'evoluzione del capitale.
Si vede l'evoluzione di un conto o di un gruppo, con tutti i singoli movimenti di preventivo.
Il programma prepara le previsioni per mese, trimestre o anno.
Le previsioni possono essere parametrizzate con quantitativi e formule di calcolo.
Quando si modifica la previsione, per esempio, si aumentano gli investimenti, automaticamente
viene ricalcolato l'ammortamento di fine anno. 
Il piano finanziario allestito per un anno può essere proiettato anche su più anni.
Tutti i report contabili, sono disponibili con i valori del passato, presente e futuro.

Modalità di Previsioni finanziarie e Budget
La funzione di pianificazione, con le proiezioni finanziarie dei costi, dei ricavi e della liquidità, è
integrata e disponibile in tutti gli applicativi di Banana Contabilità. 
Ci sono due modalità operative:

Pianificazione finanziaria completa nella tabella Preventivo1.
Nel file della contabilità viene aggiunta la tabella Preventivo, che consente d'inserire i
movimenti previsionali per poi generare previsioni finanziare complete.
La colonna Preventivo della tabella Conti viene aggiornata automaticamente dal programma
sulla base dei movimenti inseriti nella tabella Preventivo.

https://www.banana.ch/it/node/11352
https://www.banana.ch/it/node/11351
https://www.banana.ch/it/node/11353
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Preventivo annuale nella tabella Conti2.
Un metodo molto semplice e tradizionale che prevede d'inserire i preventivi annuali nella
colonna Preventivo della tabella Conti o Categorie.
Poi sulla base dei consuntivi, il programma indica gli scostamenti nella colonna Differenza
Budget, tabella Conti o Categorie.
Maggiori informazioni sono disponibili nella pagina web Preventivo semplice per l'anno.

Qui di seguito ci si concentra sul metodo che usa la tabella Preventivo.

Visione immediata dei valori di preventivo
La pianificazione finanziaria basata sul metodo della partita doppia, usa lo stesso piano dei conti della
contabilità.
Nella tabella Conti e Categorie (Contabilità Entrate e Uscite) vengono visualizzati i saldi correnti e
anche quelli di preventivo. 
Puoi impostare liberamente la struttura del Bilancio e del Conto economico, aggiungendo conti e
gruppi.
Puoi usare anche centri di costo e di profitto, segmenti, e conti per clienti e fornitori.

Caratteristiche principali:

Con la funzione Previsione Finanziaria, è possibile creare facilmente dei preventivi e anticipare
la visione dell'andamento aziendale.
Metodologia della Partita Doppia, lavori senza difficoltà con la stessa metodologia basata
sul metodo della partita doppia a cui sei già abituato.
Previsioni Complete, le previsioni finanziarie includono un piano della liquidità, previsioni
dello Stato patrimoniale e del conto economico, offrendo una visione completa della tua
situazione finanziaria.
Proiezioni Automatiche, le proiezioni sono automatiche per più anni, permettendoti di
pianificare a lungo termine con facilità.
Semplice Inserimento delle Pianificazioni, puoi inserire la pianificazione tramite
registrazioni di preventivo, rendendo il processo rapido ed efficiente.
Gestione delle Entrate e Uscite Ricorrenti, le entrate e le uscite ricorrenti possono essere
impostate con una sola registrazione, semplificando la gestione finanziaria.
Funzionalità Avanzate, oltre alle funzionalità standard disponibili in contabilità, offriamo una
vasta gamma di opzioni, tra cui registrazioni semplici o su più conti, previsioni per clienti,
fornitori, IVA, centri di costo e profitto, segmenti, quantità e prezzi.
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Formule di Calcolo Personalizzabili, puoi utilizzare formule di calcolo in Javascript con
accesso ai valori della previsione in corso, per pianificare dettagliatamente aspetti come la
crescita della cifra d'affari, commissioni, costi, ammortamenti, interessi e utilizzo di variabili.
Stampa Personalizzati, i valori delle previsioni sono disponibili nelle stampe contabili
completamente personalizzabili, con visualizzazioni per mese, trimestre, semestre o anno e
confronti tra previsione e attualità.
Scheda Conto Dettagliata, ogni conto dispone di una scheda dettagliata con movimenti di
previsione per conto o gruppo, offrendo una panoramica chiara della vostra situazione
finanziaria.

La tabella Preventivo
La pianificazione viene predisposta inserendo delle registrazioni nella tabella Preventivo, come fare
delle registrazioni contabili, ma che riguardano il futuro.
L'affitto e altre operazioni ricorrenti si indicano una volta sola, impostando l'opzione di ripetizione e
un'eventuale data di termine.
Nella colonna Totale viene indicata la somma per l'anno.
Puoi aggiungere quante righe vuoi, per l'anno corrente o per quelli successivi, cambiare, e modificare
in ogni momento.

I Report previsionali
Prima ancora che parta l'attività puoi sapere quanto redditizia sarà la tua impresa e di quanta liquidità
potrai disporre alla fine dell'anno.
Banana Contabilità Plus ti mette a disposizione tutti i report necessari per avere una visione completa
del tuo futuro finanziario, gli stessi che si usano per la contabilità, tutti integrati e bilanciati, senza
differenze, esattamente come per la contabilità. È tutto automatico, non devi perdere tempo a
impostare tabelle in Excel, inserire e controllare formule, impostare righe e colonne.  

Piano della liquidità
Puoi vedere come evolverà la liquidità nel periodo di pianificazione scelto, sapere in anticipo se
avrai i mezzi a sufficienza per far fronte ai diversi impegni.
Conto economico previsionale
Puoi vedere quali saranno i ricavi, i costi e il risultato previsto, scegliere una visione sintetica
con i totali per gruppo o anche dettagliata con i valori dei singoli elementi. La disposizione del
Conto economico la puoi impostare e modificare liberamente in base alle esigenze. Il
programma farà i totali automaticamente, senza che tu debba inserire formule.
Bilancio previsionale
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Per ogni conto e gruppo degli Attivi e Passivi vedrai l'evoluzione nel tempo. 
Piano degli investimenti
Per ogni conto o gruppo degli Attivi puoi vedere in dettaglio l'evoluzione nel tempo.
Schede di dettaglio
Puoi analizzare in dettaglio ogni voce, grazie alla scheda conto, conoscere l'evoluzione del conto
bancario o della liquidità.
Grafici con l'evoluzione nel tempo
Di ogni voce puoi avere il grafico che a colpo indica come evolveranno le vendite e capire se ci
potrà essere una crisi di liquidità. 
Centri di costo e di profitto, segmenti
Anche in sede di previsione puoi usare i centri di costo, di profitto e i segmenti.
Puoi avere previsioni dettagliate per i singoli progetti, clienti o aree geografiche.
Proiezioni su più anni
Puoi avere il Bilancio e il conto economico per uno, due, cinque o anche dieci anni.
Il programma proietta in automatico i dati dell'anno per i periodi successivi. 
Visualizza i dati per mese, trimestre, anno o più anni
Puoi avere il Bilancio e il Conto economico per un mese, trimestre, semestre, anno o più anni.
Puoi così analizzare in dettaglio il periodo che ti interessa.
Confronta il preventivo con l'effettivo
Utilizzando il medesimo piano dei conti, il confronto fra la previsione e l'effettivo è immediato.
Puoi facilmente individuare scostamenti dal preventivo.
Salva le impostazioni dei report (personalizzazioni)
Crea report e salva le personalizzazioni da richiamare quando lo desideri.

Di ogni report puoi scegliere la disposizione che ti interessa. Il programma adatta in automatico le
stampe senza che tu debba impostare righe, colonne e formule. Puoi analizzare i dati da diversi punti
di vista, passando da un tipo di visualizzazione ad un'altra. 

Visualizzazione per un periodo
Il programma ti presenta i report per l'anno, ma puoi anche richiedere di avere la previsione
solo per un trimestre. Puoi passare facilmente da una pianificazione annuale a una su più anni.
Evoluzione nel tempo
Il programma è in grado di presentarti tutti i report con delle suddivisioni per periodo. Puoi così
vedere l'evoluzione nel tempo della liquidità, del bilancio, delle vendite, dei costi e del risultato
d'esercizio. Puoi passare facilmente da una visualizzazione all'altra senza dovere reimpostare
formule o tabelle.
Report completamente personalizzati
Puoi scegliere e modificare la visualizzazione come desideri. Puoi presentare i tuoi piani in modo
professionale e fare una buona impressione a chi ti sostiene.
Salva impostazione dei report
Puoi creare e salvare le impostazioni di stampa e richiamarli quando servono.

Utilizzo semplice
Tutto è già predisposto, devi inserire i movimenti previsionali con delle semplici registrazioni. Questo
approccio è particolarmente adatto ai contabili, che in un attimo sono in grado di allestire previsioni
precise e complete. Grazie alla Contabilità Entrate e Uscite, anche persone senza conocenze contabili
particolari ci possono riuscire.

Inserimento come per le registrazioni contabili
Per ogni evento finanziario futuro si inserisce una registrazione con data, descrizione e i conti
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che vengono toccati.
È il programma che totalizzare gli importi per voce e periodo, esattamente come nella
contabilità.
Indicazione delle entrate e delle uscite in dettaglio
Si possono indicare i diversi elementi di spesa in dettaglio e nel momento esatto in cui
avverranno. Per le spese del personale si possono indicare i salari dei singoli dipendenti. 
Modifiche e aggiornamenti facilitati
Adattare, aggiungere o rimuovere entrare o uscite è semplice perché si modifica il dettaglio
specifico. Se nell'anno seguente aumenta l'affitto basta cambiare questa voce. Se ci sarà una
nuova spesa, si aggiunge una nuova riga. Il programma in automatico aggiornerà la
pianificazione. 

Veloce grazie alla ripetitività
Le operazioni che si ripetono si inseriscono una sola volta. Nel movimento di previsione si indica la
frequenza con cui l'operazione andrà a ripetersi e il programma ne tiene conto per il futuro.
In una pianificazione sono molte le operazioni che si ripetono. In poco tempo si può allestire una
pianificazione completa. La funzione di ripetizione è particolarmente efficace quando si deve adattare
la pianificazione, si cambia un solo importo e in un attimo tutto viene aggiornato.

Automatizzazione dei calcoli
Il programma esegue in automatico calcoli semplici e complessi.

Calcolo in base a quantitativi e prezzi
Si possono memorizzare i quantitativi di vendita per avere una visione più concreta della
pianificazione. Il programma calcola in automatico l'importo del movimento e aggiorna la
contabilità.
Formula di calcolo (Javascript)
La possibilità di inserire formule è disponibile in Banana Contabilità Plus solo con il
piano Advanced . Aggiorna ora !
Banana Contabilità Plus mette a disposizione un sistema di formule estremamente potente,
concepito appositamente per la pianificazione finanziaria. Si ha accesso ai dati della
pianificazione, quindi è possibile creare dei movimenti che dipendono dagli eventi precedenti. È
possibile calcolare l'ammortamento sulla base del valore degli investimenti effettuati oppure
calcolare gli interessi sul prestito in base all'utilizzo effettivo. Il programma dopo ogni modifica
ricalcolerà i valori esatti. 
Le formule sono delle espressioni di linguaggio Javascript. Si possono creare pianificazioni
semplici o complesse, completamente automatizzate:

Si possono assegnare dei valori a delle variabili e richiamarle nelle righe successive.
Le espressioni Javascript hanno accesso all'API di Banana.
Si possono anche programmare delle funzioni Javascript proprie e richiamarle.

Proiezioni automatiche su più anni
La pianificazione può essere impostata per un anno e lasciare che sia il programma a creare delle
proiezioni per gli anni successivi.
Tutti i report, come piano della liquidità, del conto economico e del bilancio previsionale, saranno
disponibili anche per gli anni successivi.

In questo modo si può avere una visione di medio e lungo termine della situazione finanziaria e la

https://www.banana.ch/it/buy
https://www.banana.ch/it/update
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proiezione può essere controllata completamente anche per gli anni successivi.
La logica di funzionamento è semplice, per le operazioni dell'anno che si ripeteranno anche negli anni
successivi, si inserisce un codice di ripetizione annuale. In questo modo il programma è in grado di
proiettare i dati della pianificazione per il periodo che interessa. Si possono facilmente effettuare
pianificazioni per due, cinque o anche più anni.

Analisi portafoglio clienti e controllo fornitori
Quando si inseriscono i movimenti di previsione, si possono indicare i codici dei clienti. S'imposta così
una pianificazione realistica, partendo dal proprio portafoglio clienti, che permetterà di capire se i
costi verranno coperti e quali clienti saranno più redditizi.
Le stesse analisi si possono ovviamente fare anche per i fornitori.

Pianificazione di progetti o settori
Puoi anche creare piani finanziari con resoconti per progetti, attività o per settori d'impresa. È
sufficiente indicare nei movimenti che una spesa o entrata è attinente a un progetto o a un reparto e
il programma prepara in automatico resoconti specifici. 

Adattamento facile
Puoi adattare la struttura del piano dei conti e la disposizione del bilancio e del conto economico.
Aggiungendo conti, categorie e gruppi, i report cambiano automaticamente, senza impostare formule
per calcolare i totali di riga o colonna. 

Confronto fra i dati di preventivo ed effettivi
Contabilità e pianificazione usano il medesimo motore di calcolo e di preparazione dei report. Nella
tabella registrazioni inserisci i valori riferiti al passato e in quella di preventivo quelli del futuro. Il
piano dei conti e la disposizione del bilancio sono sempre gli stessi e in automatico hai confronti e
indicazioni circa eventuali variazioni rispetto al preventivo.

Passaggio automatico dei dati a un nuovo anno 
Le pianificazioni allestite con Banana Contabilità sono facili da aggiornare e da modificare. È
sufficiente cambiare i relativi movimenti e il programma in automatico ricalcola le formule e aggiorna
la pianificazione.

Quando passi al nuovo anno, il programma riporta i dati della pianificazione, cambiando le date. Si
tratta poi di modificare gli elementi che  cambiano, rispetto all'anno precedente. Si ha così una
pianificazione dettagliata e perfetta per l'anno successivo. 

Simulazione finanziaria aziendale
La pianificazione integrata in contabilità è molto potente e apre una nuova era nella pianificazione
aziendale, in quanto dà la possibilità di simulare con grande precisione e in dettaglio la serie di eventi
futuri. Si possono analizzare in dettaglio le previsioni con i medesimi strumenti usati per le analisi
contabili; verificare qual è il punto di break even e analizzare la situazione dei clienti e dei progetti.
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Approfondimenti
Tabella Preventivo
Calcoli e Formule
Report di previsione
Modelli per la pianificazione

https://www.banana.ch/doc10/it/node/9313
https://www.banana.ch/doc10/it/node/9314
https://www.banana.ch/doc10/it/node/9347
https://www.banana.ch/apps/it/ac2list?combine=Pianifica&term_node_tid_depth_1=225&term_node_tid_depth=All&term_node_tid_depth_4=All&term_node_tid_depth_2=All
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Iniziare una previsione finanziaria

 Puoi allestire facilmente previsioni finanziarie complete di piani della liquidità, bilancio e conto
economico.
Il procedimento è lo stesso come per la creazione della contabilità.

▶ Video: Previsione Finanziaria | Partita Doppia

1. Crea il file della contabilità/previsione
Con il comando File → Nuovo, crea un file di previsione finanziaria, usando la tipologia di contabilità e
il modello di contabilità che più corrisponde alle tue necessità.

Puoi anche iniziare usando uno dei modelli già predisposti per l'apprendimento, che contengono
anche esempi di registrazioni di preventivo.

Piano finanziario per la famiglia (con il Cash Manager)
Per pianificare le spese e le entrate della propria famiglia.
Pianificazione finanziaria per l'apertura di un ristorante (Contabilità Entrate e Uscite) 
Questo modello per i conti usa dei numeri alfabetici, che rendono più immediata la
comprensione.
Con le entrate e uscite, anche senza conoscenze contabili, si crea una pianificazione
professionale, completa di piano della liquidità, previsioni patrimoniali e dei costi e ricavi.
Pianificazione finanziaria per l'apertura di un ristorante (Contabilità in Partita Doppia) 
Per previsioni finanziarie complete, con il sistema della contabilità in partita doppia, destinata a
chi conosce il metodo della contabilità in partita doppia.
Questo modello usa dei numeri conti alfabetici, che rendono più immediata la comprensione.

Ci sono anche dei file d'esempio per funzionalità più avanzate:

Contabilità in partita doppia, con uso delle colonne quantità e formule
Sono elencate le diverse possibilità d'uso della colonna formule. Con esempi e spiegazioni.
Contabilità multi-moneta con esempi di registrazioni di preventivo con formule
Per usare le formule specifiche alla multi-moneta.
Con esempi di registrazioni su temi più complessi.

Una volta creato il file, puoi salvarlo attribuendogli il nome, composto preferibilmente dal nome della
ditta e dall'anno "Rossi-2020.ac2".

2. Personalizza il file
Una volta creato il file si deve adattare alle esigenze specifiche:

Imposta le Proprietà del file.1.
Il nome della ditta.1.
Il Periodo contabile:2.
Normalmente è quello corrispondente all'anno solare. Puoi però indicarne un altro a
seconda delle necessità. Vedi a questo riguardo Periodo di pianificazione e di previsione
finanziaria.

Personalizza il Piano dei conti:2.

https://www.banana.ch/it/node/11449
https://www.banana.ch/apps/it/node/8976
https://www.banana.ch/apps/it/node/8449
https://www.banana.ch/apps/it/node/8082
https://www.banana.ch/apps/it/node/8251
https://www.banana.ch/apps/it/node/8258
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Puoi modificare la descrizione, aggiungere o cancellare conti o gruppi.
Se c'è la necessità puoi adattare il piano dei conti in qualsiasi momento successivo.
Se si tratta di un'attività già in corso, inserisci i Saldi iniziali.3.

3. Inserisci i movimenti di previsione finanziaria
Nella Tabella Preventivo puoi ora inserire i movimenti di previsione finanziaria.

4. Visualizza le previsioni
I dati delle previsioni sono visibili:

Nella visualizzazione dei grafici.
Nella tabella Conti, colonna Preventivo.
Nei report, nella colonna Preventivo.
Nella scheda conto, valori di Preventivo.

Adatta la previsione
Puoi cambiare, aggiungere o eliminare movimenti a tuo piacimento. Le previsioni saranno
immediatamente ricalcolate.
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Aggiungere le previsioni finanziarie a una
contabilità esistente

Qui di seguito viene spiegato come aggiungere la pianificazione finanziaria a una contabilità
esistente.

Aggiungi la tabella Preventivo
Il primo passo è quello di Aggiungere la tabella Preventivo al tuo file di contabilità. A questo punto nel
tuo file avrai la tabella preventivo dove inserire i movimenti di previsione finanziaria.

Inserisci i movimenti di preventivo
Avendo la contabilità e il piano dei conti già impostato, si può immediatamente iniziare a inserire i
movimenti nella tabella Preventivo, vedi anche esempio di movimenti.

Puoi seguire le istruzioni e i modelli anche al link seguente:

Iniziare una nuova previsione finanziaria.
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Tabella Preventivo

Nella Tabella Preventivo si inseriscono i movimenti della pianificazione finanziaria. È simile alla
tabella Registrazioni del tipo di contabilità in uso, ma presenta delle colonne specifiche alla
pianificazione che aiutano e velocizzano l'inserimento dei dati di preventivo.
Puoi anche modificare i dati come desideri, per avere delle previsioni affidabili e sempre
perfettamente aggiornate.

Previsioni facili e complete
Puoi inserire tutte le operazioni in dettaglio.
Hai previsioni complete perché basate sul metodo della partita doppia:

Dettagli sul conto di provenienza e di destinazione
Sulla base dei movimenti inseriti il programma calcola e visualizza le previsioni.
Indichi quando un'operazione verrà effettuata, se si ripeterà e fino a quando:

Puoi inserire previsioni relative all'anno corrente o a quello futuro.
Indichi il conto di provenienza e destinazione. 
Indichi l'importo previsto:

Oppure usare le colonne  Quantità e Prezzi .
Oppure usare le Formule di calcolo .

Puoi completare la registrazione con:
Conto Cliente.
Conto Fornitori.
Codice IVA.
Centro di Costo/Profitto.
Segmenti.
Aggiungere altre colonne per informazioni supplementari.

Puoi inserire i movimenti nell'ordine che desideri, così da raggrupparli.
Puoi inserire informazioni supplementari per facilitare il riporto dei dati al nuovo anno.

http://www.banana.ch/doc/it/node/9344
http://www.banana.ch/doc/it/node/9344
http://www.banana.ch/doc/it/node/9657
http://www.banana.ch/doc/it/node/9314
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Aggiungere e rimuovere la tabella Preventivo

Aggiungere la Tabella Preventivo
La Pianificazione finanziaria viene fatta aggiungendo la tabella Preventivo.

Se il proprio file contabile non ha ancora la tabella Preventivo, si procede come segue:

menu Strumenti → Aggiungi nuove funzionalità → Aggiungi tabella Preventivo 
Attenzione: questa operazione non può essere annullata (con il tasto Annulla). Se si vuole
ritornare alla situazione precedente, tenere una copia del file preesistente, oppure usare la
funzione Rimuovi Tabella Preventivo.

Successivamente il programma:

aggiunge la tabella Preventivo riprendendo i valori di preventivo indicati nella tabella Conti.
blocca la colonna Preventivo nella tabella Conti.
I valori di questa colonna vengono calcolati in base alle registrazioni di preventivo, usando
come periodo quello definito nei nelle Proprietà file, dati base della contabilità.

Rimuovere la Tabella Preventivo
Dal menu Strumenti → Aggiungi nuove funzionalità , vi è anche la possibilità di rimuovere la tabella
Preventivo.

Attenzione: Questa operazione non può essere annullata. Una volta impartito il comando tutti i
movimenti di previsione vengono cancellati.
Se si vuole ritornare alla situazione precedente è bene fare una copia dei dati.

Quando la tabella Preventivo viene eliminata, la colonna Preventivo nella tabella Conti diventa
modificabile.

http://www.banana.ch/doc/it/node/7923
http://www.banana.ch/doc/it/node/7923
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Colonne della tabella Preventivo

Le colonne della tabella Preventivo sono simili a quella della tabella Registrazioni. Nell'esempio che
segue, per una più facile comprensione, sono stati usati dei conti alfanumerici. Se si ha una
contabilità con dei conti numerici, ovviamente si useranno i propri numeri di conto.

Qui di seguito sono spiegate le colonne della tabella Preventivo:

Data
La data futura durante la quale si prevede avverrà l'operazione.
Se la data non è definibile in modo preciso, per esempio una previsione delle vendite mensili,
indicare la data di fine mese. 
Ripeti
Si inserisce un codice di ripetizione. Per maggiori informazioni sull'uso, vedi anche Date e
Ripetizioni.
Nel calcolo della previsione, il programma internamente crea delle copie delle righe con la data
impostata in successione, in base al codice di ripetizione indicato.

Vuoto - non fa alcuna ripetizione.
La riga iniziale mantiene la data indicata della colonna Data.
La data delle righe di copia viene aumentata progressivamente in base al codice di
ripetizione.
Se la ripetizione è mensile o annuale nella righe create:

Viene generalmente usato lo stesso giorno della colonna data.
Se il giorno è maggiore al numero di giorni nel mese, viene messo l'ultimo giorno
del mese.
Se vi è l'indicazione fine mese "ME" o "YE" viene messo l'ultimo giorno del mese.

Codici base per la ripetizione:
"D" ripetizione giornaliera (Day)
"W" ripetizione settimanale (Week)
"M" ripetizione mensile (Month)
"Y" ripetizione annuale (Year)

Multipli
Se si precede il codice con un numero, la ripetizione avviene con la frequenza
moltiplicata:

"2M" per bimensile
"3M" per trimestrale
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"6M" per semestrale.
Ripetizione con data successiva a fine periodo.
I codici "M" e Y" con la "E" alla fine, spostano la data di ripetizione alla fine del mese.

ME" ripetizione mensile, ma con data a fine mese. 
Se si inserisce la data 1.1.2022 la data successiva sarà 28.2.2022 e quella dopo
31.3.2022.
Se la data è il 28.2.2022, la data successiva sarà 31.3.2022.
"3ME" per trimestrale  fine mese
Se si inizia il 30.6.2022, la data successiva sarà 30.09.2022.
"6ME" per semestrale fine mese
"YE" ogni anno, ma alla fine del mese.
Se la data è il 28.2.2022 la data successiva sarà 28.2.2023
"5YE" ogni cinque anni, ma alla fine del mese.
Se la data è il 28.2.2022 la data successiva sarà 28.2.2027.

Fine - Data fine:
Generalmente da lasciare vuoto.
Inserire la data oltre la quale non ci deve più essere la ripetizione.
Per un leasing si indica come data finale, la data in cui termina il leasing.

Variante
Per indicare un'eventuale variante relativa al preventivo, in combinazione con le Estensioni.
Gestione Nuovo Anno
Per indicare come deve avvenire il trasferimento quando si crea nuovo anno.

Nessun valore - la data viene incrementata di un anno. 
"1" La data rimane uguale.
"2" L'operazione non viene trasferita nel nuovo anno.

Descrizione
Un testo descrittivo per l'operazione che appare nella scheda conto.
Si possono usare Formule di calcolo  inserendo il valore fra ${} (vedi Javascript template
literals ). Quando viene preparata la scheda conto la formula viene risolta e il risultato viene
sostituito.
Per esempio, il testo "Amount ${10+20} year" risulterà "Amount 30 year".
Si possono usare tutte le formule, ma per evitare confusione, si consiglia di evitare di inserire
degli assegnamenti di valore nella colonna Descrizione.
Conto Dare e Conto Avere, CC1, CC2, CC3
Come nella tabella Registrazioni si indicano i conti nei quali registrare l'operazione.
Si possono usare anche segmenti e centri di costo. In questo modo si può allestire un
preventivo anche per segmenti o centri di costo.
Quantità
Il quantitativo che, moltiplicato per il prezzo unitario, dà il totale dell'importo (vedi colonne
Quantità e Prezzo)
Unità
Una descrizione riferita alla quantità, per esempio: mq, ton, pz.
Prezzo/Unità
Il prezzo per ogni unità, che moltiplicato con la quantità, dà il totale dell'importo.

Nella contabilità Entrate/uscite immettere un valore negativo per fare in modo che
l'importo venga inserito nella colonna uscita.

 Formula (in moneta base)
Permette d'inserire delle Formule di calcolo, nel linguaggio Javascript, più le funzioni di
programmazione delle Estensioni di Banana Contabilità.
Se vi è una formula (o un qualsiasi testo), il valore della colonna Importo viene impostato in
base al risultato della formula.

http://www.banana.ch/doc/it/node/9314
https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Template_literals
https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Template_literals
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Si veda il punto seguente per come usarlo:
Nella contabilità in partita doppia, il risultato della formula deve essere sempre un
numero positivo.
Nella contabilità entrate e uscite, se il risultato è positivo, sarà considerato come
un'entrata, se negativo un'uscita.

Formula Inizio
Il testo che inserite in questa colonna viene inserito prima del testo utilizzato nella Formula e
poi utilizzato per il calcolo.
L'uso principale della Formula Inizio è quello di inserire un'impostazione variabile come "A=",
nella Formula si inserisce poi solo il valore, in modo che sia più facile da modificare.
Importo (in moneta base)
L'importo che viene usato per la previsione.
Nel caso in cui la riga preveda una ripetizione, viene indicato l'importo della prima
registrazione. Gli importi delle successive ripetizioni sono visibili nella scheda conto.
L'importo viene calcolato in automatico nei seguenti casi:

Se è stato inserito un valore nella colonne Quantità o Prezzo unitario, l'importo viene
calcolato in base ai contenuti di queste due colonne.

Nella contabilità in partita doppia il risultato viene convertito in un valore positivo.
Nella contabilità entrate e uscite, se il risultato è positivo sarà considerato come
un'entrata, se negativo un'uscita.

Se è stata inserita una formula, l'importo sarà il risultato della formula.
La formula ha anche la priorità rispetto alla quantità e il prezzo.

Totale
È il totale degli importi delle righe ripetute che rientrano nel Periodo contabile e di previsione,
impostato nelle proprietà del file.
Se non vi è una data oppure se la data inizio o fine non rientra nel periodo contabile, questa
colonna rimarrà vuota.

Colonne nella Contabilità Entrate e Uscite
Per il Cash Manager e la Contabilità Entrate e Uscite gli importi si indicano come segue:

Colonne Entrate e Uscite
Gli importi della pianificazione sono inseriti nelle colonne entrate e uscite.
Utilizzo colonne Quantità, Prezzo e Formula
Quando il programma calcola in automatico l'importo sulla base delle colonne Quantità, Prezzo
o Formula, il risultato viene inserito nella colonna Entrate se è positivo, e nella colonna Uscite se
è negativo.
Nella colonna quantità e prezzo si può indicare un valore positivo o negativo.

Colonne nella contabilità multi-moneta
Importo in moneta del conto
È l'importo in moneta del conto della registrazione (vedi registrazioni multi-moneta).
Questo importo serve al calcolo del valore in moneta base, al cambio indicato.
Se vi è una formula, il valore è il risultato del calcolo della formula.
Nel caso la riga preveda una di ripetizione, viene indicato l'importo della prima registrazione.
Formula importo moneta del conto
Si può immettere una Formula di calcolo.
Nel caso la riga preveda una ripetizione, viene indicato l'importo della prima registrazione. Gli
importi delle successive ripetizioni sono visibili nella scheda conto.
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Cambio
È il cambio che viene applicato per convertire l'importo in moneta del conto, in moneta base.
Totale importo moneta del conto
È il totale degli importi in moneta del conto delle righe ripetute, la cui data rientra nel periodo
contabile, definito nelle proprietà del file.
Se non vi è una data oppure se la data inizio o fine non rientra nel periodo contabile, questa
colonna rimane vuota.

Si veda anche Contabilità multi-moneta con esempi di registrazioni di preventivo con formule
 

https://www.banana.ch/apps/it/node/8258
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Pianificazione basata sul metodo della
partita doppia

 

Il sistema di pianificazione di Banana Contabilità è basato sul metodo della partita doppia, lo stesso
usato per la contabilità.
Si pianifica indicando sempre un conto di destinazione (Dare) e uno di provenienza (Avere). Questo
permette di avere una visione precisa dei flussi di capitale e dà la possibilità di avere una visione
completa che include:

Previsioni di bilancio, relativamente alla situazione finanziaria, liquidità, altri attivi, mezzi di terzi
e capitale proprio.
Previsione di Conto economico per i ricavi, i costi e risultato d'esercizio.

Pianifica Esegui Controlla
La pianificazione di Banana Contabilità è parte integrante del ciclo Pianifica-Esegui-Controlla .
Si ha un controllo costante e dinamico della situazione ed evoluzione finanziaria.

Pianificazione e contabilità in un unico file
Lo stesso file contiene sia i dati della contabilità, che quelli della pianificazione. Si può partire da un
file per tenere la contabilità e poi aggiungere la pianificazione successivamente, oppure si può partire
da un file per tenere la pianificazione e poi gestire anche la contabilità.

Elementi comuni

I dati base della contabilità
Intestazione, moneta, periodo contabile,  indirizzo, altri parametri.
Tabella Conti e Categorie
Dove si imposta il piano contabile con i conti e i gruppi di totalizzazione. 

Saldi iniziali - colonna Apertura
Si inseriscono nella tabella Conti e sono usati come situazione iniziale sia per la
contabilità (valori correnti) sia per le previsioni.
Preventivo Annuale - colonna Preventivo

Con la tabella Preventivo
La colonna Preventivo del piano dei conti è protetta e il programma indica gli

http://www.banana.ch/it/pianifica-esegui-controlla
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importi di preventivo, calcolati sulla base dei contenuti della tabella Preventivo,
riferiti al periodo contabile.
Se manca la tabella Preventivo
Si inseriscono i dati di preventivo manualmente nella tabella Conti, colonna
Preventivo.
In sede di previsione il programma crea il valore mensile, dividendo il valore
annuale per il numero di mesi del periodo contabile.

Le altre tabelle
Tabella Codici IVA.
Tabella Cambi.

I dati contabili (passato e presente)

La tabella Registrazioni
Dove si registrano i movimenti del passato (storici).
La tabella Registrazione è sempre presente nel file della contabilità. Se non la si usa, si può
renderla non visibile.
Il valore Corrente (contabile, passato e presente)
È il saldo o il movimento del periodo di un conto o gruppo.
Nei report si può visualizzare la colonna del valore Corrente.
Sono i valori calcolati sulla base dei dati contabili, calcolati tenendo conto dei

Saldi iniziali (tabella Conti).
I movimenti della tabella Registrazione.

Scheda Conto (storico)
Sono i movimenti di un conto o gruppo preparati sulla base dei saldi iniziali e delle Registrazioni
.

I dati di Preventivo

Sono quelli usati per effettuare previsioni, budget e pianificazioni.
Nel programma si usa sempre il termine Preventivo per i dati riferiti al futuro.

La tabella Preventivo
Si inseriscono i movimenti futuri, di pianificazione.
Il metodo è lo stesso della tabella Registrazioni, ci sono le medesime colonne, più altre
specifiche per la pianificazione.
Movimenti riferiti al futuro, inseriti nella tabella di Preventivo.

Valori statici (come nella tabella Registrazioni).
Movimenti con formule di calcolo, che il programma risolve al momento del calcolo della
previsione.
Movimenti ripetitivi, che il programma usa quando crea previsioni in automatico.
Possono anche contenere formule di calcolo.

Il valore di Preventivo (futuro) 
Il valore di previsione. Nei report si può visualizzare la colonna del valore Preventivo.
Il valore è calcolato tenendo conto:

Dei saldi iniziali (tabella Conti).
Dei movimenti della tabella Preventivo (se esistente).
Se non esiste la tabella Preventivo, il programma usa il valore contenuto nella colonna
Budget della tabella Conti o Categorie.

Scheda conto Preventivo (futuro)
Sono i movimenti di un conto o gruppo preparati sulla base dei saldi iniziali e delle registrazioni
di Preventivo.
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I valori di scostamento

Rappresentano la differenza fra i valori di preventivo e quelli effettivi o consuntivi.
Nei report vi è la colonna del confronto che mostra lo scostamento. 

Valori di proiezioni misti (a partire da una certa data)

Il valore a una certa data futura è calcolato nel modo seguente:

Fino alla data d'inizio, indicata sulla base dei valori correnti.
A partire dalla data indicata sui valori di preventivo.

I valori delle proiezioni miste sono disponibili solo tramite gli script e il web server.

Tipi di contabilità
Per inserire registrazioni o movimenti di preventivo si usa il metodo contabile che si è scelto per la
contabilità.

Entrate e uscite (Cash Manager e Contabilità Entrate e uscite).
Partita doppia (Contabilità in partita doppia e multi-moneta).

Internamente, per i calcoli delle previsioni, il programma utilizza sempre il motore basato sulla partita
doppia. I risultati e la reportistica che si ottengono sono quindi molto simili.

Periodo contabile, di pianificazione e di previsione
La contabilità o la previsione è sempre attinente a un periodo. Si distinguono i seguenti periodi:

Periodo contabile
È quello definito nelle proprietà file, con data inizio e fine.
Periodo di pianificazione
È il periodo definito per inserire i dati della pianificazione.
Periodo di previsione
È il periodo usato dal programma per calcolare la previsione. Viene indicato al momento in cui si
richiede una stampa.

Per maggiori informazioni si veda il Periodo di previsione .

Suddivisione per periodo
Nella pianificazione, con il metodo della partita doppia, ogni operazione ha una propria data. L'utente
in sede di stampa sceglie se avere la previsione per mese, trimestre, semestre o anno, e il
programma calcola tutto in automatico. Non è necessario, come per le tabelle di calcolo, stabilire
all'inizio se fare previsioni per mese, trimestre o anno e suddividere gli importi manualmente nelle
colonne.

Proiezioni automatiche
Grazie alla possibilità d'indicare che determinate operazioni si ripetono nel futuro, il programma ha gli
elementi necessari per allestire in automatico previsioni relative agli anni futuri. Si può così sapere

https://www.banana.ch/doc/it/node/9699/
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come evolveranno i ricavi, i costi, la liquidità e altri attivi e passivi nelle settimane, mesi, trimestri e
anni a venire.

Dettagli con tutte le operazioni
Con il metodo delle partita doppia, le previsioni sono allestiti tramite l’inserimento di registrazioni. Il
programma è in grado di presentare la scheda con i movimenti dettagliati per ogni conto. Questa
visione è molto utile per approfondire elementi e rappresenta un altro vantaggio della pianificazione
orientata alla liquidità, difficilmente ottenibile con delle pianificazioni effettuate con dei fogli di
calcolo.

Il giornale di calcolo
La base per tutte le elaborazioni contabili e di preventivo è il giornale di calcolo. Per preparare
Bilancio, Conto Economico, Schede conti, Rendiconti IVA, il programma crea una struttura dati 
interna che viene chiamata giornale di calcolo. I movimenti sono accessibili tramite l'API contabile con
la funzione Journal().

La logica per creare il giornale di calcolo è la seguente:

Viene creata partendo dai dati inseriti dall'utente.
Per ogni movimento finanziario, compresi anche i saldi di apertura, vi è una riga, dove gli
elementi principali sono:

Origine
Indica se l'operazione è relativa alla contabilità (corrente) o alla pianificazione
(preventivo).
Tipo operazione
Saldo d'apertura, movimento, riporto, compensazione fattura.
Data (la data di competenza).
Descrizione.
Conto.
Tipo Conto.
Indica se si tratta di un conto normale o di un centro di costo o profitto.
Importo (moneta base della contabilità).
I valori in positivo indicano un aumento (dare), mentre quelli negativi una diminuzione
(avere).
Importo in moneta del conto.
Altre colonne:

Tutte quelle che sono presenti nella tabella Registrazioni.
Diverse altre che servono per i calcoli.

Il giornale di calcolo viene svuotato tutte le volte che viene effettuato il ricalcolo e poi sono aggiunte:

Le righe dei movimenti correnti (relativi alla contabilità effettiva).
Le righe dei movimenti di preventivo.

Le righe dei valori correnti (effettivo)

Le righe per i valori correnti sono aggiunte al giornale temporaneo partendo dai seguenti dati:

Saldi iniziali contenuti nella tabella Conti
Per ogni conto con un saldo, viene creata una riga.
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Data - è la data dell'inizio della contabilità.
Conto - è il conto.
L'importo - è il saldo d'apertura.

Movimenti contabili, provenienti dalla tabella registrazioni.
Se il movimento ha più conti, conto dare, conto avere, conto IVA, centro di costo, viene
generata una riga per ogni conto con il relativo importo in positivo o negativo.

Le righe dei valori di preventivo

Le righe per i valori di preventivo sono aggiunte al giornale temporaneo partendo dai:

Saldi iniziali contenuti nella tabella Conti
Come per i valori contabili, per ogni conto con un saldo, viene creata una riga di preventivo.

Movimenti di pianificazione (con la tabella Preventivo)
Come per la contabilità, per ogni movimento sul conto, vengono create delle righe, partendo
dalla tabella Preventivo.

Quelli statici, con tutti i valori impostati.
Movimenti ripetuti:

Per tutto il periodo di proiezione definito, sulla base del codice di ripetizione, il
programma crea dei duplicati delle righe di preventivo e imposta la data.
Il programma genera le righe ripetute in base al contenuto delle colonne Data
inizio, Data fine e Ripetizione.
Se il periodo di proiezione è l'anno solare e a gennaio vi è la registrazione dell'affitto
con ripetizione mensile, il programma crea dei duplicati per gli 11 mesi successivi.
Se la registrazione è al 31 gennaio, per i mesi che non hanno 31 giorni, il giorno
sarà l'ultimo del mese.
Se la prima registrazione è al 28 di marzo e il codice di ripetizione è indicato come
fine mese, nei mesi successivi, il giorno sarà quello dell'ultimo del mese. 

Come per i movimenti contabili, se sulla riga di preventivo ci sono più conti, viene
generata una riga per ogni conto.

Movimenti partendo dal Budget annuale (se manca la tabella Preventivo)
Se manca la tabella Preventivo, le righe di preventivo sono create partendo dal contenuto della
colonna Budget della tabella Conti e Categorie:

Vengono calcolati i mesi che ci sono nel periodo contabile.
Viene creata una riga per ogni mese.
L'importo contenuto nella colonna Budget viene diviso per il numero di mesi.
Se vi è una differenza d'arrotondamento, viene creata una riga supplementare per il mese
finale.

Terminata la creazione, le righe sono ordinate in ordine crescente.

Calcolo della colonna Importo

Una volta creato il giornale di calcolo viene ricalcolato il contenuto della colonna importo di tutte le
righe di preventivo, che contengono una formula, una quantità o un prezzo unitario.

Risoluzione delle formule in Javascript:

Creazione interprete Javascript
Tutte le volte che viene creato il giornale di calcolo, viene anche creato un'istanza di
un'interprete Javascript, specifica per la risoluzione delle formule di Preventivo.
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Inizializzazione interprete Javascript
L'interprete Javascript viene inizializzato eseguendo degli script.

Gli script predefiniti di Banana Contabilità. 
Il contenuto del file _budget.js eventualmente presente nella tabella Documenti.
In questo modo l'utente può inizializzare delle variabili o creare delle proprie funzioni di
calcolo.

Risoluzione delle formule
Le formule contenute nelle righe del giornale temporaneo sono risolte una dopo l'altra
nella sequenza progressiva di data.
Lo stato dell'interprete Javascript è mantenuto dopo ogni operazione, pertanto la formula
può fare riferimento a variabili definite in una riga con una data precedente.
Le formule contenute nelle righe di ripetizione sono anche eseguite in ordine di data, per
cui il risultato varia a seconda di quando viene eseguita.

La sequenza di calcolo è la seguente:

Le righe di preventivo sono elaborate in ordine di data (se hanno la medesima data nell'ordine
d'immissione).
Viene calcolato l'importo della registrazione, con questa priorità:

Se c'è una formula, risolvendola.
Se è presente la quantità e il prezzo, moltiplicandoli.
Altrimenti, viene mantenuto il valore contenuto nella colonna importo.

Per la contabilità multi-moneta viene prima eseguita la formula importo in moneta e poi la
formula importo in moneta base.
Se non vi è una formula importo in moneta base, il programma riprende il cambio storico e
calcola il controvalore in moneta base.
Per la contabilità con IVA viene ricalcolata l'IVA in base all'importo della registrazione.
Le righe elaborate in precedenza servono per i calcoli delle righe successive:

Il saldo dei conti, alla data della riga di preventivo, comprende solo gli importi elaborati in
precedenza.
Se in una registrazione di febbraio si usa una formula per il calcolo del saldo per tutto
l'anno, si ha comunque solo il saldo fino a febbraio. 

Calcolo colonna Totale tabella Preventivo
La colonna Totale viene calcolata in automatico e contiene l'importo totale di preventivo per il
periodo contabile indicato nelle proprietà del file (data inizio e fine contabilità).

Se è un'operazione unica, il Totale è uguale all'importo.
Se è un'operazione ricorrente, il Totale è la somma degli importi di tutte le ripetizioni che
rientrano nel periodo della contabilità.
La colonna Totale è vuota se la data è precedente o va oltre il periodo della contabilità. 

Calcolo del valore corrente, previsione e confronto
Un volta generato il Giornale di calcolo, questo viene usato per calcolare il bilancio e tutte le altre
elaborazioni necessarie per la contabilità.

Per i periodi definiti nel report il programma calcola:

Il valore corrente (basati sulle Registrazioni).
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I valori di Preventivo.

Per i dati correnti e quelli di preventivo sono calcolati i seguenti valori:

Saldo all'inizio del periodo.
Movimento Dare.
Movimento Avere.
Movimento Totale.
Saldo alla fine del periodo (Inizio + Movimento).

Sono poi calcolati anche i confronti fra Corrente e Preventivo:

Variazione assoluta (Preventivo - Corrente).
Variazione in percentuale.

Ricalcolo automatico e manuale
I valori di preventivo sono ricalcolati automaticamente:

Se c'è una modifica nella tabella Preventivo.
Se viene modificata la data di inizio o di fine della contabilità.
Se viene modificata la tabella Conti.
Quando si richiede un report ed è stata modificata la tabella Registrazioni.

Dopo ogni ricalcolo il programma aggiorna in automatico:

La colonna Preventivo nella tabella Conti e Categorie.
La colonna Totale nella tabella Preventivo.

Se si modifica la tabella IVA o il file _budget.js o altri file Javascript che si usano nel calcolo delle
formule, si deve effettuare un ricalcolo manualmente (Comando Ricontrolla e ricalcola contabilità).

La velocità di calcolo è dipendente dai seguenti elementi:

Numero di conti e gruppi nella tabella Conti e Categorie
Numero di righe inserite nella tabella Preventivo.
Numero di righe con ripetizione.
Presenza di formule.
Periodo di pianificazione impostato. Più lungo è il periodo, maggiore sarà il numero di righe di
ripetizione.

Ricalcolo Manuale

Se il calcolo richiede diverso tempo, può risultare difficile inserire dati nella tabella Preventivo. Si può
passare al ricalcolo manuale inserendo il visto all'opzione Ricalcolare i totali manualmente, menu
File → Proprietà file → sezione Opzioni.
Per avere i valori aggiornati si dovrà quindi usare il comando Ricalcola Totali.
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Periodo per la previsione finanziaria

Il sistema di pianificazione basato sul metodo della partita doppia consente di allestire previsioni,
indicando quando avverrà l'operazione.
Diversamente da Excel, dove il foglio di calcolo viene impostato con le colonne per i periodi di
previsione (mese, trimestre o anno), con Banana Contabilità si indica semplicemente la data del
previsto accadimento. L'attribuzione a un periodo viene eseguita in automatico dal programma nella
presentazione dei dati. Si può scegliere di visualizzare le previsioni per giorno, settimana, mese, 2
mesi, trimestre, semestre, annuo, 2, 5 o 10 anni.

Si possono fare previsioni per uno o più anni.
Sulla base dei dati inseriti il programma, calcola le proiezioni della liquidità, bilancio e conto
economico, per il periodo che interessa.
Si possono avere sia previsioni giornaliere, particolarmente utili per la liquidità, oppure anche
per mese o anno.
Si veda Stampe e report previsioni finanziaria.

Periodo contabile, di pianificazione e di previsione
La contabilità e la previsione sono sempre attinenti a un periodo. Si distinguono i seguenti periodi:

Periodo contabile
È quello definito nelle proprietà file, con data inizio e fine. 
Generalmente è uguale all'anno solare, ma può avere qualsiasi data di inizio e di fine.
Periodo di pianificazione
È il periodo in cui s'inseriscono i dati della pianificazione:

Il programma non richiede che si imposti un periodo di pianificazione.
Generalmente si presume che sia uguale al periodo contabile.
Il periodo di pianificazione può essere diverso da quello contabile.
Nella tabella Preventivo si inseriscono righe che hanno effetto oltre il periodo contabile:

Operazioni con date fuori dal periodo contabile.
Operazioni ripetitive senza data fine o con una data fine che vanno oltre la data del
periodo contabile.

Periodo di previsione
È il periodo usato dal programma per calcolare la previsione.

Viene indicato al momento in cui si richiede una stampa:
Usa come valore predefinito il periodo contabile.
Può essere impostato liberamente e in questo modo si possono ottenere previsioni
per più anni e anche per più decenni. 

Il periodo contabile è usato come Periodo di previsione per il calcolo del contenuto della
colonna Totale nella tabella Preventivo e della colonna Budget delle tabelle Conti e
Categorie:

Questi valori sono quindi riferiti al periodo contabile definito nelle proprietà file.
Se si cambia la data inizio e fine della contabilità, le previsioni sono ricalcolate.

Previsioni con logica mensile
Nella tabella Budget si inseriscono i movimenti di previsione indicando la data in cui si prevede che
questi accadranno. Le date delle entrate e delle uscite devono essere il più possibile precise, sono
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importanti ai fini della previsione della liquidità.

Per tutte le altre entrate e uscite che avvengono in un giorno del mese o piuttosto all'inizio o alla fine,
come affitto, salari, spese bancarie e di altre spese o entrate, è importante indicare il giorno vicino a
quello effettivo del pagamento.

Per altre entrate e uscite si faranno invece delle approssimazioni, per esempio, salvo casi particolari,
per i ricavi di un ristorante che entrano quotidianamente, è poco efficiente fare previsioni giorno per
giorno. In questi casi è sufficiente indicare le vendite complessive che si prevede ci saranno nel mese.
Si consiglia in questo caso di indicare il giorno 15, la metà del mese.

Previsione per l'anno corrente
Nella tabella Preventivo s'inseriscono i movimenti con o senza ripetizione.

Il calcolo della previsione viene fatto generalmente tenendo conto dei movimenti che rientrano nel
periodo corrente, definito nelle proprietà del file. 

Nella colonna Totale della tabella Preventivo viene indicato l'importo complessivo per il periodo
corrente.
Nella colonna Preventivo della tabella Conti e Categorie è indicato il saldo previsionale, per il
periodo corrente.
Nelle diverse stampe, se si indica come periodo Tutto, si hanno delle previsioni per il periodo
corrente.

Se il file serve anche per tenere la contabilità, ovviamente il periodo contabile deve essere quello
riferito alla contabilità. Anche quando il file viene usato solo per delle previsioni, è meglio impostare il
periodo contabile riferito a un solo anno. Se infatti nei dati base si inserisce un periodo di due anni, i
valori delle previsioni, nella colonna Totale e dei Conti, saranno per i due anni. Questo può portare a
confondere i valori.

Previsioni per più anni
Se si inseriscono i movimenti di previsioni con il codice di ripetizione, il programma è in grado di
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allestire previsioni oltre il periodo definito.

Per ottenere delle previsioni su più anni, s'inseriscono i movimenti nella tabella Preventivo.

Saldi d'apertura
Si inseriscono nella tabella Conti.

Movimenti di previsione precedenti al periodo contabile:
Per casi particolari è possibile inserire anche operazioni con date precedenti al periodo
contabile.
Bisogna prestare attenzione, perché queste operazioni andranno a modificare i saldi al
momento dell'apertura.
Per queste operazioni, la colonna Totale risulta vuota, perché fuori dal periodo contabile.

Movimenti di previsione per il periodo contabile. 
S'indicano i movimenti con la data che rientra nel periodo contabile.
Se ci sono operazioni che si ripetono anche negli anni successivi, si deve impostare il
codice di ripetizione annuale "Y".
Se la ripetizione dell'operazione avviene per più anni, indicare il numero di anni prima
della "Y", quindi per ogni 2 anni indicare "2Y", 5 anni "5Y", 10 anni "10Y".
Se la ripetizione non va oltre una certa data (per esempio il pagamento di un leasing) si
deve indicare la data di fine.

Movimenti di previsione per gli anni successivi.
Si indica la data futura in cui l'operazione è prevista.
Si possono indicare il codice di ripetizione e la data di fine.
Per queste operazioni la colonna Totale risulta vuota, perché fuori dal periodo contabile.

Utilizzo delle formule
Le formule permettono di automatizzare i Calcoli degli ammortamenti e degli interessi. Quando
aumenta un investimento anche il conto economico viene immediatamente aggiornato. Le formule
sono particolarmente utili quando si fanno previsioni su più anni.

Le formule si possono usare per fare in modo che l'importo delle righe di ripetizione si adegui
automaticamente.

Il calcolo degli ammortamenti può basarsi sul saldo del conto immobilizzazioni.
Il calcolo degli interessi può essere fatto direttamente sul movimento del conto bancario.
Si può specificare una progressione delle vendite.
Gli acquisti possono essere definiti in percentuale.

Stampa con periodo di previsione
Grazie al fatto che nella tabella Preventivo sono stati inseriti movimenti con il codice di ripetizione o
con le date degli anni successivi, il programma è in grado di calcolare le previsioni per gli anni futuri.
Al momento della stampa del report indicare, nella sezione Periodo, la data inizio e fine.

Ammesso che la data inizio sia di il 1 gennaio 2022:

Se si vuole una previsione di 2 anni, indicare la data fine 31 dicembre 2024. 
Se si vuole una previsione di 5 anni, indicare la data fine 31 dicembre 2027. 
Se si vuole una previsione di 20 anni, indicare la data fine 31 dicembre 2042.

La possibilità di ottenere una previsione è disponibile per le seguenti stampe:
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Bilancio abbellito per gruppi
Report contabile
Scheda conto

Tutti i report contabili possono contenere i valori contabili, quelli di previsione o tutte e due assieme.
Le possibilità di parametrizzazione sono le stesse per i report contabili e per le previsioni.

Grazie a questi report si ottengono:

Bilanci previsionali
Conto economico previsionale
Piano della liquidità
Piano investimenti
Piano finanziamenti

e altro, per il periodo futuro che interessa.

Colonne con suddivisione per periodo
Nella sezione Suddivisione puoi indicare di creare delle colonne per il periodo.

Puoi così vedere l'evoluzione per mese, trimestre o anno.

Con le Personalizzazioni puoi impostare dei formati di stampa e richiamarle successivamente. Se si
fanno previsioni su più anni, è utile avere comunque delle personalizzazioni preimpostate,
complessive, per anno, 5 anni o con i confronti fra consuntivo e preventivo, che puoi richiamare
velocemente.

Bilancio - Previsione quadriennale

 Conto economico - Previsione quadriennale
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Movimenti di pianificazione

Per allestire le previsioni finanziarie, basate sul metodo della partita doppia, si inseriscono dei
movimenti nella tabella Preventivo. Per ognuno si indica il conto di provenienza e di destinazione. Il
programma ha le informazioni necessarie per allestire il bilancio e il conto economico che riguardano
il futuro e non il passato.

Quando si fanno pianificazioni con Excel, si parte impostando il conto economico, quindi elencando i
ricavi e i costi. Generalmente, solo in un secondo tempo e su fogli separati si allestiscono il piano della
liquidità e degli investimenti.
Quando si fanno previsioni con il metodo della partita doppia, si procede invece come se si tenesse
una contabilità del futuro. Si elencano tutti i movimenti che si prevedono accadranno. Sarà poi il
programma in automatico a preparare il bilancio e il conto economico, per il periodo indicato.

Strutturazione movimenti di preventivo
Per l'allestimento di un piano finanziario, si procede generalmente elencando i diversi elementi nel
seguente ordine:

Gli apporti di capitale proprio.
Gli apporti di capitale di terzi.
Le spese di costituzione.
Gli investimenti
In mobilio, apparecchiature.
I costi fissi ricorrenti
Affitto, personale, oneri sociali, energia, abbonamenti.
I ricavi ricorrenti.
I ricavi variabili.
La cifra d'affari, generalmente stagionale.
I costi variabili.
Commissioni, costi della merce venduta e altro, in relazione al volume dei ricavi previsti.
Le operazioni di fine anno
Ammortamenti, imposte, interessi su prestiti, dividendi.

Al momento che si inseriscono le vendite e i costi variabili, si ha già la struttura dei costi e di capitale.
Si conosce immediatamente se la cifra d'affari prevista permetterà alla ditta di generare utili e
liquidità sufficiente per garantirne la sostenibilità nel tempo.

Tabella preventivo con l'uso delle formule
Di regola per allestire un preventivo è sufficiente usare la colonna Importo.
Per dei preventivi più elaborati vi è la possibilità d'indicare anche quantità, prezzi unitari, oppure una
formula. Il programma calcolerà in automatico il valore nella colonna Importo.
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Aggiornamento delle previsioni
Con il metodo della partita doppia, grazie alla possibilità d'indicare ogni operazione in dettaglio,
diventa più facile aggiornare e migliorare la previsione. Inizialmente, si inseriscono le stime di diversi
costi o investimenti. Mano a mano che ci si avvicina alla fase operativa e ci sono dati più precisi,
basterà sostituire quelli esistenti.  Anche quando l'attività è iniziata e si conoscono elementi esatti, la
previsione potrà essere facilmente aggiornata. Si avranno indicazioni relativi alla redditività e alla
liquidità precisi e attendibili.

https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/formule_quantity_and_price.png
https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/formule_quantity_and_price.png
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Date e ripetizioni nei movimenti di
previsione finanziaria

La colonna Data
Il valore contenuto nella colonna Data è quello che fa stato per la previsione.

Se manca la data, il movimento sarà conteggiato all'inizio della pianificazione.
Se richiedi una previsione indicando un periodo, gli importi vengono conteggiati nel valore
saldo, all'inizio del periodo.
Per il fatto che non rientra nel periodo, non viene visualizzato alcun importo nella colonna
Totale.
Date nel periodo contabile, impostate nella proprietà file .
Sono quelle comunemente usate.
Nella colonna Totale viene indicato l'importo complessivo, tenuto conto dei movimenti ripetitivi,
nel periodo contabile.
Date precedenti al periodo.
Inserire movimenti che precedono il periodo di previsione. Bisogna però fare attenzione che
questi non vadano in conflitto con i saldi iniziali inseriti nella tabella conti.
Per il fatto che non rientra nel periodo, non viene visualizzato alcun importo nella colonna
Totale.
Date successive al periodo.
Le previsioni su più anni permettono d'indicare operazioni per gli anni a venire.
Per il fatto che non rientra nel periodo, non viene visualizzato alcun importo nella colonna
Totale.

La data fine
Viene usata in combinazione con la ripetizione, per indicare l'ultima data oltre la quale non ci deve
essere la ripetizione.

Generalmente deve essere vuota.
Se si inserisce una data quando non è necessario (per esempio la fine del periodo contabile) le
previsioni per gli anni successivi non includeranno questa operazione.
Per operazioni di leasing.
Indicare come data fine, la data in cui verrà effettuato il pagamento dell'ultima rata.
Per rimborso prestiti.
Indicare la data dell'ultimo versamento previsto.
Per cambiamenti di importo a scadenze prefissate.
Nel caso, per esempio, che l'importo di un'operazione ricorrente sia adeguato a determinate
scadenze (aumento stipendio):

Creare una riga di registrazione con ripetizione "M" e come data Fine, la data dell'ultimo
versamento prima dell'aumento.
Creare delle righe di registrazione con Data inizio, da quando inizia l'aumento.
Se l'aumento segue un automatismo preciso e regolare, può essere programmato anche
con delle formule.

http://www.banana.ch/doc/it/node/3810
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La ripetizione
Per spese o entrate ricorrenti si indica il codice di ripetizione (si veda la Documentazione sulle
colonne). 

Il programma quando calcola la previsione crea delle copie del movimento, incrementando
progressivamente la data e tenendo conto della frequenza indicata.
Se non vi è una data fine, il programma al momento del calcolo della previsione genera delle
copie interne delle registrazioni per tutto il Periodo della previsione indicato al momento del
report.

Se la data iniziale è gennaio, la frequenza è mensile:
Se il periodo di previsione è l'anno, genera righe a partire da febbraio. La prima riga
è quella originale inserita manualmente, le 11 righe sono  automatiche, per un
totale di 12 ripetizioni.
Se il periodo di previsione è 10 anni, genera righe a partire da febbraio. La prima
riga è quella originale, le 119 righe sono automatiche (11 il primo anno + 12 * 9 per
i successivi), per un totale di 120 righe.

Se si vuole che il programma calcoli in automatico le previsioni per gli anni successivi:
Per le operazioni ricorrenti, indicare il relativo codice di ripetizione.
Per le operazioni che accadono solo una volta all'anno (per esempio ammortamenti a fine
anno), indicare il codice di ripetizione "Y", in modo che l'ammortamento venga calcolato
anche negli anni successivi.
Non inserire la ripetizione unicamente se l'operazione non ci sarà nell'anno successivo.

Colonna Totale della tabella Preventivo
La colonna Totale viene calcolata in automatico e rappresenta la somma degli importi della riga
corrente con quelle di ripetizione che rientrano nel periodo della contabilità. La colonna Totale è vuota
se le operazioni hanno una data precedente o che va oltre il periodo della contabilità. 

Pianificazione con data precisa e logica mensile
Nella tabella Budget si inseriscono i movimenti di previsione, indicando la data in cui si prevede che
questi accadano.

Non è sempre possibile prevedere tutte le entrate e le uscite con precisione giornaliera. Quando si fa
una previsione è utile in certi casi approssimare, ragionando generalmente su base mensile. È
comunque utile seguire sempre una determinata logica in modo che si possano avere previsioni della
liquidità attendibili anche a corto termine:

Operazioni puntuali (versamento di capitale, investimenti) sono indicati con la data in cui si
prevede che accadano.
Se non vi è una data precisa, è utile indicarli il giorno 15 del mese in cui si prevede che
accadano.
Spese ricorrenti che hanno una data di pagamento precisa sono da impostare con la data
prevista di pagamento e il relativo codice di ripetizione:

Spese bancarie, interessi, ammortamenti sono da indicare alla fine del mese, trimestre o
anno che avvengono.
Affitti, il giorno di scadenza o la data in cui si prevede il pagamento.
Stipendi e oneri sociali:

Per il calcolo e il versamento mensile, il giorno che gli stipendi sono pagati. 
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Per le tredicesime, bonus o altro, il momento in cui sono pagati.
Versamenti per anticipi e conguagli di oneri sociali, la data prevista per il
versamento.

Versamenti e conguagli IVA, il giorno tipico di scadenza del pagamento.
Previsioni dei ricavi.
L'allestimento delle previsioni dipende dal tipo di attività.
Se non si sa il giorno preciso, ma si conoscono gli accadimenti in un certo mese, è utile indicare
il 15 del mese.

Entrate puntuali.
Sono da indicare nella data in cui si prevede l'entrata o metà mese.
Entrate ricorrenti.
Da indicare nella data in cui si prevede l'entrata o metà mese.
In molti casi si presta bene una previsione mensile. Si può indicare il ricavo al 15 del
mese.

Se le entrate sono ricorrenti si può inserire il ricavo con la ripetizione mensile.
Usando formule si possono prevedere delle crescite.
Se si conoscono delle differenze stagionali, è utile avere una riga di previsione delle
vendite per ogni mese,

Previsioni di progetti o grandi lavori.
Se vi è un calendario in cui ci sono indicati gli incassi, si indica una riga di registrazione
per ogni entrata prevista. Si può approssimare eventualmente indicando il 15 del mese.
Previsioni per i clienti:
Per un consulente o un commercialista, che lavora sia con anticipi che con progetti, può
essere molto utile allestire una previsione di entrate dettagliate per ogni cliente, con le
date di previsione dei versamenti. Questa previsione è molto utile anche per verificare se
il cliente ha effettivamente versato.

Costi variabili.
Consumo costante legato alla cifra d'affari (per esempio ristorante), i costi sono indicati
con la stessa data della cifra d'affari. Con una formula si può calcolare il valore in
percentuale della cifra d'affari.
I costi possono anche essere legati ad altri elementi, come il numero di dipendenti, locali
affittati o altro. 

Previsioni con il principio di cassa
Per le pianificazioni di piccole imprese e attività legate agli incassi (come negozi, ristoranti), è utile
ragionare con il principio di cassa, quindi indicando i ricavi con la data di quando avverranno gli
incassi e per i costi, la data di quando saranno pagati.

Per operazioni importanti, come per esempio l'acquisto di un macchinario, il cui pagamento è
dilazionato nel tempo, bisogna inserire dei movimenti di previsione con dettagli precisi:

Acquisto del macchinario (registrazione sul conto attivo e sul conto passivo fornitori) con data
dell'acquisto.
Pagamento del macchinario, con la o le date (rate) in cui si prevede il pagamento.

Previsioni con il metodo di competenza
In questo caso, per l'inserimento delle operazioni, si tiene conto della data di quando il pagamento
verrà effettuato.
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Operazioni a contanti.
Sono registrate normalmente.
Operazioni con previsione di pagamento a breve termine.
Per semplicità, per le operazioni con previsione di pagamento nell'arco di un mese può essere
utile usare il principio di cassa.
Pagamenti dilazionati.
Se le date non si conoscono con precisione si può usare il 15 del mese.

Operazioni con termini di pagamento precisi:
Con un movimento si indica la data di acquisto (con la contropartita il conto
fornitori).
Con gli altri movimenti si indica il pagamento alle date previste.

Incassi dilazionati. 
Con termini di pagamento precisi, come è il caso di un progetto:

Con un movimento si indica la data di fatturazione e con la contropartita il conto
clienti.
Con gli altri movimenti si indica il pagamento alle data previste.

Incassi in ritardo.
È il caso di quando una parte dei ricavi è incassata a breve, mentre una percentuale viene
incassata successivamente. Si può procedere in questo modo:

Inserire il ricavo come incasso a contante.
Con la stessa data si crea un movimento che sposta una parte dell'incasso sul conto
clienti.
In data successiva si indica quando avverrà l'incasso con contropartita il conto
cliente. 

Utilizzo di variabili per incassi e pagamenti dilazionati ( si veda Esempio uso di variabili)
Quando lo stesso valore deve essere riutilizzato al momento del pagamento, diventa molto utile
fare uso delle colonne formula e variabili:

Nel movimento di fatturazione, l'importo viene assegnato a una variabile.
Nel movimento di pagamento, si inserisce la variabile in modo che l'importo sia ripreso in
automatico.
Si possono usare variabili anche per definire, per esempio, la percentuale d'importo da
dilazionare.
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Esempi di movimenti di previsione finanziaria

I movimenti di pianificazione si inseriscono come delle normali registrazioni, con la data, la
descrizione, importo, conto Dare e Avere.

Inoltre, si usa la colonna Ripeti, che consente d'inserire le operazioni ricorrenti su una sola riga.

Qui di seguito sono elencati diversi esempi, ripresi dal modello che segue e, a cui si rimanda per
ulteriori spiegazioni.

Business plan e pianificazione finanziaria di una Startup (Contabilità in partita doppia)

Registrazioni di previsione inizio attività
Si tratta di registrazioni di previsione, registrate come quelle nella tabella Registrazioni.

L'esempio qui indicato è riferito all'inizio dell'attività, quindi riguarda operazioni che non si ripetono.

Registrazioni ripetitive mensili
Qui di seguito presentiamo degli esempi di registrazione con ripetizione mensile, codice "M". La
colonna Totale indica l'importo complessivo per l'anno.

Le prime due registrazioni si riferiscono all'affitto, che da febbraio a giugno è di 1'000 mensile, mentre
da luglio è di 1'200.

È indicata anche la data del 2024, quando si dovrà versare l'importo per il riscatto del leasing. In
questa riga, nella colonna Totale, non vi è alcun importo, perché il movimento non rientra nelle date
del periodo contabile definito nelle proprietà file.

Per le spese amministrative conteggiate dalla banca si è usato il codice ripetizione "ME" Fine mese
(Month End). Per le registrazioni successive non viene usato il giorno 28, ma l'ultimo giorno del mese,
quindi marzo 31, aprile 30.

https://www.banana.ch/apps/it/node/8082


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 747

 

 Fine trimestre
Qui indichiamo alcune registrazioni tipiche che si ripetono a fine trimestre. Inseriamo la ripetizione
3ME, che significa ripeti ogni 3 mesi, con data fine del mese.

Fine Anno
A fine anno ci sono delle operazioni. Qui usiamo il Ripeti "Y" in modo che queste operazioni vengono
eseguite anche per gli anni successivi.

Previsione ricavi e acquisti merce
La previsione dei ricavi è specifica a ogni attività. In questo caso, la previsione dei ricavi e degli
acquisti viene indicata mese per mese, con un importo specifico. 

A partire da marzo è indicata la ripetizione "Y" annuale, così che queste operazioni vengano ripetute
negli anni successivi.

https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/lucasbar_double_entry_budget_february_it.png
https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/lucasbar_double_entry_budget_february_it.png
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Acquisti e vendite anno successivo
I mesi di gennaio e febbraio, nel primo anno di attività, non erano considerati significativi per gli anni
successivi, quindi non avevano una ripetizione.
Per i primi due mesi del secondo anno dobbiamo impostare le vendite. Mettiamo anche la ripetizione
"Y" annuale, per poter ripetere i ricavi nell'anno successivo. 
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Previsioni con quantità e prezzo

Le colonne Quantità, Unità e Prezzo unitario della tabella Preventivo permettono di preparare più
velocemente delle previsioni. 

Il valore della colonna Importo viene calcolato dal programma moltiplicando la Quantità per il Prezzo
unitario (ammesso che la colonna Formula sia vuota).

Le colonne Quantità e Prezzo unitario sono impostate come visibili nella Vista Formula.

 

Vantaggi dell'uso delle colonna Quantità e Prezzi
Le colonne Quantità e Prezzo sono utili per fare previsioni in base ai quantitativi. Per esempio:

Nella colonna Unità, si può indicare a cosa si riferisce il prezzo.
Nella colonna Quantità, si indica il numero di coperti serviti giornalmente.
Nella colonna Prezzo, si indica il ricavo stimato per ogni coperto.
La colonna Importo verrà calcolata automaticamente in base ai valori indicati.

Con questo approccio si hanno diversi vantaggi:

Si possono dettagliare in modo preciso tutti gli elementi della pianificazione.
Si conoscono i quantitativi e i prezzi usati per fare la stima.
La modifica della pianificazione è molto semplice, occorre modificare solo l'elemento che si
desidera.
Si può verificare come varia l'utile con una variazione delle quantità vendute o del prezzo.
Analisi del break-even.

https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/formule_quantity_and_price.png
https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/formule_quantity_and_price.png
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Formule nella tabella Preventivo

L'inserimento di formule in Javascript nel Budget (tabella Preventivo) di Banana Contabilità Plus, apre
numerose possibilità.  

L'inserimento di formule nel Budget è possibile in Banana Contabilità Plus solo con il piano
Advanced. 
Guarda tutti i vantaggi del piano Advanced .

Colonna Formula
La colonna Formula della tabella Preventivo permette d'inserire delle formule di calcolo. Gli importi
di preventivo possono così essere calcolati in base a degli altri valori della stessa pianificazione (vedi
Esempi di formule). 

Indicare il costo della merce in base a una percentuale delle vendite.
Aumentare il budget delle vendite in base a una percentuale di crescita.
A fine anno, calcolare gli ammortamenti in base al valore degli investimenti effettuati.
Trimestralmente, calcolare gli interessi sul conto bancario in base all'utilizzo effettivo
(giorni/365).
Mensilmente, calcolare le imposte sull'utile in base all'utile effettivamente realizzato. 

Se si inserisce un valore nella colonna Formula, la colonna Importo viene calcolata dal
programma in base alla formula.

Come spiegato nella descrizione delle colonne della tabella Preventivo, puoi usare delle formule
Javascript anche:

Nella colonna Formula Begin
Nella colonna Descrizione, per le righe ripetitive.

File con esempi
Per informazioni su esempi in merito alle formule si rimanda alle seguenti spiegazioni:

Modello con registrazioni - uso delle colonne Quantità e Formula .
Modello con registrazioni - Contabilità multi-moneta con uso della colonna Formula per la
moneta base .
Esempi uso delle formule nelle previsioni finanziarie.

https://www.banana.ch/it/advanced
http://www.banana.ch/apps/it/node/8251
http://www.banana.ch/apps/it/node/8258
http://www.banana.ch/apps/it/node/8258
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Formule di calcolo in Javascript
La formula deve essere espressa nel linguaggio Javascript  (da non confondere con il
linguaggio Java).
Se vi è una formula (o un qualsiasi testo), il valore della colonna Importo viene impostato in
base al risultato della formula.
Si possono usare tutte le funzioni del linguaggio Javascript, più le API messe a disposizioni da
Banana.

Separatore di decimali
Come separatore di decimali, javascript usa unicamente il punto ".".

Se si usa un separatore diverso, quello usato per i numeri nel formato locale, è probabile che il
numero venga troncato.

Importo = risultato dell'ultima istruzione
In Javascript il punto e virgola ";" è usato per separare le espressioni.
Se la formula Javascript contiene più espressioni separate da ";", il valore della colonna Importo sarà
il risultato dell'ultima espressione eseguita.

10*3 //viene ritornato 30
Se vi sono più espressioni viene ripreso il risultato dell'ultima.
10*3;7; //Viene ripreso il 7.
Se vi è il return viene ripreso il valore dopo il return.
return 10; // viene ripreso il 10.

Variabili
Le variabili di Javascript  sono gli elementi più potenti della programmazione, in quanto permettono
di accedere alla memoria del computer con un nome, salvare e riprendere dei valori.
Le variabili non esistono nelle formule di Excel, ma sono simili al nome delle celle, con la differenza
che il nome può essere attribuito liberamente.

https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/formule_quantity_and_price.png
https://cdn.banana.ch/portal/repodata/ghba/FinancialPlanning/Italian/images/formule_quantity_and_price.png
https://it.wikipedia.org/wiki/JavaScript
https://www.w3schools.com/js/js_variables.asp
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La variabile viene creata indicando un nome e l'uguale (=).

È possibile definire e usare delle variabili direttamente all'interno delle righe. Scrivendo il nome della
variabile nella formula, il valore salvato viene ripreso.

Qui viene creata la variabile price e gli viene attribuito il valore 10.

var price = 10;

oppure anche semplicemente

price = 10;

qui seguito creiamo una variabile total a cui viene attribuito il valore price moltiplicato per 5.

total = price * 5;

Il valore della variabile può essere riassegnato.

price = 20;

Oggetti

Gli oggetti di Javascipt  sono delle variabili che permettono di salvare più valori, ognuno indicato con
una proprietà.
Qui di seguito viene creato l'oggetto prices, indicando le parentesi graffe {}. Per accedere e salvare i
valori si usano invece le parentesi quadre, oppure, si indica il nome della proprietà dopo il nome
dell'oggetto.

prices = {}
prices['car'] = 10;
prices.car = 10;
prices['computer'] = 20;
prices.computer = 20;

Array

Gli array di Javascript  sono delle variabili che contengono più valori, accessibili in sequenza.
Gli array si creano usando le parentesi quadre e anche per accedervi. Il primo elemento dell'array ha
indice 0.

costs = [1,2,3];

https://www.w3schools.com/js/js_objects.asp
https://www.w3schools.com/js/js_arrays.asp
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costs[0]=3;
result = prices['car'] - costs[0];

Ripetizione e variabili
Per maggiori informazioni sulla sequenza di calcolo vedi Logica della Pianificazione.

Tutte le righe (comprese quelle create per le ripetizioni) sono ordinate per data. Se ci sono righe
con la medesima data, l'ordine è quello d'inserimento nella tabella.
Dopo l'ordinamento, le righe (comprese le formule) sono ricalcolate.
Nelle formule si ha quindi accesso ai dati di budget solo fino a quella data.
Una variabile deve essere definita in una riga che ha la data che precede la riga dove viene
usata.
Se la registrazione di budget ha una ripetizione la variabile sarà riassegnata ogni volta.
sum =  10;
Se si vuole invece calcolare il totale complessivo.

In una riga iniziale creare la variabile con valore zero.
sum = 0;
Nella riga che si ripete nella somma includere anche il valore precedente.
sum =  sum + 10;
oppure usare il "+="
sum += 10

Variabili automatiche
budgetCurrent
È un oggetto che contiene la tabella con le righe di budget, successivamente alla creazione
delle ripetizioni.
Servono per riprendere i valori, in congiunzione con il JReapeatNumber.
DEBUG è una variabile che può essere "vera" o "falsa".
Se è "true", nei messaggi sono visualizzati tutti i risultati delle formule.
row
È un oggetto di javascript che fa riferimento alla riga corrente.

I valori delle celle possono essere ripresi con la funzione value ("columnNameXml").
row.value ("date") ritorna la data della registrazione. 
row.value ("JRepeatNumber") ritorna il progressivo della ripetizione.
La prima ripetizione è 0.

_totalPrice
È il valore della colonna Quantità moltiplicato per il Prezzo unitario.
Equivale alla formula "row.value('Quantity')*row.value('UnitPrice')"

Funzioni Budget
oltre alle API budget, definite nell'API della classe contabilità, ci sono delle funzioni specifiche.

budgetGetPeriod(tDate, period)

Questa funziona si usa in combinazione con la ripetizione.
Quando s'indicano delle ripetizioni è opportuno riferirsi ad un periodo di calcolo e non ad una data
precisa.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 754

Parametro tDate.
La data a cui si riferisce il calcolo del periodo. Di regola si usa la data della riga di registrazione.
Parametro Period.
Una sigla

Per il periodo corrente:
"MC" mese corrente
"QC" trimestre corrente
"YC" anno corrente.

Per il periodo precedente:
"MP" mese precedente
"QP" trimestre precedente
"YP" anno precedente .

A partire dalla versione 9.1 si possono usare anche:
"DC" giorno corrente
"DP" giorno precedente
"WC" settimana corrente
"WP" settimana precedente
"BC" bimensile corrente (2 mesi)
"BP" bimensile precedente
"SC" semestre corrente
"SP" semestre precedente

Valore di ritorno.
Un oggetto composto da due date

startDate
endDate 

// example
t = BudgetGetPeriod ('2015-01-01', 'MP') ritorna
t.startDate // 2014-12-01
t.endDate // 2014-12-31

Funzioni budget specifiche
Le funzioni che seguono sono simili a quelle disponibili con Banana.document, però possono essere
usate senza indicare l'oggetto Banana.document. 

Da tenere conto:

Invece del parametro startDate può essere usata una delle sigle periodo come "MC", "MP",
spiegate nel budgetGetPeriod.
Se si usa una sigla, la funzioni calcola la data iniziale e finale del periodo, in base alla data della
registrazione corrente.
Ha senso usare la data Fine solo se questa è precedente a quella della riga.
Se la data è uguale o superiore, comunque non ha effetto perché i valori successivi alla riga
attuale non sono ancora disponibili, perché non sono stati elaborati.
Se la data della riga di registrazione è il 15 aprile:

budgetBalance("1000","MP") ritorna il saldo del conto 1000 alla fine di marzo.
budgetBalance("1000","MC") ritorna il saldo al momento attuale, è lo stesso del
budgetBalance("1000").
budgetTotal("1000","QP") ritorna il totale del movimento per il trimestre precedente.
budgetTotal("1000","QC") ritorna il totale del movimento per il trimestre precedente, fino
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alla data attuale. 

budgetBalance(account, startDate, endDate, extraParam)

Il saldo fino alla riga attuale.

budgetBalance('1000', 'MP'); //ritorna il saldo del 1000 alla fine del mese
precedente

budgetOpening(account, startDate, endDate, extraParam)

Il saldo all'inizio del periodo.

budgetTotal(account, startDate, endDate, extraParam)

La differenza fra movimento dare e avere del periodo.

budgetTotal('1000', 'MC'); //ritorna il movimento totale del conto 1000 per
il mese corrente

budgetInterest( account, interest, startDate, endDate, extraParam)

Calcola l'interesse su un conto, per il periodo indicato (al massimo la data corrente)
Si usa per calcolare l'interesse su un conto a fine periodo. La riga dove è indicata la formula deve
essere sempre l'ultima per questa data.

Parametro account.
È il numero di conto sui cui movimenti verranno calcolati gli interessi.
Parametro interest.
Indica il tasso di interesse in percentuale:

positivo (2.5, 4, 10) calcola l'interesse sul movimento dare del conto.
negativo (-2.5, -4, -10) calcola l'interesse sul movimento avere del conto.

credit(importo)

Se il parametro importo è negativo, ritorna l'importo come valore positivo.
credit(-100) // ritorna 100.
Se il parametro importo è positivo, ritorna 0 (zero)
credit(100) // ritorna 0.

Questa funzione è utile in abbinamento alle altre funzione del budgetBalance per lavorare solo sui
saldi che servono.
Se si vuole calcolare la percentuale sulle vendite, usando questa funzione è più semplice.
credit(budgetTotal('1000')) // inserisce il valore solo se  è negativo.

debit(importo)

Se il parametro importo è positivo, ritorna l'importo.
debit(100) // ritorna 100
Se il parametro è negativo, ritorna 0 (zero)
debit(-100) // ritorna 0

Utile se si devono fare calcoli usando solo l'importo dare ed evitare di usare quello avere.
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Include

Include ed esegue un file javascript, con la possibilità di creare delle proprie funzioni e variabili che
possono essere richiamate nello script.

Include "file:test.js" 
Esegue il contenuto del file indicato. Il nome è relativo al file su cui si sta lavorando.
Include "documents:test.js" 
Esegue il contenuto del documento testo contenuto nella tabella documents.
Deve essere un file di tipo "text/javascript.

Funzioni per Contabilità multi-moneta

Si possono usare anche per contabilità senza multi-moneta, in questo caso il conto è sempre in
moneta base.

budgetBalanceCurrency(account, startDate, endDate, extraParam)

Il saldo nella moneta del conto fino alla riga attuale.

budgetExchangeDifference (account, [date, exchangeRate])

Questa formula richiama la funzione Banana.document.budgetExchangeDifference.
 

budgetOpeningCurrency(account, startDate, endDate, extraParam)

Il saldo nella moneta del conto all'inizio del periodo.

budgetTotalCurrency(account, startDate, endDate, extraParam)

A partire dalla versione 9.01 sono incluse anche le funzioni budgetCreditCurrency,
budgetDebitCurrency.

Funzioni definite dall'utente

L'utente può definire delle funzioni con il linguaggio Javascript e richiamarle nelle formule.
È possibile definire delle funzioni:

Direttamente in una formula. 
All'interno di un allegato del tipo codice javascript, indicato in un documento che ha come Id
linea, il nome "_budget.js"
All'interno di un testo nella tabella documenti, e incluso con il comando includi

Nota:
Nelle funzioni utente al momento non è possibile usare funzioni che accedono ai dati contabili correnti
(currentBalance, ...).

function calcTax(profit)
{
   var percentage = 10;
   if (profit> 50000)
      aliqpercentage = 10;
   else if (profit> 100000)



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 757

      percentage =20;
   return profit* percentage / 100;
}
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Esempi sull'uso delle formule nelle previsioni
finanziarie

La possibilità di inserire formule è disponibile in Banana Contabilità Plus solo con il piano
Advanced . Aggiorna ora !

Qui di seguito si accede agli esempi delle formule per automatizzare le previsioni finanziarie.
Si rimanda alla documentazione specifica:

Formule in Javascript nella tabella Preventivo
Modello con registrazioni con uso della colonna Quantità e della colonna Formula .

Parametri
Quando si procede a una pianificazione può essere utile definire delle variabili che si utilizzeranno
successivamente.
Bisogna creare una sezione parametri con una data registrazione al 1 gennaio, o altra data che
corrisponde al primo giorno della pianificazione. Le variabili parametri saranno poi usate nelle righe
successive.

// 30%
costOfGoodsSold = 0.3
// 5%
interestRateDebit = 0.05
// 2%
interestRateCredit = 0.02
// 10 %
latePaymentPercentage = 0.1

In questo modo si vedono subito tutti i parametri che si possono impostare. Quando viene modificato
un parametro, la previsione viene ricalcolata.

Ripetizioni o valori per mese

Utilizzando la colonna Ripeti, con una sola riga di registrazione si può pianificare tutto l'anno.

Se l'attività ha delle variazioni stagionali, è meglio inserire delle previsioni per mese. Per ogni mese si

https://www.banana.ch/it/buy
https://www.banana.ch/it/buy
https://www.banana.ch/it/update
http://www.banana.ch/apps/it/node/8251
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crea una riga con l'importo delle vendite del mese.
Se si desidera fare delle previsioni in automatico su più anni, è utile inserire sulla riga la ripetizione
"Y", così che la riga dell'anno serve anche per quello successivo.

Prezzi e quantità di vendita

Quando si crea un piano delle vendite, è più facile inserire dei valori usando la colonna quantità e
prezzo. Per esempio, un ristorante può inserire il numero di coperti serviti al giorno, alla settimana o
al mese e il programma calcola in automatico l'importo. Variando il numero di coperti o il prezzo si
vede immediatamente l'impatto sulla liquidità e sul risultato d'esercizio.

 Uso di formule con variabili per la crescita

Quando si usano le formule, ricordarsi che sono espresse nel linguaggio Javascript:

La variabile deve essere definita prima di essere usata, quindi la riga in cui viene definita deve
avere la data inferiore alla riga dove viene usata.
Nei numeri non si possono usare separatori di migliaia.
Il separatore decimale è sempre il punto ".".
I nomi sono diversi per maiuscolo/minuscolo.

Si può attribuire un valore a una variabile (il nome si sceglie liberamente) e inserire il nome della
variabile nelle righe successive per riprendere il valore.
Cambiando il valore assegnato alla variabile si modificano in automatico tutte le righe dove viene
usata la variabile.

All'inizio si può impostare, per esempio, il valore delle vendite previsto e nei mesi successivi, usare
una formula per incrementare l'importo.

Crea una variabile dal nome "S" (sales), inserendo il seguente testo nella colonna Formula.
Sales=1000
Nell'Importo sarà inserito il valore 1000.00.
Nelle righe successive usare la variabile, inserendo semplicemente nella formula il nome della
variabile:
Sales
Nell'Importo sarà inserito il valore 1000.00.
Potete aggiungere 10% all'importo (moltiplicando per 1.1)
Sales*1.1
Nell'Importo sarà inserito il valore 1100.00.
Puoi aumentare il valore di s
Sales=Sales+200
Nell'Importo sarà inserito il valore 1200.00.
Se nella riga successiva usi la variabile, ci sarà il nuovo valore
Sales
Nell'Importo sarà inserito il valore 1200.00.

Si può anche definire una variabile per definire la percentuale di crescita.

Percentage=1.1
Amount=200
Nelle formule si può usare il nome della variabile invece del numero:

Sales*Percentage
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Sales=Sales+Amount.

Variabili e ripetizioni

Ammettiamo di prevedere che la cifra d'affari aumenti del 5% ogni mese.

Inserire due righe dove assegnare il valore alla variabile, senza mettere nessun conto con la
data di inizio anno
Sales=1000
Increment=5.
Creare poi una riga con la ripetizione dove inserire i conti e la formula
Sales=Sales*(1+Increment/100).

Ogni volta che la riga viene ripetuta, il valore della variabile S risulterà aumentato del 5% e di
conseguenza anche l'importo della registrazione.
Cambiando semplicemente la percentuale di crescita, la previsione sarà ricalcolata.

In una riga si possono inserire anche più istruzioni Javascript, separandoli con il punto e virgola ";"
Sales=1000; P=5.

Uso delle formule budget

Ci sono funzioni che permettono di accedere ai saldi e ai movimenti dei conti per la pianificazione fino
alla riga che viene calcolata.
Si può inserire una formula che, tramite la funzione budgetTotal, recupera il valore del conto vendite
SALES del mese precedente.

credit( budgetTotal("SALES", "MP") )

La funzione budgetTotal prende come argomenti il numero di conto e il periodo. Al posto del periodo
si può usare una sigla.

MP sta per mese precedente.
QP sta per trimestre precedente.

I ricavi sono in Avere, quindi il valore ritornato dalla funzione è negativo e non viene accettato come
importo nella contabilità in partita doppia.
Si usa quindi la funzione credit(), che prende il valore negativo e lo mette in positivo.

Variabili per vendite mensili
Le vendite possono essere diverse per ogni mese. In questo caso è necessario usare delle
registrazioni separate per ogni mese con il nome della variabile.

sales_01 = 1000
cost_01 = sales_01 * costOfGoodsSold
sales_01 = 1100

Pagamenti dilazionati
Se si vuole un piano della liquidità molto preciso occorre separare le vendite che sono pagate subito
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da quelle dilazionate.
Un approccio può essere quello di registrare tutte le vendite come se fossero pagate in contanti,
assegnando all'importo il valore della variabile mensile.

sales_01 = 1000

Viene poi inserita una registrazione che storna le vendite dilazionate, calcolando l'importo con la
formula.

sales_01 * latePaymentPercentage

Nel mese successivo verrà quindi inserita una registrazione di pagamento con la stessa formula.

 Costi di vendita
Ci sono costi che possono essere in relazione alle vendite (costo merce), oppure, a degli altri costi
(oneri sociali, in relazione agli stipendi).

Calcolo costi con variabili

Se le vendite sono definite con delle variabili, anche i costi di vendita possono essere indicati in
percentuale delle vendite.

Puoi definire la variabile S per le Vendite e la variabile C per la percentuale del costo.
Sales=1000
Cost=60
La formula per il calcolo:
Sales*Cost/100.

Lo stesso approccio si può usare anche per calcolare gli oneri sociali.
Questa formula può essere eventualmente inserita in una riga ripetitiva.

Calcolo costi di vendita con funzioni budget

Quando i costi sono in relazioni alle vendite si può usare anche la formula budget.

credit( budgetTotal("SALES", "MC") )*60/100

La sigla periodo "MC" sta per mese corrente.
Questa formula ritorna il valore delle vendite del mese corrente, li trasforma in positivo e le moltiplica
per 60 e divide per 100.

La data deve ovviamente essere oltre le date di registrazione delle vendite.

Si può usare in una riga di ripetizione, inserendo la data fine mese. In automatico quindi i costi della
vendita vengono calcolati in base alle vendite inserite con delle registrazione.

La formula può essere combinata con delle variabili.

All'inizio dell'anno definire la percentuale dei costi.
Cost=60
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Nella formula si usa quindi la variabile C
credit( budgetTotal("SALES", "MC") )*Cost/100.

Quando si cambia la percentuale di contribuzione o una qualsiasi vendita, la pianificazione risulta
aggiornata automaticamente.

Calcolo commissioni di vendita alla fine dell'anno

Alla fine anno con questa formula è possibile calcolare le commissioni del 5 % sul totale delle vendite
nette:

credit( budgetTotal("SALES", "YC") )*5/100

La funzione bugetTotal ritorna il movimento del conto vendite per il periodo "YC", anno corrente.
Con la funzione credit(), l'importo viene messo in positivo e poi moltiplicato per 5 e diviso per 100.

Se devono essere fatte delle previsioni su più anni, ricordarsi d'inserire nella riga la ripetizione "Y",
così che la stessa formula verrà ripresa anche per l'anno successivo.
Come indicato prima, invece d'inserire il 5 direttamente nella formula, si può assegnarlo con una
variabile.

Commission=5
credit( budgetTotal("SALES", "YC") )*Commission/100

Se la percentuale cambia da un anno all'altro, è sufficiente inserire, con data anno successivo, una
registrazione che reimposta la variabile della commissione.

Inflazione con le variabili
Se si vogliono delle previsioni su più anni si può tenere conto anche dell'inflazione.

All'inizio della pianificazione assegnare una variabile alla base per i prezzi e all'inflazione (2%).
Base=1;Inflation=2.
Quando usi la variabile Sales la moltiplichi per l'inflazione
Sales=Sales*Base.
All'inizio dell'anno successivo, con ripetizione annuale, aumenti la base dei prezzi
Base=Base+Base*Inflation/100.

 Calcolo ammortamenti
Grazie alle formule si può automatizzare il calcolo degli ammortamenti.
Se nella pianificazione, cambi il valore degli investimenti, gli ammortamenti saranno ricalcolati in
automatico. Fare attenzione che la data della riga del calcolo degli ammortamenti abbia una data
superiore a quella degli investimenti. Di regole è il 31 dicembre.

Calcolo ammortamenti sul valore contabile

Per calcolare gli ammortamenti del conto EQUIPMENT, inserire a fine anno una riga con i conti Dare
e Avere, impostati per registrare l'ammortamento e la seguente formula:

budgetBalance("EQUIPMENT")*20/100
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La funzione budgetBalance ritorna il saldo a quel momento e su questo viene poi calcolato
l'ammortamento del 20%.

Usare la funzione debit, nel caso che il conto degli attivi possa andare in avere.

debit(budgetBalance("EQUIPMENT"))*20/100.

Calcolo ammortamenti sul valore iniziale

Per il calcolo sul valore iniziale degli investimenti, è necessario usare delle variabili, per ricordare il
valore degli investimenti iniziali. 

Equipment=10000

Se l'ammortamento viene dilazionato su 5 anni, si inserisce la formula nella riga dell'ammortamento
di fine anno.

Equipment=10000/5

Nella riga inserire la ripetizione annuale "Y" e anche la data Fine, che corrisponde alla data dell'ultima
rata dell'ammortamento, per evitare che l'ammortamento continui in modo indefinito.

Per ogni investimento si crea una variabile e una riga apposita di ammortamento. Nei nomi delle
variabili si possono anche inserire i numeri.

Equipment1=10000
Equipment2=5000.

 Calcolo interessi
La funzione budgetInterest( account, interest, startDate, endDate) consente di calcolare in
automatico l'interesse sulla base dell'utilizzo effettivo di un conto.
I parametri sono i seguenti:

Conto
I cui movimenti sono usati per calcolare gli interessi, nel caso di un conto corrente bancario o di
un prestito.
Interesse
Il tasso di interesse in percentuale.
Se il valore è positivo si calcolano gli interessi sui saldi dare.
Se il valore è negativo si calcolano gli interessi sui saldi avere.
Data iniziale, può essere anche una sigla.
Data finale, può essere anche una sigla.
Il valore ritornato è l'interesse calcolato per i giorni 365/365.

Interessi passivi sul conto bancario

Per calcolare gli interessi passivi del 5%, inserire una riga con la data di fine trimestre e la ripetizione
"3ME", che contiene la formula 

budgetInterest( "Bank", -5, "QC").

Il tasso d'interesse è negativo, perché il periodo "QC" significa trimestre corrente. I conti Dare e Avere
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devono essere quelli usuali per la registrazione degli interessi passivi. Se l'interesse diminuisce il
saldo del conto bancario, si userà anche nella registrazione. Si può usare un altro conto se viene
pagato con un altro conto.

È importante usare la ripetizione "3ME" affinché la data usata sia sempre l'ultima del trimestre.

Per calcolare gli interessi del mese usare la sigla "MC"

budgetInterest( "Bank", -5, "MC").

Interessi attivi sul conto bancario

Per gli interessi attivi del 2% usare invece l'interesse in positivo.

budgetInterest( "Bank", 2, "QC")

Interessi su conto prestiti a scadenza fissa

Peri  prestiti a scadenza fissa, il calcolo e la registrazione dell'interesse avviene alla data specificata.

Creare un conto diverso per ogni prestito.
Si usa la funzione budgetInterest, indicando esattamente la date d'inizio e di fine. 
Se la data è indicata come testo, si deve usare la notazione "yyyy-mm-dd", quindi
"2022-12-31".
Usare le variabili.
Come indicato per gli ammortamenti, si può assegnare il montante del prestito a una variabile.
Il calcolo degli interessi viene fatto con una formula di calcolo Javascript, 

Definire la variabile prestito
Loan=1000.
Calcolo interessi del 5%, per 120 giorni.
Loan*5/100*120/365.

Calcolo imposte sull'utile
L'utile è il totale del movimento del gruppo utile per il periodo.
Per calcolare un'imposta del 10% sull'utile, usare la formula.

credit(budgetTotal("Gr=Result","MC"))*10/100

La funzione budgetTotal nel parametro gruppo "Gr=Result", indica che invece di calcolare il
movimento di un conto, calcola quello del gruppo.
Come periodo è indicato MC, mese corrente.
La funzione budgetTotal  ritornerà un valore positivo se vi è una perdita e negativo (avere) se vi
è un utile.
La funziona credit tiene conto solo dei valori negativi, quindi se vi è una perdita l'imposta
risulterà zero.

Pagamenti differiti o con scadenze diverse
Per i pagamenti differiti o con scadenze diverse si può procedere in due modi:

Usare delle variabili a cui assegnare l'importo del pagamento.
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Usare la variabile in questione, quando si effettua la registrazione del pagamento.
Creare dei conti clienti o fornitori per le diverse scadenze dei crediti.

Altri casistiche
Preghiamo di segnalarci altre vostre esigenze, in modo da aggiungere altri esempi.
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Piano conti per Preventivo

Personalizzare il piano dei conti
Nella tabella Conti o Categorie viene disposto il Bilancio e il Conto economico, con i conti e i gruppi
di totale.
Le colonne degli importi sono aggiornati dal programma, per cui la tabella dà un'idea immediata della
situazione finanziaria attuale e anche della situazione di preventivo, in quanto accanto ad ogni conto
e gruppo è visualizzato il saldo del conto, il movimento, il preventivo e altre informazioni importanti.
Con un click viene visualizzata la scheda del conto.

Il piano dei conti viene allestito secondo le necessità dell'utente. In qualsiasi momento si possono
inserire nuovi conti e gruppi, cambiarne il numero o la descrizione e o anche cancellarli.

Per una pianificazione si inizia normalmente con pochi conti e se ne aggiungono dei nuovi quando si
reputa utile avere maggiori dettagli. 
 

Colonne del piano dei conti per il preventivo

Colonna Apertura

Nella colonna Apertura della tabella Conti si indica il saldo all'inizio del periodo contabile. Il saldo
d'apertura serve:

Come saldo iniziale per la contabilità (tabella Registrazioni)
Come saldo iniziale per i dati di preventivo (tabella Preventivo).

Colonna Preventivo

Se non vi è la tabella Preventivo, la colonna Preventivo del piano dei conti è modificabile, e serve
per inserire il preventivo dell'anno corrente in forma tabellare.

Se vi è la tabella Preventivo, la colonna Preventivo del piano dei conti è protetta, e i valori sono
calcolati automaticamente sulla base dei movimenti di preventivo, per il periodo contabile definito
nella contabilità. Il valore contenuto nella colonna Preventivo è il saldo alla fine, quindi comprende
sia il saldo iniziale che il movimento del periodo.
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Pianificazione con maggiori dettagli

Nel piano dei conti si possono impostare diversi tipi di conto. Nell'immissione dei movimenti si
possono indicare gli importi in dettaglio per:

Conti clienti e fornitori
Utili per avere una pianificazione specifica per ogni cliente, con la relativa cifra d'affari e i costi
collegati.
Centri di costo e profitto
Per una pianificazione dettagliata di un progetto particolare o delle vendite effettuate dai singoli
agenti.
Segmenti
Per avere dei conti perdite e profitti per Dipartimento, Succursale o altro.
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Pianificazione separata dalla contabilità

Preparazione del file
Se nel file della contabilità la tabella Preventivo non è visibile, procedere con la visualizzazione dal
menu Strumenti → Aggiungi Tabella Preventivo .

La tabella Registrazione rimane comunque preimpostata, se non la si vuole, usare il menu Dati →
Disponi tabelle e indicare la tabella Registrazioni come non visibile.

Il procedimento è lo stesso sia che si gestisca solo una contabilità, una pianificazione o entrambe:

Creare un file di contabilità.1.
Impostare le proprietà file.2.
Impostare il piano dei conti.3.
Inserire saldi iniziali (se ci sono).4.
Inserire nella tabella Preventivo i valori della previsione.5.

Normalmente, nel medesimo file di Banana Contabilità, si esegue la contabilità e la pianificazione.  Se
si desidera gestire la Pianificazione separatamente dalla contabilità, basta inserire le Registrazioni
unicamente nella tabella Preventivo. La tabella Registrazioni, per la registrazione dei movimenti, in
questo caso si lascia vuota.

Quando avere un file unicamente con la Pianificazione:

Per impostare la Pianificazione di una Startup:
Preparare i piani finanziari di una nuova ditta, non ancora avviata.
Inizialmente, se non si hanno idee precise, può essere utile usare un modello con pochi
conti, senza IVA.
Se si prevede di tenere anche la contabilità, è utile iniziare con uno dei nostri piani
contabili già impostati.

Per una ditta esistente che tiene la contabilità con un altro programma:
Il piano dei conti sarà modellato su quello usato per la contabilità.
Per fare il confronto con i dati consuntivi ci sono tre possibilità:

Esportare i dati di Preventivo da Banana Contabilità e importarli nel proprio
programma contabile.
Nel caso in cui si voglia fare un confronto tra la Previsione creata nel file di Banana
Contabilità e i dati consuntivi che si trovano invece nel proprio programma, si
devono esportare i dati ed importarli nel file di Previsione (tabella Preventivo di
Banana Contabilità).
Creare delle tabelle Excel e riportare i dati della Previsione di Banana Contabilità e
quelli della contabilità presenti nel proprio programma.

Maggiori informazioni sulle registrazioni di Previsione sono disponibili ai seguenti link:

Aggiungere la previsione
Tabella Preventivo
Metodo partita doppia
Periodo di previsione.

http://www.banana.ch/doc/it/node/9356
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Periodo di pianificazione
Non è necessario definire il periodo di pianificazione. Si può allestire la pianificazione per un anno e
ottenere comunque delle previsioni per gli anni successivi.

Pianificazione annuale

Di regola la pianificazione è allestita per il periodo contabile definito nella Proprietà del file, che
generalmente corrisponde all'anno solare.

Nella colonna Apertura della tabella Conti si inserisce il saldo di apertura all'inizio del periodo.
Nella tabella Preventivo si inseriscono i dati della pianificazione per l'anno corrente.

Quando si richiedono dei Report, se non viene specificato un periodo diverso da quello presente nelle
Proprietà file, il programma utilizza il periodo della contabilità.

Quando si vuole fare la pianificazione dell'anno successivo, si crea un file per il nuovo anno. Il
programma riporta le registrazioni di preventivo, che poi possono essere modificate (vedi Passaggio a
nuovo anno).

Pianificazione su più anni

Con Banana Contabilità è possibile eseguire la pianificazione su più anni. Il periodo di pianificazione è
libero e viene impostato al momento che viene richiesto il report.

Per una pianificazione su più anni, generalmente si procede impostando il periodo per il primo anno
ed estendendolo poi negli anni successivi.

Tecnicamente si procede come se si facesse una pianificazione annuale, ma estesa negli anni
successivi:

Nelle Proprietà file si indica come data inizio e fine, la data del primo anno (che generalmente  è
l'anno solare).
Si inseriscono i saldi d'apertura nel piano dei conti.
Nella tabella Preventivo si inseriscono i movimenti della pianificazione:

Le operazioni che sono specifiche solo al primo anno si indicano senza ripetizione.
Per tutte le altre operazioni, che si presume si ripetano anche negli anni successivi, si
indica il codice di ripetizione.
Le operazioni che avvengono una sola volta all'anno si indicano con la ripetizione "Y"
annuale. Per esempio come nel calcolo degli ammortamenti che viene fatto alla fine
dell'anno.
Le operazioni specifiche agli anni successivi sono indicati con la rispettiva data in cui
avvengono.
Per le operazioni ripetitive che sono limitate a un solo anno o a un periodo preciso
(operazioni di leasing con durata fissa) si indica la data di Fine periodo. Oltre questa data
non viene più fatta alcuna ripetizione.
Le formule possono essere usate per fare in modo che l'importo delle righe di ripetizione
si adegui automaticamente:

Il calcolo degli ammortamenti può basarsi sul saldo del conto immobilizzazioni.
Il calcolo degli interessi può essere fatto direttamente sul movimento del conto
bancario.
Si può specificare una progressione delle vendite.
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Gli acquisti possono essere definiti in percentuale al costo.
Per ottenere la pianificazione (Report Bilancio abbellito o con Bilancio abbellito con Gruppi,
Scheda conto) si indica la data inizio e di fine periodo della previsione richiesta.

Passaggio all'anno nuovo

La funzione di Banana Contabilità per Creare un nuovo anno riporta anche le registrazioni della
Pianificazione.

Su ogni riga si ha la possibilità di indicare se l'operazione deve essere riportata o meno, e se la
data originale deve essere mantenuta o sostituita con quella del nuovo anno.
Creare il budget per il nuovo anno è molto semplice, perché si tratta di modificare unicamente
le voci di spesa e di entrata che si prevede cambieranno.
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Stampe e report previsioni finanziaria

Ci sono diverse modalità per accedere ai dati della previsione finanziaria. Puoi ottenere tutte le
informazioni che ti interessano cliccando sui seguenti link:

Bilancio previsionale
Conto Economico
Piano liquidità
Previsione vendite
Previsioni clienti
Previsioni fornitori
Piano investimenti
Piano finanziamenti
Pianificazione progetti
Pianificazione settori

Tabella Preventivo - colonna Totale
La colonna Totale contiene l'importo totale di preventivo per il periodo contabile, indicato nelle
proprietà del file in base alla data Inizio e Fine della contabilità.

Per maggiori informazioni si veda Colonne della tabella Preventivo e Date e ripetizione.

Grafico evoluzione - Finestra Grafici
Da qualsiasi tabella, nella finestra grafici, posizionandosi con il cursore sulla cella del conto o del
gruppo, si vede immediatamente l'evoluzione del saldo.
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Colonna Preventivo nella tabella Conti e Categorie
Nella tabella Conti e Categorie sono indicati i valori aggiornati di preventivo, per il periodo contabile
indicato nelle proprietà del file in base alla data Inizio e Fine della contabilità.

Colonna Preventivo
Indica il totale di preventivo del conto per il periodo contabile.
Il valore indicato è comprensivo del saldo iniziale e dei movimenti di preventivo per il periodo.
Colonna Preventivo Differenza
Indica la differenza fra la colonna Preventivo e Saldo.

Scheda conto con movimenti di preventivo
Con il comando Scheda conto , oppure nella tabella Preventivo, cliccando sul bottoncino accanto al
conto, si ottene un dettaglio con tutti i movimenti previsionali.

Nel dialogo Scheda conto puoi scegliere di visualizzare i movimenti dei seguenti elementi:
Conto, Centro di costo, Gruppo o Segmento.
Dati correnti e o quelli di preventivo.
Nella Sezione Periodo puoi indicare il periodo di calcolo. Se si sceglie una data Fine, oltre
la data della contabilità, il programma crea in automatico una proiezione dei dati indicati.

Aprendo la scheda conto dalla tabella Preventivo viene visualizzata la scheda dei movimenti di
preventivo.

http://www.banana.ch/doc/it/node/2726


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 773

Bilancio abbellito con gruppi
Tutte le stampe che hai a disposizione per la contabilità possono includere le previsioni finanziarie.

È sufficiente rendere visibili le colonne Preventivo e Differenza preventivo.
Nella Sezione Periodo, indicare il periodo di previsione desiderata.
Si può indicare anche un periodo di più anni e il programma calcola e visualizza
immediatamente la previsione.
Nella Sezione Suddivisione si può indicare di visualizzare i dati per mese, trimestre, anno,
oppure scegliendo un segmento.

Guarda il video tutorial  che mostra come creare e stampare il bilancio abbellito con gruppi.

Tutte le personalizzazioni disponibili nella contabilità sono applicabili anche per la pianificazione:

Scegliere il livello di raggruppamento desiderato.
Presentazione con i dettagli di conto o solo con i gruppi.
Scelta delle sezioni da includere.
Si può stampare solo il Bilancio, Conto Economico, Centri di costo.
Scelta del periodo contabile.
Se si sceglie un periodo contabile oltre la data della contabilità, il programma provvede

https://www.banana.ch/it/node/11490
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automaticamente a creare le proiezioni fino alla data indicata.
Suddivisione per periodo (mensile, trimestrale, semestrale, annuale).
Vengono create delle colonne per ogni frequenza e una di totale per l'intero periodo scelto. 
Combinando il periodo di calcolo e la frequenza si possono creare report ad hoc:

Indicando il periodo di 1 anno senza suddivisioni si ha la previsione per l'anno.
Indicando il periodo di 1 anno con suddivisione trimestrale si ha una stampa con le
colonne per ogni trimestre.
Indicando il periodo di 6 mesi con suddivisione mensile si vede in dettaglio l'evoluzione
mese per mese.
Indicando il periodo di 5 anni con suddivisione annuale si hanno le colonne con
l'evoluzione per i 5 anni.

Confronto fra valori correnti e preventivo.
Aggiunta di altre colonne.
Cambio dello stile di stampa.
Salvataggio Personalizzazione di stampa.
Le impostazioni di stampa possono essere salvate come una personalizzazione ed essere
riprese successivamente.
Si possono creare quante Personalizzazioni si desiderano.
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Conto Economico previsionale

Il Conto economico previsionale presenta i ricavi, i costi e il risultato d'esercizio ad una data futura. È
uno strumento importante di conduzione aziendale perché permette di capire come si evolverà la
situazione dal punto di vista economico e finanziario.

Con Banana Contabilità, grazie alla previsione con il metodo della partita doppia, si possono avere
conti economici previsionali completi, da disporre in diversi modi. Il programma calcola le previsioni
anche su più anni.
Si ha una visione molto precisa di quella che sarà l'evoluzione economica.
La struttura del Conto economico previsionale è la medesima di quella usata per la contabilità. In
sede di stampa si possono indicare quali valori visualizzare, solo quelli di consuntivo, solo quelli di
preventivo oppure entrambi.

I valori di previsione sono calcolati tenendo conto dei saldi d'apertura e dei movimenti di previsione
indicati nella Preventivo. Quando si cambia un movimento di preventivo, le previsioni vengono subito
aggiornate. Si possono fare delle simulazioni, spostare una vendita, modificare i costi e vedere come
cambia il conto economico nel tempo.

I valori di previsione di conto economico possono essere visualizzati in diversi modi.

Utilizzo delle quantità e delle formule
Le Colonne quantità e prezzo della tabella Preventivo permettono di allestire previsioni più realistiche,
utilizzando la stessa metodologia dei fogli elettronici. Le simulazioni risultano così più veloci. È
sufficiente cambiare il prezzo e in automatico si hanno le nuove previsioni di conto economico e
anche quelli del bilancio e della liquidità. 

Le formule permettono di automatizzare i Calcoli dei costi, in modo tale che, quando per esempio si
modificano le vendite, i costi di acquisto si modificano in percentuale. In questo modo si ottengono
previsioni di conto economico precise, che si aggiornano in automatico. Le formule sono
particolarmente utili quando si fanno previsioni su più anni.

Previsioni dettagliate
La previsione del Conto economico, basata sul metodo della partita doppia, consente di ottenere dei
report previsionali dei costi e dei ricavi, usando gli stessi conti e gruppi della contabilità.  La stessa
struttura delle poste che compongono il Conto economico è utilizzata per la previsione. In automatico
sono disponibili i valori e i report per vedere in dettaglio, giorno per giorno, come si evolve la
situazione economica.

La struttura del piano contabile, su cui si basa anche la previsione, è personalizzabile; può essere
molto semplice con i gruppi principali e i conti che ne fanno parte, o più complessa, inserendo anche
dei sottogruppi, per una visione più dettagliata.

La struttura del Conto economico è a forma scalare e consente di visualizzare il risultato d'esercizio
intermedio e quello finale, dopo il pagamento delle imposte.

CONTO ECONOMICO
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Ricavi.
Costi della merce.

Risultato operativo lordo (totalizzazione dei Ricavi e dei Costi).

Costi del personale.
Costi generali.

Risultato operativo (totalizzazione del Risultato operativo lordo, Costi del personale e
Costi generali).

Costi finanziari.

Risultato ordinario (Totalizzazione Risultato operativo e Costi finanziari).

Ammortamenti.

Risultato prima delle imposte (Totalizzazione Risultato ordinario e Ammortamenti).

Imposte e tasse

Risultato netto d'esercizio (totalizzazione del Risultato prima delle imposte e Imposte e
tasse).

Tabella Conti/Categoria
Nella tabella Conti , per la Contabilità in partita doppia, e nella tabella Categorie per la Contabilità
entrate / uscite, colonna Preventivo, si hanno i valori di previsione per tutti i conti (o categorie) e i
gruppi del conto economico. Con un colpo d'occhio si ha una visione immediata del conto economico
previsionale.  I valori sono riferiti al periodo contabile e gli scostamenti sono riferiti rispetto al saldo
attuale.

Se si ha la necessità di avere maggiori dettagli, si possono aggiungere dei conti o dei gruppi.

Conto economico con gruppi
Con il comando Bilancio Abbellito con gruppi si visualizza il Conto economico previsionale, scegliendo
la modalità di presentazione più congeniale.

http://www.banana.ch/doc/it/node/3826
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Nelle opzioni Sezioni indicare di voler visualizzare i valori di Preventivo.
Si possono visualizzare i valori correnti (contabili), quelli di preventivo assieme o
singolarmente. 
Impostare il Periodo.
Se si indica un periodo che va oltre quello contabile, il programma genera in automatico
previsioni su più anni.
Indicare la Suddivisione per periodo  che si desidera.
Nella opzioni Righe si possono escludere i conti e avere una visualizzazione solo dei gruppi.
Se l'impostazione fatta sarà utilizzata per il futuro si consiglia di creare una Personalizzazione.

Utilizzando le diverse opzioni si possono personalizzare le stampe. Qui di seguito sono indicati alcuni
esempi.

 Conto economico annuale Preventivo

Questa stampa è stata impostata con solo i valori di preventivo per l'anno corrente.
Si può visualizzare anche la variazione come importo e percentuale.

 Conto economico annuale Preventivo e Corrente

I valori di consuntivo (corrente) sono confrontati con quelli di preventivo.

http://www.banana.ch/doc/it/node/3265
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Conto economico Preventivo trimestrale

Nella sezione Suddivisione impostando il trimestre, il programma mostra il Conto economico
previsionale per i diversi trimestri.
Si vede l'evoluzione del bilancio previsto durante l'anno.

Conto economico Preventivo e Corrente trimestrale

Questa stampa è impostata per stampare il preventivo e il consuntivo. Si ha quindi la situazione
prevista e corrente per i trimestri.
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Conto economico Preventivo triennale
Se si inseriscono i movimenti di previsione con il codice di ripetizione, il programma è in grado di
allestire previsioni oltre il periodo definito. Per ottenere delle previsioni su più anni, si inseriscono i
movimenti nella tabella Preventivo con la ripetizione (Y).

La stampa è impostata per ottenere il preventivo del conto economico su tre anni.

Report Contabile Conto economico Preventivo
Con il comando Report Contabile si possono ottenere delle stampe di Conto economico con i valori in
colonne come nella tabella Conti.
Le opzioni sono simili a quelle spiegate per il Bilancio abbellito per gruppi.
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Piano della liquidità

Cash is King è il motto che indica quanto sia importante la liquidità. È il motore principale per
svolgere le attività aziendali, far fronte agli impegni e produrre utile. Per investire in tutta sicurezza, è
fondamentale valutare con razionalità la capacità di produrre liquidità e la sua evoluzione nel tempo.

La previsione finanziaria di Banana Contabilità è uno strumento di conduzione aziendale importante,
che permette di capire se ci saranno i mezzi finanziari a sufficienza per fare fronte agli impegni e
ridurre al massimo la propria esposizione debitoria.
Le proiezioni della liquidità sono calcolate sulla base del saldo iniziale e delle previsioni inserite nella
nella tabella Preventivo. Quando si cambia un movimento di preventivo, le previsioni sono subito
aggiornate. Si possono simulare scenari diversi, spostare un pagamento, aggiungere un investimento,
modificare le vendite e vedere come evolverà la liquidità.

I valori della liquidità possono essere visualizzati in diversi modi.

Tabella Conti
Nella tabella Conti si impostano i conti e gruppi della liquidità. Nella colonna Preventivo figurano i
saldi aggiornati della previsione per il periodo contabile. Con un colpo d'occhio si conosce quale sarà
la situazione della liquidità alla fine dell'anno.

Grafico evoluzione

Se si visualizza la finestra Grafici e ci si posiziona con il cursore su un conto o un gruppo, appare il
grafico che rappresenta l'evoluzione della liquidità.
Nella legenda sono visibili Corrente, Precedente e Preventivo. Cliccando su ognuno si possono
nascondere o rendere visibile i rispettivi grafici.

Scheda gruppo Liquidità Preventivo
Con il comando Scheda conto di Preventivo , vengono visualizzati tutti i movimenti di previsione
della scheda conto. Giorno per giorno si potrà notare quali movimenti avranno un impatto sulla
liquidità. 

http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo
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Il comando Scheda conto permette di specificare se si vogliono vedere i movimenti correnti o di
preventivo.

Selezionare movimenti di Preventivo.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Liquidità nel Bilancio Abbellito con gruppi
Nel Bilancio abbellito con gruppi si può scegliere di avere i dati suddivisi in colonne per periodo. In
questo modo si vede l'evoluzione della liquidità per giorno, settimana, mese, trimestre, semestre,
anno, ecc.

Nelle opzioni Sezioni indicare la visualizzazione dei dati di Preventivo.
Scegliere il gruppo della Liquidità.
Si può scegliere di visualizzare anche i conti della liquidità.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
previsioni su più anni.
Indicare la Suddivisione per periodo  che si desidera.
Se l'impostazione per la stampa verrà utilizzata in futuro, si consiglia di Creare una
Personalizzazione.

http://www.banana.ch/doc/it/node/3265
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Report Contabile Liquidità Preventivo
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione dei
dati avviene in colonne, come nella tabella Conti.

Si può usare il Report contabile per avere una visione immediata dell'evoluzione dei conti della
liquidità.
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Previsione vendite

Le vendite per un'azienda sono la fonte principale di guadagno e di liquidità. A differenza dei costi che
sono più facilmente pianificabili, le vendite risultano più difficile da preventivare. In ogni caso ci si può
orientare sulla base delle vendite dell'anno prima per lo stesso periodo e valutare se ci saranno in
programma eventi importanti che potrebbero incrementare le vendite.

Sulla base di questo concetto, Banana contabilità permette di simulare e proiettare nel tempo diversi
scenari. Basta cambiare gli importi preventivati per le vendite e il programma aggiorna in automatico
le previsioni e visualizza report dettagliati per lo stesso anno o per gli anni futuri.

Le proiezioni delle vendite sono calcolate sulla base delle previsioni inserite nella tabella Preventivo e
possono essere visualizzate in diverse modalità.

Tabella Conti
Nella tabella Conti sono presenti i conti e i gruppi delle vendite. Nella colonna Preventivo ci sono i
saldi aggiornati della previsione per il periodo contabile. Con un colpo d'occhio si conosce l'evoluzione
delle vendite durante l'anno.

Grafico evoluzione delle vendite

Se si visualizza la finestra Grafici e ci si posiziona con il cursore su un conto o il gruppo vendite,
appare il grafico che rappresenta l'evoluzione delle vendite.
Nella legenda sono visibili Corrente, Precedente e Preventivo. Cliccando su ognuno si possono
nascondere o rendere visibile i rispettivi grafici.

Scheda conto vendite Preventivo
Con il comando Scheda conto di Preventivo  vengono visualizzati tutti i movimenti di previsione della
scheda conto. Giorno per giorno si potrà notare l'evoluzione delle vendite e quali movimenti avranno
un impatto maggiore.

http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo
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Il comando Scheda conto permette di specificare se si vogliono vedere i movimenti correnti o di
preventivo.

Selezionare movimenti di Preventivo.
Attivare il conto o il gruppo Vendite
Si possono attivare anche tutti i conti delle vendite.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Conto economico Preventivo trimestrale vendite
Con il Bilancio abbellito con gruppi puoi scegliere quali colonne di dati visualizzare e il periodo di
riferimento, per vedere l'evoluzione delle vendite per giorno, settimana, mese, trimestre, semestre,
anno, ecc.

Nelle opzioni Sezioni indicare di visualizzare i dati di Preventivo.
Scegliere il gruppo vendite. Si può scegliere di visualizzare anche i conti delle vendite.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Indicare la Suddivisione per periodo  che si desidera.
Se l'impostazione fatta sarà utilizzata per il futuro si consiglia di creare una Personalizzazione.

http://www.banana.ch/doc/it/node/3265
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Report contabile Preventivo vendite
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione dei
dati avviene in colonne, come nella tabella Conti.

Si può usare il Report contabile per avere una visione immediata dell'evoluzione dei conti delle
vendite.
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Previsioni finanziarie per clienti

La pianificazione dei clienti rende più completa la previsione finanziaria. Si possono, per esempio,
pianificare le vendite indicando i conti dei clienti più importanti.

La previsione, con il metodo della partita doppia, consente anche d'indicare conti per i singoli clienti.
A dipendenza della necessità, la gestione dei clienti può essere fatta con dei conti di bilancio, con dei
conti relativi ai ricavi o con dei centri di costo e di profitto.

Quando si cambia un movimento di preventivo, le previsioni relative a ogni singolo cliente vengono
aggiornate.

Tabella Conti
Nella tabella Conti Impostare i con dei clienti. Nella colonna Preventivo i saldi della previsione
vengono aggiornati in automatico per il periodo contabile. Con un colpo d'occhio si conosce quale
sarà la previsione per il singolo cliente.

Grafico evoluzione

Se si visualizza la finestra Grafici e ci si posiziona con il cursore su un conto o un gruppo clienti,
appare il grafico che rappresenta l'evoluzione dei clienti.
Nella legenda sono visibili Corrente, Precedente e Preventivo. Cliccando su ognuno si possono
nascondere o rendere visibile i rispettivi grafici.

Scheda conto Clienti Preventivo
Con il comando Scheda conto di Preventivo si ha la possibilità di vedere in dettaglio tutti i
movimenti per ogni cliente.

http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo
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Seleziona movimenti di Preventivo.
Indicare il conto o il gruppo Clienti.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Clienti nel Bilancio Abbellito con gruppi
Con il Bilancio abbellito con gruppi puoi scegliere quali colonne di dati visualizzare e il periodo di
riferimento, per vedere l'evoluzione dei clienti per giorno, settimana, mese, trimestre, semestre,
anno, ecc.

Nelle opzioni Sezioni indicare di visualizzare i dati di Preventivo.
Scegliere il gruppo Clienti. Si può scegliere di visualizzare anche i conti di ogni singolo cliente.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Indicare la Suddivisione per periodo  desiderata.
Se l'impostazione fatta sarà utilizzata per il futuro si consiglia di creare una Personalizzazione.

http://www.banana.ch/doc/it/node/3265
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Report Contabile Clienti Preventivo
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione dei
dati avviene in colonne, come nella tabella Conti.

Si può usare il Report contabile per avere una visione immediata dell'evoluzione dei conti clienti.
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Bilancio previsionale

Il bilancio previsionale presenta la situazione patrimoniale ad un periodo futuro. È uno strumento
importante per seguire la conduzione aziendale che permette di verificare come sarà la struttura di
capitale dell'impresa, lo stato degli attivi, quello dei passivi e del capitale proprio.

Con Banana Contabilità, grazie alle previsione con il metodo della partita doppia, si ottengono dei
bilanci previsionali completi, da disporre in diversi modi. Il programma calcola le previsioni anche su
più anni.
Si ha una visione molto precisa di quella che sarà la situazione patrimoniale futura.
La struttura del Bilancio previsionale è la medesima di quella usata per la contabilità. In sede di
stampa si possono indicare quali valori visualizzare, quelli del consuntivo, del preventivo oppure quelli
di entrambi.

I valori di previsione sono calcolati tenendo conto dei saldi d'apertura e dei movimenti di previsione,
indicati nella tabella Preventivo. Quando si cambia un movimento di preventivo, le previsioni sono
subito aggiornate. Si può simulare, spostare un pagamento, aggiungere un investimento, modificare
le vendite e vedere come cambia il bilancio nel tempo.

I valori di previsione del bilancio possono essere visualizzati in diversi modi.

Struttura delle previsioni
La previsione finanziaria, basata sul metodo della partita doppia, consente di ottenere le previsioni dei
valori di bilancio, usando gli stessi conti e gruppi della contabilità.  La stessa struttura delle poste che
compongono il bilancio è utilizzata per la previsione. In automatico sono disponibili i valori e i report
per vedere in dettaglio, giorno per giorno, come si evolve la liquidità, la situazione dei clienti e tanto
altro ancora.

La previsione di Banana Contabilità presenta i dati per valutare la situazione finanziaria, patrimoniale
ed economica.  La struttura è personalizzabile, può essere molto semplice con i gruppi principali e i
conti che ne fanno parte, o più complessa, inserendo anche dei sottogruppi, per una visione più
dettagliata.

ATTIVI PASSIVI
Sostanza circolante
• Liquidità
• Crediti
• Inventario
Sostanza fissa
• Beni mobili
• Beni immobili

Capitale di terzi
• Debiti a breve termine
• Debiti a lungo termine
Capitale proprio
• Riserve
• Utile/Perdita anni precedenti
• Utile d'esercizio

Tabella Conti
Nella colonna Preventivo della tabella Conti sono presenti i valori di previsione per tutti i conti e i
gruppi di bilancio. Con un colpo d'occhio si ha una visione immediata del bilancio previsionale. I valori
sono riferiti al periodo contabile e gli scostamenti sono calcolati in automatico rispetto al saldo
attuale.

Se ci sono esigenze di avere maggiori dettagli, si aggiungono nuovi conti o gruppi.
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Bilancio Abbellito con gruppi
Con il comando Bilancio Abbellito per gruppi, scegliendo la modalità di presentazione desiderata,
viene visualizzato il Bilancio previsionale.

Nelle opzioni Sezioni indicare di visualizzare i dati di Preventivo.
Si possono visualizzare i valori correnti (contabili), quelli di preventivo o entrambi.
Impostare il Periodo.
Se si indica un periodo che va oltre quello contabile, il programma genera in automatico
previsioni su più anni.
Con la Suddivisione per periodo  i dati vengono presentati con le suddivisioni scelte per il
periodo.
Nella opzioni Righe si possono escludere i conti e avere una visualizzazione solo dei gruppi.
Se si pensa di utilizzare per il futuro la stessa impostazione, creare una Personalizzazione.

Utilizzando le diverse opzioni si possono personalizzare le stampe. Qui di seguito vengono presentati
alcuni esempi.

Bilancio abbellito con gruppi Preventivo annuale

Questa stampa è stata impostata per ottenere i valori di preventivo solo per l'anno corrente.

Bilancio Preventivo e Corrente

I valori di consuntivo (corrente) sono confrontati con quelli di preventivo.
Si può visualizzare anche la variazione del confronto come importo e percentuale.

http://www.banana.ch/doc/it/node/3265
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 Bilancio Preventivo trimestrale

Per ottenere un bilancio previsionale annuale con suddivisione trimestrale, nella sezione Suddivisione
→ Suddivisione per periodo  si deve indicare il trimestre. Il programma mostra il Bilancio previsionale
dell'anno, suddiviso in 4 trimestri.

Bilancio Preventivo e Corrente trimestrale

Questa stampa è impostata per avere sia il preventivo sia il consuntivo annuale con la suddivisione
del trimestre. Si ha quindi la situazione prevista e corrente alla fine dei trimestri.

Bilancio Preventivo triennale
Questa stampa è impostata per avere la previsione del bilancio triennale.
Nella sezione Periodo impostare il periodo riferito a tre anni e nella sezione Suddivisione →
Suddivisione per periodo impostare l'anno. È necessario che nelle Proprietà file (menu file) come
periodo Inizio e Fine ci sia come intervallo di tempo 3 anni (es. inizio 01.01.2022 - fine 31.12.2024).

http://www.banana.ch/doc/it/node/3265
http://www.banana.ch/doc/it/node/3265
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Report Contabile Preventivo
Dal menu Report → Report Contabile  puoi ottenere delle stampe di bilancio visualizzate come nella
tabella conti, ma con i valori delle colonne richieste.
Le opzioni sono simili a quelle spiegate per il Bilancio abbellito per gruppi.

http://www.banana.ch/doc/it/node/3264
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Previsioni finanziarie per i fornitori

La pianificazione dei fornitori rende più completa la previsione finanziaria. Si possono, per esempio,
pianificare gli acquisti, indicando i conti dei fornitori più importanti. Si potrà così analizzare e
ottimizzare il rapporto con i diversi fornitori,  richiedendo magari dilazioni di pagamento.

La previsione con il metodo della partita doppia consente anche d'indicare i conti per i singoli fornitori.
A dipendenza della necessità, la gestione dei fornitori può essere fatta con dei conti di bilancio, con
conti relativi ai costi oppure, con dei centri di costo e profitto.

Quando si cambia un movimento di preventivo, le previsioni relative a ogni singolo fornitore vengono
aggiornate.

Tabella Conti
Nella tabella Conti Impostare i conti dei fornitori. Nella colonna Preventivo i saldi della previsione
vengono aggiornati in automatico per il periodo contabile, in base alla data di Inizio e di Fine,
impostato nelle Proprietà file. Con un colpo d'occhio si conosce quale sarà la previsione per il singolo
fornitore.

Grafico evoluzione

Se si visualizza la finestra Grafici e ci si posiziona con il cursore su un conto o un gruppo fornitori,
appare il grafico che rappresenta l'evoluzione dei fornitori.
Nella legenda sono visibili Corrente, Precedente e Preventivo. Cliccando su ognuno si possono
nascondere o rendere visibile i rispettivi grafici.

Scheda conto Fornitori Preventivo
Con il comando Scheda conto di Preventivo si ha la possibilità di vedere in dettaglio tutti i
movimenti per ogni fornitore.

http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo
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Seleziona movimenti di Preventivo.
Indicare il conto o il gruppo dei Fornitori.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Fornitori nel Bilancio Abbellito con gruppi
Con il Bilancio abbellito con gruppi puoi scegliere quali colonne di dati visualizzare e il periodo di
riferimento, per vedere l'evoluzione dei fornitori per giorno, settimana, mese, trimestre, semestre,
anno, ecc.

Nelle opzioni Sezioni indicare di visualizzare i dati di Preventivo.
Scegliere il gruppo Fornitori. Si può scegliere di visualizzare anche i conti di ogni singolo
fornitore.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Indicare la Suddivisione per periodo  che si desidera.
Se l'impostazione fatta sarà utilizzata per il futuro si consiglia di creare una Personalizzazione.

http://www.banana.ch/doc/it/node/3265
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Report Contabile Fornitori Preventivo
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione dei
dati avviene in colonne, come nella tabella Conti.

Si può usare il Report contabile per avere una visione immediata dell'evoluzione dei conti fornitori.
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Piano degli investimenti

La pianificazione degli investimenti presenta la previsione dell'evoluzione delle attrezzature, scorte,
valori mobili o immobili che sono necessarie all'azienda.

Con Banana Contabilità, grazie alle previsione con il metodo della partita doppia, si conosce
l'evoluzione degli attivi nel tempo. Le previsioni complete possono essere disposte in diversi modi e
sono possibili anche su più anni.
La struttura dei conti è la medesima di quella usata per la contabilità. In sede di stampa si possono
indicare i valori da visualizzare, come per esempio, quelli di consuntivo, quelli di preventivo, oppure
entrambi.

Quando si cambia un movimento di preventivo, le previsioni vengono subito aggiornate. È possibile
fare delle simulazioni, spostare un pagamento, aggiungere un investimento, e vedere l'evoluzione dei
conti attivi.

Per il Piano degli investimenti, ci sono a disposizione le medesime opzioni del Piano della liquidità e
del Conto Economico previsionale.

Utilizzo delle formule
Le formule permettono di automatizzare i Calcoli degli ammortamenti e degli interessi. Quando si
aumenta un investimento anche il conto economico immediatamente viene aggiornato. Le formule
sono particolarmente utili quando si fanno previsioni su più anni.

Piano dei Conti
Nella tabella Conti, colonna Preventivo, ci sono i valori di previsione di tutti i conti e i gruppi del
bilancio, quindi sono compresi anche tutti quelli relativi agli investimenti. Con un colpo d'occhio si ha
una visione immediata dei valori riferiti al periodo contabile. 

Se si ha l'esigenza di avere maggiori dettagli, relativamente agli investimenti, aggiungere ulteriori
conti o gruppi. 
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Grafico evoluzione

Se si visualizza la finestra Grafici e ci si posiziona con il cursore su un conto o un gruppo degli
investimenti, appare il grafico che rappresenta l'evoluzione degli investimenti.
Nella legenda sono visibili Corrente, Precedente e Preventivo. Cliccando su ognuno si possono
nascondere o rendere visibile i rispettivi grafici.

Scheda gruppo Investimenti Preventivo
Con il comando Scheda conto di Preventivo  si possono vedere in dettaglio tutti i movimenti degli
investimenti preventivati. Si ha l'evoluzione, giorno per giorno, di ogni singolo conto attivo e anche
dei conti di ammortamento.

Il comando Scheda conto permette di specificare se si vogliono vedere i movimenti correnti o di
preventivo.

Selezionare movimenti di Preventivo.
Indicare il conto o il gruppo Investimenti.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Investimenti nel Bilancio Abbellito con gruppi
Con il Bilancio abbellito con gruppi puoi scegliere quali colonne di dati visualizzare e il periodo di
riferimento, per vedere l'evoluzione dei clienti per giorno, settimana, mese, trimestre, semestre,
anno, ecc.

Nelle opzioni Sezioni indicare di visualizzare i dati di Preventivo.
Scegliere il gruppo Investimenti. Si può scegliere di visualizzare anche i conti di ogni singolo
attivo, relativo ad un investimento.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Indicare la Suddivisione per periodo  che si desidera.
Se l'impostazione fatta sarà utilizzata per il futuro si consiglia di creare una Personalizzazione.

http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo
http://www.banana.ch/doc/it/node/3265
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Report Contabile Investimenti Preventivo
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione dei
dati avviene in colonne, come nella tabella Conti.

Si può usare il Report contabile per avere una visione immediata dell'evoluzione dei conti
investimenti.
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Il piano aziendale dei finanziamenti

La previsione aziendale dei finanziamenti presenta l'evoluzione dei conti relativi alla provenienza del
capitale proprio e quello di terzi.

Con Banana Contabilità, grazie alle previsione con il metodo della partita doppia, si hanno delle
previsioni complete che puoi disporre in diversi modi. Il programma calcola le previsioni anche su più
anni.
La struttura dei conti è la medesima di quella usata per la contabilità. In sede di stampa si possono
indicare quali valori visualizzare, se solo quelli del consuntivo o del preventivo, oppure entrambi.

Quando si cambia un movimento di preventivo le previsioni sono subito aggiornate. Puoi fare delle
simulazioni, spostare un pagamento, aggiungere un nuovo debito, e vedere come evolvono i conti dei
passivi.

Per il Piano dei finanziamenti ci sono a disposizioni le medesime opzioni del Piano della liquidità e del
Conto Economico previsionale.

Utilizzo delle formule
Le formule ti permettono di automatizzare i Calcoli degli ammortamenti e degli interessi. Le formule
sono particolarmente utili quando si fanno previsioni su più anni.

Piano dei Conti
Nella colonna Preventivo della tabella Conti si hanno i valori di previsione per tutti i conti e gruppi di
bilancio e quindi anche per tutti quelli relativi ai finanziamenti. Con un colpo d'occhio hai una visione
immediata dei valori riferiti al periodo contabile. 

Se servono maggiori dettagli relativamente ai finanziamenti, si possono aggiungere dei conti o dei
gruppi. 

Grafico evoluzione

Se si visualizza la finestra Grafici e ci si posiziona con il cursore su un conto o un gruppo dei
finanziamenti, appare il grafico che rappresenta l'evoluzione dei finanziamenti.
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Nella legenda sono visibili Corrente, Precedente e Preventivo. Cliccando su ognuno si possono
nascondere o rendere visibile i rispettivi grafici.

Scheda gruppo Capitale di terzi Preventivo
Con il comando Scheda conto di Preventivo si vedono, giorno per giorno, come si evolve ogni
singolo conto passivo, gli ammortamenti del debito, gli interessi passivi e capire l'impatto che hanno
sui finanziamenti.

Il comando Scheda conto permette di specificare se si vogliono vedere i movimenti correnti o di
preventivo.

Seleziona movimenti di Preventivo.
Indicare il conto o il gruppo dei finanziamenti.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Bilancio Abbellito con gruppi
Con il Bilancio abbellito con gruppi si possono scegliere le colonne con i dati da visualizzare e il
periodo di riferimento, per vedere l'evoluzione dei finanziamenti per giorno, settimana, mese,
trimestre, semestre, anno, ecc.

http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo
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Nelle opzioni Sezioni indicare di visualizzare i dati di Preventivo.
Scegliere il gruppo Finanziamenti. Si può scegliere di visualizzare anche i conti di ogni singolo
conto di finanziamento.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Indicare la Suddivisione per periodo  che si desidera.
Se l'impostazione fatta sarà utilizzata per il futuro si consiglia di creare una Personalizzazione.

Report Contabile Finanziamenti Preventivo
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione dei
dati avviene in colonne, come nella tabella Conti.

Si può usare il Report contabile per avere una visione immediata dell'evoluzione dei conti per i
finanziamenti.

http://www.banana.ch/doc/it/node/3265
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Pianificazione progetti con centri di costo e
profitto

La pianificazione finanziaria dei progetti permette di avere un controllo delle entrate e delle uscite di
un progetto. Serve a valutare investimenti e ritorni di un progetto e a verificarne l'implementazione.

La previsione, con il metodo della partita doppia, consente d'indicare anche i centri di costo e di
profitto. È sufficiente impostare dei centri di costo per i diversi progetti e parallelamente alle
previsioni di bilancio e di conto economico, si ottiene anche la previsione per ogni singolo progetto.

Guarda il Video: Centri di costo e di profitto

Le proiezioni sono calcolate sulla base del saldo iniziale e delle previsioni inserite nella tabella
Preventivo. Quando si cambia un movimento di preventivo, le previsioni del progetto sono subito
aggiornate. Si possono fare delle simulazioni, spostare un pagamento, aggiungere un investimento,
modificare le vendite e vedere come cambia il progetto.

I dati dei progetti possono essere visualizzati in diversi modi.

Tabella Conti
Nella tabella Conti s'impostano i conti dei centri di costo e di profitto. Dopo ogni movimento, nella
colonna Preventivo, si presentano i saldi aggiornati della previsione per il periodo contabile di
riferimento. Con un colpo d'occhio si conosce immediatamente la situazione dei progetti.

Grafico evoluzione

Se si visualizza la finestra Grafici e ci si posiziona con il cursore su un centro di costo o su un gruppo
dei progetti, appare il grafico che rappresenta l'evoluzione dei progetti.
Nella legenda sono visibili Corrente, Precedente e Preventivo. Cliccando su ognuno si possono
nascondere o rendere visibile i rispettivi grafici.

Scheda conto con dati di preventivo
Con il comando Scheda conto di Preventivo si vedono, giorno per giorno, come si evolve ogni
singolo progetto.

https://www.banana.ch/it/node/11496
http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 804

Il comando Scheda conto permette di specificare se si vogliono vedere i movimenti correnti o di
preventivo.

Seleziona movimenti di Preventivo.
Indicare i conti dei centri di costo e di profitto, oppure, il gruppo.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Bilancio Abbellito con gruppi
Con il Bilancio abbellito con gruppi si possono scegliere quali colonne di dati visualizzare e il periodo
di riferimento, per vedere l'evoluzione dei progetti per giorno, settimana, mese, trimestre, semestre,
anno, ecc.

Nelle opzioni Sezioni indicare di visualizzare i dati di Preventivo.
Scegliere il gruppo Progetti. Si può scegliere di visualizzare anche i conti di ogni singolo conto di
progetto.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Indicare la Suddivisione per periodo  che si desidera.
Se l'impostazione fatta sarà utilizzata per il futuro, si consiglia di creare una Personalizzazione.

http://www.banana.ch/doc/it/node/3265
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Report Contabile Preventivo Progetti
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione
avviene in colonne.

Puoi quindi usarlo per avere una visione immediata dell'evoluzione dei progetti.
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Pianificazione settori

La pianificazione finanziaria dei settori permette di avere delle previsioni di Bilancio e di Conto
economico per ogni settore o filiale della ditta. Con i Segmenti si possono quindi valutare i diversi
settori dell'azienda e capire quale contributo dà all'attività complessiva.

La previsione, con il metodo della partita doppia, consente anche d'indicare i segmenti che
s'impostano nella tabella Conti, alla fine del piano contabile e servono sia per la contabilità che per la
previsione. Quando si registrano i movimenti della previsione devono essere ripresi, quando occorre, i
conti dei segmenti. Banana Contabilità esegue il Bilancio e il Conto economico anche della previsione,
con la suddivisione per i diversi settori.

Le proiezioni sono calcolate sulla base del saldo iniziale e delle previsioni inseriti nella tabella
Preventivo. Quando si cambia un movimento di preventivo, le previsioni del progetto vengono subito
aggiornate. Puoi fare delle simulazioni, spostare un pagamento, aggiungere un investimento,
modificare le vendite e vedere come cambia il progetto.

I dati dei settori o delle filiali con i segmenti possono essere visualizzati in diversi modi.

Tabella Conti
Nella tabella Conti devono essere impostati i segmenti. Se si indicano i segmenti per i conti di bilancio
e di conto economico, nei conti dei segmenti il saldo sarà sempre a zero.

Scheda gruppo Settori Preventivo
Con il comando Scheda conto di Preventivo  hai la possibilità di vedere in dettaglio tutti i movimenti
per ogni segmento.

http://www.banana.ch/doc/it/node/2726#scheda_conto_preventivo
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Il comando Scheda conto permette di specificare se si vogliono vedere i movimenti correnti o di
preventivo.

Seleziona movimenti di Preventivo.
Indicare i conti dei segmenti, oppure, il gruppo.
Impostare il Periodo.
Se viene indicato un periodo che va oltre quello contabile, il programma genera in automatico
Previsioni su più anni.
Se viene indicato un gruppo, vengono visualizzati i movimenti di tutti i conti che appartengono
a quel gruppo.
Quando ci si trova nella tabella Preventivo, si può accedere alla Scheda del conto di preventivo
cliccando sull'icona vicina al conto.

Bilancio Abbellito con gruppi
Con il Bilancio abbellito per gruppi puoi scegliere che i valori siano suddivisi in colonne per ogni
segmento. Puoi così avere il bilancio e conto economico per ogni settore.

Nella sezione colonne indica che vuoi visualizzare i valori di Preventivo.
Nella Sezioni puoi scegliere di visualizzare solo il bilancio o il conto economico.
Imposta il Periodo.
Se indichi un periodo che va oltre quello contabile, il programma genererà in automatico
previsioni per più anni.
Indica la suddivisione per segmento  che desideri.
Se credi di utilizzare ancora questa impostazione di stampa, crea una Personalizzazione.

Report Contabile Preventivo Segmenti
Il Report Contabile è simile al Bilancio Abbellito con gruppi, con la differenza che la visualizzazione
avviene in colonne.

Puoi quindi usarlo per avere una visione immediata dell'evoluzione dei segmenti.

http://www.banana.ch/doc/it/node/3265
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Passaggio al nuovo anno con le previsione
finanziaria

La funzione di Banana Contabilità per Creare un nuovo anno riporta anche le registrazioni di
pianificazione.

A livello di ogni riga della tabella Preventivo, nella colonna Nuovo anno , hai la possibilità d'indicare:

Se l'operazione deve essere riportata o meno,
Se la data deve essere mantenuta o sostituita con quella del nuovo anno.

Creare il budget per il nuovo anno è quindi semplice, perché devi modificare o aggiungere le voci di
spesa e di entrata che si prevede cambieranno.

http://www.banana.ch/doc/it/node/9344
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Preventivo annuale in colonna (Tabella Conti
e Categorie)

Se desideri impostare rapidamente un preventivo su base annuale, senza dettagli per periodo, puoi
inserire gli importi previsionali nella colonna Preventivo della tabella Conti e/o Categorie.

Colonna Preventivo annuale
Nella tabella Conti e/o Categorie, la colonna Preventivo è modificabile solo se non è stata attivata la
tabella Preventivo. Nel caso la tabella Preventivo sia presente, questa si può rimuovere nel modo
seguente:

menu Strumenti → Aggiungi nuove funzionalità → Rimuovi tabella Preventivo .

Una volta che la tabella Preventivo è stata rimossa, nella tabella Conti e/o Categorie, vista
Preventivo, la colonna Preventivo è attiva e si possono inserire gli importi di preventivo annuale.

Di regola si indica unicamente il preventivo per i costi e i ricavi (contabilità in partita doppia) e per le
entrate e le uscite (contabilità Entrate / uscite).

I valori di preventivo devono essere inseriti su ogni conto e/o Categoria. Il programma calcola i totali
automaticamente, e ne ricava l'utile o la perdita.

Tabella Conti:
I ricavi (Avere) devono essere inseriti in negativo
I costi (Dare) in positivo.

Tabella Categorie:
Le entrate devono essere indicate in positivo
Le uscite devono essere indicate in negativo.

Colonna Differenza Preventivo
Nella colonna Differenza Preventivo, il programma calcola la differenza fra il saldo e il valore
indicato nella colonna Preventivo. Ogni volta che nella tabella Conti e/o Categorie si registra un
movimento, questa colonna si aggiorna in automatico.

http://www.banana.ch/doc/it/node/9356
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Stampe per periodo
Quando si effettuano delle stampe per mese o trimestre, il programma suddivide il valore indicato
nella colonna Preventivo, in quote mensili. 

Per la suddivisione il programma procede nel modo seguente:

Calcola il numero di mesi in base alla data di inizio e fine, indicate nel menu File → Proprietà file
(dati base). 
Divide l'importo di preventivo per il numero di mesi calcolati.
Eventuali differenze di arrotondamento sono aggiunte all'ultimo mese.

Se per esempio il valore indicato è un importo di 10'000, questo sarà suddiviso in 11 mensilità di
833.33 e una mensilità di 833.37.

Se la visualizzazione è per trimestre, il valore del trimestre sarà dato dalla somma dei singoli mesi e
non dal valore dell'anno, diviso per trimestri.

Per una pianificazione diversa, per mese o trimestre, si deve usare la pianificazione con la tabella
Preventivo.

Aggiungere colonne Preventivo
Con il comando Menu Dati → Disponi Colonne→ Aggiungi puoi aggiungere altre colonne per indicare
altri valori di preventivo.

Imposta il Tipo Dato con Importo. 
In questo modo il programma calcolerà le somme dei gruppi.

Puoi aggiungere delle colonne di preventivo per:

Avere più valori di Preventivo (scenari diversi).
Tenere una copia del preventivo iniziale creato con la tabella Preventivo:

Prepara il preventivo nella Tabelle Preventivo.
Nella tabella Conti, posizionati sulla prima riga e selezione tutta la colonna (cliccando
sull'intestazione della colonna).
Menu Modifica → Copia.
Posizionati sulla prima riga nella colonna preventivo dove copiare i dati.
Menu Modifica → Incolla.
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Gestione Articoli integrata nella contabilità

Nel file della contabilità è possibile aggiungere una tabella per gestire gli articoli e collegarli alle
singole registrazioni tramite l'Id dell'articolo (identificativo articolo) che si inserisce nella colonna
Articolo. 

Questa funzionalità è molto potente e utile perché permette le seguenti automazioni:

Integrare nella contabilità un elenco di prodotti o un inventario con descrizione, quantità, prezzi
e raggruppamenti.
Nella tabella Registrazioni, inserendo le fatture e indicando semplicemente l'Id dell'articolo
(identificativo dell'articolo) nella colonna Articolo, vengono riprese la descrizione, il prezzo e il
conto.
Nella riga di registrazione, inserendo la quantità (in positivo o negativo), il programma aggiorna
in automatico il saldo dei quantitativi esistenti. Funziona quindi come un piccolo magazzino. 

Alcune estensioni, come quelle per la gestione dei titoli, fanno uso di questa funzionalità, per gestire
l'elenco dei titoli, avere un inventario e calcolare l'utile o la perdita contabile al momento della
vendita.

Attivare la funzionalità
La funzionalità si abilita dal menu Strumenti > Aggiungi funzionalità.

Le opzioni sono le seguenti:

Aggiungi tabella Articoli
Aggiunge la tabella articoli nel file della contabilità.
Aggiungi tabella Articoli e colonne Articoli nella tabella Registrazioni.
Aggiunge contemporaneamente la tabella Articoli e le colonne articoli nella tabella
Registrazioni.
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Tabella Articoli nel file contabile

La tabella Articoli è una sorta di mini-magazzino integrato in contabilità.

Serve per:

Gestire l'elenco di prodotti, con i relativi prezzi.
Puoi raggruppare i prodotti in gruppi.
Nella tabella Registrazioni, inserisci l'articolo e il programma riprende Descrizione e prezzo.
Se nella tabella Registrazioni inserisci la quantà il programma aggiorna la quantità attuale nella
tabella articolo. 

Per utilizzare la tabella Articoli è necessario:

Aggiungere la tabella Articoli.
Aggiungere le colonne Articoli alla tabella Registrazioni.
Rendere visibile nella tabella Registrazioni la colonna Articolo dal menu Dati → Disponi colonne.
Il contenuto della colonna Articolo deve essere un articolo definito nella tabella Articoli.

Aggiungere la tabella Articoli
La tabella Articoli si aggiunge dal menu Strumenti → Aggiungi nuove funzionalità → Aggiungi Tabella
Articoli.

Nella Tabella Articoli è possibile inserire articoli, prodotti o altro, e può essere anche utilizzata come
un piccolo controllo di magazzino.

Le colonne predefinite sono le seguenti:

Gruppo: per creare righe di totali.
Articolo: il codice dell'articolo.
Descrizione: la descrizione dell'articolo.
Somma in: il gruppo in cui totalizzare una serie di articoli.
Conto: il conto ripreso nelle registrazioni.
Moneta: la moneta da utilizzare (solo per i file di contabilità multi-moneta).
CodiceIVA: il codice IVA da utilizzare (solo per i file di contabilità con IVA).
Unità: una sigla per definire il tipo a cui si riferisce la quantità.
Vendita: il prezzo unitario di vendita.
Costo: il costo unitario.
Quantità iniziale: la quantità iniziale dell'articolo.
Prezzo unitario iniziale: il prezzo unitario iniziale dell'articolo.
Valore iniziale: la quantità iniziale moltiplicata dal prezzo unitario iniziale.
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Qt. Corrente: la quantità corrente calcolata dal programma tenendo conto della quantità
iniziale e delle righe della tabella Registrazioni dell'articolo. Viene usata la colonna Quantità
della tabella registrazioni.
Prezzo corrente: il prezzo corrente dell'articolo.
Valore corrente: la quantità corrente moltiplicato il Prezzo corrente.
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Colonne Articoli tabella Registrazioni

Le colonne Articoli della tabella Registrazioni sono utilizzate per inserire la quantità e il prezzo.
L'importo della registrazione viene calcolato in base al valore della colonna quantità e prezzo unitario.

Aggiungere le colonne Articoli nella tabella Registrazioni
Le colonne Articoli si aggiungono nella tabella Registrazioni  dal menu Strumenti → Aggiungi nuove
funzionalità → Aggiungi le colonne Articoli .

Le colonne sono le seguenti:

IdArticolo
È l'articolo contenuto nella tabella Articoli.
Come impostazione predefinita, nella tabella Registrazioni la colonna IdArticolo non sarà
visibile. Con il comando Dati → Disponi colonne è possibile rendere visibile la colonna in
modo da poterla utilizzare.
Quantità
Può essere positiva o negativa.
Unità
Prezzo/Unità
Può essere un valore positivo o negativo.

Per ulteriori informazioni visitare la documentazione Tabella Registrazioni.

Inserire le registrazioni
Se viene inserita una quantità o un prezzo unitario, l'importo viene calcolato in automatico.
Si possono anche inserire delle quantità in negativo, per contrassegnare delle uscite di prodotti
dal magazzino.

Collegamento con la tabella Articoli
Se la tabella Articoli è visualizzata, quando si inserisce una registrazione con l'Articolo e la quantità,
viene aggiornata la quantità corrente della rispettiva riga della tabella Articoli.

Vedi Aggiungi Tabella Articoli.

http://www.banana.ch/doc/it/node/2630
http://www.banana.ch/doc/it/node/7923
http://www.banana.ch/doc/it/node/7923


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 816

Importazione e automazione

Banana Contabilità Plus mette a disposizione diversi modi per importare movimenti o altri dati, in
modo da velocizzare e automatizzare la tenuta contabile.

Importazione e completamento dei movimenti bancari
È la funzionalità che ti permette di tenere la contabilità in modo veloce:

Importa i movimenti bancari in contabilità 1.
Il programma crea le registrazioni con data, descrizione, importo, conto e cambio. Dati
aggiuntivi come la contropartita devono essere completati a mano.
Formati standard, come l'ISO 20022 o il TXT sono inclusi nel piano Professional; altri formati
richiedono il piano Advanced.
Completa le registrazioni in automatico grazie alle regole  (piano Advanced)2.
Puoi impostare delle regole di auto-completamento per importare i movimenti aggiungendo
anche contropartita, codice IVA, Centri di costo e altre informazioni che hai specificato.

Puoi sempre modificare e completare ulteriormente le registrazioni.

Formati di importazione dei movimenti bancari

Banana Contabilità Plus legge i movimenti in diversi formati. Consulta la pagina Importa
movimenti.
Grazie alle Estensioni di importazione  programmate su misura, puoi importare dati da diversi
estratti bancari e altri programmi standard. Alcune estensioni sono disponibili unicamente nel
piano Advanced.

Altri comandi per importazione dei dati
Banana Contabilità Plus dispone diverse modalità per l'importazione dei dati:

Importa in contabilità
Puoi importare in qualsiasi tabella e da diversi formati.
Importa Righe
Tutte le tabelle permettono di importare dei dati dal formato CSV.
Copia e incolla da Excel o altri programmi.
Puoi preparare i movimenti o altri dati in una tabella di Excel e copiarli e incollarli in blocco nella
tabella Registrazioni o in ogni altra tabella.

Completamento manuale e annulla importazione
Una volta che i movimenti o altri dati sono stati importati puoi facilmente completarli e modificarli. In
questo modo è molto facile automatizzare i processi, perché nel caso vi siano delle eccezioni non
previste, puoi modificare i dati direttamente. 

Come tutti i comandi, anche quello per l'importazione può essere annullato. Quindi puoi provare
facilmente ad importare i dati e verificare se funziona come previsto. Se non hai scelto il formato
giusto o non hai impostato i parametri correttamente, basta annullare l'importazione e rifarla.

https://www.banana.ch/it/buy
https://www.banana.ch/doc/it/rules
https://www.banana.ch/apps/it/node/9561
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Link utili
Ripresa dati da altri programmi
Tutti i vantaggi del piano Advanced

https://www.banana.ch/it/advanced
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Comando Importa in contabilità

Il comando per l'importazione si attiva dal menu Azioni → Importa in contabilità e permette di
importare dati da file nelle seguenti tabelle:

Registrazioni - Movimenti bancari 
Per importare estratti conto nella tabella Registrazioni.
Registrazioni - Movimenti generici  
Per importare i movimenti nella tabella Registrazioni.
Conti
Per importare conti nella tabella Conti.
Codici IVA
Per importare i codici IVA nella tabella Codici IVA.
Cambi
Per importare i cambi nella tabella Cambi.
File
Importa i dati in più tabelle e anche nelle Proprietà file della contabilità. Questo tipo di
importazione viene usato per esempio per la conversione del piano contabile.

Per riprendere i dati da altri programmi, consulta la pagina Ripresa dati da altri programmi.

Procedura per l'importazione
Scegli la tabella di destinazione dei dati.1.
Scegli il tipo di file da importare.2.
Indica il nome del file.3.
Scegli i movimenti da importare.4.

Formati d'importazione
A dipendenza del tipo di tabella di destinazione sono a disposizione diversi formati d'importazione.

Importazione da altri file di Banana Contabilità (.AC2)
Predisposti per convertire i dati da file.
File di testo con intestazione (CSV/TXT)
Per i file creati che esportano i dati nel formato richiesto da Banana Contabilità.
Le indicazioni tecniche su come preparare questi file sono disponibili in lingua inglese.
Formati File predefiniti (generici)
ISO 20022 (generico).
Importazione tramite un'estensione di importazione
Di solito per estratti conto bancari.
L'estensione di importazione è un programma aggiuntivo di Banana Contabilità che trasforma i
dati da un formato specifico
L'utente deve installare l'estensione apposita. 
Nel caso vi fosse la necessità di importare da altri tipi di file non inclusi nell'elenco, si può
sviluppare un'Estensione Banana d'importazione specifica .

https://www.banana.ch/apps/it/node/9561
https://www.banana.ch/apps/it/node/9561
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Parametri importazione
Nome file:

Indica il nome del file dal quale i dati devono essere importati.
Per certi tipi di importazione (per esempio estratti bancari)

Puoi anche indicare più file assieme, selezionandoli con il dialogo sfoglia oppure
inserendoli separati con il punto e virgola ";".
Puoi indicare un file zip che contiene più file d'importazione.
Se importi più file devono tutti essere dello stesso tipo.

Importa dati da clipboard (Excel)

Con questa opzione i dati non sono letti dal file, ma dagli appunti/clipboard.
Si usa per importare dati da file che non possono essere letti da Banana, come per esempio da un
estratto conto bancario, disponibile solo in Excel, oppure proveniente da un altro programma.

Il vantaggio di importare i dati e non utilizzare semplicemente la funzione del copia e incolla, è che i
dati vengono convertiti dal programma di importazione e completati in automatico.

Procedi come segue:

Apri il file Excel che contiene i dati.
Seleziona i dati da importare, incluse eventuali righe di intestazione.
Impartisci il comando Copia (Ctrl+C).

Questa opzione viene mostrata solo per determinati tipi di importazione.

UTF-8

Vista questa casella se i dati da importare sono nel formato utf-8.
Questa opzione viene mostrata solo per determinati tipi di importazione.

Gestione Estensioni...

Questo comando porta al dialogo Gestisci Estensioni. 
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Utilizzalo per:

Cercare, aggiungere o rimuovere un'estensione di importazione.
Cambiare i parametri dell'estensione.

Usa anche il comando per cambiare le impostazione dell'estensione.

Impostazioni

Il bottone permette di cambiare le impostazioni dell'estensione.
Il bottone è visibile nella versione 10.1 e solo se l'estensione permette di impostare dei parametri.

Bottone OK

Avvia l'importazione.

Segnalazione di errori
Se durante l'esecuzione di un'importazione vengono segnalati degli errori, è necessario prima di tutto
aggiornare le Estensioni d'Importazione.

Se gli errori persistono, inviaci un feedback , può darsi che il formato del file sia stato aggiornato
dalla banca o istituto di origine, di conseguenza aggiorneremo anche il nostro filtro d'importazione.

https://www.banana.ch/it/feedback_documentation
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Importa i tuoi movimenti in Banana
Contabilità+

 In questa pagina viene trattata l'importazione dei movimenti da estratti conto bancari in Banana
Contabilità Plus. È una delle funzionalità più usate e più utili, che permette di automatizzare
l'inserimento dei movimenti nella tabella Registrazioni.
Puoi quindi importare in Banana Contabilità Plus il file dei movimenti bancari, sia in entrata e uscita,
dal tuo conto. È necessario inserire il numero di conto e la contropartita.
È anche possibile automatizzare l'importazione attraverso l'uso delle Regole di completamento
automatico  (piano Advanced).

Invece, per l'importazione da file che hanno movimenti di altro genere, per esempio importazioni da
un altro file di contabilità in partita doppia Banana, si rimanda alla pagina Importazione movimenti
generici. Per questi tipi di file non vi è la possibilità di applicare le regole di completamento
automatico.

▶ Video: Importa i movimenti dell'estratto bancario

 Procedura per l'importazione
Dal menu Azioni > Importa in contabilità > nella casella Importa seleziona Registrazioni1.
Scegli il tipo di file da importare.2.
Vedi spiegazioni che seguono.
Con il bottone Sfoglia, scegli uno o più file da dove si desidera importare i movimenti.3.
Imposta i parametri come necessario.4.
Vedi anche: Importa in contabilità.

Passi successivi
Un volta confermato tramite il bottone OK, i dati vengono letti e visualizzati i seguenti dialoghi:

Dialogo importa movimenti
Dove si devono dare indicazioni per il completamento delle righe importate.

https://www.banana.ch/doc/it/rules
https://www.banana.ch/doc/it/rules
https://www.banana.ch/it/node/11559
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Applica regole  (solo piano Advanced)
Al momento dell'importazione si possono memorizzare delle regole per fare in modo che il
programma completi in automatico le registrazioni, in tutte le importazioni successive.

Formati di importazione estratti bancari
Nel dialogo di importazione dei movimenti puoi scegliere fra i diversi tipi di file:

Estensioni di importazione per estratti bancari  (la maggior parte solo con il piano
Advanced)
Sono dei programmi aggiuntivi che devono essere installati dall'utente e che convertono i dati
per essere importati nei formati previsti da Banana Contabilità Plus.
Tramite il bottone Gestisci estensioni  puoi installare le estensioni programmate per
l'importazione di estratti conto bancari di diverse banche, carte di credito e altri formati.
Una volta che l'estensione è installata, appare nel menu Estensioni, ed è pronta per
l'importazione.

Estratto bancario Camt ISO 20022 -Svizzera  (piano Professional)
Questa estensione legge il formato standard messo a disposizione dalle banche svizzere.
Questa estensione decodifica anche il numero di riferimento del pagamento, generato dal
Layout fatture CH10 , e inserisce il numero di fattura o del cliente.
Elenco aggiornato delle Estensioni Banana per l'importazione .

Formati predefiniti inclusi in Banana Contabilità Plus (piano Professional)
Sono dei formati standard che quasi diverse banche mettono a disposizione e che sono inclusi
in Banana Contabilità Plus:

Estratto conto MT 940
Estratto conto ISO 20022 generico
Diverse banche in Europa mettono a disposizione l'estratto conto nel formato standard
ISO 20022.

Formato generico con Movimenti Entrate e Uscite TXT (piano Professional)
Si tratta di un file di testo del tipo CSV, che usa come separatore il tabulatore e presenta come
colonne quelle dell'importo in entrata e uscita di un conto.

Vedi Indicazioni tecniche per importare un file Entrate e Uscite (lingua inglese).

Nome file
Indichi un file o anche più file separati da un punto e virgola ";".  Puoi anche indicare uno ZIP che
contiene più file d'importazione.

Importare più file contemporaneamente:

Se la tua banca fornisce il camt053 giornaliero, puoi selezionare tutti i file del mese e importarli
in un unico passaggio.
Se la tua banca ti fornisce i file in un zip, puoi scegliere il file che contiene tutti gli estratti.

I file d'importazione devono ovviamente essere dello stesso tipo. Non puoi importare assieme formati
diversi.

Struttura del file d'importazione
Il file d'importazione contiene i movimenti tipici di un estratto conto bancario:

https://www.banana.ch/doc/it/rules
http://www.banana.ch/apps/it/node/9561
http://www.banana.ch/doc/it/node/4702
https://www.banana.ch/apps/it/node/8984
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/extensions?combine=&langcode=All&country=All&type=265&op=Invia#
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Data
[numero operazione] opzionale
Descrizione
Importo in entrata o in uscita.

Al momento dell'importazione, l'utente indica su quale conto devono essere registrati i movimenti, in
modo che le registrazioni in contabilità vengano già create con il conto Dare o Avere compilato.
Si possono creare estensioni di importazione per qualsiasi estratto conto bancario.
Vedi Indicazioni tecniche per importare un file Entrate e Uscite (lingua inglese).

Domande frequenti
Non vedo il formato per l'estratto conto della mia banca. Cosa faccio?
Clicca sul menu Estensioni → Gestione estensioni... e quindi sul bottone in basso Aggiorna
estensioni. Abilita il filtro per il formato desiderato.

Non vedo il formato per l'estratto conto xml di Postfinance (file .tgz). Come posso
importare i movimenti?
Questo formato non è più supportato. Contatta Postfinance e chiedi di ricevere l'estratto conto in
formato ISO 20022.

Appare il messaggio "Questo file ISO 20022 non contiene un estratto bancario
(camt.052/053/054)". Come è possibile?
Questo messaggio d'errore viene visualizzato se il file ISO 20022 non contiene un estratto bancario. Il
formato ISO 20022 è un formato generico che può contenere diversi tipi di informazione, quali
l'estratto bancario e le conferme d'esecuzione. In Banana Contabilità Plus è unicamente possibile
importare gli estratti bancari (camt.052/053/054).

La mia banca non è nella lista dei formati supportati. Si può aggiungere?
È possibile creare nuove estensioni per formati non ancora implementati. È disponibile anche un
supporto a pagamento  per l'implementazione di formati personalizzati.

Posso importare unicamente ordini collettivi e non vedo i dettagli (singole voci). Perché?
Nell’ebanking (per esempio della Banca Raiffeisen), quando si immette il pagamento, si deve
scegliere l’opzione "ordine individuale" anziché "ordine collettivo". Solo in questo modo i pagamenti
vengono importati come ordini individuali.
 

https://www.banana.ch/it/node/11330
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Dialogo Importa movimenti

 

Il dialogo Importa movimenti si attiva dal menu:

Azioni → Importa in contabilità → Importa: Registrazioni

Contenuto del dialogo
La visualizzazione degli elementi del dialogo dipende dal tipo di file che viene importato:

Movimenti per singolo conto ed estratti bancari 
Vengono visualizzati tutti gli elementi.
Movimenti di contabilità in partita doppia o altri
Non vengono visualizzati gli elementi seguenti:

Conto
Contropartita temporanea
Applica regole.

Raggruppamento per fattura
Questo elemento viene visualizzato solo nel caso in cui nel file d'importazione ci siano dei
contenuti nella colonna DocInvoice.

Dialogo Importa Movimenti
Segue la finestra di dialogo che permette di integrare al meglio i dati in contabilità.

Conto destinazione

Questa opzione figura quando vengono importati dei dati dall’estratto bancario o postale o i
movimenti di entrata e uscita di un conto in formato testo.

Inserisci il numero di conto bancario del tuo piano dei conti, relativo all’estratto importato.

http://www.banana.ch/doc/it/node/2795/
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Se viene lasciato vuoto il programma inserisce il conto [A] (Account) in modo tale che si possa
capire se è un movimento Dare o Avere.

Seleziona movimenti

Data inizio, Data fine

Inserisci la data iniziale e finale del periodo relativo alla ripresa delle registrazioni. È possibile
selezionare il periodo in automatico tramite le apposite caselle sottostanti a quelle delle date.

Non importare se esiste già lo stesso Riferimento esterno, Data e Importo

Se attivata, questa funzione permette di non importare i movimenti già registrati, per evitare una
doppia registrazione. Questa opzione è attivabile unicamente se nei movimenti (file) da importare è
presente la colonna "Rif.Esterno", altrimenti è disabilitata.

Ordina registrazioni per data

L'opzione è attiva per default e consente di avere i movimenti importati in ordine di data.

Completa le registrazioni con

Completamento automatico dei valori

L’opzione è relativa alla contabilità con IVA e multi-moneta.
Se attivata, permette di completare in automatico i valori che mancano nei dati importati (es. il
cambio nella tabella Cambi).

Applica regole (solo piano Advanced)

L'opzione non è disponibile  per importazioni di movimenti da file di contabilità in partita doppia
(formato ac2).

Vedi: Regole per il completamento automatico delle registrazioni.

Se questa opzione è attivata, quando si conferma con OK, si apre il dialogo Applica Regole.
Se non hai attivato questa opzione, puoi accedere alle Regole anche impartendo il comando dal
menu Azioni → Registrazioni ricorrenti → Applica regole...
Questa opzione viene attivata di default se ci sono già delle regole di importazione nella tabella
Registrazioni ricorrenti.

 Conto temporaneo di Contropartita

L'opzione non è disponibile per importazioni di movimenti da file di contabilità in partita doppia
(formato ac2).

Si indica un conto che serve per completare la contropartita della registrazione. Il conto deve poi
essere sostituito con la contropartita corretta, manualmente o con le regole per il completamente
automatico.
Il programma propone di default il conto commentato [CA] (ContraAccount).
Una volta completate le registrazioni, non ci dovrebbero più essere movimenti che usano il conto
temporaneo.

http://www.banana.ch/doc/it/node/9973
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Numero documento iniziale

L'opzione non è disponibile per importazioni di movimenti da file di contabilità in partita doppia
(formato ac2).
È il numero di documento che si attribuisce alla prima registrazione tra quelle importate.
Il numero viene incrementato.

Raggruppa registrazioni per numero Fattura

Se il file di importazione contiene dei valori nella colonna DocInvoice, nel dialogo ci saranno anche le
seguenti opzioni:

Raggruppa registrazioni per numero fattura
In questo caso le righe di una medesima fattura sono raggruppate in modo che vi sia una sola
registrazione per lo stesso conto e lo stesso codice IVA (vedi spiegazione importa dati fattura in
inglese).
Conto destinazione per differenze saldi 
Quando si utilizzano dei codici IVA, è possibile che ci siano delle differenze di arrotondamento di
pochi centesimi.
In questo caso, Banana Contabilità Plus crea per ogni fattura una registrazione supplementare
dove registrare la differenza.
Si deve fare attenzione ovviamente che i dati forniti per l'importazione si bilancino fra Dare e
Avere. In caso contrario, la riga di registrazione contiene la differenza fra Dare e Avere.

 Modifica delle registrazioni importate
Il programma crea delle registrazioni e le aggiunge alla fine della tabella Registrazioni.
I movimenti possono essere modificati o cancellati.
Nella contabilità in partita doppia, nelle colonne ContoDare e ContoAvere e nella contabilità Entrate
/ Uscite, nelle colonne Conto e Categoria, il programma inserisce dei simboli.
I simboli devono essere sostituiti con il il conto o la categoria appropriati.

[A]
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Questo simbolo viene indicato se nel dialogo non viene indicato alcun conto.
Al posto del simbolo [A] si deve inserire il conto della contabilità relativo al conto bancario.
[CA]
Questo simbolo indica che nella cella bisogna indicare il conto della contropartita, in modo che i
movimenti in Dare si compensino con quelli in Avere. 

Per le righe con una sola contropartita, sulla medesima riga vi è sia il conto o il simbolo [A]  e il
simbolo [CA] della contropartita.
Per le righe con più contropartite, ogni riga avrà il conto o il simbolo della contropartita [CA]. Se non
venisse indicato il simbolo [CA], sarebbe impossibile capire se il movimento è in Dare o in Avere.
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Importa i movimenti bancari nel formato ISO
20022 (generico)

Banana Contabilità Plus permette l'importazione dei movimenti bancari in diversi formati. 
Il formato ISO 20022 è uno standard internazionale per la trasmissione di dati finanziari che
dovrebbe ormai essere messo a disposizione da tutte le banche europee.
Questo formato può anche essere chiamato ISO xml, xml, camt.053, camt.054 o altro. Per alcune
banche il formato ISO 20022 potrebbe non essere disponibile di default ma deve essere richiesto. Il
formato ISO 20022 sostituisce il vecchio standard MT940.
Con l'importazione dei dati bancari con il formato ISO20022, Banana Contabilità Plus permette anche
di chiudere automaticamente le fatture aperte dei clienti e fornitori.

La categoria CAMT raggruppa i formati utilizzati per l'invio dell'estratto conto, movimenti contabili e
per la conferma dello stato del conto:

camt052: Report contabile
camt053 (inclusa versione 4): Estratto conto
camt054: Avviso di addebito e accredito.

Anteprima del file ISO-20022
Banana Contabilità Plus offre la possibilità di vedere il contenuto di un camt in anteprima.

Importazione dei dati nella contabilità esistente
Procedi come indicato alla pagina menu Azioni > Importa in contabilità.
Con questa funzione è anche possibile aprire un file compresso. Il programma in questo caso chiede
di scegliere il file da dove importare i dati nel file compresso.

Note tecniche relative alla conversione del file ISO 20022
Lo standard ISO 20022 codifica i dati contabili dell'estratto conto in modo molto preciso. Lascia però
anche diversa libertà per inserire informazioni aggiuntive del conto e dei movimenti.

Banana quando legge il file cerca di adattarsi alle modalità con il quale è stato predisposto il file ISO
20022.

Legge come saldo iniziale le codifiche simili.
Legge come saldo finale le codifiche simili.
Tutti i movimenti contenuti sono letti e trasformati in movimenti

Data operazione (Data)
Data valuta
Importo movimento (in positivo o negativo)
Descrizione
Per il momento Banana Contabilità Plus  assembla le varie descrizioni in un testo unico. In
futuro è prevista la possibilità di estrarre più specificatamente questa informazione e
indicare altre colonne dove destinarla.
Separazione in movimenti singoli o con dettaglio
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Per quelli con dettaglio vi è una riga per il movimento complessivo e delle righe per i
diversi singoli movimenti che lo compongono.

Specifiche nazionali
Ogni nazione e/o banca ha la possibilità, secondo le proprie esigenze, di inserire delle informazioni
supplementari nel file ISO 20022. Banana Contabilità Plus offre un filtro generico distribuito con
l'applicazione , e più filtri specifici ad una nazione e/o banca distribuiti come Estensioni Banana. Per
importare in contabilità queste informazioni supplementari è necessario installare  ed utilizzare il
filtro più specifico alla propria nazione e/o banca (es. Estratto bancario Camt ISO 20022 Svizzera
(Banana+) ).

https://www.banana.ch/apps/it/node/8226
https://www.banana.ch/apps/it/node/8226
https://www.banana.ch/apps/it/node/9295
https://www.banana.ch/apps/it/node/9660
https://www.banana.ch/apps/it/node/9660
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Importa movimenti (generico)

La spiegazione che segue si riferisce all'importazione di dati nella tabella Registrazioni da file che
contengono movimenti del tipo partita doppia, di Banana Contabilità, o di altri formati.

L'importazione di movimenti bancari  è simile all'importazione di movimenti, ma viene trattata
separatamente in dettaglio nell'apposita pagina.

Procedura per l'importazione
Dal menu Azioni > Importa in contabilità > nella casella Importa selezionare1.
Registrazioni
Scegliere il tipo di file da importare2.
Vedi spiegazioni che segue.
Con il bottone Sfoglia, scegliere il file da dove si desidera importare i movimenti.3.
Impostare i parametri come necessario.4.
Vedi anche: Importa in contabilità

Un volta confermato l'OK, i dati vengono letti e viene visualizzato il dialogo seguente:

Dialogo importa movimenti.
Dove si devono dare indicazioni per il completamento delle righe importate.

Importazione da altri file di Banana Contabilità
Nel tipo di file da importare, il programma mette a disposizione una serie di predisposizioni per
importare dati da altri file di Banana Contabilità:

Importa movimenti da contabilità entrate e uscite (*ac2)
Per poter importare i movimenti da un file di contabilità entrate / uscite, in un file di contabilità
in partita doppia è necessario che i conti e le categorie della contabilità entrate / uscite siano
corrispondenti ai conti della contabilità in partita doppia.
Importa movimenti dal Cash Manager (*ac2)
Si veda l'apposita pagina Importare i dati dalla cassa.

http://www.banana.ch/doc/it/node/9994
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Importa movimenti da contabilità in partita doppia (*ac2)
Per poter importare i movimenti da un file di contabilità in partita doppia in un altro file di
contabilità in partita doppia è necessario che i conti siano corrispondenti.
Importa registro beni ammortizzabili
Importa i movimenti dal file .ac2 del Registro beni ammortizzabili.

Importa file TXT/CSV
Questo formato deve essere utilizzato per esportare i dati da un altro software, che mette a
disposizione un formato di esportazione compatibile con quello richiesto da Banana Contabilità. Vedi
le informazioni al link seguente:

Indicazioni tecniche per creare un file da importare in Banana Contabilità Plus (lingua inglese). 

Importazione estratti conto con estensione importazione
Le Estensioni di importazione  sono dei programmi aggiuntivi, che devono essere istallati dall'utente
e convertono i dati per l'importazione in Banana Contabilità.

Ci sono estensione per l'importazione di estratti conto bancari di diverse banche, carte di credito e
altri formati.

Elenco aggiornato delle Estensioni Banana per l'importazione

Questa tipologia di estensioni funziona solo con il piano Advanced . Tutti i vecchi filtri con il tempo
verranno aggiornati e le nuove versioni saranno utilizzabili solamente per chi possiede il piano
Advanced.

Cercare e installare un'estensione:

Cliccare su Gestione Estensioni
Scegliete Importazione.
Posizionarsi sull'estensione desiderata e cliccate su Installa.
Se appare il bottone Impostazioni, vuol dire che questa estensione ha dei parametri che
potete personalizzare.

Una volta che l'estensione è istallata appare nell'elenco dei tipi disponibili, direttamente nel menu
Estensioni e puoi sceglierla per l'importazione.

http://www.banana.ch/apps/it/node/9561
https://www.banana.ch/apps/it/extensions?combine=&langcode=All&country=All&type=265&op=Invia#
https://www.banana.ch/it/advanced
http://www.banana.ch/doc/it/node/4702
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Importare movimenti dal Cash Manager

I movimenti di un file Cash Manager si possono gestire separatamente dal file della contabilità
principale tramite il Cash Manager. A scadenze regolari, i movimenti si importano nel file della
contabilità principale, raggruppandoli in base a un periodo prescelto.

In questo caso si hanno due file separati:

Un file contiene tutti i dati della contabilità generale (compreso il conto cassa).1.
Un file contiene solo i dati della cassa.2.

Per poter integrare i dati della cassa nella contabilità principale, si deve stabilire un collegamento tra
la contabilità principale e il file del Cash Manager.
Ci sono due modi diversi per creare il collegamento:

Nel file del Cash Manager attribuire alle categorie gli stessi numeri dei conti della contabilità
principale (contabilità in partita doppia o Entrate / Uscite).

Nel file del Cash Manager riportare nella colonna Categoria2 (tabella Categorie) i corrispondenti
conti della contabilità principale.
Se la colonna Categoria2 non fosse presente, è necessario visualizzarla tramite il menu Dati →
Disponi colonne.

Impostare il conto di giro per i versamenti
Quando si esegue l'importazione dei dati della cassa nel file della contabilità, affinché non ci siano
delle sovrapposizioni di scritture contabili per le operazioni di versamento, tra il conto cassa della
contabilità principale e i movimenti importati dal file Cash Manger, occorrono determinate
impostazioni.

Nel file della Contabilità principale:

Nella tabella Conti, nel gruppo degli attivi inserire il Conto di giro.

Nel file del Cash Manager:

Nella tabella Categorie, colonna Categorie nel gruppo delle Entrate inserire, come categoria
per i versamenti dal conto corrente bancario o postale, il conto di giro (lo stesso numero
impostato nella contabilità principale).
In alternativa, nella tabella Categorie, colonna Categorie2 nel gruppo delle Entrate inserire il
Conto di giro. In questo caso nella colonna Categorie si imposta una categoria per
determinare i versamenti dalla banca. Il conto di giro, che si trova nella colonna Categorie2,
crea il collegamento quando si importano le registrazioni nella contabilità principale.

Versamenti dal conto corrente bancario alla cassa
Ogni qualvolta si effettua un versamento dal conto corrente bancario alla cassa, si registra il
movimento sia nel file della contabilità principale, sia in quello della cassa. Per evitare sovrapposizioni
di scritture contabili quando si importano i dati dalla cassa si utilizza il conto di giro.
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Nel file della cassa si registra l'entrata dei fondi, utilizzando come categoria il conto di giro o in
alternativa la categoria per i versamenti dal conto corrente bancario, se il conto di giro è stato
impostato nella colonna Categoria2.
Nel file della contabilità principale si registra l'uscita dei fondi, con il conto bancario in avere e
in dare il conto di giro.

Nell'importazione dei dati della cassa nel file della Contabilità principale, il conto di giro si azzera.

Importare i dati del Cash Manager
Aprire il file della Contabilità principale
Cliccare sul menu Azioni→ Importa in contabilità
Nella finestra che appare, dal menu a tendina Importa → selezionare Registrazioni →
Movimenti libro cassa (*.ac2)"
Tramite il tasto Sfoglia, selezionare il file del Cash Manager.

Le spiegazioni di questa finestra sono disponibili alla pagina web Importa in contabilità
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In contabilità

Conto destinazione

Si deve selezionare il numero di conto della cassa, presente nella Contabilità in partita doppia o nella
Contabilità entrate / uscite, dove devono essere importati i movimenti.

Numero documento iniziale

Si può inserire un numero di documento iniziale che viene attribuito alla prima registrazione
importata. Il programma nelle registrazioni successive attribuisce in automatico un numero
progressivo, partendo da quello iniziale inserito.
Se non si desidera attribuire la numerazione progressiva in automatico si lascia la casella vuota.

Seleziona movimenti

Data Inizio / Data fine (compresa)

Si inserisce la data iniziale e finale del periodo al quale si riferiscono i movimenti importati.

Raggruppa movimenti

Attivando una delle opzioni è possibile scegliere come devono essere raggruppati i movimenti del
periodo:

Nessun raggruppamento per periodo
Sono importati tutte le righe, con i relativi contenuti delle colonne.  È importato anche il numero
Doc presente nella corrispondente colonna del file della cassa.
Se nella contabilità si vuole usare una numerazione diversa e allo stesso tempo conservare il
documento originale del file, nel Cash Manager inserire il documento nella colonna 
DocProtocollo. 
Mensile - raggruppa i movimenti per mese.
Trimestrale - raggruppa i movimenti per trimestre.
Semestrale - raggruppa i movimenti per semestre.
Annuale - raggruppa i movimenti per anno.
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Una registrazione per conto

Se più categorie vengono raggruppate in un unico conto della contabilità, ma si desiderano
registrazioni separate per ogni categoria, bisogna attivare questa casella; il programma crea delle
registrazioni per ogni categoria. Quando si usano dei codici IVA vengono create delle registrazioni non
solo per categoria, ma anche per codici IVA diversi per la medesima categoria.

Nota

Quando si ha una contabilità con IVA, i calcoli dell’IVA possono risultare leggermente diversi. Se gli
importi delle registrazioni sono inseriti al netto, anche il saldo del conto cassa, a causa delle
differenze di arrotondamento, può essere diverso.

Il file della contabilità viene aggiornato con i dati della cassa.
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Importa movimenti Paypal

Nella pagina web Filter for PayPal transactions  sono pubblicate le informazioni sulla nuova funzione
che consente d'importare tutti i movimenti da PayPal direttamente in Banana Contabilità, e le
istruzioni su come procedere (vedi sotto).

Abbiamo preparato anche dei modelli predefiniti specifici per la contabilità in partita doppia e per la
contabilità multimoneta, da visionare come guida d'esempio, oppure, da utilizzare come file separato
per registrare unicamente le transazioni PayPal.

Le informazioni su tutti i tipi di filtri d'importazione sono presenti alla pagina Import filters.
I modelli e le pagine relative alle informazioni sono in lingua inglese:

Filtro per importare i movimenti PayPal (inglese) - come procedere .
Esempi per la contabilità in partita doppia .
Esempi per la contabilità multimoneta .

Approfondimenti:

Contabilità in partita doppia.
Contabilità multimoneta.
Lista completa dei filtri di importazione .

https://www.banana.ch/apps/it/node/9472
https://www.banana.ch/apps/en/importfilters
https://www.banana.ch/apps/it/node/9472
https://www.banana.ch/apps/node/5020
https://www.banana.ch/apps/node/5019
http://www.banana.ch/apps/en/importfilters
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Importa conti

Questo comando importa i conti da un file di Contabilità in partita doppia o da una Contabilità Entrate
/ Uscite (*.ac2) o di testo (*.txt), integrandoli automaticamente nel piano contabile corrente.

Per importare i conti da un altro file, procedere come segue:

Dal menu Azioni → Importa in contabilità → nella casella Importa selezionare Conti.1.
Selezionare il tipo di file *.ac2 o di testo per importare i conti.2.
Con il bottone Sfoglia, scegliere il file da dove si desidera importare i Conti.3.

I conti o le categorie possono essere ripresi nella contabilità corrente, attivando le seguenti opzioni:
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Opzioni

Importa anche centri di costo

Nel caso che siano presenti dei centri di costo, i conti dei centri di costo vengono ripresi.

Aggiungi conti inesistenti

Se attivata, l'opzione permette di aggiungere tutti i nuovi conti nel piano contabile.

Rimpiazza testo descrizione

Se si importano conti già esistenti, ma con descrizione diversa, la descrizione del conto esistente
viene rimpiazzata da quella importata.

Rimpiazza saldo d’apertura

Se si importano conti già esistenti, ma con saldo iniziale diverso, il saldo di apertura del conto
esistente viene rimpiazzato da quello importato.
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Importa codici IVA

La funzione è presente solo nella Contabilità con IVA e permette d'importare i Codici IVA  nei
seguenti file:

File di contabilità (*.ac2).
File di testo con intestazione colonne (file di testo *.txt).

Importa da un file di contabilità
Se gestisci diverse contabilità e usi dei codici IVA personalizzati, puoi preparare la tabella codici IVA e
poi importarla negli altri file. 

Preparare la tabella Codici IVA nel proprio file di contabilità.
Comando Azioni > Importa in Contabilità > Codici IVA
Scegliere il nome del file che contiene la Tabella Codici IVA aggiornata.
Scegliere sostituire tutte le righe.

Opzioni importazione Codici IVA
Quando si importa da un altro file si hanno a disposizione diverse possibilità.

Aggiungi nuovi codici e nuovi gruppi

Se viene scelta questa opzione, vengono aggiunti i nuovi codici e mantenuti i codici già esistenti.

Sostituisci tutte le righe

Se viene scelta questa opzione, tutti i codici IVA esistenti vengono sostituiti con i Codici IVA importati.
Questa opzione è da scegliere se si vuole riprendere per intero i codici IVA.

Messaggio Conto IVA non trovato
Se appare il messaggio Conto IVA non trovato, occorre inserire il conto IVA in automatico nel menu
File > Proprietà file > sezione IVA.

Importare i Codici IVA Svizzeri predefiniti
Questa procedura indica come importare i codici IVA dal modello con i Codici IVA predefiniti 2024, che
contengono sia le aliquote 2024 (IVA 8.1%) e quelle 2018 (IVA 7.7%) .

Vedi anche pagina Codici IVA Svizzera

Cliccare sul menu Azioni → Importa in contabilità.
Selezionare Codici IVA.
Selezionare Svizzera nuove aliquote: nella casella in basso appare in automatico il file
contenente i nuovi Codici IVA 2024.
Se trattasi di Codici IVA di un'altra nazione, occorre selezionare il file contenente i codici IVA in
vigore secondo la propria nazione.
Confermare, cliccando sul bottone OK.

https://www.banana.ch/it/node/10872
https://www.banana.ch/area/it/node/10500
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Segue la finestra di dialogo seguente

Documentazione Gestione IVA
Per maggiori informazioni vedi pagina Gestione IVA.
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Importa file

La funzione permette d'importare i dati da un altro file di Banana contabilità dello stesso tipo.

Per importare i dati da un File Banana Contabilità, procedere come segue:

Dal menu Azioni → Importa in contabilità → nella casella Importa selezionare File.1.
Selezionare il tipo di file *.ac2 per importare i dati.2.
Con il bottone Sfoglia, scegliere il file da dove si desidera importare i dati.3.

Segue la finestra di dialogo con diverse opzioni che permettono di determinare quali dati importare
dal file.
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File sorgente

È il file dal quale sono ripresi i dati.

File destinazione

È il file che riceve i dati.

Opzioni

Importa movimenti

Vengono importate tutte le righe della tabella Registrazioni presenti nel file sorgente.

Importa registrazioni ricorrenti

Vengono importate tutte le righe della tabella Registrazioni ricorrenti presenti nel file sorgente.

Importa registrazioni preventivo

Vengono importate tutte le righe della tabella Preventivo presenti nel file sorgente.

Sostituisci importi della tabella Conti

Gli importi delle colonne Apertura, Preventivo e Precedenti della tabella Conti del file di destinazione
vengono cancellati e sostituiti con gli importi presenti nel file sorgente.

I conti devono avere una corrispondenza, dovuta agli stessi numeri di conto, oppure, quando vi è una
sostituzione, nel caso si usi l'opzione Converti numeri conto.

Sostituisci proprietà file (dati base)

I dati delle proprietà file del file di destinazione vengono sostituiti con quelli del file sorgente.

Converti numeri di conto

Usando questa funzione i numeri di conto importati saranno sostituiti con quelli indicati nella colonna
alternativa. 
Se si usa questa funzione, bisogna specificare anche la colonna nella quale sono indicati i numeri di
conto da usare nell'importazione, al posto di quelli esistenti.
Accanto al numero di conto ci deve essere una colonna che indica il numero alternativo da usare
nell'importazione.
Se non è specificato alcun abbinamento viene usato il numero di conto originale, presente nel file
sorgente.

Gli abbinamenti dei conti sono nel file sorgente
Si usa questa opzione quando per esempio si tiene la contabilità in una nazione, con una certa
numerazione, e regolarmente si importano i movimenti in una contabilità con una numerazione
diversa del piano dei conti.

Aggiungere nel piano dei conti una nuova colonna di testo (Comando Disponi colonne).
Per ogni conto indicare nella tabella il numero di conto di destinazione.  

Gli abbinamenti dei conti sono nel file di destinazione
Questa opzione serve quando per esempio si vuole passare a un piano dei conti con una
numerazione e raggruppamenti nuovi.
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Si crea un nuovo file di contabilità con il piano dei conti nuovo.
Si aggiunge nel piano dei conti una colonna, per inserire gli abbinamenti dei conti
(comando Disponi colonne).
In questa colonna indicare i numeri di conto della tabella sorgente. 
Separare i conti con un punto e virgola "1000;1001" per indicare che in questo conto
devono essere raggruppati più conti. 

Colonna contenente gli abbinamenti (Tabella Conti)
È la colonna aggiunta dove vengono inseriti gli abbinamenti dei conti.

Questa opzione si usa quando si passa da un piano dei conti ad un altro e quando bisogna convertire i
conti da una numerazione all'altra.

Per maggiori informazioni sulla conversione del piano contabile, consultare la pagina sulla migrazione
dei dati contabili verso i nuovi piani.

Risultato e possibili errori
Il programma riprende tutti i dati della contabilità precedente, convertendo i numeri di conto. 

Se il programma segnala degli errori (mancano conti o altro) bisogna probabilmente annullare
l'operazione d'importazione, completare gli abbinamenti e poi ripetere l'operazione d'importazione.

Il programma, per il fatto che trova piani dei conti diversi, non può verificare in automatico che tutti i
dati siano stati importati e raggruppati correttamente.

È opportuno comunque controllare manualmente il risultato, verificando che i totali del bilancio e del
conto economico siano corretti.

Opzioni avanzate d'importazione
Per altre esigenze di conversione più complesse, si rimanda agli script che permettono di
personalizzare totalmente la conversione e l'importazione.
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Importa cambi

Questa opzione è presente solo nelle Contabilità in partita doppia multi-moneta . Consente
d'importare i cambi dalla tabella cambi di un altro file.

Come procedere:

Dal menu Azioni → Importa in contabilità → nella casella Importa selezionare Cambi.1.
Selezionare il tipo di file *.ac2 dello storico cambi o il file di testo:2.
Con il bottone Sfoglia, scegliere il file da dove si desidera importare i dati.3.

Nota

lo storico cambi è un file che presenta solo la tabella Cambi, dove vengono memorizzati i cambi che si
riferiscono a delle date specifiche.

Segue la finestra che presenta delle opzioni:

https://www.banana.ch/doc10/it/node/2618
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Seleziona data

Nella finestra vengono elencate delle date con i cambi usati di recente. Se si seleziona una data, il
programma riprende i cambi utilizzati in quella data determinata.

Sostituire cambi

Se si attiva questa opzione, nella tabella cambi vengono sostituite tutte le righe dei cambi con quelli
importati.

Aggiorna righe

Se si attiva questa opzioni, nella tabella cambi vengono aggiornate solo le righe dei cambi che hanno
valori diversi.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 846

Regole per il completamento automatico
delle registrazioni importate

La funzionalità di completamento automatico delle registrazioni importate ti permette di ridurre
drasticamente il tempo necessario alla tenuta della contabilità e di ridurre la possibilità di errori.
A dipendenza del numero di registrazioni che hai il risparmio di tempo può essere anche di ore.

▶ Video: Importa e completa le registrazioni in automatico (introduzione)
▶ Video: Regole per completare le registrazioni importate (dialogo Applica regole) .
▶ Video: Regole per completare le registrazioni importate (tabella Registrazioni ricorrenti) .

Completamento automatico registrazioni importate
Dopo avere importato i movimenti bancari, le registrazioni devono essere completate con la
contropartita dare o avere, il codice IVA, Centri di costo o altre informazioni. Per esempio quando
importi un movimento in uscita che indica un pagamento alla ditta "Swisscom" significa che dovrai
completare la colonna Conto Dare con "Spese telefoniche" e la colonna Codice IVA con "M81".

Il comando Applica regole, esegue in automatico il completamento delle registrazioni importate.
Inserisce quindi in automatico il conto di contropartita, Codice IVA, centro di costo, segmenti, ecc.
usando le regole di completamento, che avrai provveduto a inserire.

Le regole per il completamento
Le regole sono delle righe di registrazioni preimpostate, che contengono informazioni che servono al
programma per:

Identificare le registrazioni importate da completare
Se inserisci nella colonna Descrizione "Swisscom" la regola verrà applicata alle registrazioni
importate che contengono nella descrizione il testo "Swisscom".
Indicare gli elementi per completare la registrazione

Nella colonna Conto Dare inserisci il conto "Spese telefoniche".
Nella colonna IVA inserisci il codice "M81".

Le regole di completamento sono salvate nella Tabella Registrazioni ricorrenti. Le puoi inserire e
modificare direttamente nella tabella o usare il dialogo Aggiungi/Modifica regole, durante la fase di
applicazione delle regole.

Flusso di lavoro
Importa i movimenti bancari1.
Il programma crea le righe di registrazione con data, descrizione, importo, conto, numero
documento, cambi.
Si apre il Dialogo Applica Regole2.

https://www.banana.ch/it/node/11531
https://www.banana.ch/it/node/11531
https://www.banana.ch/it/node/11531
https://www.banana.ch/it/node/11679
https://www.banana.ch/it/node/11679
https://www.banana.ch/it/node/11679
https://www.banana.ch/it/node/11680
https://www.banana.ch/it/node/11680
https://www.banana.ch/it/node/11680
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Vedi le registrazioni che saranno completate in automatico usando le regole esistenti.
Puoi modificare o cancellare le regole esistenti.
Aggiungi nuove regole per le registrazioni che non hanno una regola.
Nella regola inserisci il testo da cercare, la contropartita e le altre informazioni per
completare le registrazioni.
Clicca sul bottone Applica regole.

Nella tabella Registrazioni trovi i movimenti, completi di contropartita, codice IVA, centro di3.
costo e altre informazioni che hai indicato nelle regole.
Nella tabella Registrazioni Ricorrenti trovi le regole che hai aggiunto.4.

Per potere utilizzare le Regole di completamento automatico è necessario il piano Advanced.

Come iniziare
I clienti che hanno usato la funzionalità sono entusiasti, e ci testimoniano che, trascorsa una fase
iniziale necessaria per capire il funzionamento delle regole e come usarle al meglio, il loro lavoro
contabile si è ridotto sensibilmente.
Mettiamo volentieri a disposizione la seguente documentazione, per permetterti di provare e fare
pratica con degli esempi:

Introduzione alle regole
Iniziare con l'utilizzo delle regole

Principali vantaggi
I vantaggi del sistema di completamento sono immediatamente evidenti:

Completi in pochi secondi le registrazioni.
Eviti errori e dimenticanze.
Puoi delegare facilmente il lavoro di importare i dati in contabilità.

Il sistema di completamento è basato su regole:

Si integra perfettamente nella logica della partita doppia.
Completa le registrazioni in modo preciso e affidabile.
Può essere usato immediatamente, anche senza una base dati di apprendimento.
Può essere controllato e modificato a piacimento.

Aggiunta di regole
Le regole sono salvate nella Tabella Registrazioni Ricorrenti e possono essere aggiunte nei modi
seguenti:

Quando si importano i movimenti, Dialogo Applica regole, comando aggiungi Regola.
Nella Tabella Registrazioni con il Menu Azioni > Registrazioni ricorrenti > Crea regole dalla
selezione.
Nella Tabella Registrazioni con un click con il tasto destro del mouse su un movimento senza
regole > Crea regole dalla selezione.
Manualmente nella Tabella Registrazioni ricorrenti.

https://www.banana.ch/it/update
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Regole = Base di conoscenza
Ti accorgerai che le regole diventano una preziosa base di conoscenza che raggruppa la logica con la
quale devono essere registrate le diverse operazioni in contabilità. Puoi infatti:

Se non ti ricordi, vedere come sono registrate determinate operazioni.
Spiegare a persone, che devono occuparsi della contabilità, come registrare le varie operazioni.
Definire per il revisore come registrare certe operazioni.
Adattare le regole nel caso cambino i codici IVA oppure aggiungere o rimuovere dei conti, centri
di costo o altro.

Processo di completamento veloce e preciso
L'Intelligenza Artificiale (AI) viene sempre più usata nei sistemi di automazione.
In collaborazione con i nostri utenti abbiamo sviluppato un sistema per il completamento automatico
delle registrazioni importate che si basa sulle Regole.
Ci sembra un approccio molto più efficace perché:

Offre un grado di controllo e precisione molto alti.
Per esempio, i pagamenti eseguiti a compagnie di assicurazione possono essere attribuiti con
precisione ad un conto, sulla base del numero di contratto.
Tutte le regole sono elencate nella tabella Registrazioni ricorrenti e si possono facilmente
modificare (per esempio quando cambia l'IVA) e servono come base di conoscenza e di
controllo.
Non richiedono una fase di apprendimento e funzionano perfettamente anche per i pagamenti
che avvengono solo una o poche volte all'anno.

Per chi è interessato a capire a fondo come funziona il sistema delle regole, qui di seguito sono
elencate tutte le funzionalità:

Le regole vengono salvate nella tabella Registrazioni Ricorrenti come delle normali registrazioni:
Puoi indicare il testo, come parola chiave da cercare, nel movimento importato,
combinando più testi assieme.
Per completare le registrazioni importate, oltre alla contropartita, puoi specificare altri
elementi, come centri di costo, segmenti, codice IVA ecc..
Nella colonna Link puoi indicare fra parentesi quadre [ ] il testo da cercare per individuare
subito il file del giustificativo, velocizzando quindi l'abbinamento dei giustificativi.
La regola può anche generare delle registrazioni su più righe (!RuleSplit).
Le regole sono chiaramente visibili e possono essere modificate e cancellate.

Aggiungere nuove regole è semplice:
Basta aggiungere una nuova riga nella Tabella Registrazioni Ricorrenti oppure fare il copia
incolla da una esistente.
Il comando Crea regola da Registrazione parte da una registrazione esistente.
Con il comando Applica regole puoi creare nuove regole partendo dalle registrazioni
importate.

Il comando Applica Regole è il fulcro del processo di auto-completamento delle registrazioni
importate.
Ti permette di vedere e controllare il processo di auto-completamento.
Vedi quale regole vengono usate:

Puoi disattivare l'applicazione di una regola a tutte le registrazioni.
Vengono segnalate le regole che sono duplicate o in conflitto.
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Puoi aggiungere nuove regole e modificare o cancellare quelle esistenti.
Vedi a quali registrazioni le regole sono applicabili:

Vedi come sono completate le registrazioni.
Puoi disattivare l'applicazione a delle specifiche registrazioni.

Vedi le registrazioni che non hanno alcuna regola:
Puoi creare una nuova regola riprendendo i dati.
Puoi lasciarle non completate.

Scegli tu quando dare il comando applicare le regole:
Puoi applicare le regole in modo selettivo e continuare a lavorare sulle altre.
Puoi uscire dal dialogo e riprendere successivamente.
Puoi annullare l'operazione di applicazione delle regole e ripeterla successivamente.
Il comando Applica, salva anche le modifiche che hai apportato alle regole.

Puoi scegliere quando richiamare il dialogo Applica regole:
Subito dopo l'importazione dei movimenti bancari.
In qualsiasi altro momento che ti è più comodo.

Quando passi al nuovo anno tutte le regole vengono riprese:
Puoi facilmente adattarle alle nuove necessità, come per esempio il cambio dell'IVA,
aggiunta o eliminazione di conti.
Vale quindi la pena creare regole anche per operazioni che ricorrono una o solo poche
volte all'anno.
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Come funzionano le regole di completamento
delle registrazioni importate

Il comando Applica regole usa delle registrazioni modello, presenti nella tabella Registrazioni
ricorrenti, menu Azioni, per completare in automatico le registrazioni importate dagli estratti conto
bancari, postali o carte di credito.

Qui di seguito vengono spiegati visivamente i principi del funzionamento delle regole e come vengono
applicate. 
Il processo può essere riassunto in due passaggi principali:

Importazione dei movimenti bancari nella tabella Registrazioni.1.
Completamento automatico delle registrazioni sulla base delle regole.2.

Importazione dei movimenti bancari 
Quando si importano i dati dagli estratti conto bancari, il programma

Crea delle righe di registrazione riprendendo dati bancari, data, descrizione, importo ed
eventuali numeri di riferimento.
Inserisce nella registrazione il conto bancario da dove provengono i movimenti, che l'utente ha
indicato nel dialogo Importa Movimenti.

Per quei movimenti con un importo in uscita complessivo e righe con i dettagli dei diversi
pagamenti, per cui in Banana si richiede una registrazione su più righe, generalmente il
programma mette nelle righe di dettaglio solo il conto della contropartita temporanea.
Se però nel dialogo di importazione è attiva l'opzione Applica regole, il programma
inserisce anche il nome del conto bancario fra parentesi quadre [] (conto commentato).
Questo conto commentato serve alla funzione Applica regole per sapere quale è il conto
di provenienza. Il conto commentato viene poi cancellato quando viene applicata la
regola.

Per ogni movimento, inserisce il conto di Contropartita temporanea [CA] indicato nel dialogo
Importa movimenti. Se vengono importati gli accrediti di fatture emesse con numero di
riferimento ed è stata correttamente impostata l'estrazione del conto cliente dal numero di
riferimento questi accrediti saranno registrati automaticamente senza usare la Contropartita
temporanea [CA].

Completamento delle registrazioni con le regole
Le registrazioni importate sono completate in automatico sulla base delle regole che sono state
impostate:

Per l'applicazione delle regole, il programma considera le registrazioni che contengono la
contropartita temporanea.
La funzione Applica regole sostituisce la contropartita temporanea con il conto indicato e
completa le registrazioni con gli altri valori indicati nella regola (IVA, Centri di costo, ecc.).
Per le registrazioni senza una regola applicabile,

Si può creare una regola specifica, per registrazioni che si ripetono nel tempo.
Si può completare la registrazione manualmente.
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La funzione Applica regole è terminata quando non ci sono più registrazioni che contengono la
contropartita temporanea.

Regole
Le regole sono delle registrazioni modello già complete, presenti nella tabella Registrazioni
ricorrenti, dove:

La colonna Descrizione contiene il testo (una o più parole chiave) che la registrazione
importata deve contenere.
Le colonne Conto Dare e Conto Avere contengono la Contropartita che va a rimpiazzare
quella temporanea.

Quando la descrizione inizia con il "+" tutte le parole devono essere presenti nel testo della
registrazione importata in qualsiasi posizione. Nell'esempio il pagamento alla compagnia
assicurativa viene registrato su conti diversi in base al numero di polizza.

Registrazioni completate (Risultato)
Se ci sono dei valori definiti nelle colonne della regola che hanno una corrispondenza con i movimenti
importati, il comando Applica regole sostituisce la contropartita temporanea e completa le colonne
vuote. In questo esempio il programma completa con l'inserimento del conto di contropartita e del
Codice IVA.
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Come nell'esempio, se rimane solo una registrazione da completare, puoi registrare manualmente
oppure puoi creare anche per questa registrazione un'apposita regola.

Ulteriore completamento manuale
Se, dopo aver applicato la regola, hai la necessità di completare o verificare ulteriormente le
registrazioni, può essere utile fare in modo che queste registrazioni possano essere trovate
facilmente:

Nella tabella delle Registrazioni ricorrenti, alla riga della regola assegna un colore.
Successivamente, quando importi, il colore verrà assegnato alla riga d'importazione nella
tabella Registrazioni.
Inserisci un valore temporaneo nella colonna che deve essere completata.

Registrazioni prima dell'applicazione della regola 

Nell'esempio, nella colonna Link viene inserito  [Doc] che significa che la registrazione deve essere
collegata al file del giustificativo.

Definizione della regola

Registrazioni dopo l'applicazione della regola 

Crea Regole con dialogo Applica regole
Le regole possono essere anche create a partire dal dialogo Applica regole.
Una volta create le regole, queste vengono inserite nella tabella Registrazioni ricorrenti.
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Crea Regole partendo da una registrazione
Quando sei nella tabella Registrazioni puoi creare una regola:

dal menu Azioni > Registrazioni ricorrenti > Crea regole dalla selezione,
fai un click con il tasto destro del mouse su un movimento senza regole e scegli Crea regole
dalla selezione.

La riga di registrazione viene inserita nella tabella Registrazioni ricorrenti, riportando nella colonna
Doc il testo "!Rule".

Registrazioni su più righe
Nel caso in cui l'operazione debba essere scomposta e registrata su più righe è possibile anche creare
delle regole "!RuleSplit".

Registrazioni prima dell'applicazione della regola su più righe 

Definizione della regola su più righe 

Registrazioni dopo l'applicazione della regola su più righe 
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Funzionalità al momento non disponibili
Queste funzioni, seppur richieste da alcuni utenti, non sono attualmente disponibili:

Possibilità di cambiare il testo della registrazione, per accorciarlo e semplificarlo.
Per le registrazioni su più righe, possibilità si usare delle formule, che calcolano gli importi in
base all'importo della registrazione importata.
Possibilità di applicare una regola in base alla data della registrazione (condizione: colonna
Data)
 

Elenco completo funzionalità al momento non disponibili

https://www.banana.ch/doc/it/features_not_available
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Come iniziare con l'uso delle regole per il
completamento registrazioni

 La prima volta che usi le regole procedi nel modo seguente:

1. Impartisci il comando Importa in contabilità
Usa il comando dal menu Azioni > Importa in contabilità > Registrazioni.
Seleziona il formato appropriato e indica il percorso dove si trova il file con i dati del tuo estratto
conto bancario
Vedrai visualizzato questo dialogo

Imposta il conto di destinazione, relativo al conto bancario da cui stai importando.
Indica la Contropartita temporanea, predefinita "[CA]".
Puoi usare qualsiasi conto e, se lo racchiudi tra parentesi quadre, non viene contabilizzato.
Attiva l'opzione Applica regole (disponibile con il piano Advanced  di Banana Contabilità
Plus)
Conferma con OK.
Il programma:

Crea le registrazioni di importazione
Apre il dialogo Applica regole

 2. Dialogo Applica regole

https://www.banana.ch/it/update
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Nella parte in alto dei dialogo vedrai:

La contropartita temporanea che hai inserito in precedenza.
Il conto bancario che hai specificato.

Nella parte Movimenti in entrata con regole e Movimenti in uscita con regole (Money in with
rules e Money out with rules) non avrai nulla, perché ancora non hai definito nessuna regola.

Vedrai invece delle registrazioni nella parte:

Movimenti in entrata senza regole (Money In without rules)
Registrazioni con importi in entrata sul conto bancario
Movimenti in uscita senza regole (Money out without rules)
Registrazioni con importi in uscita dal conto bancario.

3. Crea nuove regole
Posizionati su una delle registrazioni per cui vuoi creare una regola.
Vai sulla parte destra, fino a che non vedi i "...".
Clicca su Aggiungi nuova regola.

Vedrai apparire il dialogo "Aggiungi nuova regola".
Inserisci:

Il testo che serve per trovare la corrispondenza della regola.
Esempio:

Best Insurance Contract 892-948
si applica alle righe che contengono esattamente il testo indicato.
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+Best Insurance Contract 892-948
si applica alle righe che contengono le parole "Best Insurance" e "892-948" in
qualsiasi posizione.

Il conto della contropartita che deve essere utilizzato per sostituire il conto temporaneo.
Eventuali altre informazioni (Centri di costi, Codice IVA, ecc.).

In basso il programma mostra già a quante registrazioni tra quelle importate la nuova regola
verrà applicata (in questo caso una sola).
Conferma con OK

Ritorna al dialogo Applica regole

A questo punto vedrai che le registrazioni relative alla nuova regola creata sono passate nella sezione
Movimenti in uscita senza regole (Money out without rules).

Vedrai che ci sono ancora delle registrazioni a cui non sono state applicate regole.
Puoi creare regole per tutte le registrazioni per cui lo ritieni opportuno.
Puoi decidere di creare delle regole anche successivamente:

Puoi quindi per ora scegliere di completare manualmente le registrazioni senza regole.
Oppure impartire nuovamente il comando Applica regole.

4. Conferma Applica Regole
Quando hai creato le regole, clicca sul bottone:
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Applica Regole
Il programma scrive le nuove regole nella tabella Registrazioni ricorrenti.
Per le registrazioni importate con regole, il programma sostituisce la contropartita
temporanea [ ] e completa le registrazioni.
Il dialogo rimane aperto.

OK
Per confermare le regole create e chiudere il dialogo Applica regole.

Annulla le modifiche effettuate

Chiuso il dialogo, vedrai nella tabella Registrazioni i movimenti completati.
Se lo desideri puoi annullare le modifiche apportate:

Se premi il tasto Annulla (menu Modifica > Annulla operazione o tasto Ctrl+Z), annulli
l'operazione di scrittura delle regole e del completamento delle registrazioni.
Se premi il tasto Annulla una seconda volta, annulli l'importazione dei dati.

Completa le altre registrazioni con Contropartita
temporanea
Dopo avere importato i movimenti bancari, lo scopo è quello di completare tutte le registrazioni in
modo tale da non avere più registrazioni dove vi è la contropartita temporanea.

Puoi completare manualmente le registrazioni che rimangono.
Questo è utile per casi particolari che non tendono a ripetersi.
Puoi creare delle nuove regole:

Puoi impartire nuovamente il comando Azioni > Registrazioni ricorrenti > Applica
regole e creare delle regole per le registrazioni che rimangono.
Direttamente nella tabella Registrazioni ricorrenti, ricordandoti di indicare '!Rule' nella
colonna Doc per ogni regola aggiunta.
Nella tabella Registrazioni puoi aggiungere nuove regole con il comando contestuale
Crea regole dalla selezione (tasto destro del mouse sulla riga di registrazione ) o con il
comando Azioni > Registrazioni ricorrenti > Crea regole dalla selezione. Una volta
creata la riga della regola dovrai completarla con la contropartita desiderata.

Aggiungere informazioni alle registrazioni completate con le
regole
Nella tabella Registrazioni vedi tutte le registrazioni e quindi puoi modificarle.

Ci possono essere dei movimenti che per completare la loro registrazione, hanno bisogno di ulteriori
informazioni specifiche, come per esempio l'aggiunta del link al documento della ricevuta.
Essendo il documento univoco per ogni operazione, non è possibile usare una regola.

Per trovare velocemente le operazioni da completare, puoi adattare la regola, per esempio:

Assegnando alla riga della regola un colore particolare.
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Inserendo nella colonna specifica, per esempio Link, un testo tipo [DOC] che rende evidente
che questa operazione deve essere completata allegando un giustificativo.
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Regole di completamento dialogo Applica
regole

La finestra Applica Regole offre un ottimo livello di controllo sulle modifiche ai movimenti contabili
perché mostra un'anteprima delle regole esistenti, con indicazione di quali registrazioni hanno una
corrispondenza con ognuna di esse e quali registrazioni non corrispondono ancora a nessuna regola.
Hai quindi la possibilità di creare nuove regole, modificare o cancellare quelle esistenti.

▶ Video: Regole per completare le registrazioni importate (dialogo Applica regole) .

Il dialogo può essere visualizzato:

Dal dialogo Importa registrazioni, quando viene vistata l'opzione Applica Regole
Le regole vengono applicate unicamente alle righe importate
 
Dal menu Azioni → Registrazioni ricorrenti → Applica regole...
Le regole vengono applicate all'intero contenuto della tabella Registrazioni

Il dialogo Applica regole, con l'importazione dei dati bancari, diventa uno strumento cruciale per
impostare tutte le registrazioni ripetitive. In questa finestra di dialogo, in presenza di più movimenti
ripetitivi dello stesso tipo, basta impostare la regola solo ad uno dei movimenti e automaticamente
vengono riportate le regole a tutti gli altri movimenti, presenti nel dialogo, senza dover impostare
nuovamente la regola.

Una volta confermate le regole, tutti i movimenti vengono riportati nella tabella Registrazioni,
garantendo uniformità e correttezza nelle registrazioni dello stesso tipo, e velocità nel contabilizzare
tutti i movimenti.

Dialogo Applica Regole
È composto da quattro sezioni:

Applica regole alle registrazioni con...
Tabella di visualizzazione delle registrazioni importate.

Suddivise fra quelle a cui sono applicate delle regole e quelle per le quali non ci sono
regole.
Con il menu contestuale "..." per aggiungere o modificare regole. 

Opzioni di visualizzazione delle registrazioni a cui applicare le regole.
Bottoni di conferma.

https://www.banana.ch/it/node/11679
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Applica regole alle registrazioni con...

Contropartita temporanea (Temporary contra account).
Questo campo è obbligatorio.
Filtra tutte le registrazioni importate che contengono quella specifica contropartita, per esempio
[CA], che è stata indicata nel Dialogo Importa movimenti.
Conto:
Filtra tutte le registrazioni importate che contengono un conto specifico, di solito il conto di una
banca o [A], che è stato indicato nel Dialogo Importa movimenti.

Il sistema di completamento basato sulle regole presuppone che una volta completate le registrazioni
non ci sia più alcuna registrazione che contenga la contropartita temporanea.

Tabella di visualizzazione delle registrazioni importate

La finestra mostra tutte le registrazioni che hanno la contropartita temporanea indicata sopra (per es.
[CA]). Queste sono raggruppate in quattro sezioni principali:

Movimenti in entrata con regole
Registrazioni con variazione positiva del conto (accredito) e con indicazione della regola a cui
corrispondono
Movimenti in uscita con regole
Registrazioni con variazione negativa del conto (addebito) e con indicazione della regola a cui
corrispondono
Movimenti in entrata senza regole
Registrazioni con variazione positiva del conto (accredito) e che non appartengono a nessuna
regola
Movimenti in uscita senza regole
Registrazioni con variazione negativa del conto (addebito) e che non appartengono a nessuna
regola

Se si è usato il bottone Applica, le registrazioni a cui sono state già applicate delle regole non
vengono più visualizzate. 

Comandi contestuali
Dalla riga di una registrazione senza regola, con un click con il tasto destro del mouse o sul "..." alla
destra, si apre un menu che permette di:



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 862

Aggiungi/Modifica regola.
Cancella regola.
Modifica regola che si sovrappone.

Opzioni di visualizzazione

Modificano la visualizzazione delle righe importate all'interno della tabella soprastante.

Espandi /Comprimi: visualizza o nasconde gli elementi delle Registrazioni.
Mostra regole inutilizzate (Display unused rules): vistando questa opzione vengono
visualizzate tutte le regole definite nella tabella Registrazioni ricorrenti; se l'opzione non è
vistata il programma mostra solo le regole che hanno delle corrispondenze.
Mostra righe senza regole (Display rows without rules): vistando questa opzione vengono
visualizzate tutte le registrazioni importate; se l'opzione non è vistata il programma mostra solo
le registrazioni che corrispondono ad una regola.
Rimuovi conti tra [ ] (Remove accounts between [ ]): Per le registrazioni su più righe dove il
programma ha inserito il conto bancario fra parantesi quadre (conto commentato), se questa
opzione è attiva, il programma rimuove il conto commentato.
Le regole con registrazioni su più righe possono essere definite unicamente nella tabella
Registrazioni ricorrenti.

Bottoni di conferma

OK: questo bottone applica le regole attive e chiude la finestra.
La contropartita temporanea viene sostituita in tutte le registrazioni che hanno una
corrispondenza con una regola.
Le regole nuove o modificate vengono salvate anche nella tabella Registrazioni
ricorrenti.

Annulla (Cancel): questo bottone chiude la finestra senza applicare le regole.
Se ci sono state modifiche a una o più regole, verrà chiesta una conferma prima di
chiudere la finestra.
Il bottone Annulla NON annulla (vedi sotto):

L'importazione delle registrazioni.
Le modifiche alle registrazioni e alle regole salvate apportate con il bottone Applica.

Applica Regole: questo bottone applica le regole senza chiudere la finestra.
Le registrazioni importate vengono completate con la contropartita e le altre colonne
specificate nelle regole. 

Le modifiche alle Registrazioni vengono salvate nella Tabella Registrazioni. 
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Le regole aggiunte o modificate vengono salvate nella tabella Registrazioni ricorrenti.
Nella tabella vedi le registrazioni che non hanno regole. 

Se vuoi annullare l'importazione o le modifiche dopo che hai dato il comando Applica Regole:

Devi chiudere la finestra. 
Usa il comando Annulla dal menu Modifica, una o più volte. 

Consigli su come utilizzare la finestra Applica regole
Il modo più efficace per lavorare con la finestra Applica regole è il seguente:

Verifica che le registrazioni con corrispondenza a delle regole siano corrette.1.
Usa il bottone Applica regole per completare le registrazioni e salvare le modifiche nella2.
tabella Registrazioni.
Nella tabella vedrai così solo i movimenti che non hanno delle regole da applicare.
Aggiungi nuove regole per le registrazioni che rimangono e controlla che vengano applicate3.
correttamente.
Usa di nuovo il bottone Applica regole.4.
Ripeti i punti 3 e 4 fino a quando tutte le registrazioni ricorrenti saranno associate a delle5.
regole.

Oppure chiudi il dialogo e completa le registrazioni manualmente.1.

Tabella registrazioni ricorrenti
Le regole sono salvate e possono essere modificate nella tabella Registrazioni ricorrenti.

Puoi completare o aggiungere regole anche con delle registrazioni su più righe nella tabella
Registrazioni ricorrenti.
Con il passare del tempo vedrai che sempre più registrazioni importate avranno delle corrispondenze
con delle regole; più regole aggiungi più il tuo lavoro contabile sarà ridotto.
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Aggiungi/Modifica regole

Dal dialogo Applica regole, puoi accedere alla sezione Aggiungi/Modifica regola, come segue:

Cliccando con il tasto destro del mouse su uno dei movimenti:
Per i movimenti che hanno già una regola puoi scegliere Modifica regola o Rimuovi
regola.
Per i movimenti che non hanno una regola puoi scegliere Aggiungi nuova regola.

Esempio Aggiungi nuova regola
L'esempio nel dialogo che segue è un movimento in uscita per il pagamento dell'assicurazione
malattia.

Per aggiungere una nuova regola:

Fai un click con il tasto destro del mouse sulla riga del movimento e scegli Aggiungi nuova
regola.
Ti appare il dialogo Aggiungi regola.
Completa i campi a disposizione.
Conferma con OK.

Dialogo Aggiungi nuova regola
Nella finestra Aggiungi nuova regola sono ripresi i dati del movimento selezionato, a partire dal
quale stai creando la regola.

Il programma crea la regola usando come valori di corrispondenza (condizioni) i dati della
registrazione di partenza (Vedi sotto). 

Devi sostituire la Descrizione e inserire il testo di ricerca.
Per esempio inserisci "Swisscom" se è una fattura che hai pagato alla ditta Swisscom.
Se non cambi la descrizione, la regola si applicherà solo alle registrazioni con esattamente
la stessa descrizione.
Devi completare tutti gli altri valori di corrispondenza.

Devi completare i valori Azione, che indicano come completare le registrazioni importate.  
Devi inserire il conto della contropartita.
Aggiungi i valori di completamento che desideri.
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Guarda se le regole vengono applicate alle registrazioni importate che desideri. 
Salva e ritorna a Applica regole

Regola
Tipo di regola.
Il programma, in base al tipo di movimento, in entrata o uscita sul conto bancario, imposta la
regola nei Movimenti in entrata o Movimenti in uscita.
Titolo della regola.
È opzionale, viene visualizzato nel dialogo Applica regola.

Condizioni di ricerca
Sono gli elementi che vengono usati per trovare le registrazioni importate che devono essere
completate.

La corrispondenza è data se sono presenti tutte le condizioni.
Se la corrispondenza è data, la registrazione viene elencata fra quelle che hanno una regola di
completamento. 

Cerca in Descrizione (Colonna Descrizione)

Corrisponde alla colonna Descrizione nella Tabella Registrazioni Ricorrenti.
Quando crei la regola partendo da una registrazione, il programma ti riprende il testo presente nella
registrazione. Lo devi sostituire.

Nella descrizione inserisci il testo da cercare nel testo della registrazione importata. La regola verrà
applicata, se il testo indicato è contenuto nella colonna Descrizione della registrazione importata e
sono date le altre condizioni di confronto. 

Esatta parola o frase
Se scrivi Best Insurance 982-948, come condizione della regola, tutte le registrazioni
che contengono questa esatta frase, verranno considerate come corrispondenze.
Se scrivi unicamente Insurance, come condizione della regola, tutte le registrazioni che
contengono questa esatta parola, verranno considerate come corrispondenze.

Tutte le parole (+ all'inizio)
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Se scrivi +Best Insurance 982-948, come condizione della regola, tutte le registrazioni che
contengono queste esatte parole, in qualsiasi posizione, verranno considerate come
corrispondenze.
Tutte le parole devono essere presenti nella descrizione della registrazione.
La posizione delle parole nella frase non è rilevante.
Il segno "+" non viene considerato nella ricerca.
Maiuscolo e minuscolo
Nella ricerca del testo inserito non viene fatta differenza fra maiuscole/minuscole.
Il testo che inserisci viene applicato sia a testi maiuscoli che minuscoli.

Importo

Corrisponde alla colonna Importo nella Tabella Registrazioni Ricorrenti.
Quando crei la regola partendo da una registrazione, l'importo è vuoto.
Se indichi un importo nella regola, solo i movimenti con lo stesso importo, oltre che la
corrispondenza nella Descrizione, verranno considerati come corrispondenze.
Se non indichi nessun importo, ogni movimento, di qualsiasi importo che rispetti tutti gli altri
criteri verrà considerato come una corrispondenza.

Conto bancario

Se lasci vuoto il campo del conto, tutti i movimenti, importati da un qualsiasi conto, che
rispettano tutti gli altri criteri, verranno considerati come corrispondenze.
Corrisponde al conto di importazione (Conto Dare o Conto Avere) nella Tabella Registrazioni
Ricorrenti.

Se è un importo in entrata il Conto bancario sarà salvato nella colonna Conto Dare.
Se è un importo in uscita il Conto bancario sarà salvato nella colonna Conto Avere.

Quando crei la regola partendo da una registrazione, riprende il conto da cui hai importato i
movimenti. 

Azioni per il completamento
Sono gli elementi che servono per completare la riga di registrazione se è data la corrispondenza.

Se il conto di contropartita o altri elementi da completare non sono presenti, puoi interrompere il
comando Applica regole, aggiungere il conto mancante e richiamare il comando Azioni >
Registrazioni ricorrenti > Applica regole...

Conto di contropartita

È il valore che servirà a completare la contropartita nella registrazione importata.
Corrisponde al Conto Dare o Conto Avere nella Tabella Registrazioni Ricorrenti.

Se è un importo in entrata la contropartita sarà salvata nella colonna Conto Avere.
Se è un importo in uscita la contropartita sarà salvata nella colonna Conto Dare.

Inserisci il conto presente nel tuo piano contabile che deve avere la corrispondenza nella regola.
In questo esempio il conto della contropartita corretto è il conto Assicurazione malattia.

IVA

Puoi già inserire nella regola il codice IVA che il programma deve applicare ad ogni movimento
corrispondente.
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A partire dalla versione 10.1.10 del programma, se è presente un codice IVA in una regola, tutte
le colonne relative all'IVA verranno automaticamente completate nel movimento.
Quando si definisce il codice IVA della regola, vengono applicate tutte le informazioni IVA
presenti nella tabella Codici IVA (comprese le colonne "Tipo importo IVA" e "Percentuale non
deducibile"). Questi dati possono essere ulteriormente modificati attraverso la tabella
Registrazioni ricorrenti. 
Quando si applicano le regole, i codici IVA definiti nella tabella Conti non vengono ripresi.
Se la regola non definisce un codice IVA, lascia inalterate le colonne IVA della registrazione da
completare.

CC1, CC2, CC3

Puoi già inserire nella regola i Centri di Costo che il programma deve aggiungere ad ogni movimento
considerato come corrispondenza.

Altri campi da completare

Se vuoi che l'applicazione della regola completi in automatico altre colonne, che non sono presenti in
questo dialogo, puoi inserirli nella Tabella Registrazioni Ricorrenti.

Tabella Registrazioni corrispondenti
Vengono elencati i movimenti di importazione visibili nel dialogo Applica regole a cui verrà
applicata questa regola. 
Adatta i campi di corrispondenza in modo che la regola sia applicata alle registrazioni. 

Bottoni
Il bottone Cancella elimina la regola
Il bottone OK salva i dati della regola.

Fai attenzione al fatto che, fino a che non impartisci il comando Applica regole, le nuove
regole non verranno salvate nella tabella Registrazioni ricorrenti.
Se annulli l'importazione, anche le regole che hai aggiunto non verranno salvate.
Vieni riportato alla finestra precedente dove sono visualizzati nuovamente i movimenti
importati con e senza regole. 

Modifica regole nella Tabella Registrazioni Ricorrenti
Tutte le regole vengono salvate nella tabella Registrazioni ricorrenti (regole per il completamento),
dove puoi modificare le regole che hai aggiunto:

Aggiungere qualsiasi altra colonna per il completamento, che non è disponibile in questo
dialogo (per esempio colonna Note, o DocLink).
Colorare la riga, se vuoi evidenziare la registrazione importata.
Aggiungere delle registrazioni su più righe (SplitRule).

Nella tabella Registrazioni Ricorrenti puoi anche aggiungere altre regole in previsione di
un'importazione che farai in futuro.
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Tabella Registrazioni ricorrenti con Regole

La tabella Registrazioni ricorrenti contiene sia dei codici per la ripresa delle righe memorizzate
(per tutti i piani di Banana Plus), sia tutte le regole esistenti, incluse quelle create nella finestra
Applica regole (solo con piano Advanced). Da questa tabella è possibile modificare le regole esistenti,
aggiungere dettagli supplementari o crearne di nuove.

▶ Video: Regole per completare le registrazioni importate (tabella Registrazioni ricorrenti) .

La tabella Registrazioni ricorrenti viene visualizzata nei seguenti modi:

Dal menu Azioni > Registrazioni ricorrenti > Tabella Registrazioni ricorrenti
Dalla tabella Registrazioni

menu Azioni > Registrazioni ricorrenti > Crea regola dalla registrazione
con un click con il tasto destro del mouse di un movimento senza regole presente nella
tabella Registrazioni > Crea regola dalla registrazione.

Le colonne usate dalle Regole
Nella tabella Registrazioni ricorrenti sono definite le regole per il completamento delle registrazioni
importate.

Colonne di corrispondenza
Colonne per verificare la corrispondenza con le registrazioni importate dal dialogo Applica
regole.

Colonna Doc - Tutte le regole devono contenere la parola !Rule
Colonna Descrizione
Colonna Importo
Colonne Conto Dare o Conto Avere che contengono il conto bancario o il conto di
contropartita temporanea [CA].
Nella contabilità Entrate / Uscite ci sono le colonne Conto e Categoria.

Colonne di sostituzione
Quando si vogliono aggiungere ulteriori dettagli ad una regola, precedentemente impostata con
il dialogo Applica regole, questi possono essere aggiunti nelle colonne di sostituzione (Codice
IVA, CC3 , note..).

Le regole possono anche essere inserite o modificate tramite il Dialogo Applica regole >
Aggiungi/Modifica regola. Una volta aggiunte sono salvate nella tabella Registrazioni ricorrenti.

https://www.banana.ch/it/node/11680
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Colonne di corrispondenza (o di ricerca)

Nella tabella Registrazioni ricorrenti le colonne di corrispondenza contengono le condizioni da
ricercare tra i movimenti importati. I movimenti individuati vegono poi completati con le informazioni
contenute nelle colonne di sostituzione. Ecco quindi quali sono le condizioni di ricerca:

La colonna Doc

Per fare in modo che una riga venga identificata come regola, nella colonna Doc ci deve essere uno
dei seguenti testi:

!Rule - Per indicare che è una regola
!RuleSplit - Per indicare che la regola deve creare delle Registrazioni su più righe (Split rows).

La colonna Descrizione

La colonna Descrizione deve contenere il testo da cercare nella descrizione delle righe importate:

Esatta parola o sequenza di parole
Se scrivi Best Insurance 982-948, come condizione della regola, tutte le registrazioni
che contengono questa esatta sequenza di parole, verranno considerate come
corrispondenze.
Se scrivi unicamente Insurance, come condizione della regola, tutte le registrazioni che
contengono questa esatta parola, verranno considerate come corrispondenze.

Tutte le parole (+ all'inizio)
Se scrivi +Best Insurance 982-948, come condizione della regola, tutte le registrazioni che
contengono queste parole, in qualsiasi posizione, verranno considerate come corrispondenze.

Tutte le parole devono essere presenti nella descrizione della registrazione.
La posizione delle parole nella frase non è rilevante.
Il segno "+" non viene considerato nella ricerca.

Maiuscolo e minuscolo
Nella ricerca del testo inserito non viene fatta differenza fra maiuscole/minuscole.
Il testo che inserisci viene applicato sia a testi maiuscoli che minuscoli.
[Nome della regola] 
Quando una descrizione inizia con un testo tra parentesi quadre, questo viene usato come
nome della regola. Da utilizzare per una migliore identificazione delle regole.

Attenzione: NON usare come descrizione l'intero testo proposto dalla banca (che è unico
per quel movimento), ma solo quella o quelle parole che sei sicuro si ripeteranno ogni
volta.

Le colonne Conto Dare e Conto Avere

Se la regola è stata creata in fase di importazione dei movimenti (dialogo Applica regole ),
normalmente nella colonna Conto Dare o Conto Avere vi è già il conto della banca o posta da cui è
stato importato il movimento. Questa condizione è facoltativa.

Se il conto di addebito o di accredito è specificato, la regola viene applicata a tutte le righe
importate che contengono la descrizione o l'importo specificato.
Se la regola è seguita da righe aggiuntive (divisione su più righe), inserisci "[ ]" per indicare che
la contropartita temporanea deve essere sostituita da un valore vuoto.
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La colonna Importo

La colonna Importo può contenere un importo preciso da cercare nelle registrazioni importate.
Questa condizione è facoltativa.

Se viene indicato nella colonna Descrizione il nome di un debitore o di un creditore come
riportato sull'estratto conto e l'importo non viene indicato la regola si applica a qualsiasi
importo ricevuto da quel debitore o versato al creditore.

Colonne di sostituzione (o di completamento)

Le colonne della tabella Registrazioni ricorrenti che non sono di corrispondenza, sono colonne
che contengono i valori per il completamento. Se una di queste colonne contiene un valore,
questo verrà usato dal programma per completare la registrazione importata nella tabella
Registrazioni.

Colonna Codice IVA per indicare il codice IVA che deve essere inserito.
Colonne CC1, CC2 o CC3 per indicare il Centro di Costo necessario.
Colonna Note per aggiungere informazioni supplementari.
Colonna DocLink per inserire una nota e distinguere le righe che devono essere associate a un
documento digitale.
Puoi usare qualsiasi altra colonna, eccetto quelle che vengono usate per l'abbinamento delle
regole (Descrizione, Conto Dare, Conto Avere, Importo). 
Puoi anche colorare una riga della regola e la riga importata riprenderà il colore della riga
della regola.

Completamento colonna DocLink 

A partire da Banana Contabilità versione 10.1.19 

Una volta importate le registrazioni, può essere necessario associare alcuni movimenti a dei
giustificativi contabili. Per velocizzare questa operazione si consiglia di procedere nel modo seguente:

Nella colonna DocLink usa un testo fra parentesi quadre [ ] per indicare che queste
registrazioni devono essere abbinate ad un giustificativo.
All'interno delle parentesi indica il testo che deve essere cercato nel nome del file del
giustificativo.
Nella tabella Registrazioni nel Filtro righe inserisci il testo "!link![ ]" per visualizzare tutte le
righe che sono da completare.
Quando si va in modifica nella colonna Link il programma visualizza nell'auto-completamento i
file non ancora abbinati ad una registrazione che contengono il testo fra le parentesi. 
Per esempio se si indica "[fattura]", il programma quando si va in modifica nella cella, nell'auto-
completamento indicherà tutti i file non ancora collegati, che contengono il testo "fattura".

Completamento manuale delle registrazioni

È possibile che certe registrazioni debbano essere completate manualmente con informazioni
supplementari, specifiche all'operazione, che non sono conosciute al momento della creazione della
regola. 

Per trovare velocemente le registrazioni da completare ti consigliamo di inserire dei valori temporanei
che servono per filtrare le registrazioni. Per esempio:
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Nella colonna Note o in qualsiasi altra colonna della riga della regola inserisci un hashtag, per
esempio #city, e inserisci poi lo stesso hashtag nel Filtro righe  quando sei nella tabella
Registrazioni. Verranno così visualizzate le righe che devi completare.

Colorare le righe delle regole
Il colore delle righe delle regole nella tabella Registrazioni ricorrenti verrà usato per colorare
la registrazione a cui viene applicata la regola. Così potrai individuare le righe velocemente o
filtrarle usando il testo "!_co!"

Registrazioni su più righe (split rows)
Puoi creare delle regole che aggiungono delle righe di registrazione a quella importata. Questa
funzionalità è utile per registrare delle operazioni che richiedono la contabilizzazione su più conti,
come per esempio:

Ricevi regolarmente un pagamento di 550 che deve essere registrato su tre conti diversi e
quindi su tre righe:

(550) incasso affitto (nessuna contropartita, perché si tratta di registrare l'importo globale
suddiviso su tre righe)
(500) affitto appartamento (contropartita affitto)
(50) spese accessorie (contropartita spese accessorie).

Puoi definire la divisione su più righe:

Le righe aggiuntive devono seguire immediatamente la riga con la regola !Rule.
Le righe aggiuntive sono inserite immediatamente dopo la riga importata che corrisponde alla
regola.
La colonna Doc delle righe aggiuntive deve avere il testo !RuleSplit.
Indica in tutte le altre colonne i valori che devono essere contenuti nelle righe aggiuntive. In
questo esempio abbiamo aggiunto il Centro di Costo dell'inquilino.

Nell'esempio di registrazione su più righe riferito all'affitto qui di seguito si presume che l'importo
incassato sia sempre di 550. Se necessario è utile indicare l'importo esatto dell'affitto. Infatti, se
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l'importo incassato è diverso da 550 sarà necessario completare la registrazione manualmente.

Consigli

Nell'esempio dell'affitto potrebbe rivelarsi utile:

Creare una regola su più righe per ogni inquilino, come riportato nell'immagine seguente,
indicando l'importo totale dell'affitto incassato di 550.
Creare una regola su una riga per ogni inquilino indicando:

Nel conto Dare il conto contabile della banca sul quale incassiamo l'affitto.
Nel conto Avere un conto contabile dei ricavi.
Nella colonna Importo non indichiamo nessun importo.
Nella colonna CC3 indichiamo il centro di costo dell'inquilino.

In questo modo:

se l'inquilino versa 550 l'importo sarà registrato correttamente suddiviso tra affitto e acconto
spese.
se l'inquilino versa un importo diverso da 550 l'importo sarà sempre associato all'inquilino che
ha effettuato il versamento.
gli importi diversi da 550 possono quindi essere gestiti manualmente secondo il motivo del
versamento.

Copiare in blocco le regole da un file all'altro
Dalla tabella Registrazioni ricorrenti è possibile copiare in blocco le righe delle regole e incollarle in
un altro file Banana.

Quando si passa da un anno all'altro le regole vengono riportate automaticamente.
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Regole Completamento Contabilità Entrate e
Uscite

 Nella Contabilità Entrate e Uscite e il Cash manager,  la funzionalità di Completamento delle
registrazioni importate funziona come per quella per il Completamento delle registrazioni della
Contabilità in partita doppia.

La differenza è che invece di usare le colonne Conto Dare e Conto Avere, vengono usate le colonne
Conto e Categoria.

La colonna Conto
È quella relativa al conto bancario.
La colonna Categoria
È quella dove viene indicata la categoria per sostituire la contropartita inserita in automatico.
Le colonne Entrate e Uscite
Sono quelle dove si indica l'importo per la corrispondenza.

La tabella Registrazioni ricorrenti nella contabilità
Entrate/Uscite

Se le regole contengono degli importi questi vengono ripresi nelle colonne Entrate o Uscite a
seconda dell'importo:

Le colonne associate all'importo sono le colonne Entrate e Uscite.
Se non viene specificato nessun importo, la regola verrà applicata sia nei movimenti in
uscita che quelli in entrata.
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Il conto di giro

Il conto di giro è un conto di appoggio, usato per registrare delle operazioni temporanee. Si utilizza
specificatamente nei casi seguenti:

Registrare operazioni di auto imposizione e recupero Imposta sull'acquisto (IVA su servizi
all'estero).
Importare dei dati nella contabilità principale dal libro cassa e dalle carte di credito.
Registrare gli stipendi netti addebitati dalla banca, in attesa della registrazione completa degli
stipendi lordi con le varie deduzioni mensili.

Uso del conto di giro nell'importazione dati dalla cassa o carta di credito

Quando i movimenti della cassa o della carta di credito vengono tenuti in file separati dalla contabilità
principale, per non creare delle sovrapposizioni di registrazioni nell'importazione, riguardo i
versamenti dalla banca verso la cassa o la carta di credito, si utilizza come conto di contropartita il
conto di giro.

Nel file della cassa o della carta di credito si registra l'entrata dei fondi (la cassa o conto carta di
credito è in aumento).
Nel file della contabilità principale si registra l'uscita dal conto corrente bancario o postale e
l'aumento della cassa o carta di credito.

In entrambi i file si deve usare come contropartita il conto di giro, sia nella registrazione del prelievo
dalla banca (contabilità principale), sia per il versamento in cassa o sulla carta di credito (file
separato).

Quando si importano i dati della cassa o della carta di credito, nel file della contabilità principale, il
conto di giro si azzera:

l dati importati dal file di cassa o del conto carta di credito saranno in avere del conto di giro.
I movimenti relativi ai versamenti già registrati con addebito sul conto banca o posta, saranno
in dare del conto di giro.

Maggiori dettagli sull'importazione con il conto di giro sono disponibili alla pagina Importare i dati
dalla cassa.
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Ripresa dati da altri programmi

Importazione dati one time con Excel
Se inizi a tenere la contabilità con Banana e ti occorre riprendere i movimenti da un altro software
contabile, probabilmente è più veloce appoggiarsi ad Excel per copiare e incollare i dati.

Con il vecchio programma di contabilità esporta i dati in un formato leggibile da Excel (CSV, txt,1.
..).
Importa i dati in Excel (vedi sotto)2.
In Excel disponi le colonne esattamente nella sequenza come appaiono nella tabella3.
Registrazioni di Banana.

Invece di cambiare disposizione alle colonne può essere più comodo aggiungere delle
colonne accanto a quelle già esistenti e copiarvi i dati oppure usare delle formule che
riprendono i dati e li convertono. Tramite formule puoi togliere spazi, modificare i testi o
convertire importi e date. 

Apri la nuova contabilità in Banana Contabilità.4.
Seleziona in Excel i dati da copiare e usa il comando Copia (Ctrl+C o Copia dal menu5.
Modifica).
Vai in Banana e impartisci il comando Incolla (Ctrl+V o Incolla dal menu Modifica).6.

Questo metodo è utile per riprendere dati da MS-Money, Intuit Quicken e Quickbooks, e dalla maggior
parte degli altri programmi di contabilità.

Importazione movimenti bancari
In questo caso è utile usare una delle funzioni di importazioni già disponibili.

Vedi: Importa movimenti in contabilità

Se non c'é un'estensione di importazione adatta al tuo caso puoi anche usare la modalità di
importazione "one time" indicata sopra. 

Esempio importazione file bancario CSV tramite Excel
Se devi importare dei dati bancari e non esiste un'estensione di importazione anche procedere
tramite Excel, seguendo l'esempio qui spiegato.

Lo scopo è di caricare i dati in Excel e trasformarli esattamente come sono disposti nella tabella
Registrazioni di Banana Contabilità, per poi selezionarli e fare un copia e incolla.

Crea un nuovo file vuoto in Excel.1.
Vai su "Dati"
Da testo/CSV 
Seleziona il file da importare
Aggiusta i parametri che Excel ti propone.
Eventualmente usa il bottone in basso "Trasforma Dati" per fare delle modifiche ulteriori.
Conferma "Carica"

Alla destra dei dati aggiungi delle intestazioni colonne, come sono nella tabella Registrazioni2.
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della contabilità.
Data
Doc
Descrizione
CtDare
CtAvere
Importo

Nella prima riga dei dati aggiungi le formule per riprendere e convertire i dati bancari.  3.
Data         
(riprende la data desiderata)       
=C2
Doc        
Lasciamo vuoto, ma si potrebbe fare una numerazione.
Descrizione       
(riprende la descrizione desiderata)       
=B2
CtDare       
Mettiamo il numero di conto della banca, per esempio "1010", solo se l'importo è
positivo.       
=IF(E2>0;"1010","")
CtAvere       
Mettiamo il numero di conto della banca, per esempio "1010", solo se l'importo è
negativo.        
=IF(E2<0;"1010","")
Importo       
Riprendiamo il valore senza segno negativo.        
=ABS(E2)

Copiare le formule create in tutte le righe successivi dove ci sono dati.4.
Selezionare i dati da copiare in Excel e dare il comando Copia.5.
Spostarsi nella tabella Registrazioni del file di contabilità, sulla prima riga vuota alla fine della6.
tabella nella colonna data.
Dare il comanda incolla.7.

Colonne contabilità multi-moneta

Se la contabilità è multi moneta aggiungi anche le colonne.

Sigla Moneta
Importo in moneta base.       
Se hai l'importo in moneta e in moneta base, il valore cambio viene calcolato da Banana
Contabilità.

Ulteriori consigli

Se le colonne importi non contengono dei separatori di migliaia è possibile che Excel non li
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converta in numeri. In questo caso selezionare tutta la colonna e usare il comando "Sostituisci"
e poi inserire il separatore di migliaia. 
Se i dati sono ordinati in maniera inversa rispetto a come li tieni in Banana, prima di procedere
con la mappatura dei campi posizionati sulla colonna Data, clicca la freccetta sulla destra e
ordina dal più vecchi al più nuovo.
Puoi aggiungere a tuo piacimento le colonne che ti servono.
Con gli Office Script di Excel puoi eventualmente anche creare una macro per automatizzare la
conversione del file.

Importazione ricorrente da altri programmi
Vedi: Importa in contabilità

Può essere invece necessario importare regolarmente dei dati:

Importare le registrazioni mensili dal programma stipendi.
Importare le fatture emesse con un programma fatture.
Importare i pagamenti, registrati con il programma di fatturazione.
Importare le vendite, registrate su uno shop-online.
Importare i dati da un altro programma di contabilità.
Importare i dati da un programma di gestione cassa (per esempio di un ristorante o di un
albergo).

In questi casi ci sono due possibilità:

Fai in modo che la tua applicazione esporti i dati nel formato file txt (TSV), appositamente1.
predisposto per l'importazione in Banana Contabilità.       
Guarda le Istruzioni per creare un file da importare in Banana Contabilità (in inglese). 
Usa un'estensione d'importazione che converta i dati esportati dal programma nel formato2.
accettato da Banana.

Verifica se c’è un'estensione già predisposta.       
Vedi: Estensioni d'importazione .
Crea un'estensione d'importazione.       
Vedi: Develop an Import Extension       
 

https://www.banana.ch/apps/it/node/9561


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 878

Tabella Registrazioni ricorrenti

La tabella Registrazioni ricorrenti si usa per memorizzare le registrazioni che vengono usate
ripetutamente.

Contiene tre tipologie di registrazioni ricorrenti:

Registrazioni ricorrenti memorizzate riprese tramite la colonna Doc nella tabella Registrazioni. 
Hanno nella colonna Doc un codice identificativo senza alcuna punteggiatura.
Regole per il completamento delle registrazioni importate. 
Servono per definire come devono essere completate le registrazioni importate. 
Hanno nella colonna Doc il codice "!Rule" o "RuleSplit".
Registrazioni automatiche con cadenze regolari. 
Servono per generare in automatico delle registrazioni che si ripetono con una determinata
frequenza, per esempio, mensilmente, trimestralmente, semestralmente o annualmente.  
Hanno nella colonna Doc il codice "!Auto".

Visualizzare e disporre colonne e viste nella tabella
Registrazioni ricorrenti
Prima di inserire le registrazioni ripetitive, deve essere visualizza la tabella Registrazioni ricorrenti,
dal menu Azioni  > Registrazioni ricorrenti.

La tabella Registrazioni ricorrenti non permette di salvare delle impostazioni di visualizzazioni
proprie, ma riprende le viste e le impostazioni delle colonne della tabella Registrazioni. 
Per personalizzare le colonne e la loro disposizione nella tabella Registrazioni ricorrenti, occorre:

Aggiungere una nuova vista nella tabella Registrazioni.
Disporre le colonne nella tabella Registrazioni nell'ordine che si desidera.
Nella Tabella Registrazioni ricorrenti, scegliere la vista che è stata creata (tabella Registrazioni).
Verranno visualizzate le colonne nello stesso ordine della vista creata. 

Inserire registrazioni ricorrenti tramite la colonna Doc
Per le operazioni ripetitive si possono creare dei codici da inserire nella colonna Doc per la ripresa
automatica dei dati.

Se è presente la colonna "Data fine" (vedi Registrazioni automatiche) puoi anche indicare una
data oltre la quale la registrazione non deve essere più ripresa nella tabella registrazioni. 
Le registrazioni che non sono più utilizzate devono essere cancellate manualmente.
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Numerazione progressiva dei documenti "docnum" 
Se nella colonna Doc della tabella Registrazioni necessiti una numerazione diversa da quella
automatica, inserisci nella tabella Registrazioni ricorrenti una riga che abbia nella colonna Doc il
codice "docnum". Per le righe successive verrà usato il tipo di numerazione che è specificato nella
colonna Descrizione.

"0" se non hai bisogno di una numerazione automatica.
"1" per la  numerazione progressiva.
"cassa-1" per la numerazione progressiva con il prefisso "cassa-" (cassa-2, cassa-3). 
Il programma sostituisce il numero indicato alla fine del testo con un numero progressivo. 
 
Se nei suggerimenti vuoi che venga visualizzata solo una riga per codice, devi far precedere la
descrizione come segue:

Un "*" -  Visualizza solo questa riga e non quelle che hanno un codice simile.
Un "**" - Visualizza solo questa riga, ma non la riprende (solo riga di titolo).
Un "\*" - Permette di iniziare la descrizione con un asterisco, senza essere interpretato
come un comando.

Riprendere registrazioni ricorrenti nella tabella
Registrazioni
Nella tabella Registrazioni puoi riprendere le righe definite nella tabella Registrazioni ricorrenti:

Nella tabella Registrazioni inserisci nella riga della di registrazione, la data. Puoi anche
aggiungere altre colonne mancanti rispetto a quelle presenti nella tabella Registrazioni
ricorrenti, a dipendenza della vista in cui ti trovi.
Nella colonna Doc della tabella Registrazioni scegli uno dei codici definiti nella tabella
Registrazioni ricorrenti (colonna Doc) e premi Enter:

Il programma inserisce le righe ripetitive che hanno lo stesso codice.
Se occorre modificare o completare qualche valore puoi sempre farlo.

Le righe memorizzate nella tabella Registrazioni ricorrenti possono essere riprese nella tabella
Registrazioni anche inserendo nella colonna Doc il codice e premendo il tasto F6.

Copiare registrazioni dalla tabella Registrazioni alla tabella
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Registrazioni ricorrenti
Le registrazioni ripetitive possono essere inserite anche copiando le registrazioni presenti nella tabella
Registrazioni, incollandole nella tabella Registrazioni ricorrenti.

Si procede come segue:

Nella tabella Registrazioni seleziona le righe da copiare.
Menu Modifica > Copia righe.
Vai nella tabella Registrazioni ricorrenti.
Menu Modifica > Inserisci righe copiate

Per copiare le registrazioni si possono usare anche i tasti Ctrl + C e Ctrl +V.
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Registrazioni automatiche con cadenze
regolari

Le registrazioni automatiche sono utili per facilitare l'inserimento di registrazioni ripetitive, come
abbonamenti, assicurazioni o tasse. Usando le registrazioni automatiche, devi solo inserire la
registrazione interessata una volta, impostare alcuni parametri come la data di inizio, la frequenza e
la data fine e poi Banana Contabilità Plus ti dirà quando una registrazione automatica è pronta per
essere creata e la creerà per te.

In Banana Contabilità Plus, ci sono due modi per creare le registrazioni automatiche: direttamente
dalla tabella Registrazioni ricorrenti oppure dal dialogo Applica registrazioni automatiche. 

Prerequisiti

Questa funzione è disponibile nell'ultima release di Banana Accounting+ Dev
Channel .
Richiede il piano Advanced . Se non hai questo piano puoi chiedere un codice
promozionale valido 1 mese tramite il formulario di contatto .
È necessario aggiungere le colonne Data fine e Ripeti alla tua contabilità.
È in Beta Test, ti chiediamo quindi di controllare e segnalarci qualsiasi
problema.

Aggiungere le colonne Data fine e Ripeti alla contabilità

Per poter attivare i comandi per le registrazioni automatiche è necessario aggiungere le colonne Data
fine e Ripeti nella tabella Registrazioni ricorrenti (menu Azioni); senza queste colonne i comandi
non verranno visualizzati.

Apri il tuo file contabile oppure crea una nuova contabilità con il comando File > Nuovo1.
Seleziona il comando dal menu Strumenti > Aggiungi/Rimuovi funzionalità2.
Apparirà il dialogo Aggiungi/Rimuovi funzionalità con l'elenco delle funzionalità disponibili.3.
Seleziona la voce Aggiungi colonne Data fine e Ripeti nella tabella Registrazioni.           4.
Se questa voce NON è visibile verifica la versione di Banana e il piano che stai utilizzando, come
descritto nel paragrafo Prerequisiti. 
Clicca su OK5.

http://www.banana.ch/it/insiderprogram
http://www.banana.ch/it/insiderprogram
http://www.banana.ch/it/buy
https://www.banana.ch/it/contact_form?obj=support&app=bananaPlus
https://www.banana.ch/it/contact_form?obj=support&app=bananaPlus
https://www.banana.ch/it/contact_form?obj=support&app=bananaPlus
https://www.banana.ch/it/contact_form?obj=support&app=bananaPlus
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Creare una registrazione automatica dalla tabella
Registrazioni ricorrenti

Seleziona il comando dal menu Azioni > Registrazioni ricorrenti > Crea registrazione1.
automatica.
Apparirà la tabella Registrazioni ricorrenti con una nuova riga, che riporta la data del giorno2.
nella colonna Data e  il testo !Auto nella colonna Doc, che serve per identificare la
registrazione automatica.   
[img]
Aggiorna la colonna Data con la data della prima occorrenza che desideri programmare.3.
Visualizza le colonne Data fine e Ripeti con il comando dal menu Dati > Disponi4.
colonne...           
Seleziona la colonna Data fine sull'elenco a sinistra e clicca su Visibile, fai lo stesso per la
colonna Ripeti.        
Se queste colonne mancano, aggiungile come descritto al paragrafo Aggiungere le colonne Data
fine e Ripeti.
Immetti la ripetizione desiderata nella colonna Ripeti. Ad esempio se desideri una ripetizione5.
trimestrale scrivi nella colonna Ripeti il testo 3M.
Se la registrazione automatica ha una scadenza, impostala nella colonna Data fine.6.
Completa le colonne Descrizione, Conto Dare, Conto Avere e Importo.7.
Seleziona il comando dal menu Azioni > Registrazioni ricorrenti > Applica registrazioni8.
automatiche per visualizzare le registrazioni pianificate nel dialogo Gestisci registrazioni
automatiche.

Nota: Posizionandosi su una registrazione già esistente nella tabella Registrazioni, se utilizzi il
comando dal menu Azioni > Registrazioni ricorrenti > Crea registrazione automatica, si crea
una regola di registrazione ricorrente automatica avente le colonne Descrizione, Importo e Conti
con i testi della registrazione originale.            
Questo passaggio può essere eseguito anche impartendo il comando Crea registrazione
automatica nel menu contestuale della tabella Registrazioni (facendo clic destro del mouse
direttamente su una registrazione, con il comando Crea registrazione automatica).
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Creare una registrazione automatica dal dialogo Applica
registrazioni automatiche

Seleziona il comando dal menu Azioni > Registrazioni ricorrenti > Applica registrazioni1.
automatiche...
Apparirà il dialogo Gestisci Registrazioni automatiche.2.
Clicca su Nuova registrazione automatica in fondo pagina.3.
Compila i campi necessari:4.

Data iniziale           
Data dalla quale partirà la prima registrazione automatica. Quando vengono generate le
registrazioni, questa data verrà aggiornata con la data dell'ultima registrazione
automatica creata.
Data finale
Ripeti
Descrizione
Conto
Contropartita
Importo
CC1, CC2, CC3
Nome o descrizione (opzionale)

Clicca su OK.5.
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Controlla e ricalcola contabilità

Il comando per il controllo e il ricalcolo della contabilità può essere richiamato come segue:

I tasti Maiuscolo + F9 (per Windows e Mac) o Cmd + 9 (per Mac)
Ricalcolo e controllo contabilità (primario).
Menu Azioni > Controlla contabilità
Con la possibilità di effettuare i controlli estesi.
Visualizzare la colonna Saldo  tramite menu Dati > Disponi colonne.

Se sono segnalati degli errori o differenze è opportuno correggerli.

Ricalcolo e controllo contabilità (primario)
Il comando Controlla contabilità verifica principalmente la versione in uso e, nel caso fosse
disponibile una versione aggiornata, il programma segnala il messaggio di aggiornarsi all'ultima
versione. Consigliamo vivamente di aggiornarsi poiché tante funzioni sono state migliorate e risolte
problematiche diverse.

Il ricalcola e ricontrolla contabilità esegue le seguenti operazioni:

Azzera i saldi dei conti, centri di costo e segmenti.
Verifica e segnala se vi sono errori nelle righe delle diverse tabelle (conti,  registrazioni, codici
IVA, cambi)
Registra nuovamente tutte le operazioni come se fossero inserite a nuovo.

Per la contabilità multimoneta ricalcola i saldi d'apertura in moneta base sulla base degli
ultimi cambi.
Se la riga di registrazione non è bloccata, ricalcola le righe di registrazione:

Sono ripresi i valori IVA dalla tabella codici IVA e ricalcolati gli importi IVA.
Aggiorna i saldi dei conti, centri di costo e segmenti
Nel Cash Manager è calcolato il saldo progressivo del conto nella tabella registrazioni.

Ricalcola i totali delle tabelle Conti e Categorie (entrate e uscite).
Aggiorna le colonne Differenza budget e Anno precedente.
Nella Contabilità multimoneta aggiorna la colonna Saldo calcolato agli ultimi cambi e la
relativa differenza di cambio.

 Finestra controlla contabilità (controllo esteso)
Oltre al ricalcolo e al controllo contabilità principali, vengono anche effettuati controlli supplementari.

https://www.banana.ch/doc10/it/node/9827
https://www.banana.ch/doc10/it/node/9827
https://www.banana.ch/doc10/it/node/9827
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Ricalcola contabilità ed esegui controlli estesi

È uno dei comandi più utili: tutta la contabilità viene controllata, i saldi sono ricalcolati e l'utente viene
avvisato di eventuali errori. Il comando aggiorna anche i testi delle colonne Descrizioni conto e
categorie (tabella Registrazioni), se questi sono stati modificati.

Proprietà dati base
L'opzione è attiva per default. Il programma controlla che i dati impostati nelle proprietà file siano
corrispondenti alla contabilità (esempio: data apertura e chiusura, conto IVA, conti differenze di
cambio....).

Registrazioni
Differenze registrazioni

Se l'opzione è attivata, il programma verifica se esistono delle differenze tra Dare e Avere o tra Conti
e Categorie nella contabilità Entrate / Uscite.

Nella finestra Messaggi vengono indicate le righe dove esistono delle differenze.
Nella Colonna Saldo viene indicata la differenza fra il movimento in dare e in avere. Se vi è
un'errore il saldo non va a zero.
Nella finestra informativa in basso è segnalato l'importo della differenza totale (solo se ci si
trova nella tabella Registrazioni).

Includi differenze intermedie

Se l'opzione è attivata, nelle registrazioni multiple, il programma verifica che non ci siano delle
differenze tra Dare e Avere.
Molto spesso le differenze sono dovute a registrazioni incomplete o a importi errati (come
nell'esempio dell'immagine sottostante).
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 Saldi di verifica (#CheckBalance)

Attivando questo controllo, il programma segnala se il saldo indicato nella descrizione è diverso
rispetto a quello contabile alla data indicata. 
Le registrazioni #CheckBalance servono per indicare che il saldo del conto a una certa data sia
corretto.
A fine mese, trimestre o anno è utile creare delle registrazioni #CheckBalance per i conti cassa,
banca. Le registrazioni #CheckBalance sono anche utili in abbinamento al comando blocco
registrazioni.
Usando le registrazioni #CheckBalance vi accorgerete se, dopo avere chiuso il periodo, si sono fatte
registrazioni non corrette.

Caratteristiche delle registrazioni #CheckBalance

Data. Deve essere la data a cui si riferisce il saldo.
Descrizione deve contenere:

#CheckBalance  seguita dal saldo del conto, compreso i decimali.
#CheckBalance  -1200.00
#CheckBalance  0.00
Per la contabilità multimoneta la dicitura #CheckBalance seguita dalla sigla divisa e il
saldo del conto, compreso i decimali.
#CheckBalance  CHF -1200.00
#CheckBalance  EUR 0.00
#CheckBalance  -1200.00  Senza la sigla moneta il controllo viene fatto in base al saldo in
moneta base.

ContoDare indicare il conto su cui si effettua la verifica.
Importo deve essere lasciato vuoto.

 Il programma ha rilevato una differenza tra il saldo di verifica e quello del conto del file.
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Stesso documento con
date diverse
Se si attiva questa opzione, il programma avvisa se le registrazioni con uno stesso numero di
documento hanno date differenti. Nelle registrazioni su più righe, dove non vi è una corrispondenza
tra documento e data, il programma non è in grado di determinare correttamente la contropartita.

Conti
Struttura piano dei conti

Se l'opzione viene attivata, il programma controlla che la struttura dei gruppi sia corretta.

Presenza di differenze di cambio

Se l'opzione viene attivata, il programma controlla se ci sono delle differenze di cambio non ancora
registrate.

Saldi di apertura differiscono dai saldi di chiusura anno precedente

Se l'opzione viene attivata, il programma verifica che i saldi di apertura del nuovo anno corrispondano
a quelli finali dell'anno precedente. Se ci sono delle differenze tra i saldi di chiusura dell'anno
precedente e quelli di apertura del nuovo anno , queste vengono segnalate come importo totale
nella finestra Messaggi.

Controlli personalizzati (Estensioni)
Se l'opzione viene attivata, il programma esegue dei controlli sulle funzionalità aggiunte dall'utente
(Estensioni), per le verifiche personalizzate.

Includi controlli estesi con il tasto maiuscolo + F9
Quando viene attivata questa opzione, il programma esegue tutte le verifiche attivate nella finestra di
dialogo, quando viene premendo il tasto maiuscolo + F9. Altrimenti, viene eseguito solo il ricalcolo
della contabilità (nella versione Mac, maiuscolo + Cmd + 9).

http://www.banana.ch/doc/it/contamsg_it_tot_teid11des
http://www.banana.ch/doc/it/contamsg_it_tot_teid11des


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 888

Colonna Movimento

La colonna Movimento è disponibile nelle schede conto e mostra i movimenti di debito e di credito in
un'unica colonna: gli importi positivi per le registrazioni a debito e gli importi negativi per le
registrazioni a credito. Gli importi sono gli stessi di quelli contenuti nelle colonne Dare e Avere.

Una singola colonna dovrebbe consentire un migliore controllo della contabilità.

È possibile attivare la colonna Movimento nella Scheda Conto , tramite il menu Dati > Disponi
Colonne.

http://www.banana.ch/doc/it/node/2726
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Colonna Saldo per rilevare le differenze
contabili

 La colonna Saldo è molto utile per vedere se ci sono differenze. Guarda il video !

Nella tabella Registrazioni puoi rendere visibile la colonna Saldo, tramite il menu Dati → Disponi
colonne.

Nota: nelle registrazioni composte, inserite su più righe , il programma riporterà una differenza tra
dare e avere fino al completamento della registrazione.

Come la colonna Saldo trova le differenze
Questa colonna contiene il saldo degli importi registrati sui conti Dare e Avere. Il valore è la differenza
cumulata, calcolata nella sequenza in cui sono inserite le registrazioni.

Il saldo è vuoto (saldo zero), se la somma degli importi in Dare e in Avere si compensano
(nessuna differenza).
Per le registrazioni su diversi conti, figura un saldo finché non  viene completata la registrazione
su tutti i conti coinvolti. Con l'ultima registrazione il saldo deve andare a zero.

Se, dopo l'ultima registrazione sui diversi conti, il saldo non va a zero, è probabile che ci sia un errore
dovuto ai seguenti motivi:

Il Conto Dare o il Conto Avere è stato inavvertitamente lasciato vuoto o non è corretto (vedi
esempio Doc 1).
Per una registrazione su diversi conti i totali degli importi in Dare e in Avere non sono uguali
(vedi esempio Doc 2).
In una registrazione con codice IVA, la scomposizione IVA o il conto IVA non sono corretti.
Se il codice IVA non esiste, gli importi sono registrati solo sul conto dare e avere e non viene
mostrata una differenza.

Nell'immagine di esempio si è generata una differenza di 150:

Nella registrazione, sulla riga Doc 1, è stato inserito il conto 4999 inesistente nel piano
contabile, quindi nella colonna Saldo, sulla stessa riga, si è creata una differenza di 100.
Nella registrazione su più conti, sulle righe Doc 2, l'importo totale pagato è 1'000, ma l'ultima

https://www.banana.ch/it/node/11369
http://www.banana.ch/doc/it/node/4760#registrazioni_composte
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registrazione non azzera l'importo totale (1'000) tra la colonna Dare e Avere, perché le
registrazioni nella contropartita hanno un importo totale di 950; pertanto si è aggiunta ancora
una differenza di 50 che porta ad una differenza totale di 150.

Controllare la contabilità
La colonna Saldo si rivela particolarmente utile per individuare le righe, a partire dalle quali, si sono
generate delle differenze contabili tra la colonna Dare e la colonna Avere.

Se la contabilità è corretta, quando si chiude una registrazione su diversi, il saldo dovrebbe essere a
zero.

Se la colonna Saldo non va a zero è perché c'é un problema. Bisogna ricercare la prima riga
dove si genera la differenza tra Dare e Avere.

Scorrere la colonna per capire su quale riga si è generato l'errore e correggere.
Oppure usare il comando Ricontrolla contabilità che indica dove inizia la differenza.

Il saldo dell'ultima riga (nell'esempio 150) deve corrisponde alla differenza Dare-Avere indicata
nella finestra Informazioni.
Se questi valori non sono uguali è necessario impartire il comando Ricontrolla contabilità.
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Esportazione da Banana Contabilità+

Banana Contabilità Plus offre diverse possibilità di esportazione. È possibile esportare i dati di una
singola tabella (esporta righe), di più tabelle (esporta file), o solo i dati contenuti nell'anteprima di
stampa. Si può scegliere l'esportazione in diversi formati: PDF, Xml, Excel, Html, txt, Json, ecc.

Novità! È ora anche possibile esportare il file PDF che include anche tutti gli allegati digitali. In un
unico file dunque è inclusa veramente tutta la contabilità. 

L'esportazione in PDF con allegati digitali è disponibile in Banana Contabilità Plus solo con
il piano Advanced . 
Guarda tutti i vantaggi del piano Advanced .

Esporta righe
Dal menu Dati > Esporta righe si può esportare il contenuto della singola tabella.
Se prima di dare il comando si selezionano delle righe, nel dialogo d'esportazione sarà attivata
l'opzione Solo righe selezionate.

Esporta File
Dal menu File > Esporta file si possono esportare più tabelle contemporaneamente.
Nel dialogo Esporta file sono usati anche le seguenti sezioni:

Quelle specifiche al tipo di file (vedi formati d'esportazione).
Includi  - per definire le tabelle e i report che devono essere inclusi nell'esportazione.
Periodo  - (Contabilità) per definire il periodo.
IVA  - (Contabilità con IVA).
Personalizzazione .

Esporta Anteprima di stampa
Nella barra degli strumenti dell'anteprima di stampa:

Clicca sulla freccia a lato del bottone Adobe PDF.
Scegli l'opzione che fa al caso:

Esporta PDF
Esporta in Html
Esporta in Excel
Copia negli appunti

Formati per l'esportazione
Per predisporre una specifica esportazione, ogni formato ha una o più sezioni con delle opzioni.
Puoi scegliere fra diversi formati:

PDF 

https://www.banana.ch/it/buy
https://www.banana.ch/it/advanced
https://banana.ch/doc/it/node/2601
https://banana.ch/doc/it/node/2602
https://banana.ch/doc/it/node/2572
https://banana.ch/doc/it/node/2604
https://banana.ch/doc/it/node/2124
https://banana.ch/doc/it/node/2124
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Permette di effettuare una stampa in PDF di tutto il contenuto del file contabile.
Nuovo! Esportazione file PDF con inclusi gli allegati digitali
Excel 
Per creare in Excel presentazioni, confronti, preventivi, calcolo indici, analisi di bilancio, grafici
che si collegano direttamente ai valori della contabilità.
HTML  
Esportando in questo formato, si può accedere a tutti i dati e resoconti contabili semplicemente
con un browser Internet (Explorer, Mozilla, Opera).
Questo formato soddisfa appieno i requisiti legali per l'archiviazione a lungo termine dei dati
contabili.
XML 
Lo standard per l'interscambio di dati. I dati contabili possono essere facilmente letti e
rielaborati con altri programmi o tramite fogli di stile XSLT.
Esporta righe in TXT 
Esporta le righe della tabella in formato testo.

https://banana.ch/doc/it/node/2040
https://banana.ch/doc/it/node/2040
https://banana.ch/doc/it/node/2583
https://banana.ch/doc/it/node/2583
https://banana.ch/doc/it/node/2594
https://banana.ch/doc/it/node/2594
https://banana.ch/doc/it/node/2708
https://banana.ch/doc/it/node/2708
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Esportazione dei dati in Excel

Per esportare in Excel cliccare sul menu File → Esporta file → Esporta in Excel.

Nome file

In quest’area bisogna inserire il nome del nuovo file che il programma crea per l’esportazione dei dati.
Qualora invece si selezioni un file già esistente tramite il bottone Sfoglia, il programma sovrascrive il
file con i nuovi dati.

Visualizza file immediatamente

Viene lanciato il programma per la visualizzazione dell’archivio MS Excel appena creato. In questo
modo si vede immediatamente il risultato dell’esportazione.

Opzioni
Definisci nome celle

Con questa opzione, in fase di esportazione, il programma attribuisce automaticamente un nome ad
ogni cella. Per esempio, la cella che contiene il saldo del conto 1000, riceve in Excel il nome
"Accounts_1000_Balance". Questo permette d'identificare univocamente ogni cella
indipendentemente dalla posizione che occupa nel foglio e dunque di creare dei report in Excel che
non devono essere corretti, se il piano dei conti viene modificato.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 894

Definisci nomi tabelle

Con questa opzione, in fase di esportazione, il programma attribuisce automaticamente un nome
nell’area delle celle appartenenti ad una tabella. Per esempio, l’area formata dalle celle appartenenti
alla tabella Accounts viene identificata con il nome DB_Accounts. Questa opzione è necessaria se in
Excel, nella creazione dei report, vengono utilizzate le funzioni di database.

Usa nomi in Xml (Inglese)

È possibile definire i nomi delle celle nella lingua originale della contabilità, oppure con il loro nome in
inglese. Nella lingua originale i nomi saranno comprensibili anche a chi non conosce l'inglese, ma non
saranno universali come quelli in inglesi. Con questa opzione si ha quindi per esempio
"Accounts_1000_Balance" invece di "Conti_1000_Saldo".

Proteggi tabelle

Questa opzione blocca il contenuto delle celle, rendendo unicamente possibile modificarne la
formattazione. Ciò impedisce che vengano inavvertitamente modificati i dati esportati. Si può
rimuovere la protezione in qualunque momento tramite il comando in Excel.

Altre sezioni

Per le spiegazioni delle altre sezioni consultare le seguenti pagine web:

Includi
Periodo
IVA
Personalizzazione

Risultato dell'esportazione

Ogni tabella della contabilità è un foglio del file Excel

Usare i nomi delle celle invece dei riferimenti riga/colonna:

I nomi ritornano il valore desiderato anche quando si inserisce una nuova riga o colonna.
I nomi sono facili da usare e comprendere.
"Conti_1000_Saldo" sta per saldo del conto 1000.
"Conti_1000_Descrizione" riprende il valore della cella contenente la descrizione del conto 1000.
I nomi possono essere usati nelle formule.
"=Conti_1000_Saldo" riprende il valore della cella contenente il saldo del conto 1000.
"=Conti_1000_Saldo/1000" divide per 1000 il saldo del conto 1000.
Con i nomi è possibile creare dei collegamenti a diversi file.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 895

Il collegamento a una cella si compone di:

Nome del file.
Nome della tabella.
Nome della cella.

Copia/incolla dei dati da Banana a Excel
Con Banana Contabilità sempre possibile, oltre all'esportazione, effettuare il copia/incolla dei dati
Banana in Excel: solo alcune celle, colonne, o tutta la tabella.

Alcuni utenti ci hanno segnalato che in rari casi e unicamente a partire da computer Mac, in fase di
esportazione dei dati da Banana ad Excel, il formato degli importi non è ottimale.
La situazione è comunque facilmente risolvibile semplicemente selezionando in Excel le colonne con
gli importi e cambiando il formato delle celle nel tipo “Numero”.
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Includi

Dal menu File → Esporta file → Esporta in Excel → sezione Includi si apre la finestra di dialogo
che permette di scegliere le tabelle e i report da includere.

Ricontrolla contabilità

Attivando la funzione, la contabilità viene ricontrollata prima di essere esportata.

Includi

Contiene la lista delle tabelle e dei report che si possono esportare. La lista dei dati può variare a
dipendenza della tipologia di file e contabilità.

Vista

Si può selezionare la vista o la personalizzazione che si vuole includere.
Questa opzione è disponibile nell'esportazione in formato Pdf, Html e Xml.

Periodi

Questo gruppo permette d'indicare delle opzioni per l'esportazione di tabelle che prevedono dei
periodi.

Conti / Categorie per periodo

Si riferisce alla scelta Conti Periodo e indica quale ripetizione per periodo si desidera.

Riassunto IVA

Si riferisce alla scelta Riassunto IVA Periodo. Crea dei riassunti IVA per i diversi periodi indicati.

Crea periodi per tutto l’anno

Questa funzione esporta i saldi parziali per l’intero anno e non limitatamente al periodo contabile
specificato o al periodo di esportazione selezionato.
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Numero massimo periodi

Il numero massimo possibile di periodi.
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Esporta in Html

Per esportare un file in Html cliccare sul menu File → Esporta file → Esporta in Html.

Nome file

In quest’area bisogna inserire il nome del nuovo file che il programma crea per l’esportazione dei dati.
Qualora invece si selezioni un file già esistente tramite il bottone Sfoglia, il programma sovrascrive il
file con i nuovi dati.

Visualizza file immediatamente

Viene lanciato il programma per la visualizzazione dell’archivio HTML appena creato. In questo modo
si vede immediatamente il risultato dell’esportazione. È bene ricordarsi che i browser come Mozilla e
MS-Explorer usano un meccanismo di cache dei documenti. Quando si effettua l’esportazione una
seconda volta, se non si preme sul bottone Aggiorna del browser, è possibile che si veda ancora la
versione precedente.

Opzioni creazione file

Intestazione 1, 2 e 3

Sono le intestazioni dei files.
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Altre sezioni

Per le spiegazioni delle altre sezioni consultare le seguenti pagine web:

Includi
Periodo
Opzioni Html
Personalizzazione

http://www.banana.ch/doc/it/node/2604
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Opzioni Html

Dal menu File → Esporta file → Esporta in Html → sezione Opzioni Html si apre la finestra di
dialogo che permette di attivare delle opzioni nell'esportazione del file in formato Html.

Usa foglio di stile CSS

Vistando questa casella è possibile collegare al file esportato, un foglio di stile. Il programma usa in
automatico un proprio foglio di stile predefinito e lo incorpora nel documento.

Usa foglio stile predefinito

Viene utilizzato il foglio di stile predefinito del programma. Disattivando la casella, si rende
automaticamente attiva l’opzione Foglio di stile esterno, in cui è possibile selezionare il nome di un
foglio di stile personale.

Foglio stile esterno

Nome file

Nel caso si utilizzi un foglio di stile esterno, con il bottone Sfoglia, selezionare il nome del file del
foglio di stile.
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Includi foglio di stile nel file Html

Quando i dati in formato Html vengono spediti, è necessario spedire anche il file del foglio di stile. Per
evitare d'inviare due files separati, attivando la casella, è possibile incorporare il foglio di stile al file
contabile Html.

Vistando le caselle, il programma archivia i dati secondo le opzioni scelte:

Esporta solo le colonne visibili
Tabella con bordo
Colonne con intestazione
Riporta i fine pagina
Esporta come dati - i dati vengono esportati senza nessuna formattazione.
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Esporta in Xml

Per esportare in Xml cliccare sul menu File → Esporta file → Esporta in Xml.

Nome File

Inserire il nome del file nuovo da creare o sceglierne uno esistente tramite il tasto Sfoglia.

Visualizza file immediatamente

Viene lanciato il programma per la visualizzazione dell’archivio Xml appena creato. In questo modo si
vede immediatamente il risultato dell’esportazione. È bene ricordarsi che i browser come Mozilla e
MS-Explorer usano un meccanismo di cache dei documenti. Quando si effettua l’esportazione una
seconda volta, se non si preme sul bottone Aggiorna del browser, è possibile che si veda ancora la
versione precedente.

Foglio stile XSLT

In quest’area è possibile impostare il foglio di stile (file Xml esterno) in base al quale il programma
deve disporre graficamente i dati contabili. Banana Contabilità non mette a disposizione files Xslt.
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Opzioni

È possibile scegliere come opzioni:

Esporta solo le colonne visibile.
Includi la lista delle viste.
Esporta come dati.

Altre sezioni

Per le spiegazioni delle altre sezioni consultare le seguenti pagine web:

Includi
Periodo
Personalizzazione

http://www.banana.ch/doc/it/node/2604
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Esporta righe in txt

Per esportare le righe si parte dal menu Dati → Esporta righe → Esporta righe in Txt. Possono
essere attivate le opzioni della finestra seguente:

Nome file

Inserire il nome del file, oppure, selezionarne uno già esistente tramite il bottone Sfoglia.

Formato

Selezionare il formato.

Visualizza file immediatamente

Viene lanciato il programma per la visualizzazione dell’archivio Txt appena creato. In questo modo si
vede immediatamente il risultato dell’esportazione. È bene ricordarsi che i browser come Mozilla e
MS-Explorer usano un meccanismo di cache dei documenti. Quando si effettua l’esportazione una
seconda volta, se non si preme sul bottone Aggiorna del browser, è possibile che si veda ancora la
versione precedente.

Opzioni

Se attivate permettono l'esportazione dei seguenti dati:

Solo righe selezionate.
Solo colonne visibili.
Intestazione campi.
Unicode (Utf-8).
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Blocco registrazioni con la tecnologia del
Blockchain

Certificazione dati con blockchain
Banana usa un sistema di certificazione dei dati contabili basata su una tecnica che oggi viene
chiamata blockchain (catena di blocchi). Il metodo di certificazione basato sul concatenamento dei
blocchi di dati "blockchain" è considerato talmente affidabile da essere impiegato per assicurare la
validità dei bitcoin e di tutte le moderne crypto-monete.

Banana.ch è stata la prima ditta al mondo a usare la tecnologia blockchain in ambito contabile. Il
metodo è stato depositato come brevetto nel 2002 (US Patent No. 7,020,640 ). Questo metodo
garantisce alti livelli d’integrità dei dati e di conformità alle normative di legge.

Per maggiori informazioni si veda Blockchain per garantire l'integrità dei movimenti contabili .

Comando blocca registrazioni
Con il comando Blocca registrazioni, i movimenti della contabilità vengono bloccati e segnati con
delle cifre di controllo che permettono di verificare nel tempo che le registrazioni non siano state
modificate.

Viene verificata la validità di un eventuale blocco già esistente
Le registrazioni fino alla data del blocco sono numerate progressivamente e bloccate. Per ogni
registrazione viene calcolato il marchio digitale della riga e quello progressivo.
Il calcolo dei marchi digitali viene fatto nella sequenza delle colonne.
Nella contabilità viene indicato che non verranno più accettate registrazioni con data uguale o
inferiore alla data blocco.
 

Data nuovo blocco (compresa)

Specificare la data fino a quando i movimenti devono essere bloccati.

https://www.banana.ch/it/node/11252
https://cdn.banana.ch/accounting/files/USPatent7,020,640.pdf
https://www.banana.ch/it/node/11252
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Password (opzionale)

È possibile inserire una password per permettere l’eventuale sblocco delle registrazioni o per poter in
seguito eseguire un nuovo blocco. Il programma, se non trova errori nelle registrazioni comprese nella
data del blocco, blocca le registrazioni, calcola e assegna ad ogni riga di registrazione delle cifre e dei
codici diversi per ogni riga, visualizzate nella vista Blocco.

Ultimo blocco

I dati di questa sezione vengono indicati automaticamente dal programma in base all'ultimo blocco
eseguito.

Blocco valido

Viene visualizzato un "Sì" se il blocco è valido.

Data blocco

È la data dell'ultimo blocco eseguito.

Numero di blocco

È il valore inserito automaticamente dal programma nell'ultima riga della colonna BloccoNum.
Quando il blocco viene ripetuto, se il valore della riga dell'ultimo blocco rimane invariato, significa che
il blocco è valido e di conseguenza i dati non sono stati modificati; se invece il valore varia viene
indicato:

(-1) se già dalla prima riga il blocco non è valido
(-2) se ci sono delle righe che hanno il medesimo Blocco Num.

Hash progressivo

È la cifra di controllo presente nell'ultima registrazione.
 

Registrazioni: Vista Blocco
Sono visualizzate i marchi digitali e le informazioni che sono servite per la firma digitale.

BloccoNum: il numero progressivo che distingue la riga
BloccoImp: l'importo cumulato dei movimenti, simile al totale di fine pagina, richiesto da alcune
legislazioni
BloccoLinea: (colonna nascosta) il marchio digitale calcolato sulla base dei valori della riga.
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BloccoProgr: il marchio digitale complessivo. 

Il marchio digitale BloccoProgr

È l'elemento centrale della certificazione e usa la metodologia del blockchain.
Il marchio digitale è calcolato in base a questi valori:

Del contenuto della registrazione attuale, compresi importi, descrizioni e descrizione del conto
al momento del blocco.
Del numero progressivo (BloccoNum)
Del saldo cumulato (BloccoImp)
Del marchio progressivo della registrazione precedente (BloccoProgr).
 

Nel caso in cui i dati della contabilità dovessero subire una minima modifica (è cambiata una data, un
importo) la cifra di controllo risulterà diversa.
Se la cifra rimane la medesima significa che i dati sono originali e quindi che non sono stati cambiati.
 

Verifica blocco
Con il Menu Azioni → Verifica blocco, il programma controlla se il blocco è valido e visualizza i dati
del blocco.

Il programma ricalcola i marchi digitali e verifica se quelli ricalcolati sono uguali a quelli abbinati
alle registrazioni.

Se sono uguali, il blocco è considerato valido e quindi i dati sono originali.
Se i marchi non sono uguali, significa che i dati sono stati modificati e non sono quelli
originali calcolati al momento del blocco.
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 Sblocca registrazioni
Il Menu Azioni → Sblocca registrazioni rimuove il blocco e le cifre di controllo. Se il blocco è stato
dotato di password, è necessario reinserirla per procedere allo sblocco.
Volendo successivamente procedere ad un nuovo blocco, se i dati e l’ordine delle registrazioni non
sono cambiati, le cifre di controllo saranno le medesime del blocco precedente, se invece sono stati
modificati, le cifre di controllo cambiano.

Sblocco parziale

Quando le registrazioni sono state bloccate, è possibile sbloccarle anche solo parzialmente, partendo
da una determinata data. Se nel blocco è stata inserita una password, per poter confermare lo
sblocco, occorre digitare la password nell'apposita casella.
 

 

Perché lasciare sbloccare la contabilità?
In linea di principio la contabilità bloccata non si dovrebbe sbloccare. Capita che dopo il blocco ci si
accorge di errori nella contabilità e della necessità di fare correzioni.
Per avere la possibilità di fare ulteriori modifiche, gli utenti tenevano una copia del file prima del
blocco. Se trovavano errori ripristinavano la situazione precedente. Nel frattempo erano state fatte
magari altre registrazioni, per cui spesso succedeva che ripristinando versioni precedenti la
contabilità risultava sbagliata. Per evitare questo inutile dispendio di tempo si è deciso di mettere a
disposizione il comando Sblocca registrazioni.

La certificazione non deve essere confusa con la sicurezza dei dati. La certificazione dei dati è una
metodologia che assicura che i dati contabili siano originali. Per impedire che i dati vengano
modificati, la metodologia è quella relativa alla sicurezza dei dati. Delle procedure per la sicurezza dei
dati possono però essere implementate unicamente in un ambiente che limita l'accesso ai dati.

Se il file è completamente a disposizione dell'utente, come quando è su un PC, le persone si trovano
ad avere il controllo completo dei dati. Possono quindi sostituire facilmente dei file. Con la
certificazione non si impedisce che i dati siano alterati, ma si riesce comunque a sapere se sono quelli
originali.
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La persona che tiene la contabilità è responsabile della contabilità e decide se una modifica è lecita o
meno.
 

Organizzare la certificazione e la verifica
Una volta che i movimenti del periodo sono stati bloccati bisogna:

Stampare l'informazione relativa al blocco o l'ultima riga cerficata con il relativo numero di1.
certificazione (BloccoProgr).
Firmare e custodire questa informazione con i documenti della contabilità o in un altro luogo2.
sicuro.

Per verificare che i dati contabili siano quelli originali:

Date il comando Mostra informazioni blocco.1.
Riprendete il documento dove risulta il marchio digitale di verifica.2.
Controllate se la riga identificata con il BloccoNum ha ancora lo stesso marchio digitale:3.

Se il numero corrisponde, i dati della contabilità sono i medesimi di quelli certificati
Se il numero non corrisponde, significa che i dati della contabilità sono stati modificati.

Banana sta sviluppando delle applicazioni che permettono di confrontare due file e avere indicazioni
circa i dati che sono stati cambiati.
 

Sicurezza dati
La certificazione digitale assicura che i dati siano ancora quelli originali. Non impedisce però la
modifica dei dati. 
È responsabilità del contabile assicurare che i dati non siano alterati. Ogni amministrazione deve
avere un'organizzazione adeguata alle proprie dimensioni e necessità.
Chi desidera fare in modo che i dati non siano alterati da persone non autorizzate, deve impiegare
altre metodologie e altri strumenti, come per esempio:

Salvare i dati su un sistema sicuro (disco di rete protetto) protetto da password.
Tenere delle copie dei dati.
Criptare gli archivi.
 

Archiviazione a lungo termine
Il file della contabilità contiene i dati immessi. Per aprire il file e ottenere un report o la scheda conto
dovete quindi avere sempre a disposizione il programma. 

Banana Contabilità consente di esportare tutti i dati della contabilità e anche le diverse stampe in
formato Pdf, Html e Xml.
L'archivio generato può essere salvato su un CD e consultato su qualsiasi computer a distanza di anni,
anche da persone che non hanno Banana Contabilità.
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Aggiungi o rimuovi funzionalità

Banana Contabilità Plus offre la possibilità di aggiungere delle funzionalità al file. Vedi anche Aggiungi
funzionalità generali.

Abilita Maiuscolo/Minuscolo nei numeri di conto descrittivi e
nei codici
Quando nel piano contabile i conti, presenti nella colonna Conto, sono descrittivi (es. cassa),
normalmente il programma converte le lettere in maiuscolo. Abilitando questa funzione, il programma
consente di avere i conti descrittivi in maiuscolo o minuscolo.
Nella tabella Registrazioni, le descrizioni che si trovano nella colonna Conto verranno ripresi così
come si presentano nella tabella Conti.
Prestare attenzione perché il conto "Cassa" scritto con la prima lettera maiuscola, sarà diverso dal
conto "cassa" scritto in minuscolo.

Aggiungi tabella Articoli
Le informazioni sono disponibili alla pagina Documentazione Tabella Articoli.

Aggiungi le colonne Articoli nella tabella Registrazioni
Le informazioni sono disponibili alla pagina Documentazione Colonne Articoli tabella Registrazioni.

Aggiungi tabella e colonne Articoli nella tabella
Registrazioni
Le informazioni sono disponibili alla pagina Documentazione Tabella Articoli e alla pagina
Documentazione Colonne Articoli tabella Registrazioni.
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 Aggiungi le colonne Indirizzi nella tabella Conti
Nel file di contabilità, questa funzione permette di aggiungere, nella tabella Conti, le colonne che
servono per inserire gli indirizzi dei clienti, dei fornitori, dei soci o altro.

Per aggiungere questa funzione procedere come segue:

Cliccare sul menu Strumenti
Selezionare il comando Aggiungi/Rimuovi funzionalità...
Selezionare Aggiungi colonne indirizzi nella tabella Conti. (Se questa opzione non
compare nell'elenco, significa che la funzione è già stata attivata).

Il programma aggiunge nella tabella Conti:

la vista Indirizzi dove sono visibili le colonne aggiuntive.
Le colonne che permettono di inserire i dati dell'indirizzo e altre informazioni.

Per rendere visibili una o più colonne, anche nelle altre viste, usare il comando Disponi
colonne del menu Dati.
Per creare altre viste con delle colonne specifiche, usare il comando Disponi Tabelle dal
menu Dati.

 Aggiungi e rimuovi tabella Preventivo
Questa funzione abilita il file contabile per la pianificazione finanziaria, aggiungendo la tabella
Preventivo dove si possono inserire le registrazioni che riguardano il preventivo.

Per ulteriori informazioni vedi Tabella Preventivo.

 Modifica colonna tipo importo IVA nelle registrazioni
Nei file di contabilità con IVA, nella tabella Registrazioni, questa funzione permette di rendere
modificabile la colonna Tipo imp. (Tipo importo IVA).

La colonna permette di inserire per ogni registrazione, quando occorre, uno dei seguenti tipi di
importo IVA:

0 (o cella vuota), si intende IVA inclusa
1 = IVA esclusa, si intende IVA esclusa
2 = importo IVA, l'importo della registrazione è considerato importo IVA al 100 %
Per ogni registrazione, il programma immette in automatico nella colonna Tipo importo i dati
predefiniti della tabella Codici IVA (per ogni codice). Se eccezionalmente, per un codice IVA
cambia il tipo di importo, è possibile inserire manualmente 1 o 2.

Nota

Utilizzando questa funzione ci sono delle incompatibilità dei dati IVA con le versioni precedenti che
non avevano questa funzione.

http://www.banana.ch/doc/it/node/2719
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Dialogo - sezione Periodo

Questa sezione appare in diversi dialoghi (p.es. nella scheda conto, nei bilanci...) e ha come funzione
quella di limitare la visualizzazione o l'elaborazione dei dati solo per un periodo indicato.
Se si indica p.es. un trimestre, nella scheda conto verranno visualizzati solo i movimenti del trimestre
e nel bilancio appariranno i risultati per il trimestre.

Tutto

Sono inclusi tutti i movimenti della contabilità.

Periodo specificato

Si intende il periodo specificato, indicando la data di inizio e di fine.

Movimenti senza data

Se nella contabilità sono stati inseriti movimenti senza data, questi saranno considerati solo se si
seleziona tutto.
Se invece si inserisce p.es. dal 1. gennaio fino al 31 dicembre, i movimenti senza data non
risulteranno nel report.
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I grafici di Banana Contabilità+

In Banana Contabilità Plus, aprendo un file, è disponibile in basso la finestra Grafici che propone una
rappresentazione grafica dell'andamento di un conto, un gruppo, un centro di costo oppure un
segmento selezionato.

Il grafico visualizza i dati del conto o di un altro elemento selezionato in una tabella, secondo le
impostazioni che si possono scegliere nel pannello di destra:

Posizionando il cursore sulla curva o la barra del grafico, si vedono i valori esatti degli importi.
Cliccando su un punto del grafico viene  aperta la relativa scheda conto nella posizione
corrispondente.

Pannello di controllo
Tramite il pannello di destra è possibile selezionare i valori ed il periodo da visualizzare, la modalità,
così come stampare o salvare il grafico.

Nel caso in cui le dimensioni della finestra non permettano di visualizzare tutti i controlli, solamente i
controlli riguardanti la legenda verranno visualizzati. Per visualizzare tutti i controlli bisogna
ingrandire la finestra principale dell'applicazione oppure la finestra in basso.

Valori temporali

Nei grafici possono essere visualizzati singolarmente o contemporaneamente i seguenti valori
contabili:

Corrente - rappresenta i valori consuntivi.
Preventivo - rappresenta i valori di preventivo.
Precedente - rappresenta i valori dell'anno precedente.

Cliccando con il mouse sopra il nome (Corrente, Preventivo o Precedente), i rispettivi valori vengono
visualizzati o nascosti.

Legenda

L'opzione Legenda seleziona se nascondere o se visualizzare la legenda all'interno della finestra del
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grafico. Di regola è nascosta, ma è possibile visualizzarla nel caso in cui si debba stampare o salvare il
grafico.

Off - Il grafico non mostra nessuna legenda.
Basso - La legenda viene visualizzata sotto il grafico, in posizione centrale.
Sinistra - La legenda viene visualizzata in basso sulla sinistra.
Alto - La legenda viene visualizzata sopra il grafico, in posizione centrale.
Destra - La legenda viene visualizzata in basso sulla destra.

Periodo

Il periodo in anni per il quale visualizzare i dati.

1A, 2A, 3A, 4A, A (A indica gli anni).

Intervallo

Lo spazio tra ciascun valore sulla scala del grafico può essere personalizzato in base alle seguenti
opzioni:

1G (giorno), 1S (settimana), 1M (mese), 3M (trimestre), 6M (semestre), 1A (anno).

Valore

Il grafico può visualizzare il saldo contabile a fine periodo o il movimento contabile del periodo. In
base al valore selezionato, la data visualizzata viene adeguata di conseguenza:

Saldo - il grafico rappresenta il saldo a fine periodo (es. 31 gen '22 - data fine periodo)
Movimento - il grafico rappresenta il movimento del periodo (es. gen '22 - periodo)
Automatico - il grafico rappresenta il saldo per i conti di bilancio ed i CC3, e il movimento per i
conti del conto economico, i CC1, CC2 ed i segmenti.

Tipo

Il grafico può rappresentare il valori nelle seguenti modalità:

Linea - il grafico è rappresentato da linee.
Area - il grafico è rappresentato da aree.
Barra - il grafico è rappresentato da barre.
Automatica - il grafico è rappresentato come area per i conti di bilancio ed i CC3, e come barre i
conti del conto economico, i CC1, CC2 ed i segmenti.

Stampa, Salva  o Copia il grafico

Questa funzionalità è unicamente disponibile con il piano Advanced di Banana Contabilità
Plus .

https://www.banana.ch/it/advanced
https://www.banana.ch/it/advanced
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Nella tabella del grafico, nell'angolo in alto a destra, cliccando sul simbolo Copia appare un menu con
i seguenti comandi:

Stampa - Visualizza il grafico nell'anteprima di stampa.
Salva - Salva il grafico come immagine PNG.
Copia - Copia il grafico negli Appunti come immagine PNG. L'immagine copiata può essere
incollata all'interno di qualsiasi editor di testo (Word, Excel, ...).
Copia dati - Copia i valori usati per creare il grafico come tabella dati che può essere incollata in
qualsiasi spreedsheet (Excel, Numbers, ...).
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Estensioni

Le estensioni sono dei moduli aggiuntivi del programma che permettono di utilizzare delle funzionalità
supplementari; la maggior parte di queste sono disponibili unicamente con il piano Advanced  di
Banana Contabilità Plus.

Qui di seguito l'elenco di quelle principali:

Rendiconto IVA 2024 per la Svizzera
Permette di creare e stampare il facsimile del formulario IVA per la svizzera in formato Pdf e Xml
per la trasmissione elettronica dei dati IVA sul portale dell'AFC.

Il Rendiconto IVA è previsto per i due metodi:

Metodo Effettivo  - Per coloro che hanno l'IVA sul fatturato e sull'incassato
Aliquote saldo  - Per coloro che hanno una gestione IVA forfettaria.

A partire dal 01.07.2024 questa estensione sarà disponibile unicamente con il piano
Advanced  di Banana Contabilità Plus. Maggiori informazioni...

Fatturazione QR per la Svizzera
Questa estensione crea la fattura con il codice QR , secondo le nuove normative svizzere e, nel
piano Advanced sono previste maggiori personalizzazioni sia per la Fatturazione integrata sia per
Offerte e Fatture.

Patriziati Ticino stampe elenco Patrizi
Per stampare il registro dei patrizi nel Canton Ticino. Sono previsti vari  report con l'elenco dei patrizi

, con la possibilità di scegliere se si vuole l'elenco completo, solo con diritto di voto e se in ordine di
numero o in ordine alfabetico.

Analisi di bilancio e flussi di cassa
Report e grafici finanziari avanzati  per la tua contabilità in partita doppia, compresi il rendiconto
finanziario, i rapporti finanziari standard, l'analisi Dupont e l'indice Altman. Puoi confrontare i dati
storici su più anni e i dati di previsione con l'anno in corso.

Questa estensione è disponibile unicamente con il piano Advanced  di Banana
Contabilità Plus.

Gestione portafoglio titoli
Per gestire nel file della tua contabilità anche i titoli . Genera i report con i dettagli sui movimenti dei
tuoi titoli, la riconciliazione e dati di valutazione contabili del portafoglio.

https://www.banana.ch/shop/it/checkout/email
https://www.banana.ch/it/node/11557
https://www.banana.ch/apps/it/node/9023
https://www.banana.ch/apps/it/node/9024
https://www.banana.ch/shop/it/checkout/email
https://www.banana.ch/shop/it/checkout/email
https://www.banana.ch/it/node/11554
http://www.banana.ch/apps/it/node/9645
https://www.banana.ch/apps/it/node/7992
http://www.banana.ch/apps/it/node/9426
https://www.banana.ch/shop/it/checkout/email
http://www.banana.ch/apps/it/node/9486
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Questa estensione è disponibile unicamente con il piano Advanced  di Banana
Contabilità Plus.

Gestione costruzioni e ristrutturazioni
Per gestire i progetti di costruzioni e ristrutturazioni . Tieni facilmente sotto controllo i costi del tuo
progetto, dalla fase di preventivo, assegnazioni e pagamenti. Vedi se i costi sono in linea con i
preventivi per evitare di superare il budget imposto. Classificazione dei dati per categoria di spesa e
per imprese.

Questa estensione è disponibile unicamente con il piano Advanced  di Banana
Contabilità Plus.

Rendiconto gestionale e stato patrimoniale Enti Terzo
Settore (Italia)
L'estensione permette di creare il calcolo e le stampe seguenti :

Stato gestionale
Stato patrimoniale
Report 5 per mille
Report raccolta fondi
Attestato di donazione per i soci.

Elenco di tutte le estensioni
Nella nostra pagina web Estensioni  si trova l'elenco di tutte le estensioni disponibili per la Svizzera,
Italia e altre Nazioni.

Estensioni autoprogrammate
Per gli esperti di programmazione è possibile modificare estensioni esistenti o crearne di proprie,
installandole poi manualmente sul programma.

Questa possibilità è disponibile unicamente con il piano Advanced  di Banana Contabilità Plus.

https://www.banana.ch/shop/it/checkout/email
http://www.banana.ch/apps/it/node/9475
https://www.banana.ch/shop/it/checkout/email
http://www.banana.ch/it/it/contabilita-terzo-settore/piu-di-220000
http://www.banana.ch/apps/it/node/8536
https://www.banana.ch/shop/it/checkout/email
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Applicativi di Produttività

Gli Applicativi di Produttività di Banana Contabilità Plus si affiancano a quelli contabili per poter
gestire, oltre la contabilità, anche tutte le altre esigenze di un'azienda. Tutto in modo facile, veloce e
con risultati immediati e professionali. Il Timesheet è completamente gratuito, perché è incluso
nel piano Free di Banana Contabilità Plus; mentre gli altri applicativi sono gratuti fino a 70
registrazioni nel piano Free e illimitati nei piani Professional e Advanced .

Gli Applicativi di Produttività sono indipendenti dalla contabilità, anche se ci sono delle funzioni e delle
estensioni che possono essere abbinati al file della contabilità, per creare dei report e avere i dei dati
nel file della contabilità.

Gli Applicativi di Produttività inclusi in Banana Contabilità Plus sono i seguenti:

Offerte e Fatture: per la gestione delle offerte e fatture.
Magazzino: per la gestione degli articoli di magazzino.
Foglio ore di lavoro: per registrare la durata e le ore di lavoro.
Registro beni ammortizzabili: per la gestione degli attivi ammortizzabili.
Rubrica indirizzi: per la gestione degli indirizzi e delle etichette.
Biblioteca e collezioni: per la gestione dei libri o altri oggetti (es. collezione di quadri, gioielli....).
Tabella semplice: viene lasciata all'utente la possibilità di creare una tabella personalizzata.

Altre funzioni abbinabili agli Applicativi Produttività
Questi comandi sono particolarmente utili in abbinamento agli Applicativi Produttività:

Estrai e ordina righe
Per creare liste dei dati esistenti.
Stampa etichette
Per creare le etichette degli indirizzi o degli articoli.
Aggiungi nuove funzionalità

Tabella documenti (allegato al bilancio...)
Tabella semplice

Menu Estensioni
Per creare report su misura, fare calcoli o altro.

https://www.banana.ch/it/buy
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Offerte e Fatture distinte dalla contabilità

L'applicativo Offerte e Fatture di Banana Contabilità Plus consente di generare e stampare
preventivi e fatture in modo rapido e semplice. Questo strumento è l'ideale per sostituire Excel nella
gestione delle fatture, offrendo una soluzione professionale senza costi aggiuntivi. L'utilizzo è intuitivo
e non richiede competenze contabili.

Ripresa automatica degli indirizzi: gli indirizzi vengono automaticamente ripresi dai
contatti, evitando la necessità di reinserirli nelle fatture.
Calcoli automatici: tutti i calcoli sono eseguiti automaticamente, garantendo precisione e
aggiornamento costante.
Personalizzazione avanzata: possibilità di impostare lingua, valuta, numero di decimali e
arrotondamento per ogni singola fattura.
Gestione flessibile delle fatture: opzioni per modificare o duplicare fatture e offerte con
facilità. Conversione semplice delle offerte in fatture.

Come iniziare con Offerte e Fatture
Per utilizzare l'applicativo è necessario scaricare e installare Banana Contabilità Plus . Per un avvio
facile e immediato consulta le nostre risorse: 

▶ Video Come iniziare con le Offerte e Fatture
▶ Video Fatture QR in tre semplici passi

Dal menu Menu File → Nuovo, puoi aprire un modello Fattura per creare fin da subito il file delle tue
Offerte e Fatture. Inserisci i propri dati e i dati dei tuoi clienti e sei già operativo. Per maggiori
informazioni visita la pagina Come fare per... 

Sono presenti vari campi per inserire tutte le informazioni necessarie e gli elementi da fatturare. Ecco
i principali:

https://www.banana.ch/it/node/11181
https://www.banana.ch/it/node/11399
https://www.banana.ch/it/node/11510
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Informazioni della fattura: Nr. fattura, lingua, moneta, modalità IVA (fatture senza IVA,
incluso IVA nell'importo ed escluso IVA, con importo IVA separato), date emissione e scadenza
della fattura,
Indirizzo cliente: tutti i dati del cliente, inseriti nella tabella Contatti, vengono ripresi in
automatico nelle Offerte e Fatture.
Dati della fattura: titolo, testo iniziale, dettagli fattura (elenco di articoli da fatturare,
quantità, descrizione, importo) e testo finale.
Totali e sconto: sconti e acconti, totali parziali e complessivi, vengono calcolati dal
programma, secondo i valori inseriti.

Le tabelle 
L'applicativo Offerte e Fatture si basa su diverse tabelle che si usano in modo simile a quelle di Excel,
ma già completamente impostate e programmate per generare offerte e fatture in modo veloce e
sicuro. 

Tabella Contatti: è la tabella dove impostare in modo preciso e ordinato i dati dei clienti. I dati
possono essere sempre aggiornati e modificati. È possibile la Ripresa dati da SmallInvoice con
estensione Banana specifica .

Tabella Articoli: in questa tabella vengono inseriti i dati per la gestione degli articoli o i servizi da
fatturare. Tramite l'assegnazione di un Id è possibile raggruppare le varie categorie di articoli o servizi
da fatturare. Si inseriscono i pezzi, il prezzo unitario e si può indicare il conto di riferimento della
contabilità. Sono disponibili anche le colonne per inserire la data di entrata e di uscita della merce e
per le annotazioni.

Tabella Fatture: la tabella è destinata all'inserimento di tutti gli elementi da fatturare. È quella più
automatizzata:

Ripresa in automatico dell'indirizzo del cliente, selezionando semplicemente l'Id di contatto del
cliente.
Ripresa automatica di tutti i dati della fattura: con un doppio click sulla cella della colonna
Totale, si apre un dialogo fattura dove sono ripresi tutti i dati inseriti nelle altre colonne della
tabella Fatture (indirizzo del cliente, data e numero di fattura, riferimento, numero di ordine,
prezzo unitario, aliquota IVA e altri possibili dati). Basta inserire le quantità e la fattura è pronta.
Può essere salvata in PDF o stampata su carta.

Tabella Offerte: si inseriscono i dati delle offerte. È del tutto simile alla tabella Fatture, con le stesse
funzionalità, modalità di calcolo e stampa, ovviamente cambia la dicitura. Le Offerte possono essere
convertite in fatture in qualsiasi momento, con la ripresa in automatico dei dati nella fattura, che
potrà essere immediatamente salvata, stampata e inviata al cliente.

Tabella Codici IVA: nella tabella vengono impostati i codici IVA per la creazione delle fatture. Nella
preparazione delle fatture, le aliquote vengono riprese in automatico e i calcoli sono automatici. Le
aliquote possono essere modificate se dovessero cambiare le normative in vigore.

Struttura della fattura
In questa immagine vedi com'è strutturata la fattura:

https://www.banana.ch/apps/it/node/9490
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Logo
Hai la possibilità d'inserire un
logo personalizzato.
Menu file > Imposta logo

 

Intestazione
I dati dell'intestazione della
fattura sono ripresi da
Menu File > Proprietà file (Dati
base) > sezione Indirizzo

 

Indirizzo del cliente
L'indirizzo del cliente viene
ripreso dalla Tabella Contatti,
dove devi impostare gli indirizzi
dei clienti.

 

Dati della fattura
Il contenuto della fattura deve
essere immesso nel nuovo
dialogo di creazione/modifica di
una fattura.
Menu Fatture > Nuova fattura

 
Testi liberi
Puoi definire titolo, testo iniziale e
note finali dal Dialogo fattura.

 

QR-Code svizzero
Le  impostazioni si possono
definire solo per la Svizzera,
unicamente con il layout [CH10]
Layout con codice QR svizzero .

Stampe e report
Stampa fattura con codice QR per la Svizzera :

È possibile stampare la fattura con bollettino QR anche senza importo e senza indirizzo,
lasciando un riquadro vuoto per inserire i dati manualmente. Maggiori informazioni alla
pagina Personalizzazione QR-Code , paragrafo Includi/escludi dalla stampa.

Stampa fattura per tutti gli altri paesi .
Stampa fattura su carta o in formato PDF.
Aggiunta del proprio logo nelle stampe delle Offerte e delle Fatture.
Visualizza fatture aperte.
Nella pagina Come fare per... trovi le informazioni relative alla stampa e alle impostazioni di
stampa.
Personalizzare la stampa delle offerte e fatture:

Con il Piano Professional, puoi utilizzare le impostazioni predefinite e personalizzare la
stampa delle offerte e fatture .
Con il Piano Advanced, oltre a personalizzare la stampa delle offerte e fatture , puoi
avere diverse personalizzazione supplementari .

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9338#personalizzazione_della_stampa_fatture
https://www.banana.ch/apps/it/node/9338#personalizzazione_della_stampa_fatture
https://www.banana.ch/apps/it/node/9338#personalizzazione_della_stampa_fatture
https://www.banana.ch/apps/it/node/9338#personalizzazione_con_programmazione
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Differenze con l'applicativo Fatturazione integrata
Offerte e Fatture è un applicativo distinto da tutti gli altri applicativi contabili e viene
utilizzato solo per creare offerte e fatture. Non esiste alcuna connessione con il file della contabilità,
come invece avviene per la fatturazione integrata, i cui dati rimangono contabilizzati nel file della
contabilità.

I dati delle fatture nell'applicativo Offerte e Fatture non possono essere importati nel file della
contabilità, ma occorre inserirli manualmente. Inoltre non è possibile importare nell'applicativo Offerte
e Fatture i movimenti bancari (inclusi i pagamenti). Se desideri queste funzioni ti consigliamo di usare
la fatturazione integrata nel file contabile .

Nell'applicativo Offerte e fatture è presente la tabella Fatture con un dialogo Fattura dove si
trovano varie colonne e opzioni per dettagliare le varie posizioni e i dati da inserire. Sotto questo
aspetto, l'applicativo Offerte e Fatture è molto più flessibile e completo perché permette maggiori
personalizzazioni. Nella fatturazione integrata, gli elementi e i dettagli da fatture (quantità, prezzi,
unità, ecc) si registrano unicamente nella tabella Registrazioni.

Nella fatturazione integrata non è possibile creare delle offerte. È possibile creare e stampare una
fattura con il titolo "Offerta" (al posto di Fattura).
L'applicativo Offerte e Fatture è specifico anche per creare Offerte.

Esportazione e archiviazione dati
Copia e incolla direttamente da e per Excel.
Esportazione tabelle in PDF e diversi altri formati.
Archiviazione delle stampe e dei dati in PDF o altri formati.
Salvataggio del file su qualsiasi supporto.
Esportazione dati offerte e fatture in formato .csv con l'estensione Strumenti Offerte e
Fatture.

Altre Funzioni
Stampa Richiami
Stampa bollettino di consegna
Modalità Dark Mode sotto macOS e Windows. 

http://www.banana.ch/doc/it/node/8294
https://www.banana.ch/apps/it/node/9667
https://www.banana.ch/apps/it/node/9667
https://www.banana.ch/apps/it/node/9667
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Funzioni disponibili solo con il piano Advanced
Imposta lo sconto per ogni singolo articolo, sia come percentuale che come importo.
Per ogni articolo, indica la data in cui è avvenuta la prestazione.
Aggiungi dei campi nella fattura per inserire informazioni specifiche (progetto, riferimenti
aggiuntivi, ecc.).
Stampare bollettini di consegna con o senza importi.
Stampare i richiami con o senza bollettino QR Svizzero.
Aggiungere dei totali intermedi (Banana Contabilità+ 10.1.8 o più recente)

Certe personalizzazioni del layout di stampa CH10 e UNI11 sono disponibili solo con il piano
Advanced.

Funzionalità al momento non disponibili
Il nuovo applicativo Offerte e Fatture supporta le funzionalità essenziali relativi alla preparazione e
alla stampa di offerte e fatture, anche per mantenere il funzionamento il più semplice possibile.

Le seguenti funzionalità non sono al momento disponibili:

Riprendere i dati delle fatture nel file della contabilità.
Collegare con l'applicativo magazzino.
Esportare i dati delle singole fatture.
Invio automatizzato delle fatture per email.
Invio fatture tramite eBill.
Definire più conti IBAN.
Aggiungere colonne supplementari nei dettagli della fattura.
Definire lo sconto per il singolo contatto.
Definire lo sconto per il singolo articolo (solo con il piano Advanced).
Creare serie di fatture.
Importare pagamenti con QR-Code.
Creare un nuovo anno.
Inserire l'indirizzo di spedizione.
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Caratteristiche Offerte e Fatture

Il nuovo Applicativo Offerte e Fatture  è incluso in Banana Contabilità Plus . Creare e stampare
preventivi e fatture diventa semplice e veloce.

Se vuoi provarlo subito, scarica gratuitamente il Piano Free . Puoi inserire fino ad un massimo di 20
fatture e 20 offerte.

Con un abbonamento annuale , puoi inserire un numero illimitato di offerte e fatture.

La logica delle offerte e fatture
Per creare offerte e fatture, basta inserire i dati dei tuoi clienti, gli articoli o i servizi da fatturare, i
prezzi unitari e le aliquote IVA, mentre a tutto il resto ci pensa il programma.

Tanti automatismi per rendere facile il lavoro e con risultati professionali immediati.

Ripresa automatica degli indirizzi dai contatti per non dover inserire nuovamente i dati nella
fattura.
Ripresa dati da SmallInvoice con estensione Banana specifica .
Nessun calcolo manuale. Tutti i calcoli sono automatici, sempre precisi ed aggiornati.
Offerte dettagliate che possono essere rapidamente convertite in fatture e inviate al cliente.
Fatture create con il codice QR per la Svizzera.
Per ogni singola fattura si possono impostare la lingua, la moneta, il numero di decimali e
l'arrotondamento.
Modifiche e/o duplicati di fatture e offerte già fatte al cliente. Basta inserire le quantità e la
nuova fattura è pronta da inviare.
Annotazioni per promemoria o altro.
Data di pagamento per controllare gli incassi.
Visualizzazione fatture aperte per controllare le scadenze.
Salvataggio in PDF e stampa sul cartaceo.
Archiviazione fatture per avere uno storico sempre ordinato e a disposizione per eventuali
controlli fiscali.
Modalità Dark Mode sotto macOS e Windows.

 

Funzionalità simili a Excel

Aggiungi quante righe vuoi senza limiti, o puoi eliminare le  righe di cui non hai bisogno.
Non hai bisogno d'inserire formule perché i calcoli vengono aggiornati immediatamente e hai
una visualizzazione contestuale, come nei fogli di calcolo.
Le colonne sono personalizzabili, puoi modificarne la posizione, aggiungerne di nuove e
cambiarne la larghezza.
Lavora con il formato che ti è più congeniale.
Colora le righe per individuare subito fatture in sospeso o per altre fini.

http://www.banana.ch/doc/it/node/9752
https://www.banana.ch/it/node/11181
https://www.banana.ch/it/buy
https://www.banana.ch/it/buy
https://www.banana.ch/apps/it/node/9490
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Basato su tabelle
L'applicativo Offerte e Fatture si basa su diverse tabelle che si usano in modo simile a quelle di Excel,
ma già completamente impostate e programmate con tutto quanto serve per preparare offerte e
fatture in modo veloce e sicuro. 

Tabella Contatti
È la tabella dove impostare in modo preciso e ordinato i dati dei clienti. I dati possono essere
sempre aggiornati e modificati.
Tabella Articoli 
In questa tabella vengono inseriti i dati per la gestione degli articoli o i servizi da fatturare.
Tramite l'assegnazione di un Id è possibile raggruppare le varie categorie di articoli o servizi da
fatturare. Si inseriscono i pezzi, il prezzo unitario e si può indicare il conto di riferimento della
contabilità. Sono disponibili anche le colonne per inserire la data di entrata e di uscita della
merce e per le annotazioni.
Tabella Fatture
Questa tabella  è destinata per inserire gli elementi da fatturare. È quella più automatizzata:

Ripresa in automatico dell'indirizzo del cliente, selezionando semplicemente l'Id di
contatto del cliente.
Ripresa automatica di tutti i dati della fattura: con un doppio click sulla cella della colonna
Totale, si apre un dialogo fattura dove sono stati ripresi tutti i dati inseriti nelle altre
colonne della tabella Fatture (indirizzo del cliente, data e numero di fattura, riferimento,
numero di ordine, prezzo unitario, aliquota IVA e altri possibili dati). Basta inserire le
quantità e la fattura è pronta. Può essere salvata in PDF o stampata su carta.

Tabella Offerte
Si inseriscono i dati delle offerte. È del tutto simile alla tabella Fatture, con le stesse
funzionalità, modalità di calcolo e stampa, ovviamente cambia la dicitura. Le offerte possono
essere in qualsiasi momento convertite in fatture con la ripresa in automatico dei dati nella
fattura, che potrà essere immediatamente salvata, stampata e inviata al cliente.
Tabella Codici IVA 
Vengono impostati i codici IVA per la creazione delle fatture. Nella preparazione delle fatture, le
aliquote vengono riprese in automatico e i calcoli sono automatici. Le aliquote possono essere
modificate se dovessero cambiare le normative in vigore.

Impostazioni dati base
Intestazioni e dati base delle Offerte e fatture impostati in un'unica finestra di dialogo, facile da
visualizzare.

Intestazioni con testi liberi
Indirizzo con  tutti i dati aziendali
Collegamento a estensioni predefinite e personalizzate
Password per rendere sicuro il tuo file delle offerte e fatture
Puoi creare più file di Offerte e Fatture in lingue diverse.

File e salvataggio dati
Hai tutti i dati salvati in un unico file, dove trovi facilmente tutto senza perdite di tempo.
Attribuisci al file il nome che desideri.
Puoi gestire un numero illimitato di file.
Salva i dati su qualsiasi supporto, computer, rete, cloud o inviali per email . Puoi accedervi

https://www.banana.ch/it/node/11059
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ovunque tu sia.
Accesso in contemporanea da più utenti, dove però solo una persona può aprire il file in
modifica.
Rendi più sicuro il tuo file inserendo una protezione con password.

Inserimento dati Offerte e Fatture
Nelle colonne hai la visualizzazione degli importi nel formato del tuo computer.
Scegli tu l'identificativo dell'articolo liberamente (conto numerico o alfa-numerico, fino a 256
caratteri).
Calcoli e totali visualizzati contestualmente e sempre aggiornati.
Nella colonna Links della tabella Articoli puoi aggiungere le immagini degli articoli.
Disposizione personalizzabile delle colonne.
Il comando Cerca ti permette di cercare velocemente i dati delle fatture o delle offerte.
Il comando Sostituisci ti permette di sostituire in automatico dei testi o altri dati nelle tabelle.
Puoi ordinare le righe secondo diverse chiavi di ordinamento.
Esportazione dati delle fatture in PDF per la conservazione dei dati
Esportazione in altri formati per una rielaborazione dati.
Importazione dati da altri programmi in formato Testo, Ascii e CSV
Importazione dati da SmallInvoice .

Segnalazioni errori e controllo
Comando per il ricalcolo immediato.
Segnalazione di eventuali impostazioni sbagliate o errori.
Ogni segnalazione è collegata a una pagina di aiuto che spiega le cause e la soluzione.
Possibilità di correggere in ogni momento.

Stampe e report
Stampa fattura con codice QR per la Svizzera .

È possibile stampare la fattura con bollettino QR anche senza importo e senza indirizzo,
lasciando un riquadro vuoto per inserire i dati manualmente. Maggiori informazioni alla
pagina Personalizzazione QR-Code , paragrafo Includi/escludi dalla stampa.

Stampa fattura per tutti gli altri paesi .
Stampa fattura su carta o in formato PDF.
Aggiunta del proprio logo nelle stampe delle Offerte e delle Fatture.
Visualizza fatture aperte.
Nella pagina Come fare per... trovi le informazioni relative alla stampa e alle impostazioni di
stampa.
Personalizzare la stampa delle offerte e fatture.

Con il Piano Professional, puoi utilizzare le impostazioni predefinite e personalizzare la
stampa delle offerte e fatture .
Con il Piano Advanced, oltre a personalizzare la stampa delle offerte e fatture , puoi
avere diverse personalizzazione supplementari .

Esportazione e archiviazione dati
Copia e incolla direttamente da e per Excel.
Esportazione tabelle in PDF e diversi altri formati.

https://www.banana.ch/apps/it/node/9490
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9338#personalizzazione_della_stampa_fatture
https://www.banana.ch/apps/it/node/9338#personalizzazione_della_stampa_fatture
https://www.banana.ch/apps/it/node/9338#personalizzazione_della_stampa_fatture
https://www.banana.ch/apps/it/node/9338#personalizzazione_con_programmazione
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Archiviazione delle stampe e dei dati in PDF o altri formati.
Salvataggio del file su qualsiasi supporto.
Esportazione dati offerte e fatture in formato .csv con l'estensione Strumenti Offerte e
Fatture.

Documentazione completa
Documentazione applicativo offerte e fatture aggiornata costantemente.
Documentazione sul programma Banana Contabilità Plus .
Domande e risposte sul programma Banana Contabilità Plus .
Documentazione disponibile anche in formato PDF.

Cronologia modifiche
L'Applicativo Offerte e Fatture viene aggiornato e migliorato costantemente.

Per informazioni dettagliate, consulta la pagina Cronologia modifiche.

 Funzioni disponibili solo con il piano Advanced
Imposta lo sconto per ogni singolo articolo, sia come percentuale che come importo.
Per ogni articolo, indica la data in cui è avvenuta la prestazione.
Aggiungi dei campi nella fattura per inserire informazioni specifiche (progetto, riferimenti
aggiuntivi, ecc.).
Stampare bollettini di consegna con o senza importi.
Stampare i richiami con o senza bollettino QR Svizzero.
Aggiungere dei totali intermedi (Banana Contabilità+ 10.1.8 o più recente)

Certe personalizzazioni del layout di stampa CH10 e UNI11 sono disponibili solo con il piano
Advanced.

Funzionalità al momento non disponibili
Il nuovo applicativo Offerte e Fatture supporta le funzionalità essenziali relativi alla preparazione e
alla stampa di offerte e fatture, anche per mantenere il funzionamento il più semplice possibile.

Le seguenti funzionalità non sono al momento disponibili:

Riprendere i dati delle fatture nel file della contabilità.
Collegare con l'applicativo magazzino.
Esportare i dati delle singole fatture.
Invio automatizzato delle fatture per email.
Invio fatture tramite eBill.
Definire più conti IBAN.
Aggiungere colonne supplementari nei dettagli della fattura.
Definire lo sconto per il singolo contatto.
Definire lo sconto per il singolo articolo (solo con il piano Advanced).
Creare serie di fatture.
Importare pagamenti con QR-Code.
Creare un nuovo anno.
Inserire l'indirizzo di spedizione.

https://www.banana.ch/apps/it/node/9667
https://www.banana.ch/apps/it/node/9667
https://www.banana.ch/apps/it/node/9667
https://www.banana.ch/doc/it/documentation
https://www.banana.ch/it/node/9340
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Elenco completo funzionalità al momento non disponibili

https://www.banana.ch/doc/it/features_not_available
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Come iniziare una Fattura

Per utilizzare l'applicativo Fattura devi aver scaricato e installato Banana Contabilità Plus .

Guarda il Video: Come iniziare con le Offerte e Fatture . Scopri come creare e stampare offerte e
fatture personalizzate.

 Creare un file Fattura
Per un inizio facile e veloce consigliamo di partire da uno dei nostri modelli predefiniti per poi
personalizzarlo, piuttosto che da un file vuoto.

Procedi nel seguente modo:

Menu File → Nuovo.
Seleziona Regione/lingua.
Seleziona il Tipo → Offerte e Fatture.
Nella sezione a destra seleziona il modello desiderato.
Fai un doppio clic sul nome del modello oppure clicca sul bottone Crea. Il programma apre
direttamente il file selezionato.
Salva il file con nome.

 Inserire i dati base
Nel menu File → Proprietà file (Dati base) → sezione Indirizzo, imposta l'indirizzo della tua
società, che sarà ripreso nell'intestazione della fattura.
Se hai un logo che vuoi utilizzare, consulta la pagina Imposta logo.

Creare nuova fattura
Con il comando dal menu Fatture → Nuova fattura si accede al dialogo per la creazione di una
nuova fattura.

https://www.banana.ch/it/node/11181
https://www.banana.ch/it/node/11399
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Inserisci le informazioni base della fattura (numero fattura, lingua, moneta, modalità IVA, data,1.
oggetto, testo iniziale e testo finale).
Inserisci l'indirizzo di fatturazione (indirizzo cliente).2.
Inserisci i dettagli della fattura (prodotto, descrizione, quantità, importo).3.
Visualizza totali parziali e complessivi e inserisci eventuali sconti e acconti.4.
Salva e stampa la fattura.5.

Stampare una fattura
La stampa della fattura avviene dal menu Fatture → Stampa Fattura.

Nella pagina Stampa Offerte e Fatture trovi le informazioni per personalizzare e stampare le fatture.

Le tabelle
Il file Fattura è composto dalle seguenti tabelle:

Tabella Contatti dove inserire gli indirizzi dei clienti.
Tabella Articoli dove inserire i dati per la gestione degli articoli e del magazzino.
Tabella Fatture dove inserire tutti i dati relativi alle fatture.
Tabella Offerte dove inserire tutti i dati relativi alle offerte.
Tabella Codici IVA dove inserire i codici IVA con le relative aliquote.
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Tabella Contatti

La tabella Contatti presenta le colonne dove inserire gli indirizzi dei clienti.

Gli indirizzi dei contatti saranno ripresi in automatico nel dialogo fattura al momento della creazione o
modifica della fattura, semplificando l'immissione dei dati.

Cambiare i dati della tabella Contatti non modifica i dati di fatture e offerte esistenti. Se si vuole che
una fattura o un'offerta esistente venga aggiornata con i nuovi dati del contatto, è necessario:

Modificare la fattura o l'offerta tramite il dialogo fattura.
Nella sezione Indirizzo cliente selezionare nuovamente il cliente dalla lista.

Le colonne
La tabella Contatti contiene molte colonne, quelle visualizzate nell'immagine, sono quelle presenti
nella vista Base. L'elenco completo è visibile nella vista Completo. Per la personalizzazione delle
colonne consultare la pagina Disponi colonne.

Id

Si inserisce il numero del contatto.

Organizzazione

Si inserisce il nome della società o dell'organizzazione del contatto.

Titolo (Prefisso)

Si inserisce il prefisso del contatto.

Nome

Si inserisce il nome del contatto.

Cognome

Si inserisce il cognome del contatto.

Via

Si inserisce l'indirizzo.
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Extra

Si inserisce l'indirizzo extra.
In caso di utilizzo del layout fattura QR, consultare la documentazione Elementi comuni per la fattura
QR Svizzera  per maggiori informazioni.

Casella postale

Si inserisce la casella postale.

CAP

Si inserisce il codice postale.

Località

Si inserisce la località.

Codice nazione

Si inserisce il codice della nazione.

Il codice nazione deve essere di due caratteri conforme allo standard ISO 3166-1 (es. CH, LI, AT, DE,
IT, FR).

Lingua

Si inserisce la lingua del cliente.

I testi delle fatture vengono stampati nella lingua del cliente, a condizione che questa sia impostata
nella relativa colonna.
La lingua è un codice ISO generalmente di 2 lettere  minuscole (it=italiano, de=tedesco,
en=inglese, fr=francese).

Se per il cliente non è stata indicata la lingua viene usata quella del file, definita nel menu File →
Proprietà file (dati base) → Varia → Lingua corrente.

Numero fiscale

È possibile inserire il numero fiscale del cliente.

Numero IVA

È possibile inserire il numero IVA del cliente.

Note

Si inseriscono eventuali note.

https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9388
https://it.wikipedia.org/wiki/ISO_639-2
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Tabella Articoli | Offerte e fatture

La tabella Articoli presenta le colonne dove inserire i dati per la gestione degli articoli e del
magazzino.

Gli articoli saranno disponibili nel Dialogo fattura al momento della creazione o modifica della fattura,
semplificando l'immissione dei dati.

Le colonne
La tabella Articoli contiene molte colonne; quelle visualizzate nell'immagine, sono quelle presenti
nella vista Base. L'elenco completo è visibile nella vista Completo. Per la personalizzazione delle
colonne consultare la pagina Disponi colonne.

Tutti i contenuti delle colonne possono essere anche stampate nella fattura. Vedi personalizzazione
stampa dettaglio del layout CH10 ).

Links

Collegamento a un file di immagine del prodotto o PDF descrittivo

Id

Si inserisce il numero dell'articolo.

Descrizione

Si inserisce la descrizione dell'articolo.

Unità

Si inserisce il tipo di unità (pezzi, ore, ecc).

Prezzo unità

Si inserisce il prezzo unitario.
Nell'impostazione della fattura si indica se gli importi sono al netto o al lordo dell'IVA.
Attenzione, se si cambia l'impostazione dal netto al lordo o viceversa, il programma modifica gli
importi, così che è possibile stampare la stessa fattura con gli importi al netto e al lordo.

Conto

Si inserisce un eventuale conto come informazione da utilizzare per la registrazione manuale nella
contabilità.

https://www.banana.ch/apps/it/node/9365#dettagli_fattura
https://www.banana.ch/apps/it/node/9365#dettagli_fattura
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Questo valore serve solamente come informazione, non viene utilizzato per la creazione delle fatture.

Note

Si inseriscono eventuali note.

 Importazione catalogo
Tramite le funzioni di importazione è possibile automatizzare l'importazione dei dati da un catalogo di
prodotti già esistente. Si veda Ripresa dati da altri programmi.

È possibile anche integrare dei cataloghi di prodotti nel programma di fatturazione.
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Tabella Fatture

La tabella Fatture presenta le colonne dove vengono ripresi in automatico tutti i dati delle fatture
che sono stati inseriti nel Dialogo fattura.

Da questa tabella puoi:

Creare delle nuove fatture
Modificare le fatture esistenti
Duplicare delle fatture
Cancellare le fatture
Stampare le fatture
Archiviare le fatture

Le colonne
La tabella Fatture contiene molte colonne, quelle visualizzate nell'immagine, sono quelle presenti
nella vista Base. L'elenco completo è visibile nella vista Completo. Per la personalizzazione delle
colonne consultare la pagina Disponi colonne.

Id

Si inserisce il numero della fattura.
Il programma riprende in automatico il valore inserito nel Dialogo fattura.

Data

Si inserisce la data della fattura.
Il programma riprende in automatico la data inserita nel Dialogo fattura.

Descrizione

Si inserisce l'oggetto della fattura.
Il programma riprende in automatico il valore inserito nel Dialogo fattura.
Questo testo viene anche utilizzato come titolo/oggetto della fattura. Se definito sovrascrive il titolo
inserito nelle impostazioni del layout di stampa della fattura.

Contatto Id

Si inserisce il numero id del contatto.
Il programma riprende in automatico il valore inserito nel Dialogo fattura.

http://www.banana.ch/doc/it/node/9761#edit_invoice
http://www.banana.ch/doc/it/node/9761#duplicate_invoice
http://www.banana.ch/doc/it/node/9761#delete_invoice
http://www.banana.ch/doc/it/node/9761#print_invoice
http://www.banana.ch/doc/it/node/9761#archive_invoices
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Indirizzo

Il programma riprende in automatico i dati dell'indirizzo del cliente, in base al numero id contatto
inserito.

Importo sconto

Si inserisce l'importo dello sconto da applicare alla fattura.
Il programma riprende in automatico l'importo inserito nel Dialogo fattura.

Totale

Il programma riprende in automatico il valore del totale calcolato nel Dialogo fattura.

Scadenza

Si inserisce il termine di scadenza.
Il programma riprende in automatico il termine di pagamento dal Dialogo fattura.

Pagamento

Si inserisce la data del pagamento della fattura.

Note

Si inseriscono eventuali note.
Il programma riprende in automatico il testo inserito nel campo Testo finale del Dialogo fattura.
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Tabella Offerte

La tabella Offerte presenta le colonne dove vengono ripresi in automatico tutti i dati delle offerte che
sono stati inseriti nel Dialogo fattura.

Le colonne
La tabella Offerte contiene molte colonne, quelle visualizzate nell'immagine, sono quelle presenti
nella vista Base. L'elenco completo è visibile nella vista Completo. Per la personalizzazione delle
colonne consultare la pagina Disponi colonne.

Id

Si inserisce il numero dell'offerta.
Il programma riprende in automatico il valore inserito nel dialogo di creazione dell'offerta.

Data

Si inserisce la data dell'offerta.
Il programma riprende in automatico la data inserita nel dialogo di creazione dell'offerta.

Descrizione

Si inserisce l'oggetto dell'offerta.
Il programma riprende in automatico il valore inserito nel dialogo di creazione dell'offerta.

Contatto Id

Si inserisce il numero id del contatto.
Il programma riprende in automatico il valore inserito nel dialogo di creazione dell'offerta.

Indirizzo

Il programma riprende in automatico i dati dell'indirizzo del cliente, in base al numero id contatto
inserito.

Importo sconto

Si inserisce l'importo dello sconto da applicare all'offerta.
Il programma riprende in automatico l'importo inserito nel dialogo di creazione dell'offerta.

Totale

Il programma riprende in automatico il valore del totale calcolato nel dialogo di creazione dell'offerta.
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Note

Si inseriscono eventuali note.
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Tabella Codici IVA

La tabella Codici IVA presenta le colonne dove inserire i codici IVA con le relative aliquote. 

I dati devono essere inseriti manualmente. Quando cambiano le aliquote IVA la tabella deve essere
aggiornata cambiando o aggiungendo i codici Id e le percentuali delle nuove aliquote.

I Codici IVA saranno ripresi in automatico nel dialogo fattura al momento della creazione o modifica
della fattura, semplificando l'immissione dei dati.

Le colonne
La tabella Codici IVA contiene molte colonne; quelle visualizzate nell'immagine, sono quelle presenti
nella vista Base. L'elenco completo è visibile nella vista Completo. Per la personalizzazione delle
colonne consultare la pagina Disponi colonne.

Id

Si inserisce il codice IVA.

Descrizione

Si inserisce la descrizione del codice IVA.

%IVA

Si inserisce l'aliquota IVA.

Note

Si inseriscono eventuali note.

IVA sul lordo o sul netto
L'impostazione per il calcolo al netto o al lordo viene fatta a livello di singola fattura, nel dialogo
Impostazioni fattura .

http://www.banana.ch/doc/it/node/9893
http://www.banana.ch/doc/it/node/9893
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Aggiungere, Modificare Fatture

Menu Fatture
Nel menu Fatture trovi i comandi per:

Creare una nuova fattura
Modificare una fattura
Duplicare una fattura
Cancellare una fattura
Stampare una fattura
Visualizzare le fatture aperte
Visualizzare le fatture di un cliente
Archiviare le fatture

Creare una nuova fattura
Per creare una nuova fattura, hai due possibilità:

Dal menu Fatture:
Utilizza il comando Fatture > Nuova fattura.
Si apre poi il dialogo fattura dove inserire i dati.
Il nuovo numero fattura progressivo viene attribuito dal programma. È possibile cambiarlo
manualmente.
Inserisci i dati della fattura e salva.

Direttamente dalla tabella Fatture:
Seleziona una nuova riga nella tabella.
Nella colonna Id (numero fattura), clicca sulla piccola icona Nuova fattura che appare in
alto nella cella.

 
Si apre poi il dialogo fattura dove inserire i dati.
Inserisci i dati della fattura e salva.

Quando crei una nuova fattura il programma aggiorna automaticamente la tabella Fatture. I dati della
nuova fattura vengono aggiunti in una nuova riga della tabella.

 Modificare una fattura
Per modificare una fattura esistente, hai due possibilità:

Dal menu Fatture:
Seleziona la riga con la fattura che vuoi modificare.
Utilizza il comando dal menu Fatture > Modifica fattura.

http://www.banana.ch/doc/it/node/9761#edit_invoice
http://www.banana.ch/doc/it/node/9761#duplicate_invoice
http://www.banana.ch/doc/it/node/9761#delete_invoice
http://www.banana.ch/doc/it/node/9761#print_invoice
http://www.banana.ch/doc/it/node/9761#show_open_invoices
http://www.banana.ch/doc/it/node/9761#show_customer_invoices
http://www.banana.ch/doc/it/node/9761#archive_invoices
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Si apre poi il dialogo fattura dove inserire e modificare i dati.
Fai le opportune modifiche e salva.

Direttamente dalla tabella Fatture:
Seleziona la riga con la fattura che vuoi modificare.
Nella colonna Id (numero fattura), clicca sulla piccola icona Modifica fattura che appare
in alto nella cella.

 
Si apre poi il dialogo fattura dove inserire e modificare i dati.
Fai le opportune modifiche e salva.

Quando modifichi una fattura il programma aggiorna automaticamente i dati nella tabella Fatture.

 Duplicare una fattura
Per duplicare una fattura, hai due possibilità:

Dal menu Fatture:
Seleziona la riga con la fattura che vuoi duplicare.
Utilizza il comando dal menu Fatture > Duplica fattura.
Il nuovo numero fattura progressivo viene attribuito dal programma. È possibile cambiarlo
manualmente.
Si apre poi il dialogo fattura con i dati della fattura che hai scelto di duplicare.
Fai le opportune modifiche e salva.
Il programma aggiorna automaticamente la tabella Fatture.

Direttamente dalla tabella Fatture:
Seleziona la riga con la fattura che vuoi duplicare. Puoi anche selezionare più righe per
duplicare più fatture in una sola volta.
Utilizza il comando dal menu Modifica > Duplica righe.
Il programma aggiorna automaticamente la tabella Fatture aggiungendo le righe
duplicate.
Per ogni fattura duplicata, devi poi modificare manualmente il numero e i dati della
fattura.

 Cancellare una fattura
Per cancellare una fattura:

Vai nella tabella Fatture.
Seleziona la riga con la fattura che vuoi cancellare. Puoi anche selezionare più righe per
cancellare più fatture in una sola volta.
Utilizza il comando dal menu Modifica > Elimina righe.
Le fatture vengono eliminate dalla tabella.
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 Stampare una fattura
Nella pagina Stampa Offerte e Fatture trovi le informazioni per personalizzare e stampare le fatture.

Per stampare una fattura, hai due possibilità:

Dal menu Fatture:
Seleziona la riga con la fattura che vuoi stampare.
Utilizza il comando dal menu Fatture > Stampa fattura.

Direttamente dalla tabella Fatture:
Seleziona la riga con la fattura che vuoi stampare.
Nella colonna Id (numero fattura), clicca sulla piccola icona Stampa fattura che appare
in alto nella cella.

 

 Visualizzare le fatture aperte
Puoi estrarre in una tabella le fatture non ancora incassate:

Vai nella tabella Fatture.
Utilizza il comando dal menu Fatture > Visualizza fatture aperte.
Il programma estrae tutte le righe delle fatture senza data di pagamento.

Ogni volta che viene incassata una nuova fattura, inserisci la data d'incasso nella colonna
Pagamento della tabella Fatture.

 Visualizzare le fatture di un cliente
Puoi estrarre in una tabella le fatture di un cliente:

Vai nella tabella Fatture.
Sotto la colonna Contatto Id clicca sul numero cliente di cui si vogliono avere le fatture
Col tasto destro del mouse clicca sul campo selezionato e seleziona il comando Estrai righe
Il programma estrae tutte le righe appartenente al cliente

 Archiviare le fatture
Con l'applicativo Offerte e Fatture:

Puoi inserire quante fatture vuoi, non ci sono limiti.
Puoi tenere fatture di diversi anni in un unico file.
Non è necessario creare un nuovo file per ogni anno nuovo.

Le fatture degli anni precedenti possono essere archiviate in qualsiasi momento:
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Vedi come fare per archiviare le fatture.
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Dialogo Aggiungere e modificare le fatture

Il dialogo Fattura permette di inserire e modificare i dati delle fatture. 

Accedere alla finestra di dialogo
Si accede tramite le seguenti modalità:

Fattura
Dal menu Fatture > comando Nuova fattura...
Dal menu Fatture > comando Modifica fattura...
Dalla tabella Fatture > con un doppio click sulla riga della fattura interessata, nella
colonna Indirizzo
Dalla tabella Fatture > con un doppio click sulla riga della fattura interessata, nella
colonna Totale
Dalla colonna ID, cliccando sulla piccola icona a destra della cella Modifica

Offerta
Dal menu Fatture > comando Nuova offerta...
Dal menu Fatture > comando Modifica offerta...
Dalla tabella Offerte > con un doppio click sulla riga dell'offerta interessata, nella
colonna Indirizzo
Dalla tabella Offerte > con un doppio click sulla riga dell'offerta interessata, nella
colonna Totale
Dalla colonna ID, cliccando sulla piccola icona a destra della cella Modifica

Dialogo Sezioni
Il dialogo è suddiviso in due sezioni:

Fattura
Nella sezione Modifica fattura si inseriscono i dati della fattura.

Impostazioni
Nella Impostazioni fattura si definiscono i parametri per i nuovi documenti e le
impostazioni dell'interfaccia del dialogo fattura.
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Dialogo Modifica fattura

 

Viste
Sono elencate in alto.

Nella sezione Impostazioni, per le viste Base, Personalizzata 1, Personalizzata 2 è possibile definire
quali campi rendere visibili e quali invece nascondere. 

Se il campo contiene un valore viene comunque visualizzato anche se il campo è stato indicato come
non visibile.

Cambiando tra le diverse viste si può passare da una con solo pochi campi a quella con molti più
elementi visibili. 

Le Viste disponibili sono le seguenti:

Base
Mostra i campi più frequentemente utilizzati.
Adattabile secondo i propri bisogni.

Personalizzata 1
Di default nascosta
Adattabile secondo i propri bisogni.

Personalizzata 2
Di default nascosta
Adattabile secondo i propri bisogni.

Completa
Vista completa con tutti i campi e di tutti gli articoli.
Non può essere modificata.

Struttura
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(1) Informazioni e testi liberi

Questa sezione permette di inserire delle informazioni riguardanti la fattura e di definire i testi liberi
da includere nella stampa.

Numero fattura
Si inserisce il numero della fattura.
Il numero viene ripreso e inserito in automatico dal programma nella colonna Id della
tabella Fatture.
Può essere incluso nella stampa della fattura.

Lingua
Si inserisce la lingua nella quale stampare la fattura.
Se definita viene ripresa e inserita la lingua del cliente impostata nella tabella Contatti.

Moneta
Si inserisce la moneta nella quale stampare la fattura.
Puoi indicare la sigla  (CHF, EUR, USD, ecc.) che verrà stampata sulla fattura.
Il programma non fa cambi e conversioni in altre monete.

Modalità IVA
Si seleziona la modalità IVA.
Se si cambia la modalità IVA, il programma modifica gli importi già inseriti, così che è
possibile stampare la stessa fattura con gli importi al lordo e al netto.
Se si è impostato l'IVA la Lordo e sono stati inseriti gli importi al netto, una volta cambiata
l'impostazione si devono anche modificare gli importi, in modo che siano al netto.

Senza IVA
Non viene applicata alcuna IVA.
Escluso IVA
Gli importi sono considerati al netto.
Incluso IVA
Gli importi sono considerati al lordo.

L'importo totale dell'IVA può variare di alcuni centesimi rispetto al calcolo eseguito
direttamente sul totale imponibile IVA. Il motivo è dovuto al fatto che il totale IVA viene
calcolato sommando l'importo IVA (arrotondato) di ogni singolo articolo. Questa differenza
non è da considerarsi un errore, ma una caratteristica del calcolo degli importi della
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fattura.
Data fattura

Si inserisce la data della fattura.
La data viene ripresa e inserita in automatico dal programma nella colonna Data della
tabella Fatture.
Può essere incluso nella stampa della fattura.

Termine pagamento
Il termine di pagamento viene inserito in automatico dal programma per tutte le fatture.
Può essere inserito manualmente per ogni fattura.
Può essere incluso nella stampa della fattura.

Numero ordine
È opzionale.
Si inserisce il numero di ordine.
Può essere incluso nella stampa della fattura.

Data ordine
È opzionale.
Si inserisce la data dell'ordine.
Può essere incluso nella stampa della fattura.

Informazioni aggiuntive
Richiede il Piano Advanced .
Sono opzionali.
Si possono definire e aggiungere alla fattura dei campi di informazioni aggiuntive
(massimo 8 campi) dove inserire testi personalizzati.
Si inserisce il valore/contenuto. Nella sezione Impostazioni si definiscono invece i
nomi/testi dei campi.
Possono essere inclusi nella stampa della fattura utilizzando i layout CH10  e UNI11 .
Nelle impostazioni di stampa dei layout, sotto Stampa → Informazioni si deve attivare
la voce Campi personalizzati.

Oggetto
È opzionale.
Si inserisce il testo dell'oggetto della fattura.
Il testo viene ripreso e inserito in automatico dal programma nella colonna Descrizione
della tabella Fatture.
Il testo viene incluso nella stampa della fattura come titolo/oggetto. Ha la priorità
sull'eventuale titolo inserito nelle impostazioni del layout fattura.

Testo iniziale
È opzionale.
Si inserisce il testo iniziale da includere nella stampa della fattura, subito dopo il
titolo/oggetto.
Il testo può essere su più righe.
Si può mettere il testo in grassetto, includendo la parte del testo tra doppi asterischi **.
Esempio: **testo1 testo2** testo3 = testo1 testo2 testo3.

Testo finale
È opzionale.
Si inseriscono le note finali da includere nella stampa della fattura, subito sotto la tabella
dei dettagli.
Il testo viene ripreso e inserito in automatico dal programma nella colonna Note della
tabella Fatture.
Il testo può essere su più righe.
Si può mettere il testo in grassetto, includendo la parte del testo tra doppi asterischi **.
Esempio: **testo1 testo2** testo3 = testo1 testo2 testo3.

http://www.banana.ch/it/advanced
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
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(2) Indirizzo cliente

Questa sezione permette di inserire l'indirizzo di fatturazione. Hai due possibilità:

Riprendi i dati dalla tabella Contatti.
Seleziona un cliente dalla lista.
Puoi anche ricercare direttamente un indirizzo digitando il nome, il cognome, la società,
l'email o numero fiscale.
Quando selezioni un contatto i vari campi dell'indirizzo vengono completati in automtico
dal programma.

Inserisci i dati manualmente.
Completa campo per campo ogni elemento dell'indirizzo.

I campi dell'indirizzo sono i seguenti:

Ditta
Si inserisce il nome della ditta.

Prefisso
Si inserisce il prefisso del cliente.

Nome
Si inserisce il nome.

Cognome
Si inserisce il cognome.

Via
Si inserisce l'indirizzo.

Extra
Eventualmente si inserisce l'indirizzo extra.

Casella postale
Si inserisce la casella postale.

Codice nazione
Si inserisce il codice della nazione.

CAP
Si inserisce il CAP.

Località
Si inserisce la località.

Email
Si inserisce l'email.

Telefono
Si inserisce il numero di telefono.

(3) Articoli / colonne articoli

È una tabella che permette di inserire le righe per gli articoli che compongono la fattura.

Nella sezione Impostazioni puoi scegliere per ogni vista:

Quali colonne rendere visibile.
L'altezza massima della tabella.
Se definisci un valore la tabella per l'inserimento degli articoli avrà una dimensione massima
(calcolata in base all'altezza di una riga di testo). Se ci sono molti articoli potrai scorrerli e
vedere sempre i bottoni in basso. 
Mentre si è sulla tabella Con la rotellina del mouse si scorre il contenuto della tabella, per fare
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scorrere la form invece bisogna usare la scroll bar verticale. 

Si tratta di una tabella con le seguenti colonne:

Riga
Il numero riga progressivo.
Tipo (Beta)
Un codice per indicare:

Intestazione
Un testo che verrà stampato in grassetto in fattura.
Totale 2
Somma tutti gli elementi contenuti.
Totale 1 
Somma tutti gli elementi e i Totali 2.
Totale
Somma tutti gli elementi e i Totali 2 e 1.
Nota
Stampa solo il testo.
 

Articolo
È opzionale.
Utilizzando la tabella Articoli è possibile selezionare dalla lista un articolo. In questo modo
i campi delle colonne successive (Descrizione, Quantità, Unità, Prezzo unità) vengono
completate in automatico dal programma.
Puoi ricercare un articolo anche digitando parte del testo descrittivo.

Data articolo
Richiede il Piano Advanced .
È opzionale.
Si inserisce una data per ogni articolo, utile per esempio per indicare la data di
esecuzione dei lavori fatturati.

Descrizione
Si inserisce la descrizione dell'articolo o dell'oggetto della fatturazione.
Il testo della descrizione può essere su più righe.
Si può mettere il testo in grassetto, includendo la parte del testo tra doppi asterischi **.
Esempio: **testo1 testo2** testo3 = testo1 testo2 testo3.

Quantità
È obbligatoria.
Si inserisce la quantità.

Unità
È opzionale.
Si inserisce il testo relativo all'unità (pz, ore, ecc).

Prezzo unità
È obbligatorio.
Si inserisce il prezzo della singola unità.

Sconto articolo
Richiede il Piano Advanced .
È opzionale.
Si indica uno sconto per ogni articolo.
Lo sconto è calcolato sul prezzo della singola unità (colonna Prezzo Unità), e può
essere indicato:

Come importo. Si inserisce direttamente l'importo dello sconto.

http://www.banana.ch/it/advanced
http://www.banana.ch/it/advanced
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Esempio: Quantità 2; Prezzo Unità 10.00; Sconto 1.00; Totale = 18.00
Se lo Sconto è uguale o maggiore del Prezzo Unità, il Totale è impostato a 0
Come percentuale. Si inserisce una percentuale (es. 10%).
Esempio: Quantità 2; Prezzo Unità 10.00; Sconto 10%; Totale = 18.00
Se lo Sconto è uguale o più grande del 100%, il Totale è impostato a 0

Totale
Il totale viene calcolato ed inserito in automatico dal programma.

IVA
È opzionale.
Si inserisce il codice IVA da utilizzare definito nella tabella Codici IVA.

(4) Sconti e totali

Questa sezione permette di inserire eventuali sconti e mostra i totali della fattura.

Il programma calcola in automatico quanto segue:

Sottototale
Viene riportata la somma di tutti gli importi della colonna Totale dei dettagli.

Sconto
È opzionale.
Si inserisce lo sconto da applicare al totale della fattura indicando descrizione e la
percentuale o l'importo.
Se si inserisce una percentuale, il programma calcola e visualizza in automatico lo sconto
in base al valore percentuale inserito.

Arrotondamento
Viene indicato l'arrotondamento.

Acconto
È opzionale.
Si inserisce l'acconto già versato dal cliente indicando la descrizione e l'importo.

Totale
Viene riportato il totale finale della fattura.
Il totale viene anche riportato in alto a destra del dialogo per velocizzare la verifica della
fattura.

IVA
Vengono riportati i totali degli importi IVA.

(5) Impostazioni

Le impostazioni del Dialogo fattura.

Per maggiori informazioni si rimanda alla pagina Impostazioni dialogo fattura.

(6) Comandi

Stampa
Comando per stampare una fattura.

Copia
Comando per copiare una fattura.

Salva
Comando per salvare le modifiche effettuate.

Chiudi
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Comando per chiudere il dialogo.
Annulla

Comando per annullare le modifiche e chiudere il dialogo senza salvare.
Aiuto

Comando che rimanda alla documentazione online dove trovare informazioni sul dialogo
fattura.

Personalizzazione
Il dialogo fattura è programmato tramite un'estensione di BananaPlus, e viene aggiornato in maniera
indipendente dall'applicazione. La versione fornita è generica e copre la maggior parte delle
necessità.

Per i contesti dove le fatture sono complesse, oppure vengono create molte fatture, è possibile
adattare il dialogo per rendere la creazione delle fatture più semplice, funzionale e rapido.

Se avete richieste particolari per un settore specifico che pensate possa interessare altri utenti,
potete contattarci tramite il nostro formulario contatto .

https://www.banana.ch/it/contact_form
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Dialogo Impostazioni fattura

Cliccando sulla sezione Impostazioni si accede al dialogo delle impostazioni della fattura.
Le impostazioni sono salvate nel file, quindi se hai più file Offerte fatture, ognuno potrà avere la
propria impostazione.

Nuovi documenti
Puoi definire alcuni parametri che verranno applicati a tutti i nuovi documenti di offerte e fatture.

Potrai comunque modificare manulamente le singole offerte e fatture.

Titolo fattura
Definisci il titolo/oggetto delle fatture.
Puoi definire una traduzione per ogni lingua.
Il valore %1 viene sostituito dal numero della fattura.

Titolo offerta
Definisci il titolo/oggetto delle offerte.
Puoi definire una traduzione per ogni lingua.
Il valore %1 viene sostituito dal numero dell'offerta.

Modalità IVA
Scegli la modalità IVA:

Senza IVA. Non viene applicata alcuna IVA.
IVA inclusa, Gli importi sono considerati al lordo.
IVA esclusa. Gli importi sono considerati al netto

Moneta
Indica la sigla della moneta  (CHF, EUR, USD, ecc.) che verrà stampata sull'offerta e sulla
fattura.
Il programma non fa cambi e conversioni in altre monete.

Decimali importi
Arrotondamento totali
Termine di pagamento fatture

Imposta la data di scadenza in giorni delle fatture.
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Validità offerte
Imposta la validità in giorni delle offerte.

Campi utente fattura
Puoi definire e aggiungere alla fattura dei campi utente dove inserire testi personalizzati.
Sulla fattura/offerta, questi campi verranno inseriti nella parte delle informazioni, di fianco all'indirizzo
di fatturazione.

Puoi aggiungere fino a un massimo di 8 campi personalizzati.
Definisci il nome/testo di ogni campo e le traduzioni nelle varie lingue.
Il valore/contenuto di ogni campo lo devi inserire nella sezione Fattura.

Interfaccia
Ti permette di cambiare i nomi delle viste Base, Corta, Lunga e di decidere quali rendere visibili e
quali nascondere nella sezione Fattura.

Viste

Puoi cambiare il nome alle viste e sceglierle se renderle visibili. 
La vista completa non è personalizzabile e visualizza sempre tutto.

Campi fattura

Per ogni vista, puoi definire quali campi rendere visibili e quali nascondere nella sezione Fattura.

Se i campi contengono dei valori saranno comunque visibili anche se sono indicati come non visibili. 

Articoli

Puoi scegliere l'altezza massima della tabella articoli.

0 verranno visualizzate tutti gli articoli che inserisci. 
1 o più la tabella Articoli avrà un'altezza fissa corrispondente al numero inserito moltiplicato per
l'altezza di una riga di testo. 
Il numero di articoli visualizzati dipenderà dall'altezza del testo descrizione che inserisci. 

Colonne Articoli

Puoi definire quale colonne nella tabella Articoli rendere visibili. 
Le colonne Descrizione, Totale e Codice IVA sono sempre visibili.

Strumenti
La parte degli strument ti permette di:

Reimpostare tutte le impostazioni con i valori predefiniti.
Cancellare le attuali impostazioni.
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Aiuto
Per maggiori informazioni e per la risoluzione di problemi, clicca su Aiuto per accedere alla pagina di
documentazione.
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Traduzione testi fattura

Nel dialogo Impostazioni cliccando su un campo di testo, per esempio il titolo per le nuove fatture o
la descrizione di uno dei campi utente, si accede al dialogo Traduzioni.

Nel dialogo Traduzioni:

È possibile inserire i testi da usare nelle varie lingue.
Vengono elencate solo le lingue attualmente in uso.
Se una lingua non è presente nell'elenco, è sufficiente aggiungere un contatto o una fattura
nella lingua desiderata.
La prima lingua elencata corrisponde alla lingua del programma.
La lingua marcata con l'asterisco * è la lingua del documento, definita dal menu File > Proprietà
file (Dati base) > sezione Varia > Lingua corrente.
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Cronologia modifiche dell'estensione offerte
e fatture

Vedi le novità ai dialoghi della release 2022-02-01.

2024-02-01
Rilasciato il 1° febbraio 2024

Generale
Nuovo: Aggiunta funzionalità di voci di sotto totale.
Nuovo: Aggiunta colonna "Termine di Pagamento in Giorni" alla tabella Contatti.
Nuovo: Aggiunto campo valuta alle tabelle Fatture e Contatti.
Risolto: Il problema dove eliminare le righe selezionate creava nuove fatture vuote nella
tabella Fatture.
Risolto: I pulsanti 'Sposta Su' e 'Sposta Giù' non funzionavano.

Dialogo Fattura
Risolto: Problema di scorrimento nel dialogo Fattura.
Risolto: Sovrapposizione di testi lunghi.
Risolto: La tabella articoli nella sezione fattura non si ridimensiona correttamente
cambiando le visualizzazioni.
Risolto: La tabella articoli nella sezione fattura non si ridimensiona correttamente su
schermi HD.
Aggiornato: Nella sezione Impostazioni del dialogo Fattura, è stata rimossa la possibilità di
regolare l'altezza degli elementi della tavola in base alle righe inserite.

2023-07-18
Generale

Risolto: l'IVA viene calcolata anche quando la modalità iva è impostata su nessuna iva
Risolto: dopo aver impostato i decimali dell'arrotondamento a 4 cifre, i totali rimangono
con 2 cifre
Risolto: la creazione di una fattura da un preventivo non aggiorna la data di scadenza
Risolto: la data di scadenza non può essere lasciata vuota
Risolto: titolo della finestra di dialogo errato per le offerte
Risolto: traduzione errata per la lingua olandese

Interfaccia
Risolto: nella finestra di dialogo della fattura il pulsante sposta articolo verso il basso non
è attivo
Risolto: nella scheda delle impostazioni gli interruttori dell'opzione non sono visibili
quando la finestra di dialogo viene ridimensionata
Risolto: spostando verso l'alto / verso il basso un elemento crea un oggetto elemento non
valido
Risolto: nella scheda delle impostazioni la barra di scorrimento verticale deve rimanere
sempre visibile
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2023-04-03
Rilasciato il 03 aprile 2023

Generale
Correzione: riga totale iva non visibile nella finestra di dialogo della fattura
Correzione: errore durante l'apertura della finestra di dialogo con qt 6.5

2022-12-14
Rilasciato il 14 dicembre 2022

Generale
Correzione: quando la finestra di dialogo della fattura viene chiusa, anche l'applicazione
viene chiusa (questo errore si verificava solo con l'ultima versione di Banana Insider)

2022-12-06
Rilasciato il 6 dicembre 2022

Inserimento dati
New: aggiunge opzione "Codice IVA predefinito", il "Codice IVA predefinito" viene ripreso
in automatico quando viene aggiunto un articolo in fattura.

2022-09-21
Rilasciato il 21 settembre 2022

Inserimento dati
Corregge il numero della fattura non viene aggiornato quando viene modificato nella
tabella delle fatture
Corregge la finestra di dialogo della fattura non si apre e viene visualizzato un errore se il
titolo per le nuove fatture è vuoto
Corregge l'inserimento di importi nel formato locale non funziona

2022-03-31
Rilasciata il 31 marzo 2022

Interfaccia
Novità: Puoi inserire e stampare i nomi delle business unit nell'indirizzo (piano Advanced)
Corregge la lingua del titolo della fattura non è quella del documento
Corregge la lingua del titolo della fattura non viene aggiornata quando si cambia la lingua
Corregge la lingua del titolo della fattura non viene aggiornato quando si cambia il cliente

2022-02-10
Rilasciata il 10 febbraio 2022

Interfaccia
Corregge la ricerca degli articolo distingue tra maiuscole e minuscole
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Corregge l'articolo evidenziato nei combobox, non corrispondeva al testo inserito
Corregge la quantità dell'articolo non può essere cancellata, l'utente non riesce quindi ad
usare un articolo come riga di descrizione (quantità e prezzo vuoti)
Corregge gli articoli senza prezzo vengono ripresi con una quantità pari a 1, l'utente non
può usare un articolo come riga di descrizione (quantità e prezzo vuoti)

2022-02-08
Rilasciata l'8 febbraio 2022

Interfaccia
Corregge il pulsante Crea fattura non crea alcuna fattura
Corregge il pulsante Copia fattura non crea alcuna fattura

2022-02-07
Rilasciata il 7 febbraio 2022

Interfaccia
Corregge il pulsante Salva fattura in casi particolari non salva la fattura
Corregge i campi di test non scorrono automaticamente, e il testo inserito oltre la
larghezza del campo no è visibile.

2022-02-01
Rilasciata il 1º febbraio 2022

Inserimento dati
Nuovo: Puoi inserire uno sconto per ogni articolo, sia come percentuale che come
importo (piano Advanced).
Nuovo: Puoi inserire una data per ogni articolo (piano Advanced).
Nuovo: Puoi inserire campi personalizzati nella sezione informazioni delle fatture (piano
Advanced).
Nuovo: Puoi inserire il prezzo unitario e la quantità con quattro o più decimali.
Nuovo: Puoi inserire la descrizioni degli articoli su più righe o con testi in grassetto.
Nuovo:  Puoi inserire il testo iniziale e finale della fattura su più righe o con testi in
grassetto.
Nuovo:  Puoi inserire un acconto già versato dall'utente.
Nuovo: Sono stati aggiunti i campi Cortesia, Indirizzo extra e Casella postale all'indirizzo
del cliente.
Nuovo: Puoi ricercare un indirizzo inserendo nome, cognome, società, email o numero
fiscale.
Nuovo: Puoi ricercare un articolo inserendo semplicemente parte del testo descrittivo.

Interfaccia
Nuovo: Sono state aggiunge le viste, così da adattare la visualizzazione e l'inserimento
dei dati in base alle tue necessità e al contesto.
Nuovo: È stata aggiunta una sezione Impostazioni per facilitare l'inserimento e la verifica
delle varie opzioni.
Nuovo: Puoi tramite le viste e le impostazioni selezionare quali campi visualizzare e quali
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campi nascondere.
È stato aggiunto il totale fattura in alto a destra per velocizzare la verifica della fattura.
È stato aggiunto il totale iva 0% nella ricapitolazione iva.
L'ultima dimensione e posizione del dialogo vengono memorizzate e riprese alla
successiva apertura del dialogo.
La larghezza delle colonne viene memorizzata e ripresa alla successiva apertura del
dialogo.
È stato aggiunto un bottone help a tutti i dialoghi.

Generale
Viene visualizzata una notifica quando una versione aggiornata dell'estensione è stata
installata.
È stato migliorato il supporto per la visualizzazione in dark mode (alto contrasto).
È stata migliorata la visualizzazione su schermi ad alta risoluzione.
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Novità release 2022-02-01

La release del 1° febbraio 2022 aggiunge nuove e importanti funzioni all'applicativo che vengono qui
di seguito elencate.

La sezione di modifica della Fattura

(1) Sezione Impostazioni

La nuova sezione Impostazioni ti permette di inserire i parametri per le nuove offerte e fatture e di
selezionare quali campi sono visibili nella sezione Fattura.

(2) Viste

Nuova possibilità di cambiare tra diverse viste della fattura, da una più generica ad una più
dettagliata.

(3) Cortesia, Indirizzo extra e Casella postale

I nuovi campi Cortesia, Indirizzo extra e Casella postale sono stati aggiunti all'indirizzo del cliente.

(4) Campi utente (piano Advanced)

Puoi definire e aggiungere alla fattura dei campi utente dove inserire testi personalizzati.

(5) Data articolo (piano Advanced)

Puoi inserire una data per ogni articolo, utile per esempio se vuoi indicare la data dei lavori fatturati
sono stati eseguiti.
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(6) Sconto articolo (piano Advanced)

Puoi indicare uno sconto per ogni articolo, sia come importo che come percentuale.

(7) Testi su più righe e in grassetto

Puoi inserire descrizioni degli articoli su più righe o con testi in grassetto.
I testi su più righe e in grassetto sono possibile anche nei campi Testo iniziale e Testo finale della
fattura

(8) Prezzo unitario e Quantità con 4 o più decimali

Puoi inserire prezzi unitari e quantià con 4 o più decimali.

(9) Acconto

Puoi inserire un acconto già versato dal cliente.

Sezione Impostazioni
La sezione impostazioni permette di personalizzare:

Alcuni elementi usati per la creazione di nuove fatture.
La disposizione degli elementi nel dialogo fatture.

(1) Titolo per nuove offerte e fatture

Puoi definire il titolo per le nuove offerte e fatture.

(2) Gestisci viste

Puoi selezionare quali viste attivare e cambiarne il nome.
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(3) Campi visibili

Puoi selezionare quali campi rendere visibili nella sezione Fattura.
L'opzione Campi non vuoti mostra i campi che contengono dati.
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Dialogo Offerte e Fatture Release Beta

La release beta dell'estensione Offerte e Fatture aggiunge nuove e importanti funzioni all'applicativo.
Tutti i più importanti sviluppi sono stati fatti e invitiamo tutti a testarla e darci dei feedback.

Come installarla
Guarda il video tutorial  che mostra come provare la nuovissima versione Beta dell'estensione
Offerte e Fatture.

Scarica e installa l'ultima versione di Banana Contabilità+ 10.1.8 o più recente
Apri il menu Estensioni > Gestisci estensioni....
Seleziona l'estensione Estimates and Invoices Dialog Extension (Offerte e Fatture)
Seleziona nella parte destra del dialogo come Canale preferito Release Beta (al posto di
Release Stabile)

Puoi cambiare il canale della versione Beta a quella Stabile in qualsiasi momento senza perdita di
dati.

Requisiti di sistema:

Banana Contabilità+ 10.1.8 o più recente
[CH10] Layout con QR Code Svizzero con data di pubblicazione del 2023-06-19 o più recente

Novità della versione Beta
Rilasciata il 06 Maggio 2024

Risolto: Problema con i decimali nella colonna quantità:
Adesso è possibile definire un importo di quantità senza i decimali
Risolve un problema durante l'inserimento di una quantità con solo una cifra nelle righe
laddove vi fossero già inseriti una descrizione o una data.

Risolto: Problema di selezione degli articoli (con mouse) dal combo box.
Risolto: Warning del programma all'apertura del dialogo.

Rilasciata il 1° febbraio 2024

Totali e sottototali di articoli (Piano Advanced)

Rilasciata il 16 gennaio 2024

Risolto: Problema di scorrimento nel dialogo Fattura.
Risolto: Sovrapposizione di testi lunghi.
Risolto: La tabella articoli nella sezione fattura non si ridimensiona correttamente cambiando le
visualizzazioni.
Risolto: La tabella articoli nella sezione fattura non si ridimensiona correttamente su schermi
HD.
Aggiornato: Nella sezione Impostazioni del dialogo Fattura, è stata rimossa la possibilità di
regolare l'altezza degli elementi della tavola in base alle righe inserite.

https://www.banana.ch/it/node/11430
https://www.banana.ch/it/download
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  Subtotali di articoli

I subtotali permettono di aggiungere in fattura dei totali parziali. Per esempio è possibile inserire un
totale parziale coi costi di manodopera, ed un totale parziale coi costi di materiale.

Per aggiungere un sottototale:

Vai nella scheda Impostazioni > sezione Colonne articoli e attiva la colonna Tipo
Vai nella scheda Fattura...

aggiungi un nuova riga
seleziona come tipo (colonna Tipo) "Totale", "Totale 1" o "Totale 2"
inserisci la descrizione desiderata.

Esempi:

Subtotali nel dialogo Fattura

Subtotali nella fattura



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 965

Prossime nuove funzionalità
Aggiungere lo stato della fattura (bozza, inviato, richiamo 1, pagato, ...)

Funzionalità integrate nella versione standard
Possibilità di stampare richiami (Advanced plan)
Possibilità di stampare bollettini di consegna (Advanced plan)
Possibilità di stampare più fatture in file pdf separati

Estensione dialogo
Il dialogo di inserimento dei dati fattura è implementato tramite l'Estensione Dialogo Offerta e Fatture

.

L'estensione viene installata in automatico quando si apre un file delle offerte e fatture.
L'estensione viene aggiornata in automatico quando viene rilasciata una nuova versione
dell'estensione.
Il dialogo può quindi cambiare anche se non è stato aggiornato il programma Banana
Contabilità.
Per provare usare una versione di sviluppo dell'estensione, vedi Gestione Estensione: Usare una
versione di sviluppo.

Se hai il piano Advanced, puoi modificare il codice sorgente e caricare il tuo codice modificato on
your instance su Banana Contabilità+.

https://www.banana.ch/apps/it/node/9411
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Feedback
Apprezziamo molto ogni feedback su questa nuova release.
Puoi mandarci il tuo feedback tramite il formulario di contatto : ti chiediamo di inserisci anche una
breve descrizione del contesto nel quale stai usando l'estensione.

https://www.banana.ch/it/contact_form?obj=feedback
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Gestire offerte

Con l'applicativo Offerte e Fatture si possono gestire le offerte.

La creazione, la modifica, la duplicazione e la stampa delle offerte sono gestite esattamente
come per le fatture.

Dalla tabella Offerte:

Crea una nuova offerta con il comando menu Fatture → Nuova offerta.
Modifica un'offerta con il comando menu Fatture → Modifica offerta.
Duplica un'offerta con il comando menu Fatture → Duplica offerta.
Stampa un'offerta con il comando menu Fatture → Stampa offerta.
Converti un'offerta in fattura:

Con il comando menu Fatture → Crea fattura come da offerta.
Oppure tramite il bottone Crea fattura dal dialogo di creazione/modifica offerta (menu
Fatture → Modifica offerta).

Il dialogo di creazione e modifica di un'offerta è lo stesso di quello della fattura. Per maggiori
informazioni visitare Dialogo fattura.
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Come fare per la stampa della fattura

La stampa della fattura può essere personalizzata e adattata alle specifiche esigenze.

Impostare l'indirizzo della tua ditta (mittente)
Nel menu File → Proprietà file (Dati base) → Indirizzo, imposta l'indirizzo della tua società.

Impostare la lingua dei clienti
Puoi stampare le fatture nella lingua dei clienti. Per ogni cliente imposta la lingua nella tabella
Contatti. Puoi anche cambiarla dal dialogo Modifica fattura.

Riprendere gli indirizzi dei clienti da Excel
Quando i dati dei clienti si trovano su un file Excel, questi possono essere riportati facilmente nella
tabella Contatti.

Procedi nel seguente modo:

Seleziona da Excel la colonna con i dati da copiare e usa il comando Copia (Ctrl+C).
Vai in Banana, tabella Contatti, posizionati nella colonna corrispondente e impartisci il
comando Incolla (Ctrl+V o Incolla dal menu Modifica).
Ripeti questa operazione per tutte le colonne dell'indirizzo (Conto, Nome, Cognome,
Organizzazione, Via, Cap, Località, Codice nazione, Lingua).
I dati corrispondenti alle colonne menzionate sono necessarie per la stampa della fattura.
Se nel file Excel non hai tutte le colonne menzionate, devi aggiugere le informazioni mancanti
manualmente.

Impostare posizione logo e indirizzo mittente
Per impostare il logo bisogna:

Caricare l'immagine del logo nel menu File → Imposta logo .
Per utilizzare il logo nella fattura, nelle Impostazioni della fattura  devi attivare la casella Logo
e inserire il nome della personalizzazione che hai utilizzato, rispettando maiuscole e minuscole,
nel campo Nome Logo.

Puoi ad esempio posizionare il logo sulla sinistra e l'indirizzo sulla destra e cambiare le dimensioni del
logo.

L'indirizzo viene ripreso in automatico dai dati base del file.

L'indirizzo del mittente, se non vengono modificate le impostazioni predefinite, viene inserito a destra,
indipendentemente dalla presenza del logo.

Se desideri impostare l'indirizzo del mittente a sinistra senza alcuno logo, consultare la pagina
seguente:

Fattura senza logo e indirizzo intestazione a sinistra .

https://www.banana.ch/doc10/it/node/9182
https://www.banana.ch/apps/it/node/9365#intestazione
https://www.banana.ch/apps/it/node/9398#left_company_address
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Se vuoi inserire un indirizzo diverso, tramite le Impostazioni della fattura :

Inserisci i testi che vuoi utilizzando i campi Testo riga 1, Testo riga 2, Testo riga 3, Testo
riga 4 e Testo riga 5.

Impostare il logo senza l'indirizzo del mittente
Nella pagina Imposta logo trovi le informazioni di come aggiungere e posizionare il logo.

Tramite le Impostazioni della fattura :

Togli la spunta alla voce Intestazione pagina per escludere dalla stampa l'indirizzo
nell'intestazione.
Vista la voce Logo per includere il logo nella stampa.

Personalizzare indirizzo nell'intestazione fattura
Lo stile dell'indirizzo del mittente nell'intestazione della fattura (colore, dimensione, carattere..) viene
impostato predefinito dal programma.

Il Piano Advanced di Banana Contabilità Plus  consente di personalizzare lo stile dell'indirizzo. Per
maggiori informazioni consultare la pagina Esempi (solo in lingua inglese) .

Impostare le informazioni fattura
Le informazioni fattura sono informazioni relative alla data, numero cliente, data scadenza, ecc. che si
trovano di regola subito sotto l'intestazione e difianco all'indirizzo del cliente.
I layout CH10  e UNI11  permettono di definire quali informazioni della fattura includere e quali
invece escludere dalla stampa. Nella pagina Impostazioni fattura  trovi le indicazioni.

Per gli altri layout di stampa (CH01-CH09 / UNI01-UNI08), le informazioni non sono modificabili.

Inserire un nuovo campo informazioni fattura
Oltre ai campi predefiniti per le informazioni (numero fattura, data, numero cliente, ecc.), puoi
inserire anche altri campi personalizzati.

Nella sezione Fattura del Dialogo fattura:

Vai alla vista Completa (in alto).
Utilizza i campi Info. aggiuntive 1 ... Info. aggiuntive 8 per aggiungere i tuoi campi di
informazioni aggiuntive.
Nella sezione Informazioni delle impostazioni layout fattura , vista il campo Campi
personalizzati.
I nuovi campi informazioni aggiuntive vengono aggiunti alla fine. Non è possibile cambiare
l'ordine.

Nella sezione Impostazioni del Dialogo fattura:

Modifica i testi dei Campi utente fattura come vuoi.
Puoi inserire le traduzioni per ogni lingua.

https://www.banana.ch/apps/it/node/9365#intestazione
https://www.banana.ch/apps/it/node/9365#intestazione
https://www.banana.ch/it/advanced
https://www.banana.ch/apps/en/node/9417
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#informazioni
https://www.banana.ch/apps/it/node/9365#informazioni
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Impostare il termine di pagamento
Il termine di pagamento delle fatture come impostazione predefinita è di 30 giorni.

Per cambiare il termine di pagamento hai due possibilità:

Cambiare l'impostazione base per tutte le nuove fatture.
Andare nella sezione Impostazioni del Dialogo fattura.
Nella sezione Nuovi documenti → Termine pagamento fatture (giorni) impostare il
valore che si desidera (es. 10).
La data di scadenza della fattura verrà ricalcolata con il nuovo termine di pagamento.

Cambiare il termine di pagamento singolarmente per ogni fattura.
Andare nel Dialogo fattura.
Nel campo Termine di pagamento inserire una data di scadenza (es. 31.12.2022).
La data di scadenza della fattura verrà sostituita con il nuovo termine di pagamento.

Impostare posizione e composizione indirizzo cliente
I layout CH10  e UNI11 permettono di definire:

La posizione dell'indirizzo del cliente.
La  composizione degli elementi dell'indirizzo.

Nella pagina Impostazioni fattura → sezione Indirizzo cliente:

Nel campo Composizione indirizzo:
Scegli come comporre l'indirizzo inserendo i nomi XML delle colonne della tabella
Contatti.
Puoi utilizzare solo le seguenti colonne (nomi XML sempre in inglese):
NamePrefix, OrganisationName, FirstName, FamilyName, Street, AddressExtra,
POBox, PostalCode, Locality, Region, Country, CountryCode.

Cambia la posizione dell'indirizzo utilizzando le opzioni Sposta orizzontalmente e Sposta
verticalmente.

Per gli altri layout di stampa (CH01-CH09 / UNI01-UNI08), la posizione e la composizione dell'indirizzo
del cliente non sono modificabili.

Se hai bisogno di più righe per stampare l'indirizzo del tuo cliente, guarda il paragrafo Stampare
l'indirizzo cliente/ditta su quattro righe

Impostare titolo/oggetto
Per inserire il titolo/oggetto della fattura, hai due possibilità:

Inserire il testo nel Dialogo fattura → campo Oggetto.
Per ogni fattura si definisce un titolo.
Se si lascia il campo vuoto, viene utilizzato il testo predefinito.
Questo titolo ha sempre la priorità rispetto all'inserimento del titolo nelle impostazioni dei
layout (vedi prossimo punto).

Con i layout CH10  e UNI11,  si può inserire il testo nelle Impostazioni fattura → sezione
Testi → Titolo fattura.

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#indirizzo_cliente
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365
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Il titolo si applica a tutte le fatture stampate con il layout in questione.
ll titolo si applica solo se non è stato definito alcun titolo come da primo punto.

Impostare testo iniziale
Per inserire il testo iniziale della fattura, hai due possibilità:

Inserire il testo nel Dialogo fattura → campo Testo iniziale.
Per ogni fattura si definisce un testo iniziale.
Questo testo ha sempre la priorità rispetto all'inserimento del testo iniziale tramite le
impostazioni dei layout (vedi prossimo punto).

Con i layout CH10  e UNI11, inserire il testo nelle Impostazioni fattura → sezione Testi →
campo Testo iniziale.

Il testo si applica a tutte le fatture stampate con il layout in questione.
Questo testo si applica solo se non è stato definito alcun testo iniziale come da primo
punto.

Impostare la tabella dettagli fattura
La tabella dettagli fattura è la tabella centrale della fattura in cui appaiono gli articoli/servizi fatturati,
con le quantità, prezzi unitari, totali, ecc.
Utilizza il Dialogo fattura per inserire gli articoli o altri elementi da fatturare.

Vedi anche le pagine:

Dettagli fattura
Sconti e totali
Impostazioni avanzate

Impostare colonne articoli fattura
Con i layout CH10  e UNI11  decidi quali colonne visualizzare nella stampa. Vedi come fare nella
pagina Impostazioni fattura → Dettagli fattura .

Per gli altri layout di stampa (CH01-CH09 / UNI01-UNI08), le colonne non sono modificabili.

Impostare testi finali
Per inserire il testo finale della fattura, hai diverse possibilità:

Inserire il testo nel Dialogo fattura → campo Testo finale.1.
Viene applicato a qualsiasi layout di stampa.
Il testo viene inserito subito sotto i dettagli della fattura.

Inserire il testo nel Dialogo Stampa fatture → sezione Opzioni → Testo finale.2.
Viene applicato a qualsiasi layout di stampa.
Se hai già inserito un testo come da punto 1, il nuovo testo viene aggiunto subito dopo al
precedente.

Inserire il testo nelle Impostazioni fattura  → sezione Testi→ campo Testo finale.3.
Questo testo ha la priorità sul testo inserito come da punto 2.
Se hai già inserito un testo come da punto 1, il nuovo testo viene aggiunto subito dopo al
precedente.

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365#dettagli_fattura
https://www.banana.ch/apps/it/node/9365
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Impostare numero di conto bancario
Se non utilizzi il QR-Code, devi inserire il numero del conto bancario come riferimento per il
pagamento della fattura.

Hai tre modalità per inserire il numero di conto bancario come testo finale:

Dialogo fattura → campo Testo finale.1.
Il numero di conto bancario figura nella stampa solo della fattura che si sta
creando/modificando.
Viene applicato a qualsiasi layout di stampa.
Il testo viene inserito subito sotto i dettagli della fattura.

Dialogo Stampa fatture → Opzioni → Testo finale.2.
In questo caso il conto bancario viene inserito in tutte le fatture che crei.
Viene applicato a qualsiasi layout di stampa.
Se hai già inserito un testo come da punto 1, in questo caso il nuovo testo viene aggiunto
subito dopo al precedente.

Impostazioni fattura  → Testi → Testo finale.3.
In questo caso il conto bancario viene inserito in tutte le fatture che crei utilizzando
questo layout.
Questo testo ha la priorità sul testo inserito come da punto 2.
Se hai già inserito un testo come da punto 1, il nuovo testo viene aggiunto subito dopo al
precedente.

Impostare IBAN per la stampa QR-Code Svizzero
Se desideri creare fatture QR con conto IBAN, devi:

Impostare il conto IBAN
Impostare la stampa del QR-Code Svizzero

Nella pagina QR-Fattura con conto IBAN  trovi maggiori informazioni per le impostazioni delle fatture
QR con conto IBAN.

Impostare QR-IBAN per la stampa QR-Code Svizzero
Se desideri creare fatture QR con conto QR-IBAN, devi:

Impostare il conto QR-IBAN
Impostare la stampa del QR-Code Svizzero

Nella pagina QR-Fattura con QR-IBAN  trovi maggiori informazioni per le impostazioni delle fatture
QR con conto QR-IBAN.

Stampare la fattura con bollettino QR senza importo e
indirizzo
Se desideri stampare una fattura senza indicare l'importo e l'indirizzo sul bollettino QR, trovi maggiori
informazioni alla pagina Personalizzazione QR-Code , paragrafo Includi/escludi dalla stampa.

https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/apps/it/node/9381#inserimento_numero_conto_iban
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9381
https://www.banana.ch/apps/it/node/9387#inserimento_numero_conto_qriban
https://www.banana.ch/apps/it/node/9388
https://www.banana.ch/apps/it/node/9387
https://www.banana.ch/apps/it/node/9388
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Stampare bollettino QR senza importo e indirizzo
Se desideri stampare solo il bollettino QR senza importo e senza indirizzo del cliente, devi:

Utilizzare l'estensione QR-Fattura senza importo e indirizzo .
Impostare la moneta, l'indirizzo e il conto IBAN .
Creare il bollettino con codice QR .

Vedi anche come stampare una Fattura senza importo .

Impostare stili e colori
Nella pagina Impostazioni fattura  trovi le indicazioni per definire:

Tipo e dimensione del carattere
Colori

Impostare dei testi in grassetto
Nella pagina Impostazioni fattura  trovi le indicazioni per applicare il grassetto  ai testi della
fattura.

Inserire immagini nelle Offerte o Fatture
È ora possibile aggiungere delle immagini nelle offerte e nelle fatture da inviare ai clienti.
Questa opzione è disponibile unicamente con il Piano Advanced di Banana Contabilità Plus

.
Questa funzionalità rende la fattura ancora più personalizzabile e il cliente che la riceve ha una
visione più completa e diretta sulla fatturazione degli articoli.

Consulta le nostre pagine informative sull'inserimento delle immagini:

Customize invoice print with Javascript  (inglese)
Offerte e Fatture con foto prodotti

 Stampare l'indirizzo cliente/ditta su quattro righe
Quando il destinatario è una ditta con diversi settori/dipartimenti o un cliente che vive in un
complesso abitativo con interni, può rendersi necessario avere a disposizione più righe per la stampa
dell'indirizzo.
Questa opzione è disponibile unicamente con il Piano Advanced di Banana Contabilità Plus

.

Per attivare la possibilità di stampa dell'indirizzo del destinatario su più righe procedi come segue:

Aggiorna le estensioni dal menu Estensioni → Gestisci estensioni → Aggiorna estensioni.
Apri la fattura in modifica e nella scheda Impostazioni → sezione Indirizzo, rendi visibili i campi
Settore 1 .. 4 per la vista Base.

https://www.banana.ch/apps/it/node/9401
https://www.banana.ch/apps/it/node/9401#impostazione_moneta_indirizzo_e_iban
https://www.banana.ch/apps/it/node/9401#crea_il_bollettino_con_codice_qr
https://www.banana.ch/apps/it/node/9398#fattura_senza_importo
https://www.banana.ch/apps/it/node/9365#stili
https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/apps/it/node/9365#bold_text
http://www.banana.ch/it/advanced
https://www.banana.ch/apps/en/node/9396#print_images_of_items
https://www.banana.ch/apps/en/node/9396#print_images_of_items
https://www.banana.ch/it/node/11439
http://www.banana.ch/it/advanced
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Eventualmente passa dalla vista Base alla vista Completa senza dover rendere visibili i campi
(nella vista Completa sono visibili tutti i campi).
Nell'indirizzo della fattura inserisci un testo nei campi settore.

 
Nelle impostazioni del layout di stampa  aggiungi i campi Settore alla composizione
dell'indirizzo cliente.
Il contenuto sarà come segue:
<OrganisationName>
<OrganisationUnit>
<OrganisationUnit2>
<OrganisationUnit3>
<OrganisationUnit4>
<NamePrefix>
<FirstName> <FamilyName>
<Street> <AddressExtra>
<POBox>
<PostalCode> <Locality>

http://www.banana.ch/apps/it/node/9365
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Se vuoi riprendere questi campi in automatico dalla tabella Contatti, aggiungi le colonne
OrganisationUnit2, OrganisationUnit3 e OrganisationUnit4 alla tabella Contatti.

Altre risorse
Personalizzazione della stampa della fattura

https://www.banana.ch/apps/it/node/9514
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Stampa Offerte e Fatture

Con l'applicativo Offerte e Fatture, incluso in Banana Contabilità Plus , la stampa delle fatture è
altamente personalizzabile e adattabile a tutte le esigenze.

Comando Stampa Offerte/Fatture
La stampa della fattura avviene dal menu Fatture > Stampa Fattura.

Questo comando crea l'anteprima di stampa della fattura . Direttamente dall'anteprima, cliccando
sul simbolo delle impostazioni (rotellina dentata) che si trova nella barra degli strumenti, accedi alla
seguente finestra di dialogo:

Dialogo Stampa Fatture. Da questa finestra di dialogo puoi fare diverse operazioni:
Impostare il layout da usare per la stampa della fattura.
Accedere alle impostazioni del layout per personalizzare la stampa.
Modificare le impostazioni di stampa.
Esportare la fattura in PDF o altri formati.

Con il piano Advanced di Banana Contabilità Plus  è anche possibile mandare in
stampa diverse fatture allo stesso tempo e ottenere PDF singoli per ognuna di
esse! Per maggiori informazioni visita la pagina Viene visualizzato un PDF con l'elenco dei
dati contenuti nelle varie colonne della tabella prescelta.

https://www.banana.ch/it/download
http://www.banana.ch/doc/it/node/3332
#4824
https://www.banana.ch/it/buy
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Dialogo Stampa Fatture

 Si accede al dialogo di stampa della fattura dall'Anteprima di stampa , cliccando su Impostazioni
(simbolo rotellina dentata).

Per accedere all'anteprima di stampa, hai tre possibilità:

Dal menu Fatture > Stampa fattura.
Dal bottone Stampa del dialogo della creazione/modifica di una fattura.
Dalla tabella Fatture, cliccando sulla piccola icona Stampa fattura in alto nella cella della
colonna Id (numero fattura).

Il programma visualizza direttamente un'anteprima della fattura, utilizzando il layout predefinito
[CH10] Layout Fattura con codice QR Svizzera .

Con il piano Advanced di Banana Contabilità Plus  è anche possibile mandare in
stampa diverse fatture allo stesso tempo e ottenere PDF singoli per ognuna di
esse! Per maggiori informazioni visita la pagina Stampa fatture o estratti clienti in PDF
separati.

Una volta scelte le opzioni di stampa, con il bottone OK, la fattura viene visualizzata in anteprima e
può essere stampata.

Sezione Stampa
Layout

L'opzione permette di cambiare il layout della fattura. Sono a disposizione una serie di layout
predefiniti .

http://www.banana.ch/doc/it/node/3332
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/it/buy
http://www.banana.ch/apps/it/node/9034
http://www.banana.ch/apps/it/node/9034
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Preferenze del layout

Requisiti per poter utilizzare le preferenze del layout:

Banana Contabilità+  (versione 10.1.7 o successive).
Il piano Advanced

L'opzione permette di impostare le preferenze offerte dal layout selezionato.
Se viene selezionato un layout che non prevede nessuna preferenza, questa sezione non viene
visualizzata nel dialogo.

Stampa come
Puoi selezionare la tipologia di documento che desideri stampare, le scelte sono:

Automatico: stampa il documento in formato fattura.
Bollettino di consegna con importi: stampa il documento come bollettino di consegna.
Bollettino di consegna senza importi: stampa il documento come bollettino di
consegna, senza mostrare gli importi ed il totale.
Offerta: stampa il documento come offerta.
Fattura Proforma: stampa documento come fattura proforma.
Fattura: Stampa il documento in formato fattura:
1. richiamo: Stampa il documento come primo richiamo.
2. richiamo: Stampa il documento come secondo richiamo
3. richiamo: Stampa il documento come terzo richiamo

Il tipo di documento scelto non viene salvato per la volta successiva, viene invece impostato
nuovamente su "automatico".

Le preferenze del layout sono offerte dai seguenti layout:

[CH10] Layout con codice QR svizzero
[UNI11] Layout 11 Fattura Programmabile 

Altri layouts

Questo bottone rimanda alla finestra di dialogo Gestione Estensioni, dove è possibile installare nuovi
layout, aggiornare quelli già in uso con le versioni più recenti, oppure aggiungere i propri layout
personalizzati.

Impostazioni

Permette di accedere al dialogo delle impostazioni del layout selezionato, dove è possibile
personalizzare la stampa della fattura. Ogni layout ha le proprie impostazioni personalizzabili.

Per maggiori informazioni sulla personalizzazione del layout CH10 consulta la pagina Impostazioni
fattura .

Sezione Opzioni
In questa sezione si possono aggiungere dei testi specifici per ogni lingua, per esempio, per
indicare dei saluti finali o le coordinate bancarie per il pagamento. A seconda della lingua del cliente,
il programma visualizzerà a fine fattura i testi salvati per la lingua indicata.

https://www.banana.ch/it/download
https://www.banana.ch/it/update
https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/apps/it/node/9365
https://www.banana.ch/apps/it/node/9365
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Si può inserire unicamente un solo tipo di testo, uno per ogni lingua.

I testi inseriti in questa sezione vengono ripresi nella stampa di tutte le fatture, con qualsiasi layout di
stampa si utilizzi.

Per inserire un testo finale:

Menu Fatture → Stampa fatture.
Dalla barra degli strumenti, cliccare sull'icona Impostazioni (simbolo rotellina dentata) >
sezione Opzioni, inserire il testo desiderato.
Confermare con OK.

Il testo inserito apparirà nell'anteprima di stampa della fattura.

Salvare fattura in PDF
Le fatture si possono salvare anche in formato PDF, per essere comodamente inviate via email:

dalla visualizzazione dell'anteprima di stampa Fatture → Stampa fattura → Ok
dalla barra degli strumenti, vai su Crea Pdf.

Stampare la fattura
Una volta visualizzata l'anteprima di stampa, per stampare la fattura:

vai sull'icona Stampa nella barra degli strumenti (in alto).
oppure, salva il pdf e stampalo.
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Stampa Richiami

Banana Contabilità Plus, con i layout CH10  e UNI11 , permette di stampare anche i richiami.

Requisiti per poter utilizzare le preferenze del layout:

Banana Contabilità+  (versione 10.1.7 o successive).
Il piano Advanced

Sulla base dei dati delle fatture, inseriti nella tabella Fatture, si possono stampare i richiami.

Come stampare il richiamo
Nella tabella Fatture seleziona la riga dove si trova la fattura per la quale devi stampare il richiamo e
procedi come segue:

Menu Report > Stampa fatture
Seleziona il Layout CH10 o UNI11
All'opzione Stampa come, seleziona una delle seguenti opzioni:

1. richiamo
2. richiamo
3. richiamo

Conferma con OK

Personalizzazione della stampa
Tutte le impostazioni che caratterizzano il Layout CH10 e UNI11 vengono mantenute anche nella
stampa dei richiami.

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/it/download
https://www.banana.ch/it/update
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Per modificare le impostazioni, vai nelle Impostazioni del Layout di stampa .

Nella sezione Testi → Richiamo  puoi definire i testi iniziali e finali nel richiamo.

Esempio di stampa:

https://www.banana.ch/apps/it/node/9365
http://www.banana.ch/apps/it/node/9365#deliverynote_reminder_texts
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Stampa bollettino di consegna

Banana Contabilità Plus, con i layout CH10  e UNI11 , permette di stampare anche i bollettini di
consegna.

Requisiti per poter utilizzare le preferenze del layout:

Banana Contabilità+  (versione 10.1.7 o successive).
Il piano Advanced

I dati dei bollettini di consegna vengono inseriti nella tabella Fatture, come avviene per le fatture.

Se i dati della fattura coincidono con quelli del bollettino di consegna, gli stessi dati potranno essere
usati sia per la stampa del bollettino di consegna sia per la fattura.

Come stampare un Bollettino di consegna
Nella tabella Fatture seleziona la riga dove si trova il bollettino di consegna e procedere come segue:

Dal menu Fatture > Stampa fatture
Seleziona il Layout CH10 o UNI11
All'opzione Stampa come, seleziona:

Bollettino di consegna con importi
In questo caso vengono inclusi nel bollettino importi nei dettagli e importo totale.
Bollettino di consegna senza importi
Nel bollettino vengono visualizzati solo i dettagli relativi alla merce spedita, senza alcun
importo.

Conferma con OK.

Personalizzazione della stampa
Tutte le impostazioni che caratterizzano il Layout CH10 e UNI11 vengono mantenute anche nella
stampa del bollettino di consegna.

Per modificare le impostazioni, vai nelle Impostazioni del Layout di stampa .

Nella sezione Testi → Bollettino di consegna puoi definire i testi iniziali e finali nel bollettino di
consegna.

Esempio di stampa:

https://www.banana.ch/apps/it/node/9338
https://www.banana.ch/apps/it/node/9423
https://www.banana.ch/it/download
https://www.banana.ch/it/update
https://www.banana.ch/apps/it/node/9365
http://www.banana.ch/apps/it/node/9365#deliverynote_reminder_texts
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Archiviare le fatture

Con l'applicativo Offerte e Fatture puoi archiviare le tue fatture in qualsiasi momento dell'anno. Il file
dove vengono inseriti i dati delle fatture rimane sempre lo stesso nel corso degli anni.

Archiviare le fatture singolarmente
Per archiviare una o più fatture singolarmente, procedi come segue:

Dalla tabella Fatture vai sulla vista Archivio.
Nella colonna Data Archivio, inserisci la data di quando desideri archiviare la fattura.
Archivia la fattura con il comando dal menu Fatture > Archivia dati > Archivia dati tabella.

Archiviare le fatture dell'anno
Per archiviare le fatture dell'intero anno, procedi come segue:

Dalla tabella Fatture vai sulla vista Archivio.
Nella colonna Data Archivio, inserisci nella prima riga la data del 31.12 e copia e incolla su
tutte le righe.
Archivia le fatture con il comando dal menu Fatture > Archivia dati > Archivia dati tabella.

Archivio fatture
Nell'archivio fatture si trovano tutte le fatture archiviate.

Le fatture archiviate vengono visualizzate nella tabella Archivio (Fatture) e rimosse dalla tabella
Fatture.

La tabella Archivio (Fatture):

Viene visualizzata in automatico quando si archiviano fatture.
Se si chiude la tabella, per visualizzarla utilizza il comando dal menu Fatture > Archivia dati
> Visualizza dati archiviati.

Archiviare i dati delle tabelle
La funzione è disponibile con Banana Contabilità+ Dev Channel .

Si possono archiviare i dati delle seguenti tabelle:

Contatti
Articoli
Fatture
Offerte

Per archiviare i dati delle tabelle:

Posizionarsi nella tabella dove ci sono i dati da archiviare.
Attivare la colonna Data Archivio.

https://www.banana.ch/it/insiderprogram
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Nella colonna Data Archivio inserire la data di quando si desidera archiviare.
Dal menu Fatture > Archivia dati > Archivia dati tabella, scegliere la tabella con i dati da
archiviare.

Il programma crea la tabella Archivio dove sono memorizzati tutti i dati archiviati (Contatti, Articoli,
Fatture o Offerte).

Visualizzare i dati archiviati
La funzione è disponibile con Banana Contabilità+ Dev Channel .

I dati archiviati vengono salvati in modo permanente nella tabella Archivio.

Per visualizzare le tabelle con i dati archiviati:

Dal menu Fatture > Archivia dati > Visualizza dati archiviati
Scegliere la tabella con i dati archiviati da visualizzare

Il programma mostra la tabella Archivio dove sono memorizzati tutti i dati archiviati (Contatti, Articoli,
Fatture o Offerte).

https://www.banana.ch/it/insiderprogram
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Nuovo anno

Nell'applicativo Offerte e Fatture è possibile avere in un unico file tutte le fatture che vengono create
da un anno all'altro, senza dover creare per il nuovo anno un nuovo file.

Se tuttavia si desidera avere le fatture separate da un anno all'altro o non visualizzare le fatture
dell'anno precedente, ci sono due possibili soluzioni:

1.  Archiviare le fatture registrate per svuotare la tabella Fatture

Dal menu Fatture, scegliere l'opzione Archivia dati → Archivia dati da tabella. Maggiori
informazioni si trovano nella pagina Archiviare le fatture.
Le fatture archiviate vengono visualizzate nella tabella Archivio (Fatture) e rimosse dalla tabella
Fatture.

2.  Creare un nuovo file facendo una copia dell'anno precedente

Partire dal file corrente e dal menu File cliccare sul comando Salva con nome, dando come
nome il nuovo anno.
Si può creare una copia del file anche dal menu Strumenti → comando Copia file.
Nella tabella Fatture eliminare tutte le righe dove figurano le fatture dell'anno precedente

Per l'applicativo Offerte e Fatture, sulla tematica Creare nuovo anno, in futuro saranno possibili dei
nuovi sviluppi.
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Importazione ed Esportazione

Strumenti per Offerte e fatture

Importazione/esportazione di Offerte e Fatture

Con l'estensione Strumenti per Offerte e Fatture  è possibile importare ed esportare i seguenti dati
da Banana:

    Offerte
    Fatture

Il formato dei file importati/esportati è descritto alla pagina Strumenti per Offerte e Fatture

Importazione/esportazione di contatti e articoli

È possibile invece utilizzare il menu Dati per importare o esportare i seguenti dati da Banana:

    Contatti
    Articoli

Il formato del file importato/esportato segue il formato descritto alla pagina seguente: Text file with
columns header.

Utilizzo di cataloghi per la fatturazione
È possibile integrare dei cataloghi di prodotti nell'applicazione offerte e fatture. Delle ditte possono
mettere a disposizione dei cataloghi ai propri rivenditori, in modo che questi possano preparare più
facilmente offerte e fatture.
Per domande al riguardo si prega di contattare il nostro servizio clienti .

https://www.banana.ch/apps/it/node/9667
https://www.banana.ch/apps/it/node/9667
http://www.banana.ch/it/contact_form_it
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Fatture in serie

Con l'Applicativo Offerte e Fatture puoi creare velocemente delle fatture in serie partendo da un
elenco dati in Excel. Ideale per inviare delle fatture in blocco a clienti o a soci di un'associazione.

Si inseriscono i dati in Excel.
Si importano in Banana Contabilità Plus con le funzioni di importazione.
Si creano e si stampano le fatture.

Prerequisiti
Per creare fatture in serie con l'Applicativo Offerte e Fatture è necessario:

Utilizzare il seguente file di Excel già predisposto dove inserire i dati dei contatti.
[Download] file Excel per i contatti .

Utilizzare il seguente file di Excel già predisposto dove inserire i dati delle fatture.
[Download] file Excel per le fatture .

Utilizzare l'estensione Strumenti Offerte e Fatture  per importare in Banana i dati
delle fatture.

Crea le fatture in serie
Le fatture in serie possono essere create in questo modo:

Installa l'estensione Strumenti Offerte e Fatture.1.
Crea il file Offerte-Fatture e inserisci i dati base.2.
Crea e importa i contatti.3.
Crea e importa le fatture.4.
Stampa le fatture.5.

Installa l'estensione Strumenti Offerte e Fatture
Avvia Banana Contabilità Plus e installa l'estensione Strumenti Offerte e Fatture .

Dal menu Estensioni > Gestione estensioni, tra le estensioni online cerca "Strumenti Offerte e
Fatture" e cliccare su installa.

Crea il file Offerte-Fatture e inserisci i dati base
Ci sono due modalità per predisporre il file:

Creare un nuovo file dal menu File > Nuovo, seleziona regione e lingua, seleziona il tipo Offerte
e Fatture, seleziona il modello file vuoto.
Utilizzare il tuo file di tipo Offerte e Fatture esistente.

Nel menu File > Proprietà file (Dati base) > sezione Indirizzo, imposta l'indirizzo della tua
associazione, che sarà ripreso nell'intestazione della fattura.

https://cdn.banana.ch/portal/repodata/ghba/Universal/invoices/files/contacts.xlsx
https://cdn.banana.ch/portal/repodata/ghba/Universal/invoices/files/contacts.xlsx
https://cdn.banana.ch/portal/repodata/ghba/Universal/invoices/files/invoices.xlsx
https://cdn.banana.ch/portal/repodata/ghba/Universal/invoices/files/invoices.xlsx
https://www.banana.ch/apps/it/node/9667
https://www.banana.ch/apps/it/node/9667
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Se hai un logo che vuoi utilizzare, consulta la pagina Imposta logo.

Crea e importa i contatti
I dati dei contatti possono essere creati partendo fa un file Excel. In questo file si inseriscono tutti i
dati e poi successivamente vengono importati in Banana. Esistono due modalità per farlo:

Metodo 1

Il primo metodo è descritto alla pagina Ripresa dati da altri programmi > Importazione dati one time
con Excel.

In Excel disponi le colonne esattamente nella sequenza come appaiono nella tabella Contatti di
Banana.
Seleziona in Excel i dati da copiare e usa il comando Copia (Ctrl+C o Copia dal menu
Modifica).
Vai in Banana e impartisci il comando Incolla (Ctrl+V o Incolla dal menu Modifica).

Metodo 2

Il secondo metodo utilizza il comando Importa righe dal menu Dati.

Scarica il file Excel apposito per inserire i dati dei contatti .
Il file è già predisposto con le colonne necessarie per inserire i dati.
La riga 1 contiene le intestazioni delle colonne. Questa riga non deve essere eliminata, e i
nomi delle colonne non devono essere cambiati.
Le succesive righe sono dei contatti di esempio.
Per abilitare le modifiche del file, clicca "Abilita modifica" nella barra giallo in alto.

Apri il file e nelle colonne apposite inserisci i dati degli indirizzi dei tuoi contatti. Le colonne sono
le seguenti:

RowId: l'id univoco del contatto.
OrganisationName: il nome dell'organizzazione o dell'azienda.
FirstName: il nome.
FamilyName: il cognome.
Street: la via.
PostalCode: il codice di avviamento postale.
Locality: la località.
CountryCode: il codice della nazione.
LanguageCode: la lingua del contatto utilizzata per creare le fatture. I testi delle fatture
vengono stampati nella lingua definita (it=italiano, de=tedesco, en=inglese, fr=francese).

 
Salva il file.
Seleziona tutte le righe e usa il comando Copia (Ctrl+C o Copia dal menu Modifica).
Importa i contatti in Banana.

In Banana apri il file di tipo Offerte e Fatture.
Seleziona la tabella Contatti.
Dal menu Dati, seleziona il comando Importa righe.

https://cdn.banana.ch/portal/repodata/ghba/Universal/invoices/files/contacts.xlsx
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Nel dialogo che si apre, spunta la voce Importa i dati degli appunti, poi conferma con
OK.

Crea e importa le fatture
I dati delle fatture possono essere creati partendo fa un file Excel. In questo file si inseriscono tutti i
dati e poi successivamente vengono importati in Banana.

Scarica il file Excel apposito per inserire i dati delle fatture .
Il file è già predisposto con le colonne necessarie per inserire i dati.
La riga 1 contiene le intestazioni delle colonne. Questa riga non deve essere eliminata, e i
nomi delle colonne non devono essere cambiati.
Le succesive righe sono delle fatture di esempio.
Per abilitare le modifiche del file, clicca "Abilita modifica" nella barra giallo in alto.

Apri il file e nelle colonne apposite inserisci i dati delle fatture.
Per maggiori informazioni sulle colonne vedi la pagina Colonne importazione offerte e
fatture .
Ogni riga rappresenta una fattura.
Puoi inserire una fattura con più articoli. Per ogni articolo aggiungi una riga alla fattura
 (vedi esempio nell'immagine righe 5-6).

 
Salva il file. 
Converti il file Excel delle fatture in uno dei due formati necessari (*.csv oppure *.txt) per
importare i dati in Banana Plus.

Apri il file Excel con i dati delle fatture.
Clicca su File > Salva con nome.
Seleziona l'opzione CSV (Comma delimited) se intendi utilizzare il formato *.csv;
oppure scegli Text (Tab delimited) se intendi utilizzare il formato *.txt.
Salva il file (una volta creato il file, sarebbe meglio non aprirlo per evitare di fare
modifiche anche involontarie che potrebbero compromettere l'importazione in Banana
Plus).

Importa le fatture in Banana.
In Banana Contabilità Plus apri il file di tipo Offerte e Fatture.
Seleziona la tabella Fatture.
Dal menu Estensioni, seleziona Strumenti Offerte e Fatture > Importa fatture.
Seleziona il file *.csv oppure *.txt che hai salvato.
Un dialogo mostra i cambiamenti che saranno applicati al file Banana. Conferma con OK.

Stampa le fatture
Vedi come fare per stampare le fatture e personalizzare la stampa.

Messaggi d'errore e risoluzione problemi
Per eventuali messaggi di errori durante l'importazione, visitare la documentazione Messaggi d'errore
e risoluzione problemi .

https://cdn.banana.ch/portal/repodata/ghba/Universal/invoices/files/invoices.xlsx
https://www.banana.ch/apps/it/node/9667#importazione_offerte_e_fatture
https://www.banana.ch/apps/it/node/9667#importazione_offerte_e_fatture
https://www.banana.ch/apps/it/node/9667#messaggi_derrore_e_risoluzione_problemi
https://www.banana.ch/apps/it/node/9667#messaggi_derrore_e_risoluzione_problemi
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Il magazzino di Banana Contabilità+

La gestione Magazzino consente di avere un controllo delle quantità disponibili, il valore complessivo
e i movimenti della merce acquistata e venduta.  Se sei attivo nel mondo del commercio online, è
anche la soluzione ideale per monitorare la merce in arrivo, gestire gli ordini da spedire e
coordinare workflow anche tra i più complessi.

L'applicativo Magazzino è molto semplice e intuitivo da utilizzare. Gestisce le attività essenziali di
magazzino ma é un applicativo separato che non ha alcun collegamento con il sistema di fatturazione
e la contabilità. 

Registrare i movimenti
La Tabella Registrazioni è il cuore dell'applicativo, e ti permette di inserire i movimenti in entrata e
uscita, per ogni singolo articolo, con quantità e prezzi. Puoi specificare da quale magazzino (luogo)
l'articolo proviene e in quale è destinato. Puoi inserire descrizioni e annotazioni.
Il programma tiene aggiornate le quantità e se hai sbagliato puoi modificare e avere sempre una
situazione perfetta.

La tabella Articoli
Tutti gli articoli del magazzino vengono definiti nella Tabella Articoli. Ogni articolo ha un id e una
descrizione. Puoi raggruppare gli articoli in gruppi e sottogruppi. Nella tabella articoli il programma
visualizza anche le quantità disponibili e altre informazioni aggiornate in base ai movimenti.
Ci sono a disposizione diverse colonne, la visualizzazione può essere personalizzata e puoi anche
aggiungere nuove colonne dal menu Dati > Disponi colonne. Per ogni articolo vengono definiti diversi
parametri che poi verranno ripresi nella tabella Registrazioni.
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Una volta che i parametri di ogni articoli sono stati definiti, è molto veloce registrare i movimenti della
merce: basta inserire l'Id dell'articolo nella tabella Registrazioni e inserendo solo le quantità tutti gli
altri valori vengono inseriti in automatico.

Gestione clienti, fornitori e progetti
Con l'applicativo Magazzino si possono aggiungere colonne e tabelle per inserire i clienti ai quali viene
venduta la merce e i fornitori dai quali arriva la merce; inoltre le colonne possono essere utilizzate per
gestire dei progetti legati alla merce.

Tramite la funzione Estrai righe si possono visualizzare le operazioni effettuate con i clienti, i fornitori
e per i progetti.

Maggiori dettagli sono disponibili alla pagina Funzioni avanzate.

Magazzini multipli e virtuali
Per gestire la merce che arriva o che viene spedita dalle filiali, si utilizza la Tabella Luoghi, dove viene
indicata la località del magazzino. Nel caso che la tua azienda abbia magazzini in varie località, puoi
indicare da quale magazzino entra ed esce la merce, oppure avere traccia da quale magazzino la
merce viene spedita la cliente.

La tabella Luoghi può essere utilizzata anche per altri scopi, cambiando l'intestazione. Un uso molto
pratico potrebbe essere quello di utilizzarla per registrare i movimenti delle chiavi nella gestione di un
condominio, impostando i nomi dei condomini.

Inoltre, puoi gestire uno shop online, e in questo caso la tabella Luoghi viene utilizzata per indicare i
magazzini virtuali.

Maggiori dettagli sono disponibili alla pagina Esempi di stampe
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Come iniziare un file Magazzino

Per creare un file Magazzino devi aver installato la versione di Banana Contabilità Plus e seguire i
seguenti passaggi:

Crea un nuovo file
Per un inizio facile e veloce consigliamo di partire da uno dei nostri modelli predefiniti per poi
personalizzarlo, piuttosto che da un file vuoto.

Procedi come di seguito:

Menu File > Nuovo
Seleziona Regione e lingua
Selezione il tipo Magazzino.

Imposta i dati base
Nel menu File > Proprietà file (Dati base) imposta i dati del tuo magazzino.

Imposta la tabella Articoli
Nella tabella Articoli imposta l'elenco di tutti gli articoli.

Per ogni articolo devi inserire:

L'Id per identificare l'articolo. Puoi inserire numeri, lettere o entrambi.
La descrizione.
La quantità iniziale.
Prezzo iniziale.
Prezzo unitario.

Inseriti i dati, il programma aggiorna in automatico i valori di tutte le colonne della tabella Articoli.

Imposta la tabella Luoghi
Se la tua azienda ha diversi magazzini dislocati in località diverse, impostando le località puoi gestire
le entrate, le uscite e i trasferimenti degli articoli di tutti i magazzini. Potrai sapere quanti articoli coni
relativi valori si trovano in ogni magazzino e valutare se occorre trasferire la merce da un magazzino
all'altra a dipendenza dello stock e delle richieste di vendita.

Nella tabella Luoghi devi inserire:

l'Id per identificare il luogo
La descrizione

Inserisci i movimenti degli articoli
Nella tabella Registrazioni inserisci gli acquisti, le vendite ed eventuali trasferimenti da un magazzino
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all'altro.

Inserisci la data
Inserisci l'Id dell'articolo
La quantità in entrata o uscita

Tutto è fatto! Le colonne dei valori saranno aggiornate in automatico, contemporaneamente anche
nella tabella Articoli.

Schede articoli e report
Dal menu Report, comando Item cards puoi ottenere le schede di ogni articolo singolarmente, per
selezione o per tutti gli articoli.

È possibile ottenere anche dei report per gruppo di articoli e anche per Location del magazzino. Le
opzioni si trovano nella finestra di dialogo Item cards.
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Proprietà file

Nel menu File > Proprietà file (Dati base) imposta i dati del tuo magazzino.

Dati base file

Inserire l'intestazione del magazzino.

Indirizzo

Inserire l'indirizzo del magazzino.

Varia

La sezione Varia contiene le seguenti opzioni:

Lingua corrente
È la lingua corrente del file magazzino.

Lingua di creazione
È la lingua con la quale è stato creato il file Magazzino.

Estensioni
Collegamento ad eventuali estensioni per report personalizzati.
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Password

Inserire un'eventuale password per rendere più sicuro il file.

Testi

Per effettuare modifiche di testi e chiavi dell'applicativo Magazzino.
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Tabella Articoli | Magazzino

Nella tabella Articoli si inseriscono tutti gli articoli del magazzino da gestire.

Creare la lista degli articoli
Tutti gli articoli disponibili nel magazzino devono essere registrati singolarmente su ogni riga nella
tabella Articoli. Per totalizzare gli importi di una serie di articoli bisogna inserire un gruppo di
totalizzazione.

Il gruppo si definisce nella colonna Gruppo, alla fine dell'elenco degli articoli della stessa categoria. Il
numero di gruppo deve essere riportato nella colonna Somma in per ogni articolo.
Per maggiori informazioni sul sistema di raggruppamento si rimanda alla pagina Sistema
Raggruppamento.

Si possono creare più gruppi di articoli a dipendenza delle proprie esigenze.

Per completare la registrazione degli articoli è necessario inserire:

L'Id per identificare l'articolo.
La descrizione.
La quantità iniziale.
Il prezzo iniziale.
Il prezzo unitario.

Colonne tabella Articoli
Le colonne con "*" sono protette e calcolate dal programma.

Links
Collegamento ad un documento digitale.
RigaGruppo
Colonna e riga per inserire il gruppo di totalizzazione di un determinato insieme di articoli.
IdRiga
Si inserisce un valore (numero, lettere o entrambi) per identificare l'articolo.
Descrizione
Si inserisce un testo per la descrizione dell'articolo.
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Somma in (nel disponi colonne è scritto RigaGruppoIn)
In questa colonna, per ogni articolo, inserire il gruppo di totalizzazione.
Note
Si possono inserire dei testi per delle annotazioni sugli articoli o per altre esigenze.
Conto
Si inserisce il conto presente nel file della contabilità che fa riferimento all'articolo.
UnitàRiferimento
Inserire una sigla per indicare l'unità (es. pz per indicare i pezzi).
QuantitàInizio
Inserire le quantità iniziali riferita al complessivo.
Se si vogliono gestire quantità separate per luoghi, lasciare questa colonna vuota, e inserire le
quantità iniziali come registrazioni di entrata, con il relativo luogo.
PrezzoUnitarioInizio
Prezzo unitario iniziale
*ValoreIniziale
Valore iniziale dell'articolo calcolato moltiplicando la Quantità iniziale e il Prezzo unitario iniziale.
*QuantitàPiù
Quantità totali di articoli risultante dalla somma della QuantitàPiù nella tabella Registrazioni.
Sono sommati sia i valori in positivo che in negativo. Non sono sommati i movimenti interni fra
due luoghi, quando c'è la sigla TrasferimentoId.
*QuantitàMeno
Quantità totali di articoli risultante dalla somma della QuantitàMeno nella tabella Registrazioni.
Sono sommati sia i valori in positivo che in negativo. Non sono sommati i movimenti interni fra
due luoghi, quando c'è la sigla TrasferimentoId.
*QuantitàModifica
Differenza tra le quantità più e quella meno.
*QuantitàSaldo
È il quantitativo di articoli attualmente in magazzino. Somma della quantità iniziale e la
Quantità modifica.
PrezzoUnitario
Prezzo unitario dell'articolo, deve essere inserito manualmente.
*ValoreTotale
Importo calcolato dal programma in base alle quantità e al prezzo unitario.
ArticoloQuantitàEffettiva
Quando si fa l'inventario per inserire il quantitativo effettivo.
ArticoloPrezzoEffettivo
Prezzo per l'inventario.
*Valore effettivo
La quantità effettiva moltiplicato per il prezzo effettivo.
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Tabella Registrazioni

È la tabella dove vengono registrati i movimenti degli articoli:

Acquisti
Vendite
Trasferimenti da un magazzino all'altro, nel caso ci siano più magazzini.

Inserendo i movimenti, si aggiorna anche in automatico la tabella Articoli riguardo le quantità e i
corrispondenti valori degli articoli.

Nel caso in cui ci siano più magazzini (sede centrale e filiali), per poter tenere traccia degli
spostamenti interni degli articoli, si possono registrare le sigle ID, impostate nella tabella Luoghi, che
si riferiscono ai luoghi dove si trovano i magazzini.

Le sigle ID devono essere inserite nelle colonne Luogo e Trasferimento della tabella Registrazioni.
Se non sono visibili, possono essere visualizzate tramite il menu Dati → Disponi colonne.

Colonne tabella Registrazioni
Le colonne con l'asterisco "*" sono protette, perché calcolate dal programma.

Links
Collegamento ad un documento digitale.
Data
La data dell'operazione.
Doc.
Numero di documento (es. nr. di bolla di consegna).
IdArticoli
Valore numerico o alfanumerico per identificare l'articolo.
DescrizioneArticoli
Testo ripreso in automatico dalla colonna Id della tabella Articoli per la descrizione.
Descrizione
Testo da inserire per la descrizione degli articoli.
Note
Nella colonna si possono inserire delle note riguardo gli articoli o per qualsiasi altra necessità.
QuantitàPiù
Valore per indicare le quantità  degli articoli in entrata, acquistate o trasferite da altri
magazzini.
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Nel caso di uno storno inserire un valore negativo.
QuantitàMeno
Valore per indicare le quantità degli articoli in uscita, venduti o trasferiti verso altri magazzini.
Nel caso di uno storno inserire un valore negativo.
UnitàRiferimento
Sigla per indicare il tipo di unità.
PrezzoUnitario
Il prezzo dell'articolo con cui viene calcolato il valore complessivo degli articoli, in base alle
quantità.
*Importo Totale
Valore complessivo degli articoli acquistati, venduti o trasferiti.
LuogoId
Identificativo del luogo dove di trova il magazzino e da cui entrano o escono gli articoli.
*LuogoDescrizioneId
Nome del luogo dove di trova il magazzino.
LuogoTrasferimentoId
Sigla del luogo dove si trova il magazzino, a cui sono destinati gli articoli.
Si comporta in maniera opposta al LuogoId.

Se vi è un'entrata nel LuogoId, nel LuogoTrasferimentoId ci sarà un'uscita.
Se vi è un'uscita dal LuogoTrasferimentoId ci sarà un'entrata.
Se è indicato il LuogoTrasferimentoId, ma il LuogoId è lasciato vuoto, il programma
considera comunque come un movimento interno senza però un LuogoId specifico.

*LuogoTrasferimentoDescrizione
Nome del luogo dove si trova il magazzino, da cui arrivano o escono gli articoli, da o per un altro
magazzino.
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Tabella Luoghi per magazzini multipli e
virtuali

La tabella Luoghi viene utilizzata nel caso in cui l'azienda ha merce in località diverse oppure per
tenere il controllo della merce in arrivo, da spedire, ecc. (vedi sotto magazzini virtuali). Puoi usare i
luoghi anche per sapere se hai dato della merce in conto vendita, prestito o altro.

Per tenere conto complessivamente degli articoli entrati e usciti di tutti i magazzini, inserendo la sigla
ID dei luoghi nella tabella Registrazioni, nelle colonne Luogo e Trasferimento si conoscono tutti i
valori degli articoli anche per singolo magazzino e i relativi spostamenti.

Per maggiori dettagli consultare la pagina web Tabella Registrazioni.

Colonne tabella Luoghi
IdRiga
Identificativo del luogo dove si trova il magazzino.
Descrizione
Nome del luogo dove si trova il magazzino.
Note
Si possono scrivere dei testi per delle note.

Luoghi e Magazzini virtuali
La tabella Luoghi viene usata per indicare i luoghi dove si trovano i magazzini, anche quelli virtuali.

Puoi anche impostare dei magazzini virtuali, per tenere traccia di ordini o altro. Per esempio:

Spedire
Per i prodotti ordinati in attesa di spedizione.
Ritirare
Prodotti che il cliente deve passare a prendere.
Riservare
In attesa che il cliente decida di effettuare l'ordine.
Arrivi
Prodotti che sono stati ordinati presso il fornitore e che sono in attesa di arrivo.
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Ritorni
Prodotti che il cliente ha indicato di volere ritornare.
Prova
Prodotti forniti in prova a dei clienti, che non sono stati ancora venduti.

Usando dei luoghi virtuali, puoi anche gestire dei workflow più complessi, per esempio simulare che la
merce è in fase di produzione, controllo qualità, ecc. Vedi Funzioni avanzate.
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Ricontrolla tutto

Il programma ricalcola, ricontrolla e visualizza eventuali errori o differenze.

Il comando è disponibile dal menu Azioni > Ricontrolla.
Utilizza questo comando quando dubiti che ci sia un problema nel tuo file.
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Report del Magazzino

I contenuti presenti in tutte le tabelle del Magazzino rappresentano già dei report, dal momento che
tutte le colonne hanno i valori aggiornati dopo ogni movimento.

I dati delle tabelle possono essere stampati dal menu File → Stampa. Inoltre possono essere
esportati in Pdf, Excel, Xml, Html, Txt e JsonCsv.

I Report vengono eseguiti dal menu Report → Schede articoli e si possono ottenere:

Giornale di un articolo o degli articoli selezionati.
Giornale completo di tutti gli articoli.
Giornale di articoli di un determinato magazzino, nel caso ci fossero più magazzini.

Report magazzino
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Note
Per ottenere il totale degli articoli per ogni località e il consuntivo degli articoli, raggruppare per
Articolo e per Luogo.
Se si vogliono gestire quantità separate per luoghi, inserire le quantità iniziali come registrazioni di
entrata, con il relativo luogo e non utilizzare la colonna Qt.Iniziale della tabella Articoli.
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Generale

Filtro
Inserendo il nome dell'articolo, appare la lista di tutti gli articoli che hanno lo stesso nome.
Dalla lista possono essere selezionati gli articoli che interessano oppure, attivando Tutti, verrà
visualizzato il giornale con i valori di tutti gli articoli.

Raggruppamento per
Item

Se viene scelta questa opzione vengono visualizzate le schede di tutti gli articoli o solo di quelli
selezionati.

Location

Se viene scelta questa opzione vengono visualizzate le schede degli articoli relativati al luogo del
magazzino selezionato.

Visualizza solo totali

Se si attiva questa opzione vengono visualizzate le schede degli articoli unicamente con i totali.
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Periodo

Tutto

Sono inclusi tutti i movimenti degli articoli.

Periodo specificato

Si intende il periodo specificato, indicando la data di inizio e di fine.

In questo caso vengono visualizzati gli articoli relativamente al periodo selezionato.
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Personalizzazione

Nome

Inserire un testo per definire il nome del report personalizzato.

Descrizione

Inserire un testo per la descrizione del report personalizzato.

Opzioni
Se una o più opzioni vengono attivate il report personalizzato apparirà come segue:

Mostra sempre questa finestra

Il report personalizzato è visualizzato nella finestra di dialogo e potrà essere modificato.

Mostra nel menu

Il report personalizzato è visualizzato nel menu Items cards.

Mostra nel menu Favorito

Il report personalizzato è visualizzato nel menu Favoriti.

Solo lettura

Il report personalizzato è in modalità solo lettura.
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Esempi di stampe

Giornale per articolo

Giornale articoli

Giornale articoli per luogo

Giornale articoli di tutti i luoghi
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Utilizzi avanzati del applicazione magazzino

L'applicazione magazzino può essere usata anche per utilizzi molto avanzati.

Gestione clienti / progetti
Per sapere a quali clienti è stato venduto o consegnato un prodotto, procedere in uno dei seguenti
modi:

Nella tabella Registrazioni aggiungere una colonna, dove inserire il nome del cliente, progetto...
Aggiungere una tabella dove elencare i clienti e attribuire un codice.

Nella tabella Registrazioni aggiungere una colonna collegata al cliente.

È possibile aggiungere diverse colonne o tabelle per tenere nota dei progetti, dei fornitori o altro.

Per filtrare le operazioni effettuate da un cliente, posizionarsi nella tabella Registrazioni e nella
colonna Clienti o Progetti, usare uno dei seguenti comandi: Estrai e ordina righe; cliccare sul tasto
destro del mouse sulla cella del cliente scegliere Estrai righe; usare la funzione del filtro.

 Online Shop / Magazzini virtuali
Per gestire uno shop online e definire dei magazzini virtuali, si usa la tabella Luoghi, dove indicare la
merce in arrivo, quella da spedire o riservata.

Alcuni esempi:

Acquisto online di merce da parte di un cliente.
Al ricevimento dell'ordine, registrare il movimento della vendita fra il magazzino fisico e
quello virtuale denominato "Spedire".
Quando poi la merce viene spedita fisicamente, registrare il movimento della merce in
uscita dal magazzino fisico, denominato "Spedire".

Ordine di merce a un fornitore.
Quando si ordina la merce, registrare il movimento dell'acquisto verso il magazzino
virtuale denominato "Arrivi".
Quando la merce ordinata arriva, registrare il movimento dell'acquisto dal magazzino
fisico al magazzino virtuale denominato "Arrivi".

Creando altri luoghi virtuali, si possono gestire anche dei workflow più complessi. 

Importazione dati
Si possono riprendere dei dati di magazzino da altri programmi in uno dei seguenti modi:

Aprire il file in Excel e disporre le colonne come sono visualizzate in Banana Contabilità e usare i
comandi copia/ incolla per riprendere e inserire i dati nel programma.
È possibile creare una vista, impostando le colonne dove riportare i movimenti. 
Preparare delle estensioni che importano e convertono i dati da altri formati esistenti .

https://www.banana.ch/apps/it/node/9561
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Applicativo gratuito Foglio ore | Time Sheet

Il Time Sheet è un applicativo gratuito e senza limiti perché è incluso nel piano Free di Banana
Contabilità Plus. Funziona come Excel, ma essendo ottimizzato per i calcoli delle ore, è molto più
affidabile e riesci facilmente a gestire orari di lavoro di ogni genere. Hai una visione completa delle
ore e puoi sempre correggere.

▶ Video: Come iniziare con il Foglio ore
Guarda tutte le caratteristiche del Foglio ore

Seguire delle impostazioni specifiche:

 

 

Intestazione
I dati dell'intestazione del Foglio
ore sono ripresi da quelli inseriti
nel menu
File → Proprietà file (Dati base) →
Foglio ore

 

Pianificare l'orario di lavoro
Hai una visione immediata dei
giorni e ore di lavoro, e delle
vacanze di cui puoi disporre.
File → Proprietà file (Dati base) →
Inizio

 

Date, festività e non
lavorativi
Puoi definire il periodo e
personalizzare le festività e i
giorni non lavorativi. Vai alla
tabella Giornale, colonna Festivo

 

Ore lavorate e assenze
Inserisci giorno per giorno le tue
ore lavorative, le assenze e
vacanze.
Vai alla tabella Giornale per
l'elenco di tutte le colonne a
disposizione.

 
Controlla
Hai totali e i saldi delle ore
lavorate, dovute, assenze e
vacanze sempre aggiornati.

Puoi impostare le ore lavorative da contratto e registrando giorno per giorno le ore lavorate, il saldo
ore viene costantemente aggiornato. Si possono indicare anche il numero di giorni di vacanza a cui
hai diritto, man mano vengono inserire le vacanze usufruite, sai sempre quanti giorni hai ancora a
disposizione. 

Il Foglio ore consente di avere un report completo da presentare al tuo datore di lavoro ed essere in
regola con l'obbligo di legge di tenere nota delle ore lavorate.

https://www.banana.ch/it/node/11360


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 1015

Approfondimenti
Caratteristiche
Come iniziare
Inserire orario di lavoro
Stipendio fisso
Stipendio a ore
Gestire progetti
Stampe
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Caratteristiche del Foglio ore

  Il Foglio Ore è il nuovo applicativo Gratuito di Banana Contabilità Plus per gestire facilmente le
tue ore di lavoro e sapere in un attimo la situazione delle ore lavorate, straordinari, vacanze, assenze.

Per iniziare basta scaricare e installare Banana Contabilità Plus  e, nel creare un nuovo file, scegliere
come tipo Foglio Ore.

▶ Video: Come iniziare con il Foglio ore

Tanti automatismi per rendere facile e veloce la gestione delle ore.

Software disponibile gratuitamente su qualsiasi sistema operativo, compresi i mobile.
Soluzione semplice da usare e da implementare, non servono login e password.
Ogni dipendente tiene il file sul proprio computer o apparecchio mobile.
Completamente adattabile alle necessità del dipendente e dell'impresa.
Grande risparmio di tempo e si evitano errori di calcolo.
Modelli di file a disposizione con calendario dell'anno in corso.
Sistema di calcolo potente e automatizzato.
Uniformità dei calcoli. Tutti i calcoli sono basati su ore e minuti e questo rende possibile
adattarsi ad ogni casistica ed esigenza
Saldi e totali aggiornati all'istante per giorno, mese e anno.
Dati inseriti nelle colonne predefinite, per risultati sempre ordinati e chiari.
Previsione ore lavorative.
Gestione delle ore dei progetti.
Ore lavorate e indicazione delle ore fatte in più o in meno e saldo progressivo.
Indicazione delle vacanze fatte e residue con riporto nell'anno successivo.
Possibilità di codificare altre informazioni utili all'azienda (progetti, spese, note).
Conforme alle normative della Corte di Giustizia europea e alle normative svizzere.

https://www.banana.ch/it/node/11181
https://www.banana.ch/it/node/11360
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Modalità di tenuta delle ore
Il Foglio ore supporta diverse modalità di raccolta dati:

Raccolta sistematica
Inserisci l'orario di entrata e uscita e il programma calcola le ore lavorate.
Rendi visibili le colonne Inizio1-Fine1, Inizio2-Fine2, ... , Inizio5-Fine5 dove inserire gli orari
di entrate e uscita.
Raccolta semplificata
Indica le ore lavorate in un giorno.
Rendi visibili le colonne Lavoro1 e Lavoro2 per inserire le ore lavorate nel giorno.
Raccolta mista
Puoi inserire sia l'orario di entrata e uscita, oppure il tempo lavorato.
Rendi visibili sia le colonne Inizio-Fine e le colonne Lavoro.

Calcoli precisi e uniformi per ogni impiego
Il foglio ore usa sempre il formato ore e minuti (per esempio: 8:15) . Anche vacanze e assenze sono
indicate giornalmente con ore e minuti. Questo consente di gestire facilmente e in modo preciso
situazioni con orari di lavoro non uniformi e soggetti a cambiamenti.
Anche i totali sono sempre indicati in ore e minuti. Questa uniformità consente una visione esatta
della propria situazione lavorativa, pienamente conforme alle normative di legge, ed evita discussioni
fra dipendente e datore di lavoro in merito ai calcoli.

Qui di seguito una panoramica di come avviene l'inserimento dei dati e i calcoli.

Orario di lavoro previsto (ore dovute)
Per ogni singolo giorno della settimana si può indicare l'esatto numero di ore e i minuti di lavoro
previsto. Il programma indica il totale previsto di ore settimanali. L'orario di lavoro può essere
modificato anche solo temporaneamente (per esempio cambio dell'orario durante solo una
settimana). 
Ore lavorate
Le ore di lavoro giornaliere possono essere inserite con ora/ore di entrata/e e uscita/e, oppure
anche come un totale di ore e minuti o una combinazione di entrambi. Il programma calcola poi
il totale delle ore lavorate giornalmente.
Ore supplementari per lavoro notturno o festivo
Si  possono specificare sia come ore e minuti sia come percentuale; il programma calcola poi il
totale.
Le vacanze
Si indicano in ore e minuti per tutto l'anno. È semplice, basta moltiplicare il totale di ore
settimanali per il numero di settimane di vacanza. Il programma calcola il saldo vacanze
rimanente che sarà preciso al minuto, anche se l'orario di lavoro è variegato.
Le assenze per malattia, servizio o di altro genere
Si indicano anche come ore e minuti.  Il programma calcola poi il totale di assenze giornaliere.
Totale ore
È la somma in ore e minuti delle ore lavorate, supplementi e assenze. Il programma calcola la
differenza giornaliera fra le ore dovute (previste) e il totale. Vi è poi un contatore progressivo
delle differenze così che si ha una visione istantanea del saldo ore.
Colonne relative a contatori tempo
Il programma calcola il totale mensile e annuale, visualizzato in formato ore e minuti, in modo
tale che si abbia un controllo completo e un'uniformità di calcolo.
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Ore in formato decimale 
Quando si inseriscono le ore, si può anche indicare un numero decimale (8.50) e il programma
lo converte in formato ore e minuti (8:30).
Il foglio ore visualizza alcuni totali anche in formato ore decimali, così da semplificare
l'inserimento in altri programmi.
Il rendiconto mensile presenta i totali delle ore giornaliere e mensili.
Delle estensioni di stampa permettono di totalizzare e visualizzare gli orari in qualsiasi altro
formato.

File e salvataggio dati
Hai tutti i dati salvati in un unico file, dove trovi facilmente tutto senza perdite di tempo.
Attribuisci al file il nome che desideri.
Puoi gestire un numero illimitato di file.
Salva i dati su qualsiasi supporto, computer, rete, cloud o inviali per email . Puoi accedervi
ovunque tu sia.
Rendi più sicuro il tuo foglio ore inserendo una protezione con password.

Basato su colonne come Excel
Nel Foglio ore è presente la tabella Giornale con delle colonne già impostate, dove si annotano giorno
per giorno i propri orari di lavoro (ora inizio e fine), le vacanze, gli straordinari o eventuali giorni di
malattia.

Le colonne della tabella Giornale sono predefinite e si possono visualizzare a scelta.
Colonne predefinite per tante esigenze:

Previsione delle ore di lavoro.
Ore effettive lavorate.
Differenza tra ore lavorate e ore previste. Pertanto si ha la segnalazione delle ore
straordinarie o le ore da recuperare.
Annotazioni e rimborsi.
Ore per progetti.

Possibilità di aggiungere più righe per lo stesso giorno lavorativo.
Nella colonna Links puoi aggiungere un Collegamento ad un documento (esempio certificato
medico).
Il comando Cerca ti permette di cercare velocemente i dati.

Segnalazioni errori e controllo
Comando per il ricalcolo del Foglio ore.
Segnalazione di eventuali impostazioni sbagliate, differenze o errori.
Ogni segnalazione è collegata a una pagina di aiuto che spiega le cause e la soluzione.
Possibilità di correggere.

Report mensili e stampe
Giornale stampabile così come si vede a video, oppure, per selezione.
Report mensile.

https://www.banana.ch/it/node/11059
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Esportazione, Importazione e archiviazione dati
Copia e incolla direttamente da e per Excel.
Esportazione dati tabella in pdf e in diversi altri formati.
Archiviazione delle stampe e dei dati in pdf o altri formati.
Salvataggio del file contabile su qualsiasi supporto.
Importazione dati del Foglio ore in altri programmi.

Documentazione completa
Ogni dialogo ed errore ha una propria pagina di documentazione accessibile con un clic .
Documentazione aggiornata costantemente .
Domande e risposte .
Documentazione disponibile anche in formato PDF.

 Funzionalità al momento non disponibili
Queste sono funzionalità che, seppur richieste da qualche utente, al momento non sono disponibili.

Stampa report mensile, con logo, con indicazione per la firma, con possibilità di scegliere le
colonne da stampare.
Nessun collegamento con il programma fatturazione
Le ore da fatturare devono essere riportate manualmente nella fatturazione.

Elenco completo funzionalità al momento non disponibili

https://www.banana.ch/doc/it/banana-error-details/it
https://www.banana.ch/doc/it/documentation
https://www.banana.ch/it/node/9340
https://www.banana.ch/doc/it/features_not_available
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Come iniziare un Foglio ore | Timesheet

Per utilizzare il Foglio ore devi scaricare e installare Banana Contabilità Plus . Nel piano Free il Foglio
ore è gratuito e illimitato.

▶ Video: Come iniziare con il Foglio ore

Per un inizio facile e veloce consigliamo di partire da uno dei nostri modelli predefiniti per poi
personalizzarlo, piuttosto che da un file vuoto.
Il programma Banana Contabilità Plus include tre tipi di modelli per il Foglio ore con colonne già
impostate:

Registrazioni sistematiche - si indicano gli orari di inizio e di fine lavoro, come generalmente1.
richiesto dalle normative di legge.
Registrazioni semplificate - inserisci le ore giornaliere lavorate (con impostazione ore dovute).2.
Salario a ore - si indicano le ore giornaliere lavorate (senza impostazione ore dovute).3.

Il nostro esempio si basa sul modello del Foglio ore con registrazione sistematica .

 Imposta il file del tuo Foglio ore

Procedi come di seguito:

Menu File → Nuovo.
Seleziona Regione/lingua.
Seleziona la Categoria → Tutto o Altro.
Digita nella casella Cerca il testo Foglio ore, oppure attiva nel Tipo → Foglio ore. Il
programma mostra i modelli disponibili.
Nella sezione a destra seleziona il modello desiderato.
Fai un doppio click sul nome del modello, oppure, clicca sul bottone Crea. Il programma apre
direttamente il file selezionato.
Salva il file con nome.

https://www.banana.ch/it/download
https://www.banana.ch/it/node/11360
https://www.banana.ch/apps/it/node/8933
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Imposta i tuoi dati

Imposta i tuoi dati dal menu File → Proprietà file (Dati base) → Foglio ore .
Inserisci  il nome e cognome, la data iniziale e finale, la percentuale di lavoro e altri dati richiesti
se disponibili.

Imposta l'orario di lavoro come da contratto

Imposta l'orario di lavoro settimanale dal menu File → Proprietà file (Dati base) → Inizio .
Le caselle del Riporto sono destinate alle ore di lavoro non pagate e a quelle delle ore di
vacanze non usufruite e riportate dall'anno precedente.
Inserisci per ogni giorno settimanale le ore di lavoro e definisci i giorni lavorativi, quelli non
lavorativi e i festivi. Queste impostazioni vengono riportate nella tabella Giornale.

http://www.banana.ch/doc/it/node/9084
http://www.banana.ch/doc/it/node/9084
http://www.banana.ch/doc/it/node/9084
http://www.banana.ch/doc/it/node/9085
http://www.banana.ch/doc/it/node/9085
http://www.banana.ch/doc/it/node/9085
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Registra il tempo di lavoro

Nella tabella Giornale  si inseriscono i dati giornalieri, l'ora d'inizio e fine lavoro, le ore di assenza per
malattia, vacanze e congedi. I dati possono essere modificati e inseriti secondo le esigenze.

Scrivi le ore di ferie a cui hai diritto nell'anno corrente.1.
Includi, modifica, aggiungi, personalizza qualunque festività, se necessario.2.
Inserisci le tue ore giornaliere di lavoro, malattia, ferie, ecc.3.

Nella prima riga del Riporto vengono riportate le ore di vacanze non fatte dell'anno
precedente, presenti nel dialogo Inizio.
Nella riga Inizio del primo giorno del mese vengono inserite le ore di vacanze annuali a cui si
ha diritto, come da contratto.
I giorni non lavorativi sono distinti con il colore blu, mentre quelli festivi sono in rosso.
Il programma calcola in base ai dati inseriti, i totali giornalieri e mensili del Dovuto, la differenza
tra le ore lavorate e quelle dovute e il progressivo.

http://www.banana.ch/doc/it/node/9047
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Nella finestra in basso vengono riportati in automatico i saldi delle ore settimanali dovute e
lavorate e il saldo delle ore di vacanza

Stampa il report mensile

Con il comando Report → Report mensile... il programma calcola e visualizza un report riassuntivo
del periodo selezionato con le colonne principali utilizzate.

Per maggiori approfondimenti e casi particolari dell'applicativo Foglio ore consultare le seguenti
pagine:

Foglio ore
Caratteristiche
Impostare il file
Tabella Giornale
Inserire orario di lavoro
Stampe
Gestione ore progetti

http://www.banana.ch/doc/it/node/9616#report_mensile
http://www.banana.ch/doc/it/node/9616#report_mensile
http://www.banana.ch/doc/it/node/9616#report_mensile
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Proprietà file - Foglio ore

Dal menu File → Proprietà file (Dati base) → Foglio ore  devono essere impostati i seguenti dati:

Nome e cognome.
Data iniziale e data finale
Si può inserire qualsiasi periodo a scelta.
Percentuale di lavoro
Altri dati se disponibili.
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Tabella Giornale del Foglio ore

Nella tabella Giornale si inseriscono i dati giornalieri del Foglio ore, che possono essere modificati e
inseriti secondo le proprie esigenze.
Le righe e le colonne di totale consentono di avere una panoramica immediata della situazione.

La tabella Giornale include diverse colonne per adattarsi a tutte le esigenze. A seconda delle
necessità si visualizzano le colonne che servono.

Tipologie di righe, colori e formati
Le righe del Giornale sono create in automatico dal programma quando viene creato un nuovo file.
Utilizzando un modello predefinito, le righe del Giornale sono già impostate.

Righe giornaliere

Le righe giornaliere servono per l'inserimento dei dati:

Righe normali - si riferiscono alle righe lavorative.
Righe in rosso - si riferiscono ai giorni festivi.
Righte in blu - si riferiscono ai giorni non lavorativi.
Riga evidenziata in giallo - si riferisce al giorno corrente.

Righe giornaliere multiple

Duplicando la riga del giorno, si possono inserire ulteriori informazioni relative allo stesso giorno,
come gli orari per progetto, annotazioni o altro.
Per differenziare le righe successive, la Descrizione giorno è leggermente rientrata.

Righe Riporto, Inizio, Totale e Saldo

Le righe Riporto, Inizio, Totale e Saldo sono indicate in grassetto.
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La riga Riporto visualizza automaticamente le vacanze e le ore dell'anno precedente, inserite
nelle Proprietà file > Inizio.
Le righe di Inizio si riferiscono all'inizio dell'anno e del mese. Si inseriscono i valori iniziali delle
vacanze o ore.
Le righe di Totale si riferiscono alla fine del mese e dell'anno. Vengono riportati in automatico i
totali delle colonne che riportano dei valori.
Le righe di Saldo vengono calcolate automaticamente dal programma e riportano i totali
progressivi delle colonne che hanno dei valori.

Viste della tabella Giornale
La tabella Giornale viene creata con diverse colonne, in modo da coprire un'ampia gamma di
esigenze.
A seconda della vista vengono visualizzate delle colonne predefinite:

Base - presenta le colonne principali.
Minima - presenta le colonne d'inserimento dati.
Completo - presenta tutte le colonne della tabella Giornale.
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Le colonne della tabella giornale

Le colonne presenti nella tabella Giornale possono essere personalizzate in base alle proprie
necessità.

Tramite il menu Dati > Disponi colonne si possono visualizzare più colonne o nascondere quelle che
non servono, cambiare le intestazioni già esistenti, aggiungere colonne proprie e cambiare il formato.

Nelle colonne, il programma lavora sempre con ore e minuti, es. 8:30 significa 8 ore e 30 minuti:

Internamente i valori sono salvati come secondi e visualizzati poi nel formato ore e minuti.
Quando si inseriscono degli orari, i tempi sono arrotondati al minuto.

Sezione

La colonna è protetta. È utilizzata dal programma per fare una distinzione fra le righe da utilizzare per
l'inserimento dei dati e le righe specifiche di sistema.

Le righe utilizzate per l'inserimento e la modifica dei dati (ore lavorative, le assenze, vacanze, ecc.),
hanno la cella della colonna Sezione vuota.

Le righe specifiche di sistema, utilizzate dal programma per fare calcoli, hanno un apposito codice
identificativo nella cella della colonna Sezione.
Questo codice non deve essere cambiato, altrimenti le somme potrebbero risultare sbagliate.
Esempi di codici utilizzati: AllStart, YearStart_2020, MonthStart_202001, MonthTotal_202001,
MonthBalance_202001, SpaceAfterMonth_202001.

Il valore è un codice identificativo composto da diversi elementi:

Periodo

All - Si riferisce a tutte le righe.
Year - Si riferisce alle righe dell'anno.
Month - Si riferisce alle righe del mese.
Week - Si riferisce alle righe della settimana.
Day - Si riferisce alle righe del giorno.

Tipo

CarryForward - Righe di riporto delle ore e delle vacanze in saldo dell'anno precedente. I
riporti sono inseriti in automatico dal programma nelle Proprietà del file, sia per i valori positivi
che negativi. 
Start - Righe di Inizio. Per inserire i valori iniziali (vacanze previste, rettifiche vacanze).
Total - Le righe dove vengono indicati i totali. Sono sommate nelle righe di totale (colonne
relative ai tempi giornalieri, rettifiche delle sezioni Start e CarryForward).
Balance - Per il saldo vacanze. È la differenza tra la somma delle vacanze, trovate nelle righe
di Riporto e Inizio, e la somma delle vacanze giornaliere.
SpaceAfterMonth - Per indicare che ci deve essere una riga vuota (anno, mese o giorno a cui
si riferisce l'identificativo).
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Data

Colonna protetta. È utilizzata per l'inserimento della data del giorno.

 Festivo

Colonna per parametrizzare il giorno. Se la cella rimane vuota viene ripreso il valore impostato nelle
proprietà del file, oppure il valore definito con il codice W (vedi sotto).

I possibili valori sono:

Vuoto - giorno lavorativo.
0 - per impostare il giorno corrente come festivo (riga visualizzata in rosso).
Se è un giorno considerato generalmente "festivo", ma in cui sei tenuto a lavorare, devi inserire
"lavorativo".
1 - per impostare il giorno corrente come non lavorativo (riga visualizzata in blu).
2 - per impostare il giorno corrente come lavorativo. Sovrascrive il valore predefinito.
[0] - giorno festivo impostato in automatico, ripreso dalle proprietà file. Non viene indicato
alcun valore nella colonna Dovuto.
[1] - giorno non lavorativo impostato in automatico, ripreso dalle proprietà file. Non viene
indicato alcun valore nella colonna Dovuto.
W0 - per impostare il giorno corrente come festivo. Lo stesso giorno, nelle settimane successive
verrà impostato in automatico con il valore  (0).
W1 - per impostare il giorno corrente come non lavorativo. Lo stesso giorno, nelle settimane
successive verrà impostato in automatico con il valore  (1).
W2 - per impostare il giorno corrente come lavorativo. Lo stesso giorno, nelle settimane
successive verrà impostato in automatico con il valore  (2).
WR - per reimpostare il giorno corrente con il valore indicato nelle proprietà file.
WA - per reimpostare il giorno corrente con il valore indicato nelle proprietà file. Lo stesso
giorno, nelle settimane successive verrà impostato in automatico con il valore indicato nelle
proprietà file.

Descrizione giorno

Colonna utilizzata dal programma per l'inserimento automatico del nome del giorno in base alla data.
Se si desidera un testo diverso da quello riportato dal programma, inserire un testo preceduto dal
carattere # (es. #Natale, #Festa nazionale).

Descrizione

Colonna per inserire una descrizione aggiuntiva.

Codice1

Colonna per indicare un eventuale numero di cliente, progetto o altro.

Lavoro1 e Lavoro2

Le colonne Lavoro1 e Lavoro2 sono usate in particolare per registrare le ore di lavoro nel modello
Foglio ore - Registrazione semplificata . Inoltre nella versione di Banana Contabilità Plus possono
essere utilizzate per inserire delle ore di lavoro particolari (es. notti, festivi).
In parallelo a queste colonne si utilizzano anche le colonne di supplemento (vedi spiegazioni
sottostanti).

http://www.banana.ch/doc/it/node/9654
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Inizio1, Fine1, Inizio2, Fine2...

Queste colonne permettono di inserire l'ora di entrata e uscita. Vi possono essere più entrate e uscite
nello stesso giorno.
Il programma calcola il tempo di presenza e somma nelle colonne Totale e Differenza.

Malattia

Colonna per l'inserimento delle ore di assenza per malattia.

Vacanze

Colonna per l'inserimento delle ore di vacanza.

Servizio

Si possono inserire assenze obbligatorie, quali servizio militare, servizio civile o altro.

Aggiustamento

Colonna per l'inserimento di un valore di rettifica.

Altro

Si possono inserire altri tipi di assenze, non indicate nella colonna Servizio o Malattia o Vacanza.

Assenza

Colonna protetta. È utilizzata dal programma per il calcolo automatico della somma delle assenze.

%Supplemento

Si può inserire la percentuale di lavoro supplementare che viene retribuita diversamente.
Se nello stesso giorno si fanno sia ore senza supplemento che ore con supplemento, bisogna inserire i
tempi su due righe:

Aggiungi riga giorno
Sulla prima riga si indica il lavoro (inizio e fine) normalmente.
Nella seconda riga si indicano le ore supplementari e l'apposita percentuale.
Se si desidera il totale giornaliero direttamente nella tabella, si deve aggiungere una riga di
totale giornaliero.

Supplemento calcolato

La colonna è protetta. È utilizzata dal programma per calcolare il tempo supplementare, indicato nella
colonna Supplemento o Supplemento %.

Supplemento totale

La colonna è protetta. È utilizzata dal programma per calcolare il tempo totale supplementare,
indicato nella colonna Supplemento o Supplemento %.
Questo valore viene sommato nella colonna totale Ore.
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Totale

La colonna è protetta. È utilizzata dal programma per l'inserimento automatico della somma delle ore
di lavoro, supplementari, assenze e rettifica.

Codice Dovuto

La colonna serve, in caso di necessità, per modificare il valore del Dovuto (ore di lavoro dovute).
Se viene lasciata vuota, il valore del Dovuto viene ripreso in automatico giorno per giorno in base
alle impostazioni presenti nel menu File > Proprietà file > Inizio .
Se si desidera cambiare il valore del Dovuto dalla tabella Giornale:

Reimpostare il dovuto.
Codici da inserire nella colonna Codice Dovuto per reimpostare il dovuto giornaliero a partire
dalla riga in cui ci si trova. Occorre poi inserire il nuovo valore nella colonna Dovuto.

DS (Set Today) - Imposta le ore dovute del giorno corrente, senza modificare gli altri
giorni.
WS (Set Week Day) - Imposta le ore dovute per il giorno e per lo stesso giorno delle
settimane seguenti.
PS (Set Predefined) - Imposta le ore dovute per il giorno e per tutti i giorni successivi
senza una impostazione diversa. 

Codici di reset del dovuto giornaliero
WR (Reset Week Day) - Resetta il valore predefinito per il giorno della settimana.
WA (Reset All Week Days) - Resetta tutti i valori predefiniti relativi ai giorni della
settimana.
PR (Reset Predefined) - Resetta Predefinito generale. Toglie il valore predefinito
impostato precedentemente.
PA (Reset Predefined and Week Day) - Resetta il valore predefinito generale e quelli della
settimana. È come se si iniziasse tutto da nuovo.

Codice di reset del progressivo
RP (Restart progressive) - Fa ripartire da zero il valore della colonna Progressivo. Si
inserisce questo codice nella riga inizio mese, quando nel mese precedente, con lo
stipendio a ore, tutte le ore sono state pagate.

Dovuto

La colonna è protetta. Il programma calcola automaticamente la differenza tra le ore lavorate e quelle
dovute. A fine mese e anno vengono riportati anche i totali del Dovuto.

Se nella colonna Codice Dovuto non ci sono dei valori, il programma riprende, nella colonna
Codice Dovuto, i valori presenti  Proprietà file > Inizio.
Se nella colonna Codice Dovuto vengono inseriti dei codici (vedi paragrafo precedente), il
programma calcola il dovuto in base a questi codici.
Tutte le righe che nella colonna Festivo hanno 0 (festivo) o 1 (non lavorativo), nella colonna
Dovuto la cella è vuota.

Differenza

La colonna è protetta. Il programma calcola automaticamente la differenza tra le ore lavorate
(Totale) e quelle dovute (Dovuto). A fine mese e a fine anno vengono riportati anche i totali della
differenza.

http://www.banana.ch/doc/it/node/9085
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Progressivo

La colonna è protetta. Il programma calcola automaticamente la differenza progressiva tra le ore
lavorate (Totale) e quelle dovute (Dovuto). A fine mese e a fine anno vengono riportati anche i totali
della differenza progressiva.

Lavorato

La colonna è protetta. È utilizzata dal programma per il calcolo automatico della somma delle ore
lavorate.

Dettaglio

La colonna è protetta. È utilizzata dal programma per visualizzare in automatico i dettagli di lavoro
(es. progetti). Vedi dettagli Gestione Progetti.

Supplemento

Si può inserire il tempo di lavoro supplementare retribuito diversamente, in ore e minuti. Può essere
usato anche per gestire dei recuperi o delle penalità per ritardi o altro.

Suddivisione1 e Suddivisione2

Colonne che possono essere usate per tenere conto delle ore investite in progetti.

Ore nel formato decimale
Si possono inserire anche le ore nel formato digitale (1.5 = 1:30).

Se si inserisce un valore preceduto dal segno ">" o "<" (maggiore o minore), il programma lo
considera come un valore decimale e lo converte in ore e minuti:

"<1.50" viene convertito in 1:30
"<1.75" viene convertito in 1:45  un'ora e tre quarti.

Nel contatore ore, inserire il numero delle ore con il separatore decimale. Per esempio, se si
inserisce 1.75, il programma visualizza il valore in ore e minuti (1:45).

Visualizzazione nel formato digitale

Nell'info windows viene indicato anche il valore delle ore in decimali.
Nella stampa mensile certi valori sono anche indicati come decimali (questo perché i programmi
per la gestione dei salari lavorano spesso con i decimali).

Velocizzare l'inserimento
Posizionarsi sul giorno corrente.

La riga del giorno corrente è quella segnalata in giallo.
Menu Azioni > Vai a giorno.

Inserire l'ora di entrata e di uscita.
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Con il "." viene inserita l'ora del computer.
Se per esempio si inserisce +5 o -5 (o qualsiasi altro numero), il programma visualizza
l'ora attuale con 5 minuti in più o in meno rispetto all'ora del computer.

Ricopiare dalla settimana precedente.
Usare il menu Azioni > Ricopia, vengono ripresi gli orari della settimana precedente.
Riprendere il valore della riga precedente.
Usare il menu Azioni > Ricopia da sopra (o il bottone F4 o Cmd 4).
Autocompletamento Vacanze o Assenza.
Andare in modifica della cella (con uno spazio) e il programma suggerisce le ore dovute, meno
le ore già eseguite.

Blocchi colonne ore
Le colonne ore della tabella Giornale sono organizzate in blocchi, come spiegato qui di seguito.

Colonne ore lavorate

Sono le colonne che servono per indicare le ore di lavoro giornaliere.
Il tempo di lavoro effettuato nel giorno può essere inserito in due modi:

Come ore lavorate - vengono inseriti i dati nelle colonne Lavoro1 e Lavoro2.
Nella versione di Banana Contabilità Plus sono considerate ore lavorate tutte le colonne di tipo
contatore ore che iniziano con TimeWork.
Come orario di entrate e uscita - vengono inseriti i dati nelle colonne Inizio1, Fine1, Inizio2,
Fine2, ecc.
Il programma calcola il tempo trascorso.

Totale ore lavorate

Nella colonna Totale ore lavorate vengono sommate le ore indicate nelle colonne ore lavorate e
quelle indicate come orario di entrata e uscita.

Nella versione di Banana Contabilità Plus vi è anche la colonna totale Dettaglio. Se il Tipo Riga
contiene il valore "D"  le ore di lavoro vengono sommate nella colonna Dettaglio e non in quella
Totale. 

Ore supplementari

Queste colonne sono presenti solo nella versione di Banana Contabilità Plus.
Servono per inserire dei supplementi di ore. Per esempio, nel caso di lavoro festivo o notturno che
comporta una maggiorazione.
Il Totale supplementare è la somma delle ore supplementari, indicate come ore, e quelle calcolate in
base a una percentuale.

Assenze

Le assenze vengono inserire nelle colonne  Malattia, Vacanza, Servizio o Altro, a secondo del caso.
Queste ore vengono sommate nella colonna Assenza (TimeAbsenceTotal) e poi nella colonna Totale.
Nel calcolo della differenza fra le ore dovute, le assenze sono considerate come retribuite.
Nella versione di Banana Contabilità Plus tutte le colonne di contatore tempo che iniziano con
TimeAbsense vengono sommate nel totale assenze. L'utente può aggiungere le colonne assenze per
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altre casistiche.
Se si vuole tenere nota delle assenze che non devono essere sommate nel Totale ore, si devono
aggiungere delle colonne di tipo Contatore ore.

Aggiustamenti

È una colonna che serve per degli aggiustamenti contabili, come nel caso in cui siano state fatte delle
ore supplementari e queste vengano pagate; quindi per scalarle dal totale si inserisce il valore con il
segno negativo nella colonna Aggiustamenti.

Il Totale ore

È la somma delle ore complessive, considerate come ore da conteggiare e come parte del dovuto.
Comprende le seguenti colonne:

Totale ore lavorate.
Totale supplementi.
Totale assenze.
Aggiustamenti.

Le ore dovute

Il Foglio di calcolo permette d'indicare le Ore dovute. Nel caso di un contratto con Stipendio fisso , si
indicano le ore dei giorni lavorativi per contratto.
Nel caso di retribuzione ad ore, senza un numero di ore prefissate incluse nel contratto, la parte ore
dovute non viene generalmente usata.

Nella colonna Dovuto è indicato il tempo di lavoro giornaliero del  dipendente. Il valore è indicato in
base a diversi parametri (vedi colonne tabella Giornale ):

Le impostazioni delle ore di lavoro, indicate nella Proprietà file > Inizio .
La colonna Festivo.
Il programma completa il valore dovuto solo per i giorni indicati come Lavorativo. 
La colonna Tipo Dovuto
Indicando un codice si può impostare diversamente il contenuto della colonna Dovuto
giornaliero.

Differenza e Progressivo ore

Nella colonna Differenza, il programma indica la differenza in ore fra il Totale e il Dovuto.
Nella colonna Progressivo, il programma indica la differenza cumulata.
Se non è stato indicato alcun Dovuto, il Progressivo corrisponde alla somma delle ore lavorate. Questo
valore può essere azzerato inserendo, nella colonna Tipo Dovuto, il codice RP (Restart progressive).

Suddivisione

Sono delle colonne informative che servono per indicare ore destinate a dei progetti.

Tabella Giornale - Colonne supplementari
In Banana Contabilità Plus  sono state aggiunte delle colonne per il calcolo del supplemento (festivo,
notturno) e per la gestione di più righe per lo stesso giorno.

https://old.banana.ch/doc/it/node/9619
https://old.banana.ch/doc/it/node/9047
https://old.banana.ch/doc/it/node/9085
https://www.banana.ch/it/node/11181
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Dettaglio

La colonna è protetta. È utilizzata dal programma per visualizzare in automatico i dettagli di lavoro
(es. progetti). Vedi dettagli Gestione Progetti.

Supplemento

Si può inserire il tempo di lavoro supplementare retribuito diversamente, in ore e minuti. Può essere
usato anche per gestire dei recuperi o delle penalità per ritardi o altro.

%Supplemento

Si può inserire la percentuale di lavoro supplementare che viene retribuita diversamente.
Se nello stesso giorno si fanno sia ore senza supplemento che ore con supplemento, bisogna inserire i
tempi su due righe:

Aggiungi riga giorno
Sulla prima riga si andrà a indicare il lavoro (inizio e fine) normalmente.
Nella seconda riga si indicheranno le ore supplementari e si indicherà l'apposita percentuale.
Se si desidera il totale giornaliero direttamente nella tabella, si dovrà aggiungere una riga di
totale giornaliero.

Supplemento calcolato

La colonna è protetta. È utilizzata dal programma per calcolare il tempo supplementare, indicato nella
colonna Supplemento o Supplemento %.

Supplemento totale

La colonna è protetta. È utilizzata dal programma per calcolare il tempo totale supplementare,
indicato nella colonna Supplemento o Supplemento %.
Questo valore viene sommato nella colonna totale ore.

Nuove colonne utente

Puoi aggiungere delle colonne che vengono poi totalizzate nei gruppi. Il nome Xml della colonna deve
essere di tipo contatore tempo e deve iniziare come segue:

TimeWork. Sommato nel totale lavoro.
TimeSurchargeManual. Sommato nel totale supplementi.
TimeAbsence. Sommato nel totale assenze.
TimeSplit. Sommato nel totale suddivisione se esiste.

Si possono definire le colonne per indicare le ore di un progetto, sommate anche nel TimeWork,
oppure, le  ore di assenze per formazione o altro, considerate assenze e conteggiate nel totale
assenze.
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Tempi e orari di lavoro

Il programma lavora sempre con ore e minuti, es. 8:30 significa 8 ore e 30 minuti.

Internamente i valori sono salvati come secondi e visualizzati poi nel formato ore e minuti.
Quando si inseriscono degli orari, i tempi sono arrotondati al minuto.

Ore nel formato decimale
Si possono inserire anche le ore nel formato decimale (1.5 = 1:30).

Se si inserisce un valore preceduto dal segno ">" o "<" (maggiore o minore), il programma lo
considera come un valore decimale e lo converte in ore e minuti:

"<1.50" viene convertito in 1:30
"<1.75" viene convertito in 1:45  un'ora e tre quarti.

Nel contatore ore, inserire il numero delle ore con il separatore decimale. Per esempio, se si
inserisce 1.75, il programma visualizza il valore in ore e minuti (1:45).

Visualizzazione nel formato decimale

Nell'info windows viene indicato anche il valore delle ore in decimali.
Nella stampa mensile certi valori sono anche indicati come decimali (questo perché i programmi
per la gestione dei salari lavorano spesso con i decimali).

Velocizzare l'inserimento
Posizionarsi sul giorno corrente.

La riga del giorno corrente è quella segnalata in giallo.
Menu Azioni → Vai a giorno.

Inserire l'ora di entrata e di uscita.
Con il "." viene inserita l'ora del computer.
Se per esempio si inserisce +5 o -5 (o qualsiasi altro numero), il programma visualizza
l'ora attuale con 5 minuti in più o in meno rispetto all'ora del computer.

Ricopiare dalla settimana precedente.
Usare il menu Azioni → Ricopia, vengono ripresi gli orari della settimana precedente.
Riprendere il valore della riga precedente.
Usare il menu Azioni → Ricopia da sopra (o il bottone F4 o Cmd 4).
Autocompletamento Vacanze o Assenza.
Andare in modifica della cella (con uno spazio) e il programma suggerisce le ore dovute, meno
le ore già eseguite.

Blocchi colonne ore
Le colonne ore della tabella Giornale sono organizzate in blocchi, come spiegato qui di seguito.

Colonne ore lavorate

Sono le colonne che servono per indicare le ore di lavoro giornaliere.
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Il tempo di lavoro effettuato nel giorno può essere inserito in due modi:

Come ore lavorate - vengono inseriti i dati nelle colonne Lavoro1 e Lavoro2.
Nella versione di Banana Contabilità Plus sono considerate ore lavorate tutte le colonne di tipo
contatore ore che iniziano con TimeWork.
Come orario di entrate e uscita - vengono inseriti i dati nelle colonne Inizio1, Fine1, Inizio2,
Fine2, ecc.
Il programma calcola il tempo trascorso.

Totale ore lavorate

Nella colonna Totale ore lavorate vengono sommate le ore indicate nelle colonne ore lavorate e
quelle indicate come orario di entrata e uscita.

Nella versione di Banana Contabilità Plus vi è anche la colonna totale Dettaglio. Se il Tipo Riga
contiene il valore "D"  le ore di lavoro vengono sommate nella colonna Dettaglio e non in quella
Totale. 

Ore supplementari

Queste colonne sono presenti solo nella versione di Banana Contabilità Plus .
Servono per inserire dei supplementi di ore per il tempo che va oltre le ore 24:00,  per esempio, nel
caso di lavoro festivo o notturno che comporta una maggiorazione di tempo superiore alla
mezzanotte. In questo caso le ore che vanno dalla mezzanotte in poi devono essere annotate come
ore complessive nella colonna Supplemento (TempoSupplementoManuale). Questa colonna può
essere visualizzata dal menu Dati → Disponi colonne.
Nella colonna Totale viene riportato il totale delle ore lavorate, incluse le ore inserite nella colonna
Supplemento.

Assenze

Le assenze vengono inserire nelle colonne  Malattia, Vacanza, Servizio o Altro, a secondo del caso.
Queste ore vengono sommate nella colonna Assenza (TimeAbsenceTotal) e poi nella colonna Totale.
Nel calcolo della differenza fra le ore dovute, le assenze sono considerate come retribuite.
Nella versione di Banana Contabilità Plus tutte le colonne di contatore tempo che iniziano con
TimeAbsence vengono sommate nel totale assenze. L'utente può aggiungere le colonne assenze per
altre casistiche.
Se si vuole tenere nota delle assenze che non devono essere sommate nel Totale ore, si devono
aggiungere delle colonne di tipo Contatore ore.

Aggiustamenti

È una colonna che serve per degli aggiustamenti contabili, come nel caso in cui siano state fatte delle
ore supplementari e queste vengano pagate; quindi per scalarle dal totale si inserisce il valore con il
segno negativo nella colonna Aggiustamenti.

Il Totale ore

È la somma delle ore complessive, considerate come ore da conteggiare e come parte del dovuto.
Comprende le seguenti colonne:

Totale ore lavorate.

https://www.banana.ch/it/node/11221
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Totale supplementi.
Totale assenze.
Aggiustamenti.

Le ore dovute

Il Foglio di calcolo permette d'indicare le Ore dovute. Nel caso di un contratto con Stipendio fisso, si
indicano le ore dei giorni lavorativi per contratto.
Nel caso di retribuzione ad ore, senza un numero di ore prefissate incluse nel contratto, la parte ore
dovute non viene generalmente usata.

Nella colonna Dovuto è indicato il tempo di lavoro giornaliero del  dipendente. Il valore è indicato in
base a diversi parametri (vedi colonne tabella Giornale):

Le impostazioni delle ore di lavoro, indicate nella Proprietà file → Inizio.
La colonna Festivo.
Il programma completa il valore dovuto solo per i giorni indicati come Lavorativo. 
La colonna Tipo Dovuto
Indicando un codice si può impostare diversamente il contenuto della colonna Dovuto
giornaliero.

Differenza e Progressivo ore

Nella colonna Differenza, il programma indica la differenza in ore fra il Totale e il Dovuto.
Nella colonna Progressivo, il programma indica la differenza cumulata.
Se non è stato indicato alcun Dovuto, il Progressivo corrisponde alla somma delle ore lavorate. Questo
valore può essere azzerato inserendo, nella colonna Tipo Dovuto, il codice RP (Restart progressive).

Suddivisione

Sono delle colonne informative che servono per indicare ore destinate a dei progetti.
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Gestione vacanze nel Foglio ore

Le vacanze sono determinate in ore e si inseriscono nella tabella Giornale, colonna Vacanze.

Riporto vacanze
Quando si crea un nuovo anno, le eventuali vacanze riportate dall'anno precedente si devono indicare
nelle Proprietà file → Inizio.
Il valore viene quindi inserito automaticamente nella riga Riporto, colonna Vacanze della tabella
Giornale.

Vacanze o congedi pagati definiti per contratto
Se nell'orario di lavoro sono già comprese delle vacanze:

Indicare nella riga Inizio anno (es. Inizio 2020) le ore di vacanza.
Inserire nella colonna Vacanze il numero di ore di vacanze come da contratto. (es. per 20
giorni di 8 ore, inserire 160, oppure 80 ore nel caso si lavori al 50%).

Giornate di congedo pagate, considerate come vacanza.
Inserire nella riga Inizio mese il numero di ore di congedo spettanti (giorni x ore giornaliere).

Impostazione vacanze o congedi
Le righe di inizio servono a indicare il numero di vacanze concesse in ore e minuti. Si possono indicare
le vacanze sia nella riga di Inizio anno o in quelle di Inizio mese.

Se una persona ha diritto a 4 settimane di vacanza e lavora 40 ore alla settimana: 40*4=160. Questo
valore deve essere indicato nella riga Inizio anno.

Se durante l'anno cambiano le ore di vacanze assegnate, nella riga Inizio mese, colonna Vacanze,
inserire il numero di ore in più o in meno (segno negativo) a disposizione.

La colonna Vacanze può anche essere usata per indicare dei congedi retribuiti.

Vacanze effettuate o pagate
Nella colonna Vacanze delle righe giornaliere, indicare il numero di ore di vacanze effettuate o
pagate.

Vacanze rimanenti
Nelle righe di Totale vengono indicate le ore di vacanze rimanenti, calcolate in automatico dal
programma.

Se le vacanze vengono pagate:

Nella riga iniziale del mese successivo inserire le ore di vacanza pagate con il segno negativo. 
Nella colonna Note indicare ad esempio "Vacanze pagate".
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Cambiamenti durante l'anno
Se durante l'anno viene cambiato l'orario di lavoro o ci sono interruzioni che modificano le ore di
vacanze, queste devono essere calcolate e modificate manualmente.
La differenza in più o meno può essere inserita nella riga di inizio mese dove avviene il cambiamento.
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Inserire orario di lavoro

Gli orari di lavoro e altri dati si inseriscono nella tabella Giornale .

Nella riga Riporto, il programma riporta le ore di vacanza dall'anno precedente, inserite nelle
Proprietà File (Dati base) > dialogo Inizio.

Nella tabella Giornale i dati possono essere modificati e inseriti secondo le esigenze.

Scrivi le ore di ferie a cui hai diritto nell'anno corrente.1.
Includi, modifica, aggiungi, personalizza qualunque festività, se necessario.2.
Inserisci le tue ore giornaliere di lavoro, malattia, ferie, ecc.3.

Stampa il tuo report mensile
Se vai nel menu Report > Report mensile..., puoi immediatamente generare, stampare e salvare
un report mensile completo.

http://www.banana.ch/doc/it/node/9047
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Link utili
Tabella Giornale
Tipologie di stipendio (Stipendio fisso o Stipendio a ore)
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Menu Report e Azioni del Folgio Ore

Per ottimizzare e velocizzare il lavoro con il Foglio ore di Banana Contabilità, sono stati implementati i
menu Report e Azioni, con cui si accede a diverse funzionalità.

Menu Report

Report mensile...

Dal menu Reports si attiva il comando Report mensile, per creare mese per mese il report mensile del
tempo di lavoro e altri dati inseriti nel Giornale (vacanze, assenze, altro).

Menu Azioni
Dal menu Azioni si possono attivare i seguenti comandi:

Vai ad oggi

Posiziona il cursore sulla riga odierna.

Ricontrolla tutto... (F9)

Il programma ricalcola, ricontrolla e visualizza eventuali errori o differenze.
Usare questo comando tutte le volte che si hanno dei dubbi che ci sia un problema.

Ordina giornale

Ordina per data le righe della tabella Giornale.

Check-in o Chek-out

Inserisce l'orario attuale nella cella selezionata. In alternativa, si può digitare il "." (punto senza
virgolette) nella cella selezionata di inizio o fine.

Ricopia giorno (dalla settimana precedente)

Riprende il tempo di lavoro e l'assenza del giorno corrente con i valori del giorno della settimana
precedente.

Ricopia settimana (dalla settimana precedente)

Riprende il tempo di lavoro e l'assenza della settimana corrente con i valori dei rispettivi giorni della
settimana precedente.

Aggiungi riga giorno 

Aggiunge una riga successiva con la stessa data di quella selezionata. Il comando viene utilizzato per
inserire ulteriori valori giornalieri.
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Aggiungi riga totale giorno

Aggiunge una riga dove vengono totalizzati i valori giornalieri.

Crea righe per periodo...

Aggiunge delle righe (giornaliere, inizio, totale, saldi e riporti) in base al periodo selezionato. Tutte le
righe del Giornale vengono ordinate per data.

Crea nuovo anno

Crea un nuovo file Foglio ore per l'anno successivo. Il programma imposta in automatico il nuovo file
riportando i valori iniziali del saldo vacanze e ore dell'anno precedente.
Attenzione! Quando si crea un nuovo anno i giorni festivi potrebbero essere diversi dall'anno
precedente. È necessario controllarli e modificarli manualmente. In alternativa, Banana.ch SA mette a
disposizione diversi modelli ogni anno con le festività nazionali già impostate per alcune nazioni.

Importa foglio ore

Riprende i valori da un foglio ore esterno.  Si indica il file da cui riprendere i valori e si specifica quali
valori riprendere.

Il programma cerca nel file importato le righe con data e sezione uguali, e riprende i valori.
Se nel file importato ci sono più righe per la stessa data, i valori successivi alla prima riga non sono
importati.
La finestra di dialogo permette di scegliere una delle seguenti opzioni:

Importa solo festivo

Riprende solo i valori della colonna Festivo.

Importa tutti i valori

Riprende i valori Festivo, Note, Lavorato, Assenze, Aggiustamento, Dovuto e Suddivisione.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 1044

Inserimento valori

Ore nel formato decimale
Il programma lavora sempre con ore e minuti 8:30 significa 8 ore e 30 minuti.
Si possono però anche inserire le ore nel formato decimale (1.5 = 1:30).

Se si inserisce un valore preceduto dal segno ">" o "<" (maggiore o minore), il programma lo
considera come un valore decimale  lo converte in ore e minuti:

"<1.50" viene convertito in 1:30
"<1.75" viene convertito in 1:45  un ora e tre quarti.

Nei contatore ore inserire il numero delle ore con il separatore decimale. Per esempio se si
inserisce 1.75, il programma visualizza il valore in ore e minuti (1:45).

Visualizzazione nel formato digitale

Nell'info Windows viene indicato anche il valore delle ore in decimali.
Nella stampa mensile certi valori sono anche indicati come decimali (questo perché i programmi
dei salari lavorano spesso con i decimali).

Velocizzazione inserimento
Posizionarsi sul giorno corrente

La riga del giorno corrente corrente è quella in in giallo.
Menu Utilità -> Vai a giorno.

Inserisci l'ora di entrata e uscita.
Con il "." viene inserita l'ora del computer.
Se inserisci +5 o -5 (o qualsiasi altro numero) il programma visualizza l'ora attuale con 5
minuti in più o in meno rispetto all'ora del computer.

Ricopia dalla settimana precedente
Usare i comandi menu Utilità1-> Ricopia si riprendono orari della settimana precedente.
Riprende il valore della riga precedente
Comando Riprendi da sopra (o il bottone F4 o Cmd 4)
Autocompletamento Vacanze o Assenza
Andare in modifica della cella (con uno spazio) e il programma suggerisce le ore dovute, meno
le ore già eseguite.
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Gestione progetti

Il Foglio ore si presta bene anche per prendere nota delle ore lavorate su progetti.

Nella Versione Experimental sono state aggiunte ulteriori possibilità proprio per facilitare la gestione
dei progetti.

Il Foglio di calcolo offre diverse possibilità, si deve scegliere quella che fa al proprio caso,
eventualmente combinando gli approcci. .

Attribuire i tempi con le colonne suddivisioni
Con questo approccio, la tenuta delle ore avviene normalmente con le normali colonne (Lavoro o ora
entrata e uscita). Nelle colonne Suddivisioni indichi le ore da attribuire a un determinato progetto.

Ci sono due colonne predefinite per la suddivisione e puoi ovviamente aggiungere altre colonne
(Tipo contatore) per altri progetti. 
Nelle righe di totale si ha poi la somma per ogni progetto.
Nella riga Riporto puoi inserire manualmente il riporto per ogni progetto. 

Nella versione Experimental se aggiungi una colonna con il nome TimeSplitTotal, di tipo contatore
tempo, il programma somma tutte le colonne il cui nome campo XML inizia con TimeSplit.
Se vuoi il totale giornaliero di tutti le suddivisioni, quando aggiungi una nuova colonna dagli il nome
XML che inizia con TimeSplit (per esempio TimeSplitP1, TimeSplitProjectX).

Inserire le ore nelle colonne Lavoro (TimeWork)
Puoi usare le colonne Lavoro1 e Lavoro2 per inserire le ore lavorate al progetto. Le ore del progetto
andranno a sommarsi alle ore di lavoro giornaliero.

Nelle righe di totale avrai la somma di ogni progetto.

Nella versione Experimental se aggiungi delle colonne di tipo contatore tempo,  che iniziano con
TimeWork, verranno anche queste sommate nella colonna Lavoro totale. Hai la possibilità quindi di
aggiungere quante colonne progetto ti servono.

Più righe giornaliere per lo stesso giorno
Nel Foglio ore puoi avere diverse righe dello stesso giorno.

Puoi creare una riga per ogni progetto. Se sullo stesso giorno lavori su più progetti dovrai
aggiungere una nuova riga, con la stessa data del giorno.
A partire dalla seconda riga dello stesso giorno, la descrizione risulterà leggermente rientrata.
Per aggiungere una nuova riga puoi usare la funzione duplica riga.
Nella versione Experimental c'é il comando per aggiungere una riga giornaliera e anche la riga
di totale giorno.

Righe di Dettaglio

Nella versione Experimental è stata aggiunta una colonna RigaTipo. Se in questa colonna inserisci il
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valore "D" (Dettaglio), le ore di lavoro inserite in questa riga, sono sommate nella colonna Dettaglio
totale, invece che nella colonna Totale.

Nella riga giornaliera normale inserisci le ore di lavoro effettive, anche con ora inizio e fine.
Nelle righe supplementari di Dettaglio, inserisci le ore per i singoli progetti. Puoi indicarli come ora
inizio o fine o anche inserendo le ore nella colonna Lavoro (TimeWork).

Se usi le colonne TimeWork è meglio non usare delle colonne diverse per inserire le ore effettuate e
quelle dei progetti, in questo modo nel totale giornaliero o mensile avrai le somme separate.

Stampe

Per il momento non vi sono ancora stampe che raggruppano i valori per progetto inseriti su righe
diverse. Si prevede che verranno create in futuro.
Se sai programmare in Javascript puoi creare delle stampe come desideri e anche metterli a
disposizione di altri.

Aggiunta Tabella Progetti, Categorie
Nella Versione Experimental puoi aggiungere delle Tabelle Progetti e Categorie, dove indicare l'elenco
progetti.

Nella tabella Giornale ti troverai una colonna dove, per ogni riga, inserire il codice del progetto o della
categoria.

Puoi anche aggiungere altre tabelle e collegarli con la tabella Giornale, per codificare altri valori.



BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 1047

Stampe

Stampa tabella Giornale
Dal menu File → Stampa, puoi stampare:

Tutte le righe della tabella Giornale.
Le righe selezionate della tabella Giornale.

 Report mensile
Dal menu Reports → Report mensile... il programma calcola e visualizza un report riassuntivo del
periodo selezionato con le colonne principali utilizzate.

Se nella stampa si vogliono cambiare le intestazioni delle colonne, si devono cambiare nella
tabella Giornale. Saranno riprese automaticamente.
Il programma stampa le colonne predefinite.
Per il momento nella  stampa del report mensile non è possibile stampare altre colonne.

Estensioni
Riepilogo mensile con totale ore giornaliere .
Ti permette di avere un riepilogo di tutte le ore mensili, in modo riassuntivo e nel formato
decimale.

https://www.banana.ch/apps/it/node/9353
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Stipendio fisso

Con il Foglio ore gratuito di Banana Contabilità Plus inizi con facilità a registrare i tempi di
lavoro, le tue vacanze e le assenze e conoscere all'istante totali e saldi di tutti i dati.

A secondo di quanto stipulato nel contratto:

Si imposta il tempo di lavoro dovuto (concordato) e le vacanze incluse.
Si inseriscono i tempi di lavoro e le assenze effettive.
Il programma calcola il saldo giornaliero e progressivo. 

Tutti i valori, tempo dovuto, ore effettuate, assenze e vacanze sono inseriti e visualizzati come
ore:minuti (es. 10:30).
Questo approccio uniforme, permette d'inserire i dati velocemente e di capire istantaneamente la
situazione.
I valori inseriti sono controllati dal programma. Se si inserisce un valore non corretto ci si accorge
immediatamente.

Impostazione del tempo dovuto
Il Foglio ore, nelle Proprietà File - Inizio, consente d'impostare velocemente l'orario di lavoro
settimanale. 
Se l'orario previsto è diverso o cambia durante l'anno, si può adattarlo, vedi Imposta il periodo e i
tempi di lavoro.

Le Vacanze previste vengono invece impostate direttamente nelle colonna Vacanze della tabella
Giornale.
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Inserimento dei tempi di lavoro e assenze
Nella tabella Giornale, nelle colonne apposite inserire i valori giornalieri, relativi ai dati seguenti:

Le ore di lavoro effettuate, si inseriscono come segue:
Tempi di entrata e uscita (raccolta sistematica)
Il programma calcola le ore e i minuti di lavoro.
Le ore di lavoro, Colonne lavoro 1 o 2
Si inseriscono le ore complessive lavorate.
Se si inseriscono valori sia di entrata e uscita e ore di lavoro, il programma le somma.

Le ore di assenza (Malattia, Vacanza, Servizio, Altro).
Sono ore che vanno comunque a dedursi dalle ore dovute.
Rettifiche.
Quando si necessitano degli aggiustamenti contabili, inserire un valore positivo o negativo nella
colonna Aggiustamenti.
Per esempio quando vengono pagate delle ore supplementari, si inseriscono le ore in negativo,
così che il progressivo viene ridotto. 

Iniziare il lavoro durante l'anno
Quando il periodo lavorativo inizia durante l'anno, per azzerare le ore dovute dal primo di gennaio fino
alla data di inizio lavoro, procedere come segue:

Al 1 gennaio, nella riga corrispondente e nella colonna Codice dovuto, inserire WA. Il
programma  azzera le ore totali per tutti i giorni che precedono l'inizio del periodo lavorativo.

Sulla riga della data di inizio lavoro, e per tutti i giorni lavorativi della prima settimana, indicare
WS nella colonna Codice dovuto e nella colonna Dovuto il numero di ore lavorative. Il
programma completerà in automatico le ore dovute per tutte le settimane fino a fine anno.
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Cambiare i giorni lavorativi durante l'anno

Se durante l'anno cambiano i giorni lavorativi, le nuove impostazioni dei giorni lavorativi non devono
essere modificate nelle Proprietà file, altrimenti la modica viene applicata retroattivamente dal primo
di gennaio, ma direttamente nella tabella Giornale utilizzando appositi codici. Sono possibili più
cambiamenti durante l'anno.

Se un giorno lavorativo diventa non lavorativo:

Sulla riga del giorno che si intende modificare (da giorno lavorativo a giorno non lavorativo),
nella colonna Festivo inserire il codice W1. Il programma, affinché possa riprendere la modifica
come giorno non lavorativo per tutte le settimane dell'anno, è necessario inserire il codice
WS, nella colonna Codice dovuto.

Se un giorno non lavorativo diventa lavorativo:

Sulla riga del giorno che si intende modificare (da giorno non lavorativo a giorno lavorativo),
nella colonna Festivo inserire il codice W2. Il programma, affinché possa riprendere la modifica
come giorno lavorativo per tutte le settimane dell'anno, è necessario inserire il codice WS,
nella colonna Codice dovuto.

Per le altre personalizzazioni consultare la spiegazione delle colonne Tabella Giornale.

Cambiare la percentuale di lavoro durante l'anno

Se durante l'anno aumentano o diminuiscono le ore lavorative dovute, le nuove impostazioni devono
essere inserite nella tabella Giornale, nelle colonne Codice dovuto e Dovuto.

Alla data in cui devono essere attuate le modifiche (esempio da 5 ore lavorative diventano 8):

Nella colonna Codice dovuto, inserire il codice WS.
Nella colonna Dovuto, inserire le ore attuali dovute (8).

Il programma riprende la modifica delle nuove ore dovute per tutte le settimane dell'anno.

Per altre personalizzazioni consultare la spiegazione della colonna Codice Dovuto.

Se cambiano le ore di vacanze a disposizione durante l'anno, le differenze devono essere calcolate e
modificate manualmente. Vedi Cambiamenti durante l'anno.
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Più righe per gli stessi giorni
Si possono avere più righe per lo stesso giorno lavorativo, dove è possibile inserire diversi valori
giornalieri. Per fare capire che è la stessa riga del giorno, nelle successive righe dello stesso giorno la
descrizione si presenta rientrata.

Ci sono diverse possibilità per creare una riga aggiuntiva per lo stesso giorno:

Dal menu Modifica → Duplica righe...
Dal menu Modifica → Aggiungi righe vuote..., inserendo la data del giorno (bisogna togliere
la protezione dalla colonna data).
Dal menu Azioni → Aggiungi riga giornaliera (solo nella versione di Banana Contabilità Plus

).

La differenza rispetto al dovuto e i totali
Nella Tabella Giornale il programma visualizza dopo ogni inserimento i seguenti dati:

La differenza tra le ore dovute e le ore lavorate del giorno.
Il saldo  progressivo.
Il totale per mese, anno e totale complessivo delle diverse colonne ore e colonne numeriche
Il totale per le vacanze è dato dalla differenza fra le vacanze impostate all'inizio dell'anno e
quelle usufruite, vedi pagina Vacanze.
Il riporto a fine mese e dell'anno delle diverse colonne numeriche:

Il riporto è il totale della posizione, tenendo conto anche dei valori dei periodi precedenti.
Alla fine del mese si conosce anche quante ore si sono fatte dall'inizio dell'anno.
Il totale finale è uguale al riporto.

Stampa mensile
La stampa mensile presenta tutti i valori in modo riassuntivo.

Aggiustamenti e pagamento ore accumulate
La colonna Aggiustamenti permette di modificare il totale ore dovute/lavorate.

Se si accumulano delle ore e queste vengono pagate:
Nella riga del giorno in cui vengono pagate

Inserire nella colonna Aggiustamento le ore pagate in negativo.
Nelle note indicate "Pagamento Ore accumulate"
Il saldo progressivo diminuisce.

Se vengono pagate delle vacanze accumulate:
Nella riga del giorno in cui le vacanze sono pagate.

Inserire nella colonna Vacanze le ore pagate in negativo.
Nelle note indicate "Pagamento vacanze accumulate"
Il saldo progressivo diminuisce.

https://www.banana.ch/it/new
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Stipendio a ore

Il Foglio ore gratuito di Banana Contabilità Plus è semplice e veloce nell'inserimento dei dati e ti
fornisce immediatamente il totale delle ore giornaliere, mensili e annuali.

Tutti i valori (tempo dovuto, ore effettuate, assenze e vacanze...) sono inseriti e visualizzati come
ore:minuti (10:30).
Questo approccio uniforme permette d'inserire i dati velocemente e il controllo automatizzato del
programma permette di avere dei report corretti.

  L'applicativo permette d'indicare i giorni e le ore concordate come da contratto e le ore di lavoro
effettuate, evidenziando eventuali differenze tra il  pattuito e l'effettuato. Il Report mensile da
consegnare al proprio datore di lavoro è completo e conforme alle esigenze legali.

Consultare la pagina Come iniziare.

Il Foglio ore si adegua a qualsiasi genere di orario lavorativo, fisso, flessibile, part-time, o con
impostazioni combinate.

Impostare l'orario di lavoro settimanale
Nel menu File → Proprietà file → Inizio indicare i giorni di lavoro e l'orario di lavoro settimanale.

Con lo stipendio a ore sono conteggiate le ore effettivamente lavorate.

Se sono state concordate le ore di lavoro giornaliere, è possibile indicarle come ore dovute,
come per lo Stipendio fisso. In questo modo il programma calcola e visualizza le differenze fra il
concordato e l'eseguito.
Se l'orario di lavoro previsto è diverso, o cambia durante l'anno, si può adattarlo come indicato
nei paragrafi successivi.
Le vacanze previste vengono invece impostate direttamente nella colonne tabella Giornale.

Inserimento dei tempi di lavoro e assenze
Nello stipendio a ore, le ore di lavoro effettuate vengono inserite nella tabella Giornale, con una delle
seguenti modalità:
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Inserire l'ora di inizio e di fine nelle corrispondenti colonne (raccolta sistematica).
Il programma calcola le ore e i minuti di lavoro nella colonna Totale.
Inserire le ore complessive lavorate nelle colonne Lavoro 1 o 2.

Se sono state utilizzate le colonne Inizio, Fine e anche la colonna Lavoro 1 o 2, il programma
somma tutte le ore complessive nella colonna Totale.

Nel caso in cui sono state indicate le ore dovute nelle Proprietà file, nella colonna Progressivo
vengono indicate le differenze tra quelle lavorate e dovute.

Le ore di assenza per malattia,  vacanza, servizio o altro, inserite nelle rispettive colonne, sono
sommate nelle ore dovute.

Rettifiche
Quando sono necessari degli aggiustamenti contabili, le ore di rettifica devono essere inserite nella
colonna Aggiustamento, con un valore positivo o negativo.
Per esempio, quando vengono pagate delle ore supplementari, nella colonna Aggiustamento, si
inseriscono le ore in negativo, affinché nella colonna del Progressivo, le ore vengano ridotte.

Iniziare il lavoro durante l'anno
Quando il periodo lavorativo inizia durante l'anno, per azzerare le ore dovute, dal primo di gennaio
fino alla data di inizio lavoro, procedere come segue:

Al 1 gennaio, nella riga corrispondente e nella colonna Codice dovuto, inserire WA. Il
programma  azzera le ore totali per tutti i giorni che precedono l'inizio del periodo lavorativo.

Sulla riga della data di inizio lavoro, e per tutti i giorni lavorativi della prima settimana, indicare
WS nella colonna Codice dovuto e nella colonna Dovuto il numero di ore lavorative. Il
programma completerà in automatico le ore dovute per tutte le settimane fino a fine anno.
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Cambiare i giorni lavorativi durante l'anno

Se durante l'anno cambiano i giorni lavorativi, le nuove impostazioni non devono essere modificate
nelle Proprietà file, altrimenti la modica viene applicata retroattivamente dal primo di gennaio, ma
direttamente nella tabella Giornale, utilizzando appositi codici. Sono possibili più cambiamenti
durante l'anno.

Se un giorno lavorativo diventa non lavorativo:

Sulla riga del giorno che si intende modificare (da giorno lavorativo a giorno non lavorativo),
nella colonna Festivo inserire il codice W1. Il programma, affinché possa riprendere la modifica
come giorno non lavorativo per tutte le settimane dell'anno,WS, nella colonna Codice
dovuto.

Se un giorno non lavorativo diventa lavorativo:

Sulla riga del giorno che si intende modificare (da giorno non lavorativo a giorno lavorativo),
nella colonna Festivo inserire il codice W2. Il programma, affinché possa riprendere la modifica
come giorno lavorativo per tutte le settimane dell'anno, necessita l'inserimento del codice
codice WS, nella colonna Codice dovuto.

Per le altre personalizzazioni consultare la spiegazione delle colonne Tabella Giornale.

Cambiare la percentuale di lavoro durante l'anno

Se durante l'anno aumentano o diminuiscono le ore lavorative dovute, le nuove impostazioni devono
essere inserite nella tabella Giornale, colonne Codice dovuto e Dovuto.

Alla data in cui devono essere attuate le modifiche (esempio da 5 ore lavorative diventano 8):

Nella colonna Codice dovuto, inserire il codice WS.
Nella colonna Dovuto, inserire le ore attuali dovute (8).

Il programma riprende la modifica delle nuove ore dovute per tutte le settimane dell'anno.

Per altre personalizzazioni consultare la spiegazione della colonna Codice Dovuto.

Se cambiano le ore di vacanze durante l'anno, le differenze devono essere calcolate e modificate
manualmente. Vedi Cambiamenti durante l'anno.
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Differenza rispetto al dovuto e i totali
Nella Tabella Giornale il programma visualizza dopo ogni inserimento:

La differenza dovuta giornaliera e quella progressiva.
Le ore in più o in meno rispetto al previsto.
Il totale per anno, mese e il totale generato dai valori immesse nelle varie colonne.
La differenza fra le vacanze impostate e quelle usufruite, vedi pagina Vacanze .
Il riporto a fine mese e dell'anno delle diverse colonne numeriche.
Il totale con la ripresa dei valori dei periodi precedenti.

Azzerare il saldo progressivo
Per l'azzeramento del saldo progressivo, inserire nella colonna Codice dovuto la sigla RP.

Vacanze
Vedi la pagina Vacanze.

Assenze e malattie
Inserisci le ore di assenza nelle colonne Malattia, Vacanze, Servizio o Altro.

Aggiungere km e spese
Per il rimborso chilometrico e spese che devono essere rimborsati, aggiungere una colonna nella
tabella Giornale, con il comando Menu Dati → Disponi colonne .

Se la colonna aggiunta è di Tipo Importo, il programma somma in automatico i valori nelle righe di
totale.

Rettifiche e pagamento ore accumulate e vacanze
La colonna Rettifiche permette di modificare il totale ore dovute/lavorate.

Se le ore straordinarie cumulate vengono retribuite,
Nella colonna Rettifiche inserire le ore pagate in negativo.
Nella colonna Note indicare Pagamento Ore straordinarie.

Se le ore di vacanze vengono retribuite, procedere come segue:
Nella colonna Vacanze inserire le ore pagate in negativo.
Nelle note indicare Pagamento vacanze non usufruite.

In entrambi i casi, il saldo progressivo viene aggiornato.

Più righe per gli stessi giorni
Se si necessita di avere più righe per lo stesso giorno, si possono aggiungere delle righe
supplementari, queste si distinguono per avere un rientro in automatico verso destra.

http://www.banana.ch/doc/it/node/9620
http://www.banana.ch/doc/it/node/2710
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Ci sono diverse possibilità per creare una riga aggiuntiva per lo stesso giorno:

Dal menu Modifica → Duplica righe...
Dal menu Modifica → Aggiungi righe vuote..., inserendo la data del giorno (bisogna togliere la
protezione dalla colonna data).
Dal menu Azioni → Aggiungi riga giornaliera  (solo nella versione di Banana Contabilità Plus).

Stampa mensile
La stampa mensile riassume tutti i valori.

http://www.banana.ch/it/new
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Gestire le ore dei progetti nel Foglio Ore

Con Banana Contabilità Plus  puoi iniziare facilmente a tenere il conteggio delle ore dedicate ai
progetti, ottenendo report immediati che puoi visionare in qualsiasi momento.

Gli utenti che hanno dei file creati con versioni precedenti devono convertire il proprio file.

Per gestire gli orari di lavoro per dei progetti occorre aggiungere le colonne necessarie nella tabella
Giornale.

Ci sono due modalità per gestire le ore dei progetti:

Lavorare con la tabella Progetti.1.
Lavorare con le colonne Lavoro1, Lavoro2, ecc.2.
 

Gestire i progetti con la tabella Progetti
Con questa modalità è necessario aggiungere la tabella Progetti:

Menu Strumenti → Aggiungi nuove funzionalità → Aggiungi tabella → Progetti.
Nella tabella Progetti sono presenti le seguenti colonne:

Id - inserire un Id unico per ogni progetto.
Descrizione - inserire la descrizione/nome del progetto.
Note - inserire eventuali note aggiuntive.

Con l'aggiunta della tabella Progetti nella tabella Giornale vengono aggiunte in automatico le
colonne Progetti Id e Descrizione progetti.

Nella tabella Giornale, utilizzando il menu Dati → Disponi colonne, vengono visualizzate le
seguenti colonne:

La  colonna RigaTipo (Tipo) - inserire D per separare il dettaglio delle ore dei progetti dal
totale delle ore lavorate.
La colonna TempoDettaglioTotale (Dettaglio) - è una colonna protetta. Se nella colonna
Tipo è stata inserita la D,  il programma calcola e visualizza separatamente il totale delle ore
dei progetti.
Se la colonna Tipo è vuota, il programma calcola e visualizza il totale delle ore dei progetti
nella colonna Totale.

Inserire ore progetti

Le ore dedicate ai progetti possono essere gestite all'interno del proprio foglio di lavoro.

Per separare le ore di lavoro fatte, dalle ore dei progetti, è necessario:

Posizionarsi sulla riga del giorno al quale si vuole aggiungere il progetto (o progetti).
Aggiungere una nuova riga dal menu Azioni → Aggiungi riga giorno.
Viene aggiunta una nuova riga con lo stesso giorno.
Nella colonna Tipo inserire D per separare il dettaglio delle ore dei progetti dal totale delle ore

https://www.banana.ch/it/node/11181
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lavorate. Lasciare vuoto se si desidera che il totale ore dei progetti venga sommato alle ore
lavorate, nella colonna Totale.
Inserire l'Id del progetto, come impostato nella tabella Id. Viene ripresa in automatico la
descrizione del progetto.
Inserire l'ora di inizio e quella di fine del progetto.

Il programma calcola e aggiorna le colonne del Totale, Dovuto, Differenza e Progressivo.

Gestire i progetti con le colonne Lavoro1, Lavoro2, ecc..
Per gestire le ore dei progetti, in alternativa alla tabella Progetti, è possibile utilizzare le colonne
Lavoro1, Lavoro2, ecc...

Ogni colonna è riferita alle ore di un progetto diverso. Il programma include due colonne predefinite,
ma è possibile aggiungere altre colonne a condizione che nella finestra Nuova colonna  (menu
Dati → Disponi colonne → Aggiungi) nel campo Nome Xml venga inserito TimeWork3,
TimeWork4...

Nella tabella Giornale, dal menu Dati → Disponi colonne, visualizza le seguenti colonne:

La  colonna RigaTipo (Tipo) - inserire D quando vuoi separare il dettaglio delle ore dei progetti
dal totale delle ore lavorate.
La colonna TempoDettaglioTotale (Dettaglio) - è una colonna protetta. Se nella colonna
Tipo è stata inserita la D,  il programma calcola e visualizza separatamente il totale delle ore
dei progetti.
Se la colonna Tipo è vuota, il programma calcola e visualizza il totale delle ore dei progetti
nella colonna Totale.

Inserire ore progetti

Le ore dedicate ai progetti possono essere gestite all'interno del proprio foglio di lavoro.

Per separare le ore di lavoro fatte, dalle ore dei progetti, è necessario:

Posizionarsi sulla riga del giorno al quale si vuole aggiungere il progetto (o progetti).
Aggiungere una nuova riga dal menu Azioni → Aggiungi riga giorno.
Viene aggiunta una nuova riga con lo stesso giorno.
Nella colonna Tipo inserisci D se per separe il dettaglio delle ore dei progetti dal totale delle
ore lavorate. Lasciare vuoto se si desidera che il totale ore dei progetti venga sommato alle ore
lavorate (colonna Totale).
Inserire l'ora di inizio e quella di fine del progetto.

Il programma calcola e aggiorna le colonne del Totale, Dovuto, Differenza e Progressivo.

Aggiungere altre colonne
Se nel progetto si necessita di tenere nota di strumenti usati, importi, km fatti o altro, tramite il menu
Dati → Disponi colonne si possono aggiungere delle colonne supplementari.

Queste possono anche essere collegate con una tabella aggiunta.
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Report con i dati di progetti e risorse
È possibile filtrare i progetti e le risorse e creare un report con i dati di ciascuno di essi.

https://www.banana.ch/apps/en/node/9438
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Informazioni sul Foglio ore per i datori di
lavoro

Il Foglio ore permette alle ditte, che non hanno un rilevamento automatizzato del tempo di lavoro, di
iniziare facilmente con un sistema moderno di raccolta dati e avere conteggi e report immediati,
senza perdite di tempo.

Le imprese, a tutela dei propri dipendenti, sono obbligati per legge a istituire un sistema di
rilevamento del tempo di lavoro giornaliero, completo di assenze e vacanze.

In Europa questo principio è stato ribadito in una sentenza della Corte Europea di giustizia . È
compito degli stati membri regolamentare la questione.
In Svizzera vi sono delle ordinanze  al riguardo che prevedono l'obbligo di rilevazione
sistematica del tempo di lavoro, con alcune eccezioni per il rilevamento semplificato (solo il
numero di ore lavorate).

Come implementare il Foglio ore per i propri dipendenti
Ogni dipendente deve scaricare e installare Banana Contabilità  sul proprio computer, tablet o
telefonino.
Il dipendente crea un proprio foglio ore per tutto l'anno.
Ci sono più modalità:

Usa il modello che gli è stato inviato per email dal datore di lavoro.
Avvia il programma e dal menu File → Nuovo crea un proprio Foglio ore, per tutto l'anno,
scegliendo il modello Foglio ore più appropriato.

Ogni dipendente inserisce le proprie ore di lavoro e salva il file sul proprio computer.
A fine mese il dipendente crea il proprio Report mensile e lo spedisce al datore di lavoro. In
alternativa può spedire direttamente tutto il file del proprio Foglio ore.

Auto-dichiarazione delle ore lavorate
Il Foglio ore di Banana Contabilità permette ad ogni dipendente d'inserire individualmente le proprie
ore e di avere sempre sotto controllo la situazione.
Il report di fine mese riassume tutte le informazioni necessarie. Se lo si desidera si possono anche
creare dei report specifici  per esigenze più complesse.

Inserimento dati centralizzato
Il Foglio ore si presta anche nel caso in cui è il datore di lavoro deve riprendere i dati delle ore
consegnate dai dipendenti in un sistema centralizzato. Si possono attribuire le ore a progetti o
quant'altro sia necessario. 

Prepara dei modelli per i dipendenti della tua ditta
Ogni ditta ha delle esigenze diverse. Per facilitare la tenuta delle ore dei dipendenti è utile preparare
dei file Foglio ore che servano da modelli, con le seguenti impostazioni:

I giorni festivi annuali.

https://www.ilsole24ore.com/art/l-orario-lavoro-corte-ue-imprese-obbligate-registrarlo-ogni-giorno-AC1IuYC
https://www.seco.admin.ch/seco/it/home/Arbeit/Arbeitsbedingungen/Arbeitnehmerschutz/Arbeits-und-Ruhezeiten/Arbeitszeiterfassung.html
https://www.banana.ch/it/node/11181
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Le colonne necessarie per il tipo di raccolta dati (sistematica, semplificata, mista).
Le colonne per il tipo di stipendio.
Le colonne assenze.
Si possono anche aggiungere ulteriori colonne per spese rimborsabili, progetti e annotazioni
sullo svolgimento del lavoro.

Rendiconti specifici
Le Estensioni permettono di creare dei report specifici alle esigenze di una ditta.

Modulo per datori di lavoro
Stiamo pensando di sviluppare un applicativo per i datori di lavoro che permetta di raccogliere e
consolidare i dati contenuti nei file, gestiti dai dipendenti a scopo di statistica  o altro.

Se vi fosse un interesse a uno strumento del genere ti preghiamo di segnalarcelo tramite il formulario
di contatto , indicando anche quali funzionalità ti interesserebbero.

Fai conoscere il Foglio ore gratuito
Se sei un'azienda o un dipendente soddisfatto, oppure, sei un'associazione padronale o sindacale o un
ente, puoi aiutare gli altri facendo sapere dell'esistenza del Foglio ore gratuito di Banana Contabilità.

Inserisci un link alla pagina di presentazione del Foglio ore per lavoratori dipendenti  
(https://www.banana.ch/it/node/11220 ) sul tuo sito internet, fai un post su Facebook o altri social
network. È utile quando lo citi, indicare anche i vantaggi principali.

https://www.banana.ch/it/contact_form
https://www.banana.ch/it/contact_form
https://www.banana.ch/it/node/11220
https://www.banana.ch/it/node/11220
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Registro beni ammortizzabili

Il registro beni ammortizzabili è un applicativo incluso in Banana Contabilità Plus. Permette una
facile gestione dei tuoi beni ammortizzabili e ottieni rapidamente tutti i valori che ti servono, nonché
le registrazioni di ammortamento a fine anno in automatico.

Tante le funzioni per facilitare il tuo lavoro:

Tenere l'elenco dei beni che devono essere ammortizzati in base alle normative fiscali.
Calcolare in automatico gli ammortamenti o per i casi speciali, adattare gli importi
manualmente.
Scegliere se avere ammortamenti mensili, trimestrali, semestrali o annuali.
Riprendere direttamente gli ammortamenti nella contabilità Banana.
Gestire altri cambiamenti di valore ( acquisti successivi,  vendite, dismissioni, o altro) relative a
ciascun bene.
Avere uno storico di tutti i cambiamenti di valore di ciascun bene.
Gestire altre informazioni relative a ciascun bene, come scadenza garanzia, assicurazione,
collocazione.

 

Link utili
Breve presentazione
Tutte le caratteristiche
Inizia un Registro beni ammortizzabili

https://cdn.banana.ch/portal/repodata/ghba/General/SampleFiles/FixedAssets/Italian/images/registro_beni_ammortizzabili_articoli_it.png
https://cdn.banana.ch/portal/repodata/ghba/General/SampleFiles/FixedAssets/Italian/images/registro_beni_ammortizzabili_articoli_it.png
https://www.banana.ch/it/registro-beni-ammortizzabili
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Caratteristiche del Registro beni
ammortizzabili

  Il Registro beni ammortizzabili è un applicativo di Banana Contabilità Plus per gestire in modo
facile e veloce i tuoi beni ammortizzabili e conoscere all'istante il loro valore iniziale, lo storico, e
l'ammortamento a fine anno.

È uno strumento molto flessibile, intuitivo e potente nei calcoli.

Lavori in tabelle come in Excel, molto intuitivo e con tutti i valori sempre visibili e aggiornati.
Hai a disposizione funzionalità che automatizzano i calcoli, ottenendo valori e saldi sempre
aggiornati:

Valore iniziale di acquisto.
Valore contabile.
Quota e percentuale di ammortamento.
Colonne per la data di acquisto e la durata della garanzia.
Giornale.
Report Articoli.

Ricerca immediata dei beni ammortizzabili
In caso di errori puoi  modificare e correggere per avere sempre ordine e precisione.
Applicativo utilizzabile in qualsiasi nazione.

Sostituto delle tabelle Excel per gli ammortamenti
Il registro Beni ammortizzabili è uno strumento molto preciso, ma anche malleabile che puoi adattare
perfettamente alle tue esigenze. Ti permette di automatizzare il calcolo degli ammortamenti, ma ti da
anche la possibilità di inserire gli ammortamenti manualmente, così che quanto ci sono casi
particolari o eccezioni, non sei obbligato a modificare formule e totali.
Il modo d'uso è ispirato a Excel, è quindi d'uso immediato e se sbagli puoi sempre modificare.
Risparmi tempo e grazie allo storico di tutte le modifiche hai una situazione chiara in caso di verifiche
fiscali.

L'applicativo può essere usato in abbinamento ad altri programmai di contabilità, sei
molto più flessibile e risparmi anche sui costi di licenza. Per ogni periodo (mese, trimestre,
semestre o anno) puoi avere una stampa del riassunto delle degli ammortamenti da registrare nel tuo
programma contabilità. Se desideri puoi anche esportare i dati.

Aggiungi quante righe vuoi senza limiti, o puoi eliminare le  righe di cui non hai bisogno.
Non hai bisogno d'inserire formule perché i calcoli vengono aggiornati immediatamente e hai
una visualizzazione contestuale (come nei fogli di calcolo).
Tutto quello che si vede può essere stampato o esportato in PDF o altri formati.
Le colonne sono personalizzabili, puoi modificarne la posizione, aggiungerne di nuove e
cambiarne la larghezza.
Lavora con il formato che ti è più congeniale.
Colora le righe per individuare subito gli articoli che ti interessano.
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Basato su tabelle
La gestione del Registro beni ammortizzabili si concentra su tre tabelle principali, che si usano in
modo simile a quelle di Excel, ma già completamente impostate e programmate con tutto quanto
serve per tenere la gestione del magazzino in modo veloce e sicuro. 

Tabella Articoli
È la tabella dove imposti tutti i beni soggetti ad ammortamento. Ogni articolo (o bene
ammortizzabile) ha un Id identificativo, una descrizione, un gruppo e un conto di appartenenza,
la contropartita e tutti i parametri di calcolo per gli ammortamenti.  Puoi creare liberamente i
gruppi degli articoli senza limiti. Visualizzando questa tabella hai immediatamente una visone
completa e aggiornata di tutti i tuoi beni ammortizzabili.
 
Tabella Registrazioni
In questa tabella vengono registrate tutte le operazioni che modificano il valore storico,
contabile o fiscale di un bene. È una tabella con delle colonne automatiche: selezionando il tipo
di ammortamento viene inserita in automatico la descrizione dell'operazione (vendita,
svalutazione, rivalutazione, ammortamento...); con la selezione dell'Id articoli viene inserita in
automatico la descrizione dell'articolo. Scorrendo la tabella si ha una visione completa di tutti
gli accadimenti durante l'anno. Se ti rendi conto di aver sbagliato puoi modificare per avere una
contabilità sempre perfetta.
 
Tipo di ammortamento
Questa tabella è destinata per inserire i codici di ammortamento affinché quando si acquista un
nuovo bene si possa decidere quale tipo di ammortamento attribuire: sul valore storico, valore
contabile, su uno specifico importo, ammortamento completo e nessun ammortamento. Una
volta stabiliti i codici, questi non devono essere cambiati per assicurare l'omogeneità e la
correttezza nei calcoli. La colonna dei codici è visibili sia nella tabella Articoli, sia in quella del
giornale per avere sempre sotto controllo quale ammortamento è stato calcolato. 
 
Tipo registrazioni
In questa tabella vengono definite le tipologie di operazione da riprendere nella tabella
Giornale. Ogni operazione ha un Id identificativo che non deve essere cambiato, affinché nella
tabella giornale venga ripresa sempre la stessa descrizione. Questo facilita e velocizza
l'inserimento dei dati nella tabella Giornale.

Impostazione contabile
Intestazioni e dati base del Registro beni ammortizzabili impostati in un'unica finestra di dialogo,
facile da visualizzare.

Intestazioni e indirizzo della ditta con testi liberi.
Impostazione della lingua.
Collegamento a estensioni per personalizzazioni.
Password per rendere sicuro il tuo file del Registro beni ammortizzabili.
Puoi avere più file in lingue diverse.

Gestione facile e precisa grazie alla logica contabile
A differenza delle tabelle di Excel, le modifiche di valore (ammortamenti, nuovi acquisti, svalutazioni)
non sono inseriti in colonne, ma in una tabella delle registrazioni.
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Nella tabella Articoli si elencano i singoli beni, con la data, valore di acquisto, tipo e
percentuale d'ammortamento e altri elementi.
Nella tabella Registrazioni si indicano gli ammortamenti, rivalutazioni o svalutazioni per ogni
singolo bene.

È lo storico di tutti i cambiamenti di valore del bene, dall'acquisto fino alla dismissione.
Il comando Crea righe d'ammortamento calcola gli ammortamenti in base alle
impostazioni della tabella Articoli e genera delle righe di registrazione.
Gli ammortamenti possono essere calcolati mensilmente, trimestralmente,
semestralmente o ogni anno.
I valori delle registrazioni possono essere inseriti e modificati manualmente. Puoi così
facilmente risolvere qualsiasi eccezione o caso particolare. 
Si possono inserire registrazioni per aumenti di valore, ammortamenti speciali, rettifiche
del valore fiscale o altro.

Le operazioni di ammortamento sono riprese nel file della contabilità con il comando Importa in
contabilità.

Ogni articolo ha diversi valori
Contrariamente alla contabilità, dove si tiene generalmente solo il valore contabile attuale, nel
registro beni ammortizzabili, per ogni articolo vengono tenuti diversi valori.

Si parte dal valore di acquisto iniziale, che è inserito manualmente nella tabella articoli.
Tutti gli altri valori sono calcolati dal programma aggiungendovi le variazioni inserite nella
tabella registrazioni.
Nella tabella Registrazioni per ogni tipo di variazione vi è una colonna apposita dove inserire il
valore.

Gli aumenti sono inseriti in positivo.
Le diminuzioni (come ammortamenti) sono inseriti in negativo.

Nella tabella articoli per ogni valore vi è il totale e la variazione.

 Valore iniziale (inserito manualmente nella tabella Articoli)
+ Acquisti. produzione propria di ammodernamento
- Vendite
= Valore d'acquisto del bene (L'esborso complessivo per l'acquisto).
+ Rivalutazioni  (per esempio a seguito dell'inflazione)

- Svalutazioni (cambiano il valore storico, diversi dagli ammortamenti che cambiano solo
quello contabile).

= Valore storico (base di calcolo per gli ammortamenti lineari)
+ Ammortamento inverso (storno ammortamento)
- Ammortamenti
= Valore contabile (base per calcolo ammortamenti sul valore residuo)
+ Aumento valore fiscale (ammortamenti non riconosciuti fiscalmente)
- Diminuzione valore fiscale
= Valore fiscale (valore riconosciuto dal fisco)

In questo modo il programma ha tutti gli elementi per calcolare in automatico gli ammortamenti.
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File e salvataggio dati
Hai tutti i dati salvati in un unico file, dove trovi facilmente tutto senza perdite di tempo.
Attribuisci al file il nome che desideri.
Puoi gestire un numero illimitato di file.
Salva i dati su qualsiasi supporto, computer, rete, cloud o inviali per email . Puoi accedervi
ovunque tu sia.
Accesso in contemporanea da più utenti, dove però solo una persona può aprire il file in
modifica.
Rendi più sicura la tua contabilità inserendo una protezione con password.

Movimentazione articoli
Nelle colonne hai la visualizzazione degli importi nel formato usato dal tuo computer, senza
doverti abituare ad altri formati a te non congeniali.
Scegli tu l'identificativo dell'articolo liberamente (conto numerico o alfa-numerico, fino a 256
caratteri).
Saldo, movimento dell'articolo e totali visualizzati contestualmente e sempre aggiornati.
Aggiunta di altre colonne per note, raggruppamento o altro.
Nella colonna Links puoi aggiungere un Collegamento digitale per l'articolo registrato (scontrino,
fattura di acquisto, garanzia).
In tutte le tabelle hai delle colonne colonne predefinite che puoi rendere visibili a scelta.
Il comando Cerca ti permette di cercare velocemente un articolo.
Puoi ordina le righe secondo diverse chiavi di ordinamento.
Esportazione in pdf per la conservazione dei dati ed esportazione in altri formati per una
rielaborazione dati.
Importazione di dati da altri programmi in formato Testo, Ascii e CSV, con le opzioni seguenti:

Importa dati dagli appunti.
Completamento automatico dei valori.
Intestazione colonne.
Unicode (Utf-8).

Colonne per l'archivio di prodotti non più disponibili.

Segnalazioni errori e controllo
Comando per controllare tutti i dati.
In un attimo, i valori vengono ricalcolati come se venissero inseriti nuovamente tutte le
operazioni.
Segnalazione di eventuali impostazioni sbagliate, differenze o errori.
Ogni segnalazione è collegata a una pagina di aiuto che spiega le cause e la soluzione.
Possibilità di correggere.

Report e stampe
Contenuto tabelle completamente stampabile o stampa anche solo per selezione.
Aggiunta del proprio logo per una personalizzazione dei documenti e delle stampe.
Disposizione colonne personalizzabile.
Report registrazioni contabili
Visualizza giornale (schede articoli).

https://www.banana.ch/it/node/11059
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Esportazione e archiviazione dati

Copia e incolla direttamente da e per Excel.
Esportazione tabelle in pdf e diversi altri formati.
Archiviazione delle stampe e dei dati in pdf o altri formati.
Estensioni per creare gli Standard Audit File .
Salvataggio del file contabile su qualsiasi supporto.

Altre funzionalità
Aggiunta di nuove funzionalità.

Rimozione di funzionalità non più necessarie.

Estensioni

Estensioni predefinite per diverse stampe e altre funzionalità .
Ricerca e istallazione veloce.
Estensioni personalizzabili.
Aggiornamento automatico.
Possibilità di creare e istallare delle proprie estensioni locali .

Documentazione completa
Ogni dialogo ed errore ha una propria pagina di documentazione accessibile con un clic .
Documentazione aggiornata costantemente .
Domande e risposte .
Documentazione disponibile anche in formato PDF.

Il registro beni ammortizzabili è un applicativo incluso in Banana Contabilità Plus. Permette una
facile gestione dei tuoi beni ammortizzabili e ottieni rapidamente tutti i valori che ti servono, nonché
le registrazioni di ammortamento a fine anno in automatico.

https://www.banana.ch/it/sicurezza-archiviazione
http://www.banana.ch/apps/it/extensions
https://www.banana.ch/it/node/9386
https://www.banana.ch/doc/it/banana-error-details/it
https://www.banana.ch/doc/it/documentation
https://www.banana.ch/it/node/9340
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Come iniziare un Registro beni
ammortizzabili

Crea un nuovo file
È generalmente più semplice iniziare da un modello preimpostato, piuttosto che uno nuovo vuoto.

Pertanto consigliamo di procedere nel seguente modo:

Menu File → Nuovo→ Registro beni ammortizzabili
Scegli il modello che trovi a disposizione e personalizza i conti e i gruppi, secondo i propri beni
ammortizzabili.

Imposta la tabella Articoli
Nella tabella Articoli imposta l'elenco dei beni e i gruppi di appartenenza.

 

Inserisci altre registrazioni
Nella tabella Registrazioni puoi anche inserire altre righe per modificare i valori storici, contabili e
fiscali.

Crea in automatico le righe di ammortamento
Dal menu Azioni → Creare righe d'ammortamento , il programma crea le righe di ammortamento per
i singoli beni, in base ai parametri specificati. Se è necessario puoi modificare i valori calcolati in
automatico.

http://www.banana.ch/doc/it/node/8015
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Stampe
Puoi stampare, copiare ed esportare in pdf tutto quello che vedi a schermo, e accedere anche ai
comandi per le Stampe specifiche.
 

Riprendi gli ammortamenti in Contabilità
Gli ammortamenti possono essere ripresi in contabilità:

Dal menu Azioni Importa in Contabilità → Movimenti .
Se si usa un altro programma di contabilità, le registrazioni di ammortamento devono essere
ripresi manualmente secondo le indicazioni di stampa.

Con la Stampa registrazioni contabili puoi vedere quali sono i valori che verranno importanti. Questa
stampa è anche comoda se usi un altro software, perché puoi riportare i valori nel tuo programma.
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Storia di un bene
Qui di seguito sono elencate diverse possibili fasi relative alla gestione di un bene:

Acquisto di un nuovo bene

Partiamo da un esempio. acquisto di un costoso computer che funge da server aziendale)

L'acquisto viene registrato dapprima nel file della contabilità sul conto specifico (computer,
macchinario, a secondo del conto impostato negli attivi o nel sottogruppo specifico).
Nel registro Beni ammortizzabili, nella tabella Articoli, viene aggiunto il bene acquistato come
nuovo articolo, con il valore d'acquisto, i parametri dell'ammortamento e il numero del conto,
presente negli attivi e il conto ammortamento (contropartita), presente nei costi del Conto
economico.
Nel registro Beni ammortizzabili, nella tabella Articoli, è utile creare un gruppo nel quale
saranno totalizzati tutti gli articoli dello stesso genere (es. gruppo computer o macchinario dove
saranno totalizzati i valori del computer o del macchinario A, B, C...). Il valore totale del gruppo
di articoli dovrà corrispondere al valore totale del corrispondente conto specifico (computer o
macchinario presente nella contabilità. In questo modo si vede se valori collimano.

Ammortamento a fine anno (o mensile se si desidera)

Con il comando Crea righe d'ammortamento, il programma crea una riga di ammortamento
per ogni bene.
Se per un bene è stato previsto anche l'ammortamento accelerato, viene creata una seconda
riga di ammortamento con un ulteriore valore di ammortamento.
La percentuale di ammortamento accelerato si imposta nella tabella Articoli, colonna
Amrt.2%, relativamente al bene di cui si prevede l'ammortamento accelerato). Se la colonna
Amrt.2% non è visibile, deve essere impostata dal menu Dati → Disponi colonne → opzione
Ammortamento percentuale 2.
Si stampa l'elenco degli ammortamenti.
In Banana Contabilità si importano gli ammortamenti dell'anno.
Si verifica che il valore contabile del gruppo computer o macchinari nella tabella Articoli sia
uguale a quello del conto computer o macchinari della contabilità.
Se i valori non combaciano vuol dire che ci sono stati acquisti o dismissioni non registrati.

Espansione del bene

L'anno successivo si acquistano materiali per un'espansione importante dei computer o
macchinari.

L'acquisto viene registrato in contabilità sul conto computer o macchinario.
Nella tabella registrazioni del registro beni ammortizzabili viene creata una riga, con la
data d'acquisto, il Tipo registrazione 11, e l'importo dell'acquisto inserito nella colonna
Variazione acquisto.

Ammortamento a fine anno successivo
Con il comando Crea righe d'ammortamento si lascia che il programma, crei una riga di
ammortamento per ogni bene.
Se l'importo dell'ammortamento calcolato dal programma per i computer o macchinari
non è corretto, si può rettificare la riga di registrazione e inserire il valore corretto.
Si stampa l'elenco degli ammortamenti.
In Banana Contabilità si importano gli ammortamenti dell'anno.
Si verifica che il valore contabile del gruppo computer o macchinari nella tabella Articoli
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sia uguale a quello del conto computer o macchinari della contabilità.
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Tabella Articoli | Registro beni
ammortizzabili

Nella tabella Articoli si inseriscono i beni ammortizzabili, con i relativi gruppi, i parametri di calcolo
degli ammortamenti e altre informazioni.

  

Creazione dell'elenco dei beni
Quando si acquista un bene si deve registrare l'acquisto in contabilità e parallelamente inserire nella
tabella Articoli una nuova riga con le informazioni dell'articolo.

Ogni articolo deve avere un Id identificativo e una descrizione.
Si indica poi la data di acquisto, il valore d'acquisto, il codice Tipo ammortamento e la
percentuale d'ammortamento.

Gruppi
Per totalizzare gli importi per ogni categoria di articoli, si crea un gruppo di totalizzazione nella
colonna Gruppo. Il codice del gruppo deve essere assegnato ad ogni articolo della stessa categoria
nella colonna Somma in.
Si possono creare più livelli di gruppo.
Per maggiori informazioni sul sistema di raggruppamento si rimanda alla pagina Sistema
Raggruppamento.

È utile che si creino i gruppi in modo che ci sia una corrispondenza con i conti della contabilità. Se in
contabilità vi è un conto "Attrezzatura", nella tabella Articoli è utile avere il gruppo Attrezzatura. Per
facilitare il controllo, si può indicare come numero di gruppo il numero di conto della contabilità. Alla
fine dell'anno si deve controllare che il valore contabile del Gruppo Attrezzatura sia uguale al saldo
del conto Attrezzatura.

I gruppi sono utili anche per non dovere specificare i parametri per ogni singolo elemento. Per il
calcolo degli ammortamenti, se i parametri (conto, contropartita, tipo e percentuale ammortamento,
ecc.) non sono specificati a livello di articolo, vengono ripresi i parametri del sottogruppo o del
gruppo.
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Colonne preimpostate
La tabella contiene una serie di colonne già impostate. Quelle indicate con l'asterisco (*) sono protette
e calcolate dal programma.
Se servono altre informazioni, si possono aggiungere ulteriori colonne con il comando Disponi
colonne.

Identificativi, descrizioni e raggruppamenti
Gruppo
Se vi è indicato un valore significa che la riga è un gruppo.
In questa riga vengono totalizzati gli importi degli articoli e dei gruppi.
Id
L'identificativo univoco del bene.
Descrizione
La descrizione dell'oggetto.
RigaGruppoIn
Il gruppo a cui questa riga appartiene. Un valore presente nella colonna RigaGruppo.
Conto
Il conto della contabilità dove è contabilizzato questo oggetto.
Il conto può essere indicato anche a livello di gruppo.
Contropartita
Il conto sul quale registrare l'ammortamento.
La contropartita può essere indicata anche a livello di gruppo.
DataIniziale
La data di acquisto del bene (o di entrata in contabilità).
DataFine
La data di durata massima del bene.
Se viene indicata una data, alla fine del periodo il bene sarà ammortizzato fino al valore
residuo.
DataDocumento
L'eventuale data del documento relativo all'acquisto del bene.

Valori / Importi
Importo iniziale
Il valore d'acquisto.
Una volta inserito non dovrebbe essere modificato. Eventuali variazioni dovrebbero essere
fatte tramite delle registrazioni per il cambiamento del valore d'acquisto o storico.
Valori calcolati dal programma

Variazione acquisto*.
Il valore in positivo o negativo dell'acquisto complessivo indicato nelle registrazioni.
ValoreAcquisto*
Il valore iniziale più la variazione d'acquisto.
VariazioneStorico*
Il valore in positivo o negativo di variazione del valore storico (rivalutazioni e
svalutazioni) indicato nelle registrazioni.
ValoreStorico*
È il valore d'acquisto più la variazione dello storico.
Variazione contabile*
Il valore in positivo o negativo della variazione contabile (ammortamenti o storni
ammortamenti) indicato nelle registrazioni.
Valore contabile*
E il valore storico più le variazioni contabili.
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VariazioneFiscale*
Il valore in positivo o negativo delle rettifiche del valore fiscale indicato nelle
registrazioni.
ValoreFiscale*
Il valore contabile più le rettifiche fiscali.

ValoreResiduo
Un eventuale valore minimo residuo da indicare.
Se il valore residuo è uguale o maggiore del valore contabile non sono più generate delle
righe di ammortamento.
ValoreStima
Un eventuale valore di stima dell'oggetto.
ValoreMercato
Un eventuale valore di mercato.

Parametri ammortamento
Tipo Ammortamento
Il tipo di ammortamento che viene applicato a questo oggetto.
Il tipo ammortamento può essere indicato anche a livello di gruppo.
Percentuale Ammortamento
La percentuale d'ammortamento.
La percentuale ammortamento può essere indicata anche a livello di gruppo.
Importo Ammortamento
Un eventuale importo dell'ammortamento nel caso che l'ammortamento non sia
specificato in percentuale.
Il Tipo Ammortamento deve essere 2.
Percentuale Ammortamento 2
La percentuale d'ammortamento supplementare da applicare al bene registrato sulla
stessa riga.
Quando in questa colonna è presente una percentuale, oltre all'ammortamento ordinario,
il comando Crea righe ammortamento, crea una riga di ammortamento supplementare. Il
metodo di calcolo è il medesimo. 
La percentuale ammortamento supplementare può essere indicata anche a livello di
gruppo.
La percentuale per il calcolo dell'ammortamento supplementare deve essere inserita solo
per l'anno che lo si prevede. Se negli anni successivi non si prevedono ammortamenti
supplementari, la percentuale inserita in questa colonna deve essere cancellata,
altrimenti il programma crea delle righe di registrazione per l'ammortamento
supplementare.
Mesi Ammortamento Primo Anno
Quanti mesi deve essere ammortizzato l'oggetto il primo anno.

Informazioni supplementari
NumeroSerie
Indicare un numero del prodotto.
Data Garanzia
La data di scadenza della garanzia.
Valore Assicurativo
Il valore a cui questo oggetto o gruppo è assicurato.
Nome Assicurazione
Il nome della compagnia d'assicurazione.
Numero Polizza
Il numero della polizza assicurativa.
Scadenza Assicurazione
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La data di scadenza della polizza assicurativa.
AnnullamentoAssicurazione
La data entro la quale si deve dare la disdetta della polizza, se non si vuole un rinnovo
automatico.

Informazioni per l'archiviazione dei dati
Data Archiviazione 
Una data indica che l'articolo deve essere archiviato.
Note Archiviazione
Si usano nel caso che l'oggetto sia da archiviare.

Aggiunta di nuove colonne
Se servono altre informazioni, si possono aggiungere ulteriori colonne con il comando Disponi
colonne.

Ammortamento nell'anno dell'acquisto del bene
Ci sono un'infinità di metodi per stabilitre come deve essere calcolato il valore d'ammortamento per il
primo anno.
Il programma offre queste possibilità:

Normalmente calcola l'ammortamento per l'anno intero.
Nella colonna MesiAmmortamentoPrimoAnno si può indicare per quanti mesi deve essere
calcolato l'ammortamento.

Se il primo anno si vuole solo il 50% dell'ammortamento normale indicare 6 mesi.
Colonna Ammortamento 2
Si usa per un ammortamento supplementare. Viene creata una riga di ammortamento
supplementare.
Il tipo di calcolo è il medesimo.
Per altre situazioni, si lascia che il programma crei la riga di ammortamento e poi la si rettifica
manualmente.
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Tabella Registrazioni

La tabella Registrazioni dei beni ammortizzabili contiene le operazioni che vanno a modificare il
valore storico, contabile o fiscale di un bene.
Con il comando Crea registrazioni d'ammortamento (dal menu Azioni) il programma calcola gli
ammortamenti in base ai parametri impostati e crea le righe di registrazione.

Oppure si possono inserire registrazioni per gli ammortamenti, le svalutazioni, rivalutazioni.

 

Colonne tabella Registrazione Ammortamenti
È la tabella dove vengono inserite le variazioni in merito al bene:

Data
La data dell'operazione
TipoRegistrazioneId
Il tipo di registrazione, come nella tabella tipo registrazione.
TipoRegistrazioneDescrizione*
Viene ripresa la descrizione della tabella.
IdArticolo
L'identificativo del bene.
DescrizioneArticoli*
La descrizione dell'articolo ripresa dalla tabella oggetti.
Note
Una nota supplementare relativa all'operazione.
VariazioneAcquisto
È l'importo della variazione (/+/-) relativa a un acquisto o alla vendita.
VariazioneStorico
È l'importo della variazione (+/-) relativa a una rivalutazione o svalutazione del bene.
VariazioneContabile
È l'importo della variazione (+/-) relativa alla variazione contabile.
Si inscrivono in particolare gli ammortamenti con il segno negativo.
VariazioneFiscale
È l'importo della variazione fiscale.
TipoAmmortamentoId
Il codice del tipo di ammortamento come dalla tabella.
DescrizioneTipoAmmortamento
La descrizione del codice ammortamento.
PercentualeAmmortamento
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La percentuale di ammortamento applicata.
Conto
Conto degli attivi sul quale l'operazione deve essere registrata.
Contropartita
Conto di contropartita (per esempio conto dell'ammortamento) sul quale deve essere registrata
l'operazione.
DataArchiviazione e NoteArchiviazione
Si usano nel caso che l'operazione sia da archiviare.
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Tabella Tipo ammortamento

In questa tabella sono indicati i codici di ammortamento.
Vi sono dei codici predefiniti che non devono essere modificati.

 

Colonne
Id
Il codice dell'ammortamento.
Questi codici sono fissi e non devono essere cambiati.
Se si cambia il numero, il programma non funziona più correttamente.

00 Nessun ammortamento
Non verrà creato alcun ammortamento.
01 Ammortamento completo in una volta
Il bene viene ammortizzato completamente in una volta sola.
02 Importo indicato
Calcolato in base all'importo indicato nella colonna Importo dell'ammortamento.
10 Sul valore storico
Detto anche ammortamento lineare o a quote costante.
Calcolato in percentuale del valore storico (quello di acquisto o dopo rivalutazioni o
svalutazioni).
11 Sul valore contabile.
Ammortamento detto anche degressivo.
Calcolato in percentuale del valore contabile.

Descrizione
La spiegazione del codice.

https://cdn.banana.ch/portal/repodata/ghba/General/SampleFiles/FixedAssets/Italian/images/registro_beni_ammortizzabili_tipo_ammortamento_it.png
https://cdn.banana.ch/portal/repodata/ghba/General/SampleFiles/FixedAssets/Italian/images/registro_beni_ammortizzabili_tipo_ammortamento_it.png


BANANA ACCOUNTING / BUCHHALTUNG / COMPTABILITÉ / CONTABILITÀ - 1079

Tabella Tipo registrazione

Nella tabella Tipo registrazione sono indicati dei valori che definiscono il tipo di operazione.
Il tipo più utilizzato è il "35  Ammortamento".
I tipi di registrazione non devono essere modificati.

 

Colonne
Id
Il codice del tipo registrazione.
Questi codici sono fissi e non devono essere cambiati.
Se si cambia il numero il programma non funziona più correttamente.

01    Valore iniziale
Utilizzato per inserire un valore iniziale, invece che immettere l'importo iniziale nella
tabella oggetti.
11    Acquisto o produzione
15    Vendita o riduzione del valore
21    Rivalutazione
25    Svalutazione
31    Ammortamento inverso
35    Ammortamento
36    Ammortamento supplementare
41    Aumento valore fiscale
45    Riduzione valore fiscale

Descrizione
La spiegazione del codice.
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Crea righe d'ammortamento

Per creare le righe di ammortamento cliccare sul menu Azioni → Crea righe di ammortamento.

 

Indicare:

La data per il calcolo dell'ammortamento.
Il periodo di calcolo dell'ammortamento, mensili, trimestrali, semestrali o annuale.

Il programma crea le righe di ammortamento in base ai parametri degli articoli indicati nella tabella
Articoli.

Se i parametri Tipo Ammortamento, Percentuale, Conto o Contropartita non sono indicati per un
singolo articolo, sono ripresi quelli indicati a livello del gruppo a cui l'articolo appartiene.
L'importo dell'ammortamento viene ridotto per evitare che che il valore contabile non vada in
negativo o non sia inferiore al valore Residuo.
I valori delle registrazioni, calcolati in automatico, possono essere rettificati manualmente.
Registrazioni per rettifiche di valore, come svalutazioni o rivalutazioni, devono essere inseriti
manualmente.

Modificare i valori calcolati in automatico
Le righe che il programma ha creato possono essere modificate o cancellate. Questa flessibilità è
molto utile in quanto ci sono delle situazioni in cui il valore calcolato in automatico necessita di
rettifiche. Si può così fare fronte a tutte le necessità e imprevisti.

In questi casi il valore dell'ammortamento sarà calcolato manualmente e inserito al posto del valore
automatico, come per esempio:

Primo ammortamento, calcolato in base a  metodi diversi.
Rettifica per arrotondamenti.
Rettifica dell'ammortamento finale, per fare in modo che l'ammortamento sia completo.
Ammortizzare per mantenere un valore finale preciso.
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Ammortamento supplementare, in questo caso è utile creare una nuova riga di registrazione.

Si possono anche Inserire registrazioni che modificano anche gli altri valori.

Cambiamento del tipo di ammortamento
Gli ammortamenti sono registrati nella tabella Registrazione, per cui dei cambiamenti nella tabella
Articoli, non hanno conseguenze sugli ammortamenti passati.

Puoi cambiare il tipo di ammortamento e la percentuale semplicemente cambiano i relativi valori per
un articolo o un gruppo, nella tabella Articoli. La prossima volta che saranno create le nuove righe
d'ammortamento, verranno usati i nuovi parametri.

Se si necessita di aggiustare il valore contabile, puoi, a scelta:

Aggiungere una nuova registrazione con gli importi di rettifica.
Modificare la registrazione creata in automatico.
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Inserire registrazioni che modificano altri
valori

La vista principale della tabella Registrazioni visualizza la modifica del valore contabile. Nella vista
completa sono indicate tutte le altre colonne disponibili, così che si possono modificare anche gli altri
valori.

Registrazioni modifica valore di Acquisto, Storico o Fiscale
Usando le appositi colonne si possono inserire registrazioni che modificano il valore d'acquisto, quello
storico o quello fiscale.

Aggiungere quindi una nuova riga e inserire manualmente i valori.
L'importo deve essere inserito manualmente dall'utente.
Usare il codice Tipo registrazione appropriato per la transazione.
Se si tratta di un ammortamento usare il codice Tipo ammortamento.
Colonne importo variazione:

+/- Acquisto
Importo in positivo per nuovi acquisti (Tipo registrazione 11).
Importo in negativo per le vendite parziali o totali (Tipo Registrazione 15).

+/- Storico
Importo in positivo per rivalutazioni (Tipo registrazione 21).
Importo in negativo per svalutazioni parziali o totali (Id Tipo Registrazione 25).

+/- Fiscale
Importo in positivo per l'aumento del valore fiscale (Tipo registrazione 31).
Importo in negativo per la riduzione del valore fiscale (Id Tipo Registrazione 45).

Modifica del Valore Iniziale
Il valore iniziale nella tabella articoli non dovrebbe essere cambiato. Se si necessitano delle rettifiche
sarebbero da inserire delle registrazioni che modificano:

o il valore d'Acquisto.
o il valore Storico (svalutazioni o rivalutazioni).
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Valore interno diverso da quello contabile
Ci possono essere delle situazioni dove il valore del bene (di mercato) è superiore al valore contabile,
quindi vi è una riserva occulta interna.

Per tenere nota di queste differenze puoi procedere con due modalità:

Nella tabella Articoli rendi visibile la colonna Valore di mercato e inserisci il valore.
Con questo sistema dovrai sempre aggiornare il valore tutte le volte che si modifica a seguito di
ammortamenti effettivi.
Usa la colonna valore fiscale come valore interno.
Il presupposto è che la colonna valore fiscale non sia già usata e quindi che il valore fiscale sia
uguale al valore contabile.

Nella tabella Articoli e Registrazioni, sostituisci le intestazioni delle colonne, usa "Valore
interno" invece di "Valore fiscale" e "+/- Interno" invece di "+/- Fiscale".
Nella tabella Tipo registrazione cambia le descrizioni dei codici 41 e 45.
Inserisci delle righe di registrazioni con il tipo registrazione 41 e 45 e nella colonna "+/-
Interno" indica la differenza in positivo.
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Ricontrolla tutto

Il programma ricalcola, ricontrolla e visualizza eventuali errori o differenze.

Usa questo comando tutte le volte che hai il dubbio che ci sia un problema.
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Stampe Registro beni ammortizzabili

Tutte le informazioni contenute nelle tabelle possono essere stampate o esportate con gli appositi
comandi.

Ci sono poi delle stampe specifiche:

Report registrazioni contabili
Visualizza giornale (schede articoli)
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Report registrazioni contabili

È il report contabile che riporta le registrazioni con il numero di conto e la contropartita.
Serve per importare in contabilità le registrazioni degli ammortamenti.

Si ottiene dal menu Report → Registrazioni contabili.

 

https://cdn.banana.ch/portal/repodata/ghba/General/SampleFiles/FixedAssets/Italian/images/registro_beni_ammortizzabili_report_registrazioni_it.png
https://cdn.banana.ch/portal/repodata/ghba/General/SampleFiles/FixedAssets/Italian/images/registro_beni_ammortizzabili_report_registrazioni_it.png
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Visualizza giornale (schede articoli)

Questa stampa visualizza, per ogni articolo, tutte le operazioni con la variazione dei valori e il valore
cumulato.
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Importa righe d'ammortamento in contabilità

A fine esercizio si possono importare in automatico nel file della contabilità le registrazioni di
ammortamento. Si procede come segue:

Menu Azioni → Importa in Contabilità → Movimenti
Scegliere come file Registro beni ammortizzabili
Con il bottone Sfoglia cercare e selezionare il file Registro beni ammortizzabili.

Sono riprese unicamente le righe del giornale che rientrano nel periodo della contabilità.
Si può successivamente scegliere d'importare solo alcune date.

Dalla versione 9.04 di Banana Contabilità si possono raggruppare le registrazioni di ammortamento
per conto.
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Rubrica indirizzi | Gestione contatti

 Con l'applicativo Rubrica Indirizzi di Banana Contabilità Plus crei con facilità la tua rubrica
indirizzi e in pochi secondi hai a disposizione i contatti che ti servono, puoi stampare le etichette,
esportare o stampare i tuoi contatti.

Se hai dei contatti registrati sul tuo telefono Android, importali direttamente nella tua Rubrica, in un
batter d'occhio hai una rubrica completa e aggiornata.

Puoi ordinare gli indirizzi ed estrarre solo quelli che vuoi stampare. Sono disponibili diversi formati,
sempre personalizzabili.

Per maggiori dettagli consultare le pagine web seguenti:

Caratteristiche
Tabella Gruppi
Tabella Contatti
Tabella Diario
Gestisci, edita, fai il backup dei contatti Google
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Caratteristiche della Rubrica Indirizzi

L'applicativo Rubrica e Indirizzi è incluso in Banana Contabilità Plus. È ideale per impostare
facilmente e velocemente gli indirizzi dei tuoi clienti, fornitori, soci, familiari e avere in un istante i
contatti di cui hai bisogno, oppure, stampare le liste degli indirizzi per le etichette.

Tante funzioni per velocizzare e rendere facile la gestione:

Colonne predefinite per ogni tipo di contenuto.
Aggiunta di ulteriori colonne da parte dell'utente.
Posizionamento delle colonne personalizzabile.
Impostazione personalizzabile del formato etichette.
Possibilità di stampare solo le righe selezionate.
Impostazione libera del formato delle etichette.
Copia/incolla indirizzi da altri programmi (Excel e Word).
Possibilità di colorare le righe per individuare subito i contatti più importanti.

Basato su tabelle come Excel
La gestione degli indirizzi si basa su colonne già predefinite che possono essere personalizzate come
posizionamento e come intestazione. Le colonne sono raggruppate in tre tabelle principali:

Tabella Gruppi
È la tabella dove vengono impostati i gruppi di indirizzi. Ogni gruppo viene identificato con un Id
che serve a categorizzare gli indirizzi. Possono essere creati gruppi per i fornitori, i clienti, i soci,
familiari, amici. Questo facilita la ricerca e consente d'impostare le etichette anche con la
selezione dei gruppi.
Tabella Contatti
In questa tabella vengono inseriti i contatti, con tutte le indicazioni del caso. Come in ogni altra
tabella possono essere aggiunte delle colonne supplementari per note o altro. I contatti possono
essere aggiornati e sincronizzati con i contatti Google.
Tabella Diario
Questa tabella è destinata per inserire giorno per giorno tutte le annotazioni relative alle
persone contattate.

Impostazione contabile
Intestazioni e dati base della Rubrica Indirizzi sono impostati in un'unica finestra di dialogo, facile da
visualizzare.

Intestazioni con testi liberi.
Indirizzo con  tutti i dati aziendali.
Impostazione lingua.
Collegamento a estensioni per personalizzazioni.
Password per rendere più sicura la tua rubrica indirizzi.
Puoi avere più file in lingue diverse.
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File e salvataggio dati
Hai tutti i dati salvati in un unico file, dove trovi facilmente tutto senza perdite di tempo.
Attribuisci al file il nome che desideri.
Puoi gestire un numero illimitato di file.
Salva i dati su qualsiasi supporto, computer, rete, cloud o inviali per email . Puoi accedervi
ovunque tu sia.
Accesso in contemporanea da più utenti, dove però solo una persona può aprire il file in
modifica.
Rendi più sicuri i tuoi contatti inserendo una protezione con password.
Nella colonna Links puoi aggiungere un Collegamento ad un documento
In tutte le tabelle hai delle colonne predefinite che puoi rendere visibili a scelta.
Il comando Cerca ti permette di cercare velocemente i contatti.
Puoi ordinare le righe secondo diverse chiavi di ordinamento.
Esportazione in pdf per la conservazione dei dati ed esportazione in altri formati per una
rielaborazione dati.
Importazione di dati da altri programmi in formato Testo, Ascii e CSV, con le opzioni seguenti:

Importa dati dagli appunti.
Completamento automatico dei valori.
Intestazione colonne.
Unicode (Utf-8).

Colonne per l'archivio di prodotti non più disponibili.

Segnalazioni errori e controllo
Comando per ricontrollare tutti i dai immessi.
Segnalazione di eventuali impostazioni sbagliate
Ogni segnalazione è collegata a una pagina di aiuto che spiega le cause e la soluzione.
Possibilità di correggere.

Report e stampe
Contenuto tabelle completamente stampabile o stampa anche solo per selezione.
Disposizione colonne personalizzabile.
Stampe etichette  (dal menu Estensioni).

Esportazione e archiviazione dati

Copia e incolla direttamente da e per Excel.
Esportazione tabelle in pdf e diversi altri formati.
Archiviazione delle stampe e dei dati in pdf o altri formati.
Salvataggio del file contabile su qualsiasi supporto.
 

Altre funzionalità

Aggiunta funzionalità

Aggiunta di nuove funzionalità.

https://www.banana.ch/it/node/11059
https://www.banana.ch/doc10/it/node/3859
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Rimozione di funzionalità non più necessarie.

Estensioni

Estensioni predefinite per diverse stampe e altre funzionalità .
Ricerca e istallazione veloce.
Estensioni personalizzabili.
Aggiornamento automatico.
Possibilità di creare e istallare delle proprie estensioni locali .

Documentazione completa
Ogni dialogo ed errore ha una propria pagina di documentazione accessibile con un clic .
Documentazione aggiornata costantemente .
Domande e risposte .
Documentazione disponibile anche in formato PDF.

http://www.banana.ch/apps/it/extensions
https://www.banana.ch/it/node/9386
https://www.banana.ch/doc/it/banana-error-details/it
https://www.banana.ch/doc/it/documentation
https://www.banana.ch/it/node/9340
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Tabella Gruppi

Nella tabella Gruppi per ogni riga si può definire, nella colonna Id, un codice di identificazione di un
Gruppo e nella colonna Descrizione la relativa descrizione (es. CLI - Clienti, FOR - Fornitori, COL -
colleghi....).
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Tabella Contatti

La tabella Contatti presenta le colonne dove inserire gli indirizzi.

Le colonne

Ci sono diverse colonne. La maggior parte delle colonne non è visibile. Usare il comando Disponi
colonne per:

Rendere visibile le colonne
Cambiare la sequenza di visualizzazione
Aggiungere delle altre colonne.

La denominazione si basa sullo standard VCard.

Id è il numero del contatto.
È necessario quando si vuole collegare un contatto al diario, ai prestiti o a un'altra tabella.
Se si preme F6 mentre si è su questa colonna vi è una numerazione automatica.
Cortesia, si inserisce "Signore", "Signora" ecc.. .
Cognome o ragione sociale (se si tratta di una ditta).
Se si tratta di una persona di contatto per una ditta, nella colonna Organizzazione potete
inserire l'ente o la ditta a cui appartiene.
Se si preme F6 sulla colonna Cognome o Nome il programma separa o inverte il nome e
cognome.
Se ci sono più di due nomi, questa funzione non è in grado di distinguere quali siano i nomi o i
cognomi.
Inizio lettera, è il saluto che viene usato all'inizio di una lettera. Si usa per la stampa unione.
Per esempio: "Caro Francesco" oppure "Egregio Signor Bianchi":
Il programma suggerisce possibili testi in base al contenuto delle colonne già inserite.

Importare nuovi Contatti

È possibile importare nuovi contatti anche dall'esterno e lo si può fare in diversi modi:

Tramite Importazione da Excel o da programmi di testo
Tramite il comando Importa righe
Sincronizzando i contatti di Google 
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Le Viste

Sono presenti diverse viste e ogni vista si differenzia dalle altre per la presenza di determinate
colonne; in questo esempio (file Rubrica), ci sono le viste Base, Nome, Indirizzo2, Archivio e Completo.
Per visualizzare tutte le colonne, cliccare sulla vista Completo.
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Tabella Diario

Nella tabella Diario si possono registrare tutte le annotazioni, giorno per giorno e riferite ai contatti
registrati.
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(Deprecato) Gestisci, edita, fai il backup dei
contatti Google

Comandi e funzionalità deprecati
Attenzione: Google ha deprecato la Contacts API usata da Banana per accedere e modificare i dati
dei contatti.
La nuova People API sostitutiva ha delle finalità e funzionalità diverse.
La lettura e modifica dei contatti Google sarà quindi disponibile SOLO FINO a quando Google manterrà
in servizio la Contacts API. Successivamente i comandi di sincronizzazione daranno un errore. I dati
salvati nel file AC2 saranno comunque sempre accessibili. Non si sa fino a quando la contacts API sarà
ancora disponibile. Si invita a non più usare queste funzionalità.

Documentazione
Scarica, vedi e modifica  in formato tabellare i contatti della tua rubrica Google / Android. Puoi
aggiornare e pulire i contatti molto più velocemente e anche stamparli, copiare e incollarli in Excel. 
Puoi anche salvare il file dei contatti sul tuo computer come copia di sicurezza.

Gestisci i contatti Google
Comando File->Nuova crea una Rubrica Indirizzo Nuova Vuota.1.
Menu->Azioni->Contatti Google ->Scarica Modifiche.2.

Ti verrà chiesto di autorizzare l'accesso ai contatti.
La tabella Contatti verrà riempita con i tuoi contatti.

Modifica e aggiorna i contatti a tuo piacimento.3.
Il Comando Menu->Data->Disponi colonne ti permette di rendere visibili altre colonne
predefinite, come Organizzazione Nome, Organizzazione Titolo, che si usano
frequentemente.

Menu->Azioni->Contatti Google ->Invia Modifiche.4.
Le modifiche locali saranno salvato in Google.

Per maggiori informazioni vedi le spiegazioni che seguono.

Autorizza l'accesso ai tuoi contatti
Sincronizza i contenuti del vostro file Banana del tipo Rubrica e indirizzi con i contatti del vostro
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account Google.

La prima volta che impartite il comando Scarica e rimpiazza i contatti esistenti a partire dal
menu Azioni-> Contatti Google, per collegarvi ai contatti Google:

appare una finestra che visualizza una pagina del browser Chrome integrato in Banana e vi
chiede il login di Google. 
Dovete inserire l'indirizzo email e la password del vostro account Google.

Banana salva unicamente l'email del vostro account di Google: i dati della sessione e la password non
sono salvati in Banana, ma sono gestiti dal meccanismo del vostro browser.

Subito dopo dovete confermare che il software Banana può accedere e modificare i vostri contatti.

Comandi Sincronizzazione

Scarica modifiche

Questa funzione riprende i dati da Google e aggiorna i valori in Banana.

Se ci sono già dati nella tabella, il programma unisce i dati esistenti e i nuovi valori delle tabelle
Gruppi
Contatti

Invia modifiche

Invia i dati modificati in Banana a Google, rispettivamente aggiorna i Contatti Google.
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Per potere inviare i dati a Google bisogna averli precedentemente scaricati almeno una volta
Se avete fatto una modifica sul vostro telefonino, prima dovete scaricare i dati e poi impartire il
comando Invia modifiche

Viene visualizzata una finestra con gli elementi modificati, aggiunti o cancellati.

Si sconsiglia di usare la colonna "GoogleNonSincronizza" perché non verrà più utilizzata in versioni
successive. Se vi è Sì, il contatto non viene sincronizzato con Google.

Scarica e rimpiazza contatti esistenti

Banana non è sempre in grado di sincronizzare tutte le modifiche.
Con questo comando i contatti nella tabella Contatti vengono cancellati e rimpiazzati da quelli
esistenti su Google.

Questo comando elimina anche gli elementi che hanno "GoogleNonSincronizza".

Conversione dei valori in tabella
Google Contacts gestisce indirizzi, numeri di telefono e email in forma strutturata. Nella tabella
Contatti i dati sono invece gestiti in colonna.

Numeri di Telefono e email

Google permette di definire diversi email e numeri di telefono. Per ognuno si indica un'etichetta e
l'indicazione di predefinito.
In Banana si devono seguire queste indicazioni:

se ci sono diverse tipologie di telefono o email si indicano nell'apposita colonna (lavoro, casa,
altro)
se per ogni tipologia ci sono più numeri di telefono o di email, questi vengono indicati nella
colonna, separati da un punto e virgola ";"
Telefono lavoro "+1234567890;+21234567890". Email lavoro
"example@gmail.com;example@yahoo.com"
se il numero di telefono o email ha un'etichetta particolare viene indicato nella colonna Altro,
con l'etichetta seguita da un due punti ":";
se ci sono più numeri si separano con un il punto e virgola ";"
"Vacanze:+1234567890*;Cugino:+1234566777".
"Temporary:example@gmail.com;Mama:example@yahoo.com"
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se ci sono diversi numeri di telefono, quello predefinito viene indicato con un asterisco "*" dopo
il numero.
Ci può essere un solo predefinito.

Indirizzi

Google permette di avere più indirizzi per il medesimo contatto.

Banana Contabilità invece permette di sincronizzare solo un indirizzo, quello "home" (indirizzo
principale).

Gruppi

Nella tabella Gruppi sono ripresi i gruppi definiti in Google e se ne possono aggiungere di nuovi.

Nella colonna Gruppi Id della tabella Contatti si possono inserire più gruppi d'appartenenza
separandoli con il punto e virgola ";".

Creare un backup dei propri contatti Google
Creare un nuovo file vuoto di tipo Rubrica.1.
Menu Azioni -> Contatti Google -> Scarica modifiche.2.
Salvare il file sul proprio computer con nel nome la data odierna.3.

Sistemare la propria rubrica dei contatti Google
Se avete tanti indirizzi nella vostra rubrica è molto più facile usare la rubrica di Banana per sistemare i
vostri indirizzi. Potete in poco tempo correggere errori, aggiungere informazioni e togliere duplicati e
altro.

Scaricate i dati da Google Contacts1.
Effettuate le modifiche2.
Ricordare che Il tasto F6 (Mac Cmd+6) ha diverse funzionalità (guardate nella finestra Info in
basso)
Sulla colonna nome e cognome, inverte i valori
Usate il comando Invia modifiche per inviare le modifiche a Google.3.

Archiviare e togliere i contatti che non si usano più 
Potete salvare sul vostro computer i contatti del telefono che non usate più ed eliminarli dalla vostra
rubrica.

La prima volta:

Create un nuovo file di tipo Rubrica Indirizzi.1.
Menu Azioni -> Contatti Google -> Scarica modifiche.2.
Salvate il file nei vostri documenti, "Rubrica_Marco_noncancellare_mai", così vi ricordate che è3.
un file importante.
Visualizzate la vista Archivio nella tabella Contatti.4.
Nella colonna Data Arch. (data di archiviazione) inserite la data odierna (digitate il punto ".")5.
per tutti quei contatti che non volete che siano più visualizzati
Comando Azioni -> Archivia dati -> Archivia dati tabella -> Contatti6.
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Comando Azioni -> Contatti Google -> Invia modifiche7.
I vostri dati saranno cancellati dalla rubrica.
Menu Azioni -> Archivia dati -> Visualizza dati archiviati -> Contatti vi permetterà di8.
accedere ai vostri contatti archiviati.
Se volete aggiungerli nuovamente alla rubrica dovete ricopiare la riga nella tabella Contatti e
cancellarla dagli Archiviati.

Custodite bene il file. Quando volete nuovamente archiviare dei contatti inutilizzati:

Aprite il vostro file rubrica Indirizzi.1.
Menu Azioni -> Contatti Google -> Scarica modifiche o se ci sono problemi Scarica e2.
rimpiazza contatti esistenti
Eseguite come indicato più sopra la procedura di Archiviazione e di Invio modifiche.3.
Salvate le modifiche.4.

Riprendere i dati in Excel
Scaricate i dati da Google Contacts.
Selezionate tutto (bottone nell'angolo in alto a sinistra)
Copiate
Incollate in Excel.

Problemi di sincronizzazione e suggerimenti
La rubrica Indirizzi di Google offre molte possibilità e può essere utilizzata in modi diversi. Abbiamo
cercato di fare in modo che tutto funzioni al meglio, ma ci possono essere delle situazioni in cui il
programma non riesce a capire le modifiche che ci sono state.
In questo caso è necessario usare il comando 'Scarica e cancella i contatti esistenti', per riallineare
completamente i due archivi.

Ci interessa ovviamente migliorare sempre il funzionamento, quindi inviateci un email dove
descrivete il problema e ci indicate come replicare il problema sui nostri computer. Solo se riusciamo
a replicare il problema, ci è anche possibile sistemarlo.
Sono anche benvenuti eventuali suggerimenti su come migliorare il prodotto.

Per i dettagli tecnici relativi al collegamento effettuato si veda la documentazione delle Google Api.

https://developers.google.com/google-apps/contacts/v3/
https://developers.google.com/gdata/docs/2.0/elements#gdReference
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Stampe etichette

L'applicativo Rubrica indirizzi permette di creare e stampare gli indirizzi su delle etichette. La stampa
può essere personalizzata e adattata per svariate esigenze.

Per stampare delle etichette è molto semplice: Menu Estensioni → Stampa etichette. Ai link che
seguono ci sono tutte le informazioni dettagliate dei vari dialoghi per la stampa e il formato delle
etichette:

Stampa etichette
Formati etichette
Stampare etichette biblioteca
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Biblioteca e collezioni

Con l'applicativo Biblioteca e collezioni di Banana Contabilità Plus organizzi con estrema facilità
un elenco di libri, oggetti o contatti e hai immediatamente gli elenchi che ti servono per controllare
prestiti, scadenze o semplicemente per digitalizzare la tua biblioteca di casa o del tuo studio per un
ordine perfetto.

Ideale per biblioteche scolastiche, comunali, librerie di studi professionali e privati.

Ottimizza e velocizza il lavoro con l'importazione dei dati dei libri direttamente da internet, modifica e
aggiorna i contatti, le scadenze, i prestiti.

Con un click stampi i cataloghi completi dei libri, la lista dei libri in scadenza o quelli già scaduti,
organizzi i turni dei bibliotecari con il diario per una perfetta organizzazione del lavoro.

Per maggiori dettagli consultare le pagine web seguenti:

Caratteristiche
Tabella Gruppi
Tabella Contatti
Tabella Articoli
Tabella Prestiti
Tabella Diario
Restituzione articoli
Archivia dati tabella
Stampare etichette biblioteca
Modello per la gestione Biblioteca e collezioni

 

https://www.banana.ch/apps/it/node/8109
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Caratteristiche Biblioteca e collezioni

Biblioteca e collezioni è incluso nella versione di Banana Contabilità Plus. È la soluzione facile e
innovativa per organizzare libri, prestiti, contatti e collezioni e, avere tutti gli elenchi all'istante per un
controllo efficace. Puoi  monitorare prestiti, scadenze e restituzioni o semplicemente per avere
perfetto ordine nella propria libreria domestica.

Tante funzioni per un'organizzazione digitalizzata ed efficiente:

Immissione dei dati veloce.
Categorizzazione per gruppi di utenti.
Ripresa dettagli libri da Google con ISBN.
Copia e incolla lista libri da Excel.
Ricerche rapide per titolo, autore, parole chiave, utente o gruppo di utenti.
Pianificazione interna con il Diario (turni bibliotecari, annotazioni o nuovi ordini da fare).
Gestione dei prestiti.

Impostazione contabile
Intestazioni e dati base impostati in un'unica finestra di dialogo, facile da visualizzare.
Intestazioni con testi liberi.
Campi predefiniti per l'indirizzo
Impostazione lingua.
Collegamento a estensioni per personalizzazioni.
Password per rendere sicuro il tuo file della Biblioteca.
Puoi avere più file in lingue diverse.
 

Tabelle
Nei file della tipologia Biblioteca e collezioni sono presenti diverse tabelle che permettono di avere
dati sempre in ordine e facili da trovare.

Le tabelle sono le seguenti:

Tabella Gruppi - dove vengono definiti i gruppi secondo i quali si desidera suddividere gli utenti.

Tabella Contatti - dove si inseriscono i dati degli utenti: nome, tel, email, ....

Tabella Articoli -  si inseriscono gli articoli: oggetti di valore, libri o altro.

Tabella Prestiti - si gestiscono gli articoli prestati, la scadenza e la data di restituzione.

Tabella Diario - per inserire delle annotazioni giornaliere e abbinarle ad un determinato contatto,
per esempio i turni dei bibliotecari.

File e salvataggio dati
Hai tutti i dati salvati in un unico file, dove trovi facilmente tutto senza perdite di tempo.
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Attribuisci al file il nome che desideri.
Puoi gestire un numero illimitato di file.
Salva i dati su qualsiasi supporto, computer, rete, cloud o inviali per email . Puoi accedervi
ovunque tu sia.
Accesso in contemporanea da più utenti, dove però solo una persona può aprire il file in
modifica.
Rendi più sicuri i tuoi contatti inserendo una protezione con password.
Nella colonna Links puoi aggiungere un Collegamento ad un documento
In tutte le tabelle hai delle colonne predefinite che puoi rendere visibili a scelta.
Il comando Cerca ti permette di cercare velocemente i contatti, i libri o altro.
Puoi ordina le righe secondo diverse chiavi di ordinamento.
Esportazione in pdf per la conservazione dei dati ed esportazione in altri formati per una
rielaborazione dati.
Importazione di dati da altri programmi in formato Testo, Ascii e CSV, con le opzioni seguenti:

Importa dati dagli appunti.
Completamento automatico dei valori.
Intestazione colonne.
Unicode (Utf-8).

Colonne per l'archivio dati.
 

Segnalazioni errori e controllo
Comando per ricontrollare tutti i dati immessi.
Segnalazione di eventuali impostazioni sbagliate.
Ogni segnalazione è collegata a una pagina di aiuto che spiega le cause e la soluzione.
Possibilità di correggere.
 

Report e stampe
Tutto ciò che si vede a video può essere stampato o salvato in pdf.

Usa l'estensione Report libri biblioteca  per ottenere:

Stampe del catalogo completo dei libri in pdf, da pubblicare sul sito internet.
Stampa della scheda dei contatti con i libri ancora in prestito (da inviare come allegato quando
si fanno i richiami).
Disposizione colonne personalizzabile.
Stampe articoli non restituiti.
Stampa delle etichette con i codici per il dorso dei libri
Stampa delle etichette per la restituzione all'interno del libro.
Stampa elenco aggiornato dei libri non ancora riconsegnati.
 

Esportazione e archiviazione dati

Copia e incolla direttamente da e per Excel.
Esportazione tabelle in pdf e diversi altri formati.
Archiviazione delle stampe e dei dati in pdf o altri formati.
Salvataggio del file contabile su qualsiasi supporto.

https://www.banana.ch/it/node/11059
https://www.banana.ch/apps/it/node/8554
https://www.banana.ch/doc10/it/node/3859
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Archivia dati.

Altre funzionalità

Aggiunta funzionalità

Aggiunta di nuove funzionalità.
Rimozione di funzionalità non più necessarie.
 

Estensioni

Estensioni predefinite per diverse stampe e altre funzionalità .
Ricerca e istallazione veloce.
Estensioni personalizzabili.
Aggiornamento automatico.
Possibilità di creare e istallare delle proprie estensioni locali .
 

Documentazione completa
Ogni dialogo ed errore ha una propria pagina di documentazione accessibile con un clic .
Documentazione aggiornata costantemente .
Domande e risposte .
Documentazione disponibile anche in formato PDF.

Altri comandi utili
Come registrare la restituzione di articoli

Come archiviare i dati di una tabella

http://www.banana.ch/apps/it/extensions
https://www.banana.ch/it/node/9386
https://www.banana.ch/doc/it/banana-error-details/it
https://www.banana.ch/doc/it/documentation
https://www.banana.ch/it/node/9340
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Come iniziare con la Biblioteca e collezioni

Crea un nuovo file
È generalmente più semplice iniziare da un modello preimpostato, piuttosto che uno nuovo vuoto.

Pertanto consigliamo di procedere nel seguente modo:

Menu File → Nuovo→ Biblioteca e collezioni . Scegli il modello che trovi a disposizione e
personalizza i conti e i gruppi, secondo le proprie necessità.
Scarica direttamente il nostro modello dalla pagina seguente: Biblioteca, collezione di libri e
gestione prestiti  e aprilo col Banana.

Imposta i dati base
Nel menu File → Proprietà file (Dati base) imposta i dati della tua Biblioteca.

Imposta i dati nelle tabelle
Tabella Gruppi
Tabella Contatti
Tabella Articoli
Tabella Prestiti
Tabella Diario

Report e Stampe
Scarica l'estensione Report libri biblioteca  per ottenere le stampe dei dati e salvarli in *.pdf.

http://www.banana.ch/doc/it/node/8015
https://www.banana.ch/apps/it/node/8109
https://www.banana.ch/apps/it/node/8109
https://www.banana.ch/apps/it/node/8554
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Tabella Gruppi

Nella tabella Gruppi vengono definiti i gruppi secondo i quali si desidera suddividere gli utenti. Per
identificare un gruppo si inserisce un codice identificativo Id (colonna Id). Nella colonna Descrizione
viene inserito un testo che identifichi il gruppo.

Per la spiegazione delle colonne presenti nella tabella Gruppi si veda la spiegazione della Rubrica.
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Tabella Contatti

Nella tabella Contatti si inseriscono i dati degli utenti. Le varie colonne possono essere
personalizzate (si possono rendere visibili solo quelle che servono, o aggiungerne di nuove).

Per la spiegazione delle colonne presenti nella tabella Contatti si veda la spiegazione della Rubrica.
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Tabella Articoli | Biblioteca e collezioni

In questa tabella si inseriscono gli articoli: possono riferirsi a oggetti di valore, libri o altro.
Ci sono diverse modalità di inserimento, anche con il copia/incolla da file Excel o riempimento
automatico con dati ripresi da internet.
Vedi sotto per spiegazioni dettagliate.

 Colonne

Ci sono diverse colonne. È possibile aggiungerne delle nuove.

Id è il numero dell'oggetto, che deve essere attribuito.
Il tasto F6 attribuisce il numero progressivamente.
È possibile usare anche un prefisso. Per esempio: A-001,  il programma proporrà A-002.
ISBN
È il numero internazionale di catalogazione dei libri.
Inserendo nella colonna Id il codice ISBN e premendo il tasto F6, il programma completa in
automatico tutti i dati del libro nelle altre colonne, riprendendoli dal database di Google, a
condizione che ci sia disponibile un collegamento internet.
Se ci sono già delle informazioni queste vengono sovrascritte.
Per informazioni vedi documentazione Google .

Non sempre i dati presenti nel database di Google sono completi. È possibile che ci sia il
titolo ma manchi l'editore o altri dati. 
Per verificare quali dati sono disponibili nel database di Google inserire nel proprio
browser la pagina 
https://www.googleapis.com/books/v1/volumes?q=9781906042509
inserendo dopo q= il numero di ISBN del libro.
Se si vede una pagina con "totalItems: 0" vuole dire che il libro NON È nel database dei
libri di Google. 
Se si vede una pagina in formato JSon (formato per programmatori) con i dati del libro
significa che il libro È presente nel database dei libri di Google. 

Titolo
È il titolo dell'opera.
Autore
Si possono inserire più autori, separandoli con un punto e virgola ";".
Editore
Si possono inserire più editori, separandoli con un punto e virgola ";".
Data restituzione
È la data di restituzione prevista per questo articolo. Viene completata automaticamente in
base ai prestiti registrati nella tabella Prestiti. Se è vuota significa che il libro è in casa.

https://developers.google.com/books/docs/v1/using?hl=en
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 Inserimento dei libri
I dati dei libri possono essere inseriti in tre modalità diverse:

Inserimento manuale - Nella tabella Articoli si inseriscono i dati dei libri. Vedi spiegazione
colonne (paragrafo precedente)
Riprendere i dati da Excel - Se si possiede già una lista di libri da un altro programma o su
Excel, si possono semplicemente copiare/incollare i dati.
Per copiare e incollare i dati bisogna assicurarsi che su Excel le colonne siano disposte come su
Banana. Il copia/incolla è possibile da Excel o da file txt.
Se l'ordine delle colonne coincide si possono copiare i dati in blocco, altrimenti si procedere
colonna per colonna o per aree selezionate.
Riprendere i dati dei libri automaticamente da internet - La colonna ISBN é molto utile se
si ha una connessione a Internet: ogni libro infatti ha un codice ISBN (formato riconosciuto
internazionalmente e scritto in genere sul retro della copertina); se si inserisce il codice ISBN
di un libro e si preme il tasto F6 (o Cmd + 6 per Mac), il programma rileva automaticamente da
internet e inserisce tutti gli altri dati (titolo, autore, editore, ecc. addirittura un piccolo riassunto
Se il libro ha diversi autori o editori, basta separare i nomi da un punto virgola ";" così verranno
trovati anche singolarmente nelle ricerche (per esempio trovare tutti i libri di un certo autore).
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Tabella Prestiti

Nella tabella Prestiti vengono gestiti gli articoli prestati, la scadenza e la data di restituzione.

Colonne

Data
È la data del prestito.
Articolo Id
Il numero dell'articolo. La ricerca può essere fatta in base al titolo.
Contatti Id
Il numero del contatto. La ricerca può essere fatta anche in base al nome, cognome, località.
Scadenza
È la data prevista per la restituzione.
Se si inserisce "+30", il programma proporrà la data di 30 giorni dopo.
Data restituzione
Inserire la data  della restiutzione.
 

 Gestire i prestiti

Registrare un prestito:

Inserire la data. Se si preme il tasto del punto "." viene scritta automaticamente la data del
giorno.
Nella colonna Articolo Id, se si inizia a digitare il titolo del libro e si seleziona dallo smart fill il
titolo desiderato, premendo F6, il programma inserisce in automatico l'Id dell'articolo e la
descrizione corrispondente.
Nella colonna Scadenza (data di restituzione del libro), il programma inserisce
automaticamente la data 30 giorni successivi alla data del prestito, ma è possibile cambiarla
manualmente (per es. scrivendo +40, il programma inserisce già la data corretta, 40 giorni
dopo).
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Tabella Diario

In questa tabella si possono inserire delle annotazioni giornaliere e abbinarle ad un determinato
contatto.
Si possono inserire per esempio i turni delle bibliotecarie, o segnare annotazioni o fatti rilevanti, liste
di cose da fare, ecc.
Per ogni annotazione si può inserire la data, la descrizione, una data di scadenza e abbinarvi un
codice utente.
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Restituzione articoli

 Registrare la restituzione di un libro:

Per indicare che un libro è stato restituito è sufficiente inserire nella colonna Restituzione della
tabella Prestiti, la data della restituzione del libro.

Se si hanno tanti libri in prestito, il dialogo Restituzione Articoli, elenca i libri in prestito, permette
di ricercarli e indicare con un visto l'avvenuta restituzione.
Ecco come procedere:

Dal menu Azioni scegliere il comando Restituzione articoli;
Appare una finestra dove occorre digitare il nome dell’utente per vedere l’elenco dei libri che ha
preso.

Vistare tutti i libri che vengono restituiti.
Con il tasto Applica, il programma inserisce automaticamente la data del giorno nella
colonna Data Restituzione della tabella Prestiti.
In caso di errori basta ritorna nella tabella Prestiti e usare il comando Annulla.
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Archivia dati tabella

 Archiviare i dati
La funzione Archivia permette di evitare l'accumulo di troppe registrazioni di libri usciti e poi
restituiti. I dati archiviati non vengono cancellati, ma sono salvati in tabelle nascoste. Per statistiche o
per qualsiasi altra necessità questi dati si possono riprendere.

Archivia dati prestiti libri rientrati

Con il comando Archivia dati (dal menu Report), e poi Archivia dati tabella -> Prestiti, il
programma elimina tutti i prestiti di libri ormai restituiti dalla tabella Prestiti, e li inserisce in
una tabella Archivio.
Nella tabella Prestiti rimangono quindi unicamente i libri prestati e non ancora rientrati.

Archivia dati contatti non più usati

Come per l'archiviazione dei libri si possono archiviare anche i vecchi contatti.

Indicare una data di archiviazione.
Impartire il comando Archivia dati dal menu Report e scegliere Archivia dati tabella e poi
Contatti.
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Stampare etichette biblioteca

Si possono stampare due tipi di etichette:

Etichette piccole -  da attaccare sul dorso del libro (con il codice del libro), in modo che sia
visibile sugli scaffali
Etichette grandi - da inserire nella pagina interna del libro, in cui si specifica l'appartenenza del
libro alla biblioteca e si annota la data entro la quale il libro deve essere restituito.

Le etichette possono essere stampate sia a partire dal file Banana, dove sono stati già registrati tutti i
libri della biblioteca, sia da un file vuoto, nel caso in cui si voglia prima stampare i codici e poi
attribuirli ai libri.

Crea nuovo
File→ Nuovo... nella casella Filtra per: inserire il termine "biblioteca" e selezionare il modello
Biblioteche, stampa etichette codici libri
In alternativa puoi trovare il modello direttamente a questo link:
https://www.banana.ch/apps/it/node/9000

 Stampa etichette per il dorso dei libri

Per la stampa delle etichette si apre un nuovo file Banana per biblioteche, vuoto, senza dati (menu
File→ Nuovo), ma si può anche partire da un file proprio, come spiegato in precedenza.

Per creare velocemente tanti codici libri, invece che scriverli a mano o usare il tasto F6 su ogni riga, si
può usare la funzione di Excel per la creazione di una sequenza progressiva di codici e poi copiarli in
Banana:

Si apre un file nuovo su Excel; nella cella A1 digitare il codice della biblioteca che si desidera
(può essere qualsiasi combinazione di lettere seguite da numeri - es. B.ES-00001, per Biblioteca
Esempio 00001).
Puntare il mouse sull'angolo a destra in basso della cella (il puntatore diventa una croce) e,
tenendo premuto, si trascina il mouse verso il basso; Excel crea automaticamente i codici
progressivi.

https://www.banana.ch/apps/it/node/9000
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Copiare i codici creati (tasti Ctrl + C) e incollarli in Banana (comandi Ctrl + V), nella tabella
Articoli, colonna Id.

Creare l'etichetta - dal menu Estensioni scegliere il comando Etichette → Stampa

Come sorgente dei Dati è importante che venga selezionata la tabella Articoli
Premere il tasto Cambia... nella sezione Formato etichette per definire l'etichetta.
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 Inserire i margini e le caratteristiche del formato di etichette scelto (nell'esempio Herma
10001)

Nella sezione Personalizzazione dare un nome alle impostazioni scelte; questo permette di
memorizzare tutte le impostazioni in modo da poterle utilizzare in futuro senza dover ripetere le
impostazioni (nel nostro caso abbiamo scelto Codici Libri dorso)
Premere il tasto OK

Nella sezione Etichetta selezionare IdRiga per indicare il contenuto dell'etichetta (nell'esempio
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si indica il codice del libro) e premere il bottone Aggiungi campo. L'IdRiga figura nella Vista
etichetta
Premendo il tasto OK per  vedere il risultato.

A questo punto basta stampare utilizzando i fogli per le etichette.
 

 Stampa etichette per l'interno dei libri

Anche in questo caso, il primo passo da fare è scegliere il formato dell'etichetta. Nell'esempio
abbiamo scelto un formato abbastanza comune, 70x36mm (Herma 4630 o Avery 3490). I passi sono
analoghi a quelli precedenti:

Dal menu Estensioni scegliere il comando Etichette → Stampa
Nella sezione Formato etichette cliccare sul bottone Cambia
Nella finestra Formato etichetta inserire i margini della nuova etichetta
Andare nella sezione Personalizzazione e dare il nome a queste nuove impostazioni (per
esempio Etichetta interna libri) e premere OK.
Dalla finestra Stampa etichette andare nella sezione Etichetta per definire il contenuto
dell'etichetta.

È possibile inserire oltre ai campi, anche del testo libero

Premendo OK si visualizza il risultato:
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Nota:

Nel modello messo a disposizione sono già presenti i due formati di etichette: l'etichetta per il dorso
dei libri e l'etichetta per l'interno dei libri.
 

Funzioni collegate:

Gestione delle quote annuali

Se si deve gestire una biblioteca in cui vi è una tassa sociale annuale o vi sono dei costi per i prestiti
dei libri, è utile usare uno dei modelli contabili di Banana Contabilità.
Si rimanda alla pagina dei modelli di contabilità .

https://www.banana.ch/apps/it
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Tabella semplice di Banana Contabilità+

La Tabella semplice è un applicativo di Banana Contabilità Plus, un file che contiene unicamente una
tabella vuota, che può poi essere adattata per rispondere alle tue necessità. Si possono aggiungere
colonne e viste e intestarle nel modo più appropriato, tramite i comandi Disponi colonne e Disponi
tabelle dal menu Dati.

Si possono poi anche aggiungere altre tabelle.
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Menu Azioni

Il menu Azioni contiene comandi specifici per gli applicativi di Produttività.
Qui di seguito spieghiamo i comandi generali, presenti in tutti gli applicativi.
Altri comandi specifici alla Rubrica e alla Biblioteca sono spiegati nella relativa documentazione.

Ricontrolla tutto
Esegue dei controlli e avvisa se ci sono degli errori.

Ordina i contatti in ordine alfabetico
Ordina le righe della tabella 'Contatti' in ordine crescente per Nome, Cognome, Secondo nome,
Località.

Menu Archivia dati
Per ogni tabella il programma tiene una lista delle righe archiviate.

Le righe archiviate sono visualizzate nella tabella righe archiviate. Bisogna scegliere quale righe
visualizzare.

Archivia dati

Il comando sposta nella tabella 'Dati archiviati' le righe appartenenti ad una tabella (Contatti, Articoli,
Prestiti, Diario), dove:

La colonna data d'archiviazione non è vuota.
Per la tabella Prestiti, vi è una data di scadenza e quella di ritorno (un prestito chiuso).
 

Viene visualizzato un elenco delle tabelle all'interno delle quali ci sono le righe da archiviare.
Se non ci sono tabelle con righe d'archiviare, la selezione è vuota.
 

Visualizza i dati archiviati

Visualizza la lista delle righe archiviate di una specifica tabella.
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Aggiungi o rimuovi funzionalità Applicativi
produttività

Con il comando Strumenti > Aggiungi/Rimuovi funzionalità puoi aggiungere delle tabelle che non sono
visualizzate per default, o eliminare dalla visualizzazione tabelle non necessarie. 

Aggiungi Tabella
A dipendenza delle esigenze possono essere visualizzate le seguenti tabelle: 

Progetti - da utilizzare nel Timesheet
Contatti- da utilizzare nelle Offerte e Fatture
Le colonne predisposte per gestire indirizzi
Categorie
Per classificare elementi - da utilizzare nel Timesheet e nel programma Offerte e Fatture.
Tabella semplice.
Con un campo indice e una descrizione.

Una volta aggiunta la tabella puoi personalizzare la posizione della visualizzazione con i comandi
Disponi colonne o Disponi Tabelle.

Aggiungi collegamento ad una tabella
Nelle tabelle visualizzate per default puoi aggiungere delle colonne che si collegano a quelle elencate.

Il collegamento avviene inserendo codice di collegamento in  una tabella visualizzata per default
verso un'altra tabella che è stata aggiunta.
Per esempio, nella tabella registrazione potere aggiungere la colonna Progetto, che si collega alla
tabella progetto.

Informazioni dettagliate sono disponibili alla seguente pagina web: Collegare tabelle.
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